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Welcome toMicroEJ developer documentation. Browse the following chapters to familiarize yourself withMicroEJ
Technology and understand the principles of app and platform development with MicroEJ.

• The Glossary chapter describes MicroEJ terminology.

• The Overview chapter introduces MicroEJ products and technology.

• The Application Developer Guide presents Java applications development and debugging tools.

• The Platform Developer Guide teaches you how to integrate a C Board Support as well as simulation config-
urations.

• The Kernel Developer Guide introduces you to advanced concepts, such as partial updates and dynamic app
life cycle workflows.

• The Tutorials chapter covers a variety of topics related to developing with the MicroEJ ecosystem.
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CHAPTER

ONE

MICROEJ GLOSSARY

This glossary defines the technical terms upon which the MICROEJ VEE (Virtual Execution Environment) is built.

Add-On Library AMicroEJ Add-On Library is a puremanaged code (Java) library. It runs over one ormoreMicroEJ
Foundation Libraries.

Abstraction Layer An Abstraction Layer is the C code that implements a Foundation Library’s low-level APIs over
a board support package (BSP) or a C library.

Application A MicroEJ Application is a so�ware program that runs on a Powered by MicroEJ device.

Standalone Application MicroEJ Standalone Application is a MicroEJ Application that is directly
linked to the C code to produce aMicroEJMono-Sandbox Firmware. It is edited usingMicroEJ
SDK.

Sandboxed Application A MicroEJ Sandboxed Application is a MicroEJ Application that can run
over a MicroEJ Multi-Sandbox Firmware. It can be linked either statically or dynamically.

System Application A MicroEJ System Application is a MicroEJ Sandboxed Application that is
statically linked to a MicroEJ Multi-Sandbox Firmware, as it is part of the initial image and
cannot be removed.

Kernel Application AMicroEJ Kernel Application is aMicroEJ Standalone Application that imple-
ments the ability to be extended to produce a MicroEJ Multi-Sandbox Firmware.

Architecture A MicroEJ Architecture is a so�ware package that includes the MicroEJ Core Engine port to a target
instruction set and a C compiler, core MicroEJ Foundation Libraries (EDC, [BON], [SNI], [KF]) and the MicroEJ
Simulator. MicroEJ Architectures are distributed either as evaluation or production version.

Core Engine, also named “MEJ32” MicroEJ Core Engine, also named MEJ32, is a scalable 32-bit core for
resource-constrained embedded devices. It is delivered in various flavors, mostly as a binary so�ware pack-
age. MicroEJ Core Engine allows applications written in various languages to run in a safe container.

Firmware A MicroEJ Firmware is the result of the binary link of a MicroEJ Standalone Application with a MicroEJ
Platform. The firmware is a binary program that can be programmed into the flash memory of a device.

Mono-Sandbox Firmware AMicroEJMono-Sandbox Firmware is aMicroEJ Firmware that imple-
ments an unmodifiable set of functions. (previously MicroEJ Single-app Firmware)

Multi-Sandbox Firmware A MicroEJ Multi-Sandbox Firmware is a MicroEJ Firmware that imple-
ments theability tobeextended, by exposinga set of APIs andamemory space to linkMicroEJ
Sandboxed Applications. (previously MicroEJ Multi-app Firmware)

Foundation Library AMicroEJFoundation Library is a library that provides coreor hardware-dependent function-
alities. A Foundation Library combines managed code (Java) and low-level APIs (C) implemented by one or
more Abstraction Layers through a native interface (SNI).

Mock A MicroEJ Mock is a mockup of a Board Support Package capability that mimics an hardware functionality
for the MicroEJ Simulator.

2

https://developer.microej.com/microej-vee-virtual-execution-environment
https://en.wikipedia.org/wiki/Managed_code
https://developer.microej.com/mej32-virtual-machine-for-embedded-systems/
https://en.wikipedia.org/wiki/Managed_code


MicroEJ Documentation, Revision 2788b3f4

Module Manager MicroEJ Module Manager downloads, installs and controls the consistency of all the dependen-
cies and versions required to build and publish a MicroEJ asset. It is based on Semantic Versioning specifi-
cation.

Platform AMicroEJ Platform integrates aMICROEJ VEE, a MicroEJ Architecture, one ormore Foundation Libraries
with their respective Abstraction Layers, and the board support package (BSP) for the target Device. It also
includes associated MicroEJ Mocks for the MicroEJ Simulator.

SDK MicroEJ SDK allows MicroEJ Firmware developers to build a MicroEJ-ready device, by integrating a MicroEJ
Architecture with both Java and C so�ware on their device.

Simulator MicroEJ Simulator allows running MicroEJ Applications on a target hardware simulator on the devel-
oper’s desktop computer. The MicroEJ Simulator runs one or more MicroEJ mock that mimics the hardware
functionality. It enables developers to develop their MicroEJ Applications without the need of hardware.

Studio MicroEJ Studio allows application developers towrite aMicroEJ Sandboxed Application, run it on a Virtual
Device, deploy it on a MicroEJ-ready device, and publish it to a MicroEJ Forge instance.

VEE MICROEJ VEE is an applications container. VEE stands for Virtual Execution Environment, and refers to the first
implementation that embeds a virtual 32-bit processor, hence the term “Virtual”. MICROEJ VEE runs on any
OS/RTOS commonly used in embedded systems (FreeRTOS,QP/C, uc/OS, ThreadX, embOS,MbedOS, Zephyr
OS, VxWorks, PikeOS, Integrity, Linux, QNX, . . . ) and can also run without RTOS (bare-metal) or proprietary
RTOS. MICROEJ VEE includes the small MEJ32, along with a wide range of libraries (Add-On Libraries and
Foundation Libraries).

Virtual Device A MicroEJ Virtual Device is a so�ware package that includes the simulation part of a MicroEJ
Firmware: runtime, libraries and application(s). It can be run on any PC without the need of MicroEJ Stu-
dio. In case a MicroEJ Multi-Sandbox Firmware, it is also used for testing a MicroEJ Sandboxed Application
in MicroEJ Studio.

3
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CHAPTER

TWO

OVERVIEW

2.1 MicroEJ Editions

2.1.1 Introduction

MicroEJ o�ers a comprehensive toolset to build the embedded so�ware of a device. The toolset covers two levels
in device so�ware development:

• MicroEJ SDK for device firmware development

• MicroEJ Studio for application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific set of Mi-
croEJ functionalities useful for application developers targeting this device.

Fig. 1: MicroEJ Development Tools Overview

Using the MicroEJ SDK tool, a firmware developer will produce two versions of the MicroEJ binary, each one able
to run applications created with the MicroEJ Studio tool:

• A MicroEJ Firmware binary to be flashed on OEM devices;

4
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• A Virtual Device which will be used as a device simulator by application developers.

Using the MicroEJ Studio tool, an application developer will be able to:

• Import Virtual Devices matching his target hardware in order to develop and test applications on the Simu-
lator;

• Deploy the application locally on an hardware device equipped with the MicroEJ Firmware;

• Package and publish the application on a MicroEJ Forge Instance, enabling remote end users to install it on
their devices. Formore information aboutMicroEJ Forge, please consult https://www.microej.com/product/
forge.

2.1.2 Determine the MicroEJ Studio/SDK Version

In MicroEJ Studio/SDK, go to Help > About MicroEJ SDK menu.

In case of MicroEJ SDK 4.1.x , the MicroEJ SDK version is directly displayed, such as 4.1.5 :

In case of MicroEJ SDK 5.x , the value displayed is the MicroEJ SDK distribution, such as 19.05 or 20.07 :

2.1. MicroEJ Editions 5
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To retrieve theMicroEJ SDK version that is currently installed in this distribution, proceedwith the following steps:

• Click on the Installation Details button,

• Click on the Installed Software tab,

• Retrieve the version of entry named MicroEJ SDK (or MicroEJ Studio ).

2.1. MicroEJ Editions 6
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2.2 Licenses

2.2.1 License Manager Overview

MicroEJ Architectures are distributed in two di�erent versions:

• Evaluation Architectures, associated with a so�ware license key. They can be downloaded at https://
repository.microej.com/modules/com/microej/architecture/.

• Production Architectures, associated with a hardware license key stored on a USB dongle. They can be re-
quested to our support team.

The license manager is provided with MicroEJ Architectures and then integrated into Platforms, consequently:

• Evaluation licenses will be shown only if at least one Evaluation Architecture or Platform built from an Eval-
uation Architecture has been imported in MicroEJ SDK.

• Production licenses will be shown only if at least one Production Architecture or Platform built from a Pro-
duction Architecture has been imported in MicroEJ SDK.

The list of installed licenses is available in MicroEJ SDK preferences dialog page in Window > Preferences >
MicroEJ :

Fig. 2: MicroEJ Licenses View

2.2.2 Evaluation Licenses

This section shouldbeconsideredwhenusingEvaluationArchitectures,whichuse so�ware licensekeys. Amachine
UID needs to be provided to activate an Evaluation license on the MicroEJ Licenses Server. Themachine UID is a 16
hexadecimal digits number.

Get your Machine UID

Retrieving the machine UID depends on the kind of MicroEJ Platform being evaluated.

2.2. Licenses 7
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If your MicroEJ Platform is already imported in Package Explorer and built with MicroEJ Module Manager, the Mi-
croEJ Architecture has been automatically imported. The machine UID will be displayed when building a MicroEJ
Standalone Application on device.

[INFO ] Launching in Evaluation mode. Your UID is XXXXXXXXXXXXXXXX.
[ERROR] Invalid license check (No license found).

Otherwise, a MicroEJ Architecture or Platform should have beenmanually imported from the MicroEJ SDK prefer-
ences page. The machine UID can be retrieved as follows:

• Go to Window > Preferences > MicroEJ ,

• Select either Architectures or Platforms ,

• Click on one of the available Architectures or Platforms,

• Press the Get UID button to get the machine UID.

Note: To access this Get UID option, at least one Evaluation Architecture or Platformmust have been imported
before (see License Manager Overview).

Copy the UID. It will be needed when requesting a license.

Fig. 3: Machine UID for Evaluation License

Request your Activation Key

• Go to MicroEJ Licenses Server https://license.microej.com.

• Click on Create a new account link.

• Create your account with a valid email address. You will receive a confirmation email a few minutes a�er.
Click on the confirmation link in the email and log in with your new account.

• Click on Activate a License .

• Set Product P/N: to 9PEVNLDBU6IJ .

• Set UID: to the machine UID you copied before.

• Click on Activate .

• The license is being activated. You should receive your activation by email in less than 5 minutes. If not,
please contact our support team.

2.2. Licenses 8
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• Once received by email, save the attached zip file that contains your activation key.

Install the License Key

If yourMicroEJPlatform is already imported inPackageExplorer andbuiltwithMicroEJModuleManager, the license
key zip file must be simply dropped to the ~/.microej/licenses/ directory (create it if it doesn’t exist).

Fig. 4: MicroEJ Shared Licenses Directory

Note: The MicroEJ SDK Preferences page will be automatically refreshed when building a MicroEJ Standalone
Application on device.

Otherwise, the license key must be installed as follows:

• Go back to MicroEJ SDK.

• Select the Window > Preferences > MicroEJ menu.

• Press Add. . . .

• Browse the previously downloaded activation key archive file.

• Press OK. A new license is successfully installed.

• Go to Architectures sub-menu and check that all Architectures are now activated (green check).

• Your MicroEJ SDK is successfully activated.

If an errormessage appears, the license key could not be installed. (see section Troubleshooting). A license key can
be removed from the key-store by selecting it and by clicking on Remove button.

Troubleshooting

Consider this section when an error message appears while adding the Evaluation license key. Before contacting
our support team, please check the following conditions:

• Key is corrupted (wrong copy/paste, missing characters, or extra characters)

• Key has not been generated for the installed environment

• Key has not been generated with the machine UID

• Machine UID has changed since submitting license request and no longer matches license key

• Keyhasnotbeengenerated foroneof the installedArchitectures (no licensemanagerable to load this license)

2.2. Licenses 9
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Fig. 5: Invalid License Key Error Message

2.2.3 Production Licenses

This section should be considered when using Production Architectures, which use hardware license keys stored
on a USB dongle.

Fig. 6: MicroEJ USB Dongle

Note: If your USB dongle has been provided to you by your sales representative and you don’t have received an
activation certificate by email, itmay be a pre-activated dongle. Then you can skip the activation steps and directly
jump to the Check Activation on MicroEJ SDK section.

Request your Activation Key

• Go to license.microej.com.

• Click on Create a new account link.

• Create your account with a valid email address. You will receive a confirmation email a few minutes a�er.
Click on the confirmation link in the email and login with your new account.

• Click on Activate a License .

• Set Product P/N: to The P/N on the activation certificate.

2.2. Licenses 10
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• Enter your UID: serial number printed on the USB dongle label (8 alphanumeric char.).

• Click on Activate and check the confirmation message.

• Click on Confirm your registration .

• Enter the Registration Code provided on the activation certificate.

• Click on Submit .

• Your Activation Key will be sent to you by email as soon as it is available (12 business hours max.).

Note: You can check the My Products page to verify your product registration status, the Activation Key avail-
ability, and download the Activation Key when available.

Once the Activation Key is available, download and save the Activation Key ZIP file to a local directory.

Activate your USB Dongle

This section contains instructions that will allow you to flash your USB dongle with the proper activation key.

You shall ensure that the following prerequisites are met :

• Your operating system is Windows

• The USB dongle is plugged and recognized by your operating system (see Troubleshooting section)

• Nomore than one USB dongle is plugged into the computer while running the update tool

• The update tool is not launched from a network drive or a USB key

• The activation key you downloaded is the one for the dongle UID on the sticker attached to the dongle (each
activation key is tied to the unique hardware ID of the dongle).

You can then proceed to the USB dongle update:

• Unzip the Activation Key file to a local directory

• Enter the directory just created by your ZIP extraction tool.

• Launch the executable program.

• Accept running the unsigned so�ware if requested (Windows 10)

2.2. Licenses 11
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• Click on the Update button (no password needed)

Fig. 7: Dongle Update Tool

• On success, an Update successfully message shall appear. On failure, an Error key or no proper
rockey message may appear.

2.2. Licenses 12
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Fig. 8: Successful Dongle Update

Check Activation on MicroEJ SDK

Note: Production licenseswill be shownonly if at least oneProductionArchitecture or Platformhasbeen imported
before (see License Manager Overview).

• Go back to MicroEJ SDK,

• Go to Window > Preferences > MicroEJ ,

• Go to Architectures or Platforms sub-menu and check that all Production Architectures or Platforms are
now activated (green check).

Fig. 9: Platform License Status OK

Troubleshooting

This section contains instructions to check that your operating system correctly recognizes your USB dongle.

GNU/Linux Troubleshooting

For GNU/Linux Users (Ubuntu at least), by default, the dongle access has not been granted to the user, you have to
modify udev rules. Please create a /etc/udev/rules.d/91-usbdongle.rules file with the following contents:

2.2. Licenses 13
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ACTION!="add", GOTO="usbdongle_end"
SUBSYSTEM=="usb", GOTO="usbdongle_start"
SUBSYSTEMS=="usb", GOTO="usbdongle_start"
GOTO="usbdongle_end"

LABEL="usbdongle_start"

ATTRS{idVendor}=="096e" , ATTRS{idProduct}=="0006" , MODE="0666"

LABEL="usbdongle_end"

Then, restart udev: /etc/init.d/udev restart

You can check that the device is recognized by running the lsusb command. The output of the command should
contain a line similar to the one below for each dongle: Bus 002 Device 003: ID 096e:0006 Feitian
Technologies, Inc.

Windows Troubleshooting

• If the dongle activation failed with No rockey message, check there is one and only one dongle recognized
with the following hardware ID :

HID\VID_096E&PID_0006&REV_0201

Go to the Device Manager > Human Interface Devices and check among the USB Input Device entries

that the Details > Hardware Ids property match the ID mentioned before.

• If the dongle activationwas successful with Update successfully message but the license does not appear
inMicroEJSDKor isnotupdated, try toactivateagainby starting theexecutablewithadministratorprivileges:

• If the following error message is thrown when building a MicroEJ Firmware, either the dongle plugged is a
verbatim dongle or it has not been successfully activated:

Invalid license check (Dongle found is not compatible).

VirtualBox Troubleshooting

In a VirtualBox virtual machine, USB drives must be enabled to be recognized correctly. Make sure to enable the
USB dongle by clicking on it in the VirtualBox menu Devices > USB .

To make this setting persistent, go to Devices > USB > USB Settings. . . and add the USB dongle in the

USB Devices Filters list.

2.2. Licenses 14
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2.3 MicroEJ Runtime

2.3.1 Language

MicroEJ is compatible with the Java language version 7.

Java source code is compiled by the Java compiler1 into the binary format specified in the JVM specification2. This
binary code needs to be linked before execution: .class files and some other application-related files (see MicroEJ
Classpath) are compiled to produce the final application that the MicroEJ Runtime can execute.

MicroEJ complies with the deterministic class initialization (<clinit>) order specified in [BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

2.3.2 Scheduler

The MicroEJ Architecture features a green thread platform that can interact with the C world [SNI]. The (green)
thread policy is as follows:

• preemptive for di�erent priorities,

• round-robin for same priorities,

• “priority inheritance protocol” when priority inversion occurs.3

MicroEJ stacks (associatedwith the threads) automatically adapt their sizes according to the thread requirements:
Once the thread has finished, its associated stack is reclaimed, freeing the corresponding RAMmemory.

2.3.3 Garbage Collector

The MicroEJ Architecture includes a state-of-the-art memory management system, the Garbage Collector (GC).
It manages a bounded piece of RAM memory, devoted to the Java world. The GC automatically frees dead Java
objects, anddefragments thememory in order to optimizeRAMusage. This is done transparentlywhile theMicroEJ
Applications keep running.

2.3.4 Foundation Libraries

Embedded Device Configuration (EDC)

The Embedded Device Configuration specification defines theminimal standard runtime environment for embed-
ded devices. It defines all default API packages:

• java.io

• java.lang

• java.lang.annotation

• java.lang.ref

• java.lang.reflect
1 The JDT compiler from the Eclipse IDE.
2 Tim Lindholm & Frank Yellin, The Java™ Virtual Machine Specification, Second Edition, 1999
3 This protocol raises the priority of a thread (that is holding a resource needed by a higher priority task) to the priority of that task.
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• java.util

Beyond Profile (BON)

[BON] defines a suitable and flexible way to fully control both memory usage and start-up sequences on devices
with limited memory resources. It does so within the boundaries of Java semantics. More precisely, it allows:

• Controlling the initialization sequence in a deterministic way.

• Defining persistent, immutable, read-only objects (that may be placed into non-volatile memory areas), and
which do not require copies to be made in RAM to bemanipulated.

• Defining immortal, read-write objects that are always alive.

• Defining and accessing compile-time constants.

2.4 MicroEJ Libraries

A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-dependent
functionality. A Foundation library is divided into an API and an implementation. A Foundation library API is com-
posed of a name and a 2 digits version (e.g. EDC-1.3 ) and follows the semantic versioning (http://semver.org)
specification. A Foundation Library API only contains prototypes without code. Foundation Library implementa-
tions are provided by MicroEJ Platforms. From a MicroEJ Classpath, Foundation Library APIs dependencies are
automaticallymapped to the associated implementations provided by the Platform or the Virtual Device onwhich
the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Libraries (100%
full Java code). A MicroEJ Add-On Library is distributed in a single JAR file, with a 3 digits version and provides its
associated source code.

Foundation and Add-On Libraries are added to MicroEJ Classpath by the application developer as module depen-
dencies (seeMicroEJ Module Manager).

Fig. 10: MicroEJ Foundation Libraries and Add-On Libraries

MicroEJ Corp. provides a large number of libraries through the MicroEJ Central Repository. To consult its libraries
APIs documentation, please visit https://developer.microej.com/microej-apis/.

2.5 MicroEJ Central Repository

2.5.1 Introduction

The MicroEJ Central Repository is themodule repository distributed and maintained by MicroEJ Corp. It contains
Foundation Library APIs and numerous Add-On Libraries.
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2.5.2 Use

Bydefault,MicroEJSDK is configured toconnectonlineMicroEJCentralRepository. TheMicroEJCentralRepository
can be downloaded locally for o�line use. Please follow the steps described at https://developer.microej.com/
central-repository/.

You can also manually browse the repository at https://repository.microej.com/modules/.

2.5.3 Content Organization

The following table describes how are organized themodules natureswithin the repository.

Table 1: MicroEJ Central Repository Organization
Organization Module Nature

ej.api , com.microej.api
Foundation Library API

com.microej.architecture
MicroEJ Architecture

com.microej.pack
MicroEJ Pack

ej.tool , com.microej.tool
Tool or Add-On processor

Any other Add-On Library

2.5.4 Javadoc

To consult the APIs documentation (Javadoc) of all libraries available in the repository, please visit https://
repository.microej.com/javadoc/microej_5.x/apis/.

2.6 Embedded Specification Requests

MicroEJ implements the following ESR Consortium specifications:

[BON] http://e-s-r.net/download/specification/ESR-SPE-0001-BON-1.2-F.pdf
[SNI] http://e-s-r.net/download/specification/ESR-SPE-0012-SNI_GT-1.2-H.pdf
[SP] http://e-s-r.net/download/specification/ESR-SPE-0014-SP-2.0-A.pdf
[MUI] http://e-s-r.net/download/specification/ESR-SPE-0002-MICROUI-2.0-B.pdf
[KF] http://e-s-r.net/download/specification/ESR-SPE-0020-KF-1.4-F.pdf

2.7 MicroEJ Firmware

2.7.1 Bootable Binary with Core Services

A MicroEJ Firmware is a binary so�ware program that can be programmed into the flash memory of a device. A
MicroEJ Firmware includes an instance of a MicroEJ runtime linked to:

• underlying native libraries and BSP + RTOS,

• MicroEJ libraries and application code (C and Java code).
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Fig. 11: MicroEJ Firmware Architecture

2.7.2 Specification

The set of libraries included in the firmware and its dimensioning limitations (maximum number of simulta-
neous threads, open connections, . . . ) are firmware specific. Please refer to https://developer.microej.com/5/
getting-started-studio.html for evaluation firmware release notes.

2.8 MicroEJ SDK

MicroEJ SDK provides tools based on Eclipse to develop so�ware applications for MicroEJ-ready devices. MicroEJ
SDK allows application developers to write MicroEJ Applications and run them on a virtual (simulated) or real de-
vice.

This document is a step-by-step introduction to application development with MicroEJ SDK. The purpose of
MicroEJ SDK is to develop for targeted MCU/MPU computers (IoT, wearable, etc.) and it is therefore a cross-
development tool.

Unlike standard low-level cross-development tools, MicroEJ SDK o�ers unique services like hardware simulation
and local deployment to the target hardware.

Application development is based on the following elements:

• MicroEJ SDK, the integrated development environment for writing applications. It is based on Eclipse and is
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ SDK (since 20.10 ) is built on
top of Eclipse 2020-06.
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• MicroEJ Platform, a so�ware package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are imported into MicroEJ SDK within a
local folder called MicroEJ Platforms repository. Once a MicroEJ Platform is imported, an application can be
launched and tested on Simulator. It also provides a mean to locally deploy the application on a MicroEJ-
ready device.

• MicroEJ-ready device, an hardware device that will be programmed with a MicroEJ Firmware. A MicroEJ
Firmware is a binary instance of MicroEJ runtime for a target hardware board.

Starting fromscratch, the steps togo through thewholeprocessaredetailed in the followingsectionsof this chapter
:

• Download and install a MicroEJ Platform

• Build and run your first Application on Simulator

• Build and run your first Application on Device

For further information on the SDK installation and releases, you can check these chapters:

2.8.1 Release Notes

Starting fromMicroEJ version 5.0.0 , MicroEJ Architectures are distributed separately fromMicroEJ SDK. MicroEJ
Evaluation Architectures can be downloaded from the Architectures Repository.

MicroEJ Studio (resp. SDK) is now packaged into an Eclipse P2 repository (https://repository.microej.com/p2/
studio), allowing partial updates and installation on any compatible Eclipse version. The historical version ( 5 )
of MicroEJ is reused for the P2 repository delivery.

MicroEJ continues to regularly build all-in-one packages, called Distributions, including an Eclipse base version,
various utility plugins, and dedicatedOS installers. This distribution has a separate versioning, which followsmod-
ern convention: [YY].[MM] .

2.8.2 MicroEJ SDK Distribution Changelog

[21.03] - 2021-03-25

• IncludedMicroEJ Studio / SDK 5.4.0

KNOWN ISSUES:

• SeeMicroEJ Studio / SDK 5.4.0 Known Issues section

[20.12] - 2020-12-11

• IncludedMicroEJ Studio / SDK 5.3.1

• Disabled Java version checkwhenupdatingMicroEJ Studio/SDK (see known issues of Studio/SDKDistribution
20.10)

[20.10] - 2020-10-30

• IncludedMicroEJ Studio / SDK 5.3.0

• Updated to Eclipse version 2020-06

• Fixed low quality MacOS SDK icons
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NOTE: Starting with this release, only 64bits JRE are supported because 32bits JRE support has been removed
since Eclipse version 2018-12 . See this link for more details.

KNOWN ISSUES:

• Projects configuredwith Null Analysis must be updated to import EDC API 1.3.3 or higher in order to avoid an
Eclipse JDT builder error (see also this link for more details).

• The default settings file for connecting MicroEJ Central Repository is not automatically installed. To connect
to the MicroEJ Central Repository, follow the procedure:

– For Windows, create the folder: C:\Users\%USERNAME%\.microej .

– For Linux, create the folder: /home/$USER/.microej .

– For macos, create the folder: /Users/$USER/.microej .

– Download and save this file microej-ivysettings-5.xml to the previously created .microej folder.

• By default, a check is done on the JRE version required by the plugins on install/update. Since CDT re-
quires JRE 11, it prevents to install/update a newer MicroEJ SDK version. The CDT documentation ex-
plains that this can be bypassed by disabling the option Windows > Preferences > Install/Update

> Verify provisioning operation is compatible with currently running JRE .

[20.07] - 2020-07-28

• IncludedMicroEJ Studio / SDK 5.2.0

• Updated thedefaultmicroej repository foldername (replacedMicroEJStudio/SDKversionby thedistribution
number)

• Added Dist. prefix in installer name (e.g. MicroEJ SDK Dist. 20.07 ) to avoid confusion betweenMicroEJ
SDK distribution vs MicroEJ SDK version

• Updated MicroEJ SDK and MicroEJ Studio End User License Agreement

• Disabled popup windowwhen installing a MicroEJ SDK update site (allow to install unsigned content by de-
fault)

[19.05] - 2019-05-17

• IncludedMicroEJ Studio / SDK version 5.1.0

• Updated MicroEJ icons ( 16x16 and 32x32 )

• Updated the publisher of Windows executables ( MicroEJ instead of IS2T SA. )

• Updated the JRE link to download in case the default JRE is not compatible. ( https://www.java.com is
deprecated)

[19.02] - 2019-02-22

• Updated to Eclipse Oxygen version 4.7.2

• IncludedMicroEJ Studio / SDK version 5.0.1

• Included Sonarlint version 4.0.0
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2.8.3 MicroEJ SDK Changelog

MicroEJ SDK includes all MicroEJ Studio features.

A line prefixed by [Studio] is valid for bothMicroEJ Studio andMicroEJ SDK. A line prefixed by [SDK] is only valid
for MicroEJ SDK.

[5.4.1] - 2021-04-16

NOTE: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous MicroEJ Studio / SDK Distribution.

MicroEJ Module Manager

• [Studio] Fixed missing repository configuration in artifact-repository skeleton (this configuration
is required to include modules bundled in an other module repository)

• [Studio] Fixed missing some old build types versions that were removed by error. (introduced in MicroEJ
SDK 5.4.0 , please refer to the Known Issues section for more details)

• [Studio] Fixed wrong version of module built in a meta-build (module was published with themodule ver-
sion instead of the snapshot version)

• [Studio] Fixed code coverage analysis on source code (besides on bytecode) thanks to the property cc.
src.folders (only for architectures in version 7.16.0 and beyond)

[5.4.0] - 2021-03-25

NOTE: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous MicroEJ Studio / SDK Distribution.

Known Issues

• Some older build types versions have been removed by error. Consequently, using MicroEJ SDK 5.4.0 , it
maybenotpossible tobuildmodules thathavebeencreatedwithanolderMicroEJSDKversion (Forexample,
MicroEJ GitHub code). The list of missing build types:

– [Studio] build-application 7.0.2

– [Studio] build-microej-javalib 4.1.1

– [SDK] build-firmware-singleapp 1.2.10

– [SDK] build-microej-extension 1.3.2

General

• [Studio] Added MicroEJ Module Manager Command Line Interface in Build Kit

• [Studio] Added ignore optional compilation problems in Addon Processor generated source folders

• [Studio] Added logs to Standalone Application build indicating themapping of Foundation Libraries to the
Platform

• [SDK] Updated End User License Agreement
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• [SDK] Added the latest HIL Engine API to mock-up skeleton (native resources management)

• [SDK] Update the Architecture import wizard to automatically accept Pack licenses when the Architecture
license is accepted

MicroEJ Module Manager

General

• [Studio] Added JSCH library to execute MicroEJ test suites on Device through ssh

• [Studio] Added pre-compilation phase before executing Addon Processor to have compiled classes avail-
able

• [Studio] Updated the default settings file to import modules from MicroEJ Developer repository (located
at ${user.dir}\.microej\microej-ivysettings-5.4.xml )

Build Types

• [Studio] Updated all relevant build types to load the Platform using the platform configuration instead
of the test configuration:

– Sandboxed Application ( application )

– Foundation Library Implementation ( javaimpl )

– Addon Library ( javalib )

– MicroEJ Testsuite ( testsuite )

• [Studio] Updated Module Repository to allow to partially include a MicroEJ Architecture module ( eval
and/or prod )

• [Studio] Fixed potential Addon Processor error NoClassDefFoundError: ej/tool/addon/util/Message
depending on the resolution order

• [SDK] Removed javadoc generation for microej-extension

Build Plugins

• [Studio] Updated Addon Processor to fail the build when an error is detected. Error messages are dumped
to the build logs.

• [Studio] Updated Platform Loader to handle Platformmodule ( .zip file)

• [Studio] Updated Platform Loader to handle Virtual Device module ( .vde file) declared as a dependency.
It worked before only by using the dropins folder.

• [Studio] Updated Platform Loader to list the Platforms locations when too many Platform modules are
detected

Skeletons

• [Studio] Fixed wrong README.md generation for artifact-repository skeleton

• [SDK] Removed useless files in microej-javaapi , microej-javaimpl and microej-extension skeletons
(intern changelog and .dbk file)
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[5.3.1] - 2020-12-11

NOTE: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous MicroEJ Studio/SDK Distribution.

General

• [Studio] Fixedmissing default settings file for connecting MicroEJ Central Repository when starting a fresh
install (introduced in 5.3.0 )

MicroEJ Module Manager

Build Plugins

• [Studio] Fixed potential build error when computing Sonar classpath fromdependencies ( ivy:cachepath
task was sometimes using a wrong cache location)

Skeletons

• [Studio] Fixed skeleton dependency to EDC-1.3.3 to avoid an Eclipse JDT builder error when Null Analysis
is enabled (see known issues of Studio/SDK Distribution 20.10)

[5.3.0] - 2020-10-30

NOTE: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous MicroEJ Studio / SDK Distribution.

Known Issues

• [Studio] Librarymodule buildmay lead to unexpected Unresolved Dependencies error in some cases (in
sonar:init target / ivy:cachepath task). Workaround is to trigger the library build again.

General

• [Studio] Fixed various plugins for Eclipse version 2020-06 compatibility (icons, project explorer menu
entries)

• [Studio] Fixed closedmodule.ivy files a�er an SDK restart that were opened before

• [Studio] Removed license check before launching an Application on Device

• [Studio] Disabled Activate on new event option of the Error Log view to prevent popup of this view
when an internal error is thrown

• [SDK] Removed license check before Platform build

• [SDK] Updated filter of the Launch Group configuration (exclude the deprecated Eclipse CDT one)

• [SDK] Fixed inclusion of mock project dependencies in launcher mock classpath

• [SDK] Enhance error message in Platform editor ( .platform files) when the required Architecture has not
been imported (displays Architecture information)
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MicroEJ Module Manager

General

• [Studio] Fixed workspace default settings file when clicking on the Default button

• [Studio] First wrong resolved dependencywhen ChainResolver returnFirst option is enabled and themod-
ule to resolve is already in the cache

• [Studio] Fixedpotential buildmodule crash (Not comparable issue)when resolvingmoduledependencies
across multiple configurations

Build Types

• [Studio] Exclude packs from artifact checker when building a module repository

• [Studio] Merged Foundation & Add-On Libraries javadoc when building a module repository

• [Studio] Added Module dependency line for each type in module repository javadoc

• [Studio] Added an option to skip deprecated types, fields, methods in module repository javadoc

• [Studio] Allow to include or exclude Java packages in module repository javadoc

• [Studio] Added an option skip.publish to skip artifacts publication in build-custom build type

• [Studio] Allow to define Application options from build option using the platform-launcher.inject.
prefix

• [Studio] Added generation and publication of code coverage report a�er a testsuite execution. The report
generation is enabled under the following conditions:

– at least one test is executed,

– tests are executed on Simulator,

– build option s3.cc.activated is set to true (default),

– the Platform is based on an Architecture version 7.12.0 or higher

– if testing a Foundation Library (using microej-testsuite ), build option microej.testsuite.cc.
jars.name.regex must be set to match the simple name of the library being covered (e.g. edc-*.jar
or microui-*.jar )

• [Studio] Fixed sonar false negative Null Analysis detection in some cases

• [SDK] Added a better error message for Studio rebrand build when izpack.microej.product.location
option is missing

• [SDK] Deprecated build-microej-ri and disabled documentation generation (useless docbook
toolchains have been removed to reduce the bundle size: -150MB )

Skeletons

• [Studio] Fixed microej-mock content script initialization folder name
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[5.2.0] - 2020-07-28

General

• [Studio] Added Dist. prefix in default workspace and repository name to avoid confusion between Mi-
croEJ SDK distribution vs MicroEJ SDK version

• [Studio] Replaced Version by Dist. in Help > About MicroEJ® SDK | Studio menu. The MicroEJ SDK
or Studio version is available in Installation Details view.

• [Studio] Replaced IS2T S.A. and MicroEJ S.A. by MicroEJ Corp. in Help >

About MicroEJ® SDK | Studio menu.

• [Studio] Updated Front Panel plugin to version 6.1.1

• [Studio] Removed MicroEJ Copyright in Java class template and skeletons files

• [Studio] Fixed Stopping a MicroEJ launch in the progress view doesn’t stop the launch

MicroEJ Module Manager

General

• [Studio] Added a new configuration page ( Window > Preferences > Module Manager ). This page is
a merge of formerly named Easyant4Eclipse preferences page and Ivy Settings relevant options for
MicroEJ.

• [Studio] Added Export > MicroEJ > Module Manager Build Kit wizard, to extract the files required for
automating MicroEJ modules builds out of the IDE.

• [Studio] Added New > MicroEJ > Module Project wizard (formerly named New Easyant Project ),
with module fields content assist and alphabetical sort of the skeletons list

• [Studio] Added Import > MicroEJ > Module Repository wizard to automatically configureworkspace
with a module repository (directory or zip file)

• [Studio] Added NewMicroEJ Add-On Library Project wizard to simplify MicroEJ Add-On library skeleton
project creation

• [Studio] Updated the build repository ( microej-build-repository.zip ) to be self contained with its
owns ivysettings.xml

• [Studio] Updated Virtual Device Player ( firmware-singleapp ) launcher-windows.bat (use
launcher-windows-verbose.bat to get logs)

• [Studio] Renamed the classpath container to Module Dependencies instead of Ivy

• [Studio] FixedAddonProcessor src-adpgenerated folder generationwhencreatingor importing aproject
with the same name than a previously deleted one

• [Studio] Fixed implementation of settings ChainResolver returnFirst option

• [Studio] Fixed Ivy module resolution being blocked from time to time
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Build Types

• [Studio] Fixed meta build to publish correct snapshot revisions for built dependencies. (Indirectly fixes
ADP resolution issue when an Add-On Library and its associated Addon Processor were built together using
a meta build)

• [Studio] Fixed potential infinite loop when building a Modules Repository with MMM semantic enabled

• [Studio] Fixed javadoc not being generated in artifactory repository build when skip.javadoc is set to
false

• [Studio] Added thecapability tobuildpartialmodules repository, byusing theuserprovided ivysettings.
xml file to check the repository consistency

• [Studio] Added the possibility to partially extend the build repository in a module repository. The build
repository can be referenced by a file system resolver using the property ${microej-build-repository.
repo.dir}

• [Studio] Added the possibility to include a module repository into an other module repository (using new
configuration repository->* )

• [SDK] Added the possibility to bundle a set of Virtual Deviceswhen building a brandedMicroEJ Studio. They
are automatically imported to the MicroEJ repository when booting on a newworkspace.

• [SDK] Added the possibility to bundle a Module Repository when building a branded MicroEJ Studio. It is
automatically imported and settings file is configured when booting on a newworkspace.

Build Plugins

• [Studio] Added variables @MMM_MODULE_ORGANISATION@ , @MMM_MODULE_NAME@ and
@MMM_MODULE_VERSION@ for README.md file

• [SDK] Fixed microej-kf-testsuite repository access issue (introduced in MicroEJ SDK 5.0.0 ).

• [Studio] Fixed artifact-checker to accept revisions surrounded by brackets (as specified by https://
keepachangelog.com/en/1.0.0/)

Skeletons

• [Studio] Updated module.ivy indentation characters with tabs instead of spaces

• [Studio] Updated CHANGELOG.md formatting

• [Studio] Updated and standardized README.md files

• [Studio] Updated dependencies in module.ivy to use the latest versions

• [Studio] Added .gitignore to ignore the target~ and src-adpgenerated folder where the module is
built

• [Studio] Added Sandboxed Application WPK dropins folder ( META-INF/wpk )

• [Studio] Removed conf provided in module.ivy for foundation libraries dependencies

• [Studio] Remove MicroEJ internal site reference in module.ant file

• [Studio] Fixed corrupted library workbenchExtension-api.jar in microej-extension skeleton

• [Studio] Fixed corrupted library HILEngine.jar in microej-mock skeleton

• [Studio] Fixed javadoc content issue in Main class firmware-singleapp skeleton
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Misc

• [Studio] Updated End User License Agreement

• [SDK] Added support for generating Application Options in reStructured Text format

[5.1.2] - 2020-03-09

MicroEJ Module Manager

• [Studio] Fixedpotential build errorwhen generating fixeddependencies file ( fixdeps taskwas sometimes
using a wrong cache location)

• [Studio] Fixed topogical sort of classpath dependencies when building using Build Module (same as in
IvyDE classpath sorted view)

• [Studio] Fixed resolution of modules with a version 0.m.p when transitively fetched (an error was thrown
with the range [1.m.p-RC,1.m.(p+1)-RC[ )

• [Studio] Fixedmissing classpathdependencies toprevent anerrorwhenbuildinga standardJARwith JUnit
tests

[5.1.1] - 2019-09-26

General

• [SDK] Fixed files locked in Platform in workspace projects preventing the Platform from being deleted
or rebuilt

[5.1.0] - 2019-05-17

General

• [Studio] Updated MicroEJ icons ( 16x16 and 32x32 )

• [Studio] Fixedpotential long-blocking operationwhen launching an application ona Virtual Device onWin-
dows 10 (Windows defender performs a slow analysis on a zip file when it is open for the first time since OS
startup)

• [Studio] Fixed missing ADP resolution on a fresh MicroEJ installation

• [Studio] Fixed ADP source folders order generation in .classpath (alphabetical sort of the ADP id)

• [Studio] Fixed Run As. . . > MicroEJ Application automatic launcher creation: when selecting a
Platform in workspace , an other platform of the repository was used instead

• [Studio] Fixed Memory Map Analyzer load of mapping scripts from Virtual Devices

• [Studio] Fixed MMM and ADP resolution when importing a zip project in a fresh MicroEJ install

• [Studio] Fixed ADP crash when a project declares dependencies without a source folder

• [Studio] Fixed inability to debug anapplicationona Virtual Device if option execution.mode was specified
in firmware build properties (now Studio options cannot be overridden)

• [SDK] Updated Front Panel plugin to comply with the new Front Panel engine
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– The Front Panel engine has been refactored and moved from UI Pack to Architecture (UI pack 12.0.0
requires Architecture 7.11.0 or higher)

– New Front Panel Project wizard now generates a project skeleton for this new Front Panel engine,
based on MMM

– Legacy Front Panel projects for UI Pack v11.1.0 or higher are still valid

• [SDK] Updated Virtual Device builder to speed-up Virtual Device boot time (System Applications are now
extracted at build time)

• [SDK] Fixed inability to select a Platform in workspace in a MicroEJ Tool launch configuration

• [SDK] Fixed broken title in MicroEJ export menu (Platform Export)

MicroEJ Module Manager

Build Plugins

• [Studio] Added a new option application.project.dir passed to launch scripts with the workspace
project directory

• [Studio] UpdatedMMM to throw a non ambiguous errormessagewhen a module.ivy configured for MMM
declares versions with legacy Ivy range notation

• [Studio] Updated MicroEJ Central Repository cache directory to ${user.dir}\.
microej\caches\repository.microej.com-[version] instead of ${user.dir}\.ivy2

• [Studio] Updated Update Module Dependencies... to be disabledwhen module.ivy cannot be loaded.
The menu entry is now grayed when the project does not declare an IvyDE classpath container

• [Studio] Fixedwrong resolution order when amodule is both resolved in the repository and theworkspace
(the workspace module must always take precedence to the module resolved in the repository)

• [Studio] Fixeduseless unknown resolver trace whencache isusedbymultiple Ivy settings configurations
with di�erent resolver names.

• [Studio] Fixed slow Add-on Processor generation. The classpath passed to ADPmodules could contain the
same entry multiple times, which leads each ADPmodule to process the same classpath multiple times.

• [Studio] Fixed misspelled recommendation message when a build failed

• [Studio] Fixed Update Module Dependencies... tool: wrong ej:match="perfect" added where it was
expected to be compatible

• [Studio] Fixed Update Module Dependencies... tool: parse errorwhen module.ivy contains <artifact
type="rip"/> element

• [Studio] Fixed resolution and publication of a module declared with an Ivy branch

• [Studio] Fixed character '-' rejected in module organisation (according to MMM specification 2.0-B )

• [Studio] Fixed ADP resolution error when the Add-on Processor module was only available in the cache

• [Studio] Fixed potential build crash depending on the build kit classpath order (error was This module
requires easyant [0.9,+] )

• [Studio] Fixed product-java broken skeleton
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Build Types

• [Studio] Updated Platform Loader error message when the property platform-loader.target.
platform.dir is set to an invalid directory

• [Studio] Fixed meta build property substitution in *.modules.list files

• [Studio] Fixed missing publications for README.md and CHANGELOG.md files

• [Studio] Update skeletons to fetch latest libraries (Wadapps Framework v1.10.0 and Junit v1.5.0 )

• [Studio] Updated README.md publication to generate MMM usage and the list of Foundation Libraries de-
pendencies

• [SDK] Added a new build nature for building platform options pages ( microej-extension )

• [SDK] Updated Virtual Device builder to speed-up Virtual Device boot time (System Applications are now
extracted at build time)

• [SDK] Fixed Virtual Device Player builder (dependencies were not exported into the zip file) and updated
firmware-singleapp skeleton with missing configurations

Skeletons

• [Studio] Updated CHANGELOG.md based on Keep a Changelog specification (https://keepachangelog.
com/en/1.0.0/)

• [Studio] Updatedo�linemodule repository skeleton to fetch in adedicated cachedirectory under ${user.
dir}/.microej/caches

[5.0.1] - 2019-02-14

General

• [Studio] Removed Wadapps Code generation (see migration notes below)

• [Studio] Added support for MicroEJ Module Manager semantic (see migration notes below)

• [Studio] Added a dedicated view for Virtual Devices in MicroEJ Preferences

• [Studio] Removed Platform related views andmenus in MicroEJ Studio (Import/Export and Preferences)

• [Studio] Added MicroEJ Studio rebranding capability (product name, icons, splash screen and installer for
Windows)

• [Studio] Added a new meta build version, with simplified syntax for multi-projects build (see migration
notes below)

• [Studio] Added a skeleton for building o�line module repositories

• [Studio] Added support for importing extended characters in Fonts Designer

• [Studio] Allow to import Virtual Devices with .vde extension ( *.jpf import still available for backward
compatibility)

• [Studio] Removed legacy selection for Types, Resources and Immutables in MicroEJ Launch Configuration
(replaced by *.list files since MicroEJ 4.0 )

• [Studio] Enabled IvyDE workspace dependencies resolution by default

• [SDK] Enabled MicroEJ workspace Foundation Libraries resolution by default
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• [SDK] Added possibility for MicroEJ Architectures to check for a minimum required version of MicroEJ SDK
( sdk.min.version property)

• [SDK] Updated New Standalone Application Project wizard to generate a single-app firmware skeleton

• [SDK] Updated Virtual Device Builder to manage Sandboxed Applications (compatible with Architectures
Products *_7.10.0 or newer)

• [SDK] Updated Virtual Device Builder to include kernel options (now options are automatically filled for the
application developer on Simulator)

MicroEJ Module Manager

Build Plugins

• [Studio] Added IvyDE resolution from properties defined in Windows > Preferences > Ant >
Runtime > Properties

• [Studio] Fixed Illegal character in path error that may occur when running an Add-on Processor

• [Studio] Fixed IvyDE crash when defining an Ant property file with Eclipse variables

Build Types

• [Studio] Kept only latest build types versions (skeletons updated)

• [Studio] Updatedmetabuild to execute tests by default for private module dependencies

• [Studio] Removed remaining build dependencies to JDK (Java code compiler and Javadoc processors). All
MicroEJ code is now compiled using the JDT compiler

• [Studio] Introduced a new plugin for executing custom testsuite using MicroEJ testsuite engine

• [Studio] FixedMalformedURLException error in Easyant trace

• [Studio] Fixed Easyant build crash when an Ivy settings file contains a cache definitions with a wildcard

• [SDK] Updated Platform Builder to keep track in the Platform of the architecture on which it has been built
( architecture.properties )

• [SDK] Updated Virtual Device Builder to generate with .vde extension

• [SDK] Updated Multi-app Firmware Builder to embed (Sim/Emb) specific modules (Add-on libraries and
System Applications)

• [SDK] Fixed build-microej-ri v1.2.1 missing dependencies (embedded in SDK 4.1.5)

Skeletons

• [Studio] Updated all skeletons: migrated to latest build types, added more comments, copyright cleanup
and configuration for MicroEJ Module Manager semantic)

• [SDK] Added the latest HIL Engine API to mock-up skeleton (Start and Stop listeners hooks)

2.8. MicroEJ SDK 30



MicroEJ Documentation, Revision 2788b3f4

2.8.4 Advanced Installation Notes

Windows Specifics

If you are using Windows Defender as your default antivirus so�ware, MicroEJ Studio or SDKmay be slow down as
it manipulates lots of JAR files (which are ZIP files) that are regularly analyzed.

To improve MicroEJ Studio or SDK experience, please find below a list of folders that should be excluded from
Windows Defender monitoring:

• %USERPROFILE%\.eclipse

• %USERPROFILE%\.ivy2

• %USERPROFILE%\.microej

• %USERPROFILE%\.p2

• %USERPROFILE%\AppData\Local\Temp\microej

• C:\Program Files\MicroEJ

• your workspace(s) folder(s)

The exclusion page is available in the Settings application ( Windows Security > Virus & threat protection >

Manage settings > Exclusions > Add or remove exclusions ).

Linux Specifics

Starting MicroEJ Studio or SDK on a linux distribution may produce troubles such as missing content pages. This
is related to incomplete Eclipse SWT configuration (see Eclipse GTK wiki page).

One solution is to configure Eclipse as follows:

• Add the next lines to MicroEK-[SDK|Studio].ini , before -vmargs argument:

--launcher.GTK_Version 2

• Ensure GTK is correctly installed ( libwebkitgtk packet)

• Configure the following environment variables

MOZILLA_FIVE_HOME=/usr/lib/mozilla
LD_LIBRARY_PATH=${MOZILLA_FIVE_HOME}:${LD_LIBRARY_PATH}

• Restart MicroEJ Studio/SDK

• Check there is not more SWT/MOZILLA related errors ( Window > Show View > Other. . . > General >
Error Log )

MacOS Specifics

When launching the SDK using the .app file, youmay encounter the following message:

"MicroEJ-SDK-xx.xx" is damaged and can't be opened. You should move it to the Trash.

This is due to MacOS putting applications in quarantine when downloaded with a browser. Use this command to
remove the SDK application from quarantine:
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sudo xattr -rd com.apple.quarantine sdk.app

where sdk.app is the SDK file name.

2.8.5 Migration Notes

From 5.2.x to 5.3.x

This section applies if MicroEJ SDK 5.3.x is started on aworkspace thatwas previously created usingMicroEJ SDK
5.2.x .

Workspacemigration warning

Startingwith theMicroEJ SDKDistribution 20.10, when opening aworkspacewhich has been createdwith an older
MicroEJ Distribution, a message is displayed with the following warning:

The workspace was written with an older version. Continue and update workspace which may make it␣
→˓incompatible with older versions?

This is a generic warning from Eclipse which can be safely ignored as long as you don’t intend to open it back with
an older MicroEJ SDK Distribution then.

From 5.1.x to 5.2.x

This section applies if MicroEJ SDK 5.2.x is started on aworkspace thatwas previously created usingMicroEJ SDK
5.1.x .

Enable NewWizards Shortcuts in MicroEJ Perspective

Eclipse perspective settings are stored in the workspace metadata, so the new wizards shortcuts (
Add-On Library Project and Module Project ) are not visible in the File > New menu.

The MicroEJ perspective must be reset to its default settings as following:

• Click on Windows > Perspective > Open Perspective > Other. . . menu

• Select MicroEJ perspective

• Click on Windows > Perspective > Reset Perspective. . . menu

• Click on Yes button to accept to reset the MicroEJ perspective to its defaults.

The new wizards shortcuts are now visible into File > New menu.

Re-enable the Ivy Preferences Pages (Advanced Use)

The original Window > Preferences > Ivy pages can be re-enabled as following:

• Close all running instances of MicroEJ Studio / SDK

• Edit MicroEJ-[SDK[Studio].ini and add the property -Dorg.apache.ivy.showAdvancedPrefs=true
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• Start MicroEJ Studio / SDK again

• Go to Window > Preferences > Module Manager page

A new link Ivy settings should appear on the bottom of the page. It opens a popupwindowwith the original Ivy
preferences pages.

From 4.1.x to 5.x

This section applies if MicroEJ SDK 5.x is started on a workspace that was previously created using MicroEJ SDK
4.1.x .

Wadapps Application Update

TheWadapps codegenerator hasbeenmoved from IDE to anAddonProcessor comingwith ej.library.wadapps.
framework module ( v1.9.0 or higher is required).

A Wadapps Application Project can be updated as follows:

• Right-click on the project, then Configure > Remove Sandboxed Application Nature

• Right-click on the project, then Configure > Add Sandboxed Application Nature

• Update module.ivy dependency to fetch ej.library.wadapps.framework version 1.9.0 (or perform
MicroEJ Module Manager update as defined below)

• Delete remaining folder src/.generated~ if any

• Check that project compiles and folder src-adpgenerated/wadapps is generated

MicroEJ Module Manager Update

It is highly recommended to migrate module.ivy to the MicroEJ Module Manager semantic, since the default Ivy
resolution will be nomore maintained in future versions.

The module.ivy can be updated as follows:

• Right-click on module.ivy , then Update Module Dependencies. . .

This has for e�ect to both migrate the module.ivy to the MicroEJ Module Manager semantic and also to update
dependencies version to the latest available in the target repository.

Meta build Project Update

A project using microej-meta-build version 1.x can be updated to version 2.x as follows:

• Edit module.ivy

– Replace the microej-meta-build version by 2.0.+

– Update all properties declaration to append the metabuild.inject. prefix (e.g. <ea:property
name="skip.test" value="true" /> must beupdated to <ea:property name="metabuild.inject.
skip.test" value="true" /> )

– Optionally remove or comment the root folder declaration as it is the default. ( <ea:property
name="metabuild.root" value=".." /> )
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• Delete module.properties . It only contains the property easyant.fork.build=true . This property is
now automatically set by easyant-build-component since version 1.12.0 . Otherwise it must be explicitly
injected by the build system as an Ant property: easyant.inject.easyant.fork.build=true

• Extract from override.module.ant the projects declarations lines:

– Extract the project declarations of local.submodule.dirs.id into a new file named private.
modules.list (one project per line)

– Extract the project declarations of submodule.dirs.id into a new file names public.modules.list
(one project per line)

• Delete override.module.ant

The new file system structure shall look like:

metabuild-project
module.ivy
private.modules.list
public.modules.list

2.9 Introducing MicroEJ Studio and Virtual Devices

MicroEJ Studio provides tools based on Eclipse to develop so�ware applications for MicroEJ-ready devices. Mi-
croEJ Studio allows application developers to write MicroEJ Applications, run them on a virtual (simulated) or real
device, and publish them to a MicroEJ Forge instance.

This document is an introduction to application development with MicroEJ Studio. The purpose of MicroEJ Studio
is to develop for targeted MCU/MPU computers (IoT, wearable, etc.) and it is therefore a cross-development tool.

Unlike standard low-level cross-development tools, MicroEJ Studio o�ers unique services like hardware simula-
tion, deployment to the target hardware and final publication to a MicroEJ Forge instance.

Application development is based on the following elements:

• MicroEJ Studio, the integrated development environment for writing applications. It is based on Eclipse and
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (seeMicroEJModuleManager). The current distribution of MicroEJ Studio ( 19.05 ) is built on top of
Eclipse Oxygen (https://www.eclipse.org/oxygen/).

• MicroEJ Virtual Device, a so�ware package including the resources and tools required for building and test-
ing an application for a specific MicroEJ-ready device. A Virtual Device will simulate all capabilities of the
corresponding hardware board:

– Computation and Memory,

– Communication channels (e.g. Network, USB . . . ),

– Display,

– User interaction.

Virtual Devices are imported into MicroEJ Studio within a local folder called MicroEJ Repository. Once a Vir-
tual Device is imported, an application can be launched and tested on Simulator. It also provides a mean to
locally deploy the application on a MicroEJ-ready device.

• MicroEJ-ready device, a hardware device that has been previously programmed with a MicroEJ Firmware. A
MicroEJ Firmware is a binary instance ofMicroEJ runtime for a target hardware board. MicroEJ-ready devices
are built using MicroEJ SDK. MicroEJ Virtual Devices andMicroEJ Firmwares share the same version (there is
a 1:1 mapping).
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The following figure gives an overview of MicroEJ Studio possibilities:

Fig. 12: MicroEJ Application Development Overview

2.10 Perform Online Getting Started

MicroEJ Studio Getting Started is available on https://developer.microej.com/5/getting-started-studio.html.

Starting from scratch, the steps to go through the whole process are:

1. Setup a board and test a MicroEJ Firmware:

• Select between one of the available boards;

• Download and install a MicroEJ Firmware on the target hardware;

• Deploy and run a MicroEJ demo on board.

2. Setup and learn to use development tools:

• Download and install MicroEJ Studio;

• Download and install the corresponding Virtual Device for the target hardware;

• Download, build and run your first application on Simulator;

• Build and run your first application on target hardware.

The following figure gives an overview of the MicroEJ so�ware components required for both host computer and
target hardware:
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Fig. 13: MicroEJ Studio Development Imported Elements

2.11 GitHub Repositories

A large number of examples, libraries, demos and tools are sharedonMicroEJGitHubaccount: https://github.com/
MicroEJ.

Most of these GitHub repositories contain projects ready to be imported in MicroEJ SDK.

2.11.1 Repository Import

This section explains the steps to import a Github repository in MicroEJ SDK, illustrated with the MWT Examples
repository.

Note: MicroEJ SDK Distribution includes the Eclipse plugin for Git.

First, from the GitHub page, copy the repository URI (HTTP address) from the dedicated field in the right menu
(highlighted in red):
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In MicroEJ SDK, to clone and import the project from the remote Git repository into the MicroEJ workspace, select
File > Import > Git > Projects from Git wizard.
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Click Next , select Clone URI , click Next and paste the remote repository address in the URI field. For
this repository, the address is https://github.com/MicroEJ/ExampleJava-MWT.git. If the HTTP address is a valid
repository, the other fields are filed automatically.
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Click Next , select the master branch, click Next and accept the proposed Local Destination by clicking Next
once again.
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Click Next once more and finally Finish . The Package Explorer view now contains the imported projects.
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If you want to import projects from another (GitHub) repository, you simply have to do the same procedure using
the Git URL of the desired repository.

2.11.2 MicroEJ GitHub Badges

MicroEJ GitHub Badges are badges embedded in a README at the root of the repository. They highlight the com-
patibilities of the repository at a quick glance with MicroEJ Architecture, MicroEJ SDK and Graphical User Interface
versions.

The color of the badge has the following meaning:

• Greenmeans a current supported version:

• Orangemeans a still supported version that will be deprecated in the future:

• Gray means a deprecated version:

2.12 System Requirements

MicroEJ SDK and MicroEJ Studio

• Intel x64 PCwithminimum :

– Dual-core Core i5 processor

– 4GB RAM

– 2GB Disk

• Operating Systems :

– Windows 10, Windows 8.1 or Windows 8

– Linuxdistributions (testedonUbuntu 18.04and20.04) - As of SDK20.10 (basedonEclipse 2020-06),
Ubuntu 16.04 is not supported.

– Mac OS X (tested on version 10.13 High Sierra, 10.14 Mojave)

• Java :

– JRE or JDK 8 (Oracle JDK or other OpenJDK build: tested on AdoptOpenJDK/Eclipse Adoptium)

Warning: When installing the AdoptOpenJDK build on Windows, the option JavaSoft (Oracle) registry
keys must be enabled:
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Without this option, the SDK installer cannot find the JRE/JDK and the message The application requires
a Java Runtime Environment 1.8.0 is displayed.

2.13 Get Support

If any questions, feel free to contact our support teamwith the following information (the table below is an exam-
ple):

Delivery Name
MicroEJ SDK Distribution 20.07 / Version 5.2.0 (see Determine the MicroEJ Studio/SDK

Version)
MicroEJ Architecture ARM Cortex-M4 / IAR / Evaluation | Production (seeMicroEJ Architecture)
Platform 1.0.0
Application 1.2.4
Module Repository https://repository.microej.com/packages/repository/2.5.0/microej-5_

0-2.5.0.zip (seeMicroEJ Central Repository)
C compiler IAR 8.40.1
Host Operating System Windows 10 (see System Requirements)
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CHAPTER

THREE

APPLICATION DEVELOPER GUIDE

3.1 Introduction

The following sectionsof this document shall proveuseful as a referencewhendevelopingapplications forMicroEJ.
They cover concepts essential to MicroEJ Applications design.

In addition to these sections, by going to https://developer.microej.com/, you can access a number of helpful re-
sources such as:

• Libraries from the MicroEJ Central Repository (https://developer.microej.com/central-repository/);

• Application Examples as source code fromMicroEJ Github Repositories (https://github.com/MicroEJ);

• Documentation (HOWTOs, Reference Manuals, APIs javadoc. . . ).

MicroEJ Applications are developed as standard Java applications on Eclipse JDT, using Foundation Libraries. Mi-
croEJ SDK allows you to run / debug / deploy MicroEJ Applications on a MicroEJ Platform.

Two kinds of applications can be developed on MicroEJ: MicroEJ Standalone Applications and MicroEJ Sanboxed
Applications.

A MicroEJ Standalone Application is a MicroEJ Application that is directly linked to the C code to produce a Mi-
croEJ Firmware. Such application must define a main entry point, i.e. a class containing a public static void
main(String[]) method. MicroEJ Standalone Applications are developed using MicroEJ SDK.

A MicroEJ Sandboxed Application is a MicroEJ Application that can run over a Multi-Sandbox Firmware. It can be
linked either statically or dynamically. If it is statically linked, it is then called a System Application as it is part of
the initial image and cannot be removed. MicroEJ Sandboxed Applications are developed using MicroEJ Studio.

3.2 Local Workspaces and Repositories

When starting MicroEJ SDK, it prompts you to select the last used workspace or a default workspace on the first
run. A workspace is a main folder where to find a set of projects containing MicroEJ source code.

When loading a new workspace, MicroEJ SDK prompts for the location of the MicroEJ repository, where the Mi-
croEJ Architectures, Platforms or Virtual Devices will be imported. By default, MicroEJ SDK suggests to point to
the default MicroEJ repository on your operating system, located at ${user.home}/.microej/repositories/
[version] . You can select an alternative location. Another common practice is to define a local repository relative
to the workspace, so that the workspace is self-contained, without external file system links and can be shared
within a zip file.
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3.3 Standalone Application

3.3.1 MicroEJ Platform Import

A MicroEJ Platform is required to run a MicroEJ Standalone Application on the Simulator or build the Firmware
binary for the target device.

The Platform Developer Guide describes how to create a MicroEJ Platform from scratch for any kind of device. In
addition, MicroEJ Corp. provides Platforms for various development boards (see https://repository.microej.com/
index.php?resource=JPF).

MicroEJ Platforms are distributed in two packages:

• Source Platform. The source files are imported into the workspace. This is the default case.

• Binary Platform. A .jpf file is imported into theMicroEJ repository. As of MicroEJ SDK 5.3.0 , this package
is deprecated.

Source Platform Import

Import from Folder

This section applies when the Platform files are already available on a local folder. This is likely the case when the
files are checked out from a Version Control System, such as a local git repository clone.

Note: If you are going to import a Platform from MicroEJ Github, you can follow the specific GitHub Repositories
section instead (the projects will be automatically imported).

• Select File > Import. . . > General > Existing Projects into Workspace > Select root directory >

Browse. . . .

• Select the root directory. The wizard will automatically discover projects to import.

• Click on the Finish button.

Import from Zip File

This section applies when the Platform files are packaged in a .zip file.

• Select File > Import. . . > General > Existing Projects into Workspace > Select archive file >

Browse. . . .

• Select the zip of the project (e.g., x.zip ). The wizard will automatically discover projects to import.

• Click on the Finish button.

Platform Build

MicroEJ Platforms are usually shared with only the Platform configuration files. Once the projects are imported,
follow the platform-specific documentation to build the Platform.

Once imported or built, a Platform project should be available as follows:
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Fig. 1: MicroEJ Platform Project

The source folder contains the Platform content which can be set to the target.platform.dir option.

Binary Platform Import

A�erdownloading theMicroEJPlatform .jpf file, launchMicroEJSDKand follow these steps to import theMicroEJ
Platform:

• Open the Platform view in MicroEJ SDK, select Window > Preferences > MicroEJ > Platforms . The
view should be empty on a fresh install of the tool.

Fig. 2: MicroEJ Platform Import

• Press Import. . . button.

• Choose Select File. . . and use the Browse option to navigate to the .jpf file containing your MicroEJ
Platform, then read and accept the license agreement to proceed.
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Fig. 3: MicroEJ Platform Selection

• The MicroEJ Platform should now appear in the Platforms view, with a green valid mark.
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Fig. 4: MicroEJ Platform List

3.3.2 Build and Run an Application

Create a MicroEJ Standalone Application

• Create a project in your workspace. Select File > New > Standalone Application Project .

Fig. 5: New MicroEJ Standalone Application Project

• Fill in the application template fields, the Project name field will automatically duplicate in the following
fields. Click on Finish . A template project is automatically created and ready to use, this project already
contains all folders wherein developers need to put content:

– src/main/java : Folder for future sources

– src/main/resources : Folder for future resources (images, fonts, etc.)
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– META-INF : Sandboxed Application configuration and resources

– module.ivy : Ivy input file, dependencies description for the current project

• Right clickon the source folder src/main/java andselect New > Package . Giveaname: com.mycompany

. Click on Finish .

Fig. 6: New Package

• The package com.mycompany is available under src/main/java folder. Right click on this package and
select New > Class . Give a name: Test and check the box public static void main(String[]

args) . Click on Finish .
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Fig. 7: New Class

• The new class has been created with an empty main() method. Fill the method body with the following
lines:

System.out.println("hello world!");
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Fig. 8: MicroEJ Application Content

The test application is now ready to be executed. See next sections.

Run on the Simulator

To run the sample project on Simulator, select it in the le� panel then right-click and select Run > Run as >
MicroEJ Application .
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Fig. 9: MicroEJ Development Tools Overview

MicroEJ SDK console will display Launch steps messages.

=============== [ Initialization Stage ] ===============
=============== [ Launching on Simulator ] ===============
hello world!
=============== [ Completed Successfully ] ===============

SUCCESS

Run on the Hardware Device

Compile an application, connect the hardware device and deploy on it is hardware dependant. These steps are
described in dedicated documentation available inside the MicroEJ Platform. This documentation is accessible
from the MicroEJ Resources Center view.

Note: MicroEJ Resources Center view may have been closed. Click on Help > MicroEJ Resources Center to
reopen it.
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Open the menu Manual and select the documentation [hardware device] MicroEJ Platform , where
[hardware device] is the name of the hardware device. This documentation features a guide to run a built-in
application on MicroEJ Simulator and on hardware device.

Fig. 10: MicroEJ Platform Guide

3.3.3 Build Output Files

When building aMicroEJ Application, multiple files are generated next to the ELF file. These files are generated in a
folderwhich is named like themain typeandwhich is located in theoutput folder specified in the run configuration.

The following image shows an example of output folder:

Fig. 11: Build Output Files

3.3. Standalone Application 52



MicroEJ Documentation, Revision 2788b3f4

The SOARMap File

The SOAR.map file lists every embedded symbol of the application (section, Java class ormethod, etc.) and its size
in ROM or RAM. This file can be opened using theMemory Map Analyzer.

The embedded symbols are grouped intomultiple categories. For example, the Object class and its methods are
grouped in the LibFoundationEDC category. For each symbol or each category, you can see its size in ROM ( Image
Size ) and RAM ( Runtime Size ).

TheSOARgroups all the Java strings in the same section,which appears in the ApplicationStrings category. The
sameapplies to the static fields ( Statics category), the types ( Types category), and the class names ( ClassNames
category).

The SOAR Information File

The soar/<main class>.xml file can be opened using any XML editor.

This file contains the list of the following embedded elements:

• method (in selected_methods tag)

• resource (in selected_resources tag)

• system property (in java_properties tag)

• string (in selected_internStrings tag)

• type (in selected_types tag)

• immutable (in selected_immutables tag)

3.3.4 MicroEJ Launch

TheMicroEJ launch configuration sets up theMicroEJ Applications environment (main class, resources, target plat-
form, and platform-specific options), and then launches a MicroEJ launch script for execution.

Execution is done on either the MicroEJ Platform or the MicroEJ Simulator. The launch operation is platform-
specific. It may depend on external tools that the platform requires (such as target memory programming). Refer
to the platform-specific documentation for more information about available launch settings.

Main Tab

The Main tab allows you to set in order:

1. The main project of the application.

2. The main class of the application containing the main method.

3. Types required in your application that are not statically embedded from the main class entry point. Most
required types are those that may be loaded dynamically by the application, using the Class.forName()
method.

4. Binary resources that need to be embedded by the application. These are usually loaded by the application
using the Class.getResourceAsStream() method.

5. Immutable objects’ description files. See the [BON 1.2] ESR documentation for use of immutable objects.
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Fig. 12: MicroEJ Launch Application Main Tab

Execution Tab

The next tab is the Execution tab. Here the target needs to be selected. Choose between execution on a MicroEJ
Platform or on a MicroEJ Simulator. Each of themmay providemultiple launch settings. This page also allows you
to keep generated, intermediate files and to print verbose options (advanced debug purpose options).
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Fig. 13: MicroEJ Launch Application Execution Tab

Configuration Tab

The next tab is the Configuration tab. This tab contains all platform-specific options.
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Fig. 14: Configuration Tab

JRE Tab

The next tab is the JRE tab. This tab allows you to configure the Java Runtime Environment used for running the
underlying launch script. It does not configure the MicroEJ Application execution. The VM Arguments text field
allows you to set vm-specific options, which are typically used to increase memory spaces:

• Tomodify heap space to 1024MB, set the -Xmx1024M option.

• To modify string space (also called PermGen space) to 256MB, set the -XX:PermSize=256M
-XX:MaxPermSize=256M options.

• To set thread stack space to 512MB, set the -Xss512M option.

Other Tabs

The next tabs ( Source and Common tabs) are the default Eclipse launch tabs. Refer to Eclipse help for more
details on how to use these launch tabs.
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3.3.5 Application Options

Introduction

To run a MicroEJ Standalone Application on a MicroEJ Platform, a set of options must be defined. Options can be
of di�erent types:

• Memory Allocation options (e.g set the Java Heap size). These options are usually called link-time options.

• Simulator & Debug options (e.g. enable periodic Java Heap dump).

• Deployment options (e.g. copy microejapp.o to a suitable BSP location).

• Foundation Library specific options (e.g. embed UTF-8 encoding).

The following section describes options provided byMicroEJ Architecture. Please consult the appropriate MicroEJ
Pack documentation for options related to other Foundation Libraries (MicroUI, NET, SSL, FS, . . . ) integrated to the
Platform.

Notice that some options may not be available, in the following cases:

• Option is specific to theMicroEJ Core Engine capability (tiny/single/multi) which is integrated in the targeted
Platform.

• Option is specific to the target (MicroEJ Core Engine on Device or Simulator).

• Option has been introduced in a newer version of theMicroEJ Architecturewhich is integrated in the targeted
Platform.

• Options related to Board Support Package (BSP) connection.

Defining an Option

A MicroEJ Standalone Application option can be defined either from a launcher or from a properties file. It is also
possible to use both together. Each MicroEJ Architecture and MicroEJ Pack option comes with a default value,
which is used if the option has not been set by the user.

Using a Launcher

To set an option in a launcher, perform the following steps:

1. In MicroEJ Studio/SDK, select Run > Run Configurations. . . menu,

2. Select the launcher of the application under MicroEJ Application or create a new one,

3. Select the Configuration tab,

4. Find the desired option and set it to the desired value.

It is recommended to index the launcher configuration to your version control system. To export launcher options
to the filesystem, perform the following steps:

1. Select the Common tab,

2. Select the Shared file: option and browse the desired export folder,

3. Press the Apply button. A file named [launcher_configuration_name].launch is generated in the ex-
port folder.
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Using a Properties File

Options can be also be defined in properties files.

When aMicroEJ Standalone Application is built using the firmware-singleapp skeleton, options are loaded from
properties files located in the build folder at the root of the project.

The properties files are loaded in the following order:

1. Every file matching build/sim/*.properties , for Simulator options only (Virtual Device build). These files
are optional.

2. Every file matching build/emb/*.properties , for Device options only (Firmware build). These files are
optional.

3. Every filematching build/*.properties , both forSimulator andDeviceoptions. At leastone file is required.

Usually, the build folder contains a single file named common.properties .

In case an option is defined in multiple properties files, the option of the first loaded file is taken into account and
the same option defined in the other files is ignored (a loaded option cannot be overridden).

The figure below shows the expected tree of the build folder:

Fig. 15: Build Options Folder

It is recommended to index the properties files to your version control system.

To set an option in a properties file, open the file in a text editor and add a line to set the desired option to the
desired value. For example: soar.generate.classnames=false .

To use the options declared in properties files in a launcher, perform the following steps:

1. In MicroEJ Studio/SDK, select Run > Run Configurations. . . ,

2. Select the launcher of the application,

3. Select the Execution tab,

4. Under Option Files , press the Add. . . button,

5. Browse the sim.properties file for Simulator or the emb.properties file for Device (if any) and press
Open button,

6. Add the common.properties file and press the Open button.

Note: An option set in a properties file can not be modified in the Configuration tab. Options are loaded in the
order the properties files are added (you can use Up and Down buttons to change the file order). In Configuration
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tab, hovering the pointer over an option field will show the location of the properties file that defines the option.

Generating a Properties File

In order to export options defined in a .launch file to a properties file, perform the following steps:

1. Select the [launcher_configuration_name].launch file,

2. Select File > Export > MicroEJ > Launcher as Properties File ,

3. Browse the desired output .properties file,

4. Press the Finish button.

Category: Runtime

Group: Types

Option(checkbox): Embed all type names

Option Name: soar.generate.classnames

Default value: true

Description:

Embed the name of all types. When this option is disabled, only names of declared required types are embedded.
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Group: Assertions

Option(checkbox): Execute assertions on Simulator

Option Name: core.assertions.sim.enabled

Default value: false

Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side e�ects or throw java.lang.AssertionError .

Option(checkbox): Execute assertions on Device

Option Name: core.assertions.emb.enabled

Default value: false

Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side e�ects or throw java.lang.AssertionError .

Group: Trace

Option(checkbox): Enable execution traces

Option Name: core.trace.enabled

Default value: false

Option(checkbox): Start execution traces automatically

Option Name: core.trace.autostart

Default value: false
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Category: Memory

Group: Heaps

Option(text): Java heap size (in bytes)

Option Name: core.memory.javaheap.size

Default value: 65536

Description:

Specifies the Java heap size in bytes.

A Java heap contains live Java objects. An OutOfMemory error can occur if the heap is too small.

Option(text): Immortal heap size (in bytes)

Option Name: core.memory.immortal.size

Default value: 4096

Description:

Specifies the Immortal heap size in bytes.

The Immortal heap contains allocated Immortal objects. An OutOfMemory error can occur if the heap is too small.

Group: Threads

Description:
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This group allows the configuration of application and library thread(s). A thread needs a stack to run. This stack
is allocated from a pool and this pool contains several blocks. Each block has the same size. At thread startup the
thread uses only one block for its stack. When the first block is full it uses another block. Themaximum number of
blocks per thread must be specified. When the maximum number of blocks for a thread is reached or when there
is no free block in the pool, a StackOverflow error is thrown. When a thread terminates all associated blocks are
freed. These blocks can then be used by other threads.

Option(text): Number of threads

Option Name: core.memory.threads.size

Default value: 5

Description:

Specifies the number of threads the application will be able to use at the same time.

Option(text): Number of blocks in pool

Option Name: core.memory.threads.pool.size

Default value: 15

Description:

Specifies the number of blocks in the stacks pool.

Option(text): Block size (in bytes)

Option Name: core.memory.thread.block.size

Default value: 512

Description:

Specifies the thread stack block size (in bytes).

Option(text): Maximum size of thread stack (in blocks)

Option Name: core.memory.thread.max.size

Default value: 4

Description:

Specifies themaximum number of blocks a thread can use. If a thread requires more blocks a StackOverflow error
will occur.
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Category: Simulator

Group: Options

Description:

This group specifies options for MicroEJ Simulator.

Option(checkbox): Use target characteristics

Option Name: s3.board.compliant

Default value: false

Description:

When selected, this option forces the MicroEJ Simulator to use the MicroEJ Platform exact characteristics. It sets
the MicroEJ Simulator scheduling policy according to the MicroEJ Platform one. It forces resources to be explicitly
specified. It enables log trace and gives information about the RAMmemory size the MicroEJ Platform uses.

Option(text): Slowing factor (0means disabled)

Option Name: s3.slow

Default value: 0

Description:

Format: Positive integer

This option allows the MicroEJ Simulator to be slowed down in order to match the MicroEJ Platform execution
speed. The greater the slowing factor, the slower the MicroEJ Simulator runs.
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Group: HIL Connection

Description:

This group enables the control of HIL (Hardware In the Loop) connection parameters (connection betweenMicroEJ
Simulator and the Mocks).

Option(checkbox): Specify a port

Option Name: s3.hil.use.port

Default value: false

Description:

When selected allows the use of a specific HIL connection port, otherwise a random free port is used.

Option(text): Port

Option Name: s3.hil.port

Default value: 8001

Description:

Format: Positive integer

Values: [1024-65535]

It specifies the port used by the MicroEJ Simulator to accept HIL connections.

Option(text): Timeout (s)

Option Name: s3.hil.timeout

Default value: 10

Description:

Format: Positive integer

It specifies the time the MicroEJ Simulator should wait before failing when it invokes native methods.

Option(text): Maximum frame size (bytes)

Option Name: com.microej.simulator.hil.frame.size

Default value: 262144

Description:

Maximum frame size in bytes. Must be increased to transfer large arrays to native side.
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Group: Shielded Plug server configuration

Description:

This group allows configuration of the Shielded Plug database.

Option(text): Server socket port

Option Name: sp.server.port

Default value: 10082

Description:

Set the Shielded Plug server socket port.

Category: Code Coverage

Group: Code Coverage

Description:

This group is used to set parameters of the code coverage analysis tool.

Option(checkbox): Activate code coverage analysis

Option Name: s3.cc.activated

Default value: false
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Description:

When selected it enables the code coverage analysis by the MicroEJ Simulator. Resulting files are output in the cc
directory inside the output directory.

Option(text): Saving coverage information period (in sec.)

Option Name: s3.cc.thread.period

Default value: 15

Description:

It specifies the period between the generation of .cc files.

Category: Debug

Group: Remote Debug

Option(text): Debug port

Option Name: debug.port

Default value: 12000

Description:

Configures the JDWP debug port.

Format: Positive integer

Values: [1024-65535]
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Category: Heap Dumper

Group: Heap Inspection

Description:

This group is used to specify heap inspection properties.

Option(checkbox): Activate heap dumper

Option Name: s3.inspect.heap

Default value: false

Description:

When selected, this option enables a dump of the heap each time the System.gc() method is called by the MicroEJ
Application.
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Category: Logs

Group: Logs

Description:

This group defines parameters for MicroEJ Simulator log activity. Note that logs can only be generated if the
Simulator > Use target characteristics option is selected.

Some logs are sent when the platform executes some specific action (such as start thread, start GC, etc), other logs
are sent periodically (according to defined log level and the log periodicity).

Option(checkbox): system

Option Name: console.logs.level.low

Default value: false

Description:

When selected, System logs are sent when the platform executes the following actions:

start and terminate a thread

start and terminate a GC

exit

Option(checkbox): thread

Option Name: console.logs.level.thread
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Default value: false

Description:

When selected, thread information is sent periodically. It gives information about alive threads (status, memory
allocation, stack size).

Option(checkbox): monitoring

Option Name: console.logs.level.monitoring

Default value: false

Description:

When selected, threadmonitoring logs are sent periodically. It gives information about time execution of threads.

Option(checkbox): memory

Option Name: console.logs.level.memory

Default value: false

Description:

When selected, memory allocation logs are sent periodically. This level allows to supervise memory allocation.

Option(checkbox): schedule

Option Name: console.logs.level.schedule

Default value: false

Description:

When selected, a log is sent when the platform schedules a thread.

Option(checkbox): monitors

Option Name: console.logs.level.monitors

Default value: false

Description:

When selected, monitors information is sent periodically. This level permits tracing of all thread state by tracing
monitor operations.

Option(text): period (in sec.)

Option Name: console.logs.period

Default value: 2

Description:

Format: Positive integer
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Values: [0-60]

Defines the periodicity of periodical logs.

Category: Device

Group: Device Architecture

Option(checkbox): Use a custom device architecture

Option Name: s3.mock.device.architecture.option.use

Default value: false

Option(text): Architecture Name

Option Name: s3.mock.device.architecture.option

Default value: (empty)

Group: Device Unique ID

Option(checkbox): Use a custom device unique ID

Option Name: s3.mock.device.id.option.use

Default value: false
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Option(text): Unique ID (hexadecimal value)

Option Name: s3.mock.device.id.option

Default value: (empty)

Category: Com Port

3.3. Standalone Application 71



MicroEJ Documentation, Revision 2788b3f4

Category: Libraries

Category: EDC

Group: Java System.out
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Option(checkbox): Use a custom Java output stream

Option Name: core.outputstream.disable.uart

Default value: false

Description:

Select this option to specify another Java System.out print stream.

If selected, the default Java output stream is not used by the Java application. the JPFwill not use the default Java
output stream at startup.

Option(text): Class

Option Name: core.outputstream.class

Default value: (empty)

Description:

Format: Java class like packageA.packageB.className

Defines the Java class used to manage System.out .

At startup the JPF will try to load this class using the Class.forName() method. If the given class is not available,
the JPF will use the default Java output stream as usual. The specified class must be available in the application
classpath.

Group: Runtime options

Description:

Specifies the additional classes to embed at runtime.

Option(checkbox): Embed UTF-8 encoding

Option Name: cldc.encoding.utf8.included

Default value: true

Description:

Embed UTF-8 encoding.

Option(checkbox): Enable SecurityManager checks

Option Name: com.microej.library.edc.securitymanager.enabled

Default value: false

Description:

Enable the security manager runtime checks.
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Category: Shielded Plug

Group: Shielded Plug configuration

Description:

Choose the database XML definition.

Option(browse): Database definition

Option Name: sp.database.definition

Default value: (empty)

Description:

Choose the database XML definition.
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Category: ECOM

Group: Device Management

Option(checkbox): Enable registration event notifications

Option Name: com.is2t.ecom.eventpump.enabled

Default value: false

Description:

Enables notification of listeners when devices are registered or unregistered. When a device is registered or un-
registered, a new ej.ecom.io.RegistrationEvent is added to an event queue. Then events are processed by a
dedicated thread that notifies registered listeners.

Option(text): Registration events queue size

Option Name: com.is2t.ecom.eventpump.size

Default value: 5

Description:

Specifies the size (in number of events) of the registration events queue.
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Category: CommConnection

Group: CommConnection Options

Description:

This group allows comm connections to be enabled and application-platformmappings set.

Option(checkbox): Enable comm connections

Option Name: use.comm.connection

Default value: false

Description:

When checked application is able to open a CommConnection .

Group: Device Management

Option(checkbox): Enable dynamic commports registration

Option Name: com.is2t.ecom.comm.registryPump.enabled

Default value: false

Description:

Enables registration (or unregistration) of ports dynamically added (or removed) by the platform. A dedicated
thread listens for ports dynamically added (or removed) by the platform and adds (or removes) their CommPort
representation to the ECOM DeviceManager .
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Category: External Resources Loader

Group: External Resources Loader

Description:

This group allows to specify the external resources input folder. The content of this folder will be copied in an
application output folder and used by SOAR and the Simulator. If empty, the default location will be [output
folder]/externalResources, where [output folder] is the location defined in Execution tab.

Option(browse):

Option Name: ej.externalResources.input.dir

Default value: (empty)

Description:

Browse to specify the external resources folder..
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Category: Device

Category: Core Engine

Group: Memory
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Option(text):

Option Name: core.memory.thread.max.nb.monitors

Default value: 8

Description:

Specifies the maximum number of monitors a thread can own at the same time.

Option(text):

Option Name: core.memory.oome.nb.frames

Default value: 5

Description:

Specifies the maximum number of stack frames that can be dumped to the standard output when Core Engine
throws an OutOfMemoryError.

Option(checkbox): Enable Java heap usagemonitoring

Option Name: com.microej.runtime.debug.heap.monitoring.enabled

Default value: false

Option(text):

Option Name: com.microej.runtime.debug.heap.monitoring.init.size

Default value: 0

Description:

Specify the initial size (in bytes) of the Java Heap.

Group: SOAR

Option(checkbox): Enable Bytecode Verifier

Option Name: soar.bytecode.verifier

Default value: false
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Category: Kernel

Option(checkbox): Check APIs allowed by Kernel

Option Name: apis.check.enable

Default value: true

Group: Threads

Option(text):

Option Name: core.memory.feature.max.threads

Default value: 5

Description:

Specifies the maximum number of threads a Feature is allowed to use at the same time.

Group: Installed Features

Option(text):

Option Name: core.memory.installed.features.max

Default value: 0

Description:

Specifies the maximum number of installed Features that can be added to this Kernel.
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Option(text):

Option Name: core.memory.installed.features.text.size

Default value: 0

Description:

Specifies the size in bytes reserved for installed Features code.

Option(text):

Option Name: core.memory.installed.features.bss.size

Default value: 0

Description:

Specifies the size in bytes reserved for installed Features runtimememory.

Category: Watchdog

Option(checkbox): Enable watchdog support

Option Name: enable.watchdog.support

Default value: true
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Group: Watchdog

Option(text):

Option Name: maximum.active.watchdogs

Default value: 4

Description:

Specifies the maximum number of active watchdogs at the same time.

Category: Deploy

Description:

Configures theoutput locationwhere store theMicroEJApplication, theMicroEJplatform libraries andheader files.

Group: Configuration

Option(checkbox): Deploy the compiled MicroEJ Application in a folder in MicroEJ Application main class
project

Default value: true

Description:

Deploy the compiled MicroEJ Application in a folder in MicroEJ Application’s main class project.
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Option(browse): Output file

Option Name: deploy.copy.filename

Default value: (empty)

Description:

Choose an output file location where copy the compiled MicroEJ Application.

Category: Feature

Description:

Specify Feature options
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Category: Dynamic Download

Group: Dynamic Download

Option(text): Output Name

Option Name: feature.output.basename

Default value: application

Option(browse): Kernel

Option Name: kernel.filename

Default value: (empty)

3.3.6 SOAR

Class Initialization Code

SOAR complies with the deterministic class initialization ( <clinit> ) order specified in [BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

A clinit map file (endingwith extension .clinitmap ) is generated beside the SOAR object file. It describes for each
clinit dependency:

• the types involved
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• the kind of dependency

• the stack calls between the two types

In case of complex clinit code with too many runtime dependencies, the statically computed clinit order may be
wrong.

It is thenpossible tohelpSOARbymanuallydeclaringexplicit clinit dependencies. Suchdependenciesaredeclared
in XML files with the .clinitdesc extension in the application classpath.

The file has the following format:

<?xml version='1.0' encoding='UTF-8'?>
<clinit>

<type name="T1" depends="T2"/>
</clinit>

where T1 and T2 are fully qualified names on the form a.b.C . This explicitly forces SOAR to create a dependency
from T1 to T2 , and therefore cuts a potentially detected dependency from T2 to T1 .

3.4 Sandboxed Application

3.4.1 Sandboxed Application Structure

Application Skeleton Creation

The first step to explore a Sandboxed Application structure is to create a new project.

First select File > New > Sandboxed Application Project :

Fill in the application template fields, the Project name field will automatically duplicate in the following fields.

A template project is automatically created and ready to use, this project already contains all folders wherein de-
velopers need to put content:

src/main/java Folder for future sources;

src/main/resources Folder for future resources (images, fonts, etc.);

META-INF Sandboxed Application configuration and resources;

module.ivy Ivy input file, dependencies description for the current project.

Sources Folder

The project source folder ( src/main ) contains two subfolders: java and resources . java folder will contain all
*.java files of the project, whereas resources folder will contain elements that the application needs at runtime
like raw resources, images or character fonts.

META-INF Folder

The META-INF folder contains several folders and amanifest file. They are described herea�er.

certificate (folder) Contains certificate information used during the application deployment.

libraries (folder) Contains a list of additional libraries useful to the application and not resolved through the
regular transitive dependency check.
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properties (folder) Contains an application.properties file which contains application specific properties
that can be accessed at runtime.

services (folder) Contains a list of files that describe local services provided by the application. Each file name
represents a service class fully qualified name, and each file contains the fully qualified nameof the provided
service implementation.

wpk (folder) Contains a set of applications ( .wpk files) that will be started when the application is executed on
the Simulator.

MANIFEST.MF (file) Contains the information given at project creation, extra information can be added to this file
to declare the entry points of the application.

module.ivy File

The module.ivy file describes all the libraries required by the application at runtime. The Ivy classpath container
lists all the modules that have been automatically resolved from the content of module.ivy . SeeMicroEJ Module
Manager for more informations about MicroEJ Module Manager.

3.4.2 Application Publication

Build the WPK

When the application is ready for deployment, the last step in MicroEJ Studio is to create theWPK (Wadapps PacK-
age) file that is intended to be published on a MicroEJ Forge instance for end users.

In MicroEJ Studio, right-click on the Sandboxed Application project name and select Build Module .

The WPK build process will display messages in MicroEJ console, ending up the following message:

[echo] project hello published locally with version 0.1.0-RC201907091602

BUILD SUCCESSFUL

Total time: 1 minute 6 seconds

TheWPK file produced by the build process is located in a dedicated target~/artifacts folder in the project and
is published to the target module repository declared inMicroEJ Module Manager settings file.

The module repository can be a MicroEJ Forge instance.

3.4.3 Shared Interfaces

Principle

The Shared Interfacemechanism provided byMicroEJ Core Engine is an object communication bus based on plain
Java interfaces wheremethod calls are allowed to cross MicroEJ Sandboxed Applications boundaries. The Shared
Interface mechanism is the cornerstone for designing reliable Service Oriented Architectures on top of MicroEJ.
Communication is based on the sharing of interfaces defining APIs (Contract Oriented Programming).

The basic schema:

• A provider application publishes an implementation for a shared interface into a system registry.

• A user application retrieves the implementation from the system registry and directly calls the methods de-
fined by the shared interface.
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Fig. 16: Shared Interface Call Mechanism

Shared Interface Creation

Creation of a shared interface follows three steps:

• Interface definition,

• Proxy implementation,

• Interface registration.

Interface Definition

The definition of a shared interface starts by defining a standard Java interface.

package mypackage;
public interface MyInterface{

void foo();
}

To declare an interface as a shared interface, itmust be registered in a shared interfaces identification file. A shared
interface identification file is an XML file with the .si su�ix with the following format:

<sharedInterfaces>
<sharedInterface name="mypackage.MyInterface"/>

</sharedInterfaces>

Shared interface identification filesmust be placed at the root of a path of the application classpath. For a MicroEJ
Sandboxed Application project, it is typically placed in src/main/resources folder.

Some restrictions apply to shared interface compared to standard java interfaces:

• Types for parameters and return values must be transferable types;

• Thrown exceptions must be classes owned by the MicroEJ Firmware.

Transferable Types

In the process of a cross-application method call, parameters and return value of methods declared in a shared
interface must be transferred back and forth between application boundaries.
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Fig. 17: Shared Interface Parameters Transfer

Shared Interface Types Transfer Rules describes the rules applied depending on the element to be transferred.

Table 1: Shared Interface Types Transfer Rules
Type Owner Instance

Owner
Rule

Base type N/A N/A Passing by value. ( boolean , byte , short
, char , int , long , double , float )

Any Class, Array or Inter-
face

Kernel Kernel Passing by reference

Any Class, Array or Inter-
face

Kernel Application Kernel specific or forbidden

Array of base types Any Application Clone by copy
Arrays of references Any Application Clone and transfer rules applied again on

each element
Shared Interface Application Application Passing by indirect reference (Proxy cre-

ation)
Any Class, Array or Inter-
face

Application Application Forbidden

Objects created by an application which class is owned by the Kernel can be transferred to another application
if this has been authorized by the Kernel. The list of eligible types that can be transferred is Kernel specific, so
you have to consult the firmware specification. MicroEJ Evaluation Firmware Example of Transfer Types lists Kernel
types allowed to be transferred through a shared interface call. When an argument transfer is forbidden, the call is
abruptly stopped and a java.lang.IllegalAccessError is thrown by MicroEJ Core Engine.

Table 2: MicroEJ Evaluation Firmware Example of Transfer Types
Type Rule

java.lang.String
Clone by copy

java.io.InputStream
Proxy reference creation

java.util.Map<String,String>
Clone by deep copy

Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying MicroEJ Core En-
gine, so that each application can still be dynamically stopped and uninstalled. This o�ers a reliable way for users
and providers to handle the relationship in case of a broken link.

Once a Java interface has been declared as Shared Interface, a dedicated implementation is required (called the
Proxy class implementation). Its main goal is to perform the remote invocation and provide a reliable implemen-
tation regarding the interface contract even if the remote application fails to fulfill its contract (unexpected excep-
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tions, application killed. . . ). The MicroEJ Core Engine will allocate instances of this class when an implementation
owned by another application is being transferred to this application.

Fig. 18: Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented interface must be
defined according to the following pattern:

package mypackage;

public class MyInterfaceProxy extends Proxy<MyInterface> implements MyInterface {

@Override
public void foo(){

try {
invoke(); // perform remote invocation

} catch (Throwable e) {
e.printStackTrace();

}
}

}

Each implemented method of the proxy class is responsible for performing the remote call and catching all errors
from the server side and to provide an appropriate answer to the client application call according to the interface
method specification (contract). Remote invocationmethods are defined in the super class ej.kf.Proxy and are
named invokeXXX() where XXX is the kind of return type. As this class is part of the application, the application
developer has the full control on the Proxy implementation and is free to insert additional code such as logging
calls and errors for example.

Table 3: Proxy Remote Invocation Built-in Methods
Invocation Method Usage
void invoke() Remote invocation for a proxy method that returns void
Object invokeRef() Remote invocation for a proxymethod that returns a reference
boolean invokeBoolean(), byte invokeByte(),
char invokeChar(), short invokeShort(), int in-
vokeInt(), long invokeLong(), double invoke-
Double(), float invokeFloat()

Remote invocation for aproxymethod that returns abase type
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3.5 Virtual Device

3.5.1 Using a Virtual Device for Simulation

The Virtual Device includes the same custom MicroEJ Core, libraries and System Applications as the real device.
The Virtual Device allows developers to run their applications either on the Simulator, or directly on the real device
through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware functionality. An ap-
plication on the Simulator is run as a Standalone Application.

Before an application is locally deployed on device, MicroEJ Studio ensures that it does not depend on any API that
is unavailable on the device.

Fig. 19: MicroEJ Virtual Device Architecture

3.5.2 Runtime Environment

The set of MicroEJ APIs exposed by a Virtual Device (and therefore provided by its associated firwmare) is docu-
mented in Javadoc format in theMicroEJ Resource Center ( Window > Show View > MicroEJ Resource Center
).
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Fig. 20: MicroEJ Resource Center APIs

3.6 MicroEJ Module Manager

3.6.1 Introduction

Modern electronic device design involvesmanyparts and teams to collaborate to finally obtain a product to be sold
on its market. MicroEJ encourages modular design which involves various stake holders: hardware engineers, UX
designers, graphic designers, drivers/BSP engineers, so�ware engineers, etc.

Modular design is a design technique that emphasizes separating the functionality of an application into inde-
pendent, interchangeable modules. Each module contains everything necessary to execute only one aspect of
the desired functionality. In order to have team members collaborate internally within their team and with other
teams, MicroEJ provides a powerful modular design concept, with smart module dependencies, controlled by the
MicroEJModule Manager (MMM). MMM frees engineers from the di�icult task of computingmodule dependencies.
Engineers specify the bare minimum description of the module requirements.

The following schema introduces the main concepts detailed in this chapter.
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Fig. 21: MMMOverview

MMM is based on the following tools:

• Apache Ivy (http://ant.apache.org/ivy) for dependencies resolution andmodule publication;

• Apache EasyAnt (https://ant.apache.org/easyant/history/trunk/reference.html) for module build from
source code.

3.6.2 Specification

MMM provides a non ambiguous semantic for dependencies resolution. Please consult the MMM specification
available on https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.
0-E.pdf.

3.6.3 Module Project Skeleton

In MicroEJ SDK, a newMicroEJ module project is created as follows:

• Select File > New > Project. . . ,

• Select MicroEJ > Module Project 1,

• Fill the module information (project name, module organization, name and revision),

• Select one of the suggested skeletons depending on the desiredmodule nature,

• Click on Finish .

1 If using MicroEJ SDK versions lower than 5.2.0 , please refer to the following section.

3.6. MicroEJ Module Manager 92

http://ant.apache.org/ivy
https://ant.apache.org/easyant/history/trunk/reference.html
https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.0-E.pdf
https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.0-E.pdf


MicroEJ Documentation, Revision 2788b3f4

The project is created and a set of files and directories are generated from the selected skeleton.

Note: When an empty Eclipse project already exists or when the skeleton has to be created within an existing
directory, the MicroEJ module is created as follows:

• In the Package Explorer, click on the parent project or directory,

• Select File > New > Other. . . ,

• Select EasyAnt > EasyAnt Skeleton .

3.6.4 Module Description File

Amoduledescription file is an Ivy configuration filenamed module.ivy , locatedat the rootof eachMicroEJmodule
project. It describes themodule nature (also called build type) and dependencies to other modules.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org" xmlns:m="http://ant.apache.org/ivy/extra"
xmlns:ej="https://developer.microej.com" ej:version="2.0.0">

<info organisation="[organisation]" module="[name]" status="integration" revision="[version]">
<ea:build organisation="com.is2t.easyant.buildtypes" module="[buildtype_name]" revision=

→˓"[buildtype_version]">
<ea:property name="[buildoption_name]" value="[buildoption_value]"/>

</ea:build>
</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="documentation" visibility="public"/>
<conf name="source" visibility="public"/>
<conf name="dist" visibility="public"/>
<conf name="test" visibility="private"/>

</configurations>

<publications>
</publications>

<dependencies>
<dependency org="[dep_organisation]" name="[dep_name]" rev="[dep_version]"/>

</dependencies>
</ivy-module>

Enable MMM Semantic

The MMM semantic is enabled in a module by adding the MicroEJ XML namespace and the ej:version attribute
in the ivy-module node:

<ivy-module xmlns:ej="https://developer.microej.com" ej:version="2.0.0">

Note: Multiple namespaces can be declared in the ivy-module node.

MMM semantic is enabled in the module created with theModule Project Skeleton.
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Module Dependencies

Module dependencies are added to the dependencies node as follow:

<dependencies>
<dependency org="[dep_organisation]" name="[dep_name]" rev="[dep_version]"/>

</dependencies>

When nomatching rule is specified, the default matching rule is compatible .

Dependency Matching Rule

The following matching rules are specified by MMM:

Name Range Notation Semantic
compatible [M.m.p-RC, (M+1).0.0-RC[ Equal or up to next major version. Default if

not set.
equivalent [M.m.p-RC, M.(m+1).0-RC [ Equal or up to next minor version
greaterOrEqual [M.m.p-RC,∞[ Equal or greater versions
perfect [M.m.p-RC, M.m.(p+1)-RC[ Exact match (strong dependency)

Set the matching rule of a given dependency with ej:match="matching rule" . For example:

<dependency org="[dep_organisation]" name="[dep_name]" rev="[dep_version]" ej:match="perfect" />

Dependency Visibility

• A dependency declared public is transitively resolved by upper modules. The default when not set.

• A dependency declared private is only used by the module itself, typically for:

– Bundling the content into the module

– Testing the module

The visibility is set by the configurations declared in the configurations node. For example:

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="[conf_name]" visibility="private"/>

</configurations>

The configuration of a dependency is specified by setting the conf attribute, for example:

<dependency org="[dep_organisation]" name="[dep_name]" rev="[dep_version]" conf="[conf_name]->*" />

Automatic Update Before Resolution

The Easyant plugin ivy-update can be used to automatically update the version (attribute rev ) of everymodule
dependencies declared.

<info organisation="[organisation]" module="[name]" status="integration" revision="[version]">
<ea:plugin org="com.is2t.easyant.plugins" name="ivy-update" revision="1.+" />

</info>
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When the plugin is enabled, for eachmodule dependency, MMM will check the version declared in the module file
and update it to the highest version available which satisfies the matching rule of the dependency.

Build Options

MMM build options can be set with:

<ea:property name="[buildoption_name]" value="[buildoption_value]"/>

The following build options are globally available:

Table 4: Build Options
Property
Name

Description Default Value

target
Path of the build directory target~ .

${basedir}/target~

Refer to the documentation ofModule Natures for specific build options.

3.6.5 MicroEJ Module Manager Configuration

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from
MicroEJ Central Repository and to publish built modules to a local directory. The repository configura-
tion is stored in a settings file ( ivysettings.xml ), and the default one is located at $USER_HOME\.
microej\microej-ivysettings-[VERSION].xml

Preferences Page

The MMM preferences page in the MicroEJ SDK is available at Window > Preferences > MicroEJ >
Module Manager 1.
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Fig. 22: MMM Preferences Page

This page allows to configure the following elements:

1. Settings File : the file describing how to connectmodule repositories. See the settings file section.

2. Options : files declaring MMM options. See the Options section.

3. Use Module repository as Build repository : the settings file for connecting thebuild repository in place
of the one bundled in MicroEJ SDK. This option shall not be enabled by default and is reserved for advanced
configuration.

4. Build repository Settings File : the settings file for connecting the build repository in place of the one
bundled in MicroEJ SDK. This option is automatically initialized the first time MicroEJ SDK is launched. It
shall not be modified by default and is reserved for advanced configuration.

5. Set verbose mode : to enable advanced debug traces when building a module.

6. Runtime JRE : the Java Runtime Environment that executes the build process.

7. Max build history size : the maximum number of previous builds available in Build Module shortcut
list:
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Settings File

The settings file is an XML file that describes howMMMconnects local or onlinemodule repositories. The file format
is described in Apache Ivy documentation.

To configure MMM to a custom settings file (usually from an o�line repository):

1. Set Settings file to a custom ivysettings.xml settings file1,

2. Click on Apply and Close button

If the workspace is not empty, it is recommended to trigger a full resolution and rebuild all the projects using this
new repository configuration:

1. Clean caches

• In the Package Explorer, right-click on a project;

• Select Ivy > Clean all caches .

2. Resolve projects using the new repository

To resolve all the workspace projects, click on the Resolve All button in the toolbar:

To only resolve a subset of the workspace projects:

• In the Package Explorer, select the desired projects,

• Right-click on a project and select Ivy > Clean all caches .

3. Trigger Add-On Library processors for automatically generated source code

• Select Project > Clean. . . ,

• Select Clean all projects ,

• Click on Clean button.

Options

Options can be used to parameterize amodule description file or a settings file. Options are declared as key/value
pairs in a standard Java properties file, and are expanded using the ${my_property} notation.

A typical usage in a settings file is for extracting repository server credentials, such as HTTP Basic access authenti-
cation:

1. Declare options in a properties file
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2. Register this property file to MMM options

3. Use this option in a settings file

A typical usage in amodule description file is for factorizing dependency versions acrossmultiplemodules projects:

1. Declare an option in a properties file

2. Register this property file to MMM options

3. Use this option in amodule description file
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3.6.6 Module Build

In MicroEJ SDK, the build of a MicroEJ module project can be started as follows:

• In the Package Explorer, right-click on the project,

• Select Build Module .

Fig. 23: Module Build

The build of a module can take time depending on

• themodule nature to build,
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• the number and the size of module dependencies to download,

• the repository connection bandwidth, . . .

The module build logs are redirected to the integrated console.

Alternatively, the build of a MicroEJ module project can be started from the build history:

Fig. 24: Module Build History

3.6.7 Build Kit

The Module Manager Build Kit is a consistent set of tools, scripts, configuration and artifacts required for building
modules in command-linemode. Starting fromMicroEJSDK 5.4.0 , it alsocontainsaCommandLine Interface (CLI).
The Build Kit allows to work in headless mode (e.g. in a terminal) and to build your modules using a Continuous
Integration tool.

The Build Kit is bundled with MicroEJ SDK and can be exported using the following steps:2

• Select File > Export > MicroEJ > Module Manager Build Kit ,

• Choose an empty Target directory ,

• Click on the Finish button.

Once the Build Kit is fully exported, the directory content shall look like:

/
bin

mmm
mmm.bat

conf
lib
microej-build-repository

ant-contrib
com
...
ivysettings.xml

microej-module-repository
ivysettings.xml

release.properties

• Add the bin directory of the Build Kit directory to the PATH environment variable of your machine.
2 If using MicroEJ SDK versions lower than 5.4.0 , please refer to the following section.
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• Make sure the JAVA_HOME environment variable is set and points to a JRE/JDK installation or that java
executable is in the PATH environment variable (Java 8 is required)

• Confirm that the installation works fine by executing the command mmm --version . The result should
display the MMM CLI version.

The mmm tool can run on any supported Operating Systems:

• onWindows, either in the command prompt using the Windows batch script mmm.bat or in MinGW environ-
ments such as Git BASH using the bash script mmm .

• on Mac OS X and Linux distributions using the bash script mmm .

The build repository ( microej-build-repository directory) contains scripts and tools for buildingmodules. It is
specific to a MicroEJ SDK version and shall not be modified by default.

The module repository ( microej-module-repository directory) contains a default Settings File for importing
modules fromMicroEJ Central Repository and this local repository (modules that are locally built will be published
to this directory). You can override with custom settings or by extracting an o�line repository.

To go further with headless builds, please consult the next chapter for command line builds, and this tutorial to
setup MicroEJ modules build in continuous integration environments.

3.6.8 Command Line Interface

Starting from version 5.4.0 , MicroEJ SDK provides a Command Line Interface (CLI). Please refer to the Build Kit
section for installation details.

The following operations are supported by the MMM CLI:

• creating a module project

• cleaning a module project

• building a module project

• running a MicroEJ Application project on the Simulator

• publishing a module in a module repository

Usage

In order to use the MMM CLI for your project:

• go to the root directory of your project

• run the following command

mmm [OPTION]... [COMMAND]

where COMMAND is the command to execute (for example mmm build ). The available commands are:

• help : display help information about the specified command

• init : create a new project

• clean : clean the project

• build : build the project

• publish : build the project and publish the module

• run : run the MicroEJ Application project on the Simulator
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The available options are:

• --help ( -h ): show the help message and exit

• --version ( -V ): print version information and exit

• --build-repository-settings-file ( -b ): path of the Ivy settings file for build scripts and tools. Defaults
to ${CLI_HOME}/microej-build-repository/ivysettings.xml .

• --module-repository-settings-file ( -r ): path of the Ivy settings file for modules. Defaults to
${CLI_HOME}/microej-module-repository/ivysettings.xml .

• --ivy-file ( -f ): path of the project’s Ivy file. Defaults to ./module.ivy .

• --verbose ( -v ): verbose mode. Disabled by default. Add this option to enable verbose mode.

• -Dxxx=yyy : any additional option passed as system properties.

When no command is specified, MMM CLI executes Easyant with custom targets using the --targets ( -t ) option
(defaults to clean,package ).

Shared configuration

In order to share configuration across several projects, these parameters can be defined in the file ${user.home}/
.microej/.mmmconfig . This file uses the TOML format. Parameters names are the same than the ones passed
as system properties, except the character _ is used as a separator instead of - . The parameters defined in the
[options] section are passed as system properties. Here is an example:

build_repository_settings_file = "/home/johndoe/ivy-configuration/ivysettings.xml"
module_repository_settings_file = "/home/johndoe/ivy-configuration/ivysettings.xml"
ivy_file = "ivy.xml"

[options]
my.first.property = "value1"
my.second.property = "value2"

Warning:

• TOML values must be surrounded with double quotes

• Backslash characters ( \ ) must be doubled (for example a Windows path
C:\\Users\\johndoe\\ivysettings.xml )

Command lineoptions takeprecedenceover thosedefined in the configuration file. So if the sameoption is defined
in both locations, the value defined in the command line is used.

Commands

init

The command init creates a new project (executes Easyant with skeleton:generate target). The skeleton and
project information must be passed with the following system properties:

• skeleton.org : organisation of the skeletonmodule. Defaults to com.is2t.easyant.skeletons .

• skeleton.module : name of the skeletonmodule. Mandatory, defaults to microej-javalib .

• skeleton.rev : revision of the skeleton module. Mandatory, defaults to + (meaning the latest released
version).
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• project.org : organisation of the project module. Mandatory, defaults to com.mycompany .

• project.module : name of the project module. Mandatory, defaults to myproject .

• project.rev : revision of the project module. Defaults to 0.1.0 .

• skeleton.target.dir : relativepathof theprojectdirectory (created if it doesnotexist). Mandatory, defaults
to the current directory.

For example

mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.2.
→˓8 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0 -Dskeleton.target.
→˓dir=myproject

If one of these properties is missing, it will be asked in interactive mode:

$ mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.
→˓2.8 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0

...

-skeleton:check-generate:
[input] skipping input as property skeleton.org has already been set.
[input] skipping input as property skeleton.module has already been set.
[input] skipping input as property skeleton.rev has already been set.
[input] The path where the skeleton project will be unzipped [/home/tdelhomenie/microej/working/

→˓skeleton]

To force the non-interactive mode, the property skeleton.interactive.mode must be set to false . In non-
interactivemode thedefault values areused formissingnon-mandatoryproperties, and the creation fails ifmanda-
tory properties are missing.

$ mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.
→˓2.8 -Dproject.org=com.mycompany -Dskeleton.target.dir=myproject -Dskeleton.interactive.mode=false

...

* Problem Report:

expected property 'project.module': Module name of YOUR project

clean

The command clean cleans the project (executes Easyant with clean target). For example

mmm clean

cleans the project.

build

The command build builds the project (executes Easyant with clean,package targets). For example

mmm build -f ivy.xml -v

builds the project with the Ivy file ivy.xml and in verbose mode.

publish

Thecommand publish builds theproject andpublishes themodule. This commandaccepts thepublication target
as a parameter, amongst these values:
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• local (default value): executes the clean,publish-local Easyant target, which publishes the project with
the resolver referenced by the property local.resolver in the Settings File.

• shared : executes the clean,publish-shared Easyant target, which publishes the project with the resolver
referenced by the property shared.resolver in the Settings File.

• release : executes the clean,release Easyant target, which publishes the project with the resolver refer-
enced by the property release.resolver the Settings File.

For example

mmm publish local

builds the project and publishes the module using the local resolver.

run

The command run runs the application on the Simulator (executes Easyant with compile,simulator:run tar-
gets). It has the following requirements:

• to run on the Simulator, the project must be configured with one of the followingModule Natures:

– Sandboxed Application

– Standalone Application

– Add-On Library

• the property application.main.class must be set to the Fully Qualified Name of the application main
class (for example com.mycompany.Main )

• a MicroEJ Platformmust be provided (see Platform Selection section)

• ApplicationOptionsmust bedefinedusingproperties file under in the build directory (seeUsingaProperties
File section)

• the module must have been built once before running the Simulator. So the mmm build commandmust be
executed before running the Simulator the first time or a�er a project clean ( mmm clean command).

Note: The next times, it is not required to rebuild the module if source code files have been modified. The
content of src/main/java and src/main/resources folders are automatically compiled by mmm run com-
mand before running the Simulator.

For example

mmm run -D"platform-loader.target.platform.file"="/path/to/the/platform.zip"

runs the application on the given platform.

The Simulator can be launched in debug mode by setting the property execution.mode of the application file
build/commons.properties to debug :

execution.mode=debug

The debug port can be defined with the property debug.port . Go to Simulator Debug options section for more
details.

help

The command help displays the help for a command. For example
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mmm help run

displays the help of the command run .

3.6.9 Troubleshooting

Unresolved Dependency

If the following message appears when resolving module dependencies:

:: problems summary ::
:::: WARNINGS

module not found: com.mycompany#mymodule;[M.m.p-RC,M.m.(p+1)-RC[

::::::::::::::::::::::::::::::::::::::::::::::

:: UNRESOLVED DEPENDENCIES ::

::::::::::::::::::::::::::::::::::::::::::::::

:: com.mycompany#mymodule;[M.m.p-RC,M.m.(p+1)-RC[: not found

::::::::::::::::::::::::::::::::::::::::::::::

First, check that either a released module com.mycompany/mymodule/M.m.p or a snapshot module com.
mycompany/mymodule/M.m.p-RCYYYYMMDD-HHMM exists in your module repository.

• If the module does not exist,

– if it is declared as a direct dependency, the module repository is not compatible with your source code.
You can either check if an othermodule version is available in the repository or add themissingmodule
to the repository.

– otherwise, this is likely a missing transitive module dependency. The module repository is not consis-
tent. Check themodule repository settings file and that consistency check has been enabled during the
module repository build (see Configure Consistency Check).

• If the module exists, this may be either a configuration issue or a network connection error. We have to find
the cause in the resolution logs with the verbose mode option enabled:

For URL repositories, find:

trying https://[MY_REPOSITORY_URL]/[MY_REPOSITORY_NAME]/com.mycompany/mymodule/
tried https://[MY_REPOSITORY_URL]/[MY_REPOSITORY_NAME]/com.mycompany/mymodule/

For filesystem repository, find:

trying [MY_REPOSITORY_PATH]/com.mycompany/mymodule/
tried [MY_REPOSITORY_PATH]/com.mycompany/mymodule/

If your module repository URL or filesystem path does not appear, check your settings file. This is likely a
missing resolver.

Otherwise, if your module repository is an URL, this may be a network connection error between MMM (the
client) and the module repository (the server). First, check for Invalid Certificate issue.

Otherwise, the next step is to debug at the HTTP level:
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HTTP response status: [RESPONSE_CODE] url=https://[MY_REPOSITORY_URL]/com.mycompany/mymodule/
CLIENT ERROR: Not Found url=https://[MY_REPOSITORY_URL]/com.mycompany/mymodule/

Depending on the HTTP error code:

– 401 Unauthorized : check your settings file credentials configuration.

– 404 Not Found : add the following options to log raw HTTP tra�ic:

-Dorg.apache.commons.logging.Log=org.apache.commons.logging.impl.SimpleLog -Dorg.apache.
→˓commons.logging.simplelog.showdatetime=true -Dorg.apache.commons.logging.simplelog.log.org.
→˓apache.http=DEBUG -Dorg.apache.commons.logging.simplelog.log.org.apache.http.wire=ERROR

Particularly, Ivy requires the HTTP HEAD request which may be disabled by some servers.

Invalid Certificate

If the following message appears when resolving module dependencies:

HttpClientHandler: sun.security.validator.ValidatorException: PKIX path building failed: sun.security.
→˓provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested␣
→˓target url=[artifactory address]

The server may use a self-signed certificate that has to be added to the JRE trust store that is running MicroEJ
Module Manager. Here is a way to do it:

1. Install Keystore Explorer,

2. Start Keystore Explorer, and open file [JRE_HOME]/lib/security/cacerts or [JDK_HOME]/jre/lib/
security/cacerts with the password changeit . You may not have the right to modify this file. Edit rights
if needed before opening it,

3. Click on Tools , then Import Trusted Certificate ,

4. Select your certificate,

5. Save the cacerts file.

If the problem still occurs, add the following option to enable SSL protocol traces:

-Djavax.net.debug=all

This is useful to detect advanced errors such as:

• invalid certificate chain: one of root or intermediate certificate may bemissing in the JRE/JDK truststore.

• TLS protocol negotiation issues.

Target “simulator:run” does not exist

If the following message appears when executing the mmm run command:

* Problem Report:

Target "simulator:run" does not exist in the project "my-app".

it means that the command run is not supported by the build type declared by your module project. Make sure it
is one of the following ones:
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• build-application , with version 7.1.0 or higher

• build-microej-javalib , with version 4.2.0 or higher

• build-firmware-singleapp , with version 1.3.0 or higher

3.6.10 Meta Build

AMeta Build is amodule allowing to build other modules. It is typically used in a project containingmultiple mod-
ules. The Meta Build module serves as an entry point to build all the modules of the project.

Meta Build creation

• In the MicroeEJ SDK, select File > New > Module Project .

Fig. 25: NewMeta Build Project

• Fill in the fields Project name , Organization , Module and Revision , then select the Skeleton named
microej-meta-build

• Click on Finish . A template project is automatically created and ready to use.

Meta Build configuration

The main element to configure in a meta build is the list of modules to build. This is done in 2 files, located at the
root folder:

• public.modules.list which contains the list of the modules relative paths to build and publish.

• private.modules.list which contains the list of the modules relative paths to build. These modules are
not published but only stored in a private and local repository in order to be fetched by the public modules.

The format of these files is a plain text file with onemodule path by line, for example:

module1
module2
module3

These paths are relative to the meta build root folder, which is set by default to the parent folder of the meta build
module ( .. ). For this reason, a meta build module is generally created at the same level of the other modules to
build. Here is a typical structure of a meta build:
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/
module1

...
module.ivy

module2
...
module.ivy

module3
...
module.ivy

metabuild
private.modules.list
public.modules.list
module.ivy

The modules build order is calculated based on the dependency information. If a module is a dependency of an-
other module, it is built first.

For a complete list of configuration options, please refer toMeta Build Module Nature section.

3.6.11 Former MicroEJ SDK Versions (lower than 5.2.0)

This section describes MMM configuration elements for MicroEJ SDK versions lower than 5.2.0 .

NewMicroEJ Module Project

TheNewMicroEJModuleProjectwizard is available at File > New > Project. . . , EasyAnt > EasyAnt Project
.

Preferences Pages

MMM Preferences Pages are located in two dedicated pages. The following pictures show the options mapping
using the same options numbers declared in Preferences Page.

Ivy Preferences Page

The Ivy Preferences Page is available at Window > Preferences > Ivy > Settings .
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Easyant Preferences Page

The Easyant Preferences Page is available at Window > Preferences > EasyAnt4Eclipse .

Build Kit

• Create an empty directory (e.g. mmm_sdk_[version]_build_kit ),

• Locate your SDK installation plugins directory (by default, C:\Program Files\MicroEJ\MicroEJ
SDK-[version]\rcp\plugins on Windows OS),

• Open the file com.is2t.eclipse.plugin.easyant4e_[version].jar with an archive manager,

• Extract the directory lib to the target directory,

• Open the file com.is2t.eclipse.plugin.easyant4e.offlinerepo_[version].jar with an archive man-
ager,

• Navigate to directory repositories ,
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• Extract the filenamed microej-build-repository.zip forMicroEJSDK 5.x or is2t_repo.zip forMicroEJ
SDK 4.1.x to the target directory.

3.6.12 Former MicroEJ SDK Versions (from 5.2.0 to 5.3.x)

Build Kit

The Build Kit is bundled with MicroEJ SDK and can be exported using the following steps:

• Select File > Export > MicroEJ > Module Manager Build Kit ,

• Choose an empty Target directory ,

• Click on the Finish button.

Once the Build Kit is fully exported, the directory content shall look like:

3.7 Module Natures

This page describes the most commonmodule natures as follows:

• Skeleton Name: the project skeleton name.

• Build Type Name: the build type name, derived from the module nature name: com.is2t.easyant.
buildtypes#build-[NATURE_NAME] .

• Documentation: a link to the documentation.

• SDK Menu: the menu to the direct wizard in MicroEJ SDK (if available). Any module nature can be created
with the default wizard from File > New > Module Project .

• Configuration: properties that can be defined to configure the module. Properties are defined inside the
ea:build tag of the module.ivy file, using ea:property tag as described in the section Build Options. A
module nature also inherits the configuration properties from the listed Natures Plugins.

3.7.1 Add-On Library

Skeleton Name: microej-javalib

Build Type Name: com.is2t.easyant.buildtypes#build-microej-javalib

Documentation: MicroEJ Libraries

SDKMenu: File > New > Add-On Library Project

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation
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• Platform Loader

• Javadoc

• Test Suite

• Artifact Checker

3.7.2 Add-On Processor

Skeleton Name: addon-processor

Build Type Name: com.is2t.easyant.buildtypes#build-addon-processor

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• J2SE Unit Tests

• Artifact Checker

3.7.3 Foundation Library API

Skeleton Name: microej-javaapi

Build Type Name: com.is2t.easyant.buildtypes#build-microej-javaapi

Documentation: MicroEJ Libraries

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• Javadoc

• Artifact Checker

This module nature defines the following dedicated configuration properties:

Name Description Default
microej.lib.name Platform library name on the form: [NAME]-[VERSION]-api . -

[NAME] : name of the implemented Foundation Library API module.
- [VERSION] : version of the implemented Foundation Library API
module without patch ( Major.minor ).

Not set

rip.printableName Printable name for the Platform Editor. Not set

3.7.4 Foundation Library Implementation

Skeleton Name: microej-javaimpl

Build Type Name: com.is2t.easyant.buildtypes#build-microej-javaimpl

Documentation: MicroEJ Libraries

Configuration:
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This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• Test Suite

This module nature defines the following dedicated configuration properties:

Name Description Default
microej.lib.implfor Execution target. Possible values are emb (only onDevice), sim (only

Simulator) and common (both). common

3.7.5 Meta Build

Skeleton Name: microej-meta-build

Build Type Name: com.is2t.easyant.buildtypes#microej-meta-build

Documentation: Meta Build

Configuration:

This module nature defines the following dedicated configuration properties:

Name Description Default
metabuild.root Path of the root folder containing the modules to build.

${basedir}/
..

private.modules.file Name of the file listing the private modules to build.
private.
modules.
list

public.modules.file Name of the file listing the public modules to build.
public.
modules.
list

3.7.6 Mock

Skeleton Name: microej-mock

Build Type Name: com.is2t.easyant.buildtypes#build-microej-mock

Documentation: Mock

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• J2SE Unit Tests

3.7.7 Module Repository

Skeleton Name: artifact-repository

Build Type Name: com.is2t.easyant.buildtypes#build-artifact-repository
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Documentation: Module Repository

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Artifact Checker

This module nature defines the following dedicated configuration properties:

Name Description Default
bar.check.as.v2.module When this property is set to true, the artifact checker uses the Mi-

croEJ Module Manager semantic. false

bar.javadoc.dir Path of the folder containing the generated javadoc.
${target}/
javadoc

bar.notification.email.fromThe email address used as the from address when sending the noti-
fication emails.

Not set

bar.notification.email.host The hostname of the mail service used to send the notification
emails.

Not set

bar.notification.email.passwordThe password used to authenticate on the mail service. Not set
bar.notification.email.port The port of the mail service used to send the notification emails Not set
bar.notification.email.ssl When this property is set to true, SSL/TLS is used to send the notifi-

cation emails.
Not set

bar.notification.email.to The notification email address destination. Not set
bar.notification.email.user The username used to authenticate on the mail service. Not set
bar.populate.from.resolverName of the resolver used to fetch the modules to populate the

repository. fetchRelease

bar.populate.ivy.settings.filePathof the Ivy settings file used to fetch themodules topopulate the
repository. ${project.

ivy.
settings.
file}

bar.populate.repository.confIvy configuration of included repositories. The modules of the
repositories declared as dependency with this configuration are in-
cluded in the built repository.

repository

bar.test.haltonerror When this property is set to true, the artifact checker stops at the
first error. false

javadoc.excludes Comma-separated list of packages to exclude from the javadoc. Empty string
javadoc.includes Comma-separated list of packages to include in the javadoc.

** (all pack-
ages)

skip.artifact.checker When this property is set to true, all artifact checkers are skipped. Not set
skip.email When this property is set (any value), the notification email is not

sent. Otherwise the bar.notification.* properties are required.
Not set

skip.javadoc.deprecated Prevents the generation of any deprecated API at all in the javadoc.
true

3.7.8 Sandboxed Application

Skeleton Name: application

Build Type Name: com.is2t.easyant.buildtypes#build-application

Documentation: Sandboxed Application
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SDKMenu: File > New > Sandboxed Application Project

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• Platform Loader

• Javadoc

• Test Suite

• Artifact Checker

3.7.9 Standalone Application

Skeleton Name: firmware-singleapp

Build Type Name: com.is2t.easyant.buildtypes#build-firmware-singleapp

Documentation: Standalone Application

SDKMenu: File > New > Standalone Application Project

Configuration:

This module nature inherits the configuration properties of the following plugins:

• Java Compilation

• Platform Loader

This module nature defines the following dedicated configuration properties:

Name Description Default
application.main.class Full Qualified Name of themain class of the application. This option

is required.
Not set

skip.build.virtual.device When this property is set (any value), the virtual device is not built. Not set
virtual.device.sim.only When this property is set (any value), the firmware is not built. Not set

3.7.10 Natures Plugins

This page describes the most commonmodule nature plugins as follows:

• Documentation: link to documentation.

• Module Natures: list ofModule Natures using this plugin.

• Configuration: properties that can be defined to configure the module. Properties are defined inside the
ea:build tag of themodule.ivy file, using ea:property tag as described in the section Build Options.

Java Compilation

Module Natures:

This plugin is used by the following module natures:

• Add-On Library
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• Foundation Library API

• Foundation Library Implementation

• Standalone Application

• Sandboxed Application

Configuration:

This plugin defines the following configuration properties:

Name Description Default
javac.debug.level Comma-separated list of levels for the Java compiler debugmode.

lines,
source,
vars

javac.debug.mode When this property is set to true, the Java compiler is set in debug
mode. false

src.main.java Path of the folder containing the Java sources.
${basedir}/
src/main/
java

Platform Loader

Documentation: Platform Selection

Module Natures:

This plugin is used by the following module natures:

• Add-On Library

• Standalone Application

• Sandboxed Application

Configuration:

This plugin defines the following configuration properties:

Name Description Default
platform-
loader.platform.dir

Path of the folder to unzip the loaded platform to.
${target}/
platform

platform.loader.skip.load.platformWhen this property is set to true, the platform is not loaded. It
must be already available in the directory defined by the property
platform-loader.platform.dir . Use with caution: the platform
content may be modified during the build (e.g. in case of Testsuite
or Virtual Device build).

false

platform-
loader.target.platform.conf

The Ivy configuration used to retrieved the platform if fetched via
dependencies. platform

platform-
loader.target.platform.dir

Path of the root folder of the platform to use in the build. See Plat-
form Selection section for Platform Selection rules.

Not set

platform-
loader.target.platform.dropins

Absolute or relative (to the project root folder) path of the folder
where the platform can be found (see Platform Selection). dropins

platform-
loader.target.platform.file

Path of the platform file to use in the build. See Platform Selection
section for Platform Selection rules.

Not set
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Javadoc

Module Natures:

This plugin is used by the following module natures:

• Add-On Library

• Foundation Library API

• Sandboxed Application

Configuration:

This plugin defines the following configuration properties:

Name Description Default
src.main.java Path of the folder containing the Java sources.

${basedir}/
src/main/
java

javadoc.file.encoding Encoding used for the generated Javadoc.
UTF-8

javadoc.failonerror When this property is set to true, the build is stopped if an error is
raised during the Javadoc generation. true

javadoc.failonwarning When this property is set to true, the build is stopped if a warning is
raised during the Javadoc generation. false

target.reports Path of the base folder for reports.
${target}/
reports

target.javadoc Path of the base folder where the Javadoc is generated.
${target.
reports}/
javadoc

target.javadoc.main Path of the folder where the Javadoc is generated.
${target.
javadoc}/
main

javadoc-
microej.overview.html

Path of the HTML template file used for the Javadoc overview page.
${src.
main.
java}/
overview.
html if
exists, oth-
erwise a
default
template.

target.artifacts Path of the packaged artifacts.
${target}/
artifacts

target.artifacts.main.javadoc.jar.nameName of the packaged JAR containing the generated Javadoc
(stored in folder target.artifacts ). ${module.

name}-javadoc.
jar

javadoc.publish.conf Ivy configuration used to publish the Javadoc artifact.
documentation
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Test Suite

Documentation: Test Suite with JUnit

Module Natures:

This plugin is used by the following module natures:

• Add-On Library

• Foundation Library API

• Foundation Library Implementation

• Standalone Application

• Sandboxed Application

Configuration:

This plugin defines the following configuration properties:

Name Description Default
microej.testsuite.cc.excludes.classesPattern of classes excluded from the code coverage anal-

ysis.
Not set

microej.testsuite.properties.s3.cc.activatedWhen this property is set to true, the code coverage anal-
ysis is enabled. true

cc.src.folders Path to the folders containing the Java sources used for
code coverage analysis.

Not set

microej.testsuite.verbose When this property is set to true, the verbose trace level
is enabled. false

test.run.excludes.pattern Pattern of classes excluded from the test suite execution. Empty string (no test)
test.run.failonerror When this property is set to true, the build fails if an error

is raised. true

test.run.includes.pattern Pattern of classes included in the test suite execution.
**/* (all tests)

skip.test When this property is set (any value), the tests are not ex-
ecuted.

Not set

J2SE Unit Tests

Warning: This plugin is reserved for tools written in Java Standard Edition. Tests classes must be created in
the folder src/test/java of the project. See Test Suite section for MicroEJ tests.

Module Natures:

This plugin is used by the following module natures:

• Add-On Processor

• Mock

Configuration:

This plugin defines the following configuration properties:
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Name Description Default
test.run.excludes.pattern Pattern of classes excluded from the test suite execution. Empty string

(no test)
test.run.failonerror When this property is set to true, the build fails if an error is raised.

true
test.run.includes.pattern Pattern of classes included in the test suite execution.

**/* (all
tests)

skip.test When this property is set (any value), the tests are not executed. Not set

Artifact Checker

Module Natures:

This plugin is used by the following module natures:

• Add-On Library

• Foundation Library API

• Standalone Application

• Sandboxed Application

• Module Repository

Configuration:

This plugin defines the following configuration properties:

Name Description Default
run.artifact.checker When this property is set (any value), the artifact checker is exe-

cuted.
Not set

skip.addonconf.checker When this property is set to true, the addon configurations checker
is not executed.

Not set

skip.changelog.checker When this property is set to true, the changelog checker is not exe-
cuted.

Not set

skip.foundationconf.checkerWhen this property is set to true, the foundation configurations
checker is not executed.

Not set

skip.license.checker When this property is set to true, the license checker is not executed. Not set
skip.publicconf.checker When this property is set to true, the public configurations checker

is not executed.
Not set

skip.readme.checker When this property is set to true, the readme checker is not exe-
cuted.

Not set

skip.retrieve.checker When this property is set to true, the retrieve checker is not exe-
cuted.

Not set

3.8 Module Repository

A module repository is a module that bundles a set of modules in a portable ZIP file. It is a tree structure where
modules organizations and names are mapped to folders.
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Fig. 26: Example of MicroEJ Module Repository Tree

Amodule repository takes its input modules from other repositories, usually theMicroEJ Central Repository which
is itself built by MicroEJ Corp. as a module repository.
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A module repository is o�en called an o�line repository as it includes the settings file for a local configuration in
MicroEJ SDK. It can also be imported in MicroEJ Forge.

3.8.1 Create a Repository Project

In MicroEJ SDK, first create a newmodule project using the artifact-repository skeleton.

• The ivysettings.xml settings file describes how to import the modules of this repository when it is ex-
tracted locally on file system. This file will be packaged at the root of the zip file and does not need to be
modified.

• The module.ivy file describes how to build repository and lists the module dependencies that will be in-
cluded in this repository.

3.8.2 Configure Resolver for Input Modules

MicroEJ Module Manager (MMM) needs to import dependencies to build the module repository. The location
fetched by MMM is defined by a resolver. The resolver is configured with the parameter bar.populate.from.
resolver . The preset value is the resolver provided by default in MicroEJ SDK configuration, which is connected
toMicroEJ Central Repository.

<ea:property name="bar.populate.from.resolver" value="MicroEJChainResolver"/>

The MicroEJChainResolver is a URL resolver defined in $USER_HOME\.
microej\microej-ivysettings-[VERSION].xml that points to MicroEJ Central Repository.

3.8.3 Configure Consistency Check

The module repository consistency check consists in verifying that each declared module can be imported using
the settings file provided by the repository. Especially, it ensures that all module transitive dependencies are also
available.

It is enabled by default to avoid further issues for repository users such as Unresolved Dependency. This is done by
the following option:

<ea:property name="skip.retrieve.checker" value="false"/>

Moreover, to ensure the repository will be compliant with theMMM specification, add the following option:

<ea:property name="bar.check.as.v2.module" value="true"/>

3.8.4 Advanced Options

There are other advanced options that do not need to be modified by default. These options are described in the
module.ivy generated by the skeleton.

3.8.5 Include Modules

Modules bundled into the module repository must be declared in the dependencies element of the module.ivy
file.
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Include a Single Module

To add amodule, declare themodule dependency using the artifacts configuration:

<dependencies>
<dependency conf="artifacts->*" transitive="false" org="[module_org]" name="[module_name]" rev=

→˓"[module_version]" />

<!-- ... other dependencies ... -->
</dependencies>

For example, to add the ej.api.edc library version 1.2.3 , write the following line:

<dependency conf="artifacts->*" transitive="false" org="ej.api" name="edc" rev="1.2.3" />

Note: We recommended to manually describe each dependency of the module repository, in order to keep full
controlof the includedmodulesaswell as includedmodulesversions. Moduledependencies canstill be transitively
included by setting the dependency attribute transitive to true . In this case, the includedmodule versions are
those that have been resolved when the module was built.

Multiple versions of the same module can be included by declaring each dependency using a di�erent configura-
tion. The artifacts configurationhas tobederivedwith anewnameasmany times as there aredi�erent versions
to include.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="artifacts" visibility="private"/>
<conf name="artifacts_1" visibility="private"/>
<conf name="artifacts_2" visibility="private"/>

<!-- ... other configurations ... -->
</configurations>

<dependencies>
<dependency conf="artifacts->*" transitive="false" org="[module_org]" name="[module_name]" rev=

→˓"[module_version_1]" />
<dependency conf="artifacts_1->*" transitive="false" org="[module_org]" name="[module_name]" rev=

→˓"[module_version_2]" />
<dependency conf="artifacts_2->*" transitive="false" org="[module_org]" name="[module_name]" rev=

→˓"[module_version_3]" />

<!-- ... other dependencies ... -->
</dependencies>

Include a Module Repository

To add all the modules already included in an other module repository, add the configuration repository if it
does not exist:

<configurations defaultconfmapping="default->default;provided->provided">
<!-- ... other configurations ... -->
<conf name="repository" visibility="private" description="Repository to be embedded in the repository

→˓" />

</configurations>
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Then declare the module repository dependency using the repository configuration:

<dependencies>
<dependency conf="repository->*" transitive="false" org="[repository_org]" name="[repository_name]"␣

→˓rev="[repository_version]" />

<!-- ... other dependencies ... -->
</dependencies>

3.8.6 Build the Repository

In the Package Explorer, right-click on the repository project and select Build Module .

The build consists of two steps:

1. Gathers all module dependencies. The whole repository content is created under target~/
mergedArtifactsRepository folder.

2. Checks the repository consistency. For each module, it tries to import it from this repository and fails the
build if at least one of the dependencies cannot be resolved.

Themodule repository .zip file is built in the target~/artifacts/ folder. This file may be published along with
a CHANGELOG.md , LICENSE.txt and README.md .

3.8.7 Use the O�line Repository

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from MicroEJ
Central Repository.

To configure MicroEJ SDK to import dependencies from a local module repository:

1. Unzip the module repository .zip file to the folder of your choice,

2. ConfigureMMMsettings file using the ivysettings.xml file located at the root of the folderwhere the repos-
itory has been extracted.

3.9 MicroEJ Classpath

MicroEJ Applications run on a target device and their footprint is optimized to fulfill embedded constraints. The
final execution context is an embedded device that may not even have a file system. Files required by the appli-
cation at runtime are not directly copied to the target device, they are compiled to produce the application binary
code which will be executed by MicroEJ Core Engine.

As a part of the compile-time trimming process, all types not required by the embedded application are eliminated
from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final application
binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or a zip file, called a JAR
file (JAR stands for Java ARchive).

• Application Classpath explains how the MicroEJ Classpath is built from a MicroEJ Application project.

• Classpath Load Model explains how the application contents is loaded fromMicroEJ Classpath.

• Classpath Elements specifies the di�erent elements that can be declared in MicroEJ Classpath to describe
the application contents.
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3.9.1 Application Classpath

The following schema shows the classpath mapping from a MicroEJ Application project to the MicroEJ Classpath
ordered list of folders and JAR files. The classpath resolution order (le� to right) follows the project appearance
order (top to bottom).

Fig. 27: MicroEJ Application Classpath Mapping

3.9.2 Classpath Load Model

A MicroEJ Application classpath is created via the loading of :

• an entry point type,

• all *.[extension].list files declared in a MicroEJ Classpath.

Thedi�erentelements that constituteanapplicationaredescribed inClasspathElements. Theyare searchedwithin
MicroEJ Classpath from le� to right (the first file found is loaded). Types referenced by previously loaded MicroEJ
Classpath elements are loaded transitively.
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Fig. 28: Classpath Load Principle

3.9.3 Classpath Elements

The MicroEJ Classpath contains the following elements:

• An entrypoint described in section Application Entry Points;

• Types in .class files, described in section Types;

• Raw resources, described in section Raw Resources;

• Immutables Object data files, described in Section Immutable Objects;

• Images, Fonts and Native Language Support (NLS) resources, described in Application Resources;

• *.[extension].list files, declaring contents to load. Supported list file extensions and format is specific
to declared application contents and is described in the appropriate section.

At source level, Java types are stored in src/main/java folder of themodule project, any other kind of resources
and list files are stored in the src/main/resources folder.

Application Entry Points

MicroEJ Application entry point declaration di�ers depending on the application kind:

• In case of a MicroEJ Standalone Application, it is a class that contains a public static void
main(String[]) method, declared using the option application.main.class .
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• In case of a MicroEJ Sandboxed Application, it is a class that implements ej.kf.FeatureEntryPoint , de-
clared in the Application-EntryPoint entry in META-INF/MANIFEST.MF file.

Types

MicroEJ types (classes, interfaces) are compiled from source code ( .java ) to classfiles ( .class ). When a type is
loaded, all types dependencies found in the classfile are loaded (transitively).

A type can be declared as a Required type in order to enable the following usages:

• to be dynamically loaded from its name (with a call to Class.forName(String) );

• to retrieve its fully qualified name (with a call to Class.getName() ).

A type that is not declared as a Required typemay not have its fully qualified name (FQN) embedded. Its FQN can
be retrieved using the stack trace reader tool (see Stack Trace Reader).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a standard Java
properties file, each line listing the fully qualified name of a type. Example:

# The following types are marked as MicroEJ Required Types
com.mycompany.MyImplementation
java.util.Vector

Raw Resources

Raw resources are binary files that need to be embedded by the application so that they may be dynamically re-
trieved with a call to Class.getResourceAsStream(java.io.InputStream) . Raw Resources are declared in Mi-
croEJ Classpath using *.resources.list files. The file format is a standard Java properties file, each line is a
relative / separated name of a file in MicroEJ Classpath to be embedded as a resource. Example:

# The following resource is embedded as a raw resource
com/mycompany/MyResource.txt

Others resources types are supported in MicroEJ Classpath, see Application Resources for more details.

Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to ej.bon.Immutables.
get(String) . Immutables objects are declared in files called immutable objects data files, which format is de-
scribed in the [BON] specification. Immutables objects data files are declared in MicroEJ Classpath using *.
immutables.list files. The file format is a standard Java properties file, each line is a / separated name of a
relative file in MicroEJ Classpath to be loaded as an Immutable objects data file. Example:

# The following file is loaded as an Immutable objects data files
com/mycompany/MyImmutables.data

System Properties

System Properties are key/value string pairs that can be accessed with a call to System.getProperty(String).

System Properties are defined when building a Standalone Application, by declaring *.properties.list files in
MicroEJ Classpath.

The file format is a standard Java properties file. Example:
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Listing 1: Example of Contents of a MicroEJ Properties File

# The following property is embedded as a System property
com.mycompany.key=com.mycompany.value
microedition.encoding=ISO-8859-1

System Properties are resolved at runtime, and all declared keys and values are embedded as intern Strings.

System Properties can also be defined using Application Options. This can be done by setting the option with a
specific prefix in their name:

• Properties for both the MicroEJ Core Engine and the MicroEJ Simulator : name starts with microej.java.
property.*

• Properties for the MicroEJ Simulator: name starts with sim.java.property.*

• Properties for the MicroEJ Core Engine: name starts with emb.java.property.*

For example, to define the property myProp with the value theValue , set the following option :

Listing 2: Example of MicroEJ System Property Definition as Applica-
tion Option

microej.java.property.myProp=theValue

Option can also be set in the VM arguments field of the JRE tab of the launch using the -D option (e.g. -Dmicroej.
java.property.myProp=theValue ).

Note: When building a Sandboxed Application, *.properties.list files found in MicroEJ Classpath are silently
skipped.

Constants

Note: This feature require [BON] version 1.4 which is available in MicroEJ Runtime starting from MicroEJ Archi-
tecture version 7.11.0 .

Constants are key/value string pairs that can be accessed with a call to ej.bon.Constants.get[Type](String) ,
where Type if one of:

• Boolean,

• Byte,

• Char,

• Class,

• Double,

• Float,

• Int,

• Long,

• Short,

• String.
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Constants are declared inMicroEJ Classpath *.constants.list files. The file format is a standard Java properties
file. Example:

Listing 3: Example of Contents of a BON constants File

# The following property is embedded as a constant
com.mycompany.myconstantkey=com.mycompany.myconstantvalue

Constants are resolved at binary level without having to recompile the sources.

At link time, constants are directly inlined at the place of Constants.get[Type] method calls with no cost.

The String key parameter must be resolved as an inlined String:

• either a String literal "com.mycompany.myconstantkey"

• or a static final String field resolved as a String constant

The String value is converted to the desired type using conversion rules described by the [BON] API.

A boolean constant declared in an if statement condition can be used to fully remove portions of code. This
feature is similar to C pre-processors #ifdef directive with the di�erence that this optimization is performed at
binary level without having to recompile the sources.

Listing 4: Example of if code removal using a BON boolean constant

if (Constants.getBoolean("com.mycompany.myconstantkey")) {
System.out.println("this code and the constant string will be fully removed when the constant is␣

→˓resolved to 'false'")
}

Please mind that Constants.getXXX must be inlined in the if condition to take e�ect. The following piece of
code will not remove the code:

static final boolean MY_CONSTANT = Constants.getBoolean("com.mycompany.myconstantkey");

...

if(MY_CONSTANT){
System.out.println("this code will not be removed when MY_CONSTANT is resolved to 'false'")

}

Note: InMulti-Sandbox environment, constants are processed locally within each context. In particular, constants
defined in the Kernel are not propagated to Sandboxed Applications.

3.10 Application Resources

Application resources are the following Classpath Elements:

• Images

• Fonts

• Native Language Support
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3.10.1 Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.getImage() or
ej.microui.display.ResourceImage.loadImage() . To be displayed, these images have to be converted from their
source format to the display raw format. The conversion can either be done at :

• build-time (using the image generator tool),

• run-time (using the relevant decoder library).

Images thatmustbeprocessedby the imagegenerator tool aredeclared inMicroEJClasspath *.images.list files.
The file format is a standard Java properties file, each line representing a / separated resource path relative to the
MicroEJ classpath root referring to a standard image file (e.g. .png , .jpg ). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImage1.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Please refer to Images for more information.

3.10.2 Fonts

Overview

Fonts are graphical resources that can be accessedwith a call to ej.microui.display.Font.getFont(). To be displayed,
these fonts have to be converted at build-time from their source format to the display raw format by the font gener-
ator tool. Fonts thatmust be processedby the font generator tool are declared inMicroEJ Classpath *.fonts.list
files. The file format is a standard Java properties file, each line representing a / separated resource path relative
to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension). The resourcemay
be followed by optional parameters which define :

• some ranges of characters to embed in the final raw file;

• the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depth is 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
(continues on next page)
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(continued from previous page)

# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf su�ix and are created using the Font Designer (see Font De-
signer).

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are twoways to specify a character range: the custom range
and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.

Examples:

• myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

• myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and
from 0x55 to 0x75.

• myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to
0x49 and character 0x55.

Known Range

A known range is a range available in the following table.

Examples:

• myfont:basic_latin : Embed all Basic Latin characters;

• myfont:basic_latin;arabic : Embed all Basic Latin characters, and all Arabic characters.

Transparency

The second parameter is for specifying the font transparency level ( 1 , 2 , 4 or 8 ). If unspecified, the encoded
transparency level is 1 (does not depend on transparency level encoded in EJF file).

Examples:

• myfont:latin:4 : Embed all latin characters with 16 levels of transparency

• myfont::2 : Embed all characters with 4 levels of transparency

3.10. Application Resources 129



MicroEJ Documentation, Revision 2788b3f4

3.10.3 Native Language Support

Native Language Support (NLS) allows the application to facilitate internationalization. It provides support to ma-
nipulate messages and translate them in di�erent languages. Each message to be internationalized is referenced
by a key, which can be used in the application code instead of using the message directly.

Messages must be defined in PO files in the MicroEJ Classpath of the application. Here is an example:

msgid ""
msgstr ""
"Language: en_US\n"
"Language-Team: English\n"
"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=UTF-8\n"

msgid "Label1"
msgstr "My label 1"

msgid "Label2"
msgstr "My label 2"

These PO files have to be converted to be usable by the application. In order to let the build system knowwhich PO
files to process, they must be referenced in MicroEJ Classpath *.nls.list files. The file format of these *.nls.
list files is a standard Java properties file. Each line represents the Full Qualified Name of a Java interface that
will be generated and used in the application. Here is an example, let’s call it i18n.nls.list:

com.mycompany.myapp.Labels
com.mycompany.myapp.Messages

For each line, PO files whose name starts with the interface name ( Messages and Labels in the example) are
retrieved from the MicroEJ Classpath and used to generate:

• a Java interface with the given FQN, containing a field for each msgid of the PO files

• a NLS binary file containing the translations

So, in the example, the generated interface com.mycompany.myapp.Labels will gather all the translations from
files named Labels*.po and located in the MicroEJ Classpath. PO files are generally su�ixed by their locale (
Labels_en_US.po ) but it is only for convenience since the su�ix is not used, the locale is extracted from the PO
file’s metadata.

Once the generation is done, the application can use the Java interfaces to get internationalized messages, for
example:

import com.mycompany.myapp.Labels;

public class MyClass {

String label = Labels.Label1;

...

The generation is triggered when building the application or a�er a change done in any PO or *.nls.list files.
This allows to always have the Java interfaces up-to-date with the translations and to use them immediately.

The NLS API module must be added to themodule.ivy of the MicroEJ Application project to use the NLS library.

<dependency org="ej.library.runtime" name="nls" rev="3.0.1"/>
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3.11 Platform Selection

Building or running a Test Suite on an application module requires a MicroEJ Platform.

There are 4 di�erent ways to provide a MicroEJ Platform for a module project:

• Set the build option platform-loader.target.platform.file to the path of a MicroEJ Platform file ( .zip
, .jpf or .vde ).

• Set thebuild option platform-loader.target.platform.dir to thepathof the source folder of analready
imported Source Platform.

• Declare amodule dependency with the conf platform :

<dependency org="myorg" name="myname" rev="1.0.0" conf="platform->default" transitive="false"/>

• Copy a MicroEJ Platform file to the dropins folder. The default dropins folder location is
[module_project_dir]/dropins . It can be changed using the build option platform-loader.target.
platform.dropins .

At least 1 of these 4 ways is required to build an application with a platform. If several ways are used, the following
rules are applied:

• If platform-loader.target.platform.file or platform-loader.target.platform.dir is set, the other
options are ignored.

• If the the module project defined several platforms, the build fails. For example the following cases are not
allowed:

– Setting a platform with the option platform-loader.target.platform.file and another one with
the option platform-loader.target.platform.dir

– Declaring a platform as a dependency and adding a platform in the dropins folder

– Declaring 2 platforms as Dependencies

– Adding 2 platforms in the dropins folder

Refer to the Platform Loader section for a complete list of options.

3.12 Development Tools

MicroEJprovidesanumberof tools toassistwith variousaspectsof development. Someof these tools are runusing
MicroEJ Tool configurations, and created using the Run Configurations dialog of the MicroEJ SDK. A configuration
must be created for the tool before it can be used.
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Fig. 29: MicroEJ Tool Configuration

The above figure shows a tool configuration being created. In the figure, the MicroEJ Platform has been selected,
but the selection of which tool to run has not yet been made. That selection is made in the Execution Settings. . .
box. The Configuration tab then contains the options relevant to the selected tool.

3.12.1 Test Suite with JUnit

MicroEJ allows to run unit tests using the standard JUnit API during the build process of a MicroEJ library or a
MicroEJ Application. TheMicroEJ Test Suite Engine runs tests on a target Platform and outputs a JUnit XML report.

Principle

JUnit testing can be enabled when using the microej-javalib (MicroEJ Add-On Library) or the
microej-application (MicroEJ Applications) build type. JUnit test cases processing is automatically enabled
when the following dependency is declared in the module.ivy file of the project.

<dependency conf="test->*" org="ej.library.test" name="junit" rev="1.5.0"/>
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WhenanewJUnit test case class is created in the src/test/java folder, a JUnit processor generatesMicroEJ com-
pliant classes into a specific source folder named src-adpgenerated/junit/java . These files are automatically
managed andmust not be edited manually.

JUnit Compliance

MicroEJ is compliant with a subset of JUnit version 4. MicroEJ JUnit processor supports the following annotations:
@After , @AfterClass , @Before , @BeforeClass , @Ignore , @Test .

Each test case entry point must be declared using the org.junit.Test annotation ( @Test before amethod dec-
laration). Please refer to JUnit documentation to get details on usage of other annotations.

Setup a Platform for Tests

Before running tests, a target platformmust be configured.

Execution in SDK

In order to execute the Test Suite in the SDK, a target platformmust be configured in the MicroEJ workspace. The
following stepsassume that aplatformhasbeenpreviously imported into theMicroEJPlatformrepository (or avail-
able in the Workspace):

• Go to Window > Preferences > MicroEJ > Platforms (or Platforms in workspace ).

• Select the desired platform on which to run the tests.

• Press F2 to expand the details.

• Select the the platform path and copy it to the clipboard.

• Go to Window > Preferences > Ant > Runtime and select the Properties tab.

• Click on Add Property. . . button and set a new property named target.platform.dir with the platform
path pasted from the clipboard.

Execution duringmodule build

Inorder toexecute theTestSuiteduring thebuildof themodule, a targetplatformmustbeconfigured in themodule
project as described in the section Platform Selection.

Setup a Project with a JUnit Test Case

This section describes how to create a new JUnit Test Case starting from a newMicroEJ library project.

• First create a newmodule project using the microej-javalib skeleton. A new project named mylibrary is
created in the workspace.

• Right-click on the src/test/java folder and select New > Other. . . menu item.

• Select the Java > JUnit > New JUnit Test Case wizard.

• Enter a test name and press Finish . A new JUnit test case class is created with a default failing test case.
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Build and Run a JUnit Test Suite

• Right-clickon the mylibrary project and select Build Module . A�er the library is built, the test suite engine
launches available test cases and the build process fails in the console view.

• On the mylibrary project, right-click and select Refresh . A target~ folder appears with intermediate
build files. The JUnit report is available at target~\test\xml\TEST-test-report.xml .

• Double-click on the file to open the JUnit test suite report.

• Modify the test case by replacing

fail("Not yet implemented");

with

Assert.assertTrue(true);

• Right-click again on the mylibrary project and select Build Module . The test is now successfully executed
on the target platform so the MicroEJ Add-On Library is fully built and published without errors.

• Double-click on the JUnit test suite report to see the test has been successfully executed.

Test Suite Reports

Once a test suite is completed, the following test suite reports are generated:

• JUnit HTML report in the module project location target~/test/html/test/junit-noframes.html . This
report contains a summary and the execution trace of every executed test.

Fig. 30: Example of MicroEJ Test Suite HTML Report

• JUnit XML report in the module project location target~/test/xml/TEST-test-report.xml .
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Fig. 31: Example of MicroEJ Test Suite XML Report

XML report file can also be open in the JUnit View. Right-click on the file > Open With > JUnit View :

Fig. 32: Example of MicroEJ Test Suite XML Report in JUnit View

If executed on device, the Firmware binary produced for each test is available inmodule project location target~/
test/xml/<TIMESTAMP>/bin/<FULLY-QUALIFIED-CLASSNAME>/application.out .

Advanced Configurations

Autogenerated Test Classes

The JUnit processor generates test classes into the src-adpgenerated/junit/java folder. This folder contains:

_AllTestClasses.java file A single classwith amain enty point that sequentially calls all declared testmethods
of all JUnit test case classes.

_AllTests_[TestCase].java files For each JUnit test case class, a class with a main entry point that sequen-
tially calls all declared test methods.

_SingleTest_[TestCase]_[TestMethod].java files For each test method of each JUnit test case class, a class
with a main entry point that calls the test method.

JUnit Test Case to MicroEJ Test Case

TheMicroEJ Test Suite Engine allows to select the classes that will be executed, by setting the following property in
the project module.ivy file.

<ea:property name="test.run.includes.pattern" value="[MicroEJ Test Case Include Pattern]"/>

The following line consider all JUnit testmethodsof the sameclassasa singleMicroEJ test case (default behaviour).
If at least one JUnit test method fails, the whole test case fails in the JUnit report.
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<ea:property name="test.run.includes.pattern" value="**/_AllTests_*.class"/>

The following line consider each JUnit test method as a dedicated MicroEJ test case. Each test method is viewed
independently in the JUnit report, but this may slow down the test suite execution because a new deployment is
done for each test method.

<ea:property name="test.run.includes.pattern" value="**/_SingleTest_*.class"/>

Run a Single Test Manually

Each test can be run independently as each class contains a main entry point.

In the src-adpgenerated/junit/java folder, right-click on the desired autogenerated class (
_SingleTest_[TestCase]_[TestMethod].java ) and select Run As > MicroEJ Application .

The test is executed on the selected Platform and the output result is dumped into the console.

Test Suite Options

The MicroEJ Test Suite Engine can be configured with specific options which can be added to the module.ivy file
of the project running the test suite, within the <ea:build> XML element.

• Application Option Injection

It is possible to inject an Application Option for all the tests, by adding to the original option the microej.
testsuite.properties. prefix:

<ea:property name="microej.testsuite.properties.[application_option_name]" value="[application_
→˓option_value]"/>

• Retry Mechanism

A test execution may not be able to produce the success trace for an external reason, for example an unre-
liable harness script that may lose some trace characters or crop the end of the trace. For all these unlikely
reasons, it is possible to configure the number of retries before a test is considered to have failed:

<ea:property name="microej.testsuite.retry.count" value="[nb_of_retries]"/>

By default, when a test has failed, it is not executed again (option value is set to 0 ).

Test Specific Options

The MicroEJ Test Suite Engine allows to define Application Options specific to each test case. This can be done by
defining a file with the same name as the generated test case file with the .properties extension instead of the
.java extension. The file must be put in the src/test/resources folder and within the same package than the
test case file.

3.12.2 Stack Trace Reader

3.12. Development Tools 136



MicroEJ Documentation, Revision 2788b3f4

Principle

Stack Trace Reader is a MicroEJ tool that reads and decodes the MicroEJ stack traces. When an exception occurs,
theMicroEJCore Engine prints the stack trace on the standard output System.out . The class names, non-required
types names(see Types), and method names obtained are encoded with a MicroEJ internal format. This internal
format prevents embedding all class names and method names in the executable image to save some memory
space. The Stack Trace Reader tool allows you to decode the stack traces by replacing the internal class names and
method names with their real names. It also retrieves the line numbers in the MicroEJ Application.

Functional Description

The Stack Trace Reader reads the debug information from the fully linked ELF file (the ELF file that contains the
MicroEJ Core Engine, the other libraries, the BSP, the OS, and the compiled MicroEJ Application). It prints the
decoded stack trace.

WhenMulti-Sandbox capability is enabled, the stack trace reader can simultaneously decode heterogeneous stack
traces with lines owned by di�erent MicroEJ Sandboxed Applications and the firmware. Lines owned by the
firmware can be decoded with the firmware debug information file (optionally made available by your firmware
provider).

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use (Standalone Application)

For example, write the following new line to dump the currently executed stack trace on the standard output.

Fig. 33: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application executable ELF file. In the
case of a platformwith full BSP connection (see BSP Connection Cases), the file is application.out in the output
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folder. In the other cases, the ELF file is generated by the C toolchainwhen building the BSP project (usually a .out
or .axf file).

Fig. 34: Application Binary File

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.

Fig. 35: Stack Trace Output
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To create a new MicroEJ Tool configuration, right-click on the application project and click on Run As. . . >
Run Configurations. . . .

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the
Stack Trace Reader tool. Set an output folder in the Output folder field.

Fig. 36: Stack Trace Reader Tool Configuration (Platform Selection)

In Configuration tab, browse the previously generated application binary file with debug information (
application.out in case of a Standalone Application with full BSP connection)
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Fig. 37: Stack Trace Reader Tool Configuration (Standalone Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.

Fig. 38: Stack Trace Reader Console

Use (Sandboxed Application)

For example, write the following new line to dump the currently executed stack trace on the standard output.
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Fig. 39: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application binary file with debug
information ( application.fodbg in the output folder). Note that the file uploaded on the device is application.
fo (stripped version without debug information).

Fig. 40: Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.
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Fig. 41: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on Run As. . . >
Run Configurations. . . .

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the
Stack Trace Reader tool. Set an output folder in the Output folder field.

Fig. 42: Stack Trace Reader Tool Configuration (Virtual Device Selection)

In the Configuration tab, if the Kernel executable file is available to you (usually named firmware.out and

located in your Virtual Device files), you canbrowse for it in the Executable file field, and thenadd your previously
generatedapplicationbinary filewithdebug information (application.fodbg in caseof aSandboxedApplication)
in the Additional object files field.
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Fig. 43: Select the Kernel Executable File

To checkwhere theKernel executable file of your Virtual Device is located, if youhave access to it, go to Window >
Preferences > MicroEJ > Virtual Devices , hoverover yourVirtualDevice in the list andwaituntil an information
popup appears. Press F2 to get all the informations and the path to the directory of your Virtual Device should
appear in the list.
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Fig. 44: Location of the Virtual Device Directory

In this directory, the Kernel executable file should be named firmware.out in the /firmware sub-directory.

If you do not have access to the Kernel executable file, you can still get some information from the Stack Trace
Reader using the application binary file only. In the Configuration tab, browse the previously generated applica-
tion binary file with debug information ( application.fodbg in case of a Sandboxed Application)
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Fig. 45: Stack Trace Reader Tool Configuration (Sandboxed Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.
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Fig. 46: Stack Trace Reader Console

Other debug information files can be appended using the Additional object files option.

Stack Trace Reader Options

The following section explains MicroEJ tool options.
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Category: Stack Trace Reader

Group: Application

Option(browse): Executable file

Option Name: application.file

Default value: (empty)

Description:

Specify the full path of a full linked elf file.

Option(list): Additional object files

Option Name: additional.application.files

Default value: (empty)

Group: “Trace port” interface for Eclipse

Description:

This group describes the hardware link between the device and the PC.

Option(combo): Connection type

Option Name: proxy.connection.connection.type
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Default value: Console

Available values:

Uart (COM)

Socket

File

Console

Description:

Specify the connection type between the device and PC.

Option(text): Port

Option Name: pcboardconnection.usart.pc.port

Default value: COM0

Description:

Format: port name

Specifies the PC COM port:

Windows - COM1 , COM2 , ... , COM*n*

Linux - /dev/ttyS0 , /dev/ttyS1 , ... , /dev/ttyS*n*

Option(combo): Baudrate

Option Name: pcboardconnection.usart.pc.baudrate

Default value: 115200

Available values:

9600

38400

57600

115200

Description:

Defines the COM baudrate for PC-Device communication.

Option(text): Port

Option Name: pcboardconnection.socket.port

Default value: 5555

Description:

IP port.
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Option(text): Address

Option Name: pcboardconnection.socket.address

Default value: (empty)

Description:

IP address, on the form A.B.C.D.

Option(browse): Stack trace file

Option Name: pcboardconnection.file.path

Default value: (empty)

3.12.3 Code Coverage Analyzer

Principle

TheMicroEJSimulator features anoption tooutput .cc (CodeCoverage) files that represent theuse rateof functions
of an application. It traces how the opcodes are really executed.

Functional Description

The Code Coverage Analyzer scans the output .cc files, and outputs anHTML report to ease the analysis ofmethods
coverage. The HTML report is available in a folder named htmlReport in the same folder as the .cc files.

3.12. Development Tools 149



MicroEJ Documentation, Revision 2788b3f4

Fig. 47: Code Coverage Analyzer Process

Dependencies

In order to work properly, the Code Coverage Analyzer should input the .cc files. The .cc files relay the classpath
used during the execution of the Simulator to the Code Coverage Analyzer. Therefore the classpath is considered
to be a dependency of the Code Coverage Analyzer.

Installation

This tool is a built-in platform tool.

Use

A MicroEJ tool is available to launch the Code Coverage Analyzer tool. The tool name is Code Coverage Analyzer.

Two levels of code analysis are provided, the Java level and the bytecode level. Also provided is a view of the fully
or partially covered classes and methods. From the HTML report index, just use hyperlinks to navigate into the
report and source / bytecode level code.
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Category: Code Coverage

Option(browse): *.cc files folder

Option Name: cc.dir

Default value: (empty)

Description:

Specify a folder which contains the cc files to process (*.cc).

Group: Classes filter

Option(list): Includes

Option Name: cc.includes

Default value: (empty)

Description:

List packages and classes to include to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:

packageA.packageB.* : includes all classes which are in package packageA.packageB

packageA.packageB.className : includes the class packageA.packageB.className
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Option(list): Excludes

Option Name: cc.excludes

Default value: (empty)

Description:

List packages and classes to exclude to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:

packageA.packageB.* : excludes all classes which are in package packageA.packageB

packageA.packageB.className : excludes the class packageA.packageB.className

3.12.4 Heap Usage Monitoring

Introduction

When building a Standalone Application, the Java heap size must be specified as an Application Option (see Op-
tion(text): Java heap size (in bytes)). The value to set in this option depends on the maximum heap usage, and the
developer can estimate it by running the application.

The MicroEJ Core Engine provides a Java API to introspect the heap usage at runtime. Additionally, heap usage
monitoring can be enabled to compute the maximum heap usage automatically.

Here are the descriptions of the di�erent notions related to heap usage:

• Heap:memory area used to store the objects allocated by the application.

• Heap Size: current size of the heap.

• Maximum Heap Size: maximum size of the heap. The heap size cannot exceed this value. See Option(text):
Java heap size (in bytes).

• Heap Usage: the amount of the heap currently being used to store alive objects.

• Garbage Collector (GC): amemorymanager in charge of recycling unused objects to increase freememory.

Fig. 48: Heap Structure Summary

The Java class java.lang.Runtime defines the following methods:
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• gc(): Runs the garbage collector. System.gc() is an alternative means of invoking this method.

• freeMemory(): Returns the amount of free memory in the heap. This value does not include unused objects
eligible for garbage collection. Calling the gc() method may result in increasing the value returned by this
method.

• totalMemory(): Returns the current size of the heap. The value returned by this methodmay vary over time.

• maxMemory(): Returns the maximum size of the heap.

Heap Usage Introspection

The methods provided by the Runtime class allow introspecting the heap usage by comparing the heap size and
the free memory size. A garbage collection must be executed before computing the heap usage to recycle all the
unused objects and count only alive objects.

The application can compute the current heap usage by executing the following code:

Runtime runtime = Runtime.getRuntime(); // get Runtime instance
runtime.gc(); // Ensure unused objects are recycled
long heapUsage = runtime.totalMemory() - runtime.freeMemory();

This example gives the heap usage at a given point but not the maximum heap usage of the application.

Note: When heap usage monitoring is disabled, the heap size is fixed, and so totalMemory() and maxMemory()
return the same value.

Automatic Heap Usage Monitoring

The maximum heap usage of an application’s execution can be computed automatically by enabling heap usage
monitoring.

Note: This feature is available in the MicroEJ Architecture versions 7.16.0 or higher.

When this option is activated, an initial size for the heapmust be specified, and the MicroEJ Core Engine increases
the heap size dynamically. The value returned by totalMemory() is the current heap size. maxMemory() returns the
maximum size of the heap. A call to gc() decreases the heap size to the higher value of either the heap usage or the
initial heap size.

At anymoment, totalMemory() returns themaximumheapusage of the current execution (assuming themaximum
heap usage is higher than the initial heap size, and gc() has not been called).

See the sectionOption(checkbox): Enable Javaheapusagemonitoring to enable this optionandconfigure the initial
heap size.

Even if the heap size can vary during time, a memory section of maxMemory() bytes is allocated at link time or
during the MicroEJ Core Engine startup. No dynamic allocation is performed when increasing the heap size.

Warning: A small initial heap size will impact the performances as the GCwill be executed every time the heap
size needs to be increased.

Furthermore, the smaller the heap size is, themore frequent the GCwill occur. This feature should be used only
for heap usage benchmarking.
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Heap Usage Analysis

To analyze heap usage and see what objects are alive in the application, use the Heap Dumper & Heap Analyzer
tools.

3.12.5 Heap Dumper & Heap Analyzer

Introduction

Heap Dumper is a tool that takes a snapshot of the heap. Generated files (with the .heap extension) are available
in the application output folder. Note that it works only on simulations. It is a built-in platform tool and has no
dependencies.

The Heap Analyzer is a set of tools to help developers understand the contents of the Java heap and find problems
such as memory leaks. For its part, the Heap Analyzer plugin is able to open dump files. It helps you analyze their
contents thanks to the following features:

• memory leaks detection

• objects instances browse

• heap usage optimization (using immortal or immutable objects)

The Heap

The heap is a memory area used to hold Java objects created at runtime. Objects persist in the heap until they are
garbage collected. An object becomes eligible for garbage collection when there are no longer any references to it
from other objects.

Heap Dump

A heap dump is an XML file that provides a snapshot of the heap contents at the moment the file is created. It
contains a list of all the instances of both class and array types that exist in the heap. For each instance, it records:

• The time at which the instance was created

• The thread that created it

• Themethod that created it

For instances of class types, it also records:

• The class

• The values in the instance’s non-static fields

For instances of array types, it also records:

• The type of the contents of the array

• The contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Heap Analyzer Tools

The Heap Analyzer is an Eclipse plugin that adds three tools to the MicroEJ environment.

Tool name Number of
input files

Purpose

Heap Viewer 1 Shows what instances are in the heap, when they were created,
and attempts to identify problem areas

Progressive
Heap Usage

1 or more Shows how the number of instances in the heap has changed over
time

Compare 2 Compares two heap dumps, showing which objects were created,
or garbage collected, or have changed values

Heap Dumper

When the Heap Dumper option is activated, the garbage collector process ends by performing a dump file that
represents a snapshot of the heap at this moment. Thus, to generate such dump files, you must explicitly call the
System.gc() method in your code, or wait long enough for garbage collector activation.

The heap dump file contains the list of all instances of both class and array types that exist in the heap. For each
instance, it records:

• the time at which the instance was created

• the thread that created it

• the method that created it

For instances of class types, it also records:

• the class

• the values in the instance’s non-static fields

For instances of array types, it also records:

• the type of the contents of the array

• the contents of the array

For each referenced class type, it records the values in the static fields of the class.

3.12. Development Tools 155



MicroEJ Documentation, Revision 2788b3f4

Category: Heap Dumper

Group: Application

Option(browse): Executable file

Option Name: application.filename

Default value: (empty)

Description:

Specify the full path of a full linked ELF file.

Option(list): Resident application files

Option Name: additional.application.filenames

Default value: (empty)

Description:

Specify the full path of System Applications .out files linked by the Firmware Linker.

Group: Memory

Option(browse): Heapmemory file

Option Name: heap.filename

Default value: (empty)
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Description:

Specify the full path of heapmemory dump, in Intel Hex format.

Group: Output

Option(text): Heap file name

Option Name: output.name

Default value: application.heap

Heap Viewer

To open the Heap Viewer tool, select a heap dump XML file in the Package Explorer , right-click on it and select

Open With > Heap Viewer

Alternatively, right-click on it and select Heap Analyzer > Open heap viewer

This will open a Heap Viewer tool window for the selected heap dump1.

The Heap Viewer works in conjunction with two views:

1. The Outline view

2. The Instance Browser view

These views are described below.

The Heap Viewer tool has three tabs, each described below.

Outline View

The Outline view shows a list of all the types in the heap dump, and for each type shows a list of the instances of
that type. When an instance is selected it also shows a list of the instances that refer to that instance. The Outline
view is opened automatically when an Heap Viewer is opened.

1 Although this is an Eclipse ‘editor’, it is not possible to edit the contents of the heap dump.
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Fig. 49: Outline View

Instance Browser View

The Instance Browser view opens automatically when a type or instance is selected in the Outline view. It has two
modes, selected using the buttons in the top right corner of the view. In ‘Fields’ mode it shows the field values for
the selected type or instance, andwhere those fields hold references it shows the fields of the referenced instance,
and so on. In ‘Reference’ mode it shows the instances that refer to the selected instance, and the instances that
refer to them, and so on.

Fig. 50: Instance Browser View - Fields mode
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Fig. 51: Instance Browser View - References mode

Heap Usage Tab

TheHeapusage page of theHeap Viewer displays four bar charts. Each chart divides the total time spanof the heap
dump (from the time stampof the earliest instance creation to the time stampof the latest instance creation) into a
number of periods along the x axis, and shows, bymeans of a vertical bar, the number of instances created during
the period.

• The top-le� chart shows the total number of instances created in each period, and is the only chart displayed
when the Heap Viewer is first opened.

• When a type or instance is selected in the Outline view the top-right chart is displayed. This chart shows the
number of instances of the selected type created in each time period.

• When an instance is selected in the Outline view the bottom-le� chart is displayed. This chart shows the
number of instances created in each time period by the thread that created the selected instance.

• When an instance is selected in the Outline view the bottom-right chart is displayed. This chart shows the
number of instances created in each time period by the method that created the selected instance.
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Fig. 52: Heap Viewer - Heap Usage Tab

Clicking on the graph area in a chart restricts the Outline view to just the types and instances that were created
during the selected time period. Clicking on a chart but outside of the graph area restores the Outline view to
showing all types and instances2.

The button Generate graphViz file in the top-right corner of the Heap Usage page generates a file compatible with
graphviz (www.graphviz.org).

The section Heap Usage Monitoring shows how to compute the maximum heap usage.

Dominator Tree Tab

The Dominator tree page of the Heap Viewer allows the user to browse the instance reference tree which contains
the greatest number of instances. This can be useful when investigating a memory leak because this tree is likely
to contain the instances that should have been garbage collected.

The page contains two tree viewers. The top viewer shows the instances that make up the tree, starting with the
root. The le� column shows the ids of the instances – initially just the root instance is shown. The Shallow instances

2 The Outline can also be restored by selecting the All types and instances option on the drop-downmenu at the top of the Outline view.
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column shows the number of instances directly referenced by the instance, and the Referenced instances column
shows the total number of instances below this point in the tree (all descendants).

Thebottomviewergroups the instances thatmakeup the treeeither according to their type, the thread that created
them, or the method that created them.

Double-clicking an instance in either viewer opens the Instance Browser view (if not already open) and shows de-
tails of the instance in that view.

Fig. 53: Heap Viewer - Dominator Tree Tab

Leak Suspects Tab

The Leak suspects page of the Heap Viewer shows the result of applying heuristics to the relationships between
instances in the heap to identify possible memory leaks.

The page is in three parts.

• The top part lists the suspected types (classes). Suspected types are classes which, based on numbers of
instances and instance creation frequency, may be implicated in a memory leak.

• Themiddle part lists accumulation points. An accumulation point is an instance that references a high num-
ber of instances of a type that may be implicated in a memory leak.
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• The bottom part lists the instances accumulated at an accumulation point.

Fig. 54: Heap Viewer - Leak Suspects Tab

Progressive Heap Usage

To open the Progressive HeapUsage tool, select one ormore heap dumpXML files in the Package Explorer , right-

click and select Heap Analyzer > Show progressive heap usage

This tool is much simpler than the Heap Viewer described above. It comprises three parts.

• The top-right part is a line graph showing the total number of instances in the heap over time, based on the
creation times of the instances found in the heap dumps.

• The le� part is a pane with three tabs, one showing a list of types in the heap dump, another a list of threads
that created instances in the heap dump, and the third a list of methods that created instances in the heap
dump.

• The bottom-le� is a line graph showing the number of instances in the heap over time restricted to those
instances that match with the selection in the le� pane. If a type is selected, the graph shows only instances
of that type; if a thread is selected the graph shows only instances created by that thread; if a method is
selected the graph shows only instances created by that method.
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Fig. 55: Progressive Heap Usage

Compare Heap Dumps

The Compare tool compares the contents of two heap dump files. To open the tool select two heap dump XML files
in the Package Explorer, right-click and select Heap Analyzer > Compare

The Compare tool shows the types in the old heap on the le�-hand side, and the types in the new heap on the
right-hand side, andmarks the di�erences between them using di�erent colors.

Types in the old heapdumpare colored red if there are one ormore instances of this typewhich are in the old dump
but not in the new dump. Themissing instances have been garbage collected.

Types in the new heap dump are colored green if there are one or more instances of this type which are in the new
dump but not in the old dump. These instances were created a�er the old heap dumpwas written.

Clicking to the right of the type name unfolds the list to show the instances of the selected type.
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Fig. 56: Compare Heap Dumps

The combo box at the top of the tool allows the list to be restricted in various ways:

• All instances – no restriction.

• Garbage collected and new instances – showonly the instances that exist in the old heap dumpbut not in the
new dump, or which exist in the new heap dump but not in the old dump.

• Persistent instances – show only those instances that exist in both the old and new dumps.

• Persistent instanceswith value changed– showonly those instances that exist inboth theoldandnewdumps
and have one or more di�erences in the values of their fields.

Instance Fields Comparison View

TheCompare toolworks in conjunctionwith the InstanceFieldsComparisonview,whichopensautomaticallywhen
an instance is selected in the tool.

The view shows the values of the fields of the instance in both the old and new heap dumps, and highlights any
di�erences between the values.
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Fig. 57: Instance Fields Comparison view

3.12.6 ELF to Map File Generator

Principle

The ELF to Map generator takes an ELF executable file and generates a MicroEJ compliant .map file. Thus, any ELF
executable file produced by third party linkers can be analyzed and interpreted using theMemory Map Analyzer.

Functional Description

Fig. 58: ELF To Map Process

3.12. Development Tools 165



MicroEJ Documentation, Revision 2788b3f4

Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: ELF to Map

Group: Input

Option(browse): ELF file

Option Name: input.file

Default value: (empty)

Group: Output

Option(browse): Map file

Option Name: output.file

Default value: (empty)
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3.12.7 Serial to Socket Transmitter

Principle

The MicroEJ serialToSocketTransmitter is a piece of so�ware which transfers all bytes from a serial port to a tcp
client or tcp server.

Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: Serial to Socket

Group: Serial Options

Option(text): Port

Option Name: serail.to.socket.comm.port

Default value: COM0

Description: Defines the COM port:

Windows - COM1 , COM2 , ... , COM*n*

Linux - /dev/ttyS0 , /dev/ttyUSB0 , ... , /dev/ttyS*n* , /dev/ttyUSB*n*
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Option(combo): Baudrate

Option Name: serail.to.socket.comm.baudrate

Default value: 115200

Available values:

9600

38400

57600

115200

Description: Defines the COM baudrate.

Group: Server Options

Option(text): Port

Option Name: serail.to.socket.server.port

Default value: 5555

Description: Defines the server IP port.

3.12.8 Memory Map Analyzer

Principle

When a MicroEJ Application is linked with the MicroEJ Workbench, a Memory MAP file is generated. The Memory
Map Analyzer (MMA) is an Eclipse plug-in made for exploring the map file. It displays the memory consumption of
di�erent features in the RAM and ROM.
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Functional Description

Fig. 59: Memory Map Analyzer Process

In addition to the executable file, the MicroEJ Platform generates a map file. Double click on this file to open the
Memory Map Analyzer.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

Themap file is available in the MicroEJ Application project output directory.
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Fig. 60: Retrieve Map File

Select an item (or several) to show the memory used by this item(s) on the right. Select “All” to show the memory
used by all items. This special item performs the same action as selecting all items in the list.

Fig. 61: Consult Full Memory

Select an item in the list, and expand it to see all symbols used by the item. This view is useful in understanding
why a symbol is embedded.
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Fig. 62: Detailed View

3.12.9 Event Tracing

Description

Event Tracing allows to record integer based events for debugging and monitoring purposes without a�ecting ex-
ecution performance too heavily. Basically, it gives access to Tracer objects that are named and can produce a
limited number of di�erent event types.

A record is an event type identified by an eventID and can have a list of values. It can be a single event or a period
of time with a start and an end.

Event Tracing can be accessed from two APIs:

• A Java API, provided by the Trace API module. The following dependency must be added to themodule.ivy
of the MicroEJ Application project:

<dependency org="ej.api" name="trace" rev="1.1.0"/>

• A C API, provided by the Platform header file named LLTRACE_impl.h .

Event Recording

Events are recorded if and only if:

• the MicroEJ Core Engine trace system is enabled,

• and trace recording is started.
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To enable the MicroEJ Core Engine trace system, set the Application Option named core.trace.enabled to true
(see also launch configuration).

Then, multiple ways are available to start and stop the trace recording:

• by setting the Application Option named core.trace.autostart to true to automatically start at startup
(see also launch configuration),

• using the Java API methods ej.trace.Tracer.startTrace() and ej.trace.Tracer.stopTrace() ,

• using the C API functions LLTRACE_IMPL_start(void) and LLTRACE_IMPL_stop(void) .

Java API Usage

The detailed Trace API documentation is available here.

First, you need to instantiate a Tracer object by calling its constructor with two parameters. The first parameter,
name , is a String that will represent the Tracer object group’s name. The second parameter, nbEventTypes , is an
integer representing the maximum number of event types available for the group.

Tracer tracer = new Tracer("MyGroup", 10);

Then, you can record an event by calling the recordEvent(int eventId) method. The event ID needs to be in
the range 0 to nbEventTypes-1 with nbEventTypes the maximum number of event types set when initializing
the Tracer object. Methods named recordEvent(...) always needs the event ID as the first parameter and can
have up to ten integer parameters as custom values for the event.

To record the end of an event, call the method recordEventEnd(int eventID) . It will trace the duration of an
event previously recorded with one of the recordEvent(int) methods. The recordEventEnd(...) method can
also have another integer parameter for a customvalue for the event end. One can use it to trace the returned value
of a method.

The Trace API also provides a String constant Tracer.TRACE_ENABLED_CONSTANT_PROPERTY representing the Con-
stant value of core.trace.enabled option. This constant can be used to remove at build time portions of code
when the trace system is disabled. To do that, just surround tracer record calls with a if statement that checks the
constant’s state. When the constant is set to false , the code inside the if statement will not be embedded with
the application and thus will not impact the performances.

if(Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
// This code is not embedded if TRACE_ENABLED_CONSTANT_PROPERTY is set to false.
tracer.recordEventEnd(0);

}

Examples:

• Trace a single event:

private static final Tracer tracer = new Tracer("Application", 100);

public static void main(String[] args) {
Tracer.startTrace();
tracer.recordEvent(0);

}

Standard Output:

VM START
[TRACE] [1] Declare group "Application"
[TRACE] [1] Event 0x0
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• Trace a method with a start event showing the parameters of the method and an end event showing the
result:

private static final Tracer tracer = new Tracer("Application", 100);

public static void main(String[] args) {
Tracer.startTrace();
int a = 14;
int b = 54;
add(a, b);

}

public static int add(int a, int b) {
tracer.recordEvent(1, a, b);
int result = a + b;
tracer.recordEventEnd(1, result);
return result;

}

Standard Output:

VM START
[TRACE] [1] Declare group "Application"
[TRACE] [1] Event 0x1 (14 [0xE],54 [0x36])
[TRACE] [1] Event End 0x1 (68 [0x44])

Platform Implementation

By default, when enabled, the Trace API displays a message in the standard output for every recordEvent(...)
and recordEventEnd(...) method calls.

It does not print a timestampwhen displaying the tracemessage because it can drastically a�ect execution perfor-
mances. It only prints the ID of the recorded event followed by the values given in parameters.

A Platform can connect its own implementation by overriding the functions defined in the LLTRACE_impl.h file.

MicroEJ provides an implementation that redirects the events to SystemView tool, the real-time recording and vi-
sualization tool from Segger. It is perfect for a finer understanding of the runtime behavior by showing events
sequence and duration.

A implementation example for the NXP OM13098 development board with SystemView support is available here.
Please contact our support team for more information about how to integrate this Platformmodule.

3.12.10 Null Analysis

NullPointerException thrown at runtime is one of the most common causes for failure of Java programs. The Null
Analysis tool can detect such programming errors (misuse of potential null Java values) at compile-time.

The following example of code shows a typical Null Analysis error detection in MicroEJ SDK.
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Fig. 63: Example of Null Analysis Detection

Principle

The Null Analysis tool is based on Java annotations. Each Java field, method parameter and method return value
must be marked to indicate whether it can be null or not.

Once the Java code is annotated,module projectsmust be configured to enable Null Analysis detection in MicroEJ
SDK.

Java Code Annotation

MicroEJ defines its own annotations:

• @NonNullByDefault: Indicates that all fields, method return values or parameters can never be null in the
annotated package or type. This rule can be overridden on each element by using the Nullable annotation.

• @Nullable: Indicates that a field, local variable, method return value or parameter can be null.

• @NonNull: Indicates that a field, local variable, method return value or parameter can never be null.

MicroEJ recommends to annotate the Java code as follows:

• In each Java package, create a package-info.java file and annotate the Java package with
@NonNullByDefault . This is a common good practice to deal with non null elements by default to avoid
undesired NullPointerException. It enforces the behavior which is already widely outlined in Java coding
rules.

3.12. Development Tools 174

https://repository.microej.com/javadoc/microej_5.x/apis/ej/annotation/NonNullByDefault.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/annotation/Nullable.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/annotation/NonNull.html
https://repository.microej.com/javadoc/microej_5.x/apis/java/lang/NullPointerException.html


MicroEJ Documentation, Revision 2788b3f4

• IneachJava type, annotateall fields,methods returnvaluesandparameters that canbenullwith @Nullable .
Usually, this information is already available as textual information in the field ormethod Javadoc comment.
The following example of code shows where annotations must be placed:

Note: MicroEJ SDK 5.3.0 or higher requires annotations declared in EDC-1.3.3 or higher. See EDC 1.3.3 Changelog
for more details.

Module Project Configuration

To enable the Null Analysis tool, amodule projectmust be configured as follows:

• In the Package Explorer, right-click on the module project and select Properties ,

• Navigate to Java Compiler > Errors/Warnings ,

• In the Null analysis section, configure options as follows:
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• Click on the Configure. . . link to configure MicroEJ annotations:

– ej.annotation.Nullable

– ej.annotation.NonNull

– ej.annotation.NonNullByDefault
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• In the Annotations section, check Suppress optional errors with ‘@SuppressWarnings’ option:
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This option allows to fully ignore Null Analysis errors in advanced cases using @SuppressWarnings("null")
annotation.

If you have multiple projects to configure, you can then copy the content of the .settings folder to an other
module project.
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Fig. 64: Null Analysis Settings Folder

Warning: You may lose information if your target module project already has custom parameterization or if it
was created with another MicroEJ SDK version. In case of any doubt, please configure the options manually or
merge with a text file comparator.

MicroEJ Libraries

Many libraries available on MicroEJ Central Repository are annotated with Null Analysis. If you are using a library
which is not yet annotated, please contact our support team.

For the benefit of Null Analysis, some APIs have been slightly constrained compared to the Javadoc description.
Here are some examples to illustrate the philosophy:

• System.getProperty(String key, String def) does not accept a null default value, which allows to ensure the
returned value is always non null .

• Collections of the Java Collections Framework that can hold null elements (e.g. HashMap) do not accept
null elements. This allows APIs to return null (e.g. HashMap.get(Object)) only when an element is not
contained in the collection.

Implementations are le� unchanged and still comply with the Javadoc description whether the Null Analysis is
enabled or not. So if these additional constraints are not acceptable for your project, please disable Null Analysis.

Advanced Use

For more information about Null Analysis and inter-procedural analysis, please visit Eclipse JDT Null Analysis doc-
umentation.
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3.13 Advanced Tools

3.13.1 MicroEJ Linker

Overview

MicroEJ Linker is a standard linker that is compliant with the Executable and Linkable File format (ELF).

MicroEJ Linker takes one or several relocatable binary files and generates an image representation using a descrip-
tion file. The process of extracting binary code, positioning blocks and resolving symbols is called linking.

Relocatable object files are generated by SOAR and third-party compilers. An archive file is a container of Relocat-
able object files.

The description file is called a Linker Specific Configuration file (lsc). It describeswhat shall be embedded, andhow
those things shall be organized in the program image. The linker outputs :

• An ELF executable file that contains the image and potential debug sections. This file can be directly used by
debuggers or programming tools. It may also be converted into a another format (Intel* hex, Motorola* s19,
rawBinary, etc.) using external tools, such as standard GNU binutils toolchain (objcopy, objdump, etc.).

• A map file, in XML format, which can be viewed as a database of what has been embedded and resolved by
the linker. It can be easily processed to get a sort of all sizes, call graphs, statistics, etc.

• The linker is composed with one or more library loaders, according to the platform’s configuration.

ELF Overview

An ELF relocatable file is split into several sections:

• allocation sections representing a part of the program

• control sections describing the binary sections (relocation sections, symbol tables, debug sections, etc.)

An allocation section can hold some image binary bytes (assembler instructions and raw data) or can refer to an
interval of memory which makes sense only at runtime (statics, main stack, heap, etc.). An allocation section is an
atomic block and cannot be split. A section has a name that by convention, represents the kind of data it holds.
For example, .text sections hold binary instructions, .bss sections hold read-write static data, .rodata hold
read-only data, and .data holds read-write data (initialized static data). Thename is used in the .lsc file to organize
sections.

A symbol is an entity made of a name and a value. A symbol may be absolute (link-time constant) or relative to a
section: Its value is unknown until MicroEJ Linker has assigned a definitive position to the target section. A symbol
can be local to the relocatable file or global to the system. All global symbol names should be unique in the system
(the name is the key that connects an unresolved symbol reference to a symbol definition). A sectionmay need the
value of symbols to be fully resolved: the address of a function called, address of a static variable, etc.

Linking Process

The linking process can be divided into three main steps:

1. Symbols and sections resolution. Starting from root symbols and root sections, the linker embeds all sec-
tions targeted by symbols and all symbols referred by sections. This process is transitive while new symbols
and/or sections are found. At the endof this step, the linkermay stop andoutput errors (unresolved symbols,
duplicate symbols, unknown or bad input libraries, etc.)
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2. Memory positioning. Sections are laid out in memory ranges according to memory layout constraints de-
scribed by the lsc file. Relocations are performed (in other words, symbol values are resolved and section
contents are modified). At the end of this step, the linker may stop and output errors (it could not resolve
constraints, such as not enoughmemory, etc.)

3. An output ELF executable file andmap file are generated.

A partial map file may be generated at the end of step 2. It provides useful information to understand why the link
phase failed. Symbol resolution is the process of connecting a global symbol name to its definition, found in one of
the linker input units. The order the units are passed to the linker may have an impact on symbol resolution. The
rules are :

• Relocatable object files are loaded without order. Two global symbols defined with the same name result in
an unrecoverable linker error.

• Archive files are loaded on demand. When a global symbolmust be resolved, the linker inspects each archive
unit in the order it was passed to the linker. When an archive contains a relocatable object file that declares
the symbol, the object file is extracted and loaded. Then the first rule is applied. It is recommended that you
group object files in archives asmuch as possible, in order to improve load performances. Moreover, archive
files are the only way to tie with relocatable object files that share the same symbols definitions.

• A symbol name is resolved to a weak symbol if - and only if - no global symbol is found with the same name.

Linker Specific Configuration File Specification

Description

A Linker Specific Configuration (Lsc) file contains directives to link input library units. An lsc file is written in an XML
dialect, and its contents can be divided into two principal categories:

• Symbols and sections definitions.

• Memory layout definitions.

Listing 5: Example of Relocation of Runtime Data from FLASH to RAM

<?xml version="1.0" encoding="UTF-8"?>
<!--

An example of linker specific configuration file
-->
<lsc name="MyAppInFlash">

<include name="subfile.lscf"/>
<!--

Define symbols with arithmetical and logical expressions
-->
<defSymbol name="FlashStart" value="0"/>
<defSymbol name="FlashSize" value="0x10000"/>
<defSymbol name="FlashEnd" value="FlashStart+FlashSize-1"/>
<!--

Define FLASH memory interval
-->
<defSection name="FLASH" start="FlashStart" size="FlashSize"/>

<!--
Some memory layout directives

-->
<memoryLayout ranges ="FLASH">

<sectionRef name ="*.text"/>

(continues on next page)
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(continued from previous page)

<sectionRef name ="*.data"/>
</memoryLayout>

</lsc>

File Fragments

An lsc file can be physically divided into multiple lsc files, which are called lsc fragments. Lsc fragments may be
loaded directly from the linker path option, or indirectly using the include tag in an lsc file.

Lsc fragments start with the root tag lscFragment . By convention the lsc fragments file extension is .lscf . From
here to the end of the document, the expression “the lsc file” denotes the result of the union of all loaded (directly
and indirectly loaded) lsc fragments files.

Symbols and Sections

A new symbol is defined using defSymbol tag. A symbol has a name and an expression value. All symbols defined
in the lsc file are global symbols.

A new section is defined using the defSection tag. A section may be used to define a memory interval, or define
a chunk of the final image with the description of the contents of the section.

Memory Layout

A memory layout contains an ordered set of statements describing what shall be embedded. Memory positioning
can be viewed asmoving a cursor into intervals, appending referenced sections in the order they appear. A symbol
can be defined as a “floating” item: Its value is the value of the cursor when the symbol definition is encountered.
In the example below, the memory layout sets the FLASH section. First, all sections named .text are embedded.
Thematching sections are appended in a undefined order. To reference a specific section, the section shall have a
unique name (for example a reset vector is commonly called .reset or .vector , etc.). Then, the floating symbol
dataStart is set to the absolute address of the virtual cursor right a�er embedded .text sections. Finally all
sections named .data are embedded.

A memory layout can be relocated to a memory interval. The positioning works in parallel with the layout ranges,
as if there were two cursors. The address of the section (used to resolve symbols) is the address in the relocated
interval. Floating symbols can refer either to the layout cursor (by default), or to the relocated cursor, using the
relocation attribute. A relocation layout is typically used to embed data in a program image that will be used
at runtime in a read-write memory. Assuming the program image is programmed in a read only memory, one of
the first jobs at runtime, before starting the main program, is to copy the data from read-only memory to RAM ,
because the symbols targeting the data have been resolvedwith the address of the sections in the relocated space.
To perform the copy, the program needs both the start address in FLASH where the data has been put, and the
start address in RAM where the data shall be copied.

Listing 6: Example of Relocation of Runtime Data from FLASH to RAM

<memoryLayout ranges="FLASH" relocation="RAM" image="true">
<defSymbol name="DataFlashStart" value="."/>
<defSymbol name="DataRamStart" value=" ." relocation="true"/>
<sectionRef name=".data"/>
<defSymbol name="DataFlashLimit" value="."/>

</memoryLayout>
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Note: the symbol DataRamStart is defined to the start address where .data sections will be inserted in RAM
memory.

Tags Specification

Here is the complete syntactical and semantical description of all available tags of the .lsc file.

Table 5: Linker Specific Configuration Tags
Tags Attributes Description

defSection
Defines a new section. A floating section only holds a declared size
attribute. A fixed section declares at least one of the start / end at-
tributes. When this tag is empty, the section is a runtime section, and
must define at least one of the start , end or size attributes. When
this tag is not empty (when it holds a binary description), the section
is an image section.

name Name of the section. The section name may not be unique. However,
it is recommended that you define a unique name if the section must
be referred separately for memory positioning.

start Optional. Expression defining the absolute start address of the sec-
tion. Must be resolved to a constant a�er the full load of the lsc file.

end Optional. Expression defining the absolute end address of the section.
Must be resolved to a constant a�er the full load of the lsc file.

size Optional. Expression defining the size in bytes of the section. Invari-
ant: (end-start)+1=size . Must be resolved to a constant a�er the
full load of the lsc file.

align Optional. Expression defining the alignment in bytes of the section.
rootSection Optional. Boolean value. Sets this section as a root section to be em-

bedded even if it is not targeted by any embedded symbol. See also
rootSection tag.

symbolPrefix Optional. Used in collaboration with symbolTags . Prefix of symbols
embedded in the auto-generated section. See Auto-generated Sec-
tions.

symbolTags Optional. Used in collaboration with symbolPrefix . Comma sepa-
rated list of tags of symbols embedded in the auto-generated section.
See Auto-generated Sections.

defSymbol
Defines a new global symbol. Symbol name must be unique in the
linker context

name Name of the symbol.
type Optional. Type of symbol usage. Thismay be necessary to set the type

of a symbol when using third party ELF tools. There are three types: -
none : default. No special type of use. - function : symbol describes
a function. - data : symbol describes some data.

value The value "." defines a floating symbol that holds the current cur-
sor position in a memory layout. (This is the only form of this tag that
can be used as a memoryLayout directive) Otherwise value is an ex-
pression. A symbol expression must be resolved to a constant a�er
memory positioning.

relocation Optional. The only allowed value is true . Indicates that the value
of the symbol takes the address of the current cursor in the memory
layout relocation space. Only allowed on floating symbols.

Continued on next page
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Table 5 – continued from previous page
Tags Attributes Description

rootSymbol Optional. Boolean value. Sets this symbol as a root symbol that must
be resolved. See also rootSymbol tag.

weak Optional. Boolean value. Sets this symbol as a weak symbol.

group memoryLayout directive. Defines a named group of sections. Group
namemay be used in expressionmacros START , END , SIZE . All mem-
oryLayout directives are allowed within this tag (recursively).

name The name of the group.

include
Includes an lsc fragment file, semantically the same as if the fragment
contents were defined in place of the include tag.

name Name of the file to include. When the name is relative, the file sepa-
rator is / , and the file is relative to the directory where the current
lsc file or fragment is loaded. When absolute, the name describes a
platform-dependent filename.

lsc
Root tag for an .lsc file.

name Name of the lsc file. The ELF executable output will be {name}.out ,
and the map file will be {name}.map

lscFragment Root tag for an lsc file fragment. Lsc fragments are loaded from the
linker path option, or included from a master file using the include
tag.

memoryLayout
Describes the organization of a set of memory intervals. The memory
layouts are processed in the order in which they are declared in the
file. The same interval may be organized in several layouts. Each lay-
out starts at the value of the cursor the previous layout ended. The fol-
lowing tags are allowedwithin amemoryLayout directive: defSymbol
(under certain conditions), group , memoryLayoutRef , padding , and
sectionRef .

ranges Exclusivewithdefault. Comma-separatedordered list of fixed sections
to which the layout is applied. Sections represent memory segments.

image Optional. Boolean value. false if not set. If true , the layout de-
scribes a part of the binary image: Only image sections can be embed-
ded. If false , only runtime sections can be embedded.

relocation Optional. Name of the section to which this layout is relocated.
name Exclusive with ranges. Defines a named memoryLayout directive in-

stead of specifying a concrete memory location. May be included in a
parent memoryLayout using memoryLayoutRef.

memoryLayoutRef
memoryLayout directive. Provides an extension-point mechanism to
include memoryLayout directives defined outside the current one.

name All directives of memoryLayout defined with the same name are in-
cluded in an undefined order.

padding
memoryLayout directive. Append padding bytes to the current cursor.
Either size or align attributes should be provided.

size Optional. Expressionmust be resolved to a constant a�er the full load
of the lsc file. Increment the cursor position with the given size.

align Optional. Expressionmust be resolved to a constant a�er the full load
of the lsc file. Move the current cursor position to thenext address that
matches the given alignment. Warning: when used with relocation,
the relocation cursor is also aligned. Keep in mind this may increase
the cursor position with a di�erent amount of bytes.

address Optional. Expressionmust be resolved to a constant a�er the full load
of the lsc file. Move the current cursor position to the given absolute
address.

Continued on next page

3.13. Advanced Tools 184



MicroEJ Documentation, Revision 2788b3f4

Table 5 – continued from previous page
Tags Attributes Description

fill Optional. Expressionmust be resolved to a constant a�er the full load
of the lsc file. Fill padding with the given value (32 bits).

rootSection
References a section name that must be embedded. This tag is not a
definition. It forces the linker to embed all loaded sections matching
the given name.

name Name of the section to be embedded.

rootSymbol
References a symbol thatmust be resolved. This tag is not a definition.
It forces the linker to resolve the value of the symbol.

name Name of the symbol to be resolved.

sectionRef
Memory layout statement. Embeds all sections matching the given
name starting at the current cursor address.

file Select only sections defined in a linker unit matching the given file
name. The file name is the simple namewithout any file separator, e.g.
bsp.o or mylink.lsc . Link units may be object files within archive
units.

name Name of the sections to embed. When the name ends with *, all sec-
tions starting with the given name are embedded (name completion),
except sections that are embedded in another sectionRef using the ex-
act name (without completion).

symbol Optional. Only embeds the section targeted by the given symbol. This
is the only way at link level to embed a specific section whose name is
not unique.

force Optional. Deprecated. Replaced by the rootSection tag. The only
allowed value is true . By default, for compaction, the linker embeds
only what is needed. Setting this attribute will force the linker to em-
bed all sections that appear in all loaded relocatable files, even sec-
tions that are not targeted by a symbol.

sort Optional. Specifies that the sections must be sorted in memory. The
value can be: - order : the sections will be in the same order as the
input files - name : the sections are sorted by their file names - unit
: the sections declared in an object file are grouped and sorted in the
order they are declared in the object file

u4
Binary section statement. Describes the four next raw bytes of the
section. Bytes are organized in the endianness of the target ELF ex-
ecutable.

value Expression must be resolved to a constant a�er the full load of the lsc
file (32 bits value).

fill
Binary section statement. Fills the section with the given expression.
Bytes are organized in the endianness of the target ELF executable.

size Expression defining the number of bytes to be filled.
value Expression must be resolved to a constant a�er the full load of the lsc

file (32 bits value).

Expressions

An attribute expression is a value resulting from the computation of an arithmetical and logical expression. Sup-
ported operators are the same operators supported in the Java language, and follow Java semantics:

• Unary operators: + , - , ~ , !

• Binary operators: + , - , * , / , % , << , >>> , >> , < , > , <= , >= , == , != , &, | , ^ ,
&& , ||
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• Ternary operator: cond ? ifTrue : ifFalse

• Built-in macros:

– START(name) : Get the start address of a section or a group of sections

– END(name) : Get the end address of a section or a group of sections

– SIZE(name) : Get the size of a section or a group of sections. Equivalent to END(name)-START(name)

– TSTAMPH() , TSTAMPL() : Get 32 bits linker time stamp (high/low part of system time in milliseconds)

– SUM(name,tag) : Get the sum of an auto-generated section (Auto-generated Sections) column. The col-
umn is specified by its tag name.

An operand is either a sub expression, a constant, or a symbol name. Constantsmay bewritten in decimal ( 127 ) or
hexadecimal form ( 0x7F ). There are no boolean constants. Constant value 0 means false , and other constants’
values mean true . Examples of use:

value="symbol+3"
value="((symbol1*4)-(symbol2*3)"

Note: Ternary expressions can be used to define selective linking because they are the only expressions that may
remain partially unresolved without generating an error. Example:

<defSymbol name="myFunction" value="condition ? symb1 : symb2"/>

No error will be thrown if the condition is true and symb1 is defined, or the condition is false and symb2 is
defined, even if the other symbol is undefined.

Auto-generated Sections

TheMicroEJ Linker allows you to define sections that are automatically generatedwith symbol values. This is com-
monly used to generate tables whose contents depends on the linked symbols. Symbols eligible to be embedded
in an auto-generated section are of the form: prefix_tag_suffix . An auto-generated section is viewed as a table
composed of lines and columns that organize symbols sharing the same prefix. On the same column appear sym-
bols that share the same tag. On the same line appear symbols that share the same su�ix. Lines are sorted in the
lexical order of the symbol name. The next line defines a sectionwhichwill embed symbols startingwith zeroinit
. The first column refers to symbols starting with zeroinit_start_ ; the second column refers to symbols starting
with zeroinit_end_ .

<defSection
name=".zeroinit"
symbolPrefix="zeroInit"
symbolTags="start,end"

/>

Consider there are four defined symbols named zeroinit_start_xxx , zeroinit_end_xxx ,
zeroinit_start_yyy and zeroinit_end_yyy . The generated section is of the form:

0x00: zeroinit_start_xxx
0x04: zeroinit_end_xxx
0x08: zeroinit_start_yyy
0x0C: zeroinit_end_yyy

If there are missing symbols to fill a line of an auto-generated section, an error is thrown.
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Execution

MicroEJ Linker can be invoked through an ANT task. The task is installed by inserting the following code in an ANT
script

<taskdef
name="linker"
classname="com.is2t.linker.GenericLinkerTask"
classpath="[LINKER_CLASSPATH]"

/>

[LINKER_CLASSPATH] is a list of path-separated jar files, including the linker and all architecture-specific library
loaders.

The following code shows a linker ANT task invocation and available options.

<linker
doNotLoadAlreadyDefinedSymbol="[true|false]"
endianness="[little|big|none]"
generateMapFile="[true|false]"
ignoreWrongPositioningForEmptySection="[true|false]"
lsc="[filename]"
linkPath="[path1:...pathN]"
mergeSegmentSections="[true|false]"
noWarning="[true|false]"
outputArchitecture="[tag]"
outputName="[name]"
stripDebug="[true|false]"
toDir="[outputDir]"
verboseLevel="[0...9]"

>
<!-- ELF object & archives files using ANT paths / filesets -->
<fileset dir="xxx" includes="*.o">
<fileset file="xxx.a">
<fileset file="xxx.a">

<!-- Properties that will be reported into .map file -->
<property name="myProp" value="myValue"/>

</linker>
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Table 6: Linker Options Details
Option Description

doNotLoadAlreadyDefinedSymbol
Silently skip the load of a global symbol if it has already
been loaded before. ( false by default. Only the first
loaded symbol is taken into account (in the order input
files are declared). This option only a�ects the load se-
mantic for global symbols, and does not modify the se-
mantic for loading weak symbols and local symbols.

endianness
Explicitly declare linker endianness [little, big] or
[none] for auto-detection. All input files must declare
the same endianness or an error is thrown.

generateMapFile
Generate the .map file ( true by default).

ignoreWrongPositioningForEmptySection
Silently ignore wrong section positioning for zero size
sections. ( false by default).

lsc
Provideamaster lsc file. Thisoption ismandatoryunless
the linkPath option is set.

linkPath
Provide a set of directories into which to load link file
fragments. Directories are separated with a platform-
path separator. This option ismandatory unless the lsc
option is set.

noWarning
Silently skip the output of warning messages.

mergeSegmentSections
(experimental). Generate a single section per segment.
Thismay speed up the load of the output executable file
into debuggers or flasher tools. ( false by default).

outputArchitecture
Set the architecture tag for the output ELF file (ELF ma-
chine id).

outputName
Specify the output name of the generated files. By de-
fault, take the name provided in the lsc tag. The output
ELF executable filenamewill be name.out. Themap file-
name will be name.map.

stripDebug
Remove all debug information from the output ELF file.
A stripped output ELF executable holds only the binary
image (no remaining symbols, debug sections, etc.).

toDir
Specify the output directory in which to store generated
files. Output filenames are in the form: od + separator
+ value of the lsc name attribute + suffix .
By default, without this option, files are generated in the
directory fromwhich the linker was launched.

verboseLevel
Print additionalmessages on the standard output about
linking process.

Error Messages

This section lists MicroEJ Linker error messages.

Table 7: Linker-Specific Configuration Tags
Message ID Description
0 The linker has encountered an unexpected internal error. Please contact the support hot-

line.
Continued on next page
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Table 7 – continued from previous page
1 A library cannot be loaded with this linker. Try verbose to check installed loaders.
2 No lsc file provided to the linker.
3 A file could not be loaded. Check the existence of the file and file access rights.
4 Conflicting input libraries. Aglobal symboldefinitionwith thesamenamehasalreadybeen

loaded from a previous object file.
5 Completion (*) could not be used in association with the force attribute. Must be an exact

name.
6 A required section refers to an unknown global symbol. Maybe input libraries are missing.
7 A library loader has encountered an unexpected internal error. Check input library file in-

tegrity.
8 Floating symbols can only be declared inside memoryLayout tags.
9 Invalid value format. For example, the attribute relocation in defSymbol must be a

boolean value.
10 Missing one of the following attributes: address , size , align .
11 Toomany attributes that cannot be used in association.
13 Negative padding. Memory layout cursor cannot decrease.
15 Not enough space in the memory layout intervals to append all sections that need to be

embedded. Check the output map file to get more information about what is required as
memory space.

16 A block is referenced but has already been embedded. Most likely a block has been espe-
cially embedded using the force attribute and the symbol attribute.

17 A block that must be embedded has nomatching sectionRef statement.
19 An IO error occurred when trying to dump one of the output files. Check the output direc-

tory option and file access rights.
20 size attribute expected.
21 The computed size does not match the declared size.
22 Sections defined in the lsc file must be unique.
23 One of the memory layout intervals refers to an unknown lsc section.
24 Relocation must be done in one and only one contiguous interval.
25 force and symbol attributes are not allowed together.
26 XML char data not allowed at this position in the lsc file.
27 A section which is a part of the program image must be embedded in an image memory

layout.
28 A section which is not a part of the program image must be embedded in a non-image

memory layout.
29 Expression could not be resolved to a link-time constant. Some symbols are unresolved.
30 Sections used in memory layout ranges must be sections defined in the lsc file.
31 Invalid character encountered when scanning the lsc expression.
32 A recursive include cycle was detected.
33 An alignment inconsistency was detected in a relocation memory layout. Most likely one

of the start addresses of the memory layout is not aligned on the current alignment.
34 An error occurs in a relocation resolution. In general, the relocation has a value that is out

of range.
35 symbol and sort attributes are not allowed together.
36 Invalid sort attribute value is not one of order , name , or no .
37 Attribute start or end in defSection tag is not allowedwhendefining a floating section.
38 Autogenerated section can build tables according to symbol names (see Auto-generated

Sections). A symbol is needed to build this section but has not been loaded.
39 Deprecated featurewarning. Remains for backward compatibility. It is recommended that

you use the new indicated feature, because this feature may be removed in future linker
releases.

Continued on next page
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Table 7 – continued from previous page
40 Unknownoutput architecture. Either the architecture ID is invalid, or the library loader has

not been loaded by the linker. Check loaded library loaders using verbose option.
41. . .43 Reserved.
44 Duplicate group definition. A group name is unique and cannot be defined twice.
45 Invalid endianness. The endianness mnemonic is not one of the expected mnemonics (

little,big,none ).
46 Multiple endiannesses detected within loaded input libraries.
47 Reserved.
48 Invalid type mnemonic passed to a defSymbol tag. Must be one of none , function , or

data .
49 Warning. A directory of link path is invalid (skipped).
50 No linker-specific description file could be loaded from the link path. Check that the link

path directories are valid, and that they contain .lsc or .lscf files.
51 Exclusive options (these options cannot be used simultaneously). For example,

-linkFilename and -linkPath are exclusive; either select amaster lsc file or a path from
which to load .lscf files.

52 Name given to a memoryLayoutRef or a memoryLayout is invalid. It must not be empty.
53 A memoryLayoutRef with the same name has already been processed.
54 A memoryLayout must define ranges or the name attribute.
55 Nomemory layout foundmatching the name of the current memoryLayoutRef .
56 A named memoryLayout is declaredwith a relocation directive, but the relocation interval

is incompatible with the relocation interval of the memoryLayout that referenced it.
57 A named memoryLayout has not been referenced. Every declared memoryLayout must

be processed. A named memoryLayout must be referenced by a memoryLayoutRef state-
ment.

58 SUM operator expects an auto-generated section.
59 SUM operator tag is unknown for the targetted auto-generated section.
60 SUM operator auto-generated section name is unknown.
61 An option is set for an unknown extension. Most likely the extension has not been set to

the linker classpath.
62 Reserved.
63 ELF unit flags are inconsistent with flags set using the -forceFlags option.
64 Reserved.
65 Reserved.
66 Found an executable object file as input (expected a relocatable object file).
67 Reserved.
68 Reserved.
69 Reserved.
70 Not enough memory to achieve the linking process. Try to increase JVM heap that is run-

ning the linker (e.g. by adding option -Xmx1024M to the JRE command line).

Map File Interpretor

The map file interpretor is a tool that allows you to read, classify and display memory information dumped by
the linker map file. The map file interpretor is a graph-oriented tool. It supports graphs of symbols and allows
standard operations on them (union, intersection, subtract, etc.). It can also dump graphs, compute graph total
sizes, list graph paths, etc.

The map file interpretor uses the standard Java regular expression syntax.

It is used internally by the graphicalMemory Map Analyzer tool.

Commands:
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• createGraph graphName symbolRegExp ... section=regexp

createGraph all section=.*

Recursively create a graph of symbols from root symbols and sections described as regular expressions. For
example, to extract the complete graph of the application:

• createGraphNoRec symbolRegExp ... section=regexp

The above line is similar to the previous statement, but embeds only declared symbols and sections (without
recursive connections).

• removeGraph graphName

Removes the graph for memory.

• listGraphs

Lists all the created graphs in memory.

• listSymbols graphName

Lists all graph symbols.

• listPadding

Lists the padding of the application.

• listSections graphName

Lists all sections targeted by all symbols of the graph.

• inter graphResult g1 ... gn

Creates a graph which is the intersection of g1/\ ... /\gn .

• union graphResult g1 ... gn

Creates a graph which is the union of g1\/ ...\/ gn .

• substract graphResult g1 ... gn

Creates a graph which is the substract of g1\ ... \ gn .

• reportConnections graphName

Prints the graph connections.

• totalImageSize graphName

Prints the image size of the graph.

• totalDynamicSize graphName

Prints the dynamic size of the graph.
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• accessPath symbolName

The above line prints one of the paths from a root symbol to this symbol. This is very useful in helping you
understand why a symbol is embedded.

• echo arguments

Prints raw text.

• exec commandFile

Execute the given commandFile. The path may be absolute or relative from the current command file.

3.13.2 MicroEJ Test Suite Engine

Introduction

The MicroEJ Test Suite Engine is a generic tool made for validating any development project using automatic test-
ing.

This section details advanced configuration for users who wish to integrate custom test suites in their build flow.

The MicroEJ Test Suite Engine allows the user to test any kind of projects within the configuration of a generic Ant
file.

The MicroEJ Test Suite Engine is already pre-configured for running test suites on a MicroEJ Platform (either on
Simulator or on Device).

• For Application and Libraries, refer to Test Suite with JUnit section.
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• For Foundation Libraries Test Suites, refer to Platform Test Suite section.

Using the MicroEJ Test Suite Ant Tasks

Multiple Ant tasks are available in the testsuite-engine.jar provided in the Build Kit:

• testsuite allows the user to run a given test suite and to retrieve an XML report document in a JUnit format.

• javaTestsuite is a subtask of the testsuite task, used to run a specialized test suite for Java (will only
run Java classes).

• htmlReport is a task which will generate an HTML report from a list of JUnit report files.

The testsuite Task

The following attributes are mandatory:

Table 8: testsuite task mandatory attributes
Attribute Name Description

outputDir
The output folder of the test suite. The final report will be generated at [outputDir]/
[label]/[reportName].xml , see the testsuiteReportFileProperty and
testsuiteReportDirProperty attributes.

harnessScript
The harness script must be an Ant script and it is the script which will be called for each test
by the test suite engine. It is called with a basedir located at output location of the current
test.

The test suite engine provides the following properties to the harness script giving all the informations to start the
test:

Table 9: harnessScript properties
Attribute Name Description

testsuite.
test.name

The output name of the current test in the report. Default value is the relative path of the
test. It can bemanually set by the user. More details on the output name are available in the
section Specific Custom Properties.

testsuite.
test.path

The current test absolute path in the filesystem.

testsuite.
test.
properties

The absolute path to the custom properties of the current test (see the property
customPropertiesExtension )

testsuite.
common.
properties

The absolute path to the common properties of all the tests (see the property
commonProperties )

testsuite.
report.dir

The absolute path to the directory of the final report.

The following attributes are optional:
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Table 10: testsuite task optional attributes
Attribute
Name

Description Default value

timeOut
The time in seconds before any test is considerated as un-
known. Set it to 0 to disable the time-out. 60

verboseLevel
The required level to output messages from the test suite.
Can be one of those values: error , warning , info ,
verbose , debug .

info

reportName
The final report name (without extension).

testsuite-report

customPropertiesExtension
The extension of the custom properties for each test. For in-
stance, if it is set to .options , a test named xxx/Test1.
class will be associated with xxx/Test1.options . If a file
exists for a test, the property testsuite.test.properties
is set with its absolute path and given to the harnessScript
. If the test path references a directory, then the custom
properties path is the concatenation of the test path and the
customPropertiesExtension value.

.properties

commonProperties
The properties to apply to every test of the test suite. Those
options might be overridden by the custom properties of
each test. If this option is set and the file exists, the prop-
erty testsuite.common.properties is set to the absolute
path of the harnessScript file.

no common properties

label
The build label. timestamp of when the test suite

was invoked.

productName
The name of the current tested product.

TestSuite

jvm
The location of your Java VM to start the test suite (the
harnessScript is called as is: [jvm] [...] -buildfile
[harnessScript] ).

java.home location if the property
is set, java otherwise.

jvmargs
The arguments to pass to the Java VM started for each test. None.

testsuiteReportFileProperty
The name of the Ant property in which the path of the
final report is stored. Path is [outputDir]/[label]/
[reportName].xml

testsuite.report.file

testsuiteReportDirProperty
Thenameof the Ant property inwhich is store the path of the
directory of the final report. Path is [outputDir]/[label] . testsuite.report.dir

testsuiteResultProperty
The name of the Ant property in which you want to have the
result of the test suite ( true or false ), depending if every
tests successfully passed the test suite or not. Ignored tests
do not a�ect this result.

None

Finally, you have to give as nested element the path containing the tests.

Table 11: testsuite task nested elements
Element Name Description

testPath
Containing all the file of the tests which will be launched by the test suite.

testIgnoredPath
(optional)

Any test in the intersection between testIgnoredPath and testPath will be executed by
the test suite, but will not appear in the JUnit final report. It will still generate a JUnit re-
port for each test, which will allow the HTML report to let them appears as “ignored” if it is
generated. Mostly used for known bugs which are not considered as failure but still relevant
enough to appears on the HTML report.
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Listing 7: Example of test suite task invocation

<!-- Launch the testusite engine -->
<testsuite:testsuite

timeOut="${microej.kf.testsuite.timeout}"
outputDir="${target.test.xml}/testkf"
harnessScript="${com.is2t.easyant.plugins#microej-kf-testsuite.microej-kf-testsuite-harness-jpf-emb.

→˓xml.file}"
commonProperties="${microej.kf.launch.propertyfile}"
testsuiteResultProperty="testkf.result"
testsuiteReportDirProperty="testkf.testsuite.report.dir"
productName="${module.name} testkf"
jvmArgs="${microej.kf.testsuite.jvmArgs}"
lockPort="${microej.kf.testsuite.lockPort}"
verboseLevel="${testkf.verbose.level}"

>
<testPath refid="target.testkf.path"/>

</testsuite:testsuite>

The javaTestsuite Task

This task extends the testsuite task, specializing the test suite to only start real Java class. This task retrieves
the classname of the tests from the classfile and provides new properties to the harness script:

Table 12: javaTestsuite task properties
Property Name Description

testsuite.
test.class

The classname of the current test. The value of the property testsuite.test.name is also
set to the classname of the current test.

testsuite.
test.
classpath

The classpath of the current test.

Listing 8: Example of javaTestsuite task invocation

<!-- Launch test suite -->
<testsuite:javaTestsuite

verboseLevel="${microej.testsuite.verboseLevel}"
timeOut="${microej.testsuite.timeout}"
outputDir="${target.test.xml}/@{prefix}"
harnessScript="${harness.file}"
commonProperties="${microej.launch.propertyfile}"
testsuiteResultProperty="@{prefix}.result"
testsuiteReportDirProperty="@{prefix}.testsuite.report.dir"
productName="${module.name} @{prefix}"
jvmArgs="${microej.testsuite.jvmArgs}"
lockPort="${microej.testsuite.lockPort}"
retryCount="${microej.testsuite.retry.count}"
retryIf="${microej.testsuite.retry.if}"
retryUnless="${microej.testsuite.retry.unless}"

>
<testPath refid="target.@{prefix}.path"/>

(continues on next page)
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(continued from previous page)

<testIgnoredPath refid="tests.@{prefix}.ignored.path" />
</testsuite:javaTestsuite>

The htmlReport Task

This task allow the user to transform a given path containing a sample of JUnit reports to an HTML detailed report.
Here is the attributes to fill:

• A nested fileset element containing all the JUnit reports of each test. Take care to exclude the final JUnit
report generated by the test suite.

• A nested element report :

– format : The format of the generated HTML report. Must be noframes or frames . When noframes
format is choosen, a standalone HTML file is generated.

– todir : The output folder of your HTML report.

– The report tag accepts the nested tag param with name and expression attributes. These tags can
pass XSL parameters to the stylesheet. The built-in stylesheets support the following parameters:

* PRODUCT : the product name that is displayed in the title of the HTML report.

* TITLE : the comment that is displayed in the title of the HTML report.

Note: It is advised to set the format to noframes if your test suite is not a Java test suite. If the format is set to
frames , with a non-JavaMicroEJ Test Suite, the nameof the linkswill not be relevant because of the non-existency
of packages.

Listing 9: Example of htmlReport task invocation

<!-- Generate HTML report -->
<testsuite:htmlReport>

<fileset dir="${@{prefix}.testsuite.report.dir}">
<include name="**/*.xml"/> <!-- include unary reports -->
<exclude name="**/bin/**/*.xml"/> <!-- exclude test bin files -->
<exclude name="*.xml"/> <!-- exclude global report -->

</fileset>
<report format="noframes" todir="${target.test.html}/@{prefix}"/>

</testsuite:htmlReport>

Using the Trace Analyzer

This section will shortly explains how to use the Trace Analyzer . The MicroEJ Test Suite comes with an archive
containing the Trace Analyzer which can be used to analyze the output trace of an application. It can be used
from di�erent forms;

• The FileTraceAnalyzer will analyze a file and research for the given tags, failing if the success tag is not
found.

• The SerialTraceAnalyzer will analyze the data from a serial connection.
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The TraceAnalyzer Tasks Options

Here is the common options to all TraceAnalyzer tasks:

• successTag : the regular expression which is synonym of success when found (by default .*PASSED.* ).

• failureTag : the regular expression which is synonym of failure when found (by default .*FAILED.* ).

• verboseLevel : int value between 0 and 9 to define the verbose level.

• waitingTimeAfterSuccess : waiting time (in s) a�er success before closing the stream (by default 5).

• noActivityTimeout : timeout (in s) with no activity on the stream before closing the stream. Set it to 0 to
disable timeout (default value is 0).

• stopEOFReached : boolean value. Set to true to stop analyzing when input stream EOF is reached. If false
, continue until timeout is reached (by default false ).

• onlyPrintableCharacters : boolean value. Set to true to only dumpASCII printable characters (by default
false ).

The FileTraceAnalyzer Task Options

Here is the specific options of the FileTraceAnalyzer task:

• traceFile : path to the file to analyze.

The SerialTraceAnalyzer Task Options

Here is the specific options of the SerialTraceAnalyzer task:

• port : the comm port to open.

• baudrate : serial baudrate (by default 9600).

• databits : databits (5|6|7|8) (by default 8).

• stopBits : stopbits (0|1|3 for (1_5)) (by default 1).

• parity : none | odd | event (by default none ).

Appendix

The goal of this section is to explain some tips and tricks thatmight be useful in your usage of the test suite engine.

Specific Custom Properties

Some customproperties are specifics and retrieved from the test suite engine in the customproperties file of a test.

• The testsuite.test.name property is the output name of the current test. Here are the steps to compute
the output name of a test:

– If the custom properties are enabled and a property named testsuite.test.name is find on the cor-
responding file, then the output name of the current test will be set to it.

– Otherwise, if the runningMicroEJ Test Suite is a Java test suite, the output name is set to the class name
of the test.

3.13. Advanced Tools 197



MicroEJ Documentation, Revision 2788b3f4

– Otherwise, from the path containing all the tests, a common prefix will be retrieved. The output name
will be set to the relative path of the current test from this common prefix. If the common prefix equals
the name of the test, then the output name will be set to the name of the test.

– Finally, if multiples tests have the same output name, then the current name will be followed by _XXX
, an underscore and an integer.

• The testsuite.test.timeout property allow the user to redefine the time out for each test. If it is negative
or not an integer, then global timeout defined for the MicroEJ Test Suite is used.

3.14 Graphical User Interface

This section presents libraries relative to the user interface.

The following schema shows the overall architecture andmodules:

Fig. 65: Graphical User Interface Overview
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Note: This chapter describes the current Graphical User Interface version 3 , provided by UI Pack version 13.0.0
or higher. If you are using the former Graphical User Interface version 2 (provided by MicroEJ UI Pack version up
to 12.4.x ), please refer to this MicroEJ Documentation Archive.

3.14.1 MicroUI

Introduction

MicroUI Foundation Library provides access to a pixel-based display and inputs.

The aim of this library is to enable the creation of user interface in Java by reifying hardware capabilities.

To use the MicroUI Foundation Library, add MicroUI API module to amodule description file:

<dependency org="ej.api" name="microui" rev="3.1.0"/>

Drawing Foundation Library extends MicroUI drawing APIs1 with more complex ones such as:

• thick line, arc, circle and ellipse

• polygon

• image deformation and rotation

To use the Drawing Foundation Library, add Drawing API module to amodule description file:

<dependency org="ej.api" name="drawing" rev="1.0.3"/>

Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.getImage() or
ej.microui.display.ResourceImage.loadImage(). To be displayed, these images have to be converted from their
source format to the display raw format. The conversion can either be done at:

• build-time (using the image generator tool),

• run-time (using the relevant decoder library).

Images thatmust beprocessedby the imagegenerator tool are declared inMicroEJClasspath *.images.list files.
The file format is a standard Java properties file, each line representing a / separated resource path relative to the
MicroEJ classpath root referring to a standard image file (e.g. .png , .jpg ). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImage1.png

# The following image is embedded

(continues on next page)

1 These APIs were formerly included in MicroUI 2.x
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(continued from previous page)

# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Configuration File

Here is the format of the *.images.list files.

ConfigFile ::= Line [ 'EOL' Line ]*
Line ::= ImagePath [ ':' ImageOption ]*
ImagePath ::= Identifier [ '/' Identifier ]*
ImageOption ::= [^:]*
Identifier ::= Letter [ LetterOrDigit ]*
Letter ::= 'a-zA-Z_$'
LetterOrDigit ::= 'a-zA-Z_$0-9'

Images Heap

The images heap is used to allocate the pixel data of:

• mutable images (i.e. Bu�eredImage instances)

• images which are not byte-addressable, such as images opened with an input stream

• images which are byte-addressable but converted to a di�erent output format

In other words, every image which can not be retrieved using Image.getImage() is saved on the images heap.

The size of the images heap can be configured with the ej.microui.memory.imagesheap.size property.

Output Formats

Without Compression

When no output format is set in the images list file, the image is embeddedwithout any conversion / compression.
This allows you to embed the resource aswell, in order to keep the source image characteristics (compression, bpp,
etc.). This option produces the same result as specifiying an image as a resource in the MicroEJ launcher.

Advantages:

• Preserves the image characteristics;

• Preserves the original image compression.

Disadvantages:

• Requires an image runtime decoder;

• Requires some RAM in which to store the decoded image;

• Requires execution time to decode the image.
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Standard Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may be directly
managed by the BSP display driver. Refer to the platform specification to retrieve the list of natively supported
formats.

Advantages:

• The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side;

• Drawing an image is very fast when the display driver recognizes the format (with or without transparency);

• Supports or not the alpha encoding: select the most suitable format for the image to encode.

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel;

• Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.

Select one the following format to use a generic format among this list: ARGB8888 , RGB888 , ARGB4444 , ARGB1555
, RGB565 , A8 , A4 , A2 , A1 , C4 , C2 , C1 , AC44 , AC22 and AC11 . The following snippets describe the color
conversion for each format:

• ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

int convertARGB8888toRAWFormat(int c){
return c;

}

• RGB888: 24 bits format, 8 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return c & 0xffffff;

}

• ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xf0000000) >> 16)
| ((c & 0x00f00000) >> 12)
| ((c & 0x0000f000) >> 8)
| ((c & 0x000000f0) >> 4)
;

}

• ARGB1555: 16 bits format, 1 bit for transparency, 5 per color.

int convertARGB8888toRAWFormat(int c){
return 0

| (((c & 0xff000000) == 0xff000000) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)

(continues on next page)
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(continued from previous page)

| ((c & 0x0000f8) >> 3)
;

}

• RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xf80000) >> 8)
| ((c & 0x00fc00) >> 5)
| ((c & 0x0000f8) >> 3)
;

}

• A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return 0xff - (toGrayscale(c) & 0xff);

}

• A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (0xff - (toGrayscale(c) & 0xff)) / 0x11;

}

• A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (0xff - (toGrayscale(c) & 0xff)) / 0x55;

}

• A1: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (0xff - (toGrayscale(c) & 0xff)) / 0xff;

}

• C4: 4 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0x11;

}

• C2: 2 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0x55;

}

• C1: 1 bit format with grayscale conversion. Image is always fully opaque.
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int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0xff;

}

• AC44: 4 bits for transparency, 4 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0

| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & 0xff) / 0x11)
;

}

• AC22: 2 bits for transparency, 2 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0

| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & 0xff) / 0x55)
;

}

• AC11: 1 bit for transparency, 1 bit with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xff000000) == 0xff000000 ? 0x2 : 0x0)
| ((toGrayscale(color) & 0xff) / 0xff)
;

}

Examples:

image1:ARGB8888
image2:RGB565
image3:A4

Display Output Format

This format encodes the image into the exact display memory representation. If the image to encode contains
some transparent pixels, the output file will embed the transparency according to the display’s implementation
capacity. When all pixels are fully opaque, no extra information will be stored in the output file in order to free up
somememory space.

Note: When the display memory representation is standard, the display output format is automatically replaced
by a standard format.

Advantages:

• Drawing an image is very fast because no pixel conversion is required at runtime;

• Supports alpha encoding when display pixel format allow it.

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels.
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image1:display

RLE1 Output Format

The imageengine candisplayembedded images that are encoded intoa compressed formatwhichencodes several
consecutive pixels into one or more 16-bit words. This encoding manages a maximum alpha level of 2 (alpha level
is always assumed to be 2, even if the image is not transparent).

• Several consecutive pixels have the same color (2 words):

– First 16-bit word specifies howmany consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).

– Second 16-bit word is the pixels’ color in RGB565 format.

• Several consecutive pixels have their own color (1 + n words):

– First 16-bit word specifies howmany consecutive pixels have their own color;

– Next 16-bit word is the next pixel color.

• Several consecutive pixels are transparent (1 word):

– 16-bit word specifies howmany consecutive pixels are transparent.

Advantages:

• Supports fully opaque and fully transparent encoding.

• Good compression when several consecutive pixels respect one of the three previous rules.

Disadvantages:

• Drawing an image is slightly slower than when using Display format.

• Not designed for imageswithmany di�erent pixel colors: in such case, the output file sizemay be larger than
the original image file.

image1:RLE1

Image Generator Error Messages

These errors can occur while preprocessing images.
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Table 13: Static Image Generator Error Messages
ID Type Description
0 Error The image generator has encountered an unexpected internal error.
1 Error The images list file has not been specified.
2 Error The image generator cannot create the final, raw file.
3 Error The image generator cannot read the images list file. Make sure the system allows reading of

this file.
4 Warning The image generator has found no image to generate.
5 Error The image generator cannot load the images list file.
6 Warning The specified image path is invalid: The image will be not converted.
7 Warning There are toomany or too few options for the desired format.
8 Error The display format is not generic; a MicroUIRawImageGeneratorExtension implementation is

required to generate the MicroUI raw image.
9 Error The image cannot be read.
10 Error The image generator has encountered an unexpected internal error (invalid endianness).
11 Error The image generator has encountered an unexpected internal error (invalid bpp).
12 Error The image generator has encountered an unexpected internal error (invalid display format).
13 Error The image generator has encountered an unexpected internal error (invalid pixel layout).
14 Error The image generator has encountered an unexpected internal error (invalid output folder).
15 Error The image generator has encountered an unexpected internal error (invalid memory

alignment).
16 Error The input image format and / or the ouput format are not managed by the image generator.
17 Error The image has been already loaded with another output format.

Fonts

Overview

Fonts are graphical resources that can be accessedwith a call to ej.microui.display.Font.getFont(). To be displayed,
these fonts have to be converted at build-time from their source format to the display raw format by the font gener-
ator tool. Fonts thatmust be processedby the font generator tool are declared inMicroEJ Classpath *.fonts.list
files. The file format is a standard Java properties file, each line representing a / separated resource path relative
to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension). The resourcemay
be followed by optional parameters which define :

• some ranges of characters to embed in the final raw file;

• the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depth is 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2
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MicroEJ font files conventionally end with the .ejf su�ix and are created using the Font Designer (see Font De-
signer).

Configuration File

Here is the format of the *.fonts.list files.

ConfigFile ::= Line [ 'EOL' Line ]*
Line ::= FontPath [ ':' [ Ranges ] [ ':' BitsPerPixel ] ]
FontPath ::= Identifier [ '/' Identifier ]*
Ranges ::= Range [ ';' Range ]*
Range ::= CustomRangeList | KnownRange
CustomRangeList ::= CustomRange [ ',' CustomRange ]*
CustomRange ::= Number | Number '-' Number
KnownRange ::= Name [ SubRangeList ]?
SubRangeList ::= '(' SubRange [ ',' SubRange ]* ')'
SubRange ::= Number | Number - Number
Identifier ::= 'a-zA-Z_$' [ 'a-zA-Z_$0-9' ]*
Number ::= Number16 | Number10
Number16 ::= '0x' [ Digit16 ]+
Number10 ::= [ Digit10 ]+
Digit16 ::= 'a-fA-F0-9'
Digit10 ::= '0-9'
BitsPerPixel ::= '1' | '2' | '4' | '8'

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are twoways to specify a character range: the custom range
and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.

Examples:

• myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

• myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and
from 0x55 to 0x75.

• myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to
0x49 and character 0x55.

Known Range

A known range is a range available in the following table.

Examples:

• myfont:basic_latin : Embed all Basic Latin characters;
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• myfont:basic_latin;arabic : Embed all Basic Latin characters, and all Arabic characters.

The following table describes the available list of ranges and sub-ranges (processed from the “Unicode Character
Database” version 9.0.0 available on the o�icial unicode website https://home.unicode.org/ ).

Table 14: Ranges
Name Tag Start End
Basic Latin basic_latin 0x0 0x7f
Latin-1 Supplement latin-1_supplement 0x80 0x�
Latin Extended-A latin_extended-a 0x100 0x17f
Latin Extended-B latin_extended-b 0x180 0x24f
IPA Extensions ipa_extensions 0x250 0x2af
Spacing Modifier Letters spacing_modifier_letters 0x2b0 0x2�
Combining Diacritical Marks combining_diacritical_marks 0x300 0x36f
Greek and Coptic greek_and_coptic 0x370 0x3�
Cyrillic cyrillic 0x400 0x4�
Cyrillic Supplement cyrillic_supplement 0x500 0x52f
Armenian armenian 0x530 0x58f
Hebrew hebrew 0x590 0x5�
Arabic arabic 0x600 0x6�
Syriac syriac 0x700 0x74f
Arabic Supplement arabic_supplement 0x750 0x77f
Thaana thaana 0x780 0x7bf
NKo nko 0x7c0 0x7�
Samaritan samaritan 0x800 0x83f
Mandaic mandaic 0x840 0x85f
Arabic Extended-A arabic_extended-a 0x8a0 0x8�
Devanagari devanagari 0x900 0x97f
Bengali bengali 0x980 0x9�
Gurmukhi gurmukhi 0xa00 0xa7f
Gujarati gujarati 0xa80 0xa�
Oriya oriya 0xb00 0xb7f
Tamil tamil 0xb80 0xb�
Telugu telugu 0xc00 0xc7f
Kannada kannada 0xc80 0xc�
Malayalam malayalam 0xd00 0xd7f
Sinhala sinhala 0xd80 0xd�
Thai thai 0xe00 0xe7f
Lao lao 0xe80 0xe�
Tibetan tibetan 0xf00 0x�f
Myanmar myanmar 0x1000 0x109f
Georgian georgian 0x10a0 0x10�
Hangul Jamo hangul_jamo 0x1100 0x11�
Ethiopic ethiopic 0x1200 0x137f
Ethiopic Supplement ethiopic_supplement 0x1380 0x139f
Cherokee cherokee 0x13a0 0x13�
Unified Canadian Aboriginal Syllabics unified_canadian_aboriginal_syllabics 0x1400 0x167f
Ogham ogham 0x1680 0x169f
Runic runic 0x16a0 0x16�
Tagalog tagalog 0x1700 0x171f
Hanunoo hanunoo 0x1720 0x173f

Continued on next page
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Table 14 – continued from previous page
Name Tag Start End
Buhid buhid 0x1740 0x175f
Tagbanwa tagbanwa 0x1760 0x177f
Khmer khmer 0x1780 0x17�
Mongolian mongolian 0x1800 0x18af
Unified Canadian Aboriginal Syllabics
Extended

unified_canadian_aboriginal_syllabics_extended 0x18b0 0x18�

Limbu limbu 0x1900 0x194f
Tai Le tai_le 0x1950 0x197f
New Tai Lue new_tai_lue 0x1980 0x19df
Khmer Symbols khmer_symbols 0x19e0 0x19�
Buginese buginese 0x1a00 0x1a1f
Tai Tham tai_tham 0x1a20 0x1aaf
CombiningDiacriticalMarks Extended combining_diacritical_marks_extended 0x1ab0 0x1a�
Balinese balinese 0x1b00 0x1b7f
Sundanese sundanese 0x1b80 0x1bbf
Batak batak 0x1bc0 0x1b�
Lepcha lepcha 0x1c00 0x1c4f
Ol Chiki ol_chiki 0x1c50 0x1c7f
Cyrillic Extended-C cyrillic_extended-c 0x1c80 0x1c8f
Sundanese Supplement sundanese_supplement 0x1cc0 0x1ccf
Vedic Extensions vedic_extensions 0x1cd0 0x1c�
Phonetic Extensions phonetic_extensions 0x1d00 0x1d7f
Phonetic Extensions Supplement phonetic_extensions_supplement 0x1d80 0x1dbf
Combining Diacritical Marks Supple-
ment

combining_diacritical_marks_supplement 0x1dc0 0x1d�

Latin Extended Additional latin_extended_additional 0x1e00 0x1e�
Greek Extended greek_extended 0x1f00 0x1�f
General Punctuation general_punctuation 0x2000 0x206f
Superscripts and Subscripts superscripts_and_subscripts 0x2070 0x209f
Currency Symbols currency_symbols 0x20a0 0x20cf
Combining Diacritical Marks for Sym-
bols

combining_diacritical_marks_for_symbols 0x20d0 0x20�

Letterlike Symbols letterlike_symbols 0x2100 0x214f
Number Forms number_forms 0x2150 0x218f
Arrows arrows 0x2190 0x21�
Mathematical Operators mathematical_operators 0x2200 0x22�
Miscellaneous Technical miscellaneous_technical 0x2300 0x23�
Control Pictures control_pictures 0x2400 0x243f
Optical Character Recognition optical_character_recognition 0x2440 0x245f
Enclosed Alphanumerics enclosed_alphanumerics 0x2460 0x24�
Box Drawing box_drawing 0x2500 0x257f
Block Elements block_elements 0x2580 0x259f
Geometric Shapes geometric_shapes 0x25a0 0x25�
Miscellaneous Symbols miscellaneous_symbols 0x2600 0x26�
Dingbats dingbats 0x2700 0x27bf
Miscellaneous Mathematical
Symbols-A

miscellaneous_mathematical_symbols-a 0x27c0 0x27ef

Supplemental Arrows-A supplemental_arrows-a 0x27f0 0x27�
Braille Patterns braille_patterns 0x2800 0x28�

Continued on next page
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Table 14 – continued from previous page
Name Tag Start End
Supplemental Arrows-B supplemental_arrows-b 0x2900 0x297f
Miscellaneous Mathematical
Symbols-B

miscellaneous_mathematical_symbols-b 0x2980 0x29�

Supplemental Mathematical Opera-
tors

supplemental_mathematical_operators 0x2a00 0x2a�

Miscellaneous Symbols and Arrows miscellaneous_symbols_and_arrows 0x2b00 0x2b�
Glagolitic glagolitic 0x2c00 0x2c5f
Latin Extended-C latin_extended-c 0x2c60 0x2c7f
Coptic coptic 0x2c80 0x2c�
Georgian Supplement georgian_supplement 0x2d00 0x2d2f
Tifinagh tifinagh 0x2d30 0x2d7f
Ethiopic Extended ethiopic_extended 0x2d80 0x2ddf
Cyrillic Extended-A cyrillic_extended-a 0x2de0 0x2d�
Supplemental Punctuation supplemental_punctuation 0x2e00 0x2e7f
CJK Radicals Supplement cjk_radicals_supplement 0x2e80 0x2e�
Kangxi Radicals kangxi_radicals 0x2f00 0x2fdf
Ideographic Description Characters ideographic_description_characters 0x2�0 0x2�f
CJK Symbols and Punctuation cjk_symbols_and_punctuation 0x3000 0x303f
Hiragana hiragana 0x3040 0x309f
Katakana katakana 0x30a0 0x30�
Bopomofo bopomofo 0x3100 0x312f
Hangul Compatibility Jamo hangul_compatibility_jamo 0x3130 0x318f
Kanbun kanbun 0x3190 0x319f
Bopomofo Extended bopomofo_extended 0x31a0 0x31bf
CJK Strokes cjk_strokes 0x31c0 0x31ef
Katakana Phonetic Extensions katakana_phonetic_extensions 0x31f0 0x31�
Enclosed CJK Letters and Months enclosed_cjk_letters_and_months 0x3200 0x32�
CJK Compatibility cjk_compatibility 0x3300 0x33�
CJK Unified Ideographs Extension A cjk_unified_ideographs_extension_a 0x3400 0x4dbf
Yijing Hexagram Symbols yijing_hexagram_symbols 0x4dc0 0x4d�
CJK Unified Ideographs cjk_unified_ideographs 0x4e00 0x9�f
Yi Syllables yi_syllables 0xa000 0xa48f
Yi Radicals yi_radicals 0xa490 0xa4cf
Lisu lisu 0xa4d0 0xa4�
Vai vai 0xa500 0xa63f
Cyrillic Extended-B cyrillic_extended-b 0xa640 0xa69f
Bamum bamum 0xa6a0 0xa6�
Modifier Tone Letters modifier_tone_letters 0xa700 0xa71f
Latin Extended-D latin_extended-d 0xa720 0xa7�
Syloti Nagri syloti_nagri 0xa800 0xa82f
Common Indic Number Forms common_indic_number_forms 0xa830 0xa83f
Phags-pa phags-pa 0xa840 0xa87f
Saurashtra saurashtra 0xa880 0xa8df
Devanagari Extended devanagari_extended 0xa8e0 0xa8�
Kayah Li kayah_li 0xa900 0xa92f
Rejang rejang 0xa930 0xa95f
Hangul Jamo Extended-A hangul_jamo_extended-a 0xa960 0xa97f
Javanese javanese 0xa980 0xa9df
Myanmar Extended-B myanmar_extended-b 0xa9e0 0xa9�

Continued on next page
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Table 14 – continued from previous page
Name Tag Start End
Cham cham 0xaa00 0xaa5f
Myanmar Extended-A myanmar_extended-a 0xaa60 0xaa7f
Tai Viet tai_viet 0xaa80 0xaadf
Meetei Mayek Extensions meetei_mayek_extensions 0xaae0 0xaa�
Ethiopic Extended-A ethiopic_extended-a 0xab00 0xab2f
Latin Extended-E latin_extended-e 0xab30 0xab6f
Cherokee Supplement cherokee_supplement 0xab70 0xabbf
Meetei Mayek meetei_mayek 0xabc0 0xab�
Hangul Syllables hangul_syllables 0xac00 0xd7af
Hangul Jamo Extended-B hangul_jamo_extended-b 0xd7b0 0xd7�
High Surrogates high_surrogates 0xd800 0xdb7f
High Private Use Surrogates high_private_use_surrogates 0xdb80 0xdb�
Low Surrogates low_surrogates 0xdc00 0xd�f
Private Use Area private_use_area 0xe000 0xf8�
CJK Compatibility Ideographs cjk_compatibility_ideographs 0xf900 0xfa�
Alphabetic Presentation Forms alphabetic_presentation_forms 0xfb00 0xfb4f
Arabic Presentation Forms-A arabic_presentation_forms-a 0xfb50 0xfd�
Variation Selectors variation_selectors 0xfe00 0xfe0f
Vertical Forms vertical_forms 0xfe10 0xfe1f
Combining Half Marks combining_half_marks 0xfe20 0xfe2f
CJK Compatibility Forms cjk_compatibility_forms 0xfe30 0xfe4f
Small Form Variants small_form_variants 0xfe50 0xfe6f
Arabic Presentation Forms-B arabic_presentation_forms-b 0xfe70 0xfe�
Halfwidth and Fullwidth Forms halfwidth_and_fullwidth_forms 0x�00 0x�ef
Specials specials 0x�f0 0x��

Transparency

The second parameter is for specifying the font transparency level ( 1 , 2 , 4 or 8 ). If unspecified, the encoded
transparency level is 1 (does not depend on transparency level encoded in EJF file).

Examples:

• myfont:latin:4 : Embed all latin characters with 16 levels of transparency

• myfont::2 : Embed all characters with 4 levels of transparency
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Font Generator Error Messages

Table 15: Static Font Generator Error Messages
ID Type Description
0 Error The font generator has encountered an unexpected internal error.
1 Error The Fonts list file has not been specified.
2 Error The font generator cannot create the final, raw file.
3 Error The font generator cannot read the fonts list file.
4 Warning The font generator has found no font to generate.
5 Error The font generator cannot load the fonts list file.
6 Warning The specified font path is invalid: The font will be not converted.
7 Warning There are toomany arguments on a line: the current entry is ignored.
8 Error The font generator has encountered an unexpected internal error (invalid output format).
9 Error The font generator has encountered an unexpected internal error (invalid endianness).
10 Error The specified entry is invalid.
11 Error The specified entry does not contain a list of characters.
12 Error The specified entry does not contain a list of identifiers.
13 Error The specified entry is an invalid width.
14 Error The specified entry is an invalid height.
15 Error The specified entry does not contain the characters’ addresses.
16 Error The specified entry does not contain the characters’ bitmaps.
17 Error The specified entry bits-per-pixel value is invalid.
18 Error The specified range is invalid.
19 Error There are toomany identifiers. The output RAW format cannot store all identifiers.
20 Error The font’s name is too long. The output RAW format cannot store all name characters.
21 Error There are toomany ranges. The output RAW format cannot store all ranges.
22 Error Output list files cannot be created.
23 Error Dynamic styles are not supported. Only a PLAIN font can be encoded.
24 Error Underlined style is not supported. Only a BOLD and ITALIC font can be set.

Font Designer

Principle

The Font Designer module is a graphical tool (Eclipse plugin) that runs within the MicroEJ IDE used to build and
edit MicroUI fonts. It stores fonts in a platform-independent format.

3.14. Graphical User Interface 211



MicroEJ Documentation, Revision 2788b3f4

Functional Description

Fig. 66: Font Generation

Font Management

Create a MicroEJ Font

To create a MicroEJ font, follow the steps below:

1. Open the Eclipse wizard: File > New > Other. . . > MicroEJ > MicroEJ Font .

2. Select a directory and a name.

3. Click Finish.

Once the font is created, a new editor is opened: the MicroEJ Font Designer.

Edit a MicroEJ Font

You can edit your font with the MicroEJ Font Designer (by double-clicking on a *.ejf file or a�er running the new
MicroEJ Font wizard).

This editor is divided into three main parts:

• The top le� part manages the main font properties.

• The top right part manages the character to embed in your font.

• The bottom part allows you to edit a set of characters or an individual character.

Main Properties

Themain font properties are:

• font size: height and width (in pixels).

• baseline (in pixels).
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• space character size (in pixels).

• styles and filters.

• identifiers.

Refer to the following sections for more information about these properties.

Font Height

A font has a fixed height. This height includes the white pixels at the top and at the bottom of each character
simulating line spacing in paragraphs.

Fig. 67: Font Height

Font Width: Proportional and Monospace Fonts

A monospace font is a font in which all characters have the same width. For example a ‘!’ representation will be
the same width as a ‘w’ (they will be in the same size rectangle of pixels). In a proportional font, a ‘w’ will be wider
than a ‘!’.

A monospace font usually o�ers a smaller memory footprint than a proportional font because the Font Designer
does not need to store the size of each character. As a result, this option can be useful if the di�erence between the
size of the smallest character and the biggest one is small.

Baseline

Characters have a baseline: an imaginary line on top of which the characters seem to stand. Note that characters
can be partly under the line, for example, ‘g’ or ‘}’.

Fig. 68: The Baseline

Space Character

The Space character (0x20) is a specific character because it has no filled pixels. From the Main Properties Menu
you can fix the space character size in pixels.

Note: When the font is monospace, the space size is equal to the font width.
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Styles

FontDesigner allows creatinga font file that holds several combinationsof built-in styles (styles hardcoded inpixels
map) and runtime styles (styles rendered dynamically at runtime). However, since MicroUI 3, a MicroUI font holds
only one style: PLAIN , BOLD , ITALIC or BOLD + ITALIC .

Font Designer features three drop-downs, one for each of BOLD , ITALIC , and UNDERLINED . Each drop-down has
three options: None , Built-in and Dynamic . The font options must be adjusted to be compatible with MicroUI
3:

• The style option Dynamic (that targets the runtime style) is forbidden; select None instead.

• The syle UNDERLINED is forbidden; select None instead.

The styles options Built-in tag the font as bold, italic, or bold and italic. This style canbe retrievedby theMicroEJ
Application thanks the methods Font.isBold() and Font.isItalic() . Adjust the styles options according to
the font:

• The font is a plain font: select None option for each style.

• The font is a bold font: select Built-in for the style bold and None for the other styles.

• The font is an italic font: select Built-in for the style italic and None for the other styles.

• The font is a bold and italic font: select Built-in for the styles bold and italic and None for UNDERLINED .

Warning: When a font holds a dynamic style or when the style UNDERLINED is not None , an error at MicroEJ
application compile-time is thrown (incompatible font file).

Identifiers

A number of identifiers can be attached to a MicroUI font. At least one identifier is required to specify the font.
Identifiers are a mechanism for specifying the contents of the font – the set or sets of characters it contains. The
identifier may be a standard identifier (for example, LATIN) or a user-defined identifier. Identifiers are numbers,
but standard identifiers, which are in the range 0 to 80, are typically associated with a handy name. A user-defined
identifier is an identifier with a value of 81 or higher.

Character List

The list of characters can be populated through the import button, which allows you to import characters from
system fonts, images or another MicroEJ font.

Import from System Font

This page allows you to select the system font to use (le� part) and the range of characters. There are predefined
ranges of characters below the font selection, as well as a custom selection picker (for example 0x21 to 0xfe for
Latin characters).

The right part displays the selected characters with the selected font. If the background color of a displayed char-
acter is red, it means that the character is too large for the defined height, or in the case of a monospace font, it
means the character is too high or too wide. You can then adjust the font properties (font size and style) to ensure
that characters will not be truncated.

When your selection is done, click the Finish button to import this selection into your font.

3.14. Graphical User Interface 214



MicroEJ Documentation, Revision 2788b3f4

Import from Images

This page allows the loading of images from a directory. The images must be named as follows: 0x[UTF-8].
[extension] .

When your selection is done, click the Finish button to import the images into your font.

Character Editor

When a single character is selected in the list, the character editor is opened.

Fig. 69: Character Editor

You can define specific properties, such as le� and right space, or index. You can also draw the character pixel by
pixel - a le�-click in the grid draws the pixel, a right-click erases it.

The changes are not saved until you click the Apply button. When changes are applied to a character, the editor
shows that the font has changed, so you can now save it.

The same part of the editor is also used to edit a set of characters selected in the top right list. You can then edit
the common editable properties (le� and right space) for all those characters at the same time.
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Working With Anti-Aliased Fonts

By default, when characters are imported from a system font, each pixel is either fully opaque or fully transparent.
Fully opaque pixels show as black squares in the character grid in the right-hand part of the character editor; fully
transparent pixels show as white squares.

However, thepixels stored in an ejf file can takeoneof 256grayscale values. A fully-transparent pixel has the value
255 (the RGB value for white), and a fully-opaque pixel has the value 0 (the RGB value for black). These grayscale
values are shown in parentheses at the endof the text in the Current alpha fieldwhen themouse cursor hovers over
a pixel in the grid. That field also shows the transparency level of the pixel, as a percentage, where 100% means
fully opaque.

It is possible to achieve better-looking characters by using a combination of fully-opaque and partially-transparent
pixels. This technique is calledanti-aliasing. Anti-aliasedcharacters canbe imported fromsystemfontsbychecking
the anti aliasing box in the import dialog. The ‘&’ character shown in the screenshot abovewas imported using anti
aliasing, and you can see the various gray levels of the pixels.

When the Font Generator converts an ejf file into the raw format used at runtime, it can create fonts with char-
acters that have 1, 2, 4 or 8 bits-per-pixel (bpp). If the raw font has 8 bpp, then no conversion is necessary and the
characters will render with the same quality as seen in the character editor. However, if the raw font has less than
8 bpp (the default is 1 bpp) any gray pixels in the input file are compressed to fit, and the final rendering will be of
lower quality (but less memory will be required to hold the font).

It is useful to be able to see the e�ects of this compression, so the character editor provides radio buttons that allow
the user to preview the character at 1, 2, 4, or 8 bpp. Furthermore, when 2, 4 or 8 bpp is selected, a slider allows the
user to select the transparency level of the pixels drawn when the le�mouse button is clicked in the grid.

Previewing a Font

You can preview your font by pressing the Preview. . . button, which opens the Preview wizard. In the Preview
wizard, press the Select File button, and select a text file which contains text that you want to see rendered using
your font. Characters that are in the selected text file but not available in the font will be shown as red rectangles.
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Fig. 70: Font Preview
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Removing Unused Characters

In order to reduce the size of a font file, you can reduce the number of characters in your font to be only those char-
acters used by your application. To do this, create a file which contains all the characters used by your application
(for example, concatenating all your NLS files is a good starting point). Then open the Previewwizard as described
above, selecting that file. If you select the check box Delete unused on finish, then those characters that are in the
font but not in the text filewill be deleted from the fontwhen youpress the Finish button, leaving your font contain-
ing theminimumnumber of characters. As this font will contain only characters used by a specific application, it is
best to prepare a “complete” font, and then apply this technique to a copy of that font to produce an application
specific cut-down version of the font.

Use a MicroEJ Font

A MicroEJ Font must be converted to a format which is specific to the targeted platform. The Font Generator tool
performs this operation for all fonts specified in the list of fonts configured in the application launch.

Dependencies

No dependency.

Installation

The Font Designer module is already installed in the MicroEJ environment.

Use

Create a new ejf font file or open an existing one in order to open the Font Designer plugin.

Application Options

MicroUI libraries and its tools provide a set of options. See Application Options to havemore information about the
application options.

Note: MicroUI implementation requires one thread (MicroUI Pump) and at least 100 bytes in the immortals heap.
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Category: Libraries

Category: MicroUI

Group: Memory
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Option(text): Pump events (inputs and display) queue size (in number of events)

Option Name: ej.microui.memory.queue.size

Default value: 100

Description:

Specifies the size of the pump events queue.

Option(combo): Pump events thread priority

Option Name: com.microej.library.microui.pump.priority

Default value: 5

Available values: 1 to 10

Description:

Specifies the priority of the pump events queue.

Option(text): Images heap size (in bytes)

Option Name: ej.microui.memory.imagesheap.size

Default value: 131072

Description:

Specifies the size of the images heap. This heap is used to store the dynamic user images, the decoded images
and the working bu�ers of embedded image decoders (for instance the PNG decoder). A too small value can cause
OutOfMemory errors and incomplete drawings.
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Category: Font

Group: Fonts to Process

Description:

This group allows to select a file describing the font files which need to be converted into a RAW format. At Mi-
croUI runtime, the pre-generated fonts will be read from the flashmemory without anymodifications (see MicroUI
specification).

Option(checkbox): Activate the font pre-processing step

Option Name: ej.microui.fontConverter.useIt

Default value: true

Description:

When checked, enables the next option Fonts list file. When the next option is disabled, there is no check on
the file path validity.

Option(checkbox): Define an explicit list file

Option Name: ej.microui.fontConverter.file.enabled

Default value: false

Description:

Bydefault, list files are loaded fromtheclasspath. Whenchecked, only thenextoption Fonts list file isprocessed.
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Option(browse):

Option Name: ej.microui.fontConverter.file

Default value: (empty)

Description:

Browse to select a font list file. Refer to Font Generator chapter for more information about the font list file format.

Category: Image

Group: Images to Process

Description:

This group allows to select a file describing the image files which need to be converted into a RAW format. At
MicroUI runtime, the pre-generated images will be read from the flash memory without any modifications (see
MicroUI specification).

Option(checkbox): Activate the image pre-processing step

Option Name: ej.microui.imageConverter.useIt

Default value: true

Description:

When checked, enables the next option Images list file. When the next option is disabled, there is no check on
the file path validity.

3.14. Graphical User Interface 222



MicroEJ Documentation, Revision 2788b3f4

Option(checkbox): Define an explicit list file

Option Name: ej.microui.imageConverter.file.enabled

Default value: false

Description:

By default, list files are loaded from the classpath. When checked, only the next option Images list file is pro-
cessed.

Option(browse):

Option Name: ej.microui.imageConverter.file

Default value: (empty)

Description:

Browse to select an image list file. Refer to Image Generator chapter for more information about the image list file
format.

Debug Traces

MicroUI logs several actions when traces are enabled. This chapter explains the traces identifiers. Some events
data are described in next tables.

[TRACE: MicroUI] Event AA(BB[CC],DD[EE])

where:

• AA is the event identifier. See next table.

• BB is the first event data.

• CC is the first event data number (0x0).

• DD is the second event data.

• EE is the second event data number (0x1).

• etc.
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Table 16: MicroUI Traces
Event
ID

Description End of event

0x0
(0)

Execute EventGenerator event %0% (see Event Type). Generator id is
%1% and data is %2% .

End of %0% (see Event Type).

0x1 (1) Drop event %0% .
0x2 (2) Execute native input event %0% (see Event Type). Generator id is %1%

and data is %2% .
End of %0% (see Event Type).

0x3 (3) Execute display event %0% (see Event Type). Event is %1% . End of %0% (see Event Type).
0x4 (4) Execute user event %0% . End of %0% .
0x5 (5) Create new image using %0% algorithm (see Create Image). Image created, image identi-

fier is %0% .
0x6 (6) New image characteristics %0% (see Image Type), identifier is %1%

andmemory size is %2% .
0xa
(10)

Flush back bu�er; position ( %0% , %1% ) size ( %2% * %3% ).

0xb
(11)

Flush done.

0xc
(12)

Start internal drawing operation %0% (see Drawing Type). End of drawing %0% (see
Drawing Type)

0xd
(13)

Start drawing operation %0% (see Drawing Type). End of drawing %0% (see
Drawing Type)

0xe
(14)

Unknown event.

0xf
(15)

Asynchronous drawing operation done.

0x14
(20)

Invalid input event %0% .

0x15
(21)

Event queue is full, cannot add event %0% .

0x16
(22)

Add event %0% at index %1% ; queue length is %2% .

0x17
(23)

Replace event %0% by %1% at index %2% ; queue length is %3% .

0x18
(24)

Read event %0% at index %1% .
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Table 17: Event Type
Event ID Description
0x0 (0) Event “Command”
0x1 (1) Event “Button”
0x2 (2) Event “Pointer”
0x3 (3) Event “State”
0x4 (4) Event “Unknwon”
0x5 (5) Event “Call Serially”
0x6 (6) Event “MicroUI Stop”
0x7 (7) Event “Input”
0x8 (8) Event “Show Displayable”
0x9 (9) Event “Hide Displayable”
0xb (11) Event “Pending Flush”
0xc (12) Event “Force Flush”
0xd (13) Event “Repaint Displayable”
0xe (14) Event “Repaint Current Displayable”
0xf (15) Event “KF Stop Feature”

Table 18: Create Image
Event ID Description
0x0 (0) Create Bu�eredImage
0x1 (1) Create Image from path
0x2 (2) Create Image from InputStream

Table 19: Image Type
Event ID Description
0x0 (0) New Bu�eredImage
0x1 (1) Load MicroEJ Image from RAW file
0x2 (2) NewMicroEJ Image from encoded image
0x3 (3) NewMicroEJ Image from RAW image in external memory
0x4 (4) NewMicroEJ Image from encoded image in external memory
0x5 (5) NewMicroEJ Image frommemory InputStream
0x6 (6) NewMicroEJ Image from byte array InputStream
0x7 (7) NewMicroEJ Image from generic InputStream
0x8 (8) Link Image

Table 20: Drawing Type
Event ID Description
0x1 (1) Write pixel
0x2 (2) Draw line
0x3 (3) Draw horizontal line
0x4 (4) Draw vertical line
0x5 (5) Draw rectangle
0x6 (6) Fill rectangle
0x7 (7) Unknown
0x8 (8) Draw rounded rectangle
0x9 (9) Fill rounded rectangle

Continued on next page
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Table 20 – continued from previous page
Event ID Description
0xa (10) Draw circle arc
0xb (11) Fill circle arc
0xc (12) Draw ellipse arc
0xd (13) Fill ellipse arc
0xe (14) Draw ellipse
0xf (15) Fill ellipse
0x10 (16) Draw circle
0x11 (17) Fill circle
0x12 (18) Draw ARGB array
0x13 (19) Draw image
0x32 (50) Draw polygon
0x33 (51) Fill polygon
0x34 (52) Get ARGB image data
0x35 (53) Draw string
0x36 (54) Draw deformed string
0x37 (55) Draw deformed image
0x38 (56) Draw character with rotation (bilinear)
0x39 (57) Draw character with rotation (simple)
0x3a (58) Get string width
0x3b (59) Get pixel
0x64 (100) Draw thick faded point
0x65 (101) Draw thick faded line
0x66 (102) Draw thick faded circle
0x67 (103) Draw thick faded circle arc
0x68 (104) Draw thick faded ellipse
0x69 (105) Draw thick line
0x6a (106) Draw thick circle
0x6b (107) Draw thick ellipse
0x6c (108) Draw thick circle arc
0xc8 (200) Draw image with fli
0xc9 (201) Draw image with rotation (simple)
0xca (202) Draw image with rotation (bilinear)
0xcb (203) Draw image with scalling (simple)
0xcc (204) Draw image with scalling (bilinear)

The traces are SystemView compatible. The following text can be copied in a file called SYSVIEW_MicroUI.txt and
copied in SystemView installation folder.

NamedType UIEvent 0=COMMAND
NamedType UIEvent 1=BUTTON
NamedType UIEvent 2=POINTER
NamedType UIEvent 3=STATE
NamedType UIEvent 4=UNKNOWN
NamedType UIEvent 5=CALLSERIALLY
NamedType UIEvent 6=STOP
NamedType UIEvent 7=INPUT
NamedType UIEvent 8=SHOW_DISPLAYABLE
NamedType UIEvent 9=HIDE_DISPLAYABLE
NamedType UIEvent 11=PENDING_FLUSH
NamedType UIEvent 12=FORCE_FLUSH
NamedType UIEvent 13=REPAINT_DISPLAYABLE

(continues on next page)
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(continued from previous page)

NamedType UIEvent 14=REPAINT_CURRENT_DISPLAYABLE
NamedType UIEvent 15=KF_STOP_FEATURE

NamedType UINewImage 0=MUTABLE_IMAGE
NamedType UINewImage 1=IMAGE_FROM_PATH
NamedType UINewImage 2=IMAGE_FROM_INPUTSTREAM

NamedType UIImageData 0=NEW_IMAGE
NamedType UIImageData 1=LOAD_MICROEJ
NamedType UIImageData 2=NEW_ENCODED
NamedType UIImageData 3=NEW_MICROEJ_EXTERNAL
NamedType UIImageData 4=NEW_ENCODED_EXTERNAL
NamedType UIImageData 5=MEMORY_INPUTSTREAM
NamedType UIImageData 6=BYTEARRAY_INPUTSTREAM
NamedType UIImageData 7=GENERIC_INPUTSTREAM
NamedType UIImageData 8=LINK_IMAGE

NamedType GEDraw 1=WRITE_PIXEL
NamedType GEDraw 2=DRAW_LINE
NamedType GEDraw 3=DRAW_HORIZONTALLINE
NamedType GEDraw 4=DRAW_VERTICALLINE
NamedType GEDraw 5=DRAW_RECTANGLE
NamedType GEDraw 6=FILL_RECTANGLE
NamedType GEDraw 7=UNKNOWN
NamedType GEDraw 8=DRAW_ROUNDEDRECTANGLE
NamedType GEDraw 9=FILL_ROUNDEDRECTANGLE
NamedType GEDraw 10=DRAW_CIRCLEARC
NamedType GEDraw 11=FILL_CIRCLEARC
NamedType GEDraw 12=DRAW_ELLIPSEARC
NamedType GEDraw 13=FILL_ELLIPSEARC
NamedType GEDraw 14=DRAW_ELLIPSE
NamedType GEDraw 15=FILL_ELLIPSE
NamedType GEDraw 16=DRAW_CIRCLE
NamedType GEDraw 17=FILL_CIRCLE
NamedType GEDraw 18=DRAW_ARGB
NamedType GEDraw 19=DRAW_IMAGE

NamedType GEDraw 50=DRAW_POLYGON
NamedType GEDraw 51=FILL_POLYGON
NamedType GEDraw 52=GET_IMAGEARGB
NamedType GEDraw 53=DRAW_STRING
NamedType GEDraw 54=DRAW_DEFORMED_STRING
NamedType GEDraw 55=DRAW_IMAGE_DEFORMED
NamedType GEDraw 56=DRAW_CHAR_ROTATION_BILINEAR
NamedType GEDraw 57=DRAW_CHAR_ROTATION_SIMPLE
NamedType GEDraw 58=STRING_WIDTH
NamedType GEDraw 59=GET_PIXEL

NamedType GEDraw 100=DRAW_THICKFADEDPOINT
NamedType GEDraw 101=DRAW_THICKFADEDLINE
NamedType GEDraw 102=DRAW_THICKFADEDCIRCLE
NamedType GEDraw 103=DRAW_THICKFADEDCIRCLEARC
NamedType GEDraw 104=DRAW_THICKFADEDELLIPSE
NamedType GEDraw 105=DRAW_THICKLINE
NamedType GEDraw 106=DRAW_THICKCIRCLE
NamedType GEDraw 107=DRAW_THICKELLIPSE

(continues on next page)
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(continued from previous page)

NamedType GEDraw 108=DRAW_THICKCIRCLEARC

NamedType GEDraw 200=DRAW_FLIPPEDIMAGE
NamedType GEDraw 201=DRAW_ROTATEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 202=DRAW_ROTATEDIMAGEBILINEAR
NamedType GEDraw 203=DRAW_SCALEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 204=DRAW_SCALEDIMAGEBILINEAR

#
# MicroUI
#
0 UI_EGEvent (MicroUI) Execute EventGenerator event %UIEvent (generatorID = %u,␣
→˓data = %p) | (MicroUI) EventGenerator event %UIEvent done
1 UI_DROPEvent (MicroUI) Drop event %p
2 UI_InputEvent (MicroUI) Execute native input event %UIEvent (generatorID = %u, event =
→˓%p) | (MicroUI) Native input event %UIEvent done
3 UI_DisplayEvent (MicroUI) Execute display event %UIEvent (event = %p) ␣
→˓ | (MicroUI) Display event %UIEvent done
4 UI_UserEvent (MicroUI) Execute user event %p ␣
→˓ | (MicroUI) User event %p done
5 UI_OpenImage (MicroUI) Create %UINewImage ␣
→˓ | (MicroUI) Image created; id = %p
6 UI_ImageData (MicroUI) %UINewImage ( %UIImageData ): id = %p; size = %d*%d

#
# MicroUI Graphics Engine
#
10 GE_FlushStart (MicroUI GraphicalEngine) Flush back buffer (%u,%u) (%u*%u)
11 GE_FlushDone (MicroUI GraphicalEngine) Flush done
12 GE_DrawInternal (MicroUI GraphicalEngine) Drawing operation %GEDraw |␣
→˓(MicroUI GraphicalEngine) Drawing operation %GEDraw done
13 GE_Draw (MicroUI GraphicalEngine) Drawing operation %GEDraw |␣
→˓(MicroUI GraphicalEngine) Drawing operation %GEDraw done
14 GE_Unknown (MicroUI GraphicalEngine) Unknown event
15 GE_GPUDrawDone (MicroUI GraphicalEngine) Asynchronous drawing operation done

#
# MicroUI Input Engine
#
20 IE_InvalidEvent (MicroUI Input Engine) Invalid event: %p
21 IE_QueueFull (MicroUI Input Engine) Queue full, cannot add event %p
22 IE_AddEvent (MicroUI Input Engine) Add event %p (index = %u / queue length = %u)
23 IE_ReplaceEvent (MicroUI Input Engine) Replace event %p by %p (index = %u / queue length =
→˓%u)
24 IE_ReadEvent (MicroUI Input Engine) Read event %p (index %u)

Error Messages

When an exception is thrown by the implementation of the MicroUI API, the exception MicroUIException with the
error message MicroUI:E=<messageId> is issued, where the meaning of <messageId> is defined in following
table:
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Table 21: MicroUI Error Messages
Message ID Description
1 Another EventGenerator cannot be added into the system pool (max 254).
0 [platform issue] Result of MicroUI static initialization step seems invalid. MicroUI cannot

start. Please fix MicroUI static initialization step (see Static Initialization) and rebuild the
platform.

-1 MicroUI is not started; call MicroUI.start() before using a MicroUI API.
-2 Unknown event generator class name.
-3 Deadlock. Cannot wait for an event in the same thread that runs events. Display.

waitFlushCompleted() must not be called in the MicroUI thread (for example in render
method).

-4 Resource’s pathmust be relative to the classpath (startwith ‘/’) or resource is not available.
-5 The resource data cannot be read for unknown reason.
-6 The resource has been closed and cannot be used anymore.
-7 Out of memory. Not enough memory to allocate the Image ’s bu�er. Try to close some

useless images and retry opening thenew image, or increase the sizeof theMicroUI images
heap.

-8 The platform cannot decode this kind of image, because the required runtime image de-
coder is not available in the platform.

-9 This exception is thrown when the FIFO of the internal MicroUI thread is full. In this case,
no more event (such as requestRender , input events, etc.) can be added into it.
Most of time this error occurs when:

• There is a user threadwhich performs toomany calls to themethod requestRender
without waiting for the end of the previous drawing.

• Too many input events are pushed from an input driver to the MicroUI thread (for
example some touch events).

-10 There is no display on the platform.
-11 There is no font (platform and application).
-12 The maximum number of event generators in the pool (254) has been reached.

Migration Guide

The MicroUI implementation is provided by the MicroEJ UI Pack. According the MicroEJ UI Pack used to build the
MicroEJ Platform, the application has to be updated.

• Refer to the table that illustrates the implemented MicroUI API for each MicroEJ UI Pack.

• Refer to the latest MicroUI API Changelog.

• Refer to the latest Drawing API Changelog.

The following chapters describe the changes to perform in the application according the MicroEJ UI Pack used to
build the MicroEJ Platform.

From 12.x to 13.x

• Update ej.api#microui dependency to the latest available version 3.x .

• Add ej.api#drawing dependency.
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<dependencies>
<dependency org="ej.api" name="microui" rev="3.1.0"/>
<dependency org="ej.api" name="drawing" rev="1.0.3"/>

</dependencies>

From 10.x to 12.x

• In MicroEJ application launcher > Configuration tab > MicroUI: check Use Flying Images when the
application is using the flying images (property com.microej.library.microui.flyingimage.enabled ).

• In MicroEJ application launcher, increase the Java heap: it now contains MicroUI images metadata (size,
format, clip etc.). The iceatea heap has been automatically decreased.

From 9.x to 10.x

• In MicroEJ application launcher > Configuration tab > MicroUI: set the image heap size (property
ej.microui.memory.imagesheap.size).

3.14.2 MWT (Micro Widget Toolkit)

Introduction

MWT is a toolkit that simplifies the creation and use of graphical user interface widgets on a pixel-based display.

The aim of this library is to be su�icient to create complex applications with a minimal framework. It provides the
main concepts without managing particular needs. Specific needs can be met by a MWT expert by creating new
widgets, adding more complex concepts, etc. The flexibility of the MWT open framework allows the selection of
only what is necessary for the application in order to guarantee lightweight applications and fast execution.

To use the MWT library, add the following line to amodule description file:

<dependency org="ej.library.ui" name="mwt" rev="3.2.1"/>

Concepts
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Graphical Elements

Widget

Awidget is an object that is intended to be displayed on a screen. A widget occupies a specific region of the display
and holds a state. A user may interact with a widget (using a touch screen or a button for example).

Widgets are arranged on a desktop. A widget can be part of only one desktop hierarchy, and can appear only once
on that desktop.

Container

A container follows the composite pattern: it is a widget composed of other widgets. It also defines the layout
policy of its children (defining their bounds). The children’s positions are relative to the position of their parent.
Containers can be nested to design elaborate user interfaces.

By default, the children are rendered in the order in which they have been added in the container. And thus if the
container allows overlapping, the widgets added last will be on top of the widgets added first. A container can also
modify how its children are rendered.

Desktop

A desktop is a displayable intended to be shown on a display (cf. MicroUI). At any time, only one desktop can be
displayed per display.

A desktop contains a widget (or a container). When the desktop is shown, its widget (and all its hierarchy for a
container) is drawn on the display.
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Rendering

A new rendering of a widget on the display can be requested by calling its requestRender() method. The render-
ing is done asynchronously in the MicroUI thread.

When a container is rendered, all its children are also rendered.

A widget can be transparent, meaning that it does not draw every pixel within its bounds. In this case, when this
widget is asked to be rendered, its parent is asked to be rendered in the area of thewidget (recursively if the parent
is also transparent). Usually a widget is transparent when its background (from the style) is transparent.

A widget can also be rendered directly in a specific graphics context by calling its render(GraphicsContext)
method. It can be useful to render a widget (and its children) in an image for example.

Render Policy

A render policy is a strategy that MWT uses in order to repaint the entire desktop or to repaint a specific widget.

The most naive render policy would be to render the whole hierarchy of the desktop whenever a widget has
changed. However DefaultRenderPolicy is smarter than that: it only repaints the widget, and its ances-
tors if the widget is transparent. The result is correct only if there is no overlapping widget, in which case
OverlapRenderPolicy should be used instead. This policy repaints the widget (or its non-transparent ancestor),
then it repaints all the widgets that overlap it.

When using a partial bu�er, these render policies can not be used because they render the entire screen in a single
pass. Instead, a custom render policy which renders the screen in multiple passes has to be used. Refer to the
partial bu�er demo for more information on how to implement this render policy and how to use it.

The render policy can be changed by overridding Desktop.createRenderPolicy() .

Lay Out

All widgets are laid out at once during the lay out process. This process can be started by Desktop.
requestLayOut() , Widget.requestLayOut() . The layout is also automatically donewhen the desktop is shown (
Desktop.onShown() ). This process is composedof two steps, each stepbrowses the hierarchy ofwidgets following
a depth-first algorithm:

• compute the optimal size for each widget and container (considering the constraints of the lay out),

• set position and size for each widget.

Once the position and size of a widget is set, the widget is notified by a call to onLaidOut() .

Event Dispatch

Events generated in the hardware (touch, buttons, etc.) are sent to the event dispatcher of the desktop. It is then
responsible of sending the event to one or several widgets of the hierarchy. A widget receives the event through
its handleEvent(int) method. This method returns a boolean that indicates whether or not the event has been
consumed by the widget.

Widgets are disabled by default and don’t receive the events.
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Pointer Event Dispatcher

By default, the desktop proposes an event dispatcher that handles only pointer events.

Pointer events are grouped in sessions. A session starts when the pointer is pressed, and ends when the pointer is
released or when it exits the pressed widget.

While no widget consumes the events, they are sent to the widget that is under the pointer (see Desktop.
getWidgetAt(int, int) ), then sent to all its parent hierarchy recursively.

Once a widget has consumed an event, it will be the only one to receive the next events during the session.

A widget can redefine its reactive area by subclassing the contains(int x, int y) method. It is useful when a
widget does not fill fully its bounds.

Style

A style describes how widgets must be rendered on screen. The attributes of the style are strongly inspired from
CSS.

Dimension

The dimension is used to constrain the size of the widget.

MWT provides multiple implementations of dimensions:

• NoDimension does not constrain the dimension of the widget, so the widget will take all the space granted
by its parent container.

• OptimalDimension constrains the dimension of the widget to its optimal size, which is given by the
computeContentOptimalSize() method of the widget.

• FixedDimension constrains the dimension of the widget to a fixed absolute size.

• RelativeDimension constrains the dimension of the widget to a percentage of the size of its parent con-
tainer.

Alignment

The horizontal and vertical alignments are used to position the content of the widget within its bounds.

The alignment is used by the framework to position the widget within its available space if the size of the widget
has been constrained with a Dimension .

The alignment can also be used in the renderContent() method in order to position the drawings of the widget
(such as a text or an image) within its content bounds.
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Outlines

The margin, border and padding are the 3 outlines which wrap the content of the widget. The widget is wrapped
in the following sequence: first the padding, then the border, and finally the margin.

MWT provides multiple implementations of invisible outlines which are usually used for margin and padding:

• NoOutline does not wrap the widget in an outline.

• UniformOutline wraps the widget in an outline which thickness is equal on all sides.

• FlexibleOutline wraps the widget in an outline which thickness can be configured for each side.

MWT also provides multiple implementations of visible outlines which are usually used for border:

• RectangularBorder draws a plain rectangle around the widget.

• RoundedBorder draws a plain rounded rectangle around the widget.

Background

The background is used to render the background of the widget. The background covers the border, the padding
and the content of the widget, but not its margin.

MWT provides multiple implementations of backgrounds:

• NoBackground leaves a transparent background behind the widget.

• RectangularBackground draws a plain rectangle behind the widget.

• RoundedBackground draws a plain rounded rectangle behind the widget.

• ImageBackground draws an image behinds the widget.

Color

The color is not used by the framework itself, but it may be used in the renderContent() to select the color of the
drawings.
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Font

The font is not used by framework itself, but it may be used in the renderContent() to select the font to usewhen
drawing strings.

Extra fields

Extra fields are not used by framework itself, but they may be used in the renderContent() to customize the
behavior and the appearance of the widget.

See chapter How to Define an Extra Style Field for more information on extra fields.

Stylesheet

A stylesheet allows to customize the appearance of all the widgets of a desktop without changing the code of the
widget subclasses.

MWT provides multiple implementations of stylesheets:

• VoidStylesheet assigns the same default style for every widget.

• CascadingStylesheet assigns styles to widgets using selectors, similarly to CSS.

For example, the following code customizes the style of every Label widget of the desktop:

CascadingStylesheet stylesheet = new CascadingStylesheet();

EditableStyle labelStyle = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
labelStyle.setColor(Colors.RED);
labelStyle.setBackground(new RectangularBackground(Colors.WHITE));

desktop.setStylesheet(stylesheet);

Animations

MWT provides a utility class in order to animate widgets: Animator. When a widget is being animated by an anima-
tor, the widget is notified each time that the display is flushed. The widget can use this interrupt in order to update
its state and request a new rendering.

See chapter How to Animate a Widget for more information on animating a widget.

Partial bu�er considerations

Rendering a widget in partial bu�er modemay require multiple cycles if the bu�er is not big enough to hold all the
pixels to update in a single shot. This means that rendering is slower in partial bu�er mode, and this may cause
performance being significantly a�ected during animations.

Besides, the whole screen is flushed in multiple times instead of a single one, which means that the user may see
the display at a time where every part of the display has not been flushed yet.

Due to these limitations, it is not recommended to repaint big parts of the screen at the same time. For example, a
transition on a small part of the screenwill look better than a transition a�ecting thewhole screen. A transitionwill
look perfect if the partial bu�er can hold all the lines to repaint. Since the bu�er holds a group of lines, a horizontal
transition may not look the same as a vertical transition.
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Desktop andwidget states

Desktop and widgets pass through di�erent states. Once created, they can be attached, then they can be shown.

Adesktop is attachedautomatically as soonas it is shownon thedisplay. It canalsobeattachedmanually by calling
Desktop.setAttached() . It could be used to render the desktop (and its widgets) on an image for example.

A widget is considered as attached when it is contained by a desktop that is attached.

In the sameway, by default, awidget is shownwhen its desktop is shown. But for optimizationpurpose, a container
can control when its children are shown or hidden. A typical use case is when the widgets are moved outside the
display.

Once awidget is attached, itmeans that it is ready tobe shown (for instance, thenecessary resources are allocated).
In other words, once attached a widget is ready to be rendered (on an image or on the display).

Once a widget is shown, it means that it is intended to be rendered on the display. While shown, it may start a
periodic refresh or an animation.
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The following sections will present several ways to customize and extend the framework to better fit your needs.

How to Create a Widget

A widget is the main way to render information on the display. A set of pre-defined widgets is described in the
Widgets and Examples section.

If the needed widget does not already exist, it is possible to create it from scratch (or by derivating another one).

To create a customwidget, a new class should be created, extending the Widget class. Widget subclasses have to
implement twomethods andmay override optional methods, as explained in the following sections.

Implementing themandatorymethods

Computing the optimal size of the widget

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the widget.

The optimal size of the widget is the size of the smallest possible area which would still allow to represent the
widget. Unless the widget is using an OptimalDimension in its style, the actual size of the widget will most likely
be bigger than the optimal size returned in this method.

The size parameter of the computeContentOptimalSize() method initially contains the size available for the
widget. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the widget.

When implementing thismethod, the getStyle() methodmaybecalled inorder to retrieve the styleof thewidget.

For example, the following snippet computes the optimal size of an image widget:

@Override
protected void computeContentOptimalSize(Size size) {

size.setSize(this.image.getWidth(), this.image.getHeight());
}

Rendering the content of the widget

The renderContent() method is called by the MWT framework in order to render the content of the widget.

The g parameter is used to draw the content of the widget. It is already configured with the translation
and clipping area which match the widget’s bounds. The contentWidth and contentHeight parameters
indicate the actual size of the content of the widget (excluding its outlines). Unless the widget is using an
OptimalDimension in its style, the given content size will most likely be bigger than the optimal size returned
in computeContentOptimalSize() . If the drawings do not take the complete content area, the position of the
drawings should be computed using the horizontal and vertical alignment values set in the widget’s style.

When implementing thismethod, the getStyle() methodmaybecalled inorder to retrieve the styleof thewidget.

For example, the following snippet renders the content of an image widget:

@Override
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {

Style style = getStyle();

(continues on next page)
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(continued from previous page)

int imageX = Alignment.computeLeftX(this.image.getWidth(), 0, contentWidth, style.
→˓getHorizontalAlignment());

int imageY = Alignment.computeTopY(this.image.getHeight(), 0, contentHeight, style.
→˓getVerticalAlignment());

Painter.drawImage(g, this.image, imageX, imageY);
}

Handling events

When a widget is created, it is disabled and it will not receive any event. A widget may be enabled or disabled by
calling setEnabled() . A common practice is to enable the widget in its constructor.

Enabled widgets can handle events by overriding handleEvent() . MicroUI event APIs may be used in order to
knowmore information on the event, such as its type. The handleEvent() method should return whether or not
the event was consumed by the widget.

For example, the following snippet prints a message when the widget receives an event:

@Override
public boolean handleEvent(int event) {

System.out.println("Event type: " + Event.getType(event));
return false;

}

Consuming events

To indicate that an event was consumed by a widget, handleEvent() should return true . Usually, once an event
is consumed, it is not dispatched to other widgets (this behavior is controlled by the event dispatcher). The widget
that consumed the event is the last one to receive it.

The following guidelines are recommended to decide when to consume an event and when not to consume an
event:

• If the widget triggers an action when receiving the event, it consumes the event.

• If the widget does not trigger an action when receiving the event, it does not consume the event.

Note: If theevent is Pointer.PRESSED , donot consume theeventunless it is required that the subsequentwidgets
in the hierarchy do not receive it. The Pointer.PRESSED event is special because pressing a widget is usually not
the deciding factor to trigger an action. The user has to release or to drag thewidget to trigger an action. If the user
presses a widget and then drags the pointer (e.g. their finger or a stylus) out of the widget before releasing it, the
action is not triggered.

Listening to the life-cycle hooks

Widget subclasses may override the following methods in order to allocate and free the necessary resources:

• onAttached()

• onDetached()

• onLaidOut()
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• onShown()

• onHidden()

For example, the onAttached() methodmay be overridden to load an image:

@Override
protected void onAttached() {

this.image = ResourceImage.loadImage(this.imagePath);
}

Likewise, the onDetached() methodmay be overridden to close the image:

@Override
protected void onDetached() {

this.image.close();
}

For example, the onShown() methodmay be overridden to start an animation:

@Override
protected void onShown() {

Animator animator = getDesktop().getAnimator();
animator.startAnimation(this);

}

Likewise, the onHidden() methodmay be overridden to stop an animation:

@Override
protected void onHidden() {

Animator animator = getDesktop().getAnimator();
animator.stopAnimation(this);

}

How to Create a Container

To create a custom container, a new class should be created, extending the Container class. This new class may
define a constructor and setter methods in order to provide a way for the user to configure the container, such
as its orientation. Container subclasses have to implement two methods and may override optional methods, as
explained in the following sections.

Implementing themandatorymethods

This section explains how to implement the twomandatory methods of a container subclass.

Computing the optimal size of the container

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the container. The optimal size of the container should be big enough so that each child can be laid out with a
size at least as big as its own optimal size.

The container is responsible for computing the optimal size of every child. To do so, the
computeChildOptimalSize() method should be called for every child. A�er this method is called, the opti-
mal size of the child can be retrieved by calling getWidth() and getHeight() on the child widget.
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The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
container. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the container.

For example, the following snippet computes the optimal size of a simple wrapper:

@Override
protected void computeContentOptimalSize(Size size) {

Widget child = getChild(0);
computeChildOptimalSize(child, size.getWidth(), size.getHeight());
size.setSize(child.getWidth(), child.getHeight());

}

Laying out the children of the container

The layOutChildren() method is called by the MWT framework in order to lay out every child of the container,
i.e. to set the position and size of the children. If a child is laid out outside the bounds of the container (partially or
fully), only the part of the widget which is within the container bounds will be visible.

The container is responsible for laying out each child. To do so, the layOutChild() method should be called for
every child. Before this method is called, the optimal size of the child can be retrieved by calling getWidth() and
getHeight() on the child widget.

When laying out a child, its bounds have to be passed as parameter. The position will be interpreted as relative to
the position of the container content. This means that the position should not include the outlines of the con-
tainer. This means that the (0, 0) coordinates represent the top-le� pixel of the container content and the
(contentWidth-1, contentHeight-1) coordinates represent the bottom-right pixel of the container content.

For example, the following snippet lays out the children of a simple wrapper:

@Override
protected void layOutChildren(int contentWidth, int contentHeight) {

Widget child = getChild(0);
layOutChild(child, 0, 0, contentWidth, contentHeight);

}

Managing the visibility of the children of the container

By default, when a container is shown, each of its children is shown too. This behavior can be changed by over-
riding the setShownChildren() method of Container . When implementing this method, the setShownChild()
method should be called for each child which should be shown when the container is shown.

At any time while the container is visible, children may be shown or hidden by calling setShownChild() or
setHiddenChild() .

When a container is hidden, each of its children is hidden too (unless it is already hidden). It is not necessary to
override setHiddenChildren() , except for optimization.

Providing APIs to change the children list of the container

The Container class introduces protected APIs in order tomanipulate the list of children of the container. These
methodsmay be overridden in the container subclass and set as public in order tomake these APIs available for
the user.
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Each of the following methods may be overridden individually:

• addChild()

• removeChild()

• removeAllChildren()

• insertChild()

• replaceChild()

• changeChildIndex()

For example, the following snippet allows the user to call the addChild() method on the container:

@Override
public void addChild(Widget child) {

super.addChild(child);
}

How to Animate a Widget

Starting and stopping the animation

To animate a widget, an Animator instance is required. This instance can be retrieved from the desktop of the
widget by calling Desktop.getAnimator() . Make sure that your widget subclass implements the Animation
interface so that it can be used with an Animator .

An animation can be started at any moment, provided that the widget is shown. For example, the animation can
start on a click event. Likewise, an animation can be stopped at any moment, for example a few seconds a�er the
animation has started. Once the widget is hidden, its animation should always be stopped to avoid memory leaks
and unnecessary operations.

To start the animation of thewidget, call the startAnimation() method of the Animator instance. To stop it, call
the stopAnimation() method of the same Animator instance.

For example, the following snippet starts the animation as soon as thewidget is shownand stops it once thewidget
is hidden:

public class MyAnimatedWidget extends Widget implements Animation {

private long startTime;
private long elapsedTime;

@Override
protected void onShown() {

// start animation
getDesktop().getAnimator().startAnimation(this);
// save start time
this.startTime = System.currentTimeMillis();
// set widget initial state
this.elapsedTime = 0;

}

@Override
protected void onHidden() {

// stop animation
getDesktop().getAnimator().stopAnimation(this);

(continues on next page)
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}
}

Performing an animation step

The tick() method is called by the animator in order to update the widget. It is called in the UI thread once the
display has been flushed. Thismethod should not render thewidget but should update its state and request a new
render if necessary. The tick() method should return whether or not the animation should continue a�er this
increment.

For example, the following snippet updates the state of the widget when it is ticked, requests a new render and
keeps the animation going until 5 seconds have passed:

@Override
public boolean tick(long currentTimeMillis) {

// update widget state
this.elapsedTime = currentTimeMillis - this.startTime;
// request new render
requestRender();
// return whether to continue or to stop the animation
return (this.elapsedTime < 5_000);

}

The renderContent() method should render the widget by using its current state (saved in the fields of the wid-
get). This method should not call methods such as System.currentTimeMillis() because the widget could be
rendered in multiple passes, for example if a partial bu�er is used.

For example, the following snippet renders the current state of the widget by displaying the time elapsed since the
start of the animation:

@Override
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {

Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, Long.toString(this.elapsedTime), style.getFont(), 0, 0);

}

How to Define an Outline or Border

To create a custom outline or border, a new class should be created, extending the Outline class. Outline sub-
classes have to implement twomethods, as explained in the following sections.

Applying the outline on an outlineable object

The apply(Outlineable) method is called by the MWT framework in order to subtract the outline from a Size
or Rectangle object.

The Outlineable parameter of the method initially contains the size or bounds of the box, including the outline.
Before themethod returns, theoutlineableobject shouldbemodifiedbysubtracting theoutline. Inorder to remove
the outline from the object, the removeOutline() method of Outlineable should be used, passing as argument
the thickness on each side.

For example, the following snippet applies an outline of 1 pixel on every side:
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@Override
public void apply(Outlineable outlineable) {

outlineable.removeOutline(1, 1, 1, 1);
}

Applying the outline on a graphics context

The apply(GraphicsContext, Size) method is called by theMWT framework in order to render the outline (only
relevant if it is a border) and to update the translation and clip of a graphics context.

The Size parameter of the method initially contains the size of the box, including the outline. Before the method
returns, the size object should be modified by subtracting the outline. In order to remove the outline from the
object, the removeOutline() method of Outlineable should be used, passing as argument the thickness on
each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@Override
public void apply(GraphicsContext g, Size size) {

size.removeOutline(1, 1, 1, 1);
g.translate(1, 1);
g.setClip(0, 0, size.getWidth(), size.getHeight());

}

How to Define a Background

To create a custom background, a new class should be created, extending the Background class. Background
subclasses have to implement twomethods, as explained in the following sections.

Informing whether the background is transparent

The isTransparent() method is called by theMWT framework in order to knowwhether or not the background is
transparent. A background is considered as transparent if it does not draw every pixel with maximal opacity when
it is applied.

For example, the following snippet informs that the background is completely opaque regardless of its size:

@Override
public boolean isTransparent(int width, int height) {

return false;
}

Applying the background on a graphics context

The apply(GraphicsContext g, Size size) method is called by the MWT framework in order to render the
background and to set or remove the background color of subsequent drawings.

For example, the following snippet applies a white background:
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@Override
public void apply(GraphicsContext g, Size size) {

g.setColor(Colors.WHITE);
Painter.fillRectangle(g, 0, 0, size.getWidth(), size.getHeight());
g.setBackgroundColor(Colors.WHITE);

}

How to Create a Desktop Event Dispatcher

Creating a custom event dispatcher can help you address two use cases:

• [Dispatch] Extending an EventDispatcher is used to dispatch the events. For example, the FocusEventDis-
patcher will send the events to the widget owning the focus.

• [Handle] Overriding the desktop is used to directly trigger a behavior. For example “BACK” command shows
the previous page.

To create a custom event dispatcher, a new class should be created, extending the EventDispatcher class. Event
dispatcher subclasses have to implement a method and may override optional methods, as explained in the fol-
lowing sections.

Dispatching the events to the widgets

The dispatchEvent() method is called by theMWT framework in order to dispatch aMicroUI event to thewidgets
of the desktop. The getDesktop() method may be called in order to retrieve the desktop with which the event
dispatcher is associated. This is useful in order to browse thewidget hierarchy of the desktop, for example by using
the getWidget() and getWidgetAt() methods of Desktop .

In order to send an event to one of the widgets of the hierarchy, the sendEventToWidget() method should be
used. The dispatchEvent() method should return whether or not the event was dispatched and consumed by a
widget.

For example, the following snippet dispatches every event to the widget of the desktop:

@Override
public boolean dispatchEvent(int event) {

Widget desktopWidget = getDesktop().getWidget();
if (desktopWidget != null) {

return sendEventToWidget(desktopWidget, event);
} else {

return false;
}

}

In addition todispatching theprovided events, an event dispatchermaygenerate customevents. Thismaybedone
by using a DesktopEventGenerator . Its buildEvent() method allows to build an event which may be sent to a
widget using the sendEventToWidget() method.

Initializing and disposing the dispatcher

EventDispatcher subclasses may override the initialize() and dispose() methods in order to allocate and
free the necessary resources.

For example, the initialize() methodmaybeoverridden tocreateanevent generator and toadd it to the system
pool of MicroUI:
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@Override
public void initialize() {

this.eventGenerator = new DesktopEventGenerator();
this.eventGenerator.addToSystemPool();

}

Likewise, the dispose() method may be overridden to remove the event generator from the system pool of Mi-
croUI:

@Override
public void dispose() {

this.eventGenerator.removeFromSystemPool();
}

How to Define an Extra Style Field

Extra style fields allow to customize a widget by configuring graphical elements of the widget from the stylesheet.
Extra fields are only relevant to a specific widget type and its subtypes. A widget type can support up to 7 extra
fields. The value of an extra fieldmay be represented as an int , a float or any object, and it can not be inherited
from parent widgets.

Defining an extra field ID

The recommended practice is to add a public constant for the ID of the new extra field in the widget subtype. This
ID should be an integer with a value between 0 and 6 .

Every extra field ID has to be unique within the widget type. However, two unrelated widget types may define an
extra field with the same ID.

For example, the following snippet defines an extra field for a secondary color:

public static final int SECONDARY_COLOR_FIELD = 0;

Setting an extra field in the stylesheet

The value of an extra field may be set in the stylesheet in a similar fashion to built-in style fields, using one of the
setExtraXXX() methods of EditableStyle .

For example, the following snippet sets the value of an extra field for all the instances of a widget subtype:

EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(MyWidget.class));
style.setExtraInt(MyWidget.SECONDARY_COLOR_FIELD, Colors.RED);

Getting an extra field during rendering

The value of an extra field may be retrieved from the style of a widget in a similar fashion to built-in style fields,
using one of the getExtraXXX() methods of Style . When calling one of thesemethods, a default value has to be
given in case the extra field is not set for this widget.

For example, the following snippet gets the value of an extra field of the widget:
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Style style = getStyle();
int secondaryColor = style.getExtraInt(SECONDARY_COLOR_FIELD, Colors.BLACK);

How to Use the Overlap Render Policy

The MWT library implements two render policies: the DefaultRenderPolicy and the OverlapRenderPolicy :

• DefaultRenderPolicy : renders the specified widget. If the widget is transparent, it renders its parent (and
recursively).

• OverlapRenderPolicy : renders the specified widget but also the other widgets that overlap with it.

While the DefaultRenderPolicy will be fine for most GUIs, it will not handle properly the case where widgets
overlap. In this case, the OverlapRenderPolicy will be the best match.

Making Widgets Overlap

A widget is said to overlap with another when:

• their boundaries intersect

• it comes a�er in the widget tree (depth-first search)

The following snippet displays two widgets that overlap:

public static void main(String[] args) {
MicroUI.start();

Desktop desktop = new Desktop();

// make two widgets overlap in a Canvas container
Canvas rootWidget = new Canvas();
final Button overlapped = new Button("Overlapped widget");
rootWidget.addChild(overlapped, 50, 50, 200, 200);
final Label overlapping = new Label("Overlapping widget");
rootWidget.addChild(overlapping, 125, 75, 100, 50);
desktop.setWidget(rootWidget);

// the overlapping widget is silver
CascadingStylesheet stylesheet = new CascadingStylesheet();
EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
style.setBackground(new RectangularBackground(Colors.SILVER));

// the overlapped widget is orange
style = stylesheet.getSelectorStyle(new TypeSelector(Button.class));
style.setBackground(new RectangularBackground(0xee502e));
desktop.setStylesheet(stylesheet);

desktop.requestShow();
}

As expected from the addChild() sequence, the widget overlapping overlaps the widget overlapped :
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So far, the DefaultRenderPolicy is being used and it seems to look fine: the widgets of the desktop are rendered
successively in depth-first order a�er the call to desktop.requestShow() .

Requesting a New Render

Let’s see how the DefaultRenderPolicy performs when the widget overlapped is requested to render again.
In most cases, a widget is requested to render when its content has been updated (e.g. the value displayed has
changed). For demonstration purposes, let’s introduce a mean to trigger a new render: each time the user clicks
on the widget overlapped , it will request the widget to render.

The snippet above shows how to do that, by adding an OnClickListener to the overlapped widget:

overlapped.setOnClickListener(new OnClickListener() {

@Override
public void onClick() {

overlapped.requestRender();
}

});

When the user clicks on the widget overlapped , the widget is rendered again but not the widget overlapping .
As a consequence, the widget that overlaps is not displayed anymore:

When using the DefaultRenderPolicy , widgets are rendered regardless of their order in the widget hierarchy.
However, the OverlapRenderPolicy will take account of the relative order of the other widgets: widgets that
come a�er in the widget tree will be rendered if their boundaries intersect those of the widget.

Using the OverlapRenderPolicy

Overriding themethod createRenderPolicy() of the Desktop , as follows, will cause the OverlapRenderPolicy
to be used when rendering widgets:

Desktop desktop = new Desktop() {
@Override
protected RenderPolicy createRenderPolicy() {

(continues on next page)
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return new OverlapRenderPolicy(this);
}

};

Now, both widgets will be displayed correctly when they are requested to render.

As a conclusion, favor the OverlapRenderPolicy when a GUI uses overlapping elements. Note that this render
policy is slightly more time-consuming because it traverses the widget tree to determine which widgets are over-
lapping with each other.

3.14.3 Widgets and Examples

Widget library

The widget library provides very common widgets with basic implementations. These simple widgets may not
provide every desired feature, but they can easily be forked since their implementation is very simple.

Thewidget library does not provide any example. However, thewidget demoprovides examples for thesewidgets.

Source

To use the widgets provided by the widget library, add the following line to amodule description file:

<dependency org="ej.library.ui" name="widget" rev="4.0.0"/>

To fork one of the providedwidgets, duplicate the associated Java class from thewidget library JAR into the source
code of your application. It is recommended to move the duplicated class to an other package and to rename the
class in order to avoid confusion between your forked class and the original class.

Provided widgets

Widgets:

• Label : displays a text.

• ImageWidget : displays an image which is loaded from a resource.

• Button : displays a text and reacts to click events.

• ImageButton : displays an image which is loaded from a resource and reacts to click events.

Containers:

• List : lays out any number of children horizontally or vertically.

• Flow : lays out any number of children horizontally or vertically, using multiple rows if necessary.

• Grid : lays out any number of children in a grid.

• Dock : lays out any number of children by docking each child one by one on a side.

• SimpleDock : lays out three children horizontally or vertically.

• OverlapContainer : lays out any number of children by stacking them.

• Canvas : lays out any number of children freely.
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Widget demo

The widget demo provides some widget implementations as well as usage examples for these widgets and for the
widgets of the Widget library. The widgets and usage examples are intended to be duplicated by the developers in
order to be adapted to their use-case.

Source

To use the widgets provided by the widget demo, clone the following GitHub repository: https://github.com/
MicroEJ/Demo-Widget. You can then import the com.microej.demo.widget project into your workspace to see
the source of the widgets and their associated examples.

Each subpackage contains the source code for a specificwidget and for a pagewhich showcases thewidget. For ex-
ample, the com.microej.demo.widget.checkbox package contains the Checkbox widget and the CheckboxPage
.

Provided widgets

Widgets:

• Checkbox : displays a text and a square which can be checked or unchecked.

• RadioButton : displays a text and a circle which can be checked or unchecked.

• ProgressBar : displays an animated bar indicating that the user should wait for an estimated amount of
time.

• IndeterminateProgressBar : displays an animated bar indicating that the user should wait for an indeter-
minate amount of time.

• Toggle : displays a text and a switch that can be checked or unchecked.

Containers:

• Split : lays out two children horizontally or vertically, by giving each child a portion of the available space.

• ScrollableList : lays out its widgets the same way as a regular list, but provides an optimization when
added to a scroll.

MWT examples

The MWT Examples repository provides various examples which extend or customize the MWT framework.

Source

To run the examples and read the source code of these examples, clone the following GitHub repository: https:
//github.com/MicroEJ/ExampleJava-MWT. You can then import the multiple project into your workspace to see
the source of each example and to run it on Simulator or on your board.

Provided examples

• com.microej.example.mwt.attribute : shows how to customize the style ofwidgets using attributes selec-
tors, similar to CSS.

3.14. Graphical User Interface 250

https://github.com/MicroEJ/Demo-Widget
https://github.com/MicroEJ/Demo-Widget
https://github.com/MicroEJ/ExampleJava-MWT
https://github.com/MicroEJ/ExampleJava-MWT


MicroEJ Documentation, Revision 2788b3f4

• com.microej.example.mwt.focus : shows how to introduce focus management in your project.

• com.microej.example.mwt.lazystylesheet : shows how to use a lazy stylesheet rather than the default
stylesheet implementation.

• com.microej.example.mwt.mvc : shows how to develop responsivewidgets using aMVC design pattern and
how to display a cursor image representing the pointer.

3.14.4 Advanced

How to Detect Text Overflow

Widgets that display a textmay experience text overflowwhen the strings are too long to fit into the available area.
It can be the case, for example, in applications that support multiple languages because widgets have to deal with
texts of di�erent lengths.

Instrumenting the Widget

The goal is to check whether the text to be displayed is within the content bounds of the widget. A way to test this
is to extend or modify the widget. In this article, the widget MyLabel will extend the type Label from the Widget
library, which displays a text:

import ej.widget.basic.Label;

public class MyLabel extends Label {

public MyLabel(String text) {
super(text);

}
}

Overriding the onLaidOut() Method

Once the position and size of a wigdet are set during the lay out process, the onLaidOut() method is called to
notify the widget. Overriding onLaidOut() of class MyLabel is a good place to check whether the text overflows
or not.

For example, the following snippet compares the text width with the available width: it will print a message if an
overflow is detected.

@Override
protected void onLaidOut() {

super.onLaidOut();

// compute the width of the text with the specified font
final Font font = getStyle().getFont();
final String text = getText();
final int textWidth = font.stringWidth(text);

// compare to the width available for the content of the widget
final int contentWidth = getContentBounds().getWidth();
if (textWidth > contentWidth) {

System.out.println("Overflow detected:\n > Text: \"" + text + "\"\n > Width = " + textWidth + "␣
→˓px (available: " + contentWidth + " px)");

(continues on next page)
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}
}

Testing

Here is a case where the widget size is set manually to be a little shorter than the text width:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Canvas canvas = new Canvas();
// add a label with an arbitrary fixed width of 25 pixels (which is too short)
canvas.addChild(new MyLabel("Some text"), 20, 20, 25, 10);
desktop.setWidget(canvas);
desktop.requestShow();

}

The text is cropped and the console logs that a text overflow has been detected:

=============== [ Initialization Stage ] ===============
=============== [ Converting fonts ] ===============
=============== [ Converting images ] ===============
=============== [ Launching on Simulator ] ===============
Overflow detected:
> Text: "Some text"
> Width = 47 px (available: 25 px)

Improving the Detection

To ease the correction process, it is best to add some additional debug information to locate the issue. Let’s extract
the text overflow detection into a helper class, so that it is available for all classes across the application.

The following snippet:

• extracts the text overflow detection into the class MyTextHelper .

• prints the part of the text that is displayed.

• prints the path to the widget in the widget tree to help the tester locate the a�ected widget in the GUI.

public class MyLabel extends Label {

public MyLabel(String text) {
super(text);

(continues on next page)
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}

@Override
protected void onLaidOut() {

super.onLaidOut();

final Font font = getStyle().getFont();
final String text = getText();
MyTextHelper.checkTextOverflow(this, text, font);

}
}

public class MyTextHelper {

/**
* Checks whether the given text overflows for the specified widget and font. In the case where an␣

→˓overflow is
* detected, the method prints a message that details the error.
*
* @param widget
* the widget that displays the text.
* @param text
* the text to display.
* @param font
* the font used for drawing the text.
*/
public static void checkTextOverflow(final Widget widget, final String text, final Font font) {

final int textWidth = font.stringWidth(text);
final int contentWidth = widget.getContentBounds().getWidth();

if (textWidth > contentWidth) {
String displayedText = buildDisplayedText(text, font, contentWidth);
String widgetPath = buildWidgetPath(widget);
System.out.println(

"Overflow detected:\n > Text: \"" + text + "\"\n > Width = " + textWidth + " px␣
→˓(available: "

+ contentWidth + " px) \n > Displayed: \"" + displayedText + "\"\n > Path :
→˓" + widgetPath);

}
}

private static String buildDisplayedText(String text, Font font, int width) {
for (int i = text.length() - 1; i > 0; i--) {

if (font.substringWidth(text, 0, i) <= width) {
return text.substring(0, i);

}
}

return "";
}

private static String buildWidgetPath(Widget widget) {
StringBuilder builder = new StringBuilder();

Widget ancestor = widget;
do {

(continues on next page)
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builder.insert(0, " > " + ancestor.getClass().getSimpleName());
ancestor = ancestor.getParent();

} while (ancestor != null);
builder.insert(0, widget.getDesktop().getClass().getSimpleName());

return builder.toString();
}

}

When the application is launched again, the console showsmore information about the text overflow:

=============== [ Initialization Stage ] ===============
=============== [ Converting fonts ] ===============
=============== [ Converting images ] ===============
=============== [ Launching on Simulator ] ===============
Overflow detected:
> Text: "Some text"
> Width = 47 px (available: 25 px)
> Displayed: "Some"
> Path : Desktop > Canvas > MyLabel

To keep control over the extra verbosity and code size, one option is to use BON constants to enable/disable this
debug code at will. In the following snippet, when the constant com.mycompany.check.text.overflow is set to
false , the debug code will not be embedded in the application.

public static void checkTextOverflow(final Widget widget, final String text, final Font font) {
if (Constants.getBoolean("com.mycompany.check.text.overflow")) {

final int textWidth = font.stringWidth(text);
final int contentWidth = widget.getContentBounds().getWidth();

if (textWidth > contentWidth) {
String displayedText = buildDisplayedText(text, font, contentWidth);
String widgetPath = buildWidgetPath(widget);
System.out.println(

"Overflow detected:\n > Text: \"" + text + "\"\n > Width = " + textWidth + " px␣
→˓(available: "

+ contentWidth + " px) \n > Displayed: \"" + displayedText + "\"\n > Path :
→˓" + widgetPath);

}
}

}

3.15 JavaScript

MicroEJ allows to develop parts of an application in JavaScript. Basically, aMicroEJ Application boots in Java, then
it initializes the JavaScript runtime to run amix of Java and JavaScript code.
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Fig. 71: MicroEJ JavaScript Overview

It supports the ECMAScript 5.1 specification, with some limitations. You can start playing with it by following the
Getting Started page.

3.15.1 Getting Started

Note: The JavaScript runtime is currently in preview and is available as a demonstration bundle on demand.
Please contact our support team.

Before going further with this getting started, follow the steps described in the README.rst of the demonstration
bundle.

Let’s walk through the steps required to use Javascript in your MicroEJ application:

• install theMMM CLI (Command Line Interface)

• create your Standalone Application project with the init command:

mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=firmware-singleapp -Dskeleton.
→˓rev=1.1.12 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0 -Dskeleton.
→˓target.dir=myproject

Adapt the properties values to your need. See theMMM CLI init command documentation for more details.

Javascript is supported in the following Module Natures page: - Add-On Library, - Standalone Application, - Sand-
boxed Application.
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• add the js dependency in the module.ivy file:

<dependency org="com.microej.library.runtime" name="js" rev="0.10.0"/>

• add the following lines in your application main class:

import com.microej.js.JsErrorWrapper;
import com.microej.js.JsCode;
import com.microej.js.JsRuntime;

...

JsCode.initJs();
JsRuntime.ENGINE.runOneJob();
JsRuntime.stop();

• create a file named hello.js in the folder src/main/js with the following content:

function hello() {
var message = "MicroEJ Javascript application!";
print("My first", message);

}

hello()

• follow the steps described in the run command documentation

• in a terminal, go to the folder containing the module.ivy file and build the project with the command:

mmm build

You should see the following message at the end of the build:

BUILD SUCCESSFUL

Total time: 20 seconds

• now that your application is built, you can run it in the simulator with the command:

mmm run

You should see the following output:

My first MicroEJ Javascript application!

You cannowgo further by exploring the capabilities of theMicroEJ Javascript engineanddiscovering the commands
available in the CLI.

3.15.2 Sources Management

JavaScript Sources Location

The JavaScript sources of an application must be located in the project folder src/main/js . All JavaScript files (
*.js ) found in this folder, at any level, are processed.
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JavaScript Sources Load Order

When several JavaScript files are found in the sources folder, they are loaded in alphabetical order of their relative
path. For example, the following source files:

src
main

js
components

component1.js
component2.js

ui
widgets.js

app.js
feature1.js
feature2.js

are loaded in this order:

1. app.js

2. components/component1.js

3. components/component2.js

4. feature1.js

5. feature2.js

6. ui/widgets.js

JavaScript Sources Load Scope

All the code of the JavaScript source files are loaded in the same scope. It means a variable or function defined in
a source file can be used in another one if it has been loaded first. In this example:

Listing 10: src/main/js/lib.js

function sum(a, b) {
return a + b;

}

Listing 11: src/main/js/main.js

print("5 + 3 = " + sum(5, 3));

the file src/main/js/lib.js is loaded before src/main/js/main.js so the function sum can be used in src/
main/js/main.js .

JavaScript Sources Processing

JavaScript sources need to be processed before being executed. This processing is done in the following cases:

• when building the project withMMM.

• when developing the project in MicroEJ SDK. The MicroEJ SDK detects any change in JavaScript sources
folder (addition/update/deletion) to trigger the processing.
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3.15.3 Examples

This section is intended to provide a set of examples to cover most of the use cases when developing JavaScript
applications with MicroEJ:

Simple Application

Note: Before trying this example, make sure you have theMMM CLI (Command Line Interface) installed.

This example shows the minimal code for a MicroEJ JavaScript application:

• create an Add-On Library project or a Sandboxed Application project

• add the MicroEJ JavaScript dependency in the module.ivy file of your project:

<dependency org="com.microej.library.runtime" name="js" rev="0.10.0"/>

• init the JavaScript code in your Java application with:

import com.microej.js.JsCode;

...

JsCode.init();

The class com.microej.js.JsCode is the Java class generated from the JavaScript sources.

• ask the MicroEJ JavaScript engine to start processing the job queue with:

import com.microej.js.JsRuntime;

...

JsRuntime.ENGINE.run();

This makes the JavaScript engine process the job queue forever until the program is stopped.

• create a file with the js extension in the src/main/js folder (for example app.js ) with the following
content:

print("My Simple Application");

• build and execute the application with theMMM CLI:

$ mmm build
$ mmm run

Themessage My Simple Application should be displayed.

Use a Java API in JavaScript

Note: Before trying this example, make sure you have theMMM CLI (Command Line Interface) installed.

It is also recommended to follow the Getting Started page and/or the Simple Application example before.
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In this example the JavaScript code calls a Java API. The Java API can come from the application or fromany library
usedby the application. Let’s create it in the project for this example, in a class Calculator ( src/main/java/com/
mycompany/Calculator.java ):

public class Calculator {
public int sum(int x, int y) {

return x + y;
}

public int mul(int x, int y) {
return x * y;

}
}

Then in the Java Main class of the application, add the glue to expose the Calculator Java API to the JavaScript
code and init the JavaScript engine:

public static void main(String[] args) throws Exception {
// Add the "getCalculator" function in the JavaScript global object
JsRuntime.JS_GLOBAL_OBJECT.put("getCalculator", JsRuntime.createFunction(new JsClosure() {

@Override
@Nullable
public Object invoke(Object thisBinding, int argsLength, Object... arguments) {

return new Calculator();
}

}), false);

// Init the JavaScript code
JsCode.initJs();
// Start the JavaScript engine
JsRuntime.ENGINE.run();

}

You can now call the API from the JavaScript code:

var calc = getCalculator();
print(calc.sum(1, 2));
print(calc.mul(5, 3));

As you can see, the methods of the Java API Calculator can be used directly from the JavaScript code.

Finally, build and execute the application with theMMM CLI:

$ mmm build
$ mmm run

The sum andmultiply results should be displayed.

For more information about communication between Java and JavaScript please refer to the Communication Be-
tween Java and JS page.

Create a JavaScript API from Java

Note: Before trying this example, make sure you have theMMM CLI (Command Line Interface) installed.

It is also recommended to follow the Getting Started page and/or the Simple Application example before.
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In this example a JavaScript API is exposed from Java. This can be useful when a specific API must be defined in
JavaScript or when adapting an existing Java API to a JavaScript API.

Create a class MyApiHostObject ( src/main/java/com/mycompany/MyApiHostObject.java ):

public class MyApiHostObject extends JsObject {

public MyApiHostObject(Object thisBinding) {

this.put("count", new DataPropertyDescriptor(JsRuntime.createFunction(new JsClosure() {
@Override
@Nullable
public Object invoke(@Nullable Object thisBinding, int argsLength, Object...␣

→˓arguments) {
String data = (String) arguments[0];
return Integer.valueOf(data.length());

}
})));

}
}

This class defines a JavaScript object using the MicroEJ JavaScript API by extending the class JsObject . It also
defines a count method which accepts a String parameter and returns its length.

Then in the Java Main class of the application, add the glue to expose theMyApi object to the JavaScript code and
init the JavaScript engine:

public static void main(String[] args) throws Exception {
// Add the "MyApi" function in the JavaScript global object
JsRuntime.JS_GLOBAL_OBJECT.put("MyApi", JsRuntime.createFunction(new JsClosure() {

@Override
@Nullable
public Object invoke(Object thisBinding, int argsLength, Object... arguments) {

return new MyApiHostObject(thisBinding);
}

}), false);

// Init the JavaScript code
JsCode.initJs();
// Start the JavaScript engine
JsRuntime.ENGINE.run();

}

You can now call the new API from the JavaScript code:

var myApi = new MyApi();
print(myApi.count("Hello World!"));

Finally, build and execute the application with theMMM CLI:

$ mmm build
$ mmm run

The length of the string Hello World! (12) should be displayed.

For more information about communication between Java and JavaScript please refer to the Communication Be-
tween Java and JS page.
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3.15.4 API

This page lists the API provided by the MicroEJ JavaScript engine.

Built-in Objects

The built-in objects are the API objects defined by the ECMAScript specification. This section lists all the JavaScript
built-in objects and their support status in the MicroEJ JavaScript engine. For the complete reference about these
built-in objects, consult the ECMAScript 5.1 specification.

For a description and usage examples of each method or property, consult a JavaScript documentation such as
Mozilla Developer Reference.

Array

• Array (len)

• isArray ( arg )

• toString ( )

• [excluded] toLocaleString ( )

• concat ( [ item1 [ , item2 [ , . . . ] ] ] )

• join (separator)

• pop ( )

• push ( [ item1 [ , item2 [ , . . . ] ] ] )

• reverse ( )

• shi� ( )

• slice (start, end)

• sort (comparefn)

• [excluded] splice (start, deleteCount [ , item1 [ , item2 [ , . . . ] ] ] )

• unshi� ( [ item1 [ , item2 [ , . . . ] ] ] )

• indexOf ( searchElement [ , fromIndex ] )

• lastIndexOf ( searchElement [ , fromIndex ] )

• every ( callbackfn [ , thisArg ] )

• some ( callbackfn [ , thisArg ] )

• forEach ( callbackfn [ , thisArg ] )

• map ( callbackfn [ , thisArg ] )

• filter ( callbackfn [ , thisArg ] )

• [excluded] reduce ( callbackfn [ , initialValue ] )

• [excluded] reduceRight ( callbackfn [ , initialValue ] )

• length
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Boolean

• Boolean (value)

• Boolean.prototype.toString ( )

• Boolean.prototype.valueOf ( )

Date

• [excluded]

Error

• [excluded]

Function

• [excluded] Function (p1, p2, . . . , pn, body)

• length

• [excluded] toString ( )

• apply (thisArg, argArray)

• call (thisArg [ , arg1 [ , arg2, . . . ] ] )

• [excluded] bind (thisArg [, arg1 [, arg2, . . . ]])

• [[Call]]

• [[Construct]]

Global

• NaN

• Infinity

• undefined

• [excluded] eval ( x )

• parseInt (string , radix)

• parseFloat (string)

• isNaN (number)

• isFinite (number)

• [excluded] escape (string)

• [excluded] unescape (string)

• [excluded] decodeURI (encodedURI)

• [excluded] decodeURIComponent (encodedURIComponent)

3.15. JavaScript 262



MicroEJ Documentation, Revision 2788b3f4

• [excluded] encodeURI (uri)

• [excluded] encodeURIComponent (uriComponent)

JSON

• parse ( text [ , reviver ] )

• stringify ( value , [ replacer [ , space ] ] )

Math

• E

• LN10

• LN2

• LOG2E

• LOG10E

• PI

• SQRT1_2

• SQRT2

• abs (x)

• acos (x)

• asin (x)

• atan (x)

• atan2 (y, x)

• ceil (x)

• cos (x)

• exp (x)

• floor (x)

• log (x)

• max ( [ value1 [ , value2 [ , . . . ] ] ] )

• min ( [ value1 [ , value2 [ , . . . ] ] ] )

• pow (x, y)

• random ( )

• round (x)

• sin (x)

• sqrt (x)

• tan (x)
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Number

• Number (value)

• MAX_VALUE

• MIN_VALUE

• NaN

• NEGATIVE_INFINITY

• POSITIVE_INFINITY

• [excluded] toString ( [ radix ] )

• [excluded] toLocaleString()

• valueOf ( )

• [excluded] toFixed (fractionDigits)

• [excluded] toExponential (fractionDigits)

• [excluded] toPrecision (precision)

Object

• Object ( [ value ] )

• Object.getPrototypeOf ( O )

• Object.getOwnPropertyDescriptor ( O, P )

• Object.getOwnPropertyNames ( O )

• Object.create ( O [, Properties] )

• Object.defineProperty ( O, P, Attributes )

• Object.defineProperties ( O, Properties )

• [excluded] Object.seal ( O )

• [excluded] Object.freeze ( O )

• [excluded] Object.preventExtensions ( O )

• Object.isSealed ( O )

• Object.isFrozen ( O )

• Object.isExtensible ( O )

• Object.keys ( O )

• toString ( )

• [excluded] toLocaleString ( )

• valueOf ( )

• hasOwnProperty (V)

• isPrototypeOf (V)

• propertyIsEnumerable (V)
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Regex

• RegExp (pattern, flags)

• exec (string)

• test (string)

• toString ()

String

• String (value)

• fromCharCode ( [ char0 [ , char1 [ , . . . ] ] ] )

• toString ( )

• valueOf ( )

• charAt (pos)

• charCodeAt (pos)

• concat ( [ string1 [ , string2 [ , . . . ] ] ] )

• indexOf (searchString, position)

• lastIndexOf (searchString, position)

• [excluded] localeCompare (that)

• match (regexp)

• replace (searchValue, replaceValue)

• [excluded] search (regexp)

• slice (start, end)

• split (separator, limit)

• [excluded] substr (start [ , length ] )

• substring (start, end)

• toLowerCase ( )

• [excluded] toLocaleLowerCase ( )

• toUpperCase ( )

• [excluded] toLocaleUpperCase ( )

• trim ( )

• length

• [[GetOwnProperty]] ( P )

Host Objects

Host objects are not part of the ECMAScript specification, they are additional API provided by the MicroEJ
JavaScript engine.
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Global

setTimeout(function[, delay, arg1, arg2, . . . ])

• description: sets a timer which executes a function once the timer expires.

• arguments:

– function : the function to execute when the delay expires.

– delay (optional): the time inmilliseconds that the timermustwait before executing the given function.

– arg1, arg2, ... (optional): additional arguments passed to the given function.

• returns: the timer object. This object can be passed to the function clearTimeout to cancel the timer.

setInterval(function[, delay, arg1, arg2, . . . ])

• description: repeatedly calls a function, with a fixed time delay between each call.

• arguments:

– function : the function to execute when the delay expires.

– delay (optional): the time inmilliseconds that the timermustwait betweeneach executionof the given
function.

– arg1, arg2, ... (optional): additional arguments passed to the given function.

• returns: the timer object. This object can be passed to the function clearInterval to cancel the timer.

clearTimeout(timer)

• description: cancels the given timer created by a call to setTimeout .

• arguments:

– timer : the timer to cancel.

clearInterval(timer)

• description: cancels the given timer created by a call to setInterval .

• arguments:

– timer : the timer to cancel.

print([arg1, arg2, . . . ])

• description: prints the given arguments in the standard output. The arguments are concatenated and sep-
arated by a space. A new line is added at the end.

• arguments:

– arg1, arg2, ... : the list of elements to print.
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3.15.5 Communication Between Java and JS

The MicroEJ engine allows to communicate between Java and JavaScript: Java API can be used from JavaScript
code and vice-versa.

JavaScript Engine

The JavaScript code is executed in a single-threaded engine, which means only one JavaScript statement is exe-
cuted at a given time. Each piece of JavaScript code that must be executed is pushed in a job queue. It is up to the
engine to manage the job queue and execute the jobs.

One consequence of this design is that Java code called from a JavaScript codemust not be blocker. When calling
a Java API from a Javascript code, in order to avoid blocking the JavaScript engine, the Java code must return as
quick as possible. Otherwise the JavaScript engine is stuck and cannot execute other JavaScript jobs. It is espe-
cially harmfull when the Java operation takes time, for example for network or IO operations. In such a case, it is
therefore recommended to execute it in a new thread and return immediately.

Another consequence of the JavaScript engine design is that JavaScript code must always be executed by the en-
gine, by the single thread. Therefore, any call to a JavaScript code from a Java codemust create a job and add it to
the job queue.

Calling Java from JavaScript

The MicroEJ engine allows to expose Java objects or methods to the JavaScript code by using the engine API and
creating the adequate JavaScript object.

For example, here is the code to create a JavaScript function named javaPrint in the global scope:

JsRuntime.JS_GLOBAL_OBJECT.put("javaPrint", JsRuntime.createFunction(new JsClosure() {
@Override
public Object invoke(Object thisBinding, Object... arguments) {

System.out.println("Print from Java: " + arguments[0]);
return null;

}
}), false);

The function is created with a com.microej.js.objects.JsObjectFunction object created with the API
JsRuntime.createFunction(JsClosure jsClosure) , and injected in the object JsRuntime.JS_GLOBAL_OBJECT
which maps to the JavaScript global scope.

The function javaPrint can then be used in JS:

javaPrint("foo")

This technique can also be used to share any Java object to JavaScript. It is achieved by returning the Java object
in the invokemethod of the JsClosure object. For example, a Java Date object can be exposed as follows:

JsRuntime.JS_GLOBAL_OBJECT.put("getCurrentDate", JsRuntime.createFunction(new JsClosure() {
@Override
public Object invoke(Object thisBinding, Object... arguments) {

return Calendar.getInstance().getTime();
}

}), false);

When a Java object is exposed in JavaScript, all its publicmethods can be called, therefore the JavaScript code can
then use this Date object and get the time:
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var date = getCurrentDate()
var time = date.getTime()
print("Current time: ", time)

for more information on how these called aremanaged by the MicroEJ JavaScript engine, please go to the Foreign
Function Interface section.

Java objects can also be shared using one of the other Java JS adapter objects. With this solution, the code of the
Java object is executed at engine initialisation, contrary to the previous solutionwhere it is executed onlywhen the
JavaScript code is called. For example, here is the code to expose a Java string named javaString in the JavaScript
global scope:

JsRuntime.JS_GLOBAL_OBJECT.put("javaString", "Hello World!", false);

The string javaString can then be used in JS:

var myString = javaString;

The available Java JS adapter objects are:

• com.microej.js.objects.JsObject : exposes a Java object as a JavaScript object

• com.microej.js.objects.JsObjectFunction : exposes a Java “process” as a JavaScript function (using a
JsClosure object)

• com.microej.js.objects.JsObjectString : exposes a Java String as a JavaScript String

• com.microej.js.objects.JsObjectArray : exposes a Java items collection as a JavaScript Array

• com.microej.js.objects.JsObjectBoolean : exposes a Java Boolean as a JavaScript Boolean

• com.microej.js.objects.JsObjectNumber : exposes a Java Number as a JavaScript Number

Calling JavaScript from Java

TheMicroEJ JavaScript engine API allows to call JavaScript code from Java code. For example, given the following
JavaScript function in a file in src/main/js :

function sum(a, b) {
print(a + " + " + b + " = " + (a+b));

}

it can be called from a Java piece of code with:

JsObjectFunction functionObject = (JsObjectFunction) JsRuntime.JS_GLOBAL_OBJECT.get("sum");
JsRuntime.ENGINE.addJob(new Job(functionObject, JsRuntime.JS_GLOBAL_OBJECT, new Integer(5), new␣
→˓Integer(3)));

The first line gets the JavaScript function from the global scope. The second line adds a job in the JavaScript engine
queue to execute the function, in the global scope, with the arguments 5 and 3 .

3.15.6 Tests

JavaScript applications can be tested with tests written in JavaScript. The JavaScript test files must be located in
the project folder src/test/js . All JavaScript files ( *.js ) found in this folder, at any level, are considered as test
files.

In order to setup JavaScript tests for your application, follow these steps:
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• create an Add-On Library project or a Standalone Application project

• define the following properties in themodule.ivy file of the project inside the ea:build tag (if the properties
already exist, replace them):

<ea:property name="test.run.includes.pattern" value="**/_JsTest_*Code.class"/>
<ea:property name="target.main.classes" value="${basedir}/target~/test/classes"/>

• add the MicroEJ JavaScript dependency in the module.ivy file of the project:

<dependency org="com.microej.library.runtime" name="js" rev="0.10.0"/>

• define the platform to use to run the tests with one of the options described in Platform Selection section

• create a file assert.js in the folder src/test/resources with the following content:

var assertionCount = 0;

function assert(value) {
assertionCount++;
if (value == 0) {

print("assert " + assertionCount + " - FAILED");
} else {

print("assert " + assertionCount + " - PASSED");
}

}

This method assert will be available in all tests to do assertions.

• create a file test.js in the folder src/test/js and write your first test:

var a = 5;
var b = 3;
var sum = a + b;
assert(sum === 8);

• build the application in the SDK or in command line with theMMM CLI

The execution of the tests produces a report available in the folder target~/test/html for the project.

3.15.7 Limitations

The MicroEJ engine supports the version 5.1 of the ECMAScript specification, with the limitations described in this
page.

Unsupported Directives

Directives, such as 'use strict' , are not supported and are considered as literal statements. Literal statements
are just ignored.

Unsupported Statements

The following syntaxes are not supported by the MicroEJ JavaScript engine:

• with (x) { } : the with statement is not supported in MicroEJ since its usage is not recommended. See
the reference documentation for more information.

3.15. JavaScript 269

https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Statements/with#ambiguity_contra


MicroEJ Documentation, Revision 2788b3f4

Unsupported Built-in Objects

The unsupported built-in objects are listed in the API section.

3.15.8 Troubleshooting

Compilation error cannot be resolved to a type in FFI class

A compilation error can be raised when the classpath contains unexpected classes, for example:

Exception in thread "main" java.lang.Error: Unresolved compilation problems:
ArrayComparisonFailure cannot be resolved to a type
ArrayComparisonFailure cannot be resolved to a type

at java.lang.Throwable.fillInStackTrace(Throwable.java:82)
at java.lang.Throwable.<init>(Throwable.java:37)
at java.lang.Error.<init>(Error.java:18)
at com.microej.js.JsFfi.ffi_toString_0(JsFfi.java:54)
at com.microej.js.JsCode$1$1.invoke(JsCode.java:50)

As described in the FFI section, in order to call Java methods from JavaScript code, all the methods with the given
names are searched in the classpath. Since the classpath can contain test dependencies which are not available
at compile time, the generated FFI can contain classes from these dependencies and therefore fail to compile. The
following classes are excluded by default:

• ej.junit.*

• org.junit.*

• junit.*

• org.hamcrest.*

• java.lang.String

• java.lang.Number

This list can be changed by setting the system property js.ffi.excludes.classes to a comma-separated list of
FQN patterns. For example:

js.ffi.excludes.classes=ej.junit.*,org.junit.*,junit.*,org.hamcrest.*,java.lang.String,java.lang.Number,
→˓com.mycompany.test.*

Warning: Defining this property overwrites the default value, so do not forget to keep the default excluded
classes (unless you knowwhat you are doing).

3.15.9 Internals

JavaScript Sources Processing

The JavaScript code is not executed directly, it is first translated in Java code and compiled with the Java appli-
cation code. This transpilation is done by the JavaScript Add-on Processor. This processor uses the Java Nashorn
library (extracted from jre1.8.0_92) to parse the Javascript files.

The operations performed by this processor are summarized in this diagram:
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• Parsing: all JavaScript source files located in the folder src/main/js and src/test/js are parsed by the
Nashorn library to provide a JavaScript AST.

• JS Validation: validation on the JavaScript AST to detect unsupported language features (for example eval
).

• Conversion preparation: before actually converting the JavaScript AST to a Java AST, a preparation opera-
tion is done to initialize all the lexical environments (done by JsIrVisitor ).

• Conversion: conversion of the JavaScript AST to a Java AST.

• Java AST cleanup/optim: post-conversion step to cleanup and optimize the Java AST. The following opera-
tions are done: - fix imports - remove dead code - remove literal statements

• Java sources generation: generation of the Java sources from the Java AST.

Foreign Function Interface

As said in the sectionCalling Java fromJavaScript, a JavaScript code canmanipulate Javaobjects and callmethods
on Java objects. This chapter describes how does the call to methods on Java objets work.

Let getValue() a Java method called from JavaScript on a Java object. As long as the type of the object is not
known at compile-time in the JavaScript code, all the types containing a method with the same signature are
searched in the classpath. Then the JavaScript pre-processor generates a JsFfi class and a method that dy-
namically tries to find the type of the receiver object. So, when the getValue() method is called from JavaScript,
this generated method is called.

Warning: Calling a method whose name is very common could result in a delay while calling it, and some
useless methods embedded.

This example shares a Java Date of the current time:

JsRuntime.JS_GLOBAL_OBJECT.put("getCurrentDate", JsRuntime.createFunction(new JsClosure() {
@Override
public Object invoke(Object thisBinding, Object... arguments) {

return Calendar.getInstance().getTime();
}

}), false);

The JavaScript can then use this Date to print the current time:

var date = getCurrentDate()
var time = date.getTime()
print("Current time: ", time)

In this case, the generated method in JsFfi looks like:

public static Object ffi_getTime_0(Object function, @ej.annotation.Nullable Object this_) {
try {

if (this_ instanceof JsObject || this_ instanceof String)
return JsRuntime.functionCall(((Reference) function).getValue(), this_);

(continues on next page)
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(continued from previous page)

if (this_ instanceof Calendar) {
return ((Calendar) this_).getTime();

}
if (this_ instanceof Date) {

return new Double(((Date) this_).getTime());
}

} catch (JsErrorWrapper e) {
throw e;

} catch (Throwable t) {
throw new JsErrorWrapper(new JsObjectError.TypeError("A Java exception has been thrown␣

→˓in generated FFI code of getTime"), t);
}
throw new JsErrorWrapper(new JsObjectError.TypeError("getTime"));

}

3.16 Networking

This section presents networking libraries.

The following schema shows the overall architecture andmodules:

Fig. 72: Network Libraries Overview
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3.16.1 Foundation Libraries

Name Description Module
Link

API Link Use

Bluetooth
Bluetooth Low Energy (BLE) based
on the Generic Attribute Profile
(GATT).

bluetooth ej.bluetooth package
• Bluetooth
utility Library

ECOM-Network
Network interfaces management
and IP configurations.

ecom-
network

NetworkInterfaceManager
class

ECOM-WIFI
Wi-Fi connectivity. ecom-

wifi
WifiManager class

• Wi-Fi setup Ex-
ample

• Wi-Fi utility Li-
brary

NET
Client and Server raw TCP/IP sock-
ets.

net java.net package
• NET Example
• NET utility
Library

Security
Cryptographic operations. security javax.crypto package

SSL
Client and Server secure sockets
layer using Transport Layer Secu-
rity (TLS) protocols.

ssl java.net.ssl package
• SSL mutual
client Example

• SSL mutual
server Example

• SSL utility
Library

3.16.2 Add-On Libraries
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IoT Libraries

Name Description Module
Link

API Link Use

Android
Connectivity

Network connection state and no-
tifications.

android-
connectivity

ConnectivityManager
class • Connectivity Ex-

ample

HTTP
Client

OpenJDK HTTP client. httpclient,
http-
sclient

HttpURLConnection
class • HTTP client

README
• See also REST
client Example

HTTP
Server
(Hoka)

Tiny footprint yet extensible web
server.

hoka HttpServer class
• Hoka user man-
ual

• Hoka Example

MQTT
Client

Eclipse Paho MQTT 3.1.1 client. mqtt,
mqtt-ssl

MqttClient class
• MQTT publish
Example

• MQTT subscribe
Example

REST
Client

REpresentational State Tranfer
(REST) client.

restclient Resty class
• REST client
README

• REST client Ex-
ample

REST
Server

REpresentational State Tranfer
(REST) server using on Hoka HTTP
Server.

restserver RestServer class
• REST server Ex-
ample

SNTP
Client

Simple Network Time Protocol
(SNTP) client, used to retrieve the
current time from an NTP server.

sntpclient SntpClient class
• SNTP client
README

WebSocket
Client

WebSocket client (RFC 6455). websocket,
websocket-
secure

WebSocket class
• WebSocket
client README

• WebSocket
client Example
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https://repository.microej.com/modules/ej/library/iot/android-connectivity/
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https://repository.microej.com/modules/ej/library/eclasspath/httpsclient/
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https://repository.microej.com/javadoc/microej_5.x/apis/java/net/HttpURLConnection.html
https://repository.microej.com/javadoc/microej_5.x/apis/java/net/HttpURLConnection.html
https://repository.microej.com/modules/ej/library/eclasspath/httpclient/1.3.0/README-1.3.0.md
https://repository.microej.com/modules/ej/library/eclasspath/httpclient/1.3.0/README-1.3.0.md
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://repository.microej.com/modules/ej/library/iot/hoka/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/hoka/http/HttpServer.html
https://github.com/MicroEJ/LibraryJava-hoka/blob/master/hoka/user-manual.rst
https://github.com/MicroEJ/LibraryJava-hoka/blob/master/hoka/user-manual.rst
https://github.com/MicroEJ/Example-Hoka
https://repository.microej.com/modules/org/eclipse/paho/mqttv3-microej/
https://repository.microej.com/modules/org/eclipse/paho/mqttv3-ssl-microej/
https://repository.microej.com/javadoc/microej_5.x/apis/org/eclipse/paho/client/mqttv3/MqttClient.html
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.mqtt.publisher
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.mqtt.publisher
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.mqtt.subscriber
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https://repository.microej.com/javadoc/microej_5.x/apis/ej/rest/web/Resty.html
https://repository.microej.com/modules/ej/library/iot/restclient/1.1.0/README-1.1.0.md
https://repository.microej.com/modules/ej/library/iot/restclient/1.1.0/README-1.1.0.md
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://repository.microej.com/modules/ej/library/iot/restserver/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/restserver/RestServer.html
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.dynamic-restserver
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.dynamic-restserver
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https://repository.microej.com/javadoc/microej_5.x/apis/android/net/SntpClient.html
https://repository.microej.com/modules/ej/library/iot/sntpclient/1.3.0/README-1.3.0.md
https://repository.microej.com/modules/ej/library/iot/sntpclient/1.3.0/README-1.3.0.md
https://repository.microej.com/modules/ej/library/iot/websocket/
https://repository.microej.com/modules/ej/library/iot/websocket-secure/
https://repository.microej.com/modules/ej/library/iot/websocket-secure/
https://repository.microej.com/javadoc/microej_5.x/apis/index.html?ej/websocket/WebSocket.html
https://repository.microej.com/modules/ej/library/iot/websocket/2.0.0/README-2.0.0.md
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Data Serialization Libraries

Name Description Module
Link

API Link Use

CBOR
Concise Binary Object Representa-
tion (CBOR) encoder and decoder
(RFC 7049).

cbor
• CborEncoder
class

• CborDecoder
class

• CBOR Tutorial

JSON
JavaScript Object Notation (JSON)
encoder and decoder.

json
• JSONObject
class (decoder)

• JSONWriter
class (encoder)

• README
• JSON Tutorial

Protocol
Buffers

Google Protocol Bu�ers 3 encoder
and decoder, supporting files com-
piled by protoc with lite plugin.

protobuf3 •
CodedInputStream
class (decoder)

•
CodedOutputStream
class (encoder)

• Protobuf3
Example

XML
eXtensible Markup Language en-
coder and decoder (kXML 3).

kxml2
• XmlPullParser
class (decoder)

• XmlSerializer
class (encoder)

• XML Tutorial

Cloud Agent Libraries

Name Description Module Link Use

AWS
IoT
Core

AWS IoT Core client, providing pub-
lish/subscribe functionalities.

aws-iot
• AWS IoT Core README
• AWS IoT Core Example

Google
Cloud
Platform
Iot
Core

Google Cloud Platform Iot Core client. gcp-iotcore
• Google Cloud Platform Getting
Started

3.17 Limitations

The following table lists the limitations of MicroEJ Architectures version 7.14.0 or higher, for both Evaluation and
Production usage. Please consultMicroEJ Architectures Changelog for limitations changes on former versions.

Note: The term unlimited means there is no Architecture specific limitation. However, there may be limitations
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https://repository.microej.com/modules/ej/library/iot/cbor/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/cbor/CborEncoder.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/cbor/CborEncoder.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/cbor/CborDecoder.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/cbor/CborDecoder.html
https://repository.microej.com/modules/ej/library/iot/json/
https://repository.microej.com/javadoc/microej_5.x/apis/org/json/me/JSONObject.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/json/me/JSONObject.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/json/me/JSONWriter.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/json/me/JSONWriter.html
https://repository.microej.com/modules/ej/library/iot/json/1.0.0/README-1.0.0.md
https://repository.microej.com/modules/com/google/protobuf3/
https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedInputStream.html
https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedInputStream.html
https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedOutputStream.html
https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedOutputStream.html
https://github.com/MicroEJ/Demo-Protobuf3
https://github.com/MicroEJ/Demo-Protobuf3
http://kxml.sourceforge.net/about.shtml
https://repository.microej.com/modules/org/kxml2/kxml2/
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlPullParser.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlPullParser.html
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driven by device memory layout. Please refer to Platform specific documentation to get the memory mapping of
MicroEJ Core Engine sections.

Table 22: Architecture Limitations
Item EVAL PROD
[Mono-Sandbox] Number of concrete types1 8192 8192
[Multi-Sandbox] Number of concrete types per context1 4096 4096
Number of abstract classes and interfaces unlimited unlimited
Class or Interface hierarchy depth 127 127
Number of methods unlimited unlimited
Method size in bytes 65536 65536
Numbers of exception handlers per method 63 63
Number of instance fields2 (Base type) 4096 4096
Number of instance fields2 (References) 31 31
Number of static fields (boolean + byte) 65536 65536
Number of static fields (short + char) 65536 65536
Number of static fields (int + float) 65536 65536
Number of static fields (long + double) 65536 65536
Number of static fields (References) 65536 65536
Number of threads 63 63
Number of held monitors3 63 63
Time limit 60 minutes unlimited
Number of methods and constructors calls 500000000 unlimited
Number of Java heap Garbage Collection 30004 unlimited

1 Concrete types are classes and arrays that can be instantiated.
2 All instance fields declared in the class and its super classes.
3 Themaximumnumber of di�erentmonitors that can be held by one thread at any time is defined by themaximumnumber ofmonitors per

thread Application option.
4 The JavaheapGarbageCollection limitmay throwunexpected cascading java.lang.OutOfMemoryError exceptionsbefore theMicroEJCore

Engine exits.
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CHAPTER

FOUR

PLATFORM DEVELOPER GUIDE

4.1 Introduction

4.1.1 Scope

This document explains how the core features of MicroEJ Architecture are accessed, configured and used by the
MicroEJ Platform builder. It describes the process for creating and augmenting a MicroEJ Architecture. This doc-
ument is concise, but attempts to be exact and complete. Semantics of implemented Foundation Libraries are
described in their respective specifications. This document includes an outline of the required low level drivers
(LLAPI) for porting the MicroEJ Architectures to di�erent real-time operating systems (RTOS).

MicroEJ Architecture is state-of-the-art, with embedded MicroEJ runtimes for MCUs. They also provide simulated
runtimes that execute on workstations to allow so�ware development on “virtual hardware.”

4.1.2 Intended Audience

The audience for this document is so�ware engineers who need to understand how to create and configure a Mi-
croEJ Platform using the MicroEJ Platform builder. This document also explains how a MicroEJ Application can
interoperate with C code on the target, and the details of the MicroEJ Architecture modules, including their APIs,
error codes and options.

4.2 MicroEJ Platform

4.2.1 Introduction

A MicroEJ Platform includes development tools and a runtime environment.

The runtime environment consists of:

• A MicroEJ Core Engine.

• Some Foundation Libraries.

• Some C libraries.

The development tools are composed of:

• Java APIs to compile MicroEJ Application code.

• Documentation: this guide, library specifications, etc.

• Tools for development and compilation.
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• Launch scripts to run the simulation or build the binary file.

• Eclipse plugins.

4.2.2 Build Process

This section summarizes the steps required to build a MicroEJ Platform and obtain a binary file to deploy on a
board.

The following figure shows the overall process. The first three steps are performed within the MicroEJ Platform
builder. The remaining steps are performed within the C IDE.

Fig. 1: Overall Process
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The steps are as follow:

1. Create a new MicroEJ Platform configuration project. This project describes the MicroEJ Platform to build
(MicroEJ Architecture, metadata, etc.).

2. Select which modules provided by the MicroEJ Architecture will be installed in the MicroEJ Platform.

3. Build the MicroEJ Platform according to the choices made in steps 1 and 2.

4. Compile a MicroEJ Application against the MicroEJ Platform in order to obtain an application file to link in
the BSP.

5. Compile the BSP and link it with the MicroEJ Application that was built previously in step 4 to produce a
MicroEJ Firmware.

6. Final step: Deploy MicroEJ Firmware (i.e. the binary application) onto a board.

4.2.3 Concepts

MicroEJ Platform Configuration

A MicroEJ Platform is described by a .platform file. This file is usually called [name].platform , and is stored at
the root of a MicroEJ Platform configuration project called [name]-configuration .

The configuration file is recognized by the MicroEJ Platform builder. The MicroEJ Platform builder o�ers a visual-
ization with two tabs:
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Fig. 2: MicroEJ Platform Configuration Overview Tab

This tab groups the basic platform information used to identify it: its name, its version, etc. These tags can be
updated at any time.
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Fig. 3: MicroEJ Platform Configuration Content Tab

This tab shows all additional modules (see Modules) which can be installed into the platform in order to augment
its features. The modules are sorted by groups and by functionality. When amodule is checked, it will be installed
into the platform during the platform creation.

Modules

The primary mechanism for augmenting the capabilities of a Concepts is to addmodules to it.

A MicroEJ module is a group of related files (Foundation Libraries, scripts, link files, C libraries, Simulator, tools,
etc.) that together provide all or part of a platform capability. Generally, these files serve a common purpose. For
example, providing an API, or providing a library implementation with its associated tools.

The list of modules is in the second tab of the platform configuration tab. A module may require a configuration
step to be installed into the platform. The Modules Detail view indicates if a configuration file is required.

Low Level API Pattern

Principle

Each time the usermust supply C code that connects a platformcomponent to the target, a LowLevel API is defined.
There is a standard pattern for the implementation of these APIs. Each interface has a name and is specified by two
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header files:

• [INTERFACE_NAME].h specifies the functions that make up the public API of the implementation. In some
cases the user code will never act as a client of the API, and so will never use this file.

• [INTERFACE_NAME]_impl.h specifies the functions that must be coded by the user in the implementation.

The user creates implementations of the interfaces, each captured in a separate C source file. In the simplest form
of this pattern, only one implementation is permitted, as shown in the illustration below.

Fig. 4: Low Level API Pattern (single implementation)

The following figure shows a concrete example of an LLAPI. The Cworld (the board support package) has to imple-
ment a send function andmust notify the library using a receive function.
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Fig. 5: Low Level API Example

Multiple Implementations and Instances

When a Low Level API allows multiple implementations, each implementation must have a unique name. At run-
time theremaybe one ormore instances of each implementation, and each instance is represented by a data struc-
ture that holds information about the instance. The address of this structure is the handle to the instance, and that
address is passed as the first parameter of every call to the implementation.

The illustration below shows this form of the pattern, but with only a single instance of a single implementation.
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Fig. 6: Low Level API Pattern (multiple implementations/instances)

The #define statement in MYIMPL.c specifies the name given to this implementation.

4.3 MicroEJ Architecture

MicroEJ Architecture features the MicroEJ Core Engine built for a specific instructions set (ISA) and compiler.

The MicroEJ Core Engine is a tiny and fast runtime associated with a Scheduler and a Garbage Collector.

MicroEJ Architecture provides implementations of the following Foundation Libraries :

• EDC: Embedded Device Configuration.

• BON Beyond Profile (see [BON]).

• SNI Simple Native Interface ([SNI]).

• SP Shielded Plug ([SP]).

• KF Kernel & Features ([KF]).

The following figure shows the components involved.
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Fig. 7: MicroEJ Architecture Modules

Three Low Level APIs allow the MicroEJ Architecture to link with (and port to) external code, such as any kind of
RTOS or legacy C libraries:

• Simple Native Interface (see [SNI])

• Low Level MicroEJ Core Engine (see LLMJVM)

• Low Level Shielded Plug (see LLSP)

For further information on Architecture installation and releases, you can check these chapters:

4.3.1 Naming Convention

MicroEJ Architecture files endswith the .xpf extension, and are classified using the following naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]/[VERSION]/[UID]-[VERSION]-[USAGE].xpf

• ISA : instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32, . . . ).

• TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48 ).

• UID : Architecture unique ID (e.g. flopi4G25 ).

• VERSION : module version (e.g. 7.12.0 ).

• USAGE = eval for evaluation Architectures, prod for production Architectures.

For example, MicroEJ Architecture versions for Arm® Cortex®-M4 microcontrollers compiled with GNU CC
toolchain are available at https://repository.microej.com/modules/com/microej/architecture/CM4/CM4hardfp_
GCC48/flopi4G25/.
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See Platform Configuration for usage.

4.3.2 MicroEJ Architectures Changelog

Notation

A line prefixed by [] describes a change that only applies on a specific configuration: [Core Engine Capability/
Instruction Set/C Compiler] :

• Core Engine Capability

– Single : Single Application (default)

– Tiny : Tiny Application

– Multi : Multi Applications

• Instruction Set

– ARM9 : ARM ARM9

– Cortex-A : ARM Cortex-A

– Cortex-M : ARM Cortex-M

– ESP32 : Espressif ESP32

– RX : Renesas RX

– x86 : Intel x86

• C Compiler

– ARMCC5 : Keil ARMCC uVision v5

– IAR74 : IAR Embedded Workbench for ARM v7.4

– QNX65 : BlackBerry QNX 6.5

– QNX70 : BlackBerry QNX 7.0

[7.16.0] - 2021-06-24

Notes

The Device module provided by the MicroEJ Architecture is deprecated and will be removed in a future version.
It has beenmoved to the Device Pack. Please update your Platforms.

Core Engine

• Added a dedicated error code LLMJVM_E_INITIALIZE_ERROR (-23) when LLMJVM_IMPL_initialize()
, LLMJVM_IMPL_vmTaskStarted() , or LLMJVM_IMPL_shutdown() fails. Previously the generic error code
LLMJVM_E_MAIN_THREAD_ALLOC (-5) was returned.

• Added automatic heap consumption monitoring when option com.microej.runtime.debug.heap.
monitoring.enabled is set to true

• Fixed some parts of LLMJVM_checkIntegrity() code were embedded even if not called
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• [Multi] Fixed potential crash during the call of LLMJVM_checkIntegrity when analyzing a corrupted Java
stack (make this function robust to object references with an invalid memory address)

Foundation Libraries

• Added source code for KF , SCHEDCONTROL , SNI , SP implementations

• Updated KF API with annotations for Null analysis

• Updated SNI API with annotations for Null analysis

• Updated SP API with annotations for Null analysis

• Updated ResourceManager implementation with annotations for Null analysis

• Updated KF implementation:

– Addedmissing Kernel.getAllFeatureStateListeners() method

– Updated code for correct Null analysis detection

– Fixed Feature.getCriticality() to throw IllegalStateException if it is in state UNINSTALLED
(instead of returning NORM_CRITICALITY )

– Fixed potential race condition between Kernel.addResourceControlListener() and Kernel.
removeResourceControlListener() . Adding a new listener may not register it if another one is re-
moved at the same time.

Integration

• Added a new task in ELF Utils library allowing to update the content of an ELF section:

– Declaration:

<taskdef classpath="${platform.dir}/tools/elfutils.jar" classname="com.is2t.elf.utils.
→˓AddSectionTask" name="addSection" />

– Usage:

<addSection file="${executable.file}" sectionFile="${section.file}" sectionName="${section.
→˓name}" sectionAlignment="${section.alignment}" outputDir="${output.dir}" outputName="$
→˓{output.name}" />

• Updated Architecture End User License Agreement to version SDK 3.0-C

• Updated copyright notice of Low Level APIs header files to latest MicroEJ SDK default license

• Updated Architecture module with required files and configurations for correct publication in a module
repository ( README.md , LICENSE.txt , and CHANGELOG.md )

Simulator

• Added an option ( com.microej.simulator.hil.frame.size ) to configure the HIL engine max frame size

• Fixed load of an immutable byte field (sign extension)

• Fixed java.lang.String constructors String(byte[] bytes, ...) when passing characters in the range
[0x80,0xFF] using default ISO-8859-1 encoding
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• Fixed potential crash in debugmodewhen a breakpoint is set on a field access (introduced in version 7.13.0
)

• Fixed wrong garbage collection of an object only referenced by an immortal object

SOAR

• Fixed the following compilation issues in if statement with BON constant:

– too many codemay be removed when the block contains a while loop

– potential Stacks merging coherence error may be thrown when the block contains a nested
try-catch statement

– potential Stacks merging coherence error when declaring a ternary expression with Constants.
getBoolean() in condition expression

• Fixed assert statement removal when it is located at the end of a then block: the else block may be
executed instead of jumping over

• Removed names of arrays of basetype unless soar.generate.classnames option is set to true

• [Multi] Fixed potential link exception when a Feature use one of the ej_bon_ByteArray methods (e.g. ej.
kf.InvalidFormatException: code=51:ON_ej_bon_ByteArray_method_readUnsignedByte_AB_I_I )

• [Multi] Fixed SOAR error ( Invalid SNI method ) when one of the ej.bon.Constants.getXXX() methods
is declared in a kernel.api file. This issue was preventing from using BON Constants in Feature code.

Tools

• Updated Code Coverage Analyzer report generation:

– Automatically configure src/main/java source directory beside a /bin directory if available

– Added an option ( cc.src.folders ) to specify the source directory (require MicroEJ SDK 5.4.1 or
higher)

– Removed the analysis of generated code for synchronized statements

– Fixed crash when loading source code with annotations

• Fixed Memory Map scripts: ClassNames groupmay contain duplicate sections with Types group

• Fixed load of an ELF executable when a section overlaps a segment (updated ELF Utils, Kernel Packager and
Firmware Linker)

• Fixed Firmware Linker to generate output executable file at the same location than the input executable file

[7.15.1] - 2021-02-19

SOAR

• [Multi] Fixed potential VM crash when declaring a Proxy class which is abstract .
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[7.15.0] - 2020-12-17

Core Engine

• Added support for applying Feature relocations

Foundation Libraries

• Updated KF implementation to apply Feature relocations using the Core Engine. The former Java im-
plementation is deprecated but can still be enabled using the option com.microej.runtime.kf.link.
relocations.java.enabled .

Integration

• Updated the Architecture naming convention: the usage level is prod instead of dev .

• Fixed generation of temporary properties file with a .properties.list extension instead of deprecated
.system.properties extension.

SOAR

• Fixed crash when declaring a clinit dependency rule on a class that is loaded but not embedded.

Tools

• Fixed Memory Map Script All graph creation to prevent slow opening of large .map file in Memory Map
Analyzer.

[7.14.1] - 2020-11-30

Core Engine

• [Multi/x86/QNX7] Fixed missing multi-sandbox version

Tools

• Fixed categories for class names and SNI library in Memory Map Scripts

[7.14.0] - 2020-09-25

Notes

The following set of Architecture properties are automatically provided as BON constants:

• com.microej.architecture.capability=[tiny|single|multi]

• com.microej.architecture.name=[architecture_uid]

• com.microej.architecture.level=[eval|prod]
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• com.microej.architecture.toolchain=[toolchain_uid]

• com.microej.architecture.version=7.14.0

The following set of Platform properties (customer defined) are automatically provided as BON constants:

• com.microej.platform.hardwarePartNumber

• com.microej.platform.name

• com.microej.platform.provider

• com.microej.platform.version

• com.microej.platform.buildLabel

Foundation Libraries

• Updated EDC UTF-8 encoder to support Unicode code points as supplementary characters

• Fixed java.lang.NullPointerException thrownwhen java.util.WeakHashMap.put() method is called
with a null key (introduced in version 7.11.0)

Integration

• Added all options starting with com.microej. prefix as BON constants

• Added all properties defined in architecture.properties as options prefixed by com.microej.
architecture.

• Added all properties defined in release.properties as options prefixed by com.microej.platform.

• Added all properties defined in script/mjvm.properties as options prefixed by com.microej.
architecture.

• Added an option ( com.microej.library.edc.supplementarycharacter.enabled ) to enable support for
supplementary characters (enabled by default)

• Updated Memory Map Scripts to extract Java static fields in a dedicated group named Statics

• Updated Memory Map Scripts to extract Java types in a dedicated group named Types

• Fixed generated Feature filename (unexpanded ${feature.output.basename} variable, introduced in ver-
sion 7.13.0)

• Fixed definition of missing default values for memory options (same values than launcher default ones)

• [Tiny,Multi] - Added display of the Core Engine capability when launching SOAR

SOAR

• [Multi] - Added a new attribute named api in Kernel soar.xml file indicating which types, methods and
static fields are exposed as Kernel APIs

• [Multi] - Fixed potential link error when calling java.lang.Object.clone method on an array in Feature
mode
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Tools

• Updated serial PC connector to JSSC 2.9.2 (COM port could not be open onWindows 10 using a JRE 8u261
or higher)

[7.13.3] - 2020-09-18

Core Engine

• [QNX70] - Embedmethod names and line numbers information in the application

• [Cortex-A/QNX70] - Fixed wrong float/double arguments passed to the SNI natives (introduced in version
7.12.0)

Simulator

• Fixed unnecessary stacktrace dump on Long.parseLong() error

• Fixed UTF-8 encoded Strings not correctly printed

Tools

• Updated Memory Map Scripts for ej.library.runtime.basictool library

[7.13.2] - 2020-08-14

Core Engine

• [ARM9/QNX65] - Fixed custom convention call

• [x86/QNX70] - Fixed SIGFPE raised when overflow occurs on division

• [x86/QNX70] - Fixed issue with NaN conversion to int or long

Tools

• Fixed Feature build script for MicroEJ SDK 5.x (introduced in version 7.13.0)

• Updated Memory Map Scripts for MicroUI 3 and Service libraries

[7.13.1] - 2020-07-20

Core Engine

• [ESP32] - Fixed potential PSRAM access faults by rebuilding using esp-idf v3.3.0 toolchain ( simikou2 )
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[7.13.0] - 2020-07-03

Core Engine

• Added SNI-1.4 support, with the following new LLSNI.h Low Level APIs:

– Added function SNI_registerResource()

– Added function SNI_unregisterResource()

– Added function SNI_registerScopedResource()

– Added function SNI_unregisterScopedResource()

– Added function SNI_getScopedResource()

– Added function SNI_retrieveArrayElements()

– Added function SNI_flushArrayElements()

– Added function SNI_isResumePending()

– Added function SNI_clearCurrentJavaThreadPendingResumeFlag()

– Added define SNI_VERSION

– Added define SNI_IGNORED_RETURNED_VALUE

– Added define SNI_ILLEGAL_ARGUMENT

– Updated the documentation of some functions to clarify the behavior

• Added amessage to IllegalArgumentException thrown in an SNI call when passing a non-immortal array
in SNI (only in case the Platform is configured to disallow the use of non-immortal arrays in SNI native calls)

• Added function LLMJVM_CheckIntegrity() to LLMJVM.h Low Level API to perform heap and internal struc-
tures integrity check

• Updated KF implementation to use SNI-1.4 to close native resources when the Feature is stopped ( ej.
lang.ResourceManager is now deprecated)

• Updated LLMJVM_dump() output with the following new information related to SNI-1.4 native resource
management:

– Last native method called (per thread)

– Current native method being invoked (per thread)

– Last native resource close hook called (per thread)

– Current native resource close hook being invoked (per thread)

– Pending Native Exception (per thread)

– Pending SNI Scoped Resource to close (per thread)

– Current GarbageCollector state: (running or not, last scannedobject address, last scannedobject class)

– LLMJVM schedule request (global and per thread)

• Updated non-immortal object access from SNI default behavior (now allowed by default)

• Fixed thread state displayed by LLMJVM_dump for threads in SLEEP state

• Fixed sni.h header file function prototypes using the SNI_callback typedef

• Fixed crash when an OutOfMemoryError is thrown while creating a native exception in SNI
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• [Multi] - Fixed runtime exceptions that can be implicitly thrown (such as NullPointerException ) which
were not automatically exposed by the Kernel

• [Multi] - Fixed passing Kernel array parameters through a shared interface method call. These parameters
were passed by copy instead of by reference as specified by KF specification

• [Multi] - Fixed execution context when jumping in a catch block of a ej.kf.Proxy method (the catch block
was executed in the Kernel context instead of the Feature context)

• [ARMCC5] - Fixed linkerror Undefined symbol _java_Ljava_lang_OutOfMemoryError_field_OOMEMethodAddr_I
with ARM Compiler 5 linker (introduced in version 7.12.0)

Foundation Libraries

• Updated SNI to version 1.4

• Updated internal library Resource-Manager-1.0 as deprecated. Use SNI-1.4 native resources instead

• Updated java.lang.Thread.getId() method implementation to return the same value than
SNI_getCurrentJavaThreadID() function

• Optimized ej.sni.SNI.toCString() method by removing a useless temporary bu�er copy

• Fixed EDC implementation of String(byte[],int,int) constructor which could allocate a too large tem-
porary bu�er

• Fixed EDC implementation of Thread.interrupt() method to throw a java.lang.SecurityException
when the interrupted thread cannot be modified by the the current thread

• Fixed EDC implementation to remove remaining references to java.util.SecurityManager class when it
is disabled

• Fixed EDC implementation of java.lang.Thread.interrupt() method that was declared final

• Fixed EDC API of java.lang.Thread.interrupt() to clarify the behavior of the method

• Fixed EDC API of java.util.Calendar method to specify that non-lenient mode is not supported

• Fixed EDC API of java.io.FilterInputStream.in field to be marked @Nullable

Integration

• Updated Architecture End User License Agreement to version SDK 3.0-B

Simulator

• Added SNI-1.4 support, with the following new HIL APIs:

– Addedmethods NativeInterface.suspendStart() and NativeInterface.suspendStop() tonotify
the simulator that a native is suspended so that it can schedule a thread with a lower priority

• Added KF support to dynamically install Features ( .fs3 files)

• Added the capability to specify the Kernel UID froman option (see options in Simulator > Kernel > Kernel
UID )

• Added object size in generated .heap dump files

• Optimized file accesses from the Application
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• Fixed crash in debug mode when paused on a breakpoint in MicroEJ SDK and hovering a Java variable with
the mouse

• Fixed potential crash in debugmode when putting a breakpoint in MicroEJ SDK on a line of code declared in
an inner class

• Fixed potential crash in debugmode ( java.lang.NullPointerException ) when a breakpoint set on a field
access is hit

• Fixed potential crash in debugmode ( ArrayIndexOutOfBoundsException )

• Added support for JDWP commands DisableCollection / EnableCollection in the debugger

• Fixed invalid heap dump generation in debugmode.

• Fixed crash when a Mockup implements com.is2t.hil.StartListener and this implementation throws
an uncaught exception in the clinit

• Fixed verbose of missing resource only when a resource is available in the classpath but not declared in a
.resources.list file

• Fixed heap consumption simulation for objects instances of classes declaring fields of type float or double

• Fixed Device UID not displayed in the Front Panel window title (introduced in version 7.11.0)

• Fixed loading of a resource from a JAR when the path starts with /

• Fixed potential deadlock on Front Panel startup in some cases

• Fixed Thread.getState() returning TERMINATED whereas the thread is running

• Fixed Simulator which may not stop properly when closing the Front Panel window

• Fixed Front Panel which stops sending widget events when dragging out of a widget

• [Multi] - Fixed monitor that may not be released when an exception occurs in a synchronized block (intro-
duced in version 7.10.0 )

• [Multi] - Fixed invalid heap dump generation that causes heap analyzer crash

• [Multi] - Fixed potential crash ( java.lang.NullPointerException ) in debugmodewhen debugging an Ap-
plication (introduced in version 7.10.0)

• [Multi] - Fixed error when using KF library without defining a kernel.kf file in the Kernel (introduced in
version 7.10.0)

SOAR

• Added anoption ( soar.bytecode.verifier ) to enable or disable the bytecode verifier (disabled by default)

• Removed size related limits in Architecture Evaluation version

Tools

• Added SNI-1.4 support to HIL Engine

• UpdatedHeapDumper to verbose information about thememory sectionwhen an overlap is detected in the
HEX file

• Updated Memory Map Scripts (Security, DTLS, Device)

• Fixed License Manager (Evaluation) random crash on Windows 10 when a Platform is built using Build
Module button
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• Fixed License Manager (Evaluation) wrong UID computation a�er reboot when Windows 10 Hyper-V feature
is enabled

• Fixed HIL Engine to exit as soon as the Simulator is disconnected (avoid remaining detached processes)

• FixedELF toMapgenerating symbol addressesdi�erent fromtheELF symbol addresses (introduice in version
7.11.0)

• Fixed Heap Dumper crash when a wrong object header is encountered

• Fixed Heap Dumper failure when amemory dump is larger than the heap section

• Fixed Heap Dumper crash when loading an Intel HEX file that contains lines of type 02

[7.12.0] - 2019-10-16

Core Engine

• Updated implementation of internal java.lang.OutOfMemoryError thrown with the maximum number of
frames that can be dumped

• Updated LLMJVM_dump() output with the following new information:

– Maximum number of alive threads

– Total number of created threads

– Maximum number of stack blocks used

– Current number of stack blocks used

– Objects referenced by each stack frame: address, type, length (in case of arrays), string content (in case
of String objects)

– [Multi] Kernel stale references with the name of the Feature stopped

Foundation Libraries

• Fixed EDC implementation of Throwable.getStackTrace() when called on a java.lang.
OutOfMemoryError thrown by Core Engine or Simulator (either the returned stack trace array was
empty or a java.lang.NullPointerException was thrown)

• [Tiny] Fixed EDC implementation of StackTraceElement.toString() (removed the character . before the
type)

• [Multi] Fixed KF implementation of Feature.start() to throw a java.lang.
ExceptionInInitializerError when an exception is thrown in a Feature clinit method

Simulator

• Updated implementation of internal java.lang.OutOfMemoryError thrown with more than one frames
dumped per thread

– By default the 20 top frames per thread are dumped. This can be modified using S3.
OutOfMemoryErrorNbFrames system property

• Fixed wrong parsing of an array of long when an element is declared with only 2 digits (e.g. 25 was parsed
as 2 )
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• Fixed error parsing of an array of byte when an element is declaredwith the unsigned hexadecimal notation
(e.g. 0xFF ) (introduced in version 7.10.0)

• Fixed crash when ej.bon.ResourceBuffer.readString() is called on a String greater than 63 characters
(introduced in version 7.10.0)

• Fixed code coverage .cc generation of classpath directories

• Fixed crash during a GC when computing the references map of a complex method (an error message is
dumped with the involved method name and suggest to increase the internal stack using S3.JavaMemory.
ThreadStackSize system property)

• [Multi] Added validity check of Shared Interface declaration files ( .si ) according to KF specification

• [Multi] Fixed processing of Resource Bu�ers declared in Feature classpath

SOAR

• Added a newoption core.memory.oome.nb.frames to configure themaximumnumber of stack frames that
can be dumped when an internal java.lang.OutOfMemoryError is thrown by Core Engine

Tools

• Updated Heap Dumper to verbose detected object references that are outside the heap

• Updated Heap Dumper to throw a dedicated error when an object reference does not target the beginning of
an object (most likely a corrupted heap)

• Updated Heap Dumper to dump .heap.error partial file when a crash occurred during heap processing

• Fixed Heap Dumper crash when processing an object owned by a Feature which type is also owned by the
Feature (was working before only when the type is owned by the Kernel)

• Fixed Firmware Linker potential negative o�set generation when some sections do not appear in the same
order in the ELF file than in their associated LOAD segment

• Fixed Code Coverage Analyzer potential generated empty report (wrong load of classfiles from JAR files)

[7.11.0] - 2019-06-24

Important Notes

• Java assertions execution is now disabled by default. If you experience any runtime trouble when migrat-
ing from a previous Architecture, please enable Java assertions execution both on Simulator and on Device
(maybe the application code requires Java assertions to be executed).

• Calls to Security Manager are now disabled by default. If you are using the Security Manager, it must be
explicitly enabled using the option describedbelow (likely the casewhenbuilding aMulti-Sandbox Firmware
and its associated Virtual Device).

• Front Panel framework is now provided by the Architecture instead of the UI Pack. This allow to build a Plat-
form with a Front Panel (splash screen, basic I/O, . . . ), even if it does not provide a MicroUI port. Moreover,
the Front Panel framework API has been redesigned and is nowdistributed using the ej.tool.frontpanel.
framework module instead of the legacy Eclipse classpath variable.
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Core Engine

• Added EDC-1.3 support for daemon threads

• Added BON support for ej.bon.Util.newArray(T[],int)

• [Multi/ARMCC5] Fixed unused undefined symbol that prevent Keil MDK-ARM to link properly

Foundation Libraries

• Updated EDC to version 1.3 (see EDC-1.3 API Changelog)

– Updated the implementation code for correct Null analysis detection (added assertions, extractedmul-
tiple field accesses into a local)

– Fixed java.io.PrintStream.PrintStream(OutputStream, boolean) writer initialization

– Removed useless String literals in java.lang.Throwable

• Updated UTF-8 decoder to support Unicode code points

• Updated BON to version 1.4 (see BON-1.4 API Changelog)

• Updated TRACE to version 1.1

– Added ej.trace.Tracer.getGroupID()

– Added a BON Constant ( core.trace.enabled ) to remove trace related code when tracing is disabled

• Fixed KF to call the registered Thread.UncaughtExceptionHandler when an exception is thrown by the
first Feature thread

Integration

• Added new options for Java assertions execution in category Runtime ( core.assertions.sim.enabled
and core.assertions.emb.enabled ). By default, Java assertions execution is disabled both on Simulator
and on Device.

• Updated options categories (options property names le� unchanged)

– Added a new category named Runtime

– Renamed Target to Device

– Moved Embed All type names option from Core Engine to Runtime

– Moved Core Engine under Device

– Removed category Target > Debug andmoved Trace options to Runtime

– Removed category Debug andmoved all sub categories under Simulator

– Renamed category JDWP to Debug

• Addedanoption (com.microej.library.edc.securitymanager.enabled ) toenableSecurityManager run-
time checks (disabled by default)
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Simulator

• Added a cache to speed-up classfile loading in JARs

• Added EDC-1.3 support for daemon threads

• Added BON-1.4 support for compile-time constants (load of .constants.list resources)

• Added BON-1.4 support for ej.bon.Util.newArray()

• Added Front Panel framework

• Updated error message when reaching S3 simulator limits

• Removed the Bootstrapping a Smart Software Simulator message when verbose mode in enabled

• Fixed Object.clone() on an immutable object to return a new (mutable) object instead of an immutable
one

• Fixed Object.clone() crash when an OutOfMemory occurs

• Fixed potential crash when calling an abstract method (some interfaces of the hierarchy were not taken into
account - introduced in version 7.10.0)

• Fixed OutOfMemory errors even if the heap is not full (resources loaded from Class.getResourceAsStream
and ResourceBuffer.open() were taken into account in simulated heap memory - introduced in version
7.10.0)

• Fixed potential crash when a GC occurs while a ResourceBuffer is open (introduced in version 7.10.0)

• Fixed potential debugger hangs when an exception was thrown but not caught in the samemethod

• [Multi] Fixed wrong class loading in some cases

• [Multi] Fixed wrong immutable loading in some cases

SOAR

• Added BON-1.4 support for compile-time constants (load of .constants.list resources)

• Added bytecode removal for Java assertions (when option is disabled)

• Added bytecode removal for if(ej.bon.Constants.getBoolean()) pattern

– then or else block is removed depending on the boolean condition

– WARNING: Current limitation: the ‘‘if‘‘ statement cannot wrap or be nested in a ‘‘try-catch-finally‘‘ state-
ment

• Added an option for grouping all the methods by type in a single ELF section

– com.microej.soar.groupMethodsByType.enabled ( false by default)

– WARNING: this option avoids to reach themaximumnumber of ELF sections (65536) when building a large
application, but a�ects the application code size (especially inlinemethods are embedded even if they are
not used)

• Added an error message when microejapp.o cannot be generated because the maximum number of ELF
sections (65536) is reached
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Tools

• Updated License Manager (Production) to debug dongle recognition issues. (usage is java -Djava.
library.path=resources/os/[OS_NAME] -jar licenseManager/licenseManagerUsbDongle.jar in an
Architecture or Platform folder)

• Updated License Manager (Production ) to support dongle recognition on Mac OS 10.14 (Mojave)

• Fixed ELF To Map to produce correct sizes from an executable generated by IAR Embedded Workbench for
ARM

• Fixed Firmware Linker .ARM.exidx section generation (missing section link content)

• Updated deployment files policy for Platforms in Worskpace, in order to be more flexible depending on the
C project layout. This also allows to deploy to the same C project di�erent Applications built with di�erent
Platforms

– Platform configuration: in bsp/bsp.properties , a new option output.dir indicates where the files
are deployed by default

* Application ( microejapp.o ) and Platform library ( microejruntime.a ) are deployed to
${output.dir}/lib . Platform header files ( *.h ) are deployed to ${output.dir}/inc/

* When this option is not set, the legacy behavior is le� unchanged ( project.file option in collab-
oration with augmentCProject scripts)

– Launch configuration: Device > Deploy options allow to override the default Platform configuration
in order to deploy each MicroEJ file into a separate folder.

• Fixed wrong ELF file generation when a section included in a LOAD segment was generated before one of
the sections included in a LOAD segment declared before the first one (integrated in ELF Utils and Firmware
Linker)

• FixedwrongELF filegenerationwhenasection included inaLOADsegmenthadanaddresswhichwasoutside
its LOAD segment virtual address space (integrated in ELF Utils and Firmware Linker)

[7.10.1] - 2019-04-03

Simulator

• Fixed Object.getClass() may return a Class instance owned by a Feature for type owned by the Kernel

[7.10.0] - 2019-03-29

Core Engine

• Added internal memories checks at startup: heaps and statics memories are not allowed to overlap with
LLBSP_IMPL_isInReadOnlyMemory()

• [Multi] - Updated Feature Kill implementation to prepare future RAM Control (fully managed by Core Engine)

• [Multi] - Updated implementation of ej.kf.Kernel : all APIs taking a Feature argument now will throw a
java.lang.IllegalStateException when the Feature is not started
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Foundation Libraries

• Updated KF library in syncwith Core Engine Kill related fixes and Simulator with Kernel & Features semantic

• Updated BON libraryonSimulator (nowuses the same implementation than theoneusedby theCoreEngine)

Integration

• Added generation of architecture.properties file when building a Platform. (Used by MicroEJ
SDK/Studio 5 whenmanipulating Platforms & Virtual Devices)

Simulator

• Added Embed all types names option for Simulation

• Addedmemory size simulation for Java Heap and Immortal Heap (Enabling Use target characteristics
option is nomore required)

• Added Kernel & Features semantic, as defined in the KF-1.4 specification

– Fully implemented:

* Ownership for types, object and thread execution context

* Kernel mode

* Context Local Static Field References

– Partially implemented:

* Kernel API (Type grained only)

* Shared Interfaces are binded using direct reference links (no Proxy execution)

* Feature.stop() does not perform the safe kill. The application cannot be stopped unless it has
correctly removed all its shared references.

– Not implemented:

* Dynamic Feature installation from Kernel.install(java.io.InputStream)

* Execution Rules Runtime checks

Tools

• Updated Memory Map Scripts (Bluetooth, MWT, NLS, Rcommand and AllJoyn libraries)

• Fixed Kernel Packager internal limits error when the ELF executable does not contains a .debug.soar
section

• FixedwrongELF file generationwhensegment file size isdi�erent than thememsize (integrated in ELF Utils
and Firmware Linker )

• Fixed Simulator COMportmapping default value (set to disabled instead of UART<->UART in order to avoid
an error when launch configuration is just created)

• Fix ELF To Map: the total sections size were not equal to the segments size
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[7.9.1] - 2019-01-08

Tools

• Fixed ELF objcopy generation when ELF executable file contains 0 size segments

• Fixed Stack Trace Reader error when ELF executable file contains relocation sections

[7.9.0] - 2018-09-20

SOAR

• Optimized SOAR processing (up to 50% faster on applications with tens of classpath entries)

[7.8.0] - 2018-08-01

Tools

• [ARMCC5] - Updated SOAR Debug Infos Post Linker tool to generate the full ELF executable file

[7.7.0] - 2018-07-19

Core Engine

• Added a permanent hook LLMJVM_on_Runtime_gc_done called a�er an explicit java.lang.Runtime.gc()

• Updated internal heap header for memory dump

SOAR

• Added check for the maximum number of allowed concrete types (avoids a Core Engine link error)

Tools

• Added Heap Dumper tool

[7.6.0] - 2018-06-29

Foundation Libraries

• [Multi] Updated BON library: a Timer owned by the Kernel can execute a TimerTask owned by a Feature

[7.5.0] - 2018-06-15

Internal Release - COTS Architecture le� unchanged.
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[7.4.0] - 2018-06-13

Core Engine

• Removed partial support of ej.bon.Util.throwExceptionInThread() (deprecated)

• [Multi/Linux] - Updated default configuration to always embedmethod names

• [Multi/Cortex-M] - Optimized KF checks execution for array & field accesses

Foundation Libraries

• Updated ej.bon.Timer to schedule ej.bon.TimerTask owned bymultiple Features

Simulator

• Fixed implementation of java.lang.Class.getResourceAsStream() to throw a java.io.IOException
when the stream is closed

SOAR

• [GCC] - Fixed microejapp.o link with GCC 6.3

Tools

• Added a retry mechanism in the Testsuite Engine

• Added a message to suggest increasing the JVM heap when an OutOfMemoryError occurs in the Firmware
Linker tool

• Fixed generation of LL header files for all cross compilation toolchains (file separator for included paths is /
)

• [Cortex-A/ARMCC5] - Fixed SNI convention call issue

• [ESP32,RX] - Fixed Firmware Linker tool internal limit

[7.3.0] - 2018-03-07

Simulator

• Added an option for the IDE to customize the mockups classpath

• Fixed Deadlock in Shielded Plug remote client when interrupting a thread that waits for block modification

[7.2.0] - 2018-03-02

Core Engine

• [Multi] - Enabled quantum counter computation only when Feature quota is set

• [Cortex-M/IAR74] - Updated compilation flags to -Oh
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Simulator

• Added a hook in the mockup that is automatically called during the HIL Engine startup

• Added dump of loaded classes when verbose option is enabled

• Fixed java.lang.Runtime.freeMemory() call freeze when Emb Characteristics option is enabled

• Fixed ShieldedPlug server error a�er interrupting a thread that is waiting for a database block

• Fixed crash Access to a wrong reference in some cases

• Fixed java.lang.NullPointerException when interrupting a thread that has not been started

• Fixed crash when closing an HIL connection in some cases

• [Multi] - Fixed KF &Watchdog library link when Emb Characteristics option is enabled

• [Multi] - Fixed XML Parsing error when Emb Characteristics option is enabled

[7.1.2] - 2018-02-02

SOAR

• Fixed SNI library was added in the classpath in some cases

[maintenance/6.18.0] - 2017-12-15

Core Engine

• [Multi] - Enabled quantum counter computation only when Feature quota is set

• [Cortex-M/IAR74] - Updated compilation flags to -Oh

Simulator

• Fixed java.lang.Runtime.freeMemory() call freeze when Emb Characteristics option is enabled

• [Multi] - Fixed KF &Watchdog library link when Emb Characteristics option is enabled

• [Multi] - Fixed XML Parsing error when Emb Characteristics option is enabled

Tools

• Updated Kernel API Generator tool with classes filtering

[7.1.1] - 2017-12-08

Tools

• [Multi/RX] - Fixed Firmware Linker tool
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[7.1.0] - 2017-12-08

Core Engine

• [Multi/RX] - Added KF support

Integration

• Fixed SNI-1.3 library name

SOAR

• [RX] - Added support for ELF symbol prefix _

Tools

• Updated Kernel API generator tool with classes filtering

[7.0.0] - 2017-11-07

Core Engine

• Added SNI-1.3 support

• SNI_suspendCurrentJavaThread() is not interruptible via java.lang.Thread.interrupt() anymore

Foundation Libraries

• Updated to SNI-1.3

[6.17.2] - 2017-10-26

Simulator

• Fixed deadlock during bootstrap in some cases

[6.17.1] - 2017-10-25

Core Engine

• Fixed conversion of -0.0 into a positive value

4.3. MicroEJ Architecture 304



MicroEJ Documentation, Revision 2788b3f4

[6.17.0) - 2017-10-10

Tools

• Updated Memory Map Scripts for TRACE library

[6.16.0] - 2017-09-27

Core Engine

• Fixed External Resource Loader link error (introduced in version 6.13.0)

[6.15.0] - 2017-09-12

Core Engine

• Added a new option to configure the maximum number of monitors that can be owned per thread (8 per
thread by default, as it was fixed before)

Foundation Libraries

• Fixed ECOM-COMM internal heap calibration

SOAR

• Added log of the class loading cause

[6.14.2] - 2017-08-24

Tools

• Fixed Firmware Linker tool script (load activity.xml from the wrong folder)

• Fixed load of symbol _java_Ljava_io_EOFException that can be required by some linkers even if this sym-
bol is not touched

[6.14.1] - 2017-08-02

Simulator

• Fixed Device Mockup too long initialization that may block the Front Panel Mockup

Foundation Libraries

• Fixed BON .types.list potential conflicts with KF
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Tools

• Modified Firmware Linker internal scripts structure for new Virtual Devices tools

[6.13.0] - 2017-07-21

Core Engine

• Added support for ej.bon.ResourceBuffer

Foundation Libraries

• Updated to BON-1.3

SOAR

• Added support for *.resourcesext.list (resources excluded from the firmware)

Tools

• Added BON Resource Bu�er generator

[6.12.0] - 2017-07-07

Core Engine

• Added a trace when java.lang.IllegalMonitorStateException is thrown on a monitorexit

Tools

• Added property skip.mergeLibraries for Platform Builder.

• Updated serial PC connector to JSSC v2.8.0

Simulator

• Fixed unexpexted java.lang.NullPointerException in some cases

[6.11.0] - 2017-06-13

Integration

• Fixed useless watchdog library copied in root folder
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[6.11.0-beta1] - 2017-06-02

Core Engine

• Added an option to enable execution traces

• Added Low Level API LLMJVM_MONITOR_impl.h

• Added Low Level API LLTRACE_impl.h

Foundation Libraries

• Added TRACE-1.0

[6.10.0] - 2017-06-02

Core Engine

• Optimized java.lang.Runtime.gc() (removed useless heap compaction in some cases)

[6.9.2] - 2017-06-02

Integration

• Fixed missing properties in release.properties (introduced in version v6.9.1)

• Fixed artifacts build dependencies to private dependencies

[6.9.1] - 2017-05-29

SOAR

• [Multi] - Fixed selected methods list in report generation (removed Kernel related method)

[6.9.0] - 2017-03-15

Base version, included into MicroEJ SDK 4.1.

4.4 MicroEJ Packs

4.4.1 Overview

On top of a MicroEJ Architecture can be imported MicroEJ Packs which provide additional features such as:

• Serial Communications,

• Graphical User Interface,

• Networking,
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• File System,

• etc.

Each MicroEJ Pack is optional and can be selected on demand during theMicroEJ Platform configuration step.

4.4.2 Naming Convention

MicroEJ Packs are distributed in two packages:

• MicroEJ Architecture Specific Pack under the com/microej/architecture/* organization.

• MicroEJ Generic Pack under the com/microej/pack/* organization.

See Pack Import for usage.

Architecture Specific Pack

MicroEJ Architecture Specific Packs contain compiled libraries archives and are thus dependent on the MicroEJ
Architecture and toolchain used in the MicroEJ Platform.

MicroEJ Architecture Specific Packs files ends with the .xpfp extension and are classified using the following
naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]-[NAME]-pack/[VERSION]/[UID]-[NAME]-pack-[VERSION].xpfp

• ISA : instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32, . . . ).

• TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48 ).

• UID : Architecture unique ID (e.g. flopi4G25 ).

• NAME : pack name (e.g. ui ).

• VERSION : pack version (e.g. 13.0.4 ).

For example, MicroEJ Architecture Specific Pack UI versions for Arm® Cortex®-M4 microcontrollers compiled
with GNU CC toolchain are available at https://repository.microej.com/modules/com/microej/architecture/CM4/
CM4hardfp_GCC48/flopi4G25-ui-pack/.

Generic Pack

MicroEJ Generic Packs can be imported on top of any MicroEJ Architecture.

They are classified using the following naming convention:

com/microej/pack/[NAME]/[NAME]-pack/[VERSION]/

• NAME : pack name (e.g. bluetooth ).

• VERSION : pack version (e.g. 2.1.0 ).

For example, MicroEJ Generic Pack Bluetooth versions are available at https://repository.microej.com/modules/
com/microej/pack/bluetooth/bluetooth-pack/.
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Legacy Generic Pack

Legacy MicroEJ Generic Packs files end with the .xpfp extension. These Packs contain one or more Platform
modules. SeePlatformModule Configuration for their configuration. They are classified using the following naming
convention:

com/microej/pack/[NAME]/[VERSION]/[NAME]-[VERSION].xpfp

• NAME : pack name (e.g. net ).

• VERSION : pack version (e.g. 9.2.3 ).

For example, the Legacy MicroEJ Generic Pack NET version 9.2.3 is available at https://repository.microej.com/
modules/com/microej/pack/net/9.2.3/net-9.2.3.xpfp.

4.5 Platform Creation

This section describes the steps to create a new MicroEJ Platform in MicroEJ SDK, and options to connect it to an
external Board Support Package (BSP) as well as a third-party C toolchain.

Note: If you own a legacy Platform, you can either create your Platform again from scratch, or follow the Former
PlatformMigration chapter.

4.5.1 Architecture Selection

The first step is to select aMicroEJ Architecture compatible with your device instructions set and C compiler.

MicroEJ Corp. provides MicroEJ Evaluation Architectures for most common instructions sets and compilers at
https://repository.microej.com/modules/com/microej/architecture.

Please refer to the chapter Architectures MCU / Compiler for the details of ABI and compiler options.

If the requested MicroEJ Architecture is not available for evaluation or to get a MicroEJ Production Architecture,
please contact your MicroEJ sales representative or our support team.

4.5.2 Platform Configuration

The next step is to create a MicroEJ Platform configuration project:

• Select File > New > Project. . . > General > Project ,

• Enter a Project name . The name is arbitrary and can be changed later. The usual convention is
[PLATFORM_NAME]-configuration ,

• Click on Finish button. A new empty project is created,

• Install the latest Platform Configuration Additions. Files within the content folder have to be copied
to the configuration project folder, by following instructions described at https://github.com/MicroEJ/
PlatformQualificationTools/blob/master/framework/platform/README.rst.

You should get a MicroEJ Platform configuration project that looks like:
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Fig. 8: MicroEJ Platform Configuration Project Skeleton

Note: The version of installed Platform Configuration Additions is indicated in the CHANGELOG file.

• Edit theModule Description File module.ivy to declare the MicroEJ Architecture dependency:

<dependencies>

<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]" rev="[VERSION]">
<artifact name="[UID]" m:classifier="[USAGE]" ext="xpf"/>

</dependency>

</dependencies>

For example, to declare the MicroEJ Evaluation Architecture version 7.14.0 for Arm® Cortex®-M4microcon-
trollers compiled with GNU CC toolchain:

<dependencies>

<dependency org="com.microej.architecture.CM4.CM4hardfp_GCC48" name="flopi4G25" rev="7.14.0">
<artifact name="flopi4G25" m:classifier="eval" ext="xpf"/>

</dependency>

</dependencies>

4.5.3 Pack Import

MicroEJ Pack provides additional features on top of the MicroEJ Architecture such as Graphical User Interface or
Networking.

Note: MicroEJ Packs are optional. You can skip this section if you intend to integrate MicroEJ runtime only with
custom libraries.

4.5. Platform Creation 310

https://github.com/MicroEJ/PlatformQualificationTools/blob/master/framework/platform/content/build/CHANGELOG.md


MicroEJ Documentation, Revision 2788b3f4

To declare a MicroEJ Pack dependency, edit theModule Description File module.ivy as follows:

<dependencies>
<!-- MicroEJ Architecture Specific Pack -->
<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]-[NAME]-pack" rev="[VERSION]

→˓"/>

<!-- MicroEJ Generic Pack -->
<dependency org="com.microej.pack.[NAME]" name="[NAME]-pack" rev="[VERSION]"/>

<!-- Legacy MicroEJ Generic Pack -->
<dependency org="com.microej.pack" name="[NAME]" rev="[VERSION]"/>

</dependencies>

For example, to declare the MicroEJ Architecture Specific Pack UI version 13.0.4 for MicroEJ Architecture
flopi4G25 on Arm® Cortex®-M4microcontrollers compiled with GNU CC toolchain:

<dependencies>
<!-- MicroEJ Architecture Specific Pack -->
<dependency org="com.microej.architecture.CM4.CM4hardfp_GCC48" name="flopi4G25-ui-pack" rev="13.0.4

→˓"/>

</dependencies>

To declare the MicroEJ Generic Pack Bluetooth version 2.1.0 :

<dependencies>
<!-- MicroEJ Generic Pack -->
<dependency org="com.microej.pack.bluetooth" name="bluetooth-pack" rev="2.1.0"/>

</dependencies>

And to declare the Legacy MicroEJ Generic Pack Net version 9.2.3 :

<dependencies>
<!-- Legacy MicroEJ Generic Pack -->
<dependency org="com.microej.pack" name="net" rev="9.2.3"/>

</dependencies>

Warning: MicroEJ Architecture Specific Packs and LegacyMicroEJ Generic Packs provide Platformmodules that
are not installed by default. See PlatformModule Configuration section for more details.

4.5.4 Platform Build

TheMicroEJ Platform can be built either from the SDK or from theMMMCLI. To build theMicroEJ Platform from the
SDK, perform a regularModule Build:

• Right-click on the Platform Configuration project,

• Select Build Module .

To build the MicroEJ Platform from the MMM CLI:
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• Set the eclipse.home property to the path of your SDK, using -Declipse.home=<path> in the command
line or using the Shared configuration.

• Execute the command: mmm

In both cases the build starts and the build logs are redirected to the integrated console. Once the build is termi-
nated, you should get the following message:

module-platform:report:
[echo] ␣

→˓============================================================================================================
[echo] Platform has been built in this directory 'C:\tmp\mydevice-Platform-[TOOLCHAIN]-

→˓0.1.0'.
[echo] To import this project in your MicroEJ SDK workspace (if not already available):
[echo] - Select 'File' > 'Import...' > 'General' > 'Existing Projects into Workspace'␣

→˓> 'Next'
[echo] - Check 'Select root directory' and browse 'C:\tmp\mydevice-Platform-

→˓[TOOLCHAIN]-0.1.0' > 'Finish'
[echo] ␣

→˓============================================================================================================

BUILD SUCCESSFUL

Total time: 43 seconds

Then, import the Platform directory to your MicroEJ SDK workspace as mentioned in the report. You should
get a ready-to-use MicroEJ Platform project in the workspace available for the MicroEJ Application project to
run on. You can also check the MicroEJ Platform availability in: Window > Preferences > MicroEJ >
Platforms in workspace .
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Fig. 9: MicroEJ Platform Project

This step is only required the first time the Platform is built, or if the Platform properties have changed (i.e, name,
version). When the same Platform is built again, the Platform project should be automatically refreshed a�er few
seconds. In case of any doubt, right-click on the Platform project and select Refresh to get the new content.

4.5.5 PlatformModule Configuration

A Platformmodule is the minimal unit that can extend a MicroEJ Architecture with additional features such as:

• Runtime Capability (e.g. Multi-Sandbox, External Resources Loader) ,

• Foundation Library Implementation (e.g. MicroUI, NET),

• Simulator (e.g. Front Panel Mock),

• Tool (e.g. MicroEJ Java H).

Platformmodules provided byMicroEJ Generic Packs are automatically installed during the Platform build and do
not require extra configuration. They are not displayed in the Platform Editor.
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PlatformmodulesprovidedbyMicroEJArchitectures,MicroEJArchitectureSpecificPacksandLegacyMicroEJGeneric
Packs following list are not installed by default. They must be enabled and configured using the Platform Editor.

Before opening the Platform Editor, the Platformmust have been built once to letMicroEJModuleManager resolve
and download MicroEJ Architecture and Packs locally. Then import them in MicroEJ SDK as follows:

• Select File > Import > MicroEJ > Architectures ,

• Browse myplatform-configuration/target~/dependencies folder (contains .xpf and .xpfp files once the
Platform is built),

• Check the I agree and accept the above terms and conditions. . . box to accept the license,

• Click on Finish button. This may take some time.

Once imported, double-click on the default.platform file to open the Platform Editor.

From the Platform Editor, select the Content tab to access the modules selection. Platform modules can be
selected/deselected from the Modules frame.

Platformmodules are organized into groups. When a group is selected, by default, all its modules are selected. To
view all themodulesmaking up a group, click on the Expand All icon on the top-right of the frame. This will let you
select/deselect on a per module basis. Note that individual module selection is not recommended and that it is
only available when the module have been imported.

The description and contents of an item (group or module) are displayed beside the list on item selection.

All the selected Platformmodules will be installed in the Platform.
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Fig. 10: MicroEJ Platform Configuration Modules Selection

Each selected Platformmodule can be customized by creating a [module] folder named a�er themodule beside

the .platform file definition. It may contain:

• A [module].properties file named a�er the module name. These properties will be injected in the execu-
tion context prefixed by the module name. Some properties might be needed for the configuration of some
modules. Please refer to the modules documentation for more information.

• A bsp.xml file which provides additional information about the BSP implementation of Low Level APIs.

This file must start with the node <bsp> . It can contain several lines like this one:
<nativeName="A_LLAPI_NAME" nativeImplementation name="AN_IMPLEMENTATION_NAME"/>

where:

– A_LLAPI_NAME refers toaLowLevelAPInativename. It is specific to theMicroEJC librarywhichprovides
the Low Level API.

– AN_IMPLEMENTATION_NAME refers to the implementation name of the Low Level API. It is specific to the
BSP; and more specifically, to the C file which does the link between the MicroEJ C library and the C
driver.

These files will be converted into an internal format during the MicroEJ Platform build.

• Optional module specific files and folders
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Modifying one of these files requires to build the Platform again.

Note: It is possible to quickly rebuild the Platform from the Platform Editor if only Platformmodule configuration
has changed. Click on the Build Platform link on the Platform configuration Overview tab.

4.5.6 Platform Customization

The configurationproject (theprojectwhich contains the .platform file) can contain anoptional dropins folder.
The contents of this folder will be copied integrally into the final Platform. This feature allows to add some addi-
tional libraries, tools etc. into the Platform.

The dropins folder organization should respect the final Platform files and folders organization. For instance, the
tools are located in the sub-folder tools . Launch a Platform build without the dropins folder to see how the
Platform files and folders organization is. Then fill the dropins folder with additional features and build again the
Platform to obtain an advanced Platform.

The dropins folder files are kept in priority. If one file has the same path and name as another file already installed
into the Platform, the dropins folder file will be kept.

Platform build can also be customized by updating the configuration.xml file beside the .platform file. This
Ant script can extend one or several of the extension points available. By default, you should not have to change
the default configuration script.

Modifying one of these files requires to build the Platform again.

4.5.7 BSP Connection

Principle

Using a MicroEJ Platform, the user can compile a MicroEJ Application on that Platform. The result of this compila-
tion is a microejapp.o file.

This file has to be linked with the MicroEJ Platform runtime file ( microejruntime.a ) and a third-party C project,
called the Board Support Package (BSP), to obtain the final binary file (MicroEJ Firmware). For more information,
please consult theMicroEJ build process overview.

The BSP connection can be configured by defining 4 folders where the following files are located:

• MicroEJ Application file ( microejapp.o ).

• MicroEJ Platform runtime file ( microejruntime.a , also available in the Platform lib folder).

• MicroEJ Platform header files ( *.h , also available in the Platform include folder).

• BSP project build script file ( build.bat or build.sh ).

Once the MicroEJ Application file ( microejapp.o ) is built, the files are then copied to these locations and the
build.bat or build.sh file is executed to produce the final executable file ( application.out ).

Note: The final build stage to produce the executable file can be done outside of MicroEJ SDK, and thus the BSP
connection configuration is optional.

BSP connection configuration is only required in the following cases:

• Use MicroEJ SDK to produce the final executable file of a Mono-Sandbox Firmware (recommended).
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• Use MicroEJ SDK to run aMicroEJ Test Suite on device.

• Build a Multi-Sandbox Firmware.

MicroEJ provides a flexible way to configure the BSP connection to target any kind of projects, teams organizations
and company build flows. To achieve this, the BSP connection can be configured either at MicroEJ Platform level
or at MicroEJ Application level (or a mix of both).

The 3 most common integration cases are:

• Case 1: No BSP connection

The MicroEJ Platform does not know the BSP at all.

BSP connection can be configured when building the MicroEJ Application (absolute locations).

Fig. 11: MicroEJ Platform with no BSP connection

This case is recommended when:

– the MicroEJ Firmware is built outside MicroEJ SDK.

– the same MicroEJ Platform is intended to be reused on multiple BSP projects which do not share the
same structure.

• Case 2: Partial BSP connection

The MicroEJ Platform knows how the BSP is structured.

BSP connection is configuredwhenbuilding theMicroEJ Platform (relative locationswithin theBSP), and the
BSP root location is configured when building the MicroEJ Application (absolute directory).

Fig. 12: MicroEJ Platform with partial BSP connection

This case is recommended when:
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– the MicroEJ Platform is used to build one MicroEJ Application on top of one BSP.

– the Application and BSP are slightly coupled, thusmaking a change in the BSP just requires to build the
firmware again.

• Case 3: Full BSP connection

The MicroEJ Platform includes the BSP.

BSP connection is configured when building MicroEJ Platform (relative locations within the BSP), as well as
the BSP root location (absolute directory). No BSP connection configuration is required when building the
MicroEJ Application.

Fig. 13: MicroEJ Platform with full BSP connection

This case is recommended when:

– the MicroEJ Platform is used to build various MicroEJ Applications.

– the MicroEJ Platform is validated using MicroEJ test suites.

– the MicroEJ Platform and BSP are delivered as a single standalonemodule (same versioning), perhaps
subcontracted to a team or a company outside the application project(s).

Options

BSP connection options can be specified as Platform options or as Application options or a mix of both.

The following table describes the Platform options, which can be set in the bsp/bsp.properties file of the Plat-
form configuration project.
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Table 1: MicroEJ Platform Options for BSP Connection
Option
Name

Description Example

microejapp.
relative.
dir

The path relative to BSP root.dir where to deploy the Mi-
croEJ Application file ( microejapp.o ). MicroEJ/lib

microejlib.
relative.
dir

The path relative to BSP root.dir where to deploy the Mi-
croEJ Platform runtime file ( microejruntime.a ). MicroEJ/lib

microejinc.
relative.
dir

The path relative to BSP root.dir where to deploy the Mi-
croEJ Platform header files ( *.h ). MicroEJ/inc

microejscript.
relative.
dir

The path relative to BSP root.dir where to execute the BSP
build script file ( build.bat or build.sh ). Project/MicroEJ

root.
dir

The 3rd-party BSP project absolute directory, to be included
to the Platform. c:\\Users\\user\\mybsp onWin-

dows systems or /home/user/bsp
on Unix systems.

The following table describes the Application options, which can be set as regularMicroEJ Application Options.

Table 2: MicroEJ Application Options for BSP Connection
Option Name Description

deploy.bsp.
microejapp

Deploy the MicroEJ Application file ( microejapp.o ) to the location defined by the Platform
(defaults to true when Platform option microejapp.relative.dir is set).

deploy.bsp.
microejlib

Deploy the MicroEJ Platform runtime file ( microejruntime.a ) to the location defined by
the Platform (defaults to true when Platform option microejlib.relative.dir is set).

deploy.bsp.
microejinc

Deploy the MicroEJ Platform header files ( *.h ) to the location defined by the Platform (de-
faults to true when Platform option microejinc.relative.dir is set).

deploy.bsp.
microejscript

Execute the BSP build script file ( build.bat or build.sh ) at the location specified by the
Platform. (defaults to false and requires microejscript.relative.dir Platform option
to be set).

deploy.bsp.
root.dir

The 3rd-party BSP project absolute directory. This option is required if at least one the 4
options described above is set to true and the Platform does not include the BSP.

deploy.dir.
microejapp

Absolute path to the directory where to deploy the MicroEJ Application file ( microejapp.o
). An empty value means no deployment.

deploy.dir.
microejlib

Absolute path to the directory where to deploy the MicroEJ Platform runtime file (
microejruntime.a ) to this absolute directory. An empty value means no deployment.

deploy.dir.
microejinc

Absolute path to the directory where to deploy the MicroEJ Platform header files ( *.h ) to
this absolute directory. An empty value means no deployment.

deploy.dir.
microejscript

Absolutepath to thedirectory that contains theBSPbuild script file (build.bat or build.sh
). An empty value means no build script execution.
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Note: It is also possible to configure the BSP root directory by setting the build option toolchain.dir , instead
of the application option deploy.bsp.root.dir . This allows to configure a MicroEJ Firmware by specifying both
the Platform (using the target.platform.dir option) and the BSP at build level, without having to modify the
application options files.

For each Platform BSP connection case, here is a summary of the options to set:

• No BSP connection, executable file built outside MicroEJ SDK

Platform Options:
[NONE]

Application Options:
[NONE]

• No BSP connection, executable file built using MicroEJ SDK

Platform Options:
[NONE]

Application Options:
deploy.dir.microejapp=[absolute_path]
deploy.dir.microejlib=[absolute_path]
deploy.dir.microejinc=[absolute_path]
deploy.bsp.microejscript=[absolute_path]

• Partial BSP connection, executable file built outside MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]

• Partial BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]
deploy.bsp.microejscript=true

• Full BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]
root.dir=[absolute_path]

(continues on next page)
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(continued from previous page)

Application Options:
deploy.bsp.microejscript=true

Build Script File

The BSP build script file is used to invoke the third-party C toolchain (compiler and linker) to produce the final
executable file ( application.out ).

The build script must comply with the following specification:

• OnWindows operating system, it is a Windows batch file named build.bat .

• On Mac OS X or Linux operating systems, it is a shell script named build.sh , with execution permission
enabled.

• On error, the script must end with a non zero exit code.

• On success

– The executablemust be copied to a file named application.out in the directory fromwhere the script
has been executed.

– The script must end with zero exit code.

Many build script templates are available formost commonly used C toolchains in the PlatformQualification Tools
repository.

Note: The final executable file must be an ELF executable file. On Unix, the command file(1) can be use to
check the format of a file. For example:

~$ file application.out
ELF 32-bit LSB executable

Run Script File

This script is required only for Platforms intended to run aMicroEJ Testsuite on device.

The BSP run script is used to invoke a third-party tool to upload and start the executable file on device.

The run script must comply with the following specification:

• OnWindows operating system, it is a Windows batch file named run.bat .

• On Mac OS X or Linux operating systems, it is a shell script named run.sh , with execution permission en-
abled.

• The executable file is passed as first script parameter if there is one, otherwise it is the application.out file
located in the directory fromwhere the script has been executed.

• On error, the script must end with a non zero exit code.

• On success:

– The executable file ( application.out ) has been uploaded and started on the device

– The script must end with zero exit code.
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The run script can optionally redirect execution traces. If it does not implement execution traces redirection, the
testsuite must be configured with the following Application Options in order to take its input from a TCP/IP socket
server, such as Serial to Socket Transmitter.

testsuite.trace.ip=localhost
testsuite.trace.port=5555

4.6 Platform Qualification

4.6.1 Introduction

A MicroEJ Platform integrates one or more Foundation Libraries with their respective Abstraction Layers.

Platform Qualification is the process of validating the conformance of the Abstraction Layer that implements the
Low Level APIs of a Foundation Library.

Fig. 14: Platform Qualification Overwiew
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For each Low Level API, an Abstraction Layer implementation is required. The validation of the Abstraction Layer
implementation is performed by running tests at two-levels:

• In C, by calling Low Level APIs (usually manually).

• In Java, by calling Foundation Library APIs (usually automatically using Platform Test Suite).

The following figure depicts an example for the FS Pack:

Fig. 15: Platform Qualification Example for FS Pack

MicroEJ provides a set of tools and pre-defined projects aimed at simplifying the steps for validating Platforms in
the form of the Platform Qualification Tools (PQT).

4.6.2 Platform Qualification Tools Overview

The Platform Qualification Tools provide the following components:

• Platform Configuration Additions (PCA):

– Used to:

* ManageMicroEJ Architecture, MicroEJ Packs and the Platformbuildwith theMicroEJModuleMan-
ager.
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* Configure the BSP connection to call the build and run scripts.

– Addedwhen creating a Platform (see Platform Creation or check the tutorial Create aMicroEJ Firmware
From Scratch).

• Build and Run Scripts examples:

– Used to generate and deploy aMicroEJ Firmware on a device by invoking a third-party toolchain for the
BSP

– Added when integrating the BSP to the Platform (see Build Script File and Run Script File or check the
tutorial Create MicroEJ Platform Build and Run Scripts).

• C and Java Test Suites:

– Used to validate the Low Level APIs implementations

– Validated during the BSP development andwhenever an Abstraction Layer implementation is added or
changed (see Platform Test Suite or check the tutorial Run a Test Suite on a Device).

Please refer to the Platform Qualification Tools README for more details and the location of the components.

4.6.3 Platform Test Suite

The purpose of a MicroEJ Platform Test Suite is to validate the Abstraction Layer that implements the Low Level
APIs of a Foundation Libraries by automatically running Java tests on the device.

TheMicroEJ Test Suite Engine is used for building, running a Test Suite, and providing a report.

A Platform Test Suite contains one or more tests. For each test, the Test Suite Engine will:

1. Build a MicroEJ Firmware for the test.

2. Program the MicroEJ Firmware onto the device.

3. Retrieve the execution traces.

4. Analyze the traces to determine whether the test has PASSED or FAILED .

5. Append the result to the Test Report.

6. Repeat until all tests of the Test Suite have been executed.
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Fig. 16: Platform Test Suite on Device Overview

4.6.4 Test Suite Versioning

Foundation Libraries are integrated in a MicroEJ Platform by MicroEJ Packs (see Pack Import). Use the Test Suite
version compliant with the Foundation Library version to validate the Abstraction Layer implementation. For ex-
ample, the Test Suite FSmodule 3.0.3 should be used to validate the Abstraction Layer implementation of the Low
Level API FS provided by the FS Pack 5.1.2.

Note: A MicroEJ Pack can provide several Foundation Libraries.

Core Engine

Table 3: Core Engine Validation
Architecture Test Suite
7.0.0 or higher Core Engine Test Suite

UI Pack

Table 4: UI Validation
UI Pack C Test Suite
13.0.0 or higher (UI3) Graphical User Interface Test Suite
[6.0.0-12.1.5] (UI2) Graphical User Interface Test Suite
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FS Pack

Table 5: FS API Implementation and Validation
FS Pack FS API Java Test Suite
[5.1.2-5.2.0[ 2.0.6 3.0.3
[4.0.0-4.1.0[ 2.0.6 On demand1

BLUETOOTH Pack

Table 6: BLUETOOTH API Implementation and Validation
BLUETOOTH Pack BLUETOOTH API Java Test Suite
2.1.0 2.1.0 2.0.0
2.0.1 2.0.0 2.0.0

NET/SSL Pack

On demand1.

4.7 MicroEJ Core Engine

The MicroEJ Core Engine (also called the platform engine) and its components represent the core of the platform.
It is used to compile and execute at runtime the MicroEJ Application code.

4.7.1 Functional Description

The following diagram shows the overall process. The first two steps are performedwithin theMicroEJWorkbench.
The remaining steps are performed within the C IDE.

1 Test Suite available on demand, please contactMicroEJ Support.
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Fig. 17: MicroEJ Core Engine Flow

1. Step 1 consists inwriting aMicroEJ Application against a set of Foundation Libraries available in the platform.

2. Step 2 consists in compiling the MicroEJ Application code and the required libraries in an ELF library, using
the SOAR.

3. Step 3 consists in linking the previous ELF file with theMicroEJ Core Engine library and a third-party BSP (OS,
drivers, etc.). This step may require a third-party linker provided by a C toolchain.

4.7.2 Architecture

The MicroEJ Core Engine and its components have been compiled for one specific CPU architecture and for use
with a specific C compiler.

The architecture of the platform engine is called green thread architecture, it runs in a single RTOS task. Its be-
havior consists in scheduling MicroEJ threads. The scheduler implements a priority preemptive scheduling policy
with round robin for the MicroEJ threads with the same priority. In the following explanations the term “RTOS
task” refers to the tasks scheduled by the underlying OS; and the term “MicroEJ thread” refers to the Java threads
scheduled by the MicroEJ Core Engine.
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Fig. 18: A Green Threads Architecture Example

The activity of the platform is defined by the MicroEJ Application. When the MicroEJ Application is blocked (when
all MicroEJ threads are sleeping), the platform sleeps entirely: The RTOS task that runs the platform sleeps.

The platform is responsible for providing the time to the MicroEJ world: the precision is 1 millisecond.

4.7.3 Capabilities

MicroEJ Core Engine defines 3 exclusive capabilities:

• Mono-sandbox: capability to produce a monolithic firmware (default one).

• Multi-Sandbox: capability to produce a extensible firmware on which new applications can be dynamically
installed. See sectionMulti-Sandbox.

• Tiny application: capability to produce a compacted firmware (optimized for size). See section Tiny Applica-
tion.

All MicroEJ Core Engine capabilities may not be available on all architectures. Refer to section Supported MicroEJ
Core Engine Capabilities by Architecture Matrix for more details.

4.7.4 Implementation

The MicroEJ Core Engine implements the [SNI] specification. It is created and initialized with the C function
SNI_createVM . Then it is started and executed in the current RTOS task by calling SNI_startVM . The function
SNI_startVM returns when the MicroEJ Application exits or if an error occurs (see section Error Codes). The func-
tion SNI_destroyVM handles the platform termination.

The file LLMJVM_impl.h that comes with the platform defines the API to be implemented. See section LLMJVM:
MicroEJ Core Engine.
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Initialization

The Low Level MicroEJ Core Engine API deals with two objects: the structure that represents the platform, and the
RTOS task that runs the platform. Two callbacks allow engineers to interact with the initialization of both objects:

• LLMJVM_IMPL_initialize : Called once the structure representing the platform is initialized.

• LLMJVM_IMPL_vmTaskStarted : Called when the platform starts its execution. This function is called within
the RTOS task of the platform.

Scheduling

To support the green thread round-robinpolicy, theplatformassumes there is anRTOS timer or someothermecha-
nism that counts (down) and fires a call-backwhen it reachesa specified value. Theplatform initializes the timerus-
ing the LLMJVM_IMPL_scheduleRequest functionwith one argument: the absolute time atwhich the timer should
fire. When the timer fires, it must call the LLMJVM_schedule function, which tells the platform to execute a green
thread context switch (which gives another MicroEJ thread a chance to run).

Idle Mode

When the platform has no activity to execute, it calls the LLMJVM_IMPL_idleVM function, which is assumed to put
the RTOS task of the platform into a sleep state. LLMJVM_IMPL_wakeupVM is called to wake up the platform task.
When theplatformtask really starts toexecuteagain, it calls the LLMJVM_IMPL_ackWakeup function toacknowledge
the restart of its activity.

Time

The platform defines two times:

• the application time: Thedi�erence,measured inmilliseconds, between the current time andmidnight, Jan-
uary 1, 1970, UTC.

• the system time: The time since the start of the device. This time is independent of any user considerations,
and cannot be set.

The platform relies on the following C functions to provide those times to the MicroEJ world:

• LLMJVM_IMPL_getCurrentTime : Depending on the parameter ( true / false ) must return the application
time or the system time. This function is called by the MicroEJmethod System.currentTimeMillis() . It is
also used by the platform scheduler, and should be implemented e�iciently.

• LLMJVM_IMPL_getTimeNanos : must return the system time in nanoseconds.

• LLMJVM_IMPL_setApplicationTime : must set the di�erence between the current time and midnight, Jan-
uary 1, 1970, UTC.

Error Codes

The C function SNI_createVM returns a negative value if an error occurred during the MicroEJ Core Engine ini-
tialization or execution. The file LLMJVM.h defines the platform-specific error code constants. The following table
describes these error codes.
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Table 7: MicroEJ Core Engine Error Codes
Error Code Meaning
0 The MicroEJ Application ended normally (i.e., all the

non-daemon threads are terminated or System.
exit(exitCode) has been called). See section Exit
Codes.

-1 The microejapp.o produced by SOAR is not compati-
ble with the MicroEJ Core Engine ( microejruntime.a
). The object file has been built from another MicroEJ
Platform.

-2 Internal error. Invalid link configuration in theMicroEJ
Architecture or the MicroEJ Platform.

-3 Evaluation version limitations reached: termination of
the application. See section Limitations.

-5 Not enough resources to start the very first MicroEJ
thread that executes main method. See section Op-
tion(text): Java heap size (in bytes).

-12 Number of threads limitation reached. See sections
Limitations and Option(text): Number of threads.

-13 Fail to start theMicroEJApplicationbecause the speci-
fiedMicroEJ heap is too large or too small. See section
Option(text): Java heap size (in bytes).

-14 Invalid MicroEJ Application stack configuration. The
stack start or end is not eight-byte aligned, or stack
block size is too small. See section Option(text): Num-
ber of blocks in pool.

-16 The MicroEJ Core Engine cannot be restarted.
-17 TheMicroEJ Core Engine is not in a valid state because

of one of the following situations:
• SNI_startVM called before SNI_createVM .
• SNI_startVM called while the MicroEJ Apppli-
cation is running.

• SNI_createVM called several times.

-18 The memory used for the MicroEJ heap or immor-
tal heap does not work properly. Read/Write mem-
ory checks failed. This may be caused by an invalid
external RAM configuration. Verify _java_heap and
_java_immortals sections locations.

-19 The memory used for the MicroEJ Application static
fields does not work properly. Read/Write memory
checks failed. This may be caused by an invalid exter-
nal RAM configuration. Verify .bss.soar section lo-
cation.

-20 KF configuration internal error. Invalid link configura-
tion in the MicroEJ Architecture or the MicroEJ Plat-
form.

-21 Number of monitors per thread limitation reached.
See sections Limitations and Options .

-22 Internal error. Invalid FPUconfiguration in theMicroEJ
Architecture.

-23 The function LLMJVM_IMPL_initialize defined in
the Abstraction Layer implementation returns an er-
ror.

-24 The function LLMJVM_IMPL_vmTaskStarted defined
in theAbstraction Layer implementation returns aner-
ror.

-25 The function LLMJVM_IMPL_shutdown defined in the
Abstraction Layer implementation returns an error.
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Example

The following example shows how to create and launch the MicroEJ Core Engine from the C world. This function (
microej_main ) should be called from a dedicated RTOS task.

#include <stdio.h>
#include "microej_main.h"
#include "LLMJVM.h"
#include "sni.h"

#ifdef __cplusplus
extern "C" {

#endif

/**
* @brief Creates and starts a MicroEJ instance. This function returns when the MicroEJ execution ends.
*/
void microej_main(int argc, char **argv)
{

void* vm;
int32_t err;
int32_t exitcode;

// create VM
vm = SNI_createVM();

if(vm == NULL)
{

printf("MicroEJ initialization error.\n");
}
else
{

printf("MicroEJ START\n");

// Error codes documentation is available in LLMJVM.h
err = SNI_startVM(vm, argc, argv);

if(err < 0)
{

// Error occurred
if(err == LLMJVM_E_EVAL_LIMIT)
{

printf("Evaluation limits reached.\n");
}
else
{

printf("MicroEJ execution error (err = %d).\n", err);
}

}
else
{

// VM execution ends normally
exitcode = SNI_getExitCode(vm);
printf("MicroEJ END (exit code = %d)\n", exitcode);

}

// delete VM
SNI_destroyVM(vm);

(continues on next page)
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}
}

#ifdef __cplusplus
}

#endif

Debugging

The internalMicroEJCore Engine function called LLMJVM_dump allows you todump the state of allMicroEJ threads:
name, priority, stack trace, etc. This function can be called at any time and from an interrupt routine (for instance
from a button interrupt).

This is an example of a dump:

============ VM Dump ============
2 java threads
---------------------------------
Java Thread[3]
name="SYSINpmp" prio=5 state=WAITING

java/lang/Thread:
at com/is2t/microbsp/microui/natives/NSystemInputPump.@134261800

[0x0800AC32]
at com/is2t/microbsp/microui/io/SystemInputPump.@134265968

[0x0800BC80]
at ej/microui/Pump.@134261696

[0x0800ABCC]
at ej/microui/Pump.@134265872

[0x0800BC24]
at java/lang/Thread.@134273964

[0x0800DBC4]
at java/lang/Thread.@134273784

[0x0800DB04]
at java/lang/Thread.@134273892

[0x0800DB6F]
---------------------------------
Java Thread[2]
name="DISPLpmp" prio=5 state=WAITING

java/lang/Thread:
at java/lang/Object.@134256392

[0x08009719]
at ej/microui/FIFOPump.@134259824

[0x0800A48E]
at ej/microui/io/DisplayPump.134263016

[0x0800B0F8]
at ej/microui/Pump.@134261696

[0x0800ABCC]
at ej/microui/Pump.@134265872

[0x0800BC24]
at ej/microui/io/DisplayPump.@134262868

[0x0800B064]
at java/lang/Thread.@134273964

[0x0800DBC4]

(continues on next page)
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at java/lang/Thread.@134273784
[0x0800DB04]

at java/lang/Thread.@134273892
[0x0800DB6F]
=================================

See Stack Trace Reader for additional info related to working with VM dumps.

4.7.5 Generic Output

The System.err stream is connected to the System.out print stream. See below for how to configure the desti-
nation of these streams.

4.7.6 Link

Several sections are defined by the MicroEJ Core Engine. Each section must be linked by the third-party linker.

Table 8: Linker Sections
Section name Aim Location Alignment (in bytes)

.bss.features.installed
System Applications statics RW 4

.bss.soar
Application static RW 8

.bss.vm.stacks.java
Application threads stack blocks RW 8

ICETEA_HEAP
MicroEJ Core Engine internal heap Internal RW 8

_java_heap
Application heap RW 4

_java_immortals
Application immortal heap RW 4

.rodata.resources
Application resources RO 16

.rodata.soar.features
System Applications code and resources RO 4

.shieldedplug
Shielded Plug data RO 4

.text.soar
Application and library code RO 16

Note: Sections ICETEA_HEAP , _java_heap and _java_immortals are zero-initialized at MicroEJ Core Engine
startup.

4.7.7 Dependencies

The MicroEJ Core Engine requires an implementation of its low level APIs in order to run. Refer to the chapter
Implementation for more information.
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4.7.8 Installation

The MicroEJ Core Engine and its components are mandatory. In the platform configuration file, check
Multi Applications to install the MicroEJ Core Engine in “Multi-Sandbox” mode. Otherwise, the “Single appli-
cation” mode is installed.

4.7.9 Use

The EDC API Module must be added to themodule.ivy of the MicroEJ Application Project. This MicroEJ module is
always required in the build path of a MicroEJ project; and all others libraries depend on it. This library provides a
set of options. Refer to the chapter Application Optionswhich lists all available options.

<dependency org="ej.api" name="edc" rev="1.3.3"/>

The BONAPI Modulemust also be added to themodule.ivy of theMicroEJ Application project in order to access the
[BON] library.

<dependency org="ej.api" name="bon" rev="1.4.0"/>

4.8 Multi-Sandbox

4.8.1 Principle

TheMulti-Sandbox capability of theMicroEJCore Engine allows amain application (called Standalone Application)
to install and execute at runtime additional applications (called sandboxed applications).

The MicroEJ Core Engine implements the [KF] specification. A Kernel is a Standalone Application generated on a
Multi-Sandbox-enabled platform. A Feature is a sandboxed application generated against a Kernel.

A sandboxed application may be dynamically downloaded at runtime or integrated at build-time within the exe-
cutable application.

Note that the Multi-Sandbox is a capability of the MicroEJ Core Engine. The MicroEJ Simulator always runs an
application as a Standalone Application.

4.8.2 Functional Description

The Multi-Sandbox process extends the overall process described in the overview of the platform process.

4.8. Multi-Sandbox 334

https://repository.microej.com/modules/ej/api/edc/
https://repository.microej.com/modules/ej/api/bon/


MicroEJ Documentation, Revision 2788b3f4

Fig. 19: Multi-Sandbox Process

Once a Kernel has been generated, additional MicroEJ Application code (Feature) can be built against the Kernel
by :

• Creating one launch configuration per feature.

• Setting the Settings field in the Execution tab of each feature launch configuration to

Build Dynamic Feature .

• Setting the Kernel field in the Configuration tab of each feature launch configuration to the . . . .

using the MicroEJ Application launch named Build Dynamic Feature. The binary application file produced (
application.fo ) is compatible only for the Kernel on which it was generated. Generating a new Kernel requires
that you generate the Features again on this Kernel.

The Features built can be deployed in the following ways:

• Downloaded and installed at runtime by so�ware. Refer to the [KF] specification for ej.kf.Kernel install
APIs.

• Linked at build-time into the executable application. Features linked this way are then called Installed Fea-
tures. The Kernel should have been generatedwith options for dimensioning themaximum size (code, data)
for such Installed Features. Features are linked within the Kernel using the Firmware linker tool.

4.8.3 Firmware Linker

A MicroEJ tool is available to link Features as Installed Features within the executable application. The tool name
is Firmware Linker. It takes as input the executable application file and the Feature binary code into which to be
linked. It outputs a newexecutable application file, including the Installed Feature. This tool canbeused to append
multiple Features, by setting as the input file the output file of the previous pass.
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4.8.4 Memory Considerations

Multi-Sandbox memory overhead of MicroEJ Core Engine runtime elements are described in the table below.

Table 9: Multi-Sandbox Memory Overhead
Runtime element Memory Description
Object RW 4 bytes
Thread RW 24 bytes
Stack Frame RW 8 bytes
Class Type RO 4 bytes
Interface Type RO 8 bytes

4.8.5 Dependencies

• LLKERNEL_impl.h implementation (see LLKERNEL: Multi-Sandbox).

4.8.6 Installation

Multi-Sandbox is an additional module, disabled by default.

To enable Multi-Sandbox of the MicroEJ Core Engine, in the platform configuration file, check Multi Applications
.

4.8.7 Use

The KF API Module must be added to themodule.ivy of the MicroEJ Application project to use [KF] library.

<dependency org="ej.api" name="kf" rev="1.4.4"/>

This library provides a set of options. Refer to the chapter Application Optionswhich lists all available options.

4.9 Tiny Application

4.9.1 Principle

The Tiny application capability of the MicroEJ Core Engine allows to build a main application optimized for size.
This capability is suitable for environments requiring a small memory footprint.

4.9.2 Installation

Tiny application is an option disabled by default. To enable Tiny application of the MicroEJ Core Engine, set the
property mjvm.standalone.configuration in configuration.xml file as follows:

<property name="mjvm.standalone.configuration" value="tiny"/>

See section Platform Customization for more info on the configuration.xml file.
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4.9.3 Limitations

In addition to general Limitations:

• The maximum application code size (classes and methods) cannot exceed 256KB . This does not include
application resources, immutable objects and internal strings which are not limited.

• The option SOAR > Debug > Embed all type names has no e�ect. Only the fully qualified names of
types marked as required types are embedded.

4.10 Native Interface Mechanisms

TheMicroEJ Core Engine provides twoways to link MicroEJ Application code with native C code. The twoways are
fully complementary, and can be used at the same time.

4.10.1 Simple Native Interface (SNI)

Principle

[SNI] provides a simple mechanism for implementing native Java methods in the C language.

[SNI] allows you to:

• Call a C function from a Java method.

• Access an Immortal array in a C function (see the [BON] specification to learn about immortal objects).

[SNI] does not allow you to:

• Access or create a Java object in a C function.

• Access Java static variables in a C function.

• Call Java methods from a C function.

[SNI] provides some Java APIs to manipulate some data arrays between Java and the native (C) world.

Functional Description

[SNI] defines how to cross the barrier between the Java world and the native world:

• Call a C function from Java.

• Pass parameters to the C function.

• Return a value from the C world to the Java world.

• Manipulate (read & write) sharedmemory both in Java and C: the immortal space.
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Fig. 20: [SNI] Processing

The above illustration shows both Java and C code accesses to shared objects in the immortal space, while also
accessing their respective memory.

Example

package example;

import java.io.IOException;

/**
* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.
*/
public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {

(continues on next page)

4.10. Native Interface Mechanisms 338



MicroEJ Documentation, Revision 2788b3f4

(continued from previous page)

int sensorID = getSensorID();
int value = getSensorValue(sensorID);
if (value == ERROR) {

throw new IOException("Unsupported sensor");
}
return value;

}

protected abstract int getSensorID();

public static native int getSensorValue(int sensorID);
}

class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final

}
}

// File providing an implementation of native method using a C function
#include <sni.h>
#include <potentiometer.h>

#define SENSOR_ERROR (-1)
#define POTENTIOMETER_ID (3)

jint Java_example_Sensor_getSensorValue(jint sensor_id){

if (sensor_id == POTENTIOMETER_ID)
{

return get_potentiometer_value();
}
return SENSOR_ERROR;

}

Synchronization

A call to a native function uses the same RTOS task as the RTOS task used to run all Java green threads. So during
this call, the MicroEJ Core Engine cannot schedule other Java threads.

[SNI] defines C functions that provide controls for the green threads’ activities:

• int32_t SNI_suspendCurrentJavaThread(int64_t timeout) : Suspends the execution of the Java thread
that initiated the current C call. This function does not block theC execution. The suspension is e�ective only
at the end of the native method call (when the C call returns). The green thread is suspended until either an
RTOS task calls SNI_resumeJavaThread , or the specified number of milliseconds has elapsed.

• int32_t SNI_getCurrentJavaThreadID(void) : Permits retrieval of the ID of the current Java threadwithin
the C function (assuming it is a “native Java to C call”). This IDmust be given to the SNI_resumeJavaThread
function in order to resume execution of the green thread.

• int32_t SNI_resumeJavaThread(int32_t id) : Resumes the green thread with the given ID. If the thread
is not suspended, the resume stays pending.
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Fig. 21: Green Threads and RTOS Task Synchronization

The above illustration shows a green thread (GT3) which has called a native method that executes in C. The C code
suspends the thread a�er having provisioned its ID (e.g. 3). Another RTOS task may later resume the Java green
thread.

Dependencies

No dependency.

Installation

The [SNI] library is a built-in feature of the platform, so there is no additional dependency to call native code from
Java. In the platform configuration file, check Java to C Interface > SNI API to install the additional Java APIs
in order to manipulate the data arrays.

Use

The SNI API module must be added to themodule.ivy of the MicroEJ Application project to use the [SNI] library.

<dependency org="ej.api" name="sni" rev="1.3.1"/>

4.10.2 Shielded Plug (SP)

Principle

The Shielded Plug [SP] provides data segregation with a clear publish-subscribe API. The data-sharing between
modules uses the concept of shared memory blocks, with introspection. The database is made of blocks: chunks
of RAM.
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Fig. 22: A Shielded Plug Between Two Application (Java/C) Modules.

Functional Description

The usage of the Shielded Plug (SP) starts with the definition of a database. The implementation of the [SP] for the
MicroEJ Platformuses an XML file description to describe the database; the syntax follows the one proposed by the
[SP] specification.

Once this database is defined, it can be accessed within the MicroEJ Application or the C application. The [SP]
Foundation Library is accessible from the [SP] API Module. This library contains the classes and methods to read
and write data in the database. See also the Java documentation from the MicroEJ Workbench resources center
(“Javadoc” menu). The C header file sp.h available in the MicroEJ Platform source/MICROJVM/include folder
contains the C functions for accessing the database.

To embed the [SP]database in your binary file, the XML file descriptionmust beprocessedby the [SP] compiler. This
compiler generates a binary file ( .o ) that will be linked to the overall application by the linker. It also generates
twodescriptions of the block ID constants, one in Java andone in C. These constants can be used by either the Java
or the C application modules.

Shielded Plug Compiler

A MicroEJ tool is available to launch the [SP] compiler tool. The tool name is Shielded Plug Compiler. It outputs:

• A description of the requested resources of the database as a binary file ( .o ) that will be linked to the over-
all application by the linker. It is an ELF format description that reserves both the necessary RAM and the
necessary Flash memory for the Shielded Plug database.

• Twodescriptions, one in Javaandone inC, of theblock ID constants tobeusedbyeither JavaorCapplication
modules.

Fig. 23: Shielded Plug Compiler Process Overview

Example

Below is an example of using a database [SP]. The code that publishes the data is written in C, and the code that
receives the data is written in Java. The data is transferred using two memory blocks. TEMP is a scalar value,
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THERMOSTAT is a boolean.

Database Description

The database is described as follows:

<shieldedPlug>
<database name="Forecast" id="0" immutable="true" version="1.0.0">

<block id="1" name="TEMP" length="4" maxTasks="1"/>
<block id="2" name="THERMOSTAT" length="4" maxTasks="1"/>

</database>
</shieldedPlug>

Java Code

From the database description we can create an interface.

public interface Forecast {
public static final int ID = 0;
public static final int TEMP = 1;
public static final int THERMOSTAT = 2;

}

Below is the task that reads the published temperature and controls the thermostat.

public void run(){
ShieldedPlug database = ShieldedPlug.getDatabase(Forecast.ID);
while (isRunning) {

//reading the temperature every 30 seconds
//and update thermostat status
try {

int temp = database.readInt(Forecast.TEMP);
print(temp);
//update the thermostat status
database.writeInt(Forecast.THERMOSTAT,temp>tempLimit ? 0 : 1);

}
catch(EmptyBlockException e){

print("Temperature not available");
}
sleep(30000);

}
}

C Code

Here is a C header that declares the constants defined in the XML description of the database.

#define Forecast_ID 0
#define Forecast_TEMP 1
#define Forecast_THERMOSTAT 2

Below, the code shows the publication of the temperature and thermostat controller task.
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void temperaturePublication() {
ShieldedPlug database = SP_getDatabase(Forecast_ID);
int32_t temp = temperature();
SP_write(database, Forecast_TEMP, &temp);

}

void thermostatTask(){
int32_t thermostatOrder;
ShieldedPlug database = SP_getDatabase(Forecast_ID);
while(1){

SP_waitFor(database, Forecast_THERMOSTAT);
SP_read(database, Forecast_THERMOSTAT, &thermostatOrder);
if(thermostatOrder == 0) {

thermostatOFF();
}
else {

thermostatON();
}

}
}

Dependencies

• LLSP_impl.h implementation (see LLSP: Shielded Plug).

Installation

The [SP] library and its relative tools are anoptional featureof theplatform. In theplatformconfiguration file, check
Java to C Interface > Shielded Plug to install the library and its relative tools.

Use

The Shielded Plug API Module must be added to themodule.ivy of the MicroEJ Application project to use the [SP]
library.

<dependency org="ej.api" name="sp" rev="2.0.2"/>

This library provides a set of options. Refer to the chapter Application Optionswhich lists all available options.

4.10.3 MicroEJ Java H

Principle

This MicroEJ tool is useful for creating the skeleton of a C file, to which some Java native implementation func-
tions will later be written. This tool helps prevent misses of some #include files, and helps ensure that function
signatures are correct.

Functional Description

MicroEJ Java H tool takes as input one or several Java class files (*.class) fromdirectories and / or JAR files. It looks
for Java native methods declared in these class files, and generates a skeleton(s) of the C file(s).
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Fig. 24: MicroEJ Java H Process

Dependencies

No dependency.

Installation

This is an additional tool. In the platform configuration file, check Java to C Interface > MicroEJ Java H to
install the tool.

Use

This chapter explains the MicroEJ tool options.

4.11 External Resources Loader

4.11.1 Principle

A resource is, for a MicroEJ Application, the contents of a file. This file is known by its path (its relative path from
theMicroEJ Application classpath) and its name. The filemay be stored in RAM, flash, or external flash; and it is the
responsibility of the MicroEJ Core Engine and/or the BSP to retrieve and load it.

MicroEJ Platformmakes the distinction between two kinds of resources:

• Internal resource: The resource is taken into consideration during the MicroEJ Application build. The SOAR
step loads the resource and copies it into the same C library as the MicroEJ Application. Like the MicroEJ Ap-
plication, the resource is linked into theCPUaddress space range (internal devicememories, external parallel
memories, etc.).

The available list of internal resources to embed must be specified in the MicroEJ Application launcher (Mi-
croEJ launch). Under the “Resources” tab, select all internal resources to embed in the final binary file.

• External resource: The resource is not taken into consideration by MicroEJ. It is the responsibility of the BSP
project to manage this kind of resource. The resource is o�en programmed outside the CPU address space
range (storage media like SD card, serial NOR flash, EEPROM, etc.).

The BSPmust implement some specific Low Level API (LLAPI) C functions: LLEXT_RES_impl.h . These func-
tions allow the MicroEJ Application to load some external resources.
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4.11.2 Functional Description

The External Resources Loader is an optional module. When not installed, only internal resources are available
for the MicroEJ Application. When the External Resources Loader is installed, the MicroEJ Core Engine tries first to
retrieve the expected resource from its available list of internal resources, before asking the BSP to load it (using
LLEXT_RES_impl.h functions).

4.11.3 Implementations

External Resources Loader module provides some Low Level API (LLEXT_RES) to let the BSP manage the external
resources.

Open a Resource

The LLAPI to implement in the BSP are listed in the header file LLEXT_RES_impl.h . First, the framework tries to
open an external resource using the open function. This function receives the resources path as a parameter. This
path is the absolute path of the resource from the MicroEJ Application classpath (the MicroEJ Application source
base directory). For example, when the resource is located here: com.mycompany.myapplication.resource.
MyResource.txt , the given path is: com/mycompany/myapplication/resource/MyResource.txt .

Resource Identifier

This open function has to return a unique ID (positive value) for the external resource, or returns an error code
(negative value). This ID will be used by the framework to manipulate the resource (read, seek, close, etc.).

Several resources can be opened at the same time. The BSP does not have to return the same identifier for two
resources living at the same time. However, it can return this ID for a new resource as soon as the old resource is
closed.

Resource O�set

The BSP must hold an o�set for each opened resource. This o�set must be updated a�er each call to read and
seek .

Resource Inside the CPU Address Space Range

An external resource can be programmed inside the CPU address space range. This memory (or a part of memory)
is not managed by the SOAR and so the resources inside are considered as external.

Most of time the content of an external resource must be copied in a memory inside the CPU address space range
in order to be accessible by the MicroEJ algorithms (draw an image etc.). However, when the resource is already
inside the CPU address space range, this copy is useless. The function LLEXT_RES_getBaseAddress must return
a valid CPU memory address in order to avoid this copy. The MicroEJ algorithms are able to target the external
resource bytes without using the other LLEXT_RES APIs such as read , mark etc.

4.11.4 External Resources Folder

The External Resource Loader module provides an option (MicroEJ launcher option) to specify a folder for the ex-
ternal resources. This folder has two roles:
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• It is the output folder used by some extra generators during the MicroEJ Application build. All output files
generated by these tools will be copied into this folder. This makes it easier to retrieve the exhaustive list of
resources to program on the board.

• This folder is taken into considerationby theSimulator inorder to simulate theavailability of these resources.
When the resources are located in another computer folder, the Simulator is not able to load them.

If not specified, this folder is created (if it does not already exist) in the MicroEJ project specified in the MicroEJ
launcher. Its name is externalResources .

4.11.5 Dependencies

• LLEXT_RES_impl.h implementation (see LLEXT_RES: External Resources Loader).

4.11.6 Installation

The External Resources Loader is an additional module. In the platform configuration file, check
External Resources Loader to install this module.

4.11.7 Use

The External Resources Loader is automatically used when the MicroEJ Application tries to open an external re-
source.

4.12 Serial Communications

MicroEJprovides someFoundationLibraries to instantiate somecommunicationswith external devices. Each com-
municationmethod has its own library. A global library called ECOM provides support for abstract communication
streams (communication framework only), and a generic devices manager.

4.12.1 ECOM

Principle

The Embedded COMmunication Foundation Library (ECOM) is a generic communication library with abstract com-
munication stream support (a communication framework only). It allows you to open and use streams on commu-
nication devices such as a COMM port.

This libraryalsoprovidesadevicemanager, includingagenericdevice registryandanotificationmechanism,which
allows plug&play-based applications.

This library does not provide APIs to manipulate some specific options for each communication method, but it
does provide some generic APIs which abstract the communication method. A�er the opening step, the MicroEJ
Application can use every communications method (COMM, USB etc.) as generic communication in order to easily
change the communication method if needed.
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Functional Description

The diagram below shows the overall process to open a connection on a hardware device.

Fig. 25: ECOM Flow

1. Step 1 consists of opening a connection on a hardware device. The connection kind and its configuration are
fixed by the parameter String connectionString of the method Connection.open .

2. Step 2 consists of opening an InputStream on the connection. This stream allows the MicroEJ Application
to access the “RX” feature of the hardware device.

3. Step 3 consists of using the InputStream APIs to receive in theMicroEJ Application all hardware device data.

4. Step 4 consists of opening an OutputStream on the connection. This stream allows the MicroEJ Application
to access the “TX” feature of the hardware device.

5. Step 5 consists of using the OutputStream APIs to transmit some data from the MicroEJ Application to the
hardware device.

Note that steps 2 and 4may be performed in parallel, and do not depend on each other.

Device Management API

A device is defined by implementing ej.ecom.Device . It is identified by a name and a descriptor ( ej.ecom.
HardwareDescriptor ), which is composed of a set of MicroEJ properties. A device can be registered/unregistered
in the ej.ecom.DeviceManager .

A device registration listener is defined by implementing ej.ecom.RegistrationListener . When a device is reg-
istered to or unregistered from the device manager, listeners registered for the device type are notified. The notifi-
cationmechanism is done in a dedicated Java thread. Themechanism can be enabled or disabled (see Application
Options).
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Dependencies

No dependency.

Installation

ECOMFoundation Library is an additional library. In the platform configuration file, check Serial Communication
> ECOM to install the library.

Use

The ECOM API Modulemust be added to themodule.ivy of the MicroEJ Application project to use the ECOM library.

<dependency org="ej.api" name="ecom" rev="1.1.4"/>

This foundation library is always requiredwhen developing aMicroEJ Applicationwhich communicates with some
external devices. It is automatically embedded as soon as a sub communication library is added in the classpath.

4.12.2 ECOM Comm

Principle

The ECOM Comm Java library provides support for serial communication. ECOM Comm extends ECOM to al-
low stream communication via serial communication ports (typically UARTs). In the MicroEJ Application, the
connection is established using the Connector.open() method. The returned connection is a ej.ecom.io.
CommConnection , and the input and output streams can be used for full duplex communication.

The use of ECOM Comm in a custom platform requires the implementation of an UART driver. There are two di�er-
ent modes of communication:

• In Bu�ered mode, ECOM Commmanages so�ware FIFO bu�ers for transmission and reception of data. The
driver copies data between the bu�ers and the UART device.

• In Custom mode, the bu�ering of characters is not managed by ECOM Comm. The driver has to manage its
own bu�ers to make sure no data is lost in serial communications because of bu�er overruns.

This ECOM Comm implementation also allows dynamic add or remove of a connection to the pool of available
connections (typically hot-plug of a USB Comm port).

Functional Description

The ECOM Comm process respects the ECOM process. Please refer to the illustration “ECOM flow”.

Component Architecture

The ECOMCommCmodule relies on a native driver to performactual communication on the serial ports. Each port
can be bound to a di�erent driver implementation, but most of the time, it is possible to use the same implemen-
tation (i.e. same code) for multiple ports. Exceptions are the use of di�erent hardware UART types, or the need for
di�erent behaviors.

Five C header files are provided:

4.12. Serial Communications 348

https://repository.microej.com/modules/ej/api/ecom/


MicroEJ Documentation, Revision 2788b3f4

• LLCOMM_impl.h

Defines the set of functions that the driver must implement for the global ECOM comm stack, such as syn-
chronization of accesses to the connections pool.

• LLCOMM_BUFFERED_CONNECTION_impl.h

Defines the set of functions that the driver must implement to provide a Bu�ered connection

• LLCOMM_BUFFERED_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Bu�ered connection

• LLCOMM_CUSTOM_CONNECTION_impl.h

Defines the set of functions that the driver must implement to provide a Custom connection

• LLCOMM_CUSTOM_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Custom connection

The ECOM Comm drivers are implemented using standard LLAPI features. The diagram below shows an example
of the objects (both Java and C) that exist to support a Bu�ered connection.

Fig. 26: ECOM Comm components

The connection is implemented with three objects1 :

• The Java object used by the application; an instance of ej.ecom.io.CommConnection

• The connection object within the ECOM CommCmodule

• The connection object within the driver

Each driver implementation provides one or more connections. Each connection typically corresponds to a physi-
cal UART.

CommPort Identifier

Each serial port available for use in ECOM Comm can be identified in three ways:

• An application port number. This identifier is specific to the application, and should be used to identify the
data stream that the port will carry (for example, “debug traces” or “GPS data”).

• A platform port number. This is specific to the platform, andmay directly identify an hardware device2.
1 This is aconceptualdescription toaidunderstanding - the reality is somewhatdi�erent, although that is largely invisible to the implementor

of the driver.
2 Some drivers may reuse the same UART device for di�erent ECOM ports with a hardware multiplexer. Drivers can even treat the platform

port number as a logical id andmap the ids to various I/O channels.
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• A platform port name. This is mostly used for dynamic connections or on platforms having a file-system
based device mapping.

When the Comm Port is identified by a number, its string identifier is the concatenation of “com” and the number
(e.g. com11).

Application Port Mapping

The mapping from application port numbers to platform ports is done in the application launch configuration.
This way, the application can refer only to the application port number, and the data stream can be directed to the
matching I/O port on di�erent versions of the hardware.

Ultimately, the application port number is only visible to the application. The platform identifier will be sent to the
driver.

Opening Sequence

The following flow chart explains Comm Port opening sequence according to the given Comm Port identifier.

Fig. 27: Comm Port Open Sequence

Dynamic Connections

The ECOMCommstack allows to dynamically add and remove connections from theDriver API. When a connection
is added, it can be immediately open by the application. When a connection is removed, the connection cannot be
open anymore and java.io.IOException is thrown in threads that are using it.

In addition, adynamic connection canbe registeredandunregistered inECOMdevicemanager (seeDeviceManage-
ment API). The registration mechanism is done in dedicated thread. It can be enabled or disabled, see Application
Options.

A removed connection is alive until it is closed by the application and, if enabled, unregistered from ECOM device
manager. A connection is e�ectively uninstalled (and thus eligible to be reused) only when it is released by the
stack.
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The following sequence diagram shows the lifecycle of a dynamic connection with ECOM registration mechanism
enabled.

Fig. 28: Dynamic Connection Lifecycle

Java API

Opening a connection is done using ej.ecom.io.Connector.open(String name) . The connection string (the
name parameter) must start with “comm:”, followed by the Commport identifier, and a semicolon-separated list of
options. Options are the baudrate, the parity, the number of bits per character, and the number of stop bits:

• baudrate=n (9600 by default)

• bitsperchar=n where n is in the range 5 to 9 (8 by default)

• stopbits=n where n is 1, 2, or 1.5 (1 by default)

• parity=x where x is odd, even or none (none by default)

All of these are optional. Illegal or unrecognized parameters cause an IllegalArgumentException .
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Driver API

The ECOM Comm Low Level API is designed to allowmultiple implementations (e.g. drivers that support di�erent
UART hardware) and connection instances (see Low Level API Pattern chapter). Each ECOM Commdriver defines a
data structure that holds information about a connection, and functions take an instance of this data structure as
the first parameter.

The name of the implementation must be set at the top of the driver C file, for example3:

#define LLCOMM_BUFFERED_CONNECTION MY_LLCOMM

This defines the name of this implementation of the LLCOMM_BUFFERED_CONNECTION interface to be MY_LLCOMM .

The data structure managed by the implementation must look like this:

typedef struct MY_LLCOMM{
struct LLCOMM_BUFFERED_CONNECTION header;
// extra data goes here

} MY_LLCOMM;

void MY_LLCOMM_new(MY_LLCOMM* env);

In this example the structure contains only the default data, in the header field. Note that the header must be the
first field in the structure. The name of this structure must be the same as the implementation name ( MY_LLCOMM
in this example).

The driver must also declare the “new” function used to initialize connection instances. The name of this function
must be the implementation namewith _new appended, and it takes as its sole argument a pointer to an instance
of the connection data structure, as shown above.

The driver needs to implement the functions specified in the LLCOMM_impl.h file and for each kind of connection,
the LLCOMM_BUFFERED_CONNECTION_impl.h (or LLCOMM_CUSTOM_CONNECTION_impl.h ) file.

The driver defines the connections it provides by adding connection objects using LLCOMM_addConnection
. Connections can be added to the stack as soon as the LLCOMM_initialize function is called. Connec-
tions added during the call of the LLCOMM_impl_initialize function are static connections. A static con-
nection is registered to the ECOM registry and cannot be removed. When a connection is dynamically added
outside the MicroJVM task context, a suitable reentrant synchronization mechanism must be implemented (see
LLCOMM_IMPL_syncConnectionsEnter and LLCOMM_IMPL_syncConnectionsExit ).

Whenopening a port from theMicroEJ Application, each connection declared in the connections poolwill be asked
about its platform port number (using the getPlatformId method) or its name (using the getName method)
depending on the requested port identifier. The first matching connection is used.

The life of a connection starts with the call to getPlatformId() or getName() method. If the the connection
matches the port identifier, the connectionwill be initialized, configured and enabled. Notifications and interrupts
are then used to keep the stream of data going. When the connection is closed by the application, interrupts are
disabled and the driver will not receive any more notifications. It is important to remember that the transmit and
receive sides of the connection are separate Java stream objects, thus, theymay have a di�erent life cycle and one
side may be closed long before the other.

The Bu�ered CommStream

InBu�eredmode, twobu�ers areallocatedby thedriver for sendingand receivingdata. TheECOMCommCmodule
will fill the transmit bu�er, and get bytes from the receive bu�er. There is no flow control.

3 The following examples use Bu�ered connections, but Custom connections follow the same pattern.
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When the transmit bu�er is full, an attempt to write more bytes from the MicroEJ Application will block the Java
thread trying to write, until some characters are sent on the serial line and space in the bu�er is available again.

When the receive bu�er is full, characters coming from the serial line will be discarded. The driver must allocate a
bu�er big enough to avoid this, according to the UART baudrate, the expected amount of data to receive, and the
speed at which the application can handle it.

The Bu�ered Cmodule manages the characters sent by the application and stores them in the transmit bu�er. On
notification of available space in the hardware transmit bu�er, it handles removing characters from this bu�er and
putting them in the hardware bu�er. On the other side, the driver notifies the C module of data availability, and
the Cmodule will get the incoming character. This character is added to the receive bu�er and stays there until the
application reads it.

The driver should take care of the following:

• Setting up interrupt handlers on reception of a character, and availability of space in the transmit bu�er. The
Cmodulemaymask these interruptswhen it needs exclusive access to the bu�ers. If no interrupt is available
from the hardware or underlying so�ware layers, it may be faked using a polling thread that will notify the C
module.

• Initialization of the I/O pins, clocks, and other things needed to get the UART working.

• Configuration of the UART baudrate, character size, flow control and stop bits according to the settings given
by the Cmodule.

• Allocation of memory for the transmit and receive bu�ers.

• Getting the state of the hardware: is it running, is there space le� in the TX and RX hardware bu�ers, is it busy
sending or receiving bytes?

The driver is notified on the following events:

• Opening and closing a connection: the driver must activate the UART and enable interrupts for it.

• A newbyte is waiting in the transmit bu�er and should be copied immediately to the hardware transmit unit.
The Cmodulemakes sure the transmit unit is not busy before sending the notification, so it is not needed to
check for that again.

The driver must notify the Cmodule on the following events:

• Data has arrived that should be added to the receive bu�er (using the
LLCOMM_BUFFERED_CONNECTION_dataReceived function)

• Space available in the transmit bu�er (using the LLCOMM_BUFFERED_CONNECTION_transmitBufferReady
function)

The Custom CommStream

In custommode, the ECOMCommCmodulewill not doanybu�ering. Readandwrite requests from theapplication
are immediately forwarded to the driver.

Since there is no bu�er on the C module side when using this mode, the driver has to define a strategy to store
received bytes that were not handed to the C module yet. This could be a fixed or variable side FIFO, the older
received but unread bytesmay be dropped, or amore complex priority arbitration could be set up. On the transmit
side, if the driver does not do any bu�ering, the Java thread waiting to send something will be blocked and wait
for the UART to send all the data.

In Custom mode flow control (eg. RTS/CTS or XON/XOFF) can be used to notify the device connected to the serial
line and so avoid losing characters.

4.12. Serial Communications 353



MicroEJ Documentation, Revision 2788b3f4

BSP File

The ECOMCommCmodule needs to know,when theMicroEJ Application is built, the nameof the implementation.
This mapping is defined in a BSP definition file. The name of this file must be bsp.xml andmust be written in the
ECOM comm module configuration folder (near the ecom-comm.xml file). In previous example the bsp.xml file
would contain:

Listing 1: ECOM CommDriver Declaration (bsp.xml)

<bsp>
<nativeImplementation

name="MY_LLCOMM"
nativeName="LLCOMM_BUFFERED_CONNECTION"

/>
</bsp>

where nativeName is the name of the interface, and name is the name of the implementation.

XML File

The Java platform has to know the maximum number of Comm ports that can be managed by the ECOM Comm
stack. It also has to know each Commport that can bemapped from an application port number. Such Commport
is identified by its platform port number and by an optional nickname (The port and its nicknamewill be visible in
the MicroEJ launcher options, see Application Options ).

A XML file is so required to configure the Java platform. The name of this file must be ecom-comm.xml . It has to be
stored in the module configuration folder (see Installation).

This file must start with the node <ecom> and the sub node <comms> . It can contain several time this kind of line:
<comm platformId="A_COMM_PORT_NUMBER" nickname="A_NICKNAME"/> where:

• A_COMM_PORT_NUMBER refers the Comm port the Java platform user will be able to use (see Application Port
Mapping).

• A_NICKNAME is optional. It allows to fix a printable name of the Comm port.

The maxConnections attribute indicates the maximum number of connections allowed, including static and dy-
namic connections. This attribute is optional. By default, it is the number of declared Comm Ports.

Example:

Listing 2: ECOM CommModule Configuration (ecom-comm.xml)

<ecom>
<comms maxConnections="20">

<comm platformId="2"/>
<comm platformId="3" nickname="DB9"/>
<comm platformId="5"/>

</comms>
</ecom>

First Comm port holds the port 2, second “3” and last “5”. Only the second Comm port holds a nickname “DB9”.

ECOM CommMock

In the simulation environment, no driver is required. The ECOM Comm mock handles communication for all the
serial ports and can redirect each port to one of the following:
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• An actual serial port on the host computer: any serial port identified by your operating system can be used.
The baudrate and flow control settings are forwarded to the actual port.

• A TCP socket. You can connect to a socket on the local machine and use netcat or telnet to see the output, or
you can forward the data to a remote device.

• Files. You can redirect the input and output each to a di�erent file. This is useful for sending precomputed
data and looking at the output later on for o�line analysis.

When using the socket and file modes, there is no simulation of an UART baudrate or flow control. On a file, data
will always be available for reading and will be written without any delay. On a socket, you can reach the maximal
speed allowed by the network interface.

Dependencies

• ECOM (see Serial Communications).

• LLCOMM_impl.h and LLCOMM_xxx_CONNECTION_impl.h implmentations (see LLCOMM: Serial Communica-
tions).

Installation

ECOM-CommJava library is an additional library. In the platform configuration file, check Serial Communication
> ECOM-COMM to install it. When checked, the xml file ecom-comm/ecom-comm.xml is required during platform
creation to configure the module (see XML File).

Use

The ECOM CommAPI Module must be added to themodule.ivy of the MicroEJ Application project to use the ECOM
Comm library.

<dependency org="ej.api" name="ecom-comm" rev="1.1.4"/>

This FoundationLibrary is always requiredwhendevelopingaMicroEJApplicationwhich communicateswith some
external devices using the serial communication mode.

This library provides a set of options. Refer to the chapter Application Optionswhich lists all available options.

4.13 Graphical User Interface

Note: This chapter describes the current Graphical User Interface version 3 , provided by UI Pack version 13.0.0
or higher. The UI Pack Changelog and aMigration Guide are provided at the end of this chapter. If you are using the
former Graphical User Interface version 2 (provided by MicroEJ UI Pack version up to 12.1.x ), please refer to this
MicroEJ Documentation Archive.

4.13.1 Principle

TheUser Interface Extension features one of the fastest graphics engines, associatedwith a unique int-based event
management system.
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This chapter describes theUI3 notions, available since MicroEJ Architecture UI pack 13.0.0 and higher: MicroUI 3.0,
Front Panel v6, Low Level APIs LLUI_xxx , etc.

The diagram below shows a simplified view of the components involved in the provisioning of User Interface Ex-
tension.

Fig. 29: Overview

The modules responsible to manage the Display, the Input and the LED are respectively called Display module,
Input module and LED module. These three Low Level parts connect MicroUI library to the user-supplied drivers
code (coded in C). The drivers can use hardware accelerators like DMA and GPU to perform specific actions (bu�ers
copy, drawings, etc.).

TheMicroEJSimulator provides all features ofMicroUI library. The threemodules are grouped together in amodule
called Front Panel. The Front Panel is supplied with a set of so�ware widgets that generically support a range of
input devices such as buttons, joysticks and touchscreens, and output devices such as displays and LEDs. With the
help of the Front Panel Designer tool that forms part of the MicroEJ Workbench the user must define a Front Panel
mock-up using these widgets.

The Displaymodule alsomanages fonts and images. The fonts and images are pre-processed before compiling the
MicroEJ application. The followingdiagramdepicts the components involved in its design, alongwith the provided
tools:
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Fig. 30: The User Interface Extension Components along with a Platform

4.13.2 MicroUI

Principle

MicroUI library defines a Low Level UI framework for embedded devices. This module allows the creation of basic
Human-Machine-Interfaces (HMI), with output on a pixel-based screen.

Architecture

MicroUI library is the entry point to perform somedrawings on a display and to interactwith user input events. This
library contains only a minimal set of basic APIs. High-level libraries can be used to have more expressive power,
such asMWT (Micro Widget Toolkit). In addition to this restricted set of APIs, the MicroUI implementation has been
designed so that the EDC and BON footprint is minimal.
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AtMicroEJ application startup all MicroUI objects relative to the I/O devices are created and accessible. The follow-
ing MicroUI methods allow you to access these objects:

• Display.getDisplay() : returns the instance of the display which drives the main display screen.

• Leds.getNumberOfLeds(): returns the numbers of available LEDs.

MicroUI is not a standalone library. It requires a configuration step and several extensions to drive I/O devices
(display, inputs, LEDs).

First, MicroUI requires a configuration step in order to create these internal objects before the call to the main()
method. The chapter Static Initialization explains how to perform the configuration step.

Note: This configuration step is the same for both embedded and smulated platforms.

The embedded platform requires some additional C libraries to drive the I/O devices. Each C library is dedicated to
a specific kind of I/O device. A specific chapter is available to explain each kind of I/O device.

Table 10: MicroUI C libraries
I/O devices Extension Name Chapter
Graphical / pixel-based display Display Display
Inputs (buttons, joystick, touch, pointers, etc.) Input Input
LEDs LED LED

The simulation platform uses a mock which simulates all I/O devices. Refer to the chapter Simulation.

Thread

Principle

TheMicroUI implementation for MicroEJ uses one internal thread. This thread is created during theMicroUI initial-
ization step, and is started by a call to MicroUI.start().

Role

This thread has several roles:

• It manages all display events (requestRender(), requestShow(), etc.).

• It reads the I/O devices inputs and dispatches them into the event generators’ listeners. See input section:
Input.

• It allows to run some piece of code using the callSerially() method.

Memory

The thread is always running. The user has to count it to determine the number of concurrent threads the MicroEJ
Core Engine can run (seeMemory options in Application Options).
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Exceptions

The thread cannot be stopped with a Java exception: the exceptions are always checked by the framework.

When an exception occurs in a user method called by the internal thread (for instance render()), the current
UncaughtExceptionHandler receives the exception. When no exception handler is set, a default handler prints
the stack trace.

Native Calls

TheMicroUI implementation for MicroEJ uses nativemethods to perform some actions (read input devices events,
perform drawings, turn on LEDs, etc.). The library implementation has been designed to not use blocking native
methods (wait input devices, wait end of drawing, etc.) which can lock the full MicroEJ Core Engine execution.

The specification of the native methods is to perform the action as fast as possible. The action execution may be
sequential or parallel because an action is able to use a third-party device (so�ware or hardware). In this case,
some callbacks are available to notify the end of this kind of parallel actions.

However some actions have to wait the end of a previous parallel action. By consequence the caller thread is
blocked until the previous action is done; in other words, until the previous parallel action has called its callback.
In this case, only the current Java thread is locked (because it cannot continue its execution until both actions are
performed). All other Java threads can run, even a thread with a lower priority than current thread. If no thread
has to be run, MicroEJ Core Engine goes in sleepmode until the native callback is called.

Transparency

MicroUI provides several policies to use the transparency. These policies depend on several factors, including the
kind of drawing and the display pixel rendering format. The main concept is that MicroUI does not allow you to
draw something with a transparency level di�erent from 255 (fully opaque). There are two exceptions: the images
and the fonts.

Images

Drawing an image (a pre-generated image or an image decoded at runtime) which contains some transparency
levels does not depend on the display pixel rendering format. During the image drawing, each pixel is converted
into 32 bits by pixel format.

This pixel format contains 8 bits to store the transparency level (alpha). This byte is used to merge the foreground
pixel (image transparent pixel) with the background pixel (bu�er opaque pixel). The formula to obtain the pixel is:

𝛼𝑀𝑢𝑙𝑡 = (𝛼𝐹𝐺 * 𝛼𝐵𝐺)/255

𝛼𝑂𝑢𝑡 = 𝛼𝐹𝐺+ 𝛼𝐵𝐺− 𝛼𝑀𝑢𝑙𝑡

𝐶𝑂𝑢𝑡 = (𝐶𝐹𝐺 * 𝛼𝐹𝐺+ 𝐶𝐵𝐺 * 𝛼𝐵𝐺− 𝐶𝐵𝐺 * 𝛼𝑀𝑢𝑙𝑡)/𝛼𝑂𝑢𝑡

The destination bu�er is always opaque, so:

𝐶𝑂𝑢𝑡 = (𝐶𝐹𝐺 * 𝛼𝐹𝐺+ 𝐶𝐵𝐺 * (255− 𝛼𝑀𝑢𝑙𝑡))/255

where:

• 𝛼FG is the alpha level of the foreground pixel (layer pixel),

• 𝛼BG is the alpha level of the background pixel (working bu�er pixel),
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• Cxx is a color component of a pixel (Red, Green or Blue),

• 𝛼Out is the alpha level of the final pixel.

Fonts

A font holds only a transparency level (alpha). This fixed alpha level is defined during the pre-generation of a font
(see Fonts).

• 1 means 2 levels are managed: fully opaque and fully transparent.

• 2 means 4 levels are managed: fully opaque, fully transparent and 2 intermediate levels.

• 4 means 16 levels are managed: fully opaque, fully transparent and 14 intermediate levels.

• 8 means 256 levels are managed: fully opaque, fully transparent and 254 intermediate levels.

Installation

The MicroUI library is an additional module. In the platform configuration file, check UI > MicroUI to install
the library. When checked, the XML file microui/microui.xml is required during platform creation in order to
configure the module. This configuration step is used to extend the MicroUI library. Refer to the chapter Static
Initialization for more information about the MicroUI Initialization step.

Use

SeeMicroUI chapter in Application Developer Guide.

4.13.3 Static Initialization

Principle

The MicroUI implementation for MicroEJ requires a configuration step (also called extension step) to customize
itself beforeMicroEJ application startup (see Architecture). This configuration step uses an XML file. In order to save
both runtime execution time and flashmemory, the file is processed by the Static MicroUI Initializer tool, avoiding
theneed toprocess the XML configuration file at runtime. The tool generates appropriate initializedobjects directly
within the MicroUI library, as well as Java and C constants files for sharing MicroUI event generator IDs.

This XML file (also called the initialization file) defines:

• The MicroUI event generators that will exist in the application in relation to Low Level drivers that provide
data to these event generators (see Input).

• Whether the application has a display; and if so, it provides its logical name.

• Which fonts will be provided to the application.

The next chapters describe succinctly the XML file. For more information about grammar, please consult appendix
MicroUI Static Initializer.
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Functional Description

The Static MicroUI Initializer tool takes as entry point the initialization file which describes the MicroUI library ex-
tension. This tool is automatically launched during the MicroEJ Platform build (see Installation ).

The Static MicroUI Initializer tool is able to generate two files:

• A Java library which extends MicroUI library. This library is automatically added to the MicroEJ Application
classpathwhenMicroUI API library is fetched. This library is used at MicroUI startup to create all instances of
I/O devices (Display, EventGenerator, etc.) and contains the fonts described into the configuration file (these
fonts are also called “system fonts”).

Warning: This MicroUI extension library is always generated andMicroUI library cannot runwithout this exten-
sion.

• A C header file ( *.h ). This header file contains some IDs which are used to make a link between an input
device (buttons, touch) and its MicroUI event generator (see Input).

Note: The Front Panel project does not need a configuration file (like C header file for embedded platform).

Fig. 31: Static MicroUI Initializer Process

XML File

The XML file must be created in platform configuration project, in folder microui and called microui.xml .

Fig. 32: Static MicroUI Initializer XML File

The XML file grammar is detailed here. The following list gives a short description of each element:

• Root element: The initialization file root element is <microui> and contains component-specific elements.
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<microui>
[ component specific elements ]

</microui>

• Display element: The display element augments the initialization file with the configuration of the display.
The following snippet is an example of display element:

<display name="DISPLAY"/>

• Fonts element: The fonts element augments the initialization file with the fonts that are implicitly embed-
ded within the application (also called system fonts). Applications can also embed their own fonts.

Note: The system fonts are optional, in which case application has to provide some fonts to be
able to draw characters.

The following snippet is an example of fonts element:

<fonts>
<font file="resources\fonts\myfont.ejf">

<range name="LATIN" sections="0-2"/>
<customrange start="0x21" end="0x3f"/>

</font>
<font file="C:\data\myfont.ejf"/>

</fonts>

• Event generators element: The eventgenerators element augments the initialization file with:

– the configuration of the predefined MicroUI Event Generator: Command, Buttons, States,
Pointer and Touch.

– the configuration of the generic MicroUI Event Generator.

The following snippet is an example of eventgenerators element:

<eventgenerators>
<!-- Generic Event Generators -->
<eventgenerator name="GENERIC" class="foo.bar.Zork">

<property name="PROP1" value="3"/>
<property name="PROP2" value="aaa"/>

</eventgenerator>

<!-- Predefined Event Generators -->
<command name="COMMANDS"/>
<buttons name="BUTTONS" extended="3"/>
<buttons name="JOYSTICK" extended="5"/>
<pointer name="POINTER" width="1200" height="1200"/>
<touch name="TOUCH" display="DISPLAY"/>
<states name="STATES" numbers="NUMBERS" values="VALUES"/>

</eventgenerators>

<array name="NUMBERS">
<elem value="3"/>
<elem value="2"/>
<elem value="5"/>

</array>

(continues on next page)
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(continued from previous page)

<array name="VALUES">
<elem value="2"/>
<elem value="0"/>
<elem value="1"/>

</array>

XML File Example

This common MicroUI initialization file initializes MicroUI with:

• a Display,

• a Command event generator,

• a Buttons event generator which targets n buttons (3 first buttons having extended features),

• a Buttons event generator which targets the buttons of a joystick,

• a Pointer event generator which targets a touch panel,

• a Font whose path is relative to this file.

<microui>

<display name="DISPLAY"/>

<eventgenerators>
<command name="COMMANDS"/>
<buttons name="BUTTONS" extended="3"/>
<buttons name="JOYSTICK" extended="5"/>
<touch name="TOUCH" display="DISPLAY"/>

</eventgenerators>

<fonts>
<font file="resources\fonts\myfont.ejf"/>

</fonts>

</microui>

Dependencies

No dependency.

Installation

The Static Initialization tool is part of the MicroUI module (see MicroUI). Install the MicroUI module to install the
Static Initialization tool and fill all properties in MicroUI module configuration file (whichmust specify the name of
the initialization file).

Use

The Static MicroUI Initializer tool is automatically launched during the MicroEJ Platform build.
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4.13.4 Low Level API

Principle

The MicroUI implementation for MicroEJ requires a Low Level implementation. This Low Level implementation
finalizes the MicroUI implementation started with the static initialization step (see Static Initialization) for a given
MicroEJ Platform.

The Low Level implementation consists of a set of headers files to implement in C to target the hardware drivers.
Some functionsaremandatory, othersarenot. Someotherheaders filesarealsoavailable tocallUI engines internal
functions.

For the simulator, some Front Panel interfaces and classes allow to specify the simulated platform characteristics.

Embedded Platform

Fig. 33: MicroUI Embedded Low Level API

The specification of header files names is:

• Name starts with LLUI_ .

• Second part name refers the UI engine: DISPLAY , INPUT , LED .

• Files whose name ends with _impl list functions to implement over hardware.

• Files whose name has no su�ix list internal UI engines functions.

There are some exceptions :

• LLUI_PAINTER_impl.h and LLDW_PAINTER_impl.h list a subpart of UI Graphics Engine functions to imple-
ment (all MicroUI native drawing methods).

• ui_drawing.h and dw_drawing.h list all drawing methods the platform can implement.

• ui_drawing_soft.h and dw_drawing_soft.h list all drawing methods implemented by the Graphics En-
gine.

• microui_constants.h is the file generated by the MicroUI Static Initializer (see Static Initialization).

All header files and their aims are described in next UI engines chapters: LED, Input and Display.
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Simulator

Fig. 34: MicroUI Simulator Low Level API

In the simulator the three UI engines are grouped in a mock called Front Panel. The Front Panel comes with a set
of classes and interfaces which are the equivalent of headers file ( *.h ) of Embedded Platform.

The specification of class names is:

• Package are the same than the MicroUI library ( ej.microui.display , ej.microui.event , ej.microui.
led ).

• Name start with LLUI .

• Second part name refers the UI engine: Display , Input , Led .

• Files whose name ends with Impl list methods to implement like embedded platform.

• Files whose name has no su�ix list internal UI engines functions.

There are some exceptions :

• LLUIPainter.java and LLDWPainter.java list a subpart of UI Graphics Engine functions (all MicroUI native
drawing methods).

• UIDrawing.java and DWDrawing.java list all drawing methods the platform can implement (and already
implemented by the Graphics Engine).

• EventXXX list methods to create input events compatible with MicroUI implementation.

All files and their aims are described in Simulation.

4.13.5 LED

Principle

The LED module contains the C part of the MicroUI implementation which manages LED devices. This module is
composed of only one element: an implementation of the Low Level APIs for the LEDs which must be provided by
the BSP (see LLUI_LED: LEDs).
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Functional Description

The LED module implements the MicroUI Leds framework. LLUI_LED specifies the Low Level APIs that receive
orders from the Java world.

The Low Level APIs are the same for the LED which is connected to a GPIO ( 0 or 1 ), to a PWM , to a bus ( I2C , SPI
), etc. The BSP has the responsibility of interpreting the MicroEJ Application parameter intensity .

Typically, when the LED is connected to a GPIO , the intensity “0”means “OFF”, and all other values “ON”. When
the LED is connected via a PWM , the intensity “0”means “OFF”, and all other valuesmust configure the PWM duty
cycle signal.

The BSP should be able to return the state of an LED. If it is not able to do so (for example GPIO is not accessible
in read mode), the BSP has to save the LED state in a global variable. If not, the returned value may be wrong and
the MicroEJ Application may not be able to know the LEDs states.

Low Level API

The LEDmodule provides Low Level APIs that allow the BSP tomanage the LEDs. The BSP has to implement these
Low Level APIs, making the link between the MicroUI library and the BSP LEDs drivers.

TheLowLevel APIs to implementare listed in theheader file LLUI_LEDS_impl.h . First, in the initialization function,
theBSPmust return theavailablenumberof LEDs theboardprovides. Theother functions areused to turn the LEDs
on and o�.

Fig. 35: Led Low Level API

When there is no LED on the board, a stub implementation of C library is available. This C library must be linked
by the third-party C IDE when the MicroUI module is installed in the MicroEJ Platform. This stub library does not
provide any Low Level API files.
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Dependencies

• MicroUI module (seeMicroUI).

• LLUI_LED_impl.h implementation if standard implementation is chosen (see Functional Description and
LLUI_LED: LEDs).

Installation

LEDs is a sub-part of MicroUI library. When the MicroUI module is installed, the LED module must be installed in
order to be able to connect physical LEDs with MicroEJ Platform. If not installed, the stubmodule will be used.

In the platform configuration file, check UI > LEDs to install LEDs.

Use

The MicroUI LEDs APIs are available in the class ej.microui.led.Leds.

4.13.6 Input

Principle

The Input module contains the C part of the MicroUI implementation which manages input devices. This module
is composed of two elements:

• the C part of MicroUI input API (a built-in C archive) called Input Engine,

• an implementation of a Low Level APIs for the input devices that must be provided by the BSP (see
LLUI_INPUT: Input).

Functional Description

The Input module implements the MicroUI int -based event generators’ framework. LLUI_INPUT specifies the
Low Level APIs that send events to the Java world.

Drivers for input devices must generate events that are sent, via a MicroUI Event Generator, to the MicroEJ Appli-
cation. An event generator accepts notifications from devices, and generates an event in a standard format that
can be handled by the application. Depending on theMicroUI configuration, there can be several di�erent types of
event generator in the system, and one or more instances of each type.

Each MicroUI Event Generator represents one side of a pair of collaborative components that communicate using
a shared bu�er:

• The producer: the C driver connected to the hardware. As a producer, it sends its data into the communica-
tion bu�er.

• The consumer: the MicroUI Event Generator. As a consumer, it reads (and removes) the data from the com-
munication bu�er.
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Fig. 36: Drivers and MicroUI Event Generators Communication

The LLUI_INPUT API allowsmultiple pairs of <driver - event generator> to use the samebu�er, andassociates
drivers and event generators using an int ID. The ID used is the event generator ID held within the MicroUI global
registry. Apart fromsharing the IDused to “connect”onedriver’sdata to its respectiveeventgenerator, bothentities
are completely decoupled.

The MicroUI thread waits for data to be published by drivers into the “input bu�er”, and dispatches to the correct
(according to the ID) event generator to read the received data. This “driver-specific-data” is then transformed into
MicroUI events by event generators and sent to objects that listen for input activity.

Fig. 37: MicroUI Events Framework

Driver Listener

Drivers may either interface directly with event generators, or they can send their notifications to a Listener, also
written in C, and the listener passes the notifications to the event generator. This decoupling has twomajor bene-
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fits:

• The drivers are isolated from the MicroEJ libraries – they can even be existing code.

• The listener can translate the notification; so, for example, a joystick could generate pointer events.

Static Initialization

The event generators available onMicroUI startup (a�er the call toMicroUI.start()) are the event generators listed in
the MicroUI description file (XML file). This file is a part of the MicroUI Static Initialization step (Static Initialization).

Theorderof eventgeneratorsdefines theunique identifier for eacheventgenerator. These identifiers aregenerated
in a header file called microui_constants.h . The input driver (or its listener) has to use these identifiers to target
a specific event generator.

If an unknown identifier is used or if two identifiers are swapped, the associated event may be never received by
MicroEJ application or may bemisinterpreted.

Standard Event Generators

MicroUI provides a set of standard event generators: Command, Buttons, Pointer and States. For each standard
generator, the Input Engine proposes a set of functions to create and send an event to this generator.

Static Initialization proposes an additional event generator: Touch . A touch event generator is a Pointer event
generator whose area size is the display size where the touch panel is placed. Furthermore, contrary to a pointer,
a press action is required to be able to have amove action (and so a drag action). The Input Engine proposes a set
of functions to target a touch event generator (equal to a pointer event generator but with some constraints). The
touch event generator is identified as a standard Pointer event generator, by consequence the Java application has
to use the Pointer API to deal with a touch event generator.

According to the event generator, one or several parameters are required. The parameter format is event generator
dependant. For instance a Pointer X-coordinate is encoded on 16 bits (0-65535 pixels).

Generic Event Generators

MicroUI provides an abstract class GenericEventGenerator (package ej.microui.event ). The aim of a generic
event generator is to be able to send custom events from native world to MicroEJ application. These events may
be constituted by only one 32-bit word or by several 32-bit words (maximum 255).

On the application side, a subclassmust be implementedby clientswhowant to define their ownevent generators.
Two abstract methods must be implemented by subclasses:

• eventReceived : The event generator received an event from a C driver through the Low Level APIs
sendEvent function.

• eventsReceived : The event generator received an event made of several int s.

The event generator is responsible for converting incoming data into a MicroUI event and sending the event to its
listener. It should be defined during MicroUI Static Initialization step (in the XML file, see Static Initialization). This
allows the MicroUI implementation to instantiate the event generator on startup.

If the event generator is not available in the application classpath, a warning is thrown (with a stack trace) and the
application continues. In this case, all events sent by BSP to this event generator are ignored because no event
generator is able to decode them.
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Low Level API

The implementation of the MicroUI Event Generator APIs provides some Low Level APIs. The BSP has to im-
plement these Low Level APIs, making the link between the MicroUI C library inputs and the BSP input devices
drivers.

The LowLevel APIs to implement are listed in the header file LLUI_INPUT_impl.h . It allows events to be sent to the
MicroUI implementation. The input drivers are allowed to add events directly using the event generator’s unique
ID (see Static Initialization). The drivers are fully dependent on the MicroEJ framework (a driver or a driver listener
cannot be developed without MicroEJ because it uses the header file generated during the MicroUI initialization
step).

To send an event to the MicroEJ application, the driver (or its listener) has to call one of the event engine function,
listed in LLUI_INPUT.h . These functions take as parameter the MicroUI EventGenerator to target and the data.
The event generator is represented by a unique ID. The data depends on the type of the event. To run correctly, the
event engine requires an implementation of functions listed in LLUI_INPUT_impl.h . When an event is added, the
event engine notifies MicroUI library.

Fig. 38: Input Low Level API

When there is no input device on the board, a stub implementation of C library is available. This C library must be
linked by the third-party C IDEwhen theMicroUImodule is installed in theMicroEJ Platform. This stub library does
not provide any Low Level API files.
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Event Bu�er

MicroUI is using a circular bu�er to manage the input events. As soon as an event is added, removed, or replaced
in the queue, the event engine calls the associated Low-Level API (LLAPI) LLUI_INPUT_IMPL_log_queue_xxx() .
This LLAPI allows the BSP to log this event to dump it later thanks to a call to LLUI_INPUT_dump() .

Note: When the functions LLUI_INPUT_IMPL_log_queue_xxx() are not implemented, a call to
LLUI_INPUT_dump() has no e�ect (there is no default logger).

The following steps describe how the logger is called:

1. On startup, MicroUI calls LLUI_INPUT_IMPL_log_queue_init() : it gives the event bu�er. The implementa-
tion should prepare its logger.

2. TheBSP adds or replaces an event in the queue, the event engine calls LLUI_INPUT_IMPL_log_queue_add()
or LLUI_INPUT_IMPL_log_queue_replace() . The implementation should store the eventmetadata: bu�er
index, event size, etc.

3. If the event cannot be added because the queue is full, the event engine calls
LLUI_INPUT_IMPL_log_queue_full() . The implementation can print a warning, throw an error, etc.

4. MicroUI reads an event, the event engine calls LLUI_INPUT_IMPL_log_queue_read() . The implementation
has to update its metadata (if required).

The following steps describe how the dump is performed:

1. The BSP calls LLUI_INPUT_dump() : the event engine starts a dump of the event bu�er.

2. First, the event engine dumps the older events. It calls LLUI_INPUT_IMPL_log_dump() for each old event.
The log type value is 0 ; it means that all logs are the events or events’ data already consumed (past events),
and the first log is the latest event or data stored in the queue.

3. Then, the event engine dumps the future events (events not consumed yet by MicroUI). It calls
LLUI_INPUT_IMPL_log_dump() for each new event. The log type value is 1 ; it means that all logs are the
events or data not consumed yet (future events).

4. The future events can target a MicroUI object (a Displayable for a requestRender event, a Runnable for
a callSerially event, etc.). The event engine notifies the logger to print the MicroUI objects by calling
LLUI_INPUT_IMPL_log_dump() with 2 as log type value.

5. Finally, the event engine notifies the logger about the end of the dump by calling
LLUI_INPUT_IMPL_log_dump() with 3 as log type value.

Warning: The dump of MicroUI objects linked to the future events is only available with the MicroEJ Architec-
tures 7.16 and higher. With older MicroEJ Architectures, nothing is dumped.

An implementation is available on the Cmodule. This logger is constituted with two files:

• LLUI_INPUT_LOG_impl.c : this file holds some metadata for each event. When the event en-
gine calls LLUI_INPUT_IMPL_log_dump() , the logger retrieves the event metadata and calls
microui_event_decoder.c functions. To enable this logger, set the define MICROUIEVENTDECODER_ENABLED
in microui_event_decoder_conf.h .

• microui_event_decoder.c : this file describes the MicroUI events. It has to be customized with the MicroUI
event generators identifiers. See microui_event_decoder_conf.h .

Example of a dump:
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============================== MicroUI FIFO Dump ===============================
---------------------------------- Old Events ----------------------------------
[27: 0x00000000] garbage
[28: 0x00000000] garbage
[...]
[99: 0x00000000] garbage
[00: 0x08000000] Display SHOW Displayable (Displayable index = 0)
[01: 0x00000008] Command HELP (event generator 0)
[02: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[03: 0x07030000] Input event: Pointer pressed (event generator 3)
[04: 0x009f0063] at 159,99 (absolute)
[05: 0x07030600] Input event: Pointer moved (event generator 3)
[06: 0x00aa0064] at 170,100 (absolute)
[07: 0x02030700] Pointer dragged (event generator 3)
[08: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[09: 0x07030600] Input event: Pointer moved (event generator 3)
[10: 0x00b30066] at 179,102 (absolute)
[11: 0x02030700] Pointer dragged (event generator 3)
[12: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[13: 0x07030600] Input event: Pointer moved (event generator 3)
[14: 0x00c50067] at 197,103 (absolute)
[15: 0x02030700] Pointer dragged (event generator 3)
[16: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[17: 0x07030600] Input event: Pointer moved (event generator 3)
[18: 0x00d00066] at 208,102 (absolute)
[19: 0x02030700] Pointer dragged (event generator 3)
[20: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[21: 0x07030100] Input event: Pointer released (event generator 3)
[22: 0x00000000] at 0,0 (absolute)
[23: 0x00000008] Command HELP (event generator 0)
---------------------------------- New Events ----------------------------------
[24: 0x0d000000] Display REPAINT Displayable (Displayable index = 0)
[25: 0x07030000] Input event: Pointer pressed (event generator 3)
[26: 0x002a0029] at 42,41 (absolute)
--------------------------- New Events' Java objects ---------------------------
[java/lang/Object[2]@0xC000FD1C

[0] com/microej/examples/microui/mvc/MVCDisplayable@0xC000BAC0
[1] null

================================================================================

Notes:

• The event 24 holds an object in the events objects array (a Displayable ); its object index is 0 .

• An object is null when the memory slot has been used during the application execution but freed at the
dump time.

• The object array’ size is the maximum of non-null objects reached during application execution.

• The indices of old events are out-of-date: the memory slot is now null or reused by a newer event.

• The event 25 targets the event generator 3 ; the identifier is available in microui_constants.h (created
during the MicroEJ Platform build, see Static Initialization).

• The events 27 to 99 cannot be identified (nometadata or partial event content due to circular queueman-
agement).

• Refers to the implementation on the Cmodule to have more information about the format of the event; this
implementation is always up-to-date with the MicroUI implementation.
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Dependencies

• MicroUI module (seeMicroUI)

• Static MicroUI initialization step (see Static Initialization). This step generates a header file which contains
some unique event generator IDs. These IDs must be used in the BSP to make the link between the input
devices drivers and the MicroUI Event Generator s.

• LLUI_INPUT_impl.h implementation (see LLUI_INPUT: Input).

Installation

Inputmodule is a sub-part of the MicroUI library. The Inputmodule is installed at same time thanMicroUImodule.

Use

The MicroUI Input APIs are available in the classes of packages ej.microui.event and ej.microui.event.
generator .

4.13.7 Display

Principle

The Display module contains the C part of the MicroUI implementation which manages graphical displays. This
module is composed of three elements:

• the C part of MicroUI Display API (a built-in C archive) called Graphics Engine,

• an implementation of a Low Level APIs for the displays (LLUI_DISPLAY) that the BSP must provide (see
LLUI_DISPLAY: Display),

• an implementation of a Low Level APIs for MicroUI drawings.

Functional Description

TheDisplaymodule implements theMicroUI graphics framework. This framework is constitutedof several notions:
the display characteristics (size, format, backlight, contrast, etc.), the drawing state machine (render, flush, wait
flush completed), the images life cycle, the fonts and drawings. Themain part of the Displaymodule is provided by
abuilt-inCarchive calledGraphics Engine. This librarymanages thedrawing statemachinemechanism, the images
and fonts. The display characteristics and the drawings are managed by the LLUI_DISPLAY implementation.

The Graphics Engine is designed to let the BSP use an optional graphics processor unit (GPU) or an optional third-
party drawing library. Each drawing can be implemented independently. If no extra framework is available, the
Graphics Engine performs all drawings in so�ware. In this case, the BSP has to perform a very simple implementa-
tion (four functions) of the Graphics Engine low-level APIs.

MicroUI library also gives the possibility to perform some additional drawings which are not available as API in
MicroUI library. The Graphics Engine gives a set of functions to synchronize the drawings between them, to get the
destination (and sometimes source) characteristics, to call internal so�ware drawings, etc.

Front Panel (simulator Graphics Engine part) gives the same possibilities. Same constraints can be applied, same
drawings can be overridden or added, same so�ware drawing rendering is performed (down to the pixel).
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Display Configurations

The Graphics Engine provides a number of di�erent configurations. The appropriate configuration should be se-
lected depending on the capabilities of the screen and other related hardware, such as display controllers.

The modes can vary in three ways:

• the bu�er mode: double-bu�er, simple bu�er (also known as direct),

• the memory layout of the pixels,

• pixel format or depth.

Bu�er Modes

Overview

When using the double bu�ering technique, the memory into which the application draws (called graphics bu�er
or back bu�er) is not the memory used by the screen to refresh it (called frame bu�er or display bu�er). When
everything has been drawn consistently from the application point of view, the back bu�er contents are synchro-
nizedwith the display bu�er. Double bu�ering avoids flickering and inconsistent rendering: it is well suited to high
quality animations.

For more static display-based applications, and/or to savememory, an alternative configuration is to use only one
bu�er, shared by both the application and the screen.

Displays addressed by one of the standard configurations are called generic displays. For these generic displays,
there are three bu�ermodes: switch, copy and direct. The following flow chart provides a handy guide to selecting
the appropriate bu�er mode according to the hardware configuration.
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Fig. 39: Bu�er Modes

Implementation

The Graphics Engine does not depend on the type of bu�er mode. The implementation of Display.flush() calls
the Low Level API LLUI_DISPLAY_IMPL_flush to let the BSP to update the display data. This function should be
atomic and the implementationhas to return thenewgraphics bu�er address (backbu�er address). In direct and
copy modes, this address never changes and the implementation has always to return the back bu�er address. In
switch mode, the implementation has to return the old display frame bu�er address.

The next sections describe the work to do for eachmode.
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Switch

The switch mode is a double-bu�ered mode where two bu�ers in RAM alternately play the role of the back bu�er
and the display bu�er. The display source is alternatively changed from one bu�er to the other. Switching the
source address may be done asynchronously. The synchronize function is called before starting the next set of
draw operations, andmust wait until the driver has switched to the new bu�er.

Synchronization steps are described below.

• Step 1: Drawing
MicroUI is drawing in bu�er 0 (back bu�er) and the display is reading its contents from bu�er 1 (display
bu�er).

• Step 2: Switch
The drawing is done. Set that the next read will be done from bu�er 0.
Note that the display “hardware component” asynchronously continues to read data from bu�er 1.

• Step 3: Copy
A copy from the bu�er 0 (new display bu�er) to the bu�er 1 (new back bu�er) must be done to keep the
contents of the current drawing. The copy routine must wait until the display has finished the switch, and
start asynchronously by comparison with the MicroUI drawing routine (see next step).
This copy routine can be done in a dedicated RTOS task or in an interrupt routine. The copy should start
a�er the display “hardware component” has finished a full bu�er read to avoid flickering.
Usually a tearing signal from the display at the end of the read of the previous bu�er (bu�er 1) or at the
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beginning of the read of the new bu�er (bu�er 0) throws an interrupt. The interrupt routine starts the copy
using a DMA.
If it is not possible to start an asynchronous copy, the copy must be performed in the MicroUI drawing
routine, at the beginning of the next step.
Note that the copy is partial: only the parts that have changed need to be copied, lowering the CPU load.

• Step 4: Synchronisation
Waits until the copy routine has finished the full copy.
If the copy has not been done asynchronously, the copy must start a�er the display has finished the switch.
It is a blocking copy because the next drawing operation has to wait until this copy is done.

• Step 5: Next draw operation
Same behavior as step 1 with bu�ers reversed.

Copy

The copy mode is a double-bu�ered mode where the back bu�er is in RAM and has a fixed address. To update the
display, data is sent to the display bu�er. This can be done either by a memory copy or by sending bytes using a
bus, such as SPI or I2C.

Synchronization steps are described below.

• Step 1: Drawing
MicroUI is drawing in the back bu�er and the display is reading its content from the display bu�er.
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• Step 2: Copy
The drawing is done. A copy from the back bu�er to the display bu�er is triggered.
Note that the implementation of the copy operation may be done asynchronously – it is recommended to
wait until the display “hardware component” has finished a full bu�er read to avoid flickering. At the
implementation level, the copy may be done by a DMA, a dedicated RTOS task, interrupt, etc.

• Step 3: Synchronization
The next drawing operation waits until the copy is complete.
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Direct

The directmode is a single-bu�eredmodewhere the samememory area is used for the back bu�er and the display
bu�er (See illustration below). Use of the directmode is likely to result in “noisy” rendering and flickering, but saves
one bu�er in runtimememory.

Partial Bu�er

In the case where RAM usage is not a constraint, the graphics bu�er is sized to store all the pixel data of the screen.
However, when the RAM available on the device is very limited, a partial bu�er can be used instead. In that case,
the bu�er is smaller and can only store a part of the screen (one third for example).

When this technique is used, the application draws in the partial bu�er. To flush the drawings, the content of the
partial bu�er is copied to the display (to its internal memory or to a complete bu�er fromwhich the display reads).

If the display does not have its own internal memory and if the device does not have enough RAM to allocate a
complete bu�er, then it is not possible to use a partial bu�er. In that case, only the Direct bu�ermode can be used.

Workflow

A partial bu�er of the desired size has to be allocated in RAM. If the display does not have its own internal memory,
a complete bu�er also has to be allocated in RAM, and the display has to be configured to read from the complete
bu�er.

The implementation should follow these steps:

1. First, the application draws in the partial bu�er.

2. Then, to flush the drawings on the screen, the data of the partial bu�er is sent to the display (either copied
to its internal memory or to the complete bu�er in RAM).

3. Finally, a synchronization is required before starting the next drawing operation.

Dual Partial Bu�er

A second partial bu�er can be used to avoid the synchronization delay before between two drawing cycles. While
one of the two partial bu�ers is being copied to the display, the application can start drawing in the second partial
bu�er.
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This technique is interesting when the copy time is long. The downside is that it requires more RAM or to reduce
the size of the partial bu�ers.

Using a dual partial bu�er has no impact on the application code.

Application Limitations

Using a partial bu�er rather than a complete bu�ermay require adapting the code of the application, since render-
ing a graphical element may require multiple passes. If the application uses MWT, a custom render policy has to be
used.

Besides, the GraphicsContext.readPixel() and the GraphicsContext.readPixels() APIs can not be used on the graph-
ics context of the display in partial bu�er mode. Indeed, we cannot rely on the current content of the back bu�er
as it doesn’t contain what is seen on the screen.

Likewise, the Painter.drawDisplayRegion() API can not be used in partial bu�er mode. Indeed, this API reads the
content of the back bu�er in order to draw a region of the display. Instead of relying on the drawings which were
performed previously, this API should be avoided and the drawings should be performed again.

Using a partial bu�er can have a significant impact on animation performance. Refer to Animations for more infor-
mation on the development of animations in an application.

Implementation Example

The partial bu�er demo provides an example of partial bu�er implementation. This example explains how to im-
plement partial bu�er support in the BSP and how to use it in an application.

Byte Layout

This chapter concerns only display with a number of bits-per-pixel (BPP) smaller than 8. For this kind of display, a
byte contains several pixels and the Graphics Engine allows to customize how to organize the pixels in a byte.

Two layouts are available:

• line: The byte contains several consecutive pixels on same line. When the end of line is reached, a padding is
added in order to start a new line with a new byte.

• column: The byte contains several consecutive pixels on same column. When the end of column is reached,
a padding is added in order to start a new column with a new byte.

When installing the Displaymodule, a property byteLayout is required to specify the kind of pixels representation
(see Installation).

Table 11: Byte Layout: line
BPP MSB LSB
4 pixel 1 pixel 0
2 pixel 3 pixel 2 pixel 1 pixel 0
1 pixel 7 pixel 6 pixel 5 pixel 4 pixel 3 pixel 2 pixel 1 pixel 0
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Table 12: Byte Layout: column
BPP 4 2 1
MSB pixel 1 pixel 3 pixel 7

pixel 6
pixel 2 pixel 5

pixel 4
pixel 0 pixel 1 pixel 3

pixel 2
pixel 0 pixel 1

LSB pixel 0

Memory Layout

For the displaywith a number of bits-per-pixel (BPP) higher or equal to 8, the Graphics Engine supports the line-by-
linememory organization: pixels are laid out from le� to right within a line, starting with the top line. For a display
with 16 bits-per-pixel, the pixel at (0,0) is stored at memory address 0, the pixel at (1,0) is stored at address 2, the
pixel at (2,0) is stored at address 4, and so on.

Table 13: Memory Layout for BPP >= 8
BPP @ + 0 @ + 1 @ + 2 @ + 3 @ + 4
32 pixel 0 [7:0] pixel 0 [15:8] pixel 0 [23:16] pixel 0 [31:24] pixel 1 [7:0]
24 pixel 0 [7:0] pixel 0 [15:8] pixel 0 [23:16] pixel 1 [7:0] pixel 1 [15:8]
16 pixel 0 [7:0] pixel 0 [15:8] pixel 1 [7:0] pixel 1 [15:8] pixel 2 [7:0]
8 pixel 0 [7:0] pixel 1 [7:0] pixel 2 [7:0] pixel 3 [7:0] pixel 4 [7:0]

For the display with a number of bits-per-pixel (BPP) lower than 8, the Graphics Engine supports the bothmemory
organizations: line by line (pixels are laid out from le� to right within a line, starting with the top line) and column
by column (pixels are laid out from top to bottomwithin a line, starting with the le� line). These byte organizations
concern until 8 consecutive pixels (seeByte Layout). When installing theDisplaymodule, a property memoryLayout
is required to specify the kind of pixels representation (see Installation).

Table 14: Memory Layout ‘line’ for BPP < 8 and byte layout ‘line’
BPP @ + 0 @ + 1 @ + 2 @ + 3 @ + 4
4 (0,0) to (1,0) (2,0) to (3,0) (4,0) to (5,0) (6,0) to (7,0) (8,0) to (9,0)
2 (0,0) to (3,0) (4,0) to (7,0) (8,0) to (11,0) (12,0) to (15,0) (16,0) to (19,0)
1 (0,0) to (7,0) (8,0) to (15,0) (16,0) to (23,0) (24,0) to (31,0) (32,0) to (39,0)

Table 15: Memory Layout ‘line’ for BPP < 8 and byte layout ‘column’
BPP @ + 0 @ + 1 @ + 2 @ + 3 @ + 4
4 (0,0) to (0,1) (1,0) to (1,1) (2,0) to (2,1) (3,0) to (3,1) (4,0) to (4,1)
2 (0,0) to (0,3) (1,0) to (1,3) (2,0) to (2,3) (3,0) to (3,3) (4,0) to (4,3)
1 (0,0) to (0,7) (1,0) to (1,7) (2,0) to (2,7) (3,0) to (3,7) (4,0) to (4,7)

Table 16: Memory Layout ‘column’ for BPP < 8 and byte layout ‘line’
BPP @ + 0 @ + 1 @ + 2 @ + 3 @ + 4
4 (0,0) to (1,0) (0,1) to (1,1) (0,2) to (1,2) (0,3) to (1,3) (0,4) to (1,4)
2 (0,0) to (3,0) (0,1) to (3,1) (0,2) to (3,2) (0,3) to (3,3) (0,4) to (3,4)
1 (0,0) to (7,0) (0,1) to (7,1) (0,2) to (7,2) (0,3) to (7,3) (0,4) to (7,4)
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Table 17: Memory Layout ‘column’ for BPP < 8 andbyte layout ‘column’
BPP @ + 0 @ + 1 @ + 2 @ + 3 @ + 4
4 (0,0) to (0,1) (0,2) to (0,3) (0,4) to (0,5) (0,6) to (0,7) (0,8) to (0,9)
2 (0,0) to (0,3) (0,4) to (0,7) (0,8) to (0,11) (0,12) to (0,15) (0,16) to (0,19)
1 (0,0) to (0,7) (0,8) to (0,15) (0,16) to (0,23) (0,24) to (0,31) (0,32) to (0,39)

Pixel Structure

Principle

The Display module provides pre-built display configurations with standard pixel memory layout. The layout of
the bits within the pixel may be standard or driver-specific. When installing the Display module, a property bpp is
required to specify the kind of pixel representation (see Installation).

Standard

When the value is one among this list: ARGB8888 | RGB888 | RGB565 | ARGB1555 | ARGB4444 | C4 | C2 | C1
, the Display module considers the pixels representation as standard. All standard representations are internally
managed by the Displaymodule, by the Front Panel and by the Image Generator. No specific support is required as
soon as a MicroEJ Platform is using a standard representation. It can:

• generate at compile-time RAW images in the same format than display pixel format,

• convert at runtime MicroUI 32-bit colors in display pixel format,

• simulate at runtime the display pixel format.

Note: The custom implementations of the image generator, low-level APIs, and Front Panel APIs are ignored by
the Display module when a standard pixel representation is selected.

According to the chosen format, some color data can be lost or cropped.

• ARGB8888: the pixel uses 32 bits-per-pixel (alpha[8], red[8], green[8] and blue[8]).

u32 convertARGB8888toLCDPixel(u32 c){
return c;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return c;

}

• RGB888: the pixel uses 24 bits-per-pixel (alpha[0], red[8], green[8] and blue[8]).

u32 convertARGB8888toLCDPixel(u32 c){
return c & 0xffffff;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| 0xff000000
| c

(continues on next page)
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;
}

• RGB565: the pixel uses 16 bits-per-pixel (alpha[0], red[5], green[6] and blue[5]).

u32 convertARGB8888toLCDPixel(u32 c){
return 0

| ((c & 0xf80000) >> 8)
| ((c & 0x00fc00) >> 5)
| ((c & 0x0000f8) >> 3)
;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| 0xff000000
| ((c & 0xf800) << 8)
| ((c & 0x07e0) << 5)
| ((c & 0x001f) << 3)
;

}

• ARGB1555: the pixel uses 16 bits-per-pixel (alpha[1], red[5], green[5] and blue[5]).

u32 convertARGB8888toLCDPixel(u32 c){
return 0

| (((c & 0xff000000) == 0xff000000) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)
;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| ((c & 0x8000) == 0x8000 ? 0xff000000 : 0x00000000)
| ((c & 0x7c00) << 9)
| ((c & 0x03e0) << 6)
| ((c & 0x001f) << 3)
;

}

• ARGB4444: the pixel uses 16 bits-per-pixel (alpha[4], red[4], green[4] and blue[4]).

u32 convertARGB8888toLCDPixel(u32 c){
return 0

| ((c & 0xf0000000) >> 16)
| ((c & 0x00f00000) >> 12)
| ((c & 0x0000f000) >> 8)
| ((c & 0x000000f0) >> 4)
;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| ((c & 0xf000) << 16)

(continues on next page)
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| ((c & 0xf000) << 12)
| ((c & 0x0f00) << 12)
| ((c & 0x0f00) << 8)
| ((c & 0x00f0) << 8)
| ((c & 0x00f0) << 4)
| ((c & 0x000f) << 4)
| ((c & 0x000f) << 0)
;

}

• C4: the pixel uses 4 bits-per-pixel (grayscale[4]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / 0x11;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * 0x111111);

}

• C2: the pixel uses 2 bits-per-pixel (grayscale[2]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / 0x55;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * 0x555555);

}

• C1: the pixel uses 1 bit-per-pixel (grayscale[1]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / 0xff;

}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * 0xffffff);

}

Driver-Specific

The Display module considers the pixel representation as driver-specificwhen the value is one among this list: 1
| 2 | 4 | 8 | 16 | 24 | 32 . Thismode is o�en usedwhen the pixel representation is not ARGB or RGB but BGRA
or BGR instead. This mode can also be used when the number of bits for a color component (alpha, red, green, or
blue) is not standard or when the value does not represent a color but an index in a CLUT. Thismode requires some
specific support in the MicroEJ Platform:

• An extension of the image generator is mandatory: see Extended Mode to convert MicroUI’s standard 32-bit
ARGB colors to display pixel format.

• The Front Panel widget Display requires an extension to convert the MicroUI 32-bit colors in display pixel
format and vice-versa, seeWidget Display.

• The driver must implement functions that convert MicroUI’s standard 32-bit ARGB colors to display pixel for-
mat and vice-versa: see Color Conversions.
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The followingexample illustrates theuseof specific formatBGR565 (thepixeluses 16bits-per-pixel (alpha[0], red[5],
green[6] and blue[5]):

1. Configure the MicroEJ Platform:

• Create or open the Platform configuration project file display/display.properties :

bpp=16

2. Image Generator:

• Create a project as described here.

• Create the class com.microej.graphicalengine.generator.MicroUIGeneratorExtension
that extends the class com.microej.tool.ui.generator.BufferedImageLoader .

• Fill the method convertARGBColorToDisplayColor() :

public class MicroUIGeneratorExtension extends BufferedImageLoader {
@Override
public int convertARGBColorToDisplayColor(int color) {

return ((color & 0xf80000) >> 19) | ((color & 0x00fc00) >> 5) | ((color & 0x0000f8) <<␣
→˓8);

}
}

• Configure the ImageGenerator’ service loader: add the file /META-INF/services/com.microej.
tool.ui.generator.MicroUIRawImageGeneratorExtension :

com.microej.graphicalengine.generator.MicroUIGeneratorExtension

• Build the module (click on the blue button).

• Copy the generated jar file ( imageGeneratorMyPlatform.jar ) in the MicroEJ Platform configu-
ration project: /dropins/tools/ .

2. Simulator (Front Panel):

• Create the class com.microej.fp.MyDisplayExtension that implements the interface ej.fp.
widget.Display.DisplayExtension :

public class MyDisplayExtension implements DisplayExtension {

@Override
public int convertARGBColorToDisplayColor(Display display, int color) {

return ((color & 0xf80000) >> 19) | ((color & 0x00fc00) >> 5) | ((color & 0x0000f8) << 8);
}

@Override
public int convertDisplayColorToARGBColor(Display display, int color) {

return ((color & 0x001f) << 19) | ((color & 0x7e00) << 5) | ((color & 0xf800) >> 8) |␣
→˓0xff000000;

}

@Override
public boolean isColor(Display display) {

return true;
}

@Override

(continues on next page)
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public int getNumberOfColors(Display display) {
return 1 << 16;

}
}

• Configure the widget Display in the .fp file by referencing the display extension:

<ej.fp.widget.Display x="41" y="33" width="320" height="240" extensionClass="com.microej.fp.
→˓MyDisplayExtension"/>

3. Build the MicroEJ Platform as usual

4. Update the LLUI_DISPLAY implementation by adding the following functions:

uint32_t LLUI_DISPLAY_IMPL_convertARGBColorToDisplayColor(uint32_t color)
{

return ((color & 0xf80000) >> 19) | ((color & 0x00fc00) >> 5) | ((color & 0x0000f8) << 8);
}

uint32_t LLUI_DISPLAY_IMPL_convertDisplayColorToARGBColor(uint32_t color)
{

return ((color & 0x001f) << 19) | ((color & 0x7e00) << 5) | ((color & 0xf800) >> 8) |␣
→˓0xff000000;
}

Low Level API

Overview

Fig. 40: Display Low Level API

• MicroUI library calls the BSP functions through the Graphics Engine and header file LLUI_DISPLAY_impl.h .

• Implementation of LLUI_DISPLAY_impl.h can call Graphics Engine functions through LLUI_DISPLAY.h .

• To perform some drawings, MicroUI uses LLUI_PAINTER_impl.h functions.

• The C module provides a default implementation of the drawing native functions of LLUI_PAINTER_impl.h
and LLDW_PAINTER_impl.h : * It implements the synchronization layer, then redirects drawings implemen-
tations to ui_drawing.h and dw_drawing.h

• ui_drawing.h and dw_drawing.h arealready implementedbybuilt-in so�warealgorithms (libraryprovided
by the UI Pack).
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• It is possible to implement some of the ui_drawing.h and dw_drawing.h functions in the BSP to provide
a custom implementation (for instance, a GPU). * Custom implementation is still allowed to call so�ware
algorithms declared in ui_drawing_soft.h and dw_drawing_soft.h .

Required Low Level API

Some four LowLevel APIs are required to connect theGraphics Engineon thedisplaydriver. The functions are listed
in LLUI_DISPLAY_impl.h .

• LLUI_DISPLAY_IMPL_initialize : The initialization function is called when MicroEJ application is calling
MicroUI.start() . Before this call, the display is useless and don’t need to be initialized. This function con-
sists in initializing the LCD driver and in filling the given structure LLUI_DISPLAY_SInitData . This structure
has to contain pointers on two binary semaphores (see a�er), the back bu�er address (see Display Configu-
rations), the display virtual size in pixels and optionally the display physical size in pixels. The display virtual
size is the size of the area where the drawings are visible. The display physical size is the required memory
size where the area is located. Virtual memory size is: display_width * display_height * bpp / 8 .
On some devices the memory width (in pixels) is higher than virtual width. In this way, the graphics bu�er
memory size is: memory_width * memory_height * bpp / 8 .

• LLUI_DISPLAY_IMPL_binarySemaphoreTake and LLUI_DISPLAY_IMPL_binarySemaphoreGive : TheGraph-
ics Engine requires two binary semaphores to synchronize its internal states. The binary semaphores must
be configured in a state such that the semaphore must first be given before it can be taken (this initializa-
tion must be performed in LLUI_DISPLAY_IMPL_initialize function). Two distinct functions have to be
implemented to take and give a binary semaphore.

• LLUI_DISPLAY_IMPL_flush : According thedisplaybu�ermode (seeDisplayConfigurations), the flush func-
tion has to be implemented. This function must not be blocking and not performing the copy directly. An-
other OS task or a dedicated hardware must be configured to perform the bu�er copy.

Optional Low Level API

Several optional Low Level API are available in LLUI_DISPLAY_impl.h . They are already implemented as weak
functions in the Graphics Engine and return no error. These optional features concern the display backlight and
constrast, display characteristics (is colored display, double bu�er), colors conversions (see Pixel Structure and
CLUT), etc. Refer to each function comment to have more information about the default behavior.

Painter Low Level API

AllMicroUIdrawings (available in Painter class) are callinganative function. TheMicroUInativedrawing functions
are listed in LLUI_PAINTER_impl.h . The implementationmust takecareabouta lotof constraints: synchronization
between drawings, Graphics Engine notification, MicroUI GraphicsContext clip and colors, flush dirty area, etc.
The principle of implementing a MicroUI drawing function is described in the chapter Drawing Native.

An implementation of LLUI_PAINTER_impl.h is already available on the C module. This implementation re-
spects the synchronization between drawings, the Graphics Engine notification, reduce (when possible) the Mi-
croUI GraphicsContext clip constraints and update (when possible) the flush dirty area. This implementation
does not perform the drawings. It only calls the equivalent of drawing available in ui_drawing.h . This allows to
simplify how to use a GPU (or a third-party library) to perform a drawing: the ui_drawing.h implementation has
just to take in consideration the MicroUI GraphicsContext clip and colors and flush dirty area. Synchronization
with the Graphics Engine is already performed.

In addition to the implementation of LLUI_PAINTER_impl.h , an implementation of ui_drawing.h is already
available in Graphics Engine (in weakmode). This allows to implement only the functions the GPU is able to per-
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form. For a given drawing, the weak function implementation is calling the equivalent of drawing available in
ui_drawing_soft.h . This file lists all drawing functions implemented by the Graphics Engine.

The Graphics Engine implementation of ui_drawing_soft.h is performing the drawings in so�ware. However
some drawings can call another ui_drawing.h function. For instance UI_DRAWING_SOFT_drawHorizontalLine
is calling UI_DRAWING_fillRectangle in order to use aGPU if available. If not available, theweak implementation
of UI_DRAWING_fillRectangle is calling UI_DRAWING_SOFT_fillRectangle and so on.

The BSP implementation is also allowed to call ui_drawing_soft.h algorithms, one or several times per function
to implement. For instance, a GPUmay be able to draw an image whose format is RGB565. But if the image format
is ARGB1555, BSP implementation can call UI_DRAWING_SOFT_drawImage function.

Graphics Engine API

The Graphics Engine provides a set of functions to interact with the C archive. The functions allow to retrieve some
drawing characteristics, synchronize drawings between them, notify the end of flush and drawings, etc.

The functions are available in LLUI_DISPLAY.h .

Drawing Native

As explained before, MicroUI implementation provides a dedicated header file which lists all MicroUI Painter draw-
ings native function. The implementation of these functions has to respect several rules to not corrupt the MicroUI
execution (flickering,memory corruption, unknownbehavior, etc.). These rules arealready respected in thedefault
AbstractionLayer implementationmodules availableon theCmodule. In addition,MicroUI allows toadd somecus-
tom drawings. The implementation of MicroUI Painter native drawings should be used asmodel to implement the
custom drawings.

All native functions must have a MICROUI_GraphicsContext* as parameter (o�en first parameter). This identi-
fies the destination target: the MicroUI GraphicsContext. This target is retrieved in MicroEJ application calling the
method GraphicsContext.getSNIContext() . This method returns a byte array which is directly mapped on the
MICROUI_GraphicsContext structure in MicroUI native drawing function declaration.

A graphics context holds a clip and the drawer is not allowed to perform a drawing outside this clip (otherwise the
behavior is unknown). Note the bottom-right coordinates might be smaller than top-le� (in x and/or y) when the
clip width and/or height is null. The clip may be disabled (when the current drawing fits the clip); this allows to
reduce runtime. See LLUI_DISPLAY_isClipEnabled() .

Note: Several clip functions are available in LLUI_DISPLAY.h to check if a drawing fits the clip.

The Graphics Engine requires the synchronization between the drawings. To do that, it requires a call to
LLUI_DISPLAY_requestDrawing at the beginning of native function implementation. This function takes as pa-
rameter the graphics context and the pointer on the native function itself. This pointer must be casted in a
SNI_callback .

The drawing function must update the next Display.flush() area (dirty area). If not performed, the next call to Dis-
play.flush() will not call LLUI_DISPLAY_IMPL_flush() function.

The native function implementation pattern is:

void Java_com_mycompany_MyPainterClass_myDrawingNative(MICROUI_GraphicsContext* gc, ...)
{

// tell to the Graphics Engine if drawing can be performed
if (LLUI_DISPLAY_requestDrawing(gc, (SNI_callback)&Java_com_mycompany_MyPainterClass_

→˓myDrawingNative))
(continues on next page)
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(continued from previous page)

{
DRAWING_Status status;

// perform the drawings (respecting clip if not disabled)
[...]

// update new flush dirty area
LLUI_DISPLAY_setDrawingLimits(gc, ...);

// set drawing status
LLUI_DISPLAY_setDrawingStatus(DRAWING_DONE); // or DRAWING_RUNNING;

}
// else: refused drawing

}

Display Synchronization

Overview

TheGraphics Engine is designed tobe synchronizedwith thedisplay refresh rate bydefining somepoints in the ren-
dering timeline. It is optional; however it ismainly recommanded. This chapter explains why to use display tearing
signal and its consequences. Some chronograms describe several use cases: with and without display tearing sig-
nal, long drawings, long flush time, etc. Times are in milliseconds. To simplify chronograms views, the display
refresh rate is every 16ms (62.5Hz).

Captions definition:

• UI: It is the UI task which performs the drawings in the back bu�er. At the end of the drawings, the examples
consider that the UI thread calls Display.flush() 1 millisecond a�er the end of the drawings. At this moment,
a flush can start (the call to Display.flush() is symbolized by a simple peak in chronograms).

• Flush: In copy mode, it is the time to transfer the content of back bu�er to display bu�er. In switchmode, it
is the time to swap back and display bu�ers (o�en instantaneous) and the time to recopy the content of new
display bu�er to new back bu�er. During this time, the back bu�er is in use and UI task has to wait the end of
copy before starting a new drawing.

• Tearing: The peaks show the tearing signals.

• Rendering frequency: the frequency between the start of a drawing to the end of flush.

Tearing Signal

In this example, the drawing time is 7ms, the time between the end of drawing and the call to Display.flush() is
1ms and the flush time is 6ms. So the expected rendering frequency is 7 + 1 + 6 = 14ms (71.4Hz). Flush starts just
a�er the call to Display.flush() and the next drawing starts just a�er the end of flush. Tearing signal is not taken in
consideration. By consequence the display content is refreshed during the display refresh time. The content can
be corrupted: flickering, glitches, etc. The rendering frequency is faster than display refresh rate.
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In this example, the timesare identical topreviousexample. The tearing signal isused tostart the flush in respecting
the display refreshing time. The rendering frequency becomes smaller: it is cadenced on the tearing signal, every
16ms (62.5Hz). During 2ms, the CPU can schedule other tasks or goes in idle mode. The rendering frequency is
equal to display refresh rate.

In this example, the drawing time is 14ms, the time between the end of drawing and the call to Display.flush() is
1ms and the flush time is 6ms. So the expected rendering frequency is 14 + 1 + 6 = 21ms (47.6Hz). Flush starts just
a�er the call to Display.flush() and the next drawing starts just a�er the end of flush. Tearing signal is not taken in
consideration.

In this example, the timesare identical topreviousexample. The tearing signal isused tostart the flush in respecting
the display refreshing time. The drawing time + flush time is higher than display tearing signal period. So the flush
cannot start at every tearing peak: it is cadenced on two tearing signals, every 32ms (31.2Hz). During 11ms, the CPU
can schedule other tasks or goes in idle mode. The rendering frequency is equal to display refresh rate divided by
two.

Additional Bu�er

Some devices take a lot of time to send back bu�er content to display bu�er. The following examples demonstrate
the consequence on rendering frequency. The use of an additional bu�er optimizes this frequency, however it uses
a lot of RAMmemory.

In this example, the drawing time is 7ms, the time between the end of drawing and the call to Display.flush() is
1ms and the flush time is 12ms. So the expected rendering frequency is 7 + 1 + 12 = 20ms (50Hz). Flush starts just
a�er the call to Display.flush() and the next drawing starts just a�er the end of flush. Tearing signal is not taken in
consideration. The rendering frequency is cadenced on drawing time + flush time.

4.13. Graphical User Interface 390

https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--


MicroEJ Documentation, Revision 2788b3f4

As mentionned above, the idea is to use two back bu�ers. First, UI task is drawing in back bu�er A . Just a�er the
call to Display.flush(), the flush can start. At same moment, the content of back bu�er A is copied in back bu�er
B (use a DMA, copy time is 1ms). During the flush time (copy of back bu�er A to display bu�er), the back bu�er
B can be used by UI task to continue the drawings. When the drawings in back bu�er B are done (and a�er call
to Display.flush()), the DMA copy of back bu�er B to back bu�er A cannot start: the copy can only start when the
flush is fully done because the flush is using the back bu�er A . As soon as the flush is done, a new flush (and DMA
copy) can start. The rendering frequency is cadenced on flush time, ie 12ms (83.3Hz).

The previous example doesn’t take in consideration the display tearing signal. With tearing signal and only one
back bu�er, the frequency is cadenced on two tearing signals (see previous chapter). With two back bu�ers, the
frequency is now cadenced on only one tearing signal, despite the long flush time.

Time Sum-up

The following table resumes the previous examples times:

• It consider the display frequency is 62.5Hz (16ms).

• Drawing time is the time let to the application to perform its drawings and call Display.flush(). In our exam-
ples, the time between the last drawing and the call to Display.flush() is 1ms.

• FPS and CPU load are calculated from examples times.

• Max drawing time is the maximum time let to the application to perform its drawings, without overlapping
next display tearing signal (when tearing is enabled).

Tear-
ing

Nb
bu�ers

Drawing time
(ms)

Flush time
(ms)

DMA copy time
(ms)

FPS
(Hz)

CPU load
(%)

Maxdrawing time
(ms)

no 1 7+1 6 71.4 57.1
yes 1 7+1 6 62.5 50 10
no 1 14+1 6 47.6 71.4
yes 1 14+1 6 31.2 46.9 20
no 1 7+1 12 50 40
yes 1 7+1 12 31.2 25 8
no 2 7+1 12 1 83.3 66.7
yes 2 7+1 12 1 62.5 50 11

4.13. Graphical User Interface 391

https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--


MicroEJ Documentation, Revision 2788b3f4

GPU Synchronization

When a GPU is used to perform a drawing, the caller (MicroUI painter native method) returns immediately. This
allows the MicroEJ application to perform other operations during the GPU rendering. However, as soon as the
MicroEJ application is trying to perform another drawing, the previous drawing made by the GPU must be done.
The Graphics Engine is designed to be synchronizedwith the GPU asynchronous drawings by defining some points
in the rendering timeline. It is not optional: MicroUI considers a drawing is fully donewhen it starts a new one. The
end of GPU drawing must notify the Graphics Engine calling LLUI_DISPLAY_drawingDone() .

Antialiasing

Fonts

The antialiasing mode for the fonts concerns only the fonts with more than 1 bit per pixel (see Font Generator).

Background Color

For each pixel to draw, the antialiasing process blends the foreground color with a background color. This back-
ground color can be specified or not by the application:

• specified: Thebackgroundcolor is fixedby theMicroEJApplication (GraphicsContext.setBackgroundColor()).

• not specified: The background color is the original color of the destination pixel (a “read pixel” operation is
performed for each pixel).

CLUT

The Display module allows to target display which uses a pixel indirection table (CLUT). This kind of display are
considered as generic but not standard (see Pixel Structure). It consists to store color indices in image memory
bu�er instead of colors themselves.

Color Conversion

The driver must implement functions that convert MicroUI’s standard 32-bit ARGB colors (see LLUI_DISPLAY: Dis-
play) to display color representation. For each application ARGB8888 color, the display driver has to find the cor-
responding color in the table. The Graphics Engine will store the index of the color in the table instead of using the
color itself.

When an application color is not available in the display driver table (CLUT), the display driver can try to find the
closest color or return a default color. First solution is o�en quite di�icult to write and can cost a lot of time at
runtime. That’s why the second solution is preferred. However, a consequence is that the application has only to
use a range of colors provided by the display driver.

Alpha Blending

MicroUI and the Graphics Engine use blending when drawing some texts or anti-aliased shapes. For each pixel to
draw, the display stack blends the current application foreground colorwith the targetedpixel current color orwith
the current application background color (when enabled). This blending creates some intermediate colors which
are managed by the display driver.
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Most of time the intermediate colors do not match with the palette. The default color is so returned and
the rendering becomes wrong. To prevent this use case, the Graphics Engine o�ers a specific Low Level API
LLUI_DISPLAY_IMPL_prepareBlendingOfIndexedColors(void* foreground, void* background) .

This API is only used when a blending is required and when the background color is enabled. The Graphics Engine
calls the API just before the blending and gives as parameter the pointers on the both ARGB colors. The display
driver should replace the ARGB colors by the CLUT indices. Then the Graphics Engine will only use between both
indices.

For instance, when the returned indices are 20 and 27 , the display stack will use the indices 20 to 27 , where all
indices between 20 and 27 target some intermediate colors between both the original ARGB colors.

This solution requires several conditions:

• Background color is enabled and it is an available color in the CLUT.

• Application can only use foreground colors provided by the CLUT. The platform designer should give to the
application developer the available list of colors the CLUTmanages.

• The CLUT must provide a set of blending ranges the application can use. Each range can have its own size
(di�erent number of colors between two colors). Each range is independent. For instance if the foreground
color RED ( 0xFFFF0000 ) can be blended with two background colors WHITE ( 0xFFFFFFFF ) and BLACK (
0xFF000000 ), two ranges must be provided. Both the ranges have to contain the same index for the color
RED .

• Application can only use blending ranges provided by the CLUT. Otherwise the display driver is not able to
find the range and the default color will be used to perform the blending.

• Rendering of dynamic images (images decoded at runtime) may be wrong because the ARGB colors may be
out of CLUT range.

Image Pixel Conversion

Overview

The Graphics Engine is built for a dedicated display pixel format (see Pixel Structure). For this pixel format, the
Graphics Enginemust be able to draw images with or without alpha blending and with or without transformation.
In addition, it must be able to read all image formats.

The MicroEJ application may not use all MicroUI image drawings options andmay not use all images formats. It is
notpossible todetectwhat theapplicationneeds, sonooptimizationcanbeperformedatapplicationcompiletime.
However, for a given application, the platform can be built with a reduced set of pixel support.

All pixel format manipulations (read, write, copy) are using dedicated functions. It is possible to remove some
functions or to use generic functions. The advantage is to reduce the memory footprint. The inconvenient is that
some features are removed (the application should not use them) or some features are slower (generic functions
are slower than the dedicated functions).

Functions

There are five pixel conversionmodes:

• Draw an image without transformation and without global alpha blending: copy a pixel from a format to the
destination format (display format).

• Drawan imagewithout transformationandwithglobal alphablending: copyapixelwith alphablending from
a format to the destination format (display format).
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• Draw an imagewith transformation andwith or without alpha blending: draw an ARGB8888 pixel in destina-
tion format (display format).

• Load a ResourceImage with an output format: convert an ARGB8888 pixel to the output format.

• Read a pixel from an image (Image.readPixel() or to draw an image with transformation or to convert an
image): read any pixel formats and convert it in ARGB8888.

Table 18: Pixel Conversion
Nb input formats Nb output formats Number of combinations

Draw image without global alpha 22 1 22
Draw image with global alpha 22 1 22
Draw image with transformation 2 1 2
Load a ResourceImage 1 6 6
Read an image 22 1 22

There are 22x1 + 22x1 + 2x1 + 1x6 + 22x1 = 74 functions. Each function takes between 50 and 200 bytes
depending on its complexity and the C compiler.

Linker File

All pixel functions are listed in a platform linker file. It is possible to edit this file to remove some features or to share
some functions (using generic function).

How to get the file:

1. Build platform as usual.

2. Copy platform file [platform]/source/link/display_image_x.lscf in platform configuration project:
[platform configuration project]/dropins/link/ . x is a number which characterizes the display
pixel format (see Pixel Structure). See next warning.

3. Perform some changes into the copied file (see a�er).

4. Rebuild the platform: the dropins file is copied in the platform instead of the original one.

Warning: When the display format in [platform configuration project]/display/display.properties
changes, the linker file su�ix changes too. Perform again all operations in new file with new su�ix.

The linker file holds five tables, one for each use case, respectively IMAGE_UTILS_TABLE_COPY ,
IMAGE_UTILS_TABLE_COPY_WITH_ALPHA , IMAGE_UTILS_TABLE_DRAW , IMAGE_UTILS_TABLE_SET and
IMAGE_UTILS_TABLE_READ . For each table, a comment describes how to remove an option (when possible)
or how to replace an option by a generic function (if available).

Library ej.api.Drawing

This Foundation Library provides additional drawing APIs. This library is fully integrated in Display module. It
requires an implementation of its Low Level API: LLDW_PAINTER_impl.h . These functions are implemented in the
Abstraction Layer implementationmodule com.microej.clibrary.llimpl#microui. LikeMicroUI painter’s natives, the
functions are redirected to dw_drawing.h . A default implementation of these functions is available in So�ware
Algorithmsmodule (in weak). This allows the BSP to override one or several APIs.
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Dependencies

• MicroUI module (seeMicroUI)

• LLUI_DISPLAY_impl.h implementation if standard or custom implementation is chosen (see Dependencies
and LLUI_DISPLAY: Display).

Installation

The Display module is a sub-part of the MicroUI library. When the MicroUI module is installed, the Display module
must be installed in order to be able to connect the physical display with the MicroEJ Platform. If not installed, the
stubmodule will be used.

In the platform configuration file, check UI > Display to install the Display module. When checked, the prop-
erties file display/display.properties is required during platform creation to configure the module. This con-
figuration step is used to choose the kind of implementation (see Dependencies).

The properties file must / can contain the following properties:

• bpp [mandatory]: Defines the number of bits per pixels the display device is using to render a pixel. Expected
value is one among these both list:

Standard formats:

– ARGB8888 : Alpha 8 bits; Red 8 bits; Green 8 bits; Blue 8 bits,

– RGB888 : Alpha 0 bit; Red 8 bits; Green 8 bits; Blue 8 bits (fully opaque),

– RGB565 : Alpha 0 bit; Red 5 bits; Green 6 bits; Blue 5 bits (fully opaque),

– ARGB1555 : Alpha 1 bit; Red 5 bits; Green 5 bits; Blue 5 bits (fully opaque or fully transparent),

– ARGB4444 : Alpha 4 bits; Red 4 bits; Green 4 bits; Blue 4 bits,

– C4 : 4 bits to encode linear grayscale colors between 0x�000000 and 0x���� (fully opaque),

– C2 : 2 bits to encode linear grayscale colors between 0x�000000 and 0x���� (fully opaque),

– C1 : 1 bit to encode grayscale colors 0x�000000 and 0x���� (fully opaque).

Custom formats:

– 32 : up to 32 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 24 : up to 24 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 16 : up to 16 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 8 : up to 8 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 4 : up to 4 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 2 : up to 2 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

– 1 : 1 bit to encode Alpha, Red, Green or Blue.

All other values are forbidden (throw a generation error).

• byteLayout [optional, default value is “line”]: Defines the pixels data order in a byte the display device is
using. A byte can contain several pixels when the number of bits-per-pixels (see ‘bpp’ property) is lower than
8. Otherwise this property is useless. Two modes are available: the next bit(s) on the same byte can target
the next pixel on the same line or on the same column. In first case, when the end of line is reached, the next
byte contains the first pixels of next line. In second case, when the end of column is reached, the next byte
contains the first pixels of next column. In both cases, a new line or a new column restarts with a new byte,
even if it remains some free bits in previous byte.
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– line : the next bit(s) on current byte contains the next pixel on same line (x increment),

– column : the next bit(s) on current byte contains the next pixel on same column (y increment).

Note:

– Default value is ‘line’.

– All other modes are forbidden (throw a generation error).

– When thenumberof bits-per-pixels (see ‘bpp’ property) is higheror equal than8, this property is useless
and ignored.

• memoryLayout [optional, default value is “line”]: Defines the pixels data order in memory the display device
is using. This option concerns only the display with a bpp lower than 8 (see ‘bpp’ property). Two modes are
available: when the bytememory address is incremented, the next targeted group of pixels is the next group
on the same line or the next group on same column. In first case, when the end of line is reached, the next
group of pixels is the first group of next line. In second case, when the end of column is reached, the next
group of pixels is the first group of next column.

– line : the next memory address targets the next group of pixels on same line (x increment),

– column : the next memory address targets the next group of pixels on same column (y increment).

Note:

– Default value is ‘line’.

– All other modes are forbidden (throw a generation error).

– When thenumberof bits-per-pixels (see ‘bpp’ property) is higheror equal than8, this property is useless
and ignored.

• imageBuffer.memoryAlignment [optional, default value is “4”]: Defines the image memory alignment to
respect when creating an image. This notion is useful when images drawings are performed by a third party
hardware accelerator (GPU): it can require some constraints on the image to draw. This value is used by the
Graphics Engine when creating a dynamic image and by the image generator to encode a RAW image. See
MicroEJ Format: GPU and CustomMicroEJ Format. Allowed values are 1, 2, 4, 8, 16, 32, 64, 128 and 256.

• imageHeap.size [optional, default value is “not set”]: Defines the images heap size. Useful to fix a platform
heap size when building a firmware in command line. When using a MicroEJ launcher, the size set in this
launcher is priority to the platform value.

Use

The MicroUI Display APIs are available in the class ej.microui.display.Display.

4.13.8 Images

Overview

Principle

The Image Engine is designed to make the distinction between three kinds of MicroUI images:
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• the images which can be used by the application without a loading step: class Image,

• the images which requires a loading step before being usable by the application: class ResourceImage,

• the bu�ered images where the application can draw into: class Bu�eredImage.

The first kind of image requires the Image Engine to be able to use (get, read and draw) an image referenced by
its path without any loading step. The open step should be very fast: just have to find the image in the application
resources list and create an Image object which targets the resource. No RAMmemory to store the image pixels is
required: the Image Engine directly uses the resource address (o�en in FLASHmemory). And finally, closing step is
useless because there is nothing to free (except Image object itself, via the garbage collector).

The second kind of image requires the Image Engine to be able to use (load, read and draw) an image referenced
by its path with or without any loading step. When the image is understandable by the Image Engine without any
loading step, the image is considered like the first kind of image (fast open step, no RAM memory, useless closing
step). When a loading step is required (dynamic decoding, external resource loading, image format conversion),
the open state becomes longer and a bu�er in RAM is required to store the image pixels. By consequence a closing
step is required to free the bu�er when image becomes useless.

The third kind of image requires, by definition, a bu�er to store the image pixels. Image Enginemust be able to use
(create, read and draw) this kind of image. The open state consists in creating a bu�er. By consequence a closing
step is required to free the bu�er when the image becomes useless. Contrary to the other kinds of images, the
application will be able to draw into this image.

Functional Description

The Image Engine is composed of:

• An “Image Generator” module, for converting images into a MicroEJ format (known by the Image Engine
Renderer) or into a platform binary format (cannot be used by the Image Engine Renderer), before runtime
(pre-generated images).

• The “Image Loader” module, for loading, converting and closing the images.

• A set of “Image Decoder” modules, for converting standard image formats into a MicroEJ format (known by
the Image Renderer) at runtime. Each Image Decoder is an additional module of the main module “Image
Loader”.

• The “Image Renderer” module, for reading and drawing the images in MicroEJ format.
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Input Files
(png, xxx)

Image Generator

png | xxx

Flash
(internal ROM, NOR)

png | xxx

External Flash
(SDCard etc.)

png | xxx

png | xxx | mej | binpng | xxx | mej | bin

Image Loader

PNG Decoder

png

XXX Decoder

xxx

MEJ Converter

mej

RAM

mejmej

Image Renderer

BSP

mej

Software
Algorithms

Memory Buffer

mej

png | xxx | mej (to convert)

mej

bin

mej

png | xxx | mej

mej (byte @)

bin

GPU

mej mej | bin

• Colors:

– blue: o�-board elements (tools, files).

– green: hardware elements (memory, processor).

– orange: on-board Graphics Engine elements.

– gray: BSP.

• Line labels:

4.13. Graphical User Interface 398



MicroEJ Documentation, Revision 2788b3f4

– png : symbolizes all standard image input formats (PNG, JPG, etc.).

– xxx : symbolizes a non-standard input format.

– mej : symbolizes the MicroEJ output format (MicroEJ Format: Standard).

– bin : symbolizes a platform binary format (Binary Format).

Process overview:

1. The user specifies the pre-generated images to embed (see Image Generator) and / or the images to embed
as regular resources (see Encoded Image).

2. The files are embedded as resources with the MicroEJ Application. The files’ data are linked into the FLASH
memory.

3. When the MicroEJ Application creates a MicroUI Image object, the Image Loader loads the image, calling the
right sub Image Engine module (see Image Generator and Encoded Image) to decode the specified image.

4. When the MicroEJ Application draws this MicroUI Image on the display (or on bu�ered image), the decoded
image data is used, and nomore decoding is required, so the decoding is done only once.

5. When the MicroUI Image is no longer needed, it must be closed explicitly by the application. The Image
Engine Core asks the right sub Image Engine module (see Image Generator and Encoded Image) to free the
image working area.

Image Format

The Image Engine makes the distinction between the input formats (how an image is encoded) and the output
formats (how the image is used by the platform and/or the Image Renderer).The Image Engine manages several
standard formats in input: PNG, JPEG, BMP, etc. In addition, an input formatmay be custom (platform dependant,
unsupported image format by default). Itmanages two formats in output: theMicroEJ format (knownby the Image
Renderer) and the binary format.

Each Image Engine can manage one or several input formats. However the Image Renderer manages only the
MicroEJ format (MicroEJ Format: Standard, MicroEJ Format: Display and MicroEJ Format: GPU). The binary output
format (Binary Format)is fully platform dependant and can be used to encode some images which are not usable
by MicroUI standard API.

MicroEJ Format: Standard

Several MicroEJ format encodings are available. Some encodings may be directly managed by the display driver.
Refers to the platform specification to retrieve the list of better formats.

Advantages:

• The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side.

• Drawing an image is very fast when the display driver recognizes the format (with or without transparency).

• Supports or not the alpha encoding: select the better format according to the image to encode.

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
number of bits-per-pixel.

• Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.
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This format requires a small header (around 20 bytes) to store the image size (width, height), format, flags
(is_transparent etc.), row stride etc. The required memory also depends on number of bits-per-pixels of MicroEJ
format:

required_memory = header + (image_width * image_height) * bpp / 8;

The pixels array is stored a�er the MicroEJ image file header. A padding between the header and the pixels array is
added to force to start the pixels array at a memory address aligned on number of bits-per-pixels.

Select one the following format to use a generic format among this list: ARGB8888 , RGB888 , ARGB4444 , ARGB1555
, RGB565 , A8 , A4 , A2 , A1 , C4 , C2 , C1 , AC44 , AC22 and AC11 . The following snippets describe the color
conversion for each format:

• ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

u32 convertARGB8888toRAWFormat(u32 c){
return c;

}

• RGB888: 24 bits format, 8 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return c & 0xffffff;

}

• ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| ((c & 0xf0000000) >> 16)
| ((c & 0x00f00000) >> 12)
| ((c & 0x0000f000) >> 8)
| ((c & 0x000000f0) >> 4)
;

}

• ARGB1555: 16 bits format, 1 bit for transparency, 5 per color.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| (((c & 0xff000000) == 0xff000000) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)
;

}

• RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| ((c & 0xf80000) >> 8)
| ((c & 0x00fc00) >> 5)
| ((c & 0x0000f8) >> 3)

(continues on next page)
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;
}

• A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat(u32 c){
return 0xff - (toGrayscale(c) & 0xff);

}

• A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat(u32 c){
return (0xff - (toGrayscale(c) & 0xff)) / 0x11;

}

• A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat(u32 c){
return (0xff - (toGrayscale(c) & 0xff)) / 0x55;

}

• A1: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat(u32 c){
return (0xff - (toGrayscale(c) & 0xff)) / 0xff;

}

• C4: 4 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return (toGrayscale(c) & 0xff) / 0x11;

}

• C2: 2 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return (toGrayscale(c) & 0xff) / 0x55;

}

• C1: 1 bit format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat(u32 c){
return (toGrayscale(c) & 0xff) / 0xff;

}

• AC44: 4 bits for transparency, 4 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & 0xff) / 0x11)

(continues on next page)
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;
}

• AC22: 2 bits for transparency, 2 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & 0xff) / 0x55)
;

}

• AC11: 1 bit for transparency, 1 bit with grayscale conversion.

u32 convertARGB8888toRAWFormat(u32 c){
return 0

| ((c & 0xff000000) == 0xff000000 ? 0x2 : 0x0)
| ((toGrayscale(color) & 0xff) / 0xff)
;

}

The pixels order in MicroEJ file follows this rule:

pixel_offset = (pixel_Y * image_width + pixel_X) * bpp / 8;

MicroEJ Format: Display

The display can hold a pixel encoding which is not standard (see Pixel Structure). The MicroEJ format can be cus-
tomized to encode the pixel in same encoding than display. The number of bits-per-pixels and the pixel bits organi-
sation is askedduring theMicroEJ format generationandwhen the drawImage algorithmsare running. If the image
to encode contains some transparent pixels, the output file will embed the transparency according to the display’s
implementation capacity. When all pixels are fully opaque, no extra information will be stored in the output file in
order to free up somememory space.

Note: From Image Engine point of view, the format stays a MicroEJ format, readable by the Image Renderer.

Advantages:

• Encoding is identical to display encoding.

• Drawing an image is o�en very fast (simplememory copy when the display pixel encoding does not hold the
opacity level).

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels. The required memory is
similar toMicroEJ Format: Standard.

MicroEJ Format: GPU

The MicroEJ format may be customized to be platform’s GPU compatible. It can be extanded by one or several
restrictions on the pixels array:

• Its start address has to be aligned on a higher value than the number of bits-per-pixels.
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• A padding has to be added a�er each line (row stride).

• TheMicroEJ format can hold a platform dependant header, located betweenMicroEJ format header (start of
file) and pixels array. TheMicroEJ format is designed to let the platform encodes and decodes this additional
header. For Image Engine so�ware algorithms, this header is useless and never used.

Note: From ImageEnginepoint of view, the format stays aMicroEJ format, readable by the ImageEngineRenderer.

Advantages:

• Encoding is recognized by the GPU.

• Drawing an image is o�en very fast.

• Supports opacity encoding.

Disadvantages:

• No compression: the image size in bytes is proportional to the number of pixels. The required memory is
similar toMicroEJ Format: Standard when there is no custom header.

When MicroEJ format holds another header (called custom_header ), the required memory depends is:

required_memory = header + custom_header + (image_width * image_height) * bpp / 8;

The row stride allows to add some padding at the end of each line in order to start next line at an address with a
specificmemory alignment; it is o�en required by hardware accelerators (GPU). The row stride is by default a value
in relationwith the imagewidth: row_stride_in_bytes = image_width * bpp / 8 . It canbe customizedat image
bu�er creation thanks to the Low Level API LLUI_DISPLAY_IMPL_getNewImageStrideInBytes . The required RAM
memory becomes:

required_memory = header + custom_header + row_stride * image_height;

MicroEJ Format: RLE1

The ImageEnginecandisplayembedded images that areencoded intoacompressed formatwhichencodes several
consecutive pixels into one or more 16-bit words. This encoding only manages fully opaque and fully transparent
pixels.

• Several consecutive pixels have the same color (2 words).

– First 16-bit word specifies howmany consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).

– Second 16-bit word is the pixels’ color in RGB565 format.

• Several consecutive pixels have their own color (1 + n words).

– First 16-bit word specifies howmany consecutive pixels have their own color.

– Next 16-bit word is the next pixel color.

• Several consecutive pixels are transparent (1 word).

– 16-bit word specifies howmany consecutive pixels are transparent.
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– Not designed for imageswithmany di�erent pixel colors: in such case, the output file sizemay be larger
than the original image file.

Advantages:

• Supports fully opaque and fully transparent encoding.

• Good compression when several consecutive pixels respect one of the three previous rules.

Disadvantages:

• Drawing an image is slightly slower than when using Display format.

The file format is quite similar toMicroEJ Format: Standard.

Binary Format

This format is not compatible with the Image Renderer and by MicroUI. It is can be used by MicroUI addon libraries
which provide their own images managements.

Advantages:

• Encoding is known by platform.

• Compression is inherent to the format itself.

Disadvantages:

• This format cannot be used to target a MicroUI Image (unsupported format).

Without Compression

An image can be embedded without any conversion / compression. This allows to embed the resource as it is, in
order to keep the source image characteristics (compression, bpp, etc.). This option produces the same result as
specifying an image as a resource in the MicroEJ launcher.

Advantages:

• Conserves the image characteristics.

Disadvantages:

• Requires an image runtime decoder.

• Requires some RAM in which to store the decoded image in MicroEJ format.

Image Generator

Principle

The Image Generator module is an o�-board tool that generates image data that is ready to be displayed without
needing additional runtimememory. The twomain advantages of this module are:

• A pre-generated image is already encoded in the format known by the Image Renderer (MicroEJ format) or
by the platform (custom binary format). The time to create an image is very fast and does not require any
RAM (Image Loader is not used).

• No extra support is needed (no runtime Image Decoder).
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Functional Description

Fig. 41: Image Generator Principle

Process overview (see too Functional Description)

1. The user defines, in a text file, the images to load.

2. The Image Generator outputs a binary file for each image to convert.

3. The raw files are embedded as (hidden) resources within the MicroEJ Application. The binary files’ data are
linked into the FLASHmemory.

4. When theMicroEJApplicationcreates aMicroUI Imageobjectwhich targets apre-generated image, the Image
Engine has only to create a link from the MicroUI image object to the data in the FLASHmemory. Therefore,
the loading is very fast; only the image data from the FLASH memory is used: no copy of the image data is
sent to the RAM first.

5. When the MicroUI Image is no longer needed, it is garbage-collected by the platform, which just deletes the
useless link to the FLASHmemory.

The image generator can run in twomodes:

• Standalone mode: the image to convert (input files) are standard (PNG, JPEG, etc.), the generated binary
files are inMicroEJ format and do not depend on platform characteristics or restrictions (seeMicroEJ Format:
Standard).

• Extendedmode: the image to convert (input files)may be custom, the generated binary files can be encoded
in customized MicroEJ format (can depend on several platform characteristics and restrictions, see MicroEJ
Format: Display andMicroEJ Format: GPU) or the generated files are encoded in another format thanMicroEJ
format (binary format, see Binary Format).

Structure

The Image Generator module is constituted from several parts, the core part and services parts:

• “Core” part: it takes an images list file as entry point and generates a binary file (no specific format) for each
file. To read a file, it redirects the reading to the available service loaders. To generate a binary file, it redirects
the encoding to the available service encoders.
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• “Service API” part: it provides some APIs used by the core part to load input files and to encode binary files.
It also provides some APIs to customize the MicroEJ format.

• “Standard input format loader” part: this service loads standard image files (PNG, JPEG, etc.).

• “MicroEJ format generator” part: this service encodes an image in MicroEJ format.

Standalone Mode

The standalone Image Generator embeds all parts described above. By consequence, once installed in a platform,
the standalone image generator does not need any extended module to generate MicroEJ files from standard im-
ages files.

Extended Mode

To increase thecapabilitiesof ImageGenerator, theextensionmustbebuilt andadded in theplatform. Asdescribed
above this extension will be able to:

• readmore input image file formats,

• extand the MicroEJ format with platform characteristics,

• encode images in a third-party binary format.

To do that the Image Generator provides some services to implement. This chapter explain how to create and
include this extension in the platform. Next chapters explain the aim of each service.

1. Create a std-javalib project. The module namemust start with the prefix imageGenerator (for instance
imageGeneratorMyPlatform ).

2. Add the dependency:

<dependency org="com.microej.pack.ui" name="ui-pack" rev="x.y.z">
<artifact name="imageGenerator" type="jar"/>

</dependency>

Where x.y.z is the UI pack version used to build the platform (minimum 13.0.0 ). The module.ivy should
look like:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org" xmlns:m="http://www.easyant.org/ivy/
→˓maven" xmlns:ej="https://developer.microej.com" ej:version="2.0.0">

<info organisation="com.microej.microui" module="imageGeneratorMyPlatform" status="integration
→˓" revision="1.0.0">

<ea:build organisation="com.is2t.easyant.buildtypes" module="build-std-javalib" revision="2.
→˓+"/>

</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public" description="Runtime dependencies to other␣

→˓artifacts"/>
<conf name="provided" visibility="public" description="Compile-time dependencies to APIs␣

→˓provided by the platform"/>
<conf name="documentation" visibility="public" description="Documentation related to the␣

→˓artifact (javadoc, PDF)"/>
<conf name="source" visibility="public" description="Source code"/>
<conf name="dist" visibility="public" description="Contains extra files like README.md,␣

→˓licenses"/>
(continues on next page)
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<conf name="test" visibility="private" description="Dependencies for test execution. It is␣
→˓not required for normal use of the application, and is only available for the test compilation␣
→˓and execution phases."/>

</configurations>

<publications/>

<dependencies>
<dependency org="com.microej.pack.ui" name="ui-pack" rev="[UI Pack version]">

<artifact name="imageGenerator" type="jar"/>
</dependency>

</dependencies>
</ivy-module>

3. Create the folder META-INF/services in source folder src/main/resources (this folder will be filled in
later).

4. When a service is added (see next chapters), build the easyant project.

5. Copy the generated jar: target~/artifacts/imageGeneratorMyPlatform.jar in the platform configura-
tion project folder: MyPlatform-configuration/dropins/tools/

6. Rebuild the platform.

Warning: The dropins folder must be updated (and platform built again) a�er any changes in the image gen-
erator extension project.

Service Image Loader

The standalone Image Generator is not able to load all images formats, for instance SVG format. The service loader
can be used to add this feature in order to generate an image file in MicroEJ format.

1. Open image generator extension project.

2. Create an implementation of interface com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension .

3. Create the file META-INF/services/com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension and open it.

4. Note down the name of created class, with its package and classname.

5. Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

Note: The class com.microej.tool.ui.generator.BufferedImageLoader already implements the interface.
This implementation is used to load standard images. It can be sub-classed to add some behavior.

CustomMicroEJ Format

As mentionned above (MicroEJ Format: Display andMicroEJ Format: GPU), the MicroEJ format can be extanded by
notions specific to the platform (and o�en to the GPU the platform is using). The generated file stays a MicroEJ file
format, usable by the Image Renderer. Additionally, the file becomes compatible with the platform constraints.
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1. Open image generator extension project.

2. Create a subclass of com.microej.tool.ui.generator.BufferedImageLoader (to be able to load
standard images) or create an implementation of interface com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension (to load custom images).

3. Override method convertARGBColorToDisplayColor(int) if the platform’s display pixel encoding is not
standard (see Pixel Structure).

4. Override method getStride(int) if a padding must be added a�er each line.

5. Override method getOptionalHeader() if an additional header must be added between the MicroEJ file
header and pixels array. The header size is also used to align image memory address (custom header is
aligned on its size).

6. Create the file META-INF/services/com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension and open it.

7. Note down the name of created class, with its package and classname.

8. Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

If the only constraint is the pixels array aligment, the Image Generator extension is not useful:

1. Open platform configuration file display/display.properties .

2. Add the property imageBuffer.memoryAlignment .

3. Build again the platform.

This alignment will be used by the Image Generator and also by the Image Loader.

Platform Binary Format

As mentionned above (Binary Format), the Image Generator is able to generate a binary file compatible with plat-
form (and not compatible with Image Renderer). This is very useful when a platform library o�ers the possibility
to use other kinds of images than MicroUI library. The binary file can be encoded according to the options the user
gives in the images list file.

1. Open image generator extension project.

2. Create an implementation of the interface com.microej.tool.ui.generator.ImageConverter .

3. Create the file META-INF/services/com.microej.tool.ui.generator.ImageConverter and open it.

4. Note down the name of created class, with its package and classname.

5. Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

Configuration File

The Image Generator uses a configuration file (also called the “list file”) for describing images that need to be pro-
cessed. The list file is a text file in which each line describes an image to convert. The image is described as a
resource path, and should be available from the application classpath.

Note: The list filemust be specified in theMicroEJ Application launcher (see Application Options). However, all the
files in the application classpath with su�ix .images.list are automatically parsed by the Image Generator tool.
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Each line can add optional parameters (separated by a ‘:’) which define and/or describe the output file format (raw
format). When no option is specified, the image is not converted and embedded as well.

Note: See Configuration File to understand the list file grammar.

• MicroEJ standard output format: to encode the image in a standard MicroEJ format, specify the MicroEJ
format:

Listing 3: Standard Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4

• MicroEJ “Display” output format: to encode the image in the same format as the display (generic display or
custom display, see Pixel Structure), specify display as output format:

Listing 4: Display Output Format Example

image1:display

• MicroEJ “GPU” output format: this format declaration is identical to standard format. It is a format that is
also supported by the GPU.

Listing 5: GPU Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4

• MicroEJ RLE1 output format: to encode the image in RLE1 format, specify RLE1 as output format:

Listing 6: RLE1 Output Format Example

image1:RLE1

• Without Compression: to keep original file, do not specify any format:

Listing 7: Unchanged Image Example

image1

• Binary format: to encode the image in a format only known by the platform, refer to the platform documen-
tation to knowwhich format are available.

Listing 8: Binary Output Format Example

image1:XXX

Linker File

In addition to images binary files, the Image Generator module generates a linker file ( *.lscf ). This linker file
declares an image section called .rodata.images . This section follows the next rules:

• The files are always listed in same order between two MicroEJ application builds.
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• The section is aligned on the value specified by the Display module property imageBuffer.
memoryAlignment (32 bits by default).

• Each file is aligned on section alignment value.

External Resources

The ImageGeneratormanages twoconfiguration fileswhen theExternal Resources Loader is enabled. The first con-
figuration file lists the images which will be stored as internal resources with the MicroEJ Application. The second
file lists the images the Image Generator must convert and store in the External Resource Loader output directory.
It is the BSP’s responsibility to load the converted images into an external memory.

Dependencies

• Image Renderer module (see Image Renderer).

• Displaymodule (seeDisplay): Thismodule gives the characteristics of the graphical display that are useful to
configure the Image Generator.

Installation

The Image Generator is an additional module for the MicroUI library. When the MicroUI module is installed, also
install this module in order to be able to target pre-generated images.

In the platform configuration file, check UI > Image Generator to install the Image Generator module. When
checked, the properties file imageGenerator/imageGenerator.properties is required to specify the Image Gen-
erator extension project. When no extension is required (standalone mode only), this property is useless.

Use

The MicroUI Image APIs are available in the class ej.microui.display.Image ant its subclasses. There are no specific
APIs that use a pre-generated image. When an image has been pre-processed, the MicroUI Image APIs getImage
and loadImage will get/load the images.

Refer to the chapter ApplicationOptions ( Libraries > MicroUI > Image ) formore information about specifying
the image configuration file.

Image Loader

Principle

The Image Loader module is an on-board engine that

• retrieves image data that is ready to be displayed without needing additional runtimememory,

• retrieves image data that is required to be converted into the format known by the Image Renderer (MicroEJ
format),

• retrieves image in external memories (external memory loader),

• converts images in MicroEJ format,

• creates a runtime bu�er to manage MicroUI Bu�eredImage,
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• manages dynamic images life cycle.

Note: The Image Loader is managing images to be compatible with Image Renderer. It does manage image in
custom format (see Binary Format)

Functional Description

1. The application is using one of three ways to create a MicroUI Image object.

2. The Image Loader creates the image according the MicroUI API, image location, image input format and im-
age output format to be compatible with Image Renderer.

3. When the application closes the image, the Image Loader frees the RAMmemory.

Memory

There are several ways to create a MicroUI Image. Except few specific cases, the Image Loader requires some RAM
memory to store the image content in MicroEJ format. This format requires a small header as explained here:
MicroEJ Format: Standard. It can be GPU compatible as explained here: MicroEJ Format: GPU.

The heap size is application dependant. In MicroEJ application launcher, set its size in Libraries > MicroUI >
Images heap size (in bytes) . It will declare a section whose name is .bss.microui.display.imagesHeap .

By default, the Image Loader uses an internal best fit allocator to allocate the image bu�ers (internal Graphics
Engine’s allocator). SomespecificLowLevel API (LLAPI) areavailable tooverride thisdefault implementation. These
LLAPIs may be helpful to control the bu�ers allocation, retrieve the remaining space, etc. When not implemented
by the BSP, the default internal Graphics Engine’s allocator is used.

Bu�eredImage

MicroUI application is able to create an image where it is allowed to draw into: the MicroUI BufferedImage . The
image format is the same than the display format; in other words, its number of bits-per-pixel and its pixel bits
organization are the same. The display pixel format can be standard or custom (see Pixel Structure). To create this
kindof image, the ImageLoaderhas just to createabu�er inRAMwhose sizedependson the image size (seeMicroEJ
Format: Display).

External Resource

Principle

An image is retrieved by its path (except for Bu�eredImage). The path describes a location in the application class-
path. The resourcemaybegeneratedat the same timeas theapplication (internal resource) or beexternal (external
resource). The Image Loader can load some images located outside the CPU addresses’ space range. It uses the
External Resource Loader.

When an image is located in such memory, the Image Loader copies it into RAM (into the CPU addresses’ space
range). Then it considers the image as an internal resource: it can continue to load the image (see following chap-
ters). TheRAM section used to load the external image is automatically freedwhen the Image Loader does not need
it again.
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The imagemay be located in externalmemory but be available in CPUaddresses’ space ranges (byte-addressable).
In this case, the Image Loader considers the image as internal and does not need to copy its content in RAM.

Configuration File

Like internal resources, the Image Generator uses a configuration file (also called the “list file”) for describing im-
ages that need to be processed. The list file must be specified in the MicroEJ Application launcher (see Application
Options). However, all the files in the application classpath with the su�ix .imagesext.list are automatically
parsed by the Image Generator tool.

Process

This chapter describes the steps to open an external resource from the application:

1. Add the image in the application project (usually in the source folder src/main/resources and in the pack-
age images ).

2. Create / open the configuration file (usually application.imagesext.list ).

3. Add the relative path of the image: see Images.

4. Launch the application: the Image Generator converts the image in RAW format in the external resources
folder ( [application_output_folder]/externalResources ).

5. Deploy the external resources in the external memory (SDCard, flash, etc.).

6. (optional) Update the implementation of the External Resources Loader.

7. Build and link the application with the BSP.

8. The application loads the external resource using Image.loadImage(String).

9. The image loader looks for the image and copies it in the images heap (no copy if the external memory is
byte-addressable).

10. (optional) The imagemay be decoded (for instance: PNG), and the source image is removed from the images
heap.

11. The external resource is immediately closed: the image’s bytes have been copied in the images heap, or the
image’s bytes are always available (byte-addressable memory).

12. The application can use the image.

13. The application closes the image: the image is removed from the image heap.

Note: The simulator (Front Panel) does not manage the external resources. All images listed in .imagesext.list
files are generated in the external resources folder, and this folder is added to the simulator’s classpath.

Image in MicroEJ Format

An imagemay be pre-processed (Image Generator) and so already in the format compatible with Image Renderer:
MicroEJ format.

• When application is loading an imagewhich is in such format andwithout specifiying another output format,
the Image Loader has just to make a link between the MicroUI Image object and the resource location. No
more runtime decoder or converter is required, and so nomore RAMmemory.
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• When application specifies another output format thanMicroEJ format encoded in the image, Image Loader
has to allocate a bu�er in RAM. It will convert the image in the expected MicroEJ format.

• When application is loading an image in MicroEJ format located in external memory, the Image Loader has
to copy the image into RAMmemory to be usable by Image Renderer.

Encoded Image

An image can be encoded (PNG, JPEG, etc.). In this case Image Loader asks to its Image Decoders module if a
decoder is able todecode the image. Thesource image isnot copied inRAM(expect for images located inanexternal
memory). Image Decoder allocates the decoded image bu�er in RAM first and then inflates the image. The image is
encoded inMicroEJ format specified by the application, when specified. When not specified, the image in encoded
in the default MicroEJ format specified by the Image Decoder itself.

The UI extension provides two internal Image Decoders modules:

• PNG Decoder: a full PNG decoder that implements the PNG format ( https://www.w3.org/Graphics/PNG ).
Regular, interlaced, indexed (palette) compressions are handled.

• BMPMonochromeDecoder: .bmp format files that embedonly 1 bit per pixel canbedecodedby this decoder.

Some additional decoders can be added. Implement the function LLUI_DISPLAY_IMPL_decodeImage to add a
new decoder. The implementation must respect the following rules:

• Fills the MICROUI_Image structure with the image characteristics: width, height and format.

Note: The output image format might be di�erent than the expected format (given as argument). In this
way, the Displaymodule will perform a conversion a�er the decoding step. During this conversion, an out of
memory error can occur because the final RAW image cannot be allocated.

• Allocates the RAW image data calling the function LLUI_DISPLAY_allocateImageBuffer . This functionwill
allocates the RAW image data space in the display working bu�er according the RAW image format and size.

• Decodes the image in the allocated bu�er.

• Waiting the end of decoding step before returning.

Dependencies

• Image Renderer module (see Image Renderer)

Installation

The ImageDecodersmodules are someadditionalmodules to theDisplaymodule. The decoders belong to distinct
modules, and either or several may be installed.

In the platform configuration file, check UI > Image PNG Decoder to install the runtime PNG decoder. Check

UI > Image BMP Monochrome Decoder to install the runtime BMPmonochrom decoder.
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Use

The MicroUI Image APIs are available in the class ej.microui.display.Image . There is no specific API that uses
a runtime image. When an image has not been pre-processed (see Image Generator), the MicroUI Image APIs
createImage* will load this image.

Image Renderer

Principle

The Image Renderer is an on-board engine that reads and draws the image encoded in MicroEJ format (see Image
Format). It calls Low LevelLow Level APIs to draw and transform the images (rotation, scaling, deformation, etc.).
It also includes so�ware algorithms to perform the rendering.

Functional Description

The engine redirects all MicroUI images drawings to a set of Low Level API. All Low Level API are implemented by
weak functionswhichcall so�warealgorithms. TheBSPhas thepossibility tooverride thisdefault behavior for each
Low Level API independently. Furthermore, the BSP can override a Low Level API for a specific MicroEJ format (for
instance ARGB8888 ) and call the so�ware algorithms for all other formats.
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Painter API

LLUI_PAINTER_impl.h

BSP

GPU Software Algorithms

hardware

LLUI_PAINTER_impl.c

ui_drawing.h

weak_ui_drawing.c

Dependencies

• MicroUI module (seeMicroUI),

• Display module (see Display).
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Installation

Image Renderer module is part of the MicroUI module and Display module. Install them in order to be able to use
some images.

Use

The MicroUI image APIs are available in the class ej.microui.display.Image .

4.13.9 Fonts

Overview

Principle

The Font Engine is composed of:

• A “Font Designer”module: a graphical tool which runs within the MicroEJ IDE used to build and edit MicroUI
fonts; it stores fonts in a platform-independent format. See Font Designer.

• A “Font Generator” module, for converting fonts from the platform-independent format into a platform-
dependent format.

• The “Font Renderer” module which decodes and renders at application runtime the platform-dependent
fonts files generated by the “Font Generator”.

The three modules are complementary: a MicroUI font must be created and edited with the Font Designer before
being integratedas a resourceby theFontGenerator. Finally the FontRenderer uses the generated fonts at runtime.

Functional Description

Fig. 42: Font Generation

Process overview:

1. User uses the Font Designer module to create a new font, and imports characters from system fonts ( *.ttf
files) and / or user images ( *.png , *.jpg , *.bmp , etc.).

2. Font Designer module saves the font as a MicroEJ Font ( *.ejf file).
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3. The user defines, in a text file, the fonts to load.

4. The Font Generator outputs a raw file for each font to convert (the raw format is display device-dependent).

5. The raw files are embedded as (hidden) resources within the MicroEJ Application. The raw files’ data are
linked into the FLASHmemory.

6. When the MicroEJ Application creates a MicroUI Font object which targets a pre-generated image, the Font
Engine Core only has to link from the MicroUI Font object to the data in the FLASH memory. Therefore, the
loading is very fast; only the font data from the FLASH memory is used: no copy of the font data is sent to
RAMmemory first.

Font Characteristics

Font Format

The Font Engine provides fonts that conform to the Unicode Standard. The .ejf files hold font properties:

• Identifiers: Fonts hold at least one identifier that can be one of the predefined Unicode scripts (see o�icial
Unicode website) or a user-specified identifier. The intention is that an identifier indicates that the font con-
tains a specific set of character codes, but this is not enforced.

• Font height andwidth, in pixels. A font has a fixed height. This height includes thewhite pixels at the top and
bottom of each character, simulating line spacing in paragraphs. A monospace font is a font where all char-
acters have the same width; for example, a ‘!’ representation has the same width as a ‘w’. In a proportional
font, ‘w’ will be wider than a ‘!’. No width is specified for a proportional font.

Fig. 43: Font Height

• Baseline, in pixels. All characters have the same baseline, which is an imaginary line on top of which the
characters seem to stand. Characters can be partly under the line, for example ‘g’ or ‘}’. The number of pixels
specified is the number of pixels above the baseline.

Fig. 44: Font baseline

• Space character size, in pixels. For proportional fonts, the Space character ( 0x20 ) is a specific character
because it has no filled pixels, and so its width must be specified. For monospace, the space size is equal to
the font width (and hence the same as all other characters).

• Styles: A font holds either a combination of these styles: BOLD, ITALIC, or is said to be PLAIN.

• When the selected font does not have a graphical representation of the required character, the first character
in font is drawn instead.

Multiple filters may apply at the same time, combining their transformations on the displayed characters.
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Pixel Transparency

The Font Renderer renders the font according the the value stored for each pixel. If the value is 0, the pixel is not
rendered. If the value is themaximumvalue (for example the value 3 for 2 bits-per-pixel), the pixel is renderedusing
the current foreground color, completely overwriting the current value of the destination pixel. For other values,
the pixel is rendered by blending the selected foreground color with the current color of the destination.

If n is the number of bits-per-pixel, then the maximum value of a pixel (pmax) is 2^n 1 . The value of each color
component of the final pixel is equal to:

𝑓𝑜𝑟𝑒𝑔𝑟𝑜𝑢𝑛𝑑 * 𝑝𝑖𝑥𝑒𝑙𝑉 𝑎𝑙𝑢𝑒/𝑝𝑚𝑎𝑥+ 𝑏𝑎𝑐𝑘𝑔𝑟𝑜𝑢𝑛𝑑 * (𝑝𝑚𝑎𝑥− 𝑝𝑖𝑥𝑒𝑙𝑉 𝑎𝑙𝑢𝑒)/𝑝𝑚𝑎𝑥

Language

Supported Languages

The Font Renderermanages theUnicodebasicmultilingual languages, whose characters are encodedon 16-bit, i.e.
Unicodes from0x0000 to0xFFFF. It allows to render le�-to-rightor right-to-le�writing systems: Latin (English, etc.),
Arabic, Chinese, etc. are somesupported languages. Note that the rendering is alwaysperformed le�-to-right, even
if the string arewritten right-to-le�. There is no support for top-to-bottomwriting systems. Some languages require
diacritics and contextual letters; the Font Renderer manages simple rules in order to combine several characters.

Arabic Support

The Font Renderer manages the ARABIC font specificities: the diacritics and contextual letters.

To render an Arabic text, the Font Renderer requires several points:

• To determinate if a character has to overlap the previous character, the Font Renderer uses a specific range
of ARABIC characters: from 0xfe70 to 0xfefc . All other characters (ARABIC or not) outside this range are
considered classic and no overlap is performed. Note that several ARABIC characters are available outside
this range, but the same characters (same representation) are available inside this range.

• The application strings must use the UTF-8 encoding. Furthermore, in order to force the use of char-
acters in the range 0xfe70 to 0xfefc , the string must be filled with the following syntax: ‘
\ufee2\ufedc\ufe91\u0020\ufe8e\ufe92\ufea3\ufeae\ufee3 ’; where \uxxxx is theUTF-8 character en-
coding.

• The application string and its rendering are always performed from le� to right. However the string contents
are managed by the application itself, and so can be filled from right to le�. To write the text:

the string charactersmust be : ‘ \ufee2\ufedc\ufe91\u0020\ufe8e\ufe92\ufea3\ufeae\ufee3 ’. The Font
Renderer will first render the character ‘ \ufee2 ’, then ‘ \ufedc ,’ and so on.

• Each character in the font (in the ejf file) must have a rendering compatible with the character position.
The character will be rendered by the Font Renderer as-is. No support is performed by the Font Renderer to
obtain a linear text.

Font Generator
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Principle

The Font Generator module is an o�-board tool that generates fonts ready to be displayed without the need for
additional runtimememory. It outputs a raw file for each converted font.

Functional Description

Fig. 45: Font Generator Principle

Process overview:

1. The user defines, in a text file, the fonts to load.

2. The Font Generator outputs a raw file for each font to convert.

3. The raw files are embedded as (hidden) resourceswithin theMicroEJ Application. The raw file’s data is linked
into the FLASHmemory.

4. When the MicroEJ Application draws text on the display (or on an image), the font data comes directly from
the FLASHmemory (the font data is not copied to the RAMmemory first).

Pixel Transparency

Asmentionedabove, eachpixelof eachcharacter inan .ejf filehasoneof256di�erentgray-scalevalues. However
RAWfiles canhave 1, 2, 4or8bits-per-pixel (respectively 2, 4, 16or 256gray-scale values). The requiredpixel depth is
defined in the configuration file (see next chapter). The Font Generator compresses the input pixels to the required
depth.

The following tables illustrates the conversion “grayscale to transparency level”. The grayscale value ‘0x00’ is black
whereas value ‘0x�’ is white. The transparency level ‘0x0’ is fully transparent whereas level ‘0x1’ (bpp == 1), ‘0x3’
(bpp == 2) or ‘0xf’ (bpp == 4) is fully opaque.

Table 19: Font 1-BPP RAW Conversion
Grayscale Ranges Transparency Levels
0x00 to 0x7f 0x1
0x80 to 0x� 0x0

Table 20: Font 2-BPP RAW Conversion
Grayscale Ranges Transparency Levels
0x00 to 0x1f 0x3
0x20 to 0x7f 0x2
0x80 to 0xdf 0x1
0xe0 to 0x� 0x0
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Table 21: Font 4-BPP RAW Conversion
Grayscale Ranges Transparency Levels
0x00 to 0x07 0xf
0x08 to 0x18 0xe
0x19 to 0x29 0xd
0x2a to 0x3a 0xc
0x3b to 0x4b 0xb
0x4c to 0x5c 0xa
0x5d to 0x6d 0x9
0x6e to 0x7e 0x8
0x7f to 0x8f 0x7
0x90 to 0xa0 0x6
0xa1 to 0xb1 0x5
0xb2 to 0xc2 0x4
0xc3 to 0xd3 0x3
0xd4 to 0xe4 0x2
0xe5 to 0xf5 0x1
0xf6 to 0x� 0x0

For 8-BPP RAW font, a transparency level is equal to 255 - grayscale value .

Configuration File

The Font Generator uses a configuration file (called the “list file”) for describing fonts that must be processed. The
list file is a basic text file where each line describes a font to convert. The font file is described as a resource path,
and should be available from the application classpath.

Note: The list file must be specified in the MicroEJ Application launcher (see Application Options). However, all
files in application classpath with su�ix .fonts.list are automatically parsed by the Font Generator tool.

Each line can have optional parameters (separated by a ‘:’) which define some ranges of characters to embed in the
final raw file, and the required pixel depth. By default, all characters available in the input font file are embedded,
and the pixel depth is 1 (i.e 1 bit-per-pixel).

Note: See Configuration File to understand the list file grammar.

Selecting only a specific set of characters to embed reduces the memory footprint. There are two ways to specify
a character range: the custom range and the known range. Several ranges can be specified, separated by “;”.

Below is an example of a list file for the Font Generator:

Listing 9: Fonts Configuration File Example

myfont
myfont1:latin
myfont2:latin:8
myfont3::4
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External Resources

The Font Generator manages two configuration files when the External Resources Loader is enabled. The first con-
figuration file lists the fonts whichwill be stored as internal resourceswith theMicroEJ Application. The second file
lists the fonts the Font Generator must convert and store in the External Resource Loader output directory. It is the
BSP’s responsibility to load the converted fonts into an external memory.

Dependencies

• Font Renderer module (see Font Renderer)

Installation

The Font Generator module is an additional tool for MicroUI library. When the MicroUI module is installed, install
this module in order to be able to embed some additional fonts with the MicroEJ Application.

If the module is not installed, the platform user will not be able to embed a new font with his/her MicroEJ Appli-
cation. He/she will be only able to use the system fonts specified during the MicroUI initialization step (see Static
Initialization).

In the platform configuration file, check UI > Font Generator to install the Font Generator module.

Use

In order to be able to embed ready-to-be-displayed fonts, youmust activate the fonts conversion feature and spec-
ify the fonts configuration file.

Refer to the chapter Application Options ( Libraries > MicroUI > Font ) for more information about specifying
the fonts configuration file.

Font Renderer

Principle

The Font Renderer is included in the MicroUI module (see MicroUI) for the application side; and is included in the
Display module (see Display) for the C side.

Functional Description

The Graphics Engine redirects all MicroUI font drawings to the internal so�ware algorithms. There is no indirection
to a set of Low Level API.
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Painter API

Graphics Engine

Software Algorithms

hardware

External Resources

Memory Management

The Font Renderer is able to load some fonts located outside the CPU addresses’ space range. It uses the External
Resource Loader.

When a font is located in suchmemory, the Font Renderer copies a very short part of the resource (the font file) into
a RAMmemory (into CPU addresses space range): the font header. This header stays located in RAM until MicroEJ
Application is using the font. As soon as the MicroEJ Application uses another external font, new font replaces the
old one. Then, onMicroEJ Application demand, the Font Renderer loads some extra information from the font into
the RAMmemory (the font meta data, the font pixels, etc.). This extra information is automatically unloaded from
RAMwhen the Font Renderer no longer needs them.

This extra information is stored into a RAM section called .bss.microui.display.externalFontsHeap . Its size is
automatically calculated according to the external fonts usedby the firmware. However it is possible to change this
value by setting the MicroEJ application property ej.microui.memory.externalfontsheap.size . This option is
very useful when building a kernel: the kernel may anticipate the section size required by the features.

Warning: When this size is smaller than the size required by an external font, some characters may be not
drawn.
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Configuration File

Like internal resources, the Font Generator uses a configuration file (also called the “list file”) for describing fonts
that need to be processed. The list file must be specified in the MicroEJ Application launcher (see Application Op-
tions). However, all the files in the application classpath with the su�ix .fontsext.list are automatically parsed
by the Font Generator tool.

Process

This chapter describes the steps to open an external resource from the application:

1. Add the font in the application project (most of the time in the source folder src/main/resources and in
the package fonts ).

2. Create / open the configuration file (usually application.fontsext.list ).

3. Add the relative path of the font: see Fonts.

4. Launch the application: the Font Generator converts the font in RAW format in the external resources folder
( [application_output_folder]/externalResources ).

5. Deploy the external resources in the external memory (SDCard, flash, etc.).

6. (optional) Update the implementation of the External Resources Loader.

7. Build and link the application with the BSP.

8. The application loads the external resource using Font.getFont(String).

9. The font loader looks for the font and only reads the font header.

10. (optional) The external resource is closed if the external resource is inside the CPU addresses’ space range.

11. The application can use the font.

12. The external resource is never closed: the font’s bytes are copied in RAM on demand (drawString, etc.).

Note: The simulator (Front Panel) does not manage the external resources. All fonts listed in .fontsext.list
files are generated in the external resources folder, and this folder is added to the simulator’s classpath.

Backward Compatibility

As explained here, the notion of Dynamic styles and the style UNDERLINED are not supported anymore by MicroUI
3. However, an external font may have been generated with an older version of the Font Generator; consequently,
the generated file can hold the Dynamic style. The Font Renderer can load these old versions of fonts. However,
there are some runtime limitations:

• The Dynamic styles are ignored. The font is drawn without any dynamic algorithm.

• The font style (the style returned by Font.isBold() and Font.isItalic() ) is the Dynamic style. For
instance, when a font holds the style bold as dynamic style and the style italic as built-in style, the font is
considered as bold + italic; even if the style bold is not rendered.
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Dependencies

• MicroUI module (seeMicroUI),

• Display module (see Display).

Installation

The Font Renderer is part of the MicroUI module and Display module. You must install them in order to be able to
use some fonts.

Use

The MicroUI font APIs are available in the class ej.microui.display.Font.

4.13.10 Simulation

Principle

The graphical user interface uses the Front Panel mock (see Front Panel Mock) and some extensions (widgets) to
simulate the user interactions. It is the equivalent of the three embeddedmodules (Display, Input and LED) of the
MicroEJ Platform (seeMicroUI).

The Front Panel enhances the development environment by allowing User Interface applications to be designed
and tested on the computer rather than on the target device (whichmay not yet be built). Themock interacts with
the user’s computer in two ways:

• output: LEDs, graphical displays

• input: buttons, joystick, touch, haptic sensors

Note: This chapter completes the notions described in Front Panel Mock chapter.

Module Dependencies

The Front Panel project is a regular MicroEJ Module project. Its module.ivy file should look like this example:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org" xmlns:ej="https://developer.microej.com"␣
→˓ej:version="2.0.0">
<info organisation="com.mycompany" module="examplePanel" status="integration" revision="1.0.0"/>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public" description="Runtime dependencies to other artifacts"/>
<conf name="provided" visibility="public" description="Compile-time dependencies to APIs provided␣

→˓by the platform"/>
</configurations>

<dependencies>
<dependency org="ej.tool.frontpanel" name="widget" rev="1.0.0"/>

</dependencies>
</ivy-module>
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It depends at least on the Front Panel framework. This framework contains the Front Panel core classes. The de-
pendencies can be reduced to:

<dependencies>
<dependency org="ej.tool.frontpanel" name="framework" rev="1.1.0"/>

</dependencies>

To be compatible with Display module’s Graphics Engine, the project must depend on an extension of Front Panel
framework. This extensionprovides some interfaces and classes the Front Panel is using to target simulateddisplay
and input devices. The extension does not provide anywidgets. It is the equivalent of the embedded LowLevel API.
It fetches by transitivity the Front Panel framework, so the Front Panel framework dependency does not need to
be specified explicitly:

<dependencies>
<dependency org="com.microej.pack.ui" name="ui-pack" rev="[UI Pack version]">

<artifact name="frontpanel" type="jar"/>
</dependency>

</dependencies>

Warning: This extension is built for each UI pack version. By consequence, a Front Panel project is done for
a platform built with the same UI pack. When the UI pack mismatch, some errors may occur during the Front
Panel project export step, during the platform build, and/or during the application runtime. The current pack
version is 13.1.0.

The Front Panel extension does not provide any widgets. Some compatible widgets are available in a third library.
The life cycle of this library is di�erent than the UI pack’s one. New widgets can be added to simulate new kind
of displays, input devices, etc. This extension fetches by transitivity the Front Panel extension, so this extension
dependency does not need to be specified explicitly:

<dependencies>
<dependency org="ej.tool.frontpanel" name="widget" rev="2.0.0"/>

</dependencies>

Warning: The minimal version 2.0.0 is required to be compatible with UI pack 13.0.0 and higher. By default,
when creating a new Front Panel project, the widget dependency version is 1.0.0 .

MicroUI Implementation

As described here, the Front Panel uses an equivalent of embedded side’s header files that implement MicroUI
native methods.
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This set of classes and interfaces is available in the module com.microej.pack.ui#ui-pack . It o�ers the same
capacity to override some built-in drawing algorithms (internal Graphics Engine drawing algorithms), to add some
custom drawing algorithms, to manipulate the MicroUI concepts (GraphicsContext, Image, etc.) in the Front Panel
project, etc.

• The interface ej.microui.display.LLUIDisplay represents the MicroUI Graphics Engine (MicroUI frame-
work). It provides somemethods tomapMicroUI byte arrays inMicroUIGraphicsContext objects,manipulate
MicroUI colors, etc. An instance of this framework is available via the field Instance .

• The interface ej.microui.display.LLUIDisplayImpl all methods required by MicroUI implementation to
be compatible with the MicroUI Display class implementation. SeeWidget Display.

• The class ej.microui.display.LLUIPainter implements all MicroUI drawing natives. It defines some in-
terfaces and classes to manipulate the MicroUI concepts (GraphicsContext, Image, etc.) in the Front Panel
project. Like the embedded side, this class manages the synchronization with the Graphics Engine and del-
egates the drawing to the interface ej.microui.display.UIDrawing .

• Like theembedded side, thedefault implementationof the interface ej.microui.display.UIDrawing : ej.
microui.display.UIDrawing.UIDrawingDefault calls the internal Graphics Engine algorithms (so�ware
algorithms). Each algorithm can be overridden independently.

• The classes in the package ej.drawing implement the native of the MicroUI extended library: Drawing

• The classes in the package ej.microui.event manage the input events, see Inputs Extensions.

• The classes in the package ej.microui.led manage the LEDs.

Widget Display

The widget Display implements the interface ej.microui.display.LLUIDisplayImpl to be compatible with the
implementation of the MicroUI class Display.

This widget manages:

• The simple or double bu�ering (default value): doubleBufferFeature=true|false .

• The backlight (enabled by default): backlightFeature=true|false .

• The non-rectangular displays: filter="xxx.png" . Some displays can have another appearance (for in-
stance: circular); the Front Panel can simulate using a filter (seeWidget). This filter defines the pixels inside
and outside thewhole display area. The filter imagemust have the same size as the rectangular display area.
A display pixel at a given position will not be rendered if the pixel at the same position in the mask is fully
transparent.

• The standard pixel formats.
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• The driver-specific pixel formats: extensionClass="xxx" . This class must be added in the Front Panel
project and implement the interface ej.fp.widget.Display.DisplayExtension .

Custom Drawings

Custom algorithms like the embedded side can replace the Graphics Engine drawing algorithms. This chapter de-
scribes how to override the method fillRectangle() .

1. Create an implementation of the interface ej.microui.display.UIDrawing.UiDrawingDefault :
MyDrawer .

2. Create an empty widget to invoke the new implementation:

@WidgetDescription(attributes = { })
public class Init extends Widget{

@Override
public void start() {

super.start();
LLUIPainter.setDrawer(new MyDrawer());

}
}

3. Invokes this widget in the .fp file:

<frontpanel xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns="https://developer.microej.com"␣
→˓ xsi:schemaLocation="https://developer.microej.com .widget.xsd">

<device name="STM32429IEVAL" skin="Board-480-272.png">
<com.is2t.microej.fp.Init/>
[...]

</device>
</frontpanel>

4. Implements the fillRectangle method like this:

@Override
public void fillRectangle(MicroUIGraphicsContext gc, int x1, int y1, int x2, int y2) {

// manage the clip
if (gc.isClipEnabled() && !gc.isRectangleInClip(x1, y1, x2, y2)) {

x1 = Math.max(x1, gc.getClipX1());
x2 = Math.min(x2, gc.getClipX2());
y1 = Math.max(y1, gc.getClipY1());
y2 = Math.min(y2, gc.getClipY2());

if (x2 < x1 || y2 < y1) {
// nothing to render
return;

}
}
// clip disabled, or rectangle entirely fits the clip

// get/create AWT objects
Graphics2D src = (Graphics2D) ((BufferedImage) gc.getImage().getRAWImage()).getGraphics();
Color color = new Color(gc.getRenderingColor());

// fill rectangle
src.setColor(color);

(continues on next page)
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src.fillRect(x1, y1, x2 - x1 + 1, y2 - y1 + 1);

// update Graphics Engine's dirty area
gc.setDrawingLimits(x1, y1, x2, y2);

}

Explanations:

• The Front Panel framework is running over AWT.

• Themethod gc.getImage() returns a ej.fp.Image . It is the representation of aMicroUI Image in the Front
Panel framework. The method gc.getImage().getRAWImage() returns the implementation of the Front
Panel image on the J2SE framework: a AWT BufferedImage . From this image, retrieve the AWT graphics.

• The MicroUI color ( gc.getRenderingColor() ) is converted in an AWT color.

• Before drawing, the MicroUI clip is checked (the MicroUI drawing can be outside the clip and/or the image
itself).

• A�er drawing, the implementation updates the Graphics Engine dirty area by calling gc.
setDrawingLimits() .

Note: More details are available in LLUIPainter, UIDrawing, LLUIDisplay, and LLUIDisplayImpl classes.

New Drawings

The Front Panel framework allows the addition of custom drawing algorithms. This chapter describes how to im-
plement the method drawSomething() .

Note: To add a custom drawing algorithm, it is strongly recommended to follow the same rules as the MicroUI
drawings: a class that synchronizes the drawings with the Graphics Engine and another class that performs the
drawing itself (like Custom Drawings).

1. In the MicroEJ application, write the new native:

private static void drawSomething(byte[] gc, int x, int y);

2. Call this function from a render method:

@Override
public void render(GraphicsContext gc) {

[...]
drawSomething(gc.getSNIContext(), 15, 36);
[...]

}

3. In the Front Panel project, write the equivalent of LLUIPainter class:

public static void drawSomething(byte[] target, int x, int y) {
LLUIDisplay graphicalEngine = LLUIDisplay.Instance;
synchronized (graphicalEngine) {

MicroUIGraphicsContext gc = graphicalEngine.mapMicroUIGraphicsContext(target);
if (gc.requestDrawing()) {

(continues on next page)
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MyDrawer.Instance.drawSomething(gc, x, y);
}

}
}

4. In the Front Panel project, write the equivalent of UIDrawing interface, see Custom Drawings:

public static void drawSomething(MicroUIGraphicsContext gc, int x, int y) {
// 1- manage clip
// 2- draw
// 3- update Graphics Engine's dirty area

}

Note: More details are available in LLUIPainter, UIDrawing, LLUIDisplay, and LLUIDisplayImpl classes.

Inputs Extensions

The input device widgets (button, joystick, touch, etc.) require a listener to know how to react on input events
(press, release, move, etc.). The aim of this listener is to generate an event compatible with MicroUI Event Gener-
ator. Thereby, a button press action can become a MicroUI Buttons press event or a Command event or anything
else.

AMicroUI EventGenerator is knownby its name. This name is fixedduring theMicroUI static initialization (seeStatic
Initialization). To generate an event to a specific event generator, the widget has to use the event generator name
as identifier.

A Front Panel widget can:

• Force the behavior of an input action: the associated MicroUI Event Generator type is hardcoded (Buttons,
Pointer, etc.), the event is hardcoded (for instance: widget button press action may be hardcoded on event
generator Buttons and on the event pressed). Only the event generator name (identifier) should be editable
by the Front Panel extension project.

• Propose a default behavior of an input action: contrary to first point, the Front Panel extension project is able
to change the default behavior. For instance a joystick can simulate a MicroUI Pointer.

• Do nothing: the widget requires the Front Panel extension project to give a listener. This listener will receive
all widgets action (press, release, etc.) and will have to react on it. The action should be converted on a
MicroUI Event Generator event or might be dropped.

This choice of behavior is widget dependant. Please refer to the widget documentation to have more information
about the chosen behavior.

Heap Simulation

Graphics Engine is using two dedicated heaps: for the images (see Memory ) and the external fonts (see External
Resources). Front Panel partly simulates the heaps usage.

• Images heap: Front Panel simulates the heap usage when the application is creating a Bu�eredImage, when
it loads and decodes an image (PNG, BMP, etc.) which is not a raw resource and when it converts an image
in MicroEJ format in another MicroEJ format. However it does not simulate the external image copy in heap
(see External Resource).
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• External fonts heap: Front Panel does not simulate this heap (see External Resources). There is no rendering
limitation when application is using a font which is located outside CPU addresses ranges.

Image Decoders

Front Panel uses its own internal image decoders when the associated modules have been selected (see internal
image decoders). Front Panel can add some additional decoders like the C-side for the embedded platform (see
external image decoders). However, the exhaustive list of additional decoders is limited (Front Panel is using the
Java AWT ImageIO API). To add an additional decoder, specify the property hardwareImageDecoders.list in
Front Panel configuration properties file (see Installation) with one or several property values:

Table 22: Front Panel Additional Image Decoders
Type Property value
Graphics Interchange Format (GIF) gif
Joint Photographic Experts Group (JPEG) jpeg or jpg
Portable Network Graphics (PNG) png
Windows bitmap (BMP) bmp

The decoders list is comma (,) separated. Example:

hardwareImageDecoders.list=jpg,bmp

Dependencies

• MicroUI module (seeMicroUI),

• Display module (see Display): This module gives the characteristics of the graphical display that are useful
for configuring the Front Panel.

Installation

Front Panel is an additional module for MicroUI library. When the MicroUI module is installed, install this module
in order to be able to simulate UI drawings on the Simulator. See Installation to install the module.

The properties file can additional properties:

• hardwareImageDecoders.list [optional, default value is “” (empty)]: Defines the available list of additional
image decoders provided by the hardware (see Image Decoders). Use comma (‘,’) to specify several decoders
among this list: bmp, jpg, jpeg, gif, png. If empty or unspecified, no image decoder is added.

Use

Launch a MicroUI application on the Simulator to run the Front Panel.

4.13.11 Release Notes

MicroEJ Architecture Compatibility Version

The current UI Pack version is 13.1.0. The following tables describe the compatibility ranges between MicroEJ UI
Packs and MicroEJ Architectures.
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Standard Versions

UI Pack Range Architecture Range Comment
[13.0.0-13.1.0] [7.13.0-8.0.0[ SNI 1.3
[12.0.0-12.1.5] [7.11.0-8.0.0[ Move Front Panel in MicroEJ Architecture
[11.0.0-11.2.0] [7.0.0-8.0.0[ SNI Callback feature
[9.3.1-10.0.2] [6.13.0-7.0.0[

LLEXT link error with Architecture 6.13+ and UI 9+
[9.2.0-9.3.0] [6.12.0-6.13.0[ SOAR can exclude some resources
[9.1.0-9.1.2] [6.8.0-6.12.0[ Internal scripts
[8.0.0-9.0.2] [6.4.0-6.12.0[ Manage external memories like byte addressable memories
[6.0.0-7.4.7] [6.1.0-6.12.0[

Maintenance Versions

UI Pack Version UI Pack Base Version Architecture Range Comment
(maint) 8.0.0 7.4.7 [7.0.0-8.0.0[ SNI Callback feature

Foundation Libraries

The following table describes Foundation Libraries API versions implemented in MicroEJ UI Packs.

Table 23: MicroUI API Implementation
UI Pack Range MicroUI Drawing
13.1.0 3.1.0 1.0.3
[13.0.4-13.0.7] 3.0.3 1.0.2
13.0.3 3.0.2 1.0.1
[13.0.1-13.0.2] 3.0.1 1.0.0
13.0.0 3.0.0 1.0.0
[12.1.0-12.1.5] 2.4.0
[11.1.0-11.2.0] 2.3.0
[9.2.0-11.0.1] 2.2.0
[9.1.1-9.1.2] 2.1.3
9.1.0 2.1.2
[9.0.0-9.0.2] 2.0.6
[6.0.0-8.1.0] 2.0.0

Abstraction Layer Interface

The following sectionsbriefly describesAbstractionLayer interface changes. Formoredetails, refer to theMigration
Guide.
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Display

UI Pack Range Changes
[13.0.0-13.1.0] UI3 format: implement LLUI_DISPLAY_impl.h :

• void LLUI_DISPLAY_IMPL_initialize([...
]);

• void LLUI_DISPLAY_IMPL_binarySemaphoreTake([.
..]);

• void LLUI_DISPLAY_IMPL_binarySemaphoreGive([.
..]);

• uint8_t* LLUI_DISPLAY_IMPL_flush([...
]);

[10.0.0-12.1.5] Remove:
• int32_t LLDISPLAY_IMPL_getWorkingBufferStartAddress([.
..]);

• int32_t LLDISPLAY_IMPL_getWorkingBufferEndAddress([.
..]);

[8.0.0-9.4.1] Merge in LLDISPLAY_impl.h :
• LLDISPLAY_SWITCH_impl.h
• LLDISPLAY_COPY_impl.h
• LLDISPLAY_DIRECT_impl.h

[6.0.0-7.4.7] UI2 format: implement one of header file:
• LLDISPLAY_SWITCH_impl.h
• LLDISPLAY_COPY_impl.h
• LLDISPLAY_DIRECT_impl.h

Input

UI Pack Range Changes
[13.0.0-13.1.0] UI3 format: implement LLUI_INPUT_impl.h :

• void LLUI_INPUT_IMPL_initialize([...]);
• jint LLUI_INPUT_IMPL_getInitialStateValue([.
..]);

• void LLUI_INPUT_IMPL_enterCriticalSection([.
..]);

• void LLUI_INPUT_IMPL_leaveCriticalSection([.
..]);

[6.0.0-12.1.5] UI2 format: implement LLINPUT_impl.h
• void LLINPUT_IMPL_initialize([...]);
• int32_t LLINPUT_IMPL_getInitialStateValue([.
..]);

• void LLINPUT_IMPL_enterCriticalSection([.
..]);

• void LLINPUT_IMPL_leaveCriticalSection([.
..]);
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LED

UI Pack Range Changes
[13.0.0-13.1.0] UI3 format: implement LLUI_LED_impl.h :

• jint LLUI_LED_IMPL_initialize([...]);
• jint LLUI_LED_IMPL_getIntensity([...]);
• void LLUI_LED_IMPL_setIntensity([...]);

[6.0.0-12.1.5] UI2 format: implement LLLEDS_impl.h
• int32_t LLLEDS_IMPL_initialize([...]);
• int32_t LLLEDS_IMPL_getIntensity([...
]);

• void LLLEDS_IMPL_setIntensity([...]);

Front Panel API

Since MicroEJ UI Pack 13.0.0 , the Front Panel project must depend on module com.microej.pack.ui.ui-
pack(frontpanel). The module version is the MicroEJ Generic UI Pack version, that is always aligned with the Mi-
croEJ UI Packs specific for MCUs.

UI Pack Range Module Version
[13.0.0-13.1.0]

com.microej.pack.ui.ui-pack(frontpanel)
13.1.0

[12.0.0-12.1.5]
ej.tool.frontpanel.widget-microui

1.0.0

Note: Before MicroEJ UI Pack 12.0.0 , the Front Panel project must depend on classpath variable
FRONTPANEL_WIDGETS_HOME .

Image Generator API

Since MicroEJ UI Pack 13.0.0 , the Image Generator extension project must depend on module
com.microej.pack.ui.ui-pack(imagegenerator). The module version is the MicroEJ Generic UI Pack version,
that is always aligned with the MicroEJ UI Packs specific for MCUs.

UI Pack Range Module Version
[13.0.0-13.1.0]

com.microej.pack.ui.ui-pack(imagegenerator)
13.1.0

Note: Before MicroEJ UI Pack 13.0.0 , the Image Generator extension project must depend on classpath variable
IMAGE-GENERATOR-x.x .

CModule

A C module https://repository.microej.com/modules/com/microej/clibrary/llimpl/microui is available on MicroEJ
Central Repository. This C module provides default implementations for:

4.13. Graphical User Interface 433

https://repository.microej.com/modules/com/microej/pack/ui/ui-pack/
https://repository.microej.com/modules/com/microej/pack/ui/ui-pack/
https://repository.microej.com/modules/com/microej/pack/ui/ui-pack/
https://repository.microej.com/modules/com/microej/clibrary/llimpl/microui


MicroEJ Documentation, Revision 2788b3f4

• LLUI_PAINTER_impl.h and LLDW_PAINTER_impl.h : see Low Level API,

• Images heap allocator: seeMemory,

• LLUI_INPUT_IMPL_log_queue_xxx() : see Event Bu�er.

The following table describes the compatibility versions between the Cmodules and the MicroEJ UI Packs:

C Module Range UI Pack Range
1.1.0 13.1.0
[1.0.0-1.0.3] [13.0.0-13.1.0]

4.13.12 Changelog

[13.1.0] - 2021-08-03

• Compatible with Architecture 7.13.0 or higher.

MicroUI API

Removed

• Remove MicroUI and Drawing API from UI pack.

MicroUI Implementation

Changed

• Compatible with MicroUI API 3.1.0.

• Check Immortals heapminimal size required by MicroUI implementation.

• Change the EventGenerator Pointer event format.

• Do no systematically use the GPU to draw intermediate steps of a shape.

Fixed

• EventGenerator’s event has not to be sent to the Display’s handler when EventGenerator’s handler is null.

• Fill rounded rectangle: fix rendering when corner radius is higher than rectangle height.

• An external image is closed twice when the application only checks if the image is available.

• RLE1 image rendering when platform requires image pixels address alignment.

• Manage the system fonts when the font generator is not embedded in the platform.

• Have to wait the end of current drawing before closing an image.

Drawing Implementation

Changed

• Compatible with Drawing API 1.0.3.
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LLAPIs

Added

• Add LLUI_DISPLAY_convertDisplayColorToARGBColor() .

• Add LLAPI to manage theMicroUI Image heap.

• Add LLAPI to dump theMicroUI Image queue.

Changed

• Change signature of LLUI_DISPLAY_setDrawingLimits() : remove MICROUI_GraphicsContext* to be able
to call this function from GPU callback method.

Simulator

Added

• Add MicroUIImage.getImage(int) : apply a rendering color on Ax images.

• Add LLUIDisplay.convertRegion() : convert a region according image format restrictions.

Changed

• Compatible with new EventGenerator Pointer event format.

Fixed

• Fix OutputFormat A8 when loading an image (path or stream) or converting a RAW image.

• Fix OOM (Java heap space) when opening/closing several hundreds of MicroUI Images.

• Simulates the image data alignment.

[13.0.7] -2021-07-30

• Compatible with Architecture 7.13.0 or higher.

MicroUI Implementation

Fixed

• Allow to open a font in format made with UI Pack 12.x (but cannot manage Dynamic styles).

• Display.flush() method is called once when MicroUI pump thread has a higher priority than the caller of
Display.requestFlush() .

• Display.requestFlush() is only executed once from a feature (UI deadlock).

Misc

Fixed

• Fix MMM dependencies: do not fetch the MicroEJ Architecture.
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[13.0.6] - 2021-03-29

• Compatible with Architecture 7.13.0 or higher.

LLAPIs

Fixed

• Size of the typedef MICROUI_Image : do not depend on the size of the enumeration MICROUI_ImageFormat
( LLUI_PAINTER_impl.h ).

[13.0.5] - 2021-03-08

• Compatible with Architecture 7.13.0 or higher.

MicroUI Implementation

Removed

• Remove ResourceManager dependency.

Fixed

• A feature was not able to call Display.callOnFlushCompleted().

• Stop feature: prevent NullPointerException when a kernel’s EventGenerator is removed from event genera-
tors pool.

• Filter DeadFeatureException in MicroUI pump.

• Drawing of thick arcs which represent an almost full circle.

• Drawing of thick faded arcs which pass by 0° angle.

Simulator

Fixed

• Front panel memory management: reduce simulation time.

[13.0.4] - 2021-01-15

• Compatible with Architecture 7.13.0 or higher.

MicroUI API

Changed

• [Changed] Include MicroUI API 3.0.3.

• [Changed] Include MicroUI Drawing API 1.0.2.
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MicroUI Implementation

Fixed

• Fix each circle arc cap being drawn on both sides of an angle.

• Fix drawing of rounded caps of circle arcs when fade is 0.

• Cap thickness and fade in thick drawing algorithms.

• Clip is not checked when filling arcs, circles and ellipsis.

• Image path when loading an external image ( LLEXT ).

• InternalLimitsError when calling MicroUI.callSerially() from a feature.

Drawing Implementation

Fixed

• Draw deformed image is not rendered.

ImageGenerator

Changed

• Compatible with com.microej.pack.ui#ui-pack(imageGenerator)#13.0.4.

Fixed

• NullPointerException when trying to convert an unknown image.

• Restore external resources option in MicroEJ launcher.

[13.0.3] - 2020-12-03

• Compatible with Architecture 7.13.0 or higher.

MicroUI API

Changed

• [Changed] Include MicroUI API 3.0.2.

• [Changed] Include MicroUI Drawing API 1.0.1.

MicroUI Implementation

Fixed

• Reduce Java heap usage.

• Fix empty images heap.

• Draw image algorithm does not respect image stride in certain circumstances.

• Fix flush limits of drawThickFadedLine , drawThickEllipse and drawThickFadedEllipse .
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[13.0.2] - 2020-10-02

• Compatible with Architecture 7.13.0 or higher.

• Use new naming convention: com.microej.architecture.[toolchain].[architecture]-ui-pack .

Fixed

• [ESP32] - Potential PSRAM access faults by rebuilding using esp-idf v3.3.0 toolchain - simikou2 .

[13.0.1] - 2020-09-22

• Compatible with Architecture 7.13.0 or higher.

MicroUI API

Changed

• Include MicroUI API 3.0.1.

MicroUI Implementation

Fixed

• Throw an exception when there is no display.

• Antialiased circle may be cropped.

• FillRoundRectangle can give invalid arguments to FillRectangle .

• Flush bounds may be invalid.

• Reduce memory footprint (java heap and immortal heap).

• No font is loaded when an external font is not available.

• A8 color is cropped to display limitation too earlier on simulator.

LLAPIs

Fixed

• Missing a LLAPI to check the overlapping between source and destination areas.

Simulator

Fixed

• Cannot use an external image decoder on front panel.

• Missing an API to check the overlapping between source and destination areas.
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ImageGenerator

Fixed

• Cannot build a platform with image generator and without front panel.

[13.0.0] - 2020-07-30

• Compatible with Architecture 7.13.0 or higher.

• Integrate SDK 3.0-B license.

MicroUI API

Changed

• [Changed] Include MicroUI API 3.0.0.

• [Changed] Include MicroUI Drawing API 1.0.0.

MicroUI Implementation

Added

• Manage image data (pixels) address alignment (not more fixed to 32-bits word alignment).

Changed

• Reduce EDC dependency.

• Merge DisplayPump and InputPump : only one thread is required by MicroUI.

• Use a bss section to load characters from an external font instead of using java heap.

Removed

• Dynamic fonts (dynamic bold, italic, underline and ratios).

Fixed

• Lock only current thread when waiting end of flush or end of drawing (and not all threads).

• Draw anti-aliased ellipse issue (vertical line is sometimes drawn).

• Screenshot on platform whose physical size is higher than virtual size.

Known issue

• Render of draw/fill arc/circle/ellipse with an even diameter/edge is one pixel too high (center is 1/2 pixel too
high).

LLAPIs

Added

• Some new functions are mandatory: see header files list, tagmandatory.

• Some new functions are optional: see header files list, tag optional.
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• Some header files list the libraries ej.api.microui and ej.api.drawing natives. Provided by Abstraction
Layer implementation module com.microej.clibrary.llimpl#microui.

• Some header files list the drawing algorithms the platform can implement; all algorithms are optional.

• Some header files list the internal graphical engine so�ware algorithms the platform can call.

Changed

• All old header files and functions have been renamed or shared.

• SeeMigration notes that describe the available changes in LLAPI.

Simulator

Added

• Able to override MicroUI drawings algorithms like embedded platform.

Changed

• Compatible with com.microej.pack.ui#ui-pack(frontpanel)#13.0.0.

• SeeMigration notes that describe the available changes in Front Panel API.

Removed

• ej.tool.frontpanel#widget-microui has been replaced by com.microej.pack.
ui#ui-pack(frontpanel) .

ImageGenerator

Added

• Redirects source image reading to the image generator extension project in order to increase the number of
supported image formats in input.

• Redirectsdestination imagegeneration to the imagegenerator extensionproject inorder tobeable toencode
an image in a custom RAW format.

• Generates a linker file in order to always link the resources in same order between two launches.

Changed

• Compatible with com.microej.pack.ui#ui-pack(imageGenerator)#13.0.0.

• SeeMigration notes that describe the available changes in Image Generator API.

• Uses a service loader to loads the image generator extension classes.

• Manages image data (pixels) address alignment.

Removed

• Classpath variable IMAGE-GENERATOR-x.x : Image generator extension project has to use ivy dependency
com.microej.pack.ui#ui-pack(imageGenerator) instead.

FontGenerator

Changed

• Used a dedicated bss section to load characters from an external font instead of using the java heap.
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[12.1.5] - 2020-10-02

• Compatible with Architecture 7.11.0 or higher.

• Use new naming convention: com.microej.architecture.[toolchain].[architecture]-ui-pack .

Fixed

• [ESP32] - Potential PSRAM access faults by rebuilding using esp-idf v3.3.0 toolchain - simikou2 .

[12.1.4] - 2020-03-10

• Compatible with Architecture 7.11.0 or higher.

MicroUI Implementation

Fixed

• Obsolete references on Java heap are used (since MicroEJ UI Pack 12.0.0).

[12.1.3] - 2020-02-24

• Compatible with Architecture 7.11.0 or higher.

MicroUI Implementation

Fixed

• Caps are not used when drawing an anti-aliased line.

[12.1.2] - 2019-12-09

• Compatible with Architecture 7.11.0 or higher.

MicroUI Implementation

Fixed

• Fix graphical engine empty clip (empty clip had got a size of 1 pixel).

• Clip not respected when clip is set “just a�er or before” graphics context drawable area: first (or last) line (or
column) of graphics context was rendered.

[12.1.1] - 2019-10-29

• Compatible with Architecture 7.11.0 or higher.
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MicroUI Implementation

Fixed

• Fix graphical engine clip (cannot be outside graphics context).

[(maint) 8.0.0] - 2019-10-18

• Compatible with Architecture 7.0.0 or higher.

• Based on 7.4.7.

MicroUI Implementation

Fixed

• Pending flush cannot be added a�er an OutOfEventException.

[12.1.0] - 2019-10-16

• Compatible with Architecture 7.11.0 or higher.

MicroUI API

Changed

• Include MicroUI API 2.4.0.

MicroUI Implementation

Changed

• Prepare inlining of get X/Y/W/Hmethods.

• Reduce number of strings embedded by MicroUI library.

Fixed

• Pending flush cannot be added a�er an OutOfEventException .

• Display.isColor() returns an invalid value.

• Draw/fill circle/ellipse arc is not drawn when angle is negative.

[12.0.2] - 2019-09-23

• Compatible with Architecture 7.11.0 or higher.
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MicroUI Implementation

Changed

• Change CM4hardfp_IAR83 compiler flags.

• Remove RAW images from cache as soon as possible to reduce java heap usage.

• Do not cache RAW images with their paths to reduce java heap usage.

Fixed

• Remove useless exception in SystemInputPump.

[12.0.1] - 2019-07-25

• Compatible with Architecture 7.11.0 or higher.

MicroUI Implementation

Fixed

• Physical size is not taken in consideration.

Simulator

Fixed

• Increase native implementation execution time.

[12.0.0] - 2019-06-24

• Compatible with Architecture 7.11.0 or higher.

MicroUI Implementation

Added

• Trace MicroUI events and log them on SystemView.

Changed

• Manage the Graphics Context clip on native side.

• Use java heap to store images metadata instead of using icetea heap (remove option “max o�screen”).

• Optimize retrieval of all fonts.

• Ensure user bu�er size is larger than LCD size.

• Use java heap to store flying images metadata instead of using icetea heap (remove option “max flying im-
ages”).

• Use java heap to store fill polygon algorithm’s objects instead of using icetea heap (remove option “max
edges”).

• SecurityManager enabled as a boolean constant option (footprint removal by default).
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• Remove FlyingImage feature using BON constants (option to enable it).

Fixed

• Wrong rendering of a fill polygon on emb.

• Wrong rendering of image overlaping on C1/2/4 platforms.

• Wrong rendering of a LUT image with more than 127 colors on emb.

• Wrong rendering of an antialiased arc with 360 angle.

• Debug option com.is2t.microui.log=true fails when there is a flying image.

• Gray scale between gray and white makes magenta.

• Minimal size of some bu�ers set by user is never checked.

• The format of a RAW image using “display” format is wrong.

• Dynamic image width for platform C1/2/4 may be wrong.

• Wrong pixel address when reading from a C2/4 display.

• getDisplayColor() can return a color with transparency (spec is 0x00RRGGBB ).

• A fully opaque image is tagged as transparent (ARGB8888 platform).

Simulator

Added

• Simulate flush time (add JRE property -Dfrontpanel.flush.time=8 ).

Fixed

• A pixel read on an image is always truncated.

FrontPanel Plugin

Removed

• FrontPanel version 5: Move front panel from MicroEJ UI Pack to Architecture (not backward compatible); Ar-
chitecture contains now Front Panel version 6.

[11.2.0] - 2019-02-01

• Compatible with Architecture 7.0.0 or higher.

MicroUI Implementation

Added

• Manage extended UTF16 characters (> 0x��).

Fixed

• IOException thrown instead of an OutOfMemory when using external resource loader.
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Tools

Removed

• Remove Font Designer from pack (useless).

[11.1.2] - 2018-08-10

• Compatible with Architecture 7.0.0 or higher.

MicroUI Implementation

Fixed

• Fix drawing bug in thick circle arcs.

[11.1.1] - 2018-08-02

• Compatible with Architecture 7.0.0 or higher.

• Internal release.

[11.1.0] - 2018-07-27

• Compatible with Architecture 7.0.0 or higher.

• Merge 10.0.2 and 11.0.1.

MicroUI API

Changed

• Include MicroUI API 2.3.0.

MicroUI Implementation

Added

• LLDisplay : prepare round LCD.

Fixed

• Fillrect throws a hardfault on 8bpp platform.

• Rendering of a LUT image is wrong when using so�ware algorithm.

[11.0.1] - 2018-06-05

• Compatible with Architecture 7.0.0 or higher.

• Based on 11.0.0.
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MicroUI Implementation

Fixed

• Image rendering may be invalid on custom display.

• Render a dynamic image on custom display is too slow.

• LRGB888 image format is always fully opaque.

• Number of colors returned when it is a custom display may be wrong.

[10.0.2] - 2018-02-15

• Compatible with Architecture 6.13.0 or higher.

• Based on 10.0.1.

MicroUI Implementation

Fixed

• Number of colors returned when it is a custom display may be wrong.

• LRGB888 image format is always fully opaque.

• Render a dynamic image on custom display is too slow.

• Image rendering may be invalid on custom display.

[11.0.0] - 2018-02-02

• Compatible with Architecture 7.0.0 or higher.

• Based on 10.0.1.

MicroUI Implementation

Changed

• SNI Callback feature in the VM to remove the SNI retry pattern (not backward compatible).

[10.0.1] - 2018-01-03

• Compatible with Architecture 6.13.0 or higher.

MicroUI Implementation

Fixed

• Hard fault when using custom display stack.
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[10.0.0] - 2017-12-22

• Compatible with Architecture 6.13.0 or higher.

MicroUI Implementation

Changed

• Improve TOP-LEFT anchor checks.

Fixed

• Subsequent renderings may not be correctly flushed.

• Rendering of display on display was not optimized.

Simulator

Changed

• Check the allocated memory when creating a dynamic image (not backward compatible).

Misc

Added

• Option in platform builder to images heap size.

[9.4.1] - 2017-11-24

• Compatible with Architecture 6.12.0 or higher.

ImageGenerator

Fixed

• Missing some files in image generator module.

[9.4.0] - 2017-11-23

• Compatible with Architecture 6.12.0 or higher.

• Deprecated: use 9.4.1 instead.

MicroUI Implementation

Added

• LUT imagemanagement.

Changed

• Optimize character encoding removing first vertical line when possible.
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Fixed

• Memory leak when an OutOfEvent exception is thrown.

• A null Java object is not checked when using a font.

[9.3.1] - 2017-09-28

• Compatible with Architecture 6.12.0 or higher.

MicroUI Implementation

Fixed

• Returned X coordinates when drawing a string was considered as an error code.

• Exception when loading a font from an application.

• LLEXT link error with Architecture 6.13+ and UI 9+.

[9.3.0] - 2017-08-24

• Compatible with Architecture 6.12.0 or higher.

MicroUI Implementation

Fixed

• Ellipsis must not drawn when text anchor is a “manual” TOP-RIGHT .

Simulator

Fixed

• Do not create an AWT window for each image.

• Error when trying to play with an unknown led.

[9.2.1] - 2017-08-14

• Compatible with Architecture 6.12.0 or higher.

Simulator

Added

• Provide function to send a Long Button event.

• “flush” debug option.

Fixed

• Mock startup is too long.
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[9.2.0] - 2017-07-21

• Compatible with Architecture 6.12.0 or higher.

• Merge 9.1.2 and 9.0.2.

MicroUI API

Changed

• Include MicroUI API 2.2.0.

MicroUI Implementation

Added

• Provide function to send a Long Button event (emb only).

Changed

• Use font format v5.

• A signature on RAW files.

• Allow to open a raw image with Image.createImage(stream) .

• Improve Image.createImage(stream) when stream is a memory input stream.

Fixed

• Draw region of the display on the display does not support overlap.

• Unspecified exception while loading an image with an empty name.

• Display.flush() : ymax can be higher than display.height.

ImageGenerator

Fixed

• Generic displays must be able to generate standard images.

Misc

Changed

• SOAR can exclude some resources (update llext output folder).

Fixed

• RI build: reduce frontpanel dependency.

[9.0.2] - 2017-04-21

• Compatible with Architecture 6.4.0 or higher.

• Based on 9.0.1.
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MicroUI Implementation

Fixed

• Rendering of a RAW image on grayscale display is wrong.

ImageGenerator

Fixed

• An Ax imagemay be fully opaque.

[9.1.2] - 2017-03-16

• Compatible with Architecture 6.8.0 or higher.

• Based on 9.1.1.

MicroUI API

Changed

• Include MicroUI API 2.1.3.

MicroUI Implementation

Added

• Renderable strings.

Changed

• Draw string: improve time to perform it.

• Optimize antialiased circle arc drawing when fade=0.

Fixed

• ImageScale bugs.

• Draw string: some errors are not thrown.

• Font.getWidth() and getHeight() don’t use ratio factor.

• Draw antialiased circle arc render issue.

• Draw antialiased circle arc render bug with 45° angles.

• MicroUI lib expects the dynamic image decoder default format.

• Wrong error code is returned when converting an image.
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ImageGenerator

Fixed

• Use the application classpath.

• An Ax imagemay be fully opaque.

[9.0.1] - 2017-03-13

• Compatible with Architecture 6.4.0 or higher.

• Based on 9.0.0.

MicroUI Implementation

Fixed

• Hardfault when filling a rectangle on an odd image.

• Pixel rendering on non-standard LCD is wrong.

• RZ hardware accelerator: RAW images have to respect an aligned size.

• Use the classpath when invoking the fonts and images generators.

Simulator

Fixed

• Wrong rendering of A8 images.

FrontPanel Plugin

Fixed

• Manage display mask on preview.

• Respect initial background color set by user on preview.

• Preview does not respect the real size of display.

[9.1.1] - 2017-02-14

• Compatible with Architecture 6.8.0 or higher.

• Based on 9.1.0.

Misc

Fixed

• RI build: Several custom event generators in same microui.xml file are not embedded.
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[9.1.0] - 2017-02-13

• Compatible with Architecture 6.8.0 or higher.

• Based on 9.0.0.

MicroUI API

Changed

• Include MicroUI API 2.1.2.

MicroUI Implementation

Added

• G2D hardware accelerator.

• Hardware accelerator: add flip feature.

Fixed

• Hardfault when filling a rectangle on an odd image.

• Pixel rendering on non-standard LCD is wrong.

• RZ hardware accelerator: RAW images have to respect an aligned size.

• Use the classpath when invoking the fonts and images generators.

• Exception when flipping an image out of display bounds.

• Flipped image is translated when clip is modified.

Simulator

Fixed

• Wrong rendering of A8 images.

FrontPanel Plugin

Fixed

• Manage display mask on preview.

• Respect initial background color set by user on preview.

• Preview does not respect the real size of display.

[9.0.0] - 2017-02-02

• Compatible with Architecture 6.4.0 or higher.
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MicroUI API

Changed

• Include MicroUI API 2.0.6.

MicroUI Implementation

Changed

• Update MicroUI to use watchdogs in KF implementation.

Fixed

• Display linker file is required even if there is no display on platform.

• MicroUI on KF: NPE when changing app quickly (in several threads).

• MicroUI on KF: NPE when stopping a Feature and there’s no eventHandler in a generator.

• MicroUI on KF: Remaining K->F link when there is no default event handler registered by the Kernel.

MWT

Removed

• Remove MWT fromMicroEJ UI Pack (not backward compatible).

Simulator

Added

• Optional mask on display.

Changed

• Display Device UID if available in the window title.

Tools

Changed

• FrontPanel plugin: Update icons.

• FontDesigner plugin: Update icons.

• Font Designer and Generator: use Unicode 9.0.0 specification.

Misc

Fixed

• Remove obsolete documentations from FrontPanel And FontDesigner plugins.
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[8.1.0] - 2016-12-24

• Compatible with Architecture 6.4.0 or higher.

MicroUI Implementation

Changed

• Improve image drawing timings.

• Runtime decoders can force the output RAW image’s fully opacity.

MWT

Fixed

• With two panels, the paint is done but the screen is not refreshed.

• Widget show notify method is called before the panel is set.

• Widget still linked to panel when lostFocus() is called.

Simulator

Added

• Can add an additional screen on simulator.

[8.0.0] - 2016-11-17

• Compatible with Architecture 6.4.0 or higher.

MicroUI Implementation

Added

• RZ UI acceleration.

• External image decoders.

• Manage external memories like internal memories.

• Custom display stacks (hardware acceleration).

Changed

• Merge stacks DIRECT/COPY/SWITCH (not backward compatible).

Fixed

• add KF rule: a thread cannot enter in a feature code while it owns a kernel monitor.

• automatic flush is not waiting the end of previous flush.

• Invalid image rotation rendering.

• Do not embed Images & Fonts.list of kernel API classpath in appmode.
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• Invalid icetea heap allocation.

• microui image: invalid “defaultformat” and “format” fields values.

MWT

Fixed

• possible to create an inconsistent hierarchy.

Simulator

Added

• Can decode additional image formats.

Fixed

• Cannot set initial value of StateEventGenerator.

[7.4.7] - 2016-06-14

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Fixed

• Do not create all fonts derivations of built-in styles.

• A bold font is not flagged as bold font.

• Wrong A4 image rendering.

Simulator

Fixed

• Cannot convert an image.

[7.4.2] - 2016-05-25

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Fixed

• invalid image drawing for column display.
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[7.4.1] - 2016-05-10

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Fixed

• Restore stack 1, 2 and 4 BPP.

[7.4.0] - 2016-04-29

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Fixed

• image A1’s width is sometimes invalid.

Simulator

Added

• Restore stack 1, 2 and 4 BPP.

[7.3.0] - 2016-04-25

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Added

• Stack 8BPP with LUT support.

[7.2.1] - 2016-04-18

• Compatible with Architecture 6.1.0 or higher.

Misc

Fixed

• Remove java keyword in workbench extension.

[7.2.0] - 2016-04-05

• Compatible with Architecture 6.1.0 or higher.
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Tools

Added

• Preprocess *.xxx.list files.

[7.1.0] - 2016-03-02

• Compatible with Architecture 6.1.0 or higher.

MicroUI Implementation

Added

• Manage several images RAW formats.

[7.0.0] - 2016-01-20

• Compatible with Architecture 6.1.0 or higher.

Misc

Changed

• Remove jpf property header (not backward compatible).

[6.0.1] - 2015-12-17

MicroUI Implementation

Fixed

• A negative clip throws an exception on simulator.

[6.0.0] - 2015-11-12

MicroUI Implementation

Changed

• LLDisplay for UIv2 (not backward compatible).

4.13.13 Migration Guide

From 13.0.x to 13.1.x

Front Panel

• Set the explicit dependency to the UI Pack 13.1.0:
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<dependency org="com.microej.pack.ui" name="ui-pack" rev="13.1.0">
<artifact name="frontpanel" type="jar"/>

</dependency>

BSP

• Add a cast when using MICROUI_Image* object: (MICROUI_ImageFormat)image->format .

• Remove parameter MICROUI_GraphicsContext* when calling LLUI_DISPLAY_setDrawingLimits() .

• Ensure to call LLUI_DISPLAY_setDrawingLimits() before calling LLUI_DISPLAY_setDrawingStatus() or
LLUI_DISPLAY_notifyAsynchronousDrawingEnd() .

• (optional) Add an implementation of LLUI_DISPLAY_IMPL_image_heap_xxx to control the images heap al-
location; by default the internal Graphics Engine’s allocator is used. Another implementation is also available
on the Cmodule.

From 12.x to 13.x

Platform Configuration Project

• Update Architecture version: 7.13.0 or higher.

• Add the following module in themodule description file:

<dependency org="com.microej.clibrary.llimpl" name="microui" rev="1.0.3"/>

• If not already set, set the ea:property bsp.project.microej.dir in the module ivy file to configure the
BSP output folder where is extracted the module.

Hardware Accelerator

• Open -configuration project > display > display.properties

• Remove optional property hardwareAccelerator . If old value was dma2d , add the followingmodule in the
module description file:

<dependency org="com.microej.clibrary.llimpl" name="display-dma2d" rev="1.0.6"/>``

• For the hardware accelerator DMA2D, please consult STM32F7Discovery board updates. Add the file
lldisplay_dma2d.c , the global defines DRAWING_DMA2D_BPP=16 (or another value) and STM32F4XX or
STM32F7XX

• For the others hardware accelerators, please contact MicroEJ support.

Front Panel

This chapter resumes the changes to perform. The available changes in Front Panel API are described in next chap-
ter.

• If not already done, follow the Front Panel version 6migration procedure detailled in chapter From 11.x to 12.x.

4.13. Graphical User Interface 458



MicroEJ Documentation, Revision 2788b3f4

• Update the fp project dependency: <dependency org="ej.tool.frontpanel" name="widget" rev="2.
0.0"/>

• ej.fp.event.MicroUIButtons has been renamed in ej.microui.event.EventButton , and all others ej.
fp.event.MicroUIxxx in ej.microui.event.Eventxxx

• Display abstract class AbstractDisplayExtension (class to extendwidgetDisplaywhen targettinga custom
display) has been converted on the interface DisplayExtension . Somemethods names have changed and
now take in parameter the display widget.

Front Panel API

• ej.drawing.DWDrawing

– [Added] Equivalent of dw_drawing.h and dw_drawing_soft.h** : allows to implement some drawing
algorithms and/or to use the ones provided by the graphical engine. The drawing methods are related
to the library ej.api.drawing .

– [Added] Interface DWDrawingDefault : default implementation of DWDrawing which calls the graphical
engine algorithms.

• ej.drawing.LLDWPainter

– [Added] Equivalent of module com.microej.clibrary.llimpl#microui ( LLDW_PAINTER_impl.c ): imple-
ments all ej.api.drawing natives and redirect them to the interface DWDrawing .

– [Added] setDrawer(DWDrawing) : allows to configure the implementation of DWDrawing the
LLDWPainter has to use. When no drawer is configured, LLDWPainter redirects all drawings to the
internal graphical engine so�ware algorithms.

• ej.fp.event.MicroUIButtons

– [Removed] Replaced by EventButton .

• ej.fp.event.MicroUICommand

– [Removed] Replaced by EventCommand .

• ej.fp.event.MicroUIEventGenerator

– [Removed] Replaced by LLUIInput .

• ej.fp.event.MicroUIGeneric

– [Removed] Replaced by EventGeneric .

• ej.fp.event.MicroUIPointer

– [Removed] Replaced by EventPointer .

• ej.fp.event.MicroUIStates

– [Removed] Replaced by EventState .

• ej.fp.event.MicroUITouch

– [Removed] Replaced by EventTouch .

• ej.fp.widget.MicroUIDisplay

– [Removed] Replaced by LLUIDisplayImpl . Abstract widget display class has been replaced by an in-
terface that a widget (which should simulate a display) has to implement to be compatible with the
graphical engine.
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– [Removed] AbstractDisplayExtension , all available implementations and
setExtensionClass(String) : the standard display formats (RGB565, etc.) are internally man-
aged by the graphical engine. For generic formats, some APIs are available in LLUIDisplayImpl
.

– [Removed] finalizeConfiguration() , getDisplayHeight() , getDisplayWidth() ,
getDrawingBuffer() , setDisplayWidth(int) , setDisplayHeight(int) , start() :
LLUIDisplayImpl is not an abstract widget anymore, these notions are widget dependent.

– [Removed] flush() .

– [Removed] getNbBitsPerPixel() .

– [Removed] switchBacklight(boolean) .

• ej.fp.widget.MicroUILED

– [Removed] Replacedby LLUILedImpl . Abstractwidget LED class has been replacedby an interface that
a widget (which should simulate a LED) has to implement to be compatible with the graphical engine.

– [Removed] finalizeConfiguration() : LLUILedImpl is not an abstract widget anymore, this notion
is widget dependent.

– [Removed] getID() : MicroUI uses the widget (which implements the interface LLUILedImpl )’s label
to retrieve the LED. The LED labels must be integers from 0 to n-1 .

• ej.microui.display.LLUIDisplay

– [Added] Equivalent of LLUI_DISPLAY.h : several functions to interact with the graphical engine.

– [Added] blend(int,int,int) : blends two ARGB colors and opacity level.

– [Added] convertARGBColorToColorToDraw(int) : crops given color to display capacities.

– [Added] getDisplayPixelDepth() : replaces MicroUIDisplay.getNbBitsPerPixel() .

– [Added] getDWDrawerSoftware() : gives the unique instance of graphical engine’s internal so�ware
drawer (instance of DWDrawing ).

– [Added] getUIDrawerSoftware() : gives the unique instance of graphical engine’s internal so�ware
drawer (instance of UIDrawing ).

– [Added] mapMicroUIGraphicsContext(byte[]) and newMicroUIGraphicsContext(byte[]) : maps
the graphics context byte array ( GraphicsContext.getSNIContext() ) on an object which represents
the graphics context in front panel.

– [Added] mapMicroUIImage(byte[]) and newMicroUIImage(byte[]) : maps the image byte array (
Image.getSNIContext() ) on an object which represents the image in front panel.

– [Added] requestFlush(boolean) : requests a call to LLUIDisplayImpl.flush() .

– [Added] requestRender(void) : requests a call to Displayable.render() .

• ej.microui.display.LLUIDisplayImpl

– [Added] Replaces MicroUIDisplay , equivalent of LLUI_DISPLAY_impl.h .

– [Added] initialize() : asks to initialize thewidget and to return a front panel imagewhere the graph-
ical engine will perform the MicroUI drawings.

– [Changed] flush(MicroUIGraphicsContext, Image, int, int, int, int) : asks to flush the graph-
ics context drawn by MicroUI in image returned by initialize() .

• ej.microui.display.LLUIPainter
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– [Added] Equivalent of module com.microej.clibrary.llimpl#microui ( LLUI_PAINTER_impl.c ): imple-
ments all ej.api.microui natives and redirect them to the interface UIDrawing .

– [Added] MicroUIGraphicsContext : representation of aMicroUI GraphicsContext in front panel. This
interface (implemented by the graphical engine) provides several function to get information on graph-
ics context, clip, etc.

– [Added] MicroUIGraphicsContext#requestDrawing() : allows to take thehandon thedrawingbu�er.

– [Added] MicroUIImage : representation of aMicroUI Image in front panel. This interface (implemented
by the graphical engine) provides several function to get information on image.

– [Added] setDrawer(UIDrawing) : allows to configure the implementation of UIDrawing the
LLUIPainter has to use. When no drawer is configured, LLUIPainter redirects all drawings to the
internal graphical engine so�ware algorithms.

–

• ej.microui.display.UIDrawing

– [Added] Equivalent of ui_drawing.h and ui_drawing_soft.h** : allows to implement some drawing
algorithms and/or to use the ones provided by the graphical engine. The drawing methods are related
to the library ej.api.microui .

– [Added] Interface UIDrawingDefault : default implementation of UIDrawing which calls the graphical
engine algorithms.

• ej.microui.event.EventButton

– [Added] Replaces MicroUIButton .

• ej.microui.event.EventCommand

– [Added] Replaces MicroUICommand .

• ej.microui.event.EventGeneric

– [Added] Replaces MicroUIGeneric .

• ej.microui.event.EventPointer

– [Added] Replaces MicroUIPointer .

• ej.microui.event.EventQueue

– [Added] Dedicated events queue used by MicroUI.

• ej.microui.event.EventState

– [Added] Replaces MicroUIState .

• ej.microui.event.EventTouch

– [Added] Replaces MicroUITouch .

• ej.microui.event.LLUIInput

– [Added] Replaces MicroUIEventGenerator .

• ej.microui.led.LLUILedImpl

– [Added] Replaces MicroUILED .
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Image Generator

This chapter resumes the changes to perform. The available changes in Image Generator API are described in next
chapter.

This chapter only concerns platform with a custom display. In this case a dedicated image generator extension
project is available. This project must be updated.

• Reorganize project to use source folders src/main/java and src/main/resources

• Add new module.ivy file:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org" xmlns:m="http://www.easyant.
→˓org/ivy/maven" xmlns:ej="https://developer.microej.com" ej:version="2.0.0">

<info organisation="com.is2t.microui" module="imageGenerator-xxx" status="integration
→˓" revision="1.0.0">

<ea:build organisation="com.is2t.easyant.buildtypes" module="build-std-javalib"␣
→˓revision="2.+"/>

</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public" description="Runtime dependencies to␣

→˓other artifacts"/>
<conf name="provided" visibility="public" description="Compile-time dependencies␣

→˓to APIs provided by the platform"/>
<conf name="documentation" visibility="public" description="Documentation related␣

→˓to the artifact (javadoc, PDF)"/>
<conf name="source" visibility="public" description="Source code"/>
<conf name="dist" visibility="public" description="Contains extra files like␣

→˓README.md, licenses"/>
<conf name="test" visibility="private" description="Dependencies for test␣

→˓execution. It is not required for normal use of the application, and is only available␣
→˓for the test compilation and execution phases."/>

</configurations>

<publications/>

<dependencies>
<dependency org="com.microej.pack.ui" name="ui-pack" rev="[UI Pack version]">

<artifact name="imageGenerator" type="jar"/>
</dependency>

</dependencies>
</ivy-module>

The artifact name prefix must be imageGenerator- .

• Update project classpath: remove classpath variable IMAGE-GENERATOR-x.x and add ivy file dependency

• Instead of implement GenericDisplayExtension , the extension class must extend BufferedImageLoader
class; check class methods to override.

• Add the file src/main/resources/META-INF/services/com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension ; this file has to specify the class which extends the
BufferedImageLoader class, for instance:

com.microej.generator.MyImageGeneratoExtension

• Build the easyant project
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• Copy the jar in the platform -configuration project > dropins folder

• Rebuild the platform a�er any changes

Image Generator API

• com.is2t.microej.microui.image.CustomDisplayExtension

– [Removed] Replaced by ImageConverter and MicroUIRawImageGeneratorExtension .

• com.is2t.microej.microui.image.DisplayExtension

– [Removed]

• com.is2t.microej.microui.image.GenericDisplayExtension

– [Removed] Replaced by ImageConverter and MicroUIRawImageGeneratorExtension .

• com.microej.tool.ui.generator.BufferedImageLoader

– [Added] Pixelated image loader (PNG, JPEG etc.).

• com.microej.tool.ui.generator.Image

– [Added] Representation of an image listed in a images.list file.

• com.microej.tool.ui.generator.ImageConverter

– [Added] Generic converter to convert an image in an output stream.

• com.microej.tool.ui.generator.MicroUIRawImageGeneratorExtension

– [Added] Graphical engine RAW image converter: used when the image (listed in images.list ) targets
a RAW format known by the graphical engine.

Font

• Open optional font(s) in -configuration project > microui/**/*.ejf

• Removeall Dynamic styles (select None or Built-in for bold, italic andunderline); thenumberof generated
fonts must be 1 (the feature to render Dynamic styles at runtime have been removed)

• Save the file(s)

BSP

This chapter resumes the changes to perform. The available changes in LLAPI are described in next chapter.

• Delete all platform header files (folder should be set in -configuration project > bsp > bsp.properties
> property output.dir )

• If not possible to delete this folder, delete all UI headers files:

– intern/LLDISPLAY*

– intern/LLINPUT*

– intern/LLLEDS*

– LLDISPLAY*

– LLINPUT*
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– LLLEDS*

• Replace all #include "LLDISPLAY.h" , #include "LLDISPLAY_EXTRA.h" and #include
"LLDISPLAY_UTILS.h" by #include "LLUI_DISPLAY.h"

• Replace all #include "LLDISPLAY_impl.h" , #include "LLDISPLAY_EXTRA_drawing.h" and #include
"LLDISPLAY_EXTRA_impl.h" by #include "LLUI_DISPLAY_impl.h"

• Replace all LLDISPLAY_EXTRA_IMAGE_xxx by MICROUI_IMAGE_FORMAT_xxx

• All LLDISPLAY_IMPL_xxx functions have been renamed in LLUI_DISPLAY_IMPL_xxx

• LLUI_DISPLAY_IMPL_initialize has now the paremeter LLUI_DISPLAY_SInitData* init_data ; fill it as
explained in C doc.

• Implement new functions void LLUI_DISPLAY_IMPL_binarySemaphoreTake(void* sem) and void
LLUI_DISPLAY_IMPL_binarySemaphoreGive(void* sem, bool under_isr)

• Signature of LLUI_DISPLAY_IMPL_flush has changed

• All LLDISPLAY_EXTRA_IMPL_xxx functions have been renamed in LLUI_DISPLAY_IMPL_xxx

• Fix some functions signatures ( LLUI_DISPLAY_IMPL_hasBacklight() , etc)

• Remove the functions LLDISPLAY_IMPL_getGraphicsBufferAddress ,
LLDISPLAY_IMPL_getHeight , LLDISPLAY_IMPL_getWidth , LLDISPLAY_IMPL_synchronize ,
LLDISPLAY_EXTRA_IMPL_waitPreviousDrawing , LLDISPLAY_EXTRA_IMPL_error

• Add the end of asynchronous flush copy, call LLUI_DISPLAY_flushDone

• Add the files LLUI_PAINTER_impl.c and LLDW_PAINTER_impl.c in your C configuration project

• Replace the prefix LLINPUT in all header files, functions and defines by the new prefix LLUI_INPUT

• Replace the prefix LLLEDS in all header files, functions and defines by the new prefix LLUI_LED

• Replace the prefix LLDISPLAY in all header files, functions and defines by the new prefix LLUI_DISPLAY

LLAPI

• dw_drawing_soft.h

– [Added] List of internal graphical engine so�ware algorithms to perform some drawings (related to li-
brary ej.api.drawing ).

• dw_drawing.h

– [Added] List of ej.api.drawing library’s drawing functions to optionally implement in platform.

• LLDISPLAY.h and intern/LLDISPLAY.h

– [Removed]

• LLDISPLAY_DECODER.h and intern/LLDISPLAY_DECODER.h

– [Removed]

• LLDISPLAY_EXTRA.h and intern/LLDISPLAY_EXTRA.h merged in LLUI_PAINTER_impl.h and
LLDW_PAINTER_impl.h

– [Changed] LLDISPLAY_SImage : replaced by MICROUI_Image .

– [Removed] LLDISPLAY_SRectangle , LLDISPLAY_SDecoderImageData , LLDISPLAY_SDrawImage ,
LLDISPLAY_SFlipImage , LLDISPLAY_SScaleImage and LLDISPLAY_SRotateImage

• LLDISPLAY_EXTRA_drawing.h
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– [Removed]

• LLDISPLAY_EXTRA_impl.h and intern/LLDISPLAY_EXTRA_impl.h merged in LLUI_DISPLAY_impl.h ,
ui_drawing.h and dw_drawing.h

– [Changed] LLDISPLAY_EXTRA_IMPL_setContrast(int32_t) : replaced by
LLUI_DISPLAY_IMPL_setContrast(uint32_t) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_getContrast(void) : replaced by
LLUI_DISPLAY_IMPL_getContrast(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_hasBackLight(void) : replaced by
LLUI_DISPLAY_IMPL_hasBacklight(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_setBacklight(int32_t) : replaced by
LLUI_DISPLAY_IMPL_setBacklight(uint32_t) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_getBacklight(void) : replaced by
LLUI_DISPLAY_IMPL_getBacklight(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_isColor(void) : replaced by
LLUI_DISPLAY_IMPL_isColor(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_getNumberOfColors(void) : replaced by
LLUI_DISPLAY_IMPL_getNumberOfColors(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_isDoubleBuffered(void) : replaced by
LLUI_DISPLAY_IMPL_isDoubleBuffered(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_getBacklight(void) : replaced by
LLUI_DISPLAY_IMPL_getBacklight(void) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_fillRect(void*,int32_t,void*,int32_t) : replaced by
UI_DRAWING_fillRectangle(MICROUI_GraphicsContext*,jint,jint,jint,jint) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_drawImage(void*,int32_t,void*,int32_t,void*) : replaced
by UI_DRAWING_drawImage(MICROUI_GraphicsContext*,MICROUI_Image*,jint,jint,jint,jint,
jint,jint,jint) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_flipImage(void*,int32_t,void*,int32_t,void*) : replaced
by DW_DRAWING_drawFlippedImage(MICROUI_GraphicsContext*,MICROUI_Image*,jint,jint,
jint,jint,jint,jint,DRAWING_Flip,jint) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_scaleImage(void*,int32_t,void*,int32_t,void*) :
replaced by DW_DRAWING_drawScaledImageNearestNeighbor(MICROUI_GraphicsContext*,
MICROUI_Image*,jint,jint,jfloat,jfloat,jint) and DW_DRAWING_drawScaledImageBilinear(MICROUI_GraphicsContext*,
MICROUI_Image*,jint,jint,jfloat,jfloat,jint) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_rotateImage(void*,int32_t,void*,int32_t,void*) :
replaced by DW_DRAWING_drawRotatedImageNearestNeighbor(MICROUI_GraphicsContext*,
MICROUI_Image*,jint,jint,jint,jint,jfloat,jint) and DW_DRAWING_drawRotatedImageBilinear(MICROUI_GraphicsContext*,
MICROUI_Image*,jint,jint,jint,jint,jfloat,jint) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_convertARGBColorToDisplayColor(int32_t) and
LLDISPLAY_EXTRA_IMPL_convertDisplayColorToARGBColor(int32_t) : replaced re-
spectively by LLUI_DISPLAY_IMPL_convertARGBColorToDisplayColor(uint32_t) and
LLUI_DISPLAY_IMPL_convertDisplayColorToARGBColor(uint32_t) (_optional_).

– [Changed] LLDISPLAY_EXTRA_IMPL_prepareBlendingOfIndexedColors(void*,void*) : replaced by
LLUI_DISPLAY_IMPL_prepareBlendingOfIndexedColors(uint32_t*,uint32_t*) (_optional_).
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– [Changed] LLDISPLAY_EXTRA_IMPL_decodeImage(int32_t,int32_t,int32_t,void*) : replaced by
LLUI_DISPLAY_IMPL_decodeImage(uint8_t*,uint32_t,MICROUI_ImageFormat,MICROUI_Image*,
bool*) (_optional_).

– [Removed] LLDISPLAY_EXTRA_IMPL_getGraphicsBufferMemoryWidth(void) and
LLDISPLAY_EXTRA_IMPL_getGraphicsBufferMemoryHeight(void) : replacedbyelements in structure
LLUI_DISPLAY_SInitData (_optional_).

– [Removed] LLDISPLAY_EXTRA_IMPL_backlightOn(void) and LLDISPLAY_EXTRA_IMPL_backlightOff(void)
.

– [Removed] LLDISPLAY_EXTRA_IMPL_enterDrawingMode(void) and
LLDISPLAY_EXTRA_IMPL_exitDrawingMode(void) .

– [Removed] LLDISPLAY_EXTRA_IMPL_error(int32_t) .

– [Removed] LLDISPLAY_EXTRA_IMPL_waitPreviousDrawing(void) : implementation has to call
LLUI_DISPLAY_notifyAsynchronousDrawingEnd(bool) instead.

• LLDISPLAY_impl.h and intern/LLDISPLAY_impl.h merged in LLUI_DISPLAY_impl.h

– [Changed] LLDISPLAY_IMPL_initialize(void) : replacedby LLUI_DISPLAY_IMPL_initialize(LLUI_DISPLAY_SInitData*)
(_mandatory_).

– [Changed] LLDISPLAY_IMPL_flush(int32_t,int32_t,int32_t,int32_t,int32_t) : replaced
by LLUI_DISPLAY_IMPL_flush(MICROUI_GraphicsContext*,uint8_t*, uint32_t,uint32_t,
uint32_t,uint32_t) (_mandatory_).

– [Removed] LLDISPLAY_IMPL_getWidth(void) , LLDISPLAY_IMPL_getHeight(void) and
LLDISPLAY_IMPL_getGraphicsBufferAddress(void) : replaced by elements in structure
LLUI_DISPLAY_SInitData .

– [Removed] LLDISPLAY_IMPL_synchronize(void) : implementation has to call
LLUI_DISPLAY_flushDone(bool) instead.

• LLDISPLAY_UTILS.h and intern/LLDISPLAY_UTILS.h merged in LLUI_DISPLAY.h

– [Changed] LLDISPLAY_UTILS_getBufferAddress(int32_t) : replaced by
LLUI_DISPLAY_getBufferAddress(MICROUI_Image*) .

– [Changed] LLDISPLAY_UTILS_setDrawingLimits(int32_t,int32_t,int32_t,int32_t,int32_t)
: replaced by LLUI_DISPLAY_setDrawingLimits(MICROUI_GraphicsContext*,jint,jint,jint,
jint) .

– [Changed] LLDISPLAY_UTILS_blend(int32_t,int32_t,int32_t) : replaced by
LLUI_DISPLAY_blend(uint32_t,uint32_t,uint32_t) .

– [Changed] LLDISPLAY_UTILS_allocateDecoderImage(void*) : replaced by
LLUI_DISPLAY_allocateImageBuffer(MICROUI_Image*,uint8_t) .

– [Changed] LLDISPLAY_UTILS_flushDone(void) : replaced by LLUI_DISPLAY_flushDone(bool) .

– [Changed] LLDISPLAY_UTILS_drawingDone(void) : replaced by
LLUI_DISPLAY_notifyAsynchronousDrawingEnd(bool) .

– [Removed] LLDISPLAY_UTILS_getWidth(int32_t) , LLDISPLAY_UTILS_getHeight(int32_t) and
LLDISPLAY_UTILS_getFormat(int32_t) : use MICROUI_Image elements instead.

– [Removed] LLDISPLAY_UTILS_enterDrawingMode(void) and LLDISPLAY_UTILS_exitDrawingMode(void)
.

– [Removed] LLDISPLAY_UTILS_setClip(int32_t,int32_t,int32_t,int32_t,int32_t) .
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– [Removed] LLDISPLAY_UTILS_getClipX1/X2/Y1/Y2(int32_t) : use MICROUI_GraphicsContext ele-
ments instead.

– [Removed] LLDISPLAY_UTILS_drawPixel(int32_t,int32_t,int32_t) and
LLDISPLAY_UTILS_readPixel(int32_t,int32_t,int32_t) .

• LLDW_PAINTER_impl.h

– [Added] List of ej.api.drawing library’s native functions implemented in module
com.microej.clibrary.llimpl#microui.

• LLLEDS_impl.h and intern/LLLEDS_impl.h merged in LLUI_LED_impl.h

– [Changed] LLLEDS_MIN_INTENSITY and LLLEDS_MAX_INTENSITY : replaced respectively by
LLUI_LED_MIN_INTENSITY and LLUI_LED_MAX_INTENSITY .

– [Changed] LLLEDS_IMPL_initialize(void) : replaced by LLUI_LED_IMPL_initialize(void) .

– [Changed] LLLEDS_IMPL_getIntensity(int32_t) : replaced by
LLUI_LED_IMPL_getIntensity(jint) .

– [Changed] LLLEDS_IMPL_setIntensity(int32_t,int32_t) : replaced by
LLUI_LED_IMPL_setIntensity(jint,jint) .

• LLINPUT.h and intern/LLINPUT.h merged in LLUI_INPUT.h

– [Changed] LLINPUT_sendEvent(int32_t,int32_t) : replaced by LLUI_INPUT_sendEvent(jint,
jint) .

– [Changed] LLINPUT_sendEvents(int32_t,int32_t*,int32_t) : replaced by
LLUI_INPUT_sendEvents(jint,jint*,jint) .

– [Changed] LLINPUT_sendCommandEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendCommandEvent(jint,jint) .

– [Changed] LLINPUT_sendButtonPressedEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendButtonPressedEvent(jint,jint) .

– [Changed] LLINPUT_sendButtonReleasedEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendButtonReleasedEvent()jint,jint .

– [Changed] LLINPUT_sendButtonRepeatedEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendButtonRepeatedEvent(jint,jint) .

– [Changed] LLINPUT_sendButtonLongEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendButtonLongEvent(jint,jint) .

– [Changed] LLINPUT_sendPointerPressedEvent(int32_t,int32_t,int32_t,int32_t,int32_t) :
replaced by LLUI_INPUT_sendPointerPressedEvent(jint,jint,jint,jint,LLUI_INPUT_Pointer)
.

– [Changed] LLINPUT_sendPointerReleasedEvent(int32_t,int32_t) : replaced by
LLUI_INPUT_sendPointerReleasedEvent(jint,jint) .

– [Changed] LLINPUT_sendPointerMovedEvent(int32_t,int32_t,int32_t,int32_t) : replaced by
LLUI_INPUT_sendPointerMovedEvent(jint,jint,jint,LLUI_INPUT_Pointer) .

– [Changed] LLINPUT_sendTouchPressedEvent(int32_t,int32_t,int32_t) : replaced by
LLUI_INPUT_sendTouchPressedEvent(jint,jint,jint) .

– [Changed] LLINPUT_sendTouchReleasedEvent(int32_t) : replaced by
LLUI_INPUT_sendTouchReleasedEvent(jint) .

– [Changed] LLINPUT_sendTouchMovedEvent(int32_t,int32_t,int32_t) : replaced by
LLUI_INPUT_sendTouchMovedEvent(jint,jint,jint) .
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– [Changed] LLINPUT_sendStateEvent(int32_t,int32_t,int32_t) : replaced by
LLUI_INPUT_sendStateEvent(jint,jint,jint) .

– [Changed] LLINPUT_getMaxEventsBufferUsage(void) : replaced by
LLUI_INPUT_getMaxEventsBufferUsage(void) .

• LLINPUT_impl.h and intern/LLINPUT_impl.h merged in LLUI_INPUT_impl.h

– [Changed] LLINPUT_IMPL_initialize(void) : replaced by LLUI_INPUT_IMPL_initialize(void)
(_mandatory_).

– [Changed] LLINPUT_IMPL_getInitialStateValue(int32_t,int32_t) : replaced by
LLUI_INPUT_IMPL_getInitialStateValue(jint,jint) (_mandatory_).

– [Changed] LLINPUT_IMPL_enterCriticalSection(void) : replaced by
LLUI_INPUT_IMPL_enterCriticalSection(void) (_mandatory_).

– [Changed] LLINPUT_IMPL_leaveCriticalSection(void) : replaced by
LLUI_INPUT_IMPL_leaveCriticalSection(void) (_mandatory_).

• LLUI_DISPLAY.h

– [Added] Renaming of LLDISPLAY_UTILS.h .

– [Added]Several functions to interactwith thegraphical engineand toget informationon images, graph-
ics context, clip, etc.

– [Added] LLUI_DISPLAY_requestFlush(bool) : requests a call to LLUI_DISPLAY_IMPL_flush() .

– [Added] LLUI_DISPLAY_requestRender(void) : requests a call to Displayable.render() .

– [Added] LLUI_DISPLAY_freeImageBuffer(MICROUI_Image*) : frees an image previously allocated by
LLUI_DISPLAY_allocateImageBuffer(MICROUI_Image*,uint8_t) .

– [Added] LLUI_DISPLAY_requestDrawing(MICROUI_GraphicsContext*,SNI_callback) : allows to
take the hand on the shared drawing bu�er.

– [Added] LLUI_DISPLAY_setDrawingStatus(DRAWING_Status) : specifies the drawing status to the
graphical engine.

• LLUI_DISPLAY_impl.h

– [Added] Merge of LLDISPLAY_EXTRA_impl.h and LLDISPLAY_impl.h .

– [Added] Structure LLUI_DISPLAY_SInitData : implementation has to fill it in
LLUI_DISPLAY_IMPL_initialize(LLUI_DISPLAY_SInitData*) .

– [Added] LLUI_DISPLAY_IMPL_binarySemaphoreTake(void*) and
LLUI_DISPLAY_IMPL_binarySemaphoreGive(void*,bool) : implementation has to manage a
binary semaphore (_mandatory_).

– [Added] LLUI_DISPLAY_IMPL_getNewImageStrideInBytes(MICROUI_ImageFormat,uint32_t,
uint32_t,uint32_t) : allows to set an image stride di�erent than image side (_optional_).

• LLUI_PAINTER_impl.h

– [Added] List of ej.api.microui library’s native functions implemented in module
com.microej.clibrary.llimpl#microui.

– [Added] MICROUI_ImageFormat : MicroUI Image pixel format.

– [Added] MICROUI_Image : MicroUI Image representation.

– [Added] MICROUI_GraphicsContext : MicroUI GraphicsContext representation.

• ui_drawing_soft.h
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– [Added] List of internal graphical engine so�ware algorithms to perform some drawings (related to li-
brary ej.api.microui ).

• ui_drawing.h

– [Added] List of ej.api.microui library’s drawing functions to optionally implement in platform.

CustomNative Drawing Functions

• In custom UI native methods, replace LLDISPLAY_UTILS_getBufferAddress(xxx); by
(uint32_t)LLUI_DISPLAY_getBufferAddress(xxx) (new function returns uint8_t* ), where uint32_t
xxx is replaced by MICROUI_Image* xxx or by MICROUI_GraphicsContext* xxx .

• Replace LLDISPLAY_UTILS_getFormat(xxx) by xxx->format , where uint32_t xxx is replaced by
MICROUI_Image* xxx or by MICROUI_GraphicsContext* xxx .

• Replace call to LLDISPLAY_allocateDecoderImage by a call to LLUI_DISPLAY_allocateImageBuffer

• Optional: implement drawing functions listed in ui_drawing.h following the available examples in
LLUI_PAINTER_impl.c and LLDW_PAINTER_impl.c files comments.

Application

• See applicationMigration Guide.

From 11.x to 12.x

Platform Configuration Project

• Update Architecture version: 7.11.0 or higher.

Front Panel

• Create a new Front Panel Project (next sections explain how to update each widget):

1. Verify that FrontPanelDesigner is at least version 6: Help > About > Installations Details >

Plug-ins .

2. Create a new front panel project: File > New > Project. . . > MicroEJ >

MicroEJ Front Panel Project , choose a name and press Finish .

3. Move files from [old project]/src to [new project]/src/main/java .

4. Move files from [old project]/resources to [new project]/src/main/resources .

5. Move files from [old project]/definitions to [new project]/src/main/resources , except your
xxx.fp file.

6. If existing delete file [new project]/src/main/java/microui.properties .

7. Delete file [new project]/src/main/resources/.fp.xsd .

8. Delete file [new project]/src/main/resources/.fp1.0.xsd .

9. Delete file [new project]/src/main/resources/widgets.desc .
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10. Open [old project]/definitions/xxx.fp .

11. Copy device attributes ( name and skin ) from [old project]/definitions/xxx.fp to [new
project]/src/main/resources/xxx.fp .

12. Copy content of body (not body tag itself) from [old project]/definitions/xxx.fp under device
group of [new project]/src/main/resources/xxx.fp .

• Widget “led2states”:

1. Rename led2states by ej.fp.widget.LED .

2. Rename the attribute id by label .

• Widget “pixelatedDisplay”:

1. Rename pixelatedDisplay by ej.fp.widget.Display .

2. Remove the attribute id .

3. (if set) Remove the attribute initialColor if its value is 0

4. (if set) Rename the attribute mask by filter ; this imagemust have the same size in pixels than display
itself ( width * height ).

5. (if set) Rename the attribute realWidth by displayWidth .

6. (if set) Rename the attribute realHeight by displayHeight .

7. (if set) Rename the attribute transparencyLevel by alpha ; change the value: newValue = 255 -
oldValue .

8. (if set) Remove the attribute residualFactor (not supported).

9. (if set) If extensionClass is specified: follow next notes.

• Widget “pixelatedDisplay”: ej.fp.widget.Display Extension Class:

1. Open the class

2. Extends ej.fp.widget.MicroUIDisplay.AbstractDisplayExtension instead of com.is2t.
microej.frontpanel.display.DisplayExtension .

3. Renamemethod convertDisplayColorToRGBColor to convertDisplayColorToARGBColor .

4. Renamemethod convertRGBColorToDisplayColor to convertARGBColorToDisplayColor .

• Widget “pointer”:

1. Rename pointer by ej.fp.widget.Pointer .

2. Remove the attribute id .

3. (if set) Rename the attribute realWidth by areaWidth .

4. (if set) Rename the attribute realHeight by areaHeight .

5. Keep or remove the attribute listenerClass according next notes.

• Widget “pointer”: ej.fp.widget.Pointer Listener Class:

This extension class is useless if the implementation respects these rules:

– (a) press method is sending a press MicroUI Pointer event.

– (b) release method is sending a release MicroUI Pointer event.

– (c ) move method is sending a move MicroUI Pointer event.
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– (d) The MicroUI Pointer event generator name is POINTER when ej.fp.widget.Pointer ’s
touch attribute is false (or not set).

– (e) The MicroUI Pointer event generator name is TOUCH when ej.fp.widget.Pointer ’s
touch attribute is true .

If only (d) or (e) is di�erent:

1. Open the listener class.

2. Extends the class ej.fp.widget.Pointer.PointerListenerToPointerEvents instead
of implementing the interface com.is2t.microej.frontpanel.input.listener.
PointerListener .

3. Implements the method getMicroUIGeneratorTag() .

In all other cases:

1. Open the listener class.

2. Implements the interface ej.fp.widget.Pointer.PointerListener instead of com.is2t.
microej.frontpanel.input.listener.PointerListener .

• Widget “push”:

1. Rename push by ej.fp.widget.Button .

2. Rename the attribute id by label .

3. (if set) Review filter image: this imagemust have the same size in pixels than the button skin .

4. (if set) Remove the attribute hotkey (not supported).

5. Keep or remove the attribute listenerClass according next notes.

• Widget “push”: ej.fp.widget.Button Listener Class:

This extension class is useless if the implementation respects these rules:

– (a) press method is sending a press MicroUI Buttons event with button label (equals to
old button id ) as button index.

– (b) release method is sending a release MicroUI Buttons eventwith button label (equals
to old button id ) as button index.

– (c ) The MicroUI Buttons event generator name is BUTTONS .

If only (c ) is di�erent:

1. Open the listener class.

2. Extends the class ej.fp.widget.Button.ButtonListenerToButtonEvents instead
of implementing the interface com.is2t.microej.frontpanel.input.listener.
ButtonListener .

3. Overrides the method getMicroUIGeneratorTag() .

In all other cases:

1. Open the listener class.

2. Implements the interface ej.fp.widget.Button.ButtonListener instead of com.is2t.
microej.frontpanel.input.listener.ButtonListener .

• Widget “repeatPush”:

1. Rename repeatPush by ej.fp.widget.RepeatButton .
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2. (if set) Remove the attribute sendPressRelease (not supported).

3. Same rules than widget push.

• Widget “longPush”:

1. Rename longPush by ej.fp.widget.LongButton .

2. Same rules than widget push.

• Widget “joystick”:

1. Rename joystick by ej.fp.widget.Joystick .

2. Remove the attribute id .

3. (if set) Rename the attribute mask by filter ; this imagemust have the same size in pixels than joystick
skin .

4. (if set) Remove the attribute hotkeys (not supported).

5. Keep or remove the attribute listenerClass according next notes.

• Widget “joystick”: ej.fp.widget.Joystick Listener Class:

This extension class is useless if the implementation respects these rules:

– (a) press methods are sending some MicroUI Command events UP , DOWN , LEFT , RIGHT
and SELECT .

– (b) repeat methods are sending same MicroUI Command events UP , DOWN , LEFT , RIGHT
and SELECT .

– (c ) release methods are sending nothing.

– (d) The MicroUI Command event generator name is JOYSTICK .

If only (d) is di�erent:

1. Open the listener class

2. Extends the class ej.fp.widget.Joystick.JoystickListenerToCommandEvents in-
stead of implementing the interface com.is2t.microej.frontpanel.input.listener.
JoystickListener .

3. Overrides the method getMicroUIGeneratorTag() .

In all other cases:

1. Open the listener class.

2. Implements the interface ej.fp.widget.Joystick.JoystickListener instead of com.
is2t.microej.frontpanel.input.listener.JoystickListener .

• Others Widgets:

These widgets may have not been migrated. Check in ej.tool.frontpanel.widget library if
some widgets are compatible or write your own widgets.

Application

• See applicationMigration Guide.
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From 10.x to 11.x

Platform Configuration Project

• Update Architecture version: 7.0.0 or higher.

From 9.x to 10.x

Platform Configuration Project

• Update Architecture version: 6.13.0 or higher.

• Edit display/display.properties

• Add property imagesHeap.size=xxx ; this value fixes the images heap size when using the platform in com-
mand line (to build a firmware)

• In platform linker file (standalone mode with MicroEJ linker): remove the image heap reserved section and
put the section .bss.microui.display.imagesHeap instead.

BSP

• In BSP linker file: remove the image heap reserved section and put the section .bss.microui.display.
imagesHeap instead

• Edit LLDISPLAY*.c : remove the functions LLDISPLAY_IMPL_getWorkingBufferStartAddress and
LLDISPLAY_IMPL_getWorkingBufferEndAddress

Application

• See applicationMigration Guide.

From 8.x to 9.x

Application

• See applicationMigration Guide.

From 7.x to 8.x

Platform Configuration Project

• Update Architecture version: 6.4.0 or higher.

• Edit display/display.properties : remove property mode=xxx
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BSP

• Edit LLDISPLAY*.c

• For LLDISPLAY SWITCH

– Remove the function LLDISPLAY_SWITCH_IMPL_getDisplayBufferAddress()

– Replace the function void LLDISPLAY_SWITCH_IMPL_getDisplayBufferAddress() by int32_t
LLDISPLAY_IMPL_flush()

– In this function, return the old LCD frame bu�er address

– Replace the function LLDISPLAY_COPY_IMPL_getBackBufferAddress() by
LLDISPLAY_IMPL_getGraphicsBufferAddress()

• For LLDISPLAY COPY

– Replace the function void LLDISPLAY_COPY_IMPL_copyBuffer() by int32_t
LLDISPLAY_IMPL_flush()

– In this function, return the back bu�er address (given in argument)

– Replace the function LLDISPLAY_COPY_IMPL_getBackBufferAddress() by
LLDISPLAY_IMPL_getGraphicsBufferAddress()

• For LLDISPLAY DIRECT

– Add the function void LLDISPLAY_IMPL_synchorize(void) (do nothing)

– Add the function int32_t LLDISPLAY_IMPL_flush()

– In this function, just return the back bu�er address (given in argument)

• Replace h file LLDISPLAY_SWITCH_IMPL.h , LLDISPLAY_COPY_IMPL.h or LLDISPLAY_DIRECT_IMPL.h by
LLDISPLAY_IMPL.h

• Replace all functions LLDISPLAY_SWITCH_IMPL_xxx , LLDISPLAY_COPY_IMPL_xxx and
LLDISPLAY_DIRECT_IMPL_xxx by LLDISPLAY_IMPL_xxx

• Remove the argument int32_t type from getWidth and getHeight

STM32 Platforms with DMA2D only

• In platform configuration project, edit display/display.properties

• Add property hardwareAccelerator=dma2d

• In BSP project, edit LLDISPLAY*.c

• simplify following functions (see STM32F7Discovery board implementation)

LLDISPLAY_EXTRA_IMPL_fillRect
LLDISPLAY_EXTRA_IMPL_drawImage
LLDISPLAY_EXTRA_IMPL_waitPreviousDrawing

• Add the following function

void LLDISPLAY_EXTRA_IMPL_error(int32_t errorCode)
{

printf("lldisplay error: %d\n", errorCode);
while(1);

}
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• Launch a MicroEJ application with images and fillrect

• Compile, link and debug the BSP

• Set some breakpoints on three functions

• Ensure the functions are called

4.14 Networking

4.14.1 Principle

MicroEJ provides some Foundation Libraries to initiate raw TCP/IP protocol-oriented communications and secure
this communication by using Secure Socket Layer (SSL) or Transport Layer Security (TLS) cryptographic protocols.

The diagram below shows a simplified view of the components involved in the provisioning of a Java network
interface.

Fig. 46: Overview

Net and SSL low level parts connects the Net and SSL libraries to the user-supplied drivers code (coded in C).

The MicroEJ Simulator provides all features of Net and SSL libraries. This one takes part of the network settings
stored in the operating system on which the Simulator will be launched.

4.14.2 Network Core Engine

Principle

TheNetmodule defines a low-level network framework for embedded devices. Thismodule allows you tomanage
connection (TCP)- or connectionless (UDP)-oriented protocols for client/server networking applications.
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Functional Description

The Net library includes two sub-protocols:

• UDP: a connectionless-oriented protocol that allows communication with the server or client side in a non-
reliable way. No handshake mechanisms, no guarantee on delivery, and no order in packet sending.

• TCP: a connection-oriented protocol that allows communication with the server or client side in a reliable
way. Handshakes mechanism used, bytes ordered, and error checking performed upon delivery.

Dependencies

• LLNET_CHANNEL_impl.h , LLNET_SOCKETCHANNEL_impl.h , LLNET_STREAMSOCKETCHANNEL_impl.h
, LLNET_DATAGRAMSOCKETCHANNEL_impl.h , LLNET_DNS_impl.h , LLNET_NETWORKADDRESS_impl.h ,
LLNET_NETWORKINTERFACE_impl.h (see LLNET: Network).

Installation

Network is an additional module. In the platform configuration file, check NET to install this module. When
checked, the properties file net/net.properties is required during platform creation to configure the module.
This configuration step is used to customize the kind of TCP/IP native stack used and the Domain Name System
(DNS) implementation.

The properties file must / can contain the following properties:

• stack [optional, default value is “custom”]: Defines the kind of TCP/IP interface used in the C project.

– custom : Select this configuration tomakea“fromscratch” implementationgluebetween theCNetwork
Core Engine and the C project TCP/IP interface.

– bsd : Select this configuration to use a BSD-like library helper to implement the glue between the CNet-
work Core Engine and the C project TCP/IP interface. This property requires that the C project provides
a TCP/IP native stack with a Berkeley Sockets API and a select mechanism.

• dns [optional, default value is “native”]: Defines the kind of Domain Name System implementation used.

– native : Select this configuration to implement the glue between the C Network Core Engine DNS part
and the C project TCP/IP interface.

– soft : Select this configuration if you want a so�ware implementation of the DNS part. Only the IPs list
of the DNS server must be provided by the C Network Core Engine glue.

Use

The Net API Module must be added to themodule.ivy of the MicroEJ Application project to use the Net library.

<dependency org="ej.api" name="net" rev="1.1.1"/>

This library provides a set of options. Refer to the chapter Application Optionswhich lists all available options.

4.14.3 SSL
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Principle

SSL (Secure Sockets Layer) library provides APIs to create and establish an encrypted connection between a server
and a client. It implements the standard SSL/TLS (Transport Layer Security) protocol thatmanages client or server
authentication and encrypted communication. Mutual authentication is supported since SSL API 2.1.0.

Functional Description

The SSL/TLS process includes two sub-protocols :

• Handshake protocol: consists that a server presents its digital certificate to the client to authenticate the
server’s identity. The authentication process uses public-key encryption to validate the digital certificate
and confirm that a server is in fact the server it claims to be.

• Record protocol: a�er the server authentication, the client and the server establish cipher settings to encrypt
the information they exchange. This provides data confidentiality and integrity.

Dependencies

• Network core module (see Network Core Engine).

• LLNET_SSL_CONTEXT_impl.h and LLNET_SSL_SOCKET_impl.h implementations (see LLNET_SSL: SSL).

Installation

SSL is an additional module. In the platform configuration file, check SSL to install the module.

Use

The SSL API module must be added to themodule.ivy of the MicroEJ Application project to use the SSL library.

<dependency org="ej.api" name="ssl" rev="2.2.0"/>

4.15 File System

4.15.1 Principle

The FSmodule defines a low-level File System framework for embedded devices. It allows you tomanage abstract
files and directories without worrying about the native underlying File System kind.

4.15.2 Functional Description

The MicroEJ Application manages File System elements using File/Directory abstraction. The FS implementation
made for each MicroEJ Platform is responsible for surfacing the native File System specific behavior.

4.15.3 Dependencies

• LLFS_impl.h and LLFS_File_impl.h implementations (see LLFS: File System).
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4.15.4 Installation

FS is an additionalmodule. In the platform configuration file, check FS to install it. When checked, the properties
file fs/fs.properties is required during platform creation in order to configure the module. This properties file
specifies the characteristics of the File System used in the C project (case sensitivity, root directory, file separator,
etc.).

The FS module defines two pre-configured File System types: Unix and FatFS . Some characteristics don’t need
to be specified for these File System types, but they can be overridden if needed. For example, specifying a Unix
File System type will automatically set the file separator to / .

If none of the pre-configured File System types correspond to the File System used in the C project, the Custom
type can be used. When this type is selected, all the File System characteristics must be specified in the properties
file.

The list below describes the properties that can be defined in the file fs/fs.properties :

• fs : Defines the type of File System used in the C project (optional, the default value is Unix ). This property
can have one of the following values:

– Unix : select this configuration when using a Unix-like File System (case-sensitive, file separator is / ).

– FatFS : select this configuration when using FatFS File System (case-insensitive, file separator is / ).

– Custom : select this configuration when using another type of File System.

• root.dir : Defines the File System root volume. This property is optional for Unix and FatFS ( / by default
for both).

• user.dir : Defines the File System user directory. This property is optional for FatFS ( /usr/ by default).

• java.io.tmpdir : Defines the File System temporary directory. This property is optional for Unix and FatFS
( /tmp/ by default for both).

• file.separator : Defines the File System file separator. This property is optional for Unix and FatFS ( /
by default for both).

• path.separator : Defines the File System path separator. This property is optional for Unix and FatFS ( :
by default for both).

• case.sensitivity : Defines the case sensitivity of the File System. This property is optional for Unix (
caseSensitive by default) and FatFS ( caseInsensitive by default). This property can have one of the
following values:

– caseSensitive : the File System is case-sensitive.

– caseInsensitive : the File System is case-insensitive.

Properties File Template

The following snippet can be used as a template for fs.properties file:

# Defines the type of File System used in the C project.
# Possible values are:
# - FatFs
# - Unix
# - Custom
# @optional, default value is "Unix"
#fs=

(continues on next page)
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(continued from previous page)

# Defines the File System root volume.
# @optional for the following File System types:
# - FatFs (default value is "/")
# - Unix (default value is "/")
# @mandatory for the following File System type:
# - Custom
#root.dir=

# Defines the File System user directory.
# @optional for the following File System type:
# - FatFs (default value is "/usr")
# @mandatory for the following File System types:
# - Unix
# - Custom
#user.dir=

# Defines the File System temporary directory.
# @optional for the following File System types:
# - FatFs (default value is "/tmp")
# - Unix (default value is "/tmp")
# @mandatory for the following File System type:
# - Custom
#java.io.tmpdir=

# Defines the File System file separator.
# @optional for the following File System types:
# - FatFs (default value is "/")
# - Unix (default value is "/")
# @mandatory for the following File System type:
# - Custom
#file.separator=

# Defines the File System path separator.
# @optional for the following File System types:
# - FatFs (default value is ":")
# - Unix (default value is ":")
# @mandatory for the following File System type:
# - Custom
#path.separator=

# Defines the case sensitivity of the File System.
# Valid values are "caseInsensitive" and "caseSensitive".
# @optional for the following File System types:
# - FatFs (default value is "caseInsensitive")
# - Unix (default value is "caseSensitive")
# @mandatory for the following File System type:
# - Custom
#case.sensitivity=

4.15.5 Use

The FS API Module must be added to themodule.ivy of the MicroEJ Application project to use the FS library.

<dependency org="ej.api" name="fs" rev="2.0.6"/>
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4.16 Hardware Abstraction Layer

4.16.1 Principle

The Hardware Abstraction Layer (HAL) library features API that target IO devices, such as GPIOs, analog to/from
digital converters (ADC / DAC), etc. The API are very basic in order to be as similar as possible to the BSP drivers.

4.16.2 Functional Description

The MicroEJ Application configures and uses some physical GPIOs, using one unique identifier per GPIO. The HAL
implementationmade for each MicroEJ Platform has the responsibility of verifying the veracity of the GPIO identi-
fier and the valid GPIO configuration.

Theoretically, a GPIO can be reconfigured at any time. For example a GPIO is configured in OUTPUT first, and later
in ADC entry. However the HAL implementation can forbid the MicroEJ Application from performing this kind of
operation.

4.16.3 Identifier

Basic Rule

MicroEJ Application manipulates anonymous identifiers used to identify a specific GPIO (port and pin). The iden-
tifiers are fixed by the HAL implementationmade for each MicroEJ Platform, and so this implementation is able to
make the link between the MicroEJ Application identifiers and the physical GPIOs.

• A port is a value between 0 and n - 1 , where n is the available number of ports.

• A pin is a value between 0 and m - 1 , where m is the maximum number of pins per port.

Generic Rules

Most of time the basic implementationmakes the link between the port / pin and the physical GPIO following these
rules:

• The port 0 targets all MCU pins. The first pin of the first MCU port has the ID 0 , the second pin has 1 ; the
first pin of the next MCUport has the ID m (where m is themaximumnumber of pins per port), etc. Examples:

/* m = 16 (16 pins max per MCU port) */
mcu_pin = application_pin & 0xf;
mcu_port = (application_pin >> 4) + 1;

/* m = 32 (32 pins max per MCU port) */
mcu_pin = application_pin & 0x1f;
mcu_port = (application_pin >> 5) + 1;

• The port from 1 to n (where n is the available number of MCU ports) targets the MCU ports. The first MCU
port has the ID 1 , the second has the ID 2 , and the last port has the ID n .

• The pin from 0 to m - 1 (where m is the maximum number of pins per port) targets the port pins. The first
port pin has the ID 0 , the second has the ID 1 , and the last pin has the ID m - 1 .

The implementation can also normalize virtual and physical board connectors. A physical connector is a connector
available on the board, and which groups several GPIOs. The physical connector is usually called JPn or CNn ,
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where n is the connector ID. A virtual connector represents one or several physical connectors, and has a name;
for example ARDUINO_DIGITAL .

Using a unique ID to target a virtual connector allows you tomake an abstraction between theMicroEJ Application
and the HAL implementation. For exmaple, on a board A, the pin D5 of ARDUINO_DIGITAL port will be connected
to the MCU portA , pin12 (GPIO ID = 1 , 12 ). And on board B, it will be connected to the MCU port5 , pin0 (GPIO
ID = 5 , 0 ). From the MicroEJ Application point of view, this GPIO has the ID 30 , 5 .

Standard virtual connector IDs are:

ARDUINO_DIGITAL = 30;
ARDUINO_ANALOG = 31;

Finally, the available physical connectors can have a number from 64 to 64 + i - 1 , where i is the available
numberof connectors on theboard. This allows theapplication toeasily target aGPIO that is availableonaphysical
connector, without knowing the corresponding MCU port and pin.

JP3 = 64;
JP6 = 65;
JP11 = 66;

4.16.4 Configuration

A GPIO can be configured in any of five modes:

• Digital input: The MicroEJ Application can read the GPIO state (for example a button state).

• Digital inputpull-up: TheMicroEJApplicationcan read theGPIOstate (for exampleabutton state); thedefault
GPIO state is driven by a pull-up resistor.

• Digital output: The MicroEJ Application can set the GPIO state (for example to drive an LED).

• Analog input: The MicroEJ Application can convert some incoming analog data into digital data (ADC). The
returned values are values between 0 and n - 1 , where n is the ADC precision.

• Analog output: The MicroEJ Application can convert some outgoing digital data into analog data (DAC). The
digital value is a percentage (0 to 100%) of the duty cycle generated on selected GPIO.

4.16.5 Dependencies

• LLHAL_impl.h implementation (see LLHAL: Hardware Abstraction Layer).

4.16.6 Installation

HAL is an additional module. In the platform configuration file, check HAL to install the module.

4.16.7 Use

The HAL API Module must be added to themodule.ivy of the MicroEJ Application project to use the ECOM library.

<dependency org="ej.api" name="hal" rev="1.0.4"/>
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4.17 Device Information

4.17.1 Principle

The Device library provides access to the device information. This includes the architecture name and a unique
identifier of the device for this architecture.

4.17.2 Dependencies

• LLDEVICE_impl.h implementation (see LLDEVICE: Device Information).

4.17.3 Installation

Device Information is an additional module. In the platform configuration file, check Device Information to in-
stall it. When checked, the property file device/device.properties may be defined during platform creation to
customize the module.

The properties file must / can contain the following properties:

• architecture [optional, default value is “Virtual Device”]: Defines the value returned by the ej.util.
Device.getArchitecture() method on the Simulator.

• id.length [optional]: Defines the size of the ID returned by the ej.util.Device.getId() method on the
Simulator.

4.17.4 Use

TheDevice APIModulemust be added to themodule.ivy of theMicroEJApplicationproject to use theDevice library.

<dependency org="ej.api" name="device" rev="1.0.2"/>

4.18 Watchdog Timer

4.18.1 Overview

The WatchdogTimer foundation library provides a way to handle platform watchdog timer. A watchdog is partic-
ularly useful if you want to monitor di�erent items of your so�ware system during the runtime. The figure below
shows watchdog elements at each level of a MicroEJ project:
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4.18.2 Principle

The Watchdog Timer API is in two parts, the first part drives thewatchdog timer itself. The second part of the API
implements a checkpoint registration system linked to the watchdog timer.

The checkpoint registration systemallows the user to add checkpointsmonitored by the platformwatchdog timer.
Each checkpoint registered by the Watchdog Timer API must attest their activity before the watchdog timeout,
otherwise a hardware reset is performed. The high level diagram below summarizes interactions between the
user application, the Watchdog Timer API and the Watchdog timer.
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The particularity of this library is that it can be either used in Java, in C inside the BSP or even both of them. The
use of this library in the BSP in C is relevant when the user needs to monitor an item of the so�ware system which
is outside of the MicroEJ Virtual Machine. The sequence diagram below shows a standard use of the Watchdog API
in Java and in C.
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4.18.3 Mock Implementation

When you run your Java application on the simulator, the watchdog timer must be emulated. To do so, a Java
Timer Task is used which emulates the watchdog timer.

The Mock implementation does not perform a hardware reset when the false watchdog timer triggers.

4.18.4 Dependencies

• This library needs tobeusedwith theWatchdogTimerGeneric C implementationdeveloped for this purpose,
its module name is watchdog-timer-generic .

• LLWATCHDOG_TIMER_impl.h implemented by the Watchdog Timer C implementation (see LLWATCH-
DOG_TIMER: Watchdog Timer).

• watchdog_timer_helper.h implementation needed by the Watchdog Timer C implementation (see LL-
WATCHDOG_TIMER: Watchdog Timer).

4.18.5 Installation

Watchdog Timer is an API composed of a Pack module and a C componentmodule. You need both of them in your
platform to install the API.

In the platform configuration project, the one with -configuration extension, add the dependency to the two
required modules in the file module.ivy :
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<dependency org="com.microej.pack.watchdog-timer" name="watchdog-timer-pack" rev="2.0.1" />
<dependency org="com.microej.clibrary.llimpl" name="watchdog-timer-generic" rev="3.0.1"/>

The Platformmust be rebuilt (Platform Build).

Then, you have to implement functions that match the LLWATCHDOG_TIMER_IMPL_*_action pattern which is re-
quired by the Watchdog C implementation.

4.18.6 Use in a Java application

The WatchdogTimer API Module must be added to the module.ivy of the MicroEJ Application project in order to
allow access to the Watchdog library.

<dependency org="ej.api" name="watchdog-timer" rev="2.0.0"/>

4.18.7 Code example in Java

Here is an example that summarizes all features in a simple use case. The checkpoint is performed in a TimerTask
scheduled to run every 5 seconds. To use TimerTask in your Java application, add the following dependency:

<dependency org="ej.api" name="bon" rev="1.4.0" />

Then, you can use this example code:

// Test a simple watchdog timer use case
public static void main(String[] args) {

if (WatchdogTimer.isResetCause()) {
System.out.println("Watchdog timer triggered the last board reset!"); //$NON-NLS-1$

} else {
System.out.println("Watchdog timer DID NOT triggered the last board reset!"); //$NON-

→˓NLS-1$
}

WatchdogTimer.init();
System.out.println("Watchdog timer initialized to trigger after " + WatchdogTimer.

→˓getWatchdogTimeoutMs() + " ms."); //$NON-NLS-1$

TimerTask checkpointTask = new TimerTask() {

private final int checkpointId = WatchdogTimer.registerCheckpoint();

@Override
public void run() {

// We attest our task activity using the checkpoint method.
// Since this is our only checkpoint registered, the watchdog timer is␣

→˓refreshed.
WatchdogTimer.checkpoint(this.checkpointId);
System.out.println("Task performed watchdog checkpoint with the ID " + this.

→˓checkpointId); //$NON-NLS-1$
}

};

// We schedule our task to be executed every 5 seconds.

(continues on next page)
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(continued from previous page)

Timer timer = new Timer();
final int DELAY = 0;
final int PERIOD = 5000; // We assume that the watchdog timeout period is higher than 5000␣

→˓milliseconds.
timer.schedule(checkpointTask, DELAY, PERIOD);

// Everything is ready, we launch the watchdog
WatchdogTimer.start();
System.out.println("Watchdog started!");

// Let the checkpointTask runs for a minute.

final int WAIT_A_MINUTE = 60000; // 60 000 milliseconds to wait a minute
try {

Thread.sleep(WAIT_A_MINUTE);
} catch (InterruptedException e) {

// TODO Auto-generated catch block
e.printStackTrace();

}

// Our program is finished. Now we stop the checkpointTask and the watchdog.
timer.cancel();
WatchdogTimer.stop(); // This method also unregisters all checkpoints.
System.out.println("Monitored task stopped and Watchdog timer stopped.");

}

4.18.8 Use in C inside the BSP

Once the platform is configured to use theWatchdog Timer API as explained in Installation section, you can use
functions defined in LLWATCHDOG_TIMER_impl.h .

Note that compared to the Java API, you have to get error codes returned by functions to check if the function is
executed correctly since you have no access to exceptions generated for the Java.

TheWatchdog Timer Low Level API provides a set of functionswith the same usage as in Java. Here is the list of the
watchdog Low Level API functions:

LLWATCHDOG_TIMER_IMPL_init() // refer to ej.hal.WatchdogTimer.init()
LLWATCHDOG_TIMER_IMPL_start() // refer to ej.hal.WatchdogTimer.start()
LLWATCHDOG_TIMER_IMPL_stop() // refer to ej.hal.WatchdogTimer.stop()
LLWATCHDOG_TIMER_IMPL_registerCheckpoint() // refer to ej.hal.WatchdogTimer.registerCheckpoint()
LLWATCHDOG_TIMER_IMPL_unregisterCheckpoint() // refer to ej.hal.WatchdogTimer.
→˓unregisterCheckpoint()
LLWATCHDOG_TIMER_IMPL_checkpoint() // refer to ej.hal.WatchdogTimer.checkpoint()
LLWATCHDOG_TIMER_IMPL_isResetCause() // refer to ej.hal.WatchdogTimer.isResetCause()
LLWATCHDOG_TIMER_IMPL_getWatchdogTimeoutMs() // refer to ej.hal.WatchdogTimer.
→˓getWatchdogTimeoutMs()

There is an additional function in LLWATCHDOG_TIMER_impl.h compared to the Java API. This is
LLWATCHDOG_TIMER_IMPL_refresh , because a low level implementation of this function is required for the
library. However, the user does not need and should not use this function on his own.
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4.18.9 Code example in C

Here is an example that summarizesmain features in a simple use case. The checkpoint is performed in a FreeRTOS
task scheduled to attest its activity to the watchdog every 5 seconds.

#include <stdio.h>
#include <stdint.h>

#include "FreeRTOS.h"
#include "task.h"
#include "queue.h"
#include "semphr.h"

#include "LLWATCHDOG_TIMER_impl.h"

#define MONITORED_TASK_STACK_SIZE 1024
#define TASK_SLEEP_TIME_MS 5000 // We sleep for 5 seconds, assuming that the watchdog timeout is higher.

/*-----------------------------------------------------------*/

static void my_monitored_task( void *pvParameters ){
// We get an ID from watchdog registration system for this new checkpoint
int32_t checkpoint_id = LLWATCHDOG_TIMER_IMPL_registerCheckpoint();

for(;;){
vTaskDelay( TASK_SLEEP_TIME_MS / portTICK_PERIOD_MS);
// Since this is our only checkpoint registered, the watchdog timer is refreshed.
LLWATCHDOG_TIMER_IMPL_checkpoint(checkpoint_id);
printf("MonitoredTask with ID = %d did watchdog checkpoint!\n", checkpoint_id);

}
}

/*-----------------------------------------------------------*/

int main( void ){
xTaskHandle handle_monitored_task;

/* Check if last reset was done by the Watchdog timer. */
if(LLWATCHDOG_TIMER_IMPL_isResetCause()){

printf("Watchdog timer triggered the last reset, we stop the program now! \n");
return -1;

}

/* Setup the Watchdog Timer*/
if(WATCHDOG_TIMER_ERROR == LLWATCHDOG_TIMER_IMPL_init()){

printf("Failed to init watchdog timer in main. \n");
} else{

printf("Watchdog timer initialized to trigger after %d ms \n", LLWATCHDOG_TIMER_IMPL_
→˓getWatchdogTimeoutMs());

}

/* Start the Watchdog Timer*/
if(WATCHDOG_TIMER_ERROR == LLWATCHDOG_TIMER_IMPL_start()){

printf("Failed to start watchdog timer in main. \n");
} else{

printf("Watchdog started!\n");
}

(continues on next page)
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(continued from previous page)

/* Create the monitored task. */
xTaskCreate( my_monitored_task, "MonitoredTask", MONITORED_TASK_STACK_SIZE, NULL, tskIDLE_

→˓PRIORITY, &handle_monitored_task);

/* Start the scheduler. */
printf("Starting scheduler...\n");
vTaskStartScheduler();

return 0;
}

4.19 SystemView

4.19.1 Principle

SystemView is a real-time recording and visualization tool for embedded systems that reveals the true runtime
behavior of an application, going far deeper than the system insights provided by debuggers. This is particularly
e�ective when developing and working with complex embedded systems comprising multiple threads and inter-
rupts: SystemView can ensure a systemperforms as designed, can track down ine�iciencies, and showunintended
interactions and resource conflicts, with a focus on the details of every single system tick.

A specific SystemView extension made by MicroEJ allows to traces the OS tasks and the MicroEJ Java threads at
the same time. This chapter explains how to add SystemView feature in a platform and how to setup it.

A SystemView support is provided to use the so�ware with a MicroEJ system. This documentation shows how to
setup your BSP and your Java application.

Note: SystemView support for MicroEJ is compatible with FreeRTOS 9 and FreeRTOS 10.

Note: This SystemView section has been written for SystemView version V2.52a. Later versions may or may not
work, andmay needmodification to the following steps.

4.19.2 References

• https://www.segger.com/products/development-tools/systemview/

• https://www.segger.com/downloads/jlink/UM08027

4.19.3 Installation

SystemView consists on installing several items in the BSP. The following steps describe them and must be per-
formed in the right order. If SystemView support is already available in the BSP, apply only modifications made by
MicroEJ on SystemView files and SystemView for FreeRTOS files to enable MicroEJ Java threads monitoring.

1. Download and install SystemView V2.52a: http://segger.com/downloads/systemview/.

2. Apply SystemView for FreeRTOSpatch asdescribed indocumentation (https://www.segger.com/downloads/
jlink/UM08027); patch is available in installation folder SEGGER\SystemView\Src\Sample\FreeRTOSVxx .
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Note: If you are using FreeRTOS V10.2.0, use the patch located here: https://forum.segger.com/index.php/Thread/
6158-SOLVED-SystemView-Kernelpatch-for-FreeRTOS-10-2-0/?s=add3b0f6a33159b9c4b602da0082475afeceb89a

3. Check if the patch disabled SystemView systick events in port.c , if not remove these lines manually:

4. Add SEGGER\SystemView\Src\Sample\FreeRTOSVxx\Config\SEGGER_SYSVIEW_Config_FreeRTOS.c in
your BSP.

This file can bemodified to fit with your system configuration:

• Update SYSVIEW_APP_NAME , SYSVIEW_DEVICE_NAME and SYSVIEW_RAM_BASE defines to fit your system
information.

• To add MicroEJ Java threads management in SystemView tasks initialization:

– Add these includes #include "LLMJVM_MONITOR_SYSVIEW.h" and #include
"LLTRACE_SYSVIEW_configuration.h" .

– In function _cbSendSystemDesc(void) , add this instruction:
SEGGER_SYSVIEW_SendSysDesc("N="SYSVIEW_APP_NAME",D="SYSVIEW_DEVICE_NAME",
O=FreeRTOS"); before SEGGER_SYSVIEW_SendSysDesc("I#15=SysTick"); .

– Replace the Global function section by this code:
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/*********************************************************************
*
* Global functions
*
**********************************************************************
*/

SEGGER_SYSVIEW_OS_API SYSVIEW_MICROEJ_X_OS_TraceAPI;

static void SYSVIEW_MICROEJ_X_OS_SendTaskList(void){
SYSVIEW_X_OS_TraceAPI.pfSendTaskList();
LLMJVM_MONITOR_SYSTEMVIEW_send_task_list();

}

void SEGGER_SYSVIEW_Conf(void) {
SYSVIEW_MICROEJ_X_OS_TraceAPI.pfGetTime = SYSVIEW_X_OS_TraceAPI.pfGetTime;
SYSVIEW_MICROEJ_X_OS_TraceAPI.pfSendTaskList = SYSVIEW_MICROEJ_X_OS_SendTaskList;

SEGGER_SYSVIEW_Init(SYSVIEW_TIMESTAMP_FREQ, SYSVIEW_CPU_FREQ,
&SYSVIEW_MICROEJ_X_OS_TraceAPI, _cbSendSystemDesc);

SEGGER_SYSVIEW_SetRAMBase(SYSVIEW_RAM_BASE);
}

5. Add in your BSP the MicroEJ Cmodule files for SystemView: com.microej.clibrary.thirdparty#systemview (or
check the di�erences between pre-installed SystemView and C files provided by this module)

6. Add in your BSP the MicroEJ C module files for SystemView FreeRTOS support (or check the di�erences be-
tween pre-installed SystemView and C files provided by this module)

• FreeRTOS 10: com.microej.clibrary.thirdparty#systemview-freertos10

• FreeRTOS 9: please contact our support team to get the latest maintenance version of com.microej.
clibrary.thirdparty#systemview-freertos9 module.

7. Install the Abstraction Layer implementation of the Java Trace API for SystemView by adding C module files
in your BSP: com.microej.clibrary.llimpl#trace-systemview

8. Make FreeRTOS compatible with SystemView: open FreeRTOSConfig.h and:

• add #define INCLUDE_xTaskGetIdleTaskHandle 1

• add #define INCLUDE_pxTaskGetStackStart 1

• add #define INCLUDE_uxTaskPriorityGet 1

• comment the line #define traceTASK_SWITCHED_OUT() if defined

• comment the line #define traceTASK_SWITCHED_IN() if defined

• add #include "SEGGER_SYSVIEW_FreeRTOS.h" at the end of file

9. Enable SystemView on startup (before creating first OS task): call SEGGER_SYSVIEW_Conf(); . Include re-
quired #include "SEGGER_SYSVIEW.h" .

10. Print the RTT block address to the serial port on startup: printf("SEGGER_RTT block address: %p\n",
&(_SEGGER_RTT)); . Include required #include "SEGGER_RTT.h" .

Note: This is useful if SystemViewdoes not find automatically theRTTblock address. See sectionRTTControl Block
Not Found for more details.
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Note: Youmay also find the RTT block address in RAM by searching _SEGGER_RTT in the .map file generated with
the firmware binary.

11. Add a call to SEGGER_SYSVIEW_setMicroJVMTask((U32)pvCreatedTask); just a�er creating the OS task to
register the MicroEJ Core Engine OS task. The handler to give is the one filled by xTaskCreate function.

12. Copy the file /YourPlatformProject-bsp/projects/microej/trace/systemview/SYSVIEW_MicroEJ.txt
to the SystemView install path such as: SEGGER/SystemView_V252a/Description/ . If you use MicroUI
traces, you can also copy the file in section Debug Traces

4.19.4 MicroEJ Core Engine OS Task

The MicroEJ Core Engine task is the OS task that executes MicroEJ Java threads. Once it is started (by calling
SNI_startVM ) it executes initialization code and rapidly starts to execute the MicroEJ Application main thread.
At that time, the events produced by this OS task (context switch, semaphores, etc.) are dispatched to the current
MicroEJ Java thread. By consequence, this OS task is useless when the MicroEJ Application is running.

SystemView for MicroEJ disables the visibility of this OS task when the MicroEJ Application is running. It simplifies
the SystemView client debugging.

4.19.5 OS Tasks and Java Threads Names

Tomake a distinction between the OS tasks and MicroEJ Java threads, a prefix is added to OS tasks names ( [OS] )
and Java threads names ( [MEJ] ).
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Fig. 47: OS Tasks and Java Threads Names

Note: SystemView limits the number of characters to 32. The prefix length is included in these 32 characters and
by consequence the end of the original OS task or Java thread name can be cropped.

4.19.6 OS Tasks and Java Threads Priorities

SystemView lists the OS tasks and Java threads according their priorities. However the priority notion has not the
same signification when talking about OS tasks or Java threads: a Java thread priority depends on the MicroEJ
Core Engine OS task priority.

By consequence, a Java thread with the priority 5 may not appear between an OS task with the priority 4 and
other OS task with priority 6 :

• if the MicroEJ Core Engine OS task priority is 3 , the Java threadmust appear below an OS task with priority
4 .

• if the MicroEJ Core Engine OS task priority is 7 , the Java threadmust appear above an OS task with priority
6 .
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To keep a consistent line ordering in SystemView, the priorities sent to SystemView client respect the following
rules:

• OS task: priority_sent = task_priority * 100 .

• MicroEJ Java thread: priority_sent = MicroJvm_task_priority * 100 + thread_priority .

4.19.7 Use

MicroEJ Architecture can generate specific events that allowmonitoring current Java thread executed, Java excep-
tions, Java allocations, . . . as well as custom application events. Please refer to Event Tracing section.

To enable events recording, refer to section Event Recording to configure required Application Options.

4.19.8 Troubleshooting

SystemView doesn’t see any activity in MicroEJ Tasks

You have to enable runtime traces of your Java application.

• In Run > Run configuration select your Java application launcher.

• Then, go to Configuration tab > Runtime > Trace .

• Finally, check checkboxes Enable execution traces and Start execution traces automatically as shown
in the picture below.

• Rebuild your firmware with the new Java application version and it should fix the issue.
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Youmay only check the first checkbox when you knowwhen you want to start the trace recording. For more infor-
mation, please refer to section Event Recording to configure required Application Options.

OVERFLOW Events in SystemView

Depending on the application, OVERFLOW events can be seen in System View. To mitigate this prob-
lem, the default SEGGER_SYSVIEW_RTT_BUFFER_SIZE can be increased from the default 1kB to a more
appropriate size of 4kB. Still, if OVERFLOW events are still visible, the user can further increase this
configuration found in /YourPlatformProject-bsp/projects/microej/thirdparty/systemview/inc/
SEGGER_SYSVIEW_configuration.h .
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RTT Control Block Not Found

• Get RTT block address from standard output by resetting the board (it’s printed at the beginning of the
firmware program),

• In SystemView, select Target > Start recording ,

• In RTT Control Block Detection , select Address and put the address retrieved. You can also try with
Search Range option.

4.19.9 RTT block found by SystemView but no traces displayed

• Be sure that your MCU is running. It may happen that the BSP uses semi-hosting traces that block the MCU
execution if the application is running out of a Debug session.

• You can check the state of theMCUusing J-Link tools such as J-Link Commander and Ozone to start a Debug
session.

4.19.10 Bus hardfault when running SystemViewwithout Java Virtual Machine (JVM)

The function LLMJVM_MONITOR_SYSTEMVIEW_send_task_list(); triggers a Bus Hardfault when no JVM is
launched. To solve this issue, comment this function call in SEGGER_SYSVIEW_Config_FreeRTOS.c when you run
SystemView without launching the JVM.

4.19.11 SystemView for STM32 ST-Link Probe

SystemView so�ware requires a J-Link probe. If your target board uses a ST-Link probe, it is possible to re-flash
the ST-LINK on board with a J-Link firmware. See instructions provided by SEGGER Microcontroller https://www.
segger.com/products/debug-probes/j-link/models/other-j-links/st-link-on-board/ for more details.

If you cannot flash a firmware for a STM32 device a�er replacing back J-Link firmware by ST-Link original one:

• Use ST_Link utility program to update the ST_Link firmware, go to ST-LINK > Firmware update .

• Then, try to flash again.
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4.20 Simulation

4.20.1 Principle

The MicroEJ Platform provides an accurate MicroEJ Simulator that runs on workstations. Applications execute in
an almost identical manner on both the workstation and on target devices. The MicroEJ Simulator features IO
simulation, JDWP debug coupled with Eclipse, accurate Java heap dump, and an accurate Java scheduling policy
(the same as the embedded one).1

4.20.2 Functional Description

In order to simulate external stimuli that come from the nativeworld (that is, “the Cworld”), theMicroEJ Simulator
has a Hardware In the Loop interface, HIL, which performs the simulation of Java-to-C calls. All Java-to-C calls are
rerouted to an HIL engine. Indeed HIL is a replacement for the [SNI] interface.

1 Only the execution speed is not accurate. The Simulator speed can be set to match the average MicroEJ Platform speed in order to adapt
the Simulator speed to the desktop speed.

4.20. Simulation 497



MicroEJ Documentation, Revision 2788b3f4

Fig. 48: The HIL Connects the MicroEJ Simulator to the Workstation.

The “simulated C world” is made of Mocks that simulate native code (such as drivers and any other kind of C li-
braries), so that the MicroEJ Application can behave the same as the device using the MicroEJ Platform.

The MicroEJ Simulator and the HIL are two processes that run in parallel: the communication between them is
through a socket connection. Mocks run inside the process that runs the HIL engine.

Fig. 49: A MicroEJ Simulator connected to its HIL Engine via a socket.

4.20.3 Dependencies

No dependency.

4.20.4 Installation

The Simulator is a built-in feature of MicroEJ Platform architecture.

4.20.5 Use

To run an application in the Simulator, create a MicroEJ launch configuration by right-clicking on themain class of
the application, and selecting Run As > MicroEJ Application .
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This will create a launch configuration configured for the Simulator, and will run it.

4.20.6 Mock

Principle

The HIL engine is a Java standard-based engine that runs Mocks. A Mock is a jar file containing some Java classes
that simulate natives for the Simulator. Mocks allow applications to be run unchanged in the Simulator while still
(apparently) interacting with native code.

Functional Description

As with [SNI], HIL is responsible for finding the method to execute as a replacement for the native Java method
that the MicroEJ Simulator tries to run. Following the [SNI] philosophy, the matching algorithm uses a naming
convention. When a native method is called in the MicroEJ Simulator, it requests that the HIL engine execute it.
The corresponding Mock executes the method and provides the result back to the MicroEJ Simulator.

Fig. 50: The MicroEJ Simulator Executes a Native Java Method foo() .

Example

package example;

import java.io.IOException;

/**
* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.
*/
public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {
int sensorID = getSensorID();
int value = getSensorValue(sensorID);
if (value == ERROR) {

(continues on next page)
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(continued from previous page)

throw new IOException("Unsupported sensor");
}
return value;

}

protected abstract int getSensorID();

public static native int getSensorValue(int sensorID);
}

class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final

}
}

To implement the nativemethod getSensorValue(int sensorID) , you need to create aMicroEJ standard project
containing the same Sensor class on the same example package. To do so, open the Eclipsemenu File > New
> Project. . . > Java > Java Project in order to create a MicroEJ standard project.

The following code is the required Sensor class of the created Mock project:

package example;

import java.util.Random;

/**
* Java standard class included in a Mock jar file.
* It implements the native method using a Java method.
*/
public class Sensor {

/**
* Constants
*/
private static final int SENSOR_ERROR = -1;
private static final int POTENTIOMETER_ID = 3;

private static final Random RANDOM = new Random();

/**
* Implementation of native method "getSensorValue()"
*
* @param sensorID Sensor ID
* @return Simulated sensor value
*/
public static int getSensorValue(int sensorID) {

if( sensorID == POTENTIOMETER_ID ) {
// For the simulation, Mock returns a random value
return RANDOM.nextInt();

}
return SENSOR_ERROR;

}

}
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Note: The visibility of the native method implemented in the mock must be public regardless of the vis-
ibility of the native method in the application. Otherwise the following exception is raised: java.lang.
UnsatisfiedLinkError: No such method in remote class .

Mocks Design Support

Interface

TheMicroEJ Simulator interface is defined by static methods on the Java class com.is2t.hil.NativeInterface .

Array Type Arguments

Both [SNI] and HIL allow arguments that are arrays of base types. By default the contents of an array are NOT sent
over to theMock. An “empty copy” is sent by theHIL engine, and the contents of the arraymust be explicitly fetched
by the Mock. The array within the Mock can be modified using a regular assignment. Then to apply these changes
in the MicroEJ Simulator, the modifications must be flushed back. There are two methods provided to support
fetch and flush between the MicroEJ Simulator and the HIL:

• refreshContent : initializes the array argument from the contents of its MicroEJ Simulator counterpart.

• flushContent : propagates (to the MicroEJ Simulator) the contents of the array that is used within the HIL
engine.

Fig. 51: An Array and Its Counterpart in the HIL Engine.

Below is a typical usage.

public static void foo(char[] chars, int offset, int length){
NativeInterface ni = HIL.getInstance();
//inside the Mock
ni.refreshContent(chars, offset, length);
chars[offset] = 'A';
ni.flushContent(chars, offset, 1);

}

Blocking Native Methods

Some native methods block until an event has arrived [SNI]. Such behavior is implemented in native using the
following three functions:
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• int32_t SNI_suspendCurrentJavaThread(int64_t timeout)

• int32_t SNI_getCurrentJavaThreadID(void)

• int32_t SNI_resumeJavaThread(int32_t id)

This behavior is implemented in a Mock using the following methods on a lock object:

• Object.wait(long timeout) : Causes the current thread towait until another thread invokes the notify()
method or the notifyAll() method for this object.

• Object.notifyAll() : Wakes up all the threads that are waiting on this object’s monitor.

• NativeInterface.notifySuspendStart() : Notifies the Simulator that the current native is suspended so
it can schedule a thread with a lower priority.

• NativeInterface.notifySuspendEnd() : Notifies the Simulator that the current native is no more sus-
pended. Lower priority threads in the Simulator will not be scheduled anymore.

public static byte[] data = new byte[BUFFER_SIZE];
public static int dataLength = 0;
private static Object lock = new Object();

// Mock native method
public static void waitForData() {

NativeInterface ni = HIL.getInstance();
// inside the Mock
// wait until the data is received
synchronized (lock) {

while (dataLength == 0) {
try {

ni.notifySuspendStart();
lock.wait(); // equivalent to lock.wait(0)

} catch (InterruptedException e) {
// Use the error code specific to your library
throw new NativeException(-1, "InterruptedException", e);

} finally {
ni.notifySuspendEnd();

}
}

}
}

// Mock data reader thread
public static void notifyDataReception() {

synchronized (lock) {
dataLength = readFromInputStream(data);
lock.notifyAll();

}
}

Resource Management

In Java, every class canplay the roleof a small read-only file systemroot: The stored files are called “Java resources”
and are accessible using a path as a String.

The MicroEJ Simulator interface allows the retrieval of any resource from the original Java world, using the
getResourceContent method.
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public static void bar(byte[] path, int offset, int length) {
NativeInterface ni = HIL.getInstance();
ni.refreshContent(path, offset, length);
String pathStr = new String(path, offset, length);
byte[] data = ni.getResourceContent(pathStr);
...

}

Synchronous Terminations

To terminate the whole simulation (MicroEJ Simulator and HIL), use the stop() method.

public static void windowClosed() {
HIL.getInstance().stop();

}

Dependencies

The HIL Engine API is automatically provided by the microej-mock project skeleton.

Installation

First create a newmodule project using the microej-mock skeleton.

Once implemented, right-click on the repository project and select Build Module .

Once the module is built, the mock can be installed in a Platform in one of the two ways:

• by adding themockmodule as a regular Platformmodule dependency (if your Platform configuration project
contains a module.ivy file),

• or by manually copying the JAR file [mock_project]\target~\rip\mocks\[mock_name].jar to the Plat-
form configurationmock dropins folder dropins/mocks/dropins/ .

Use

Once installed, a Mock is used automatically by the Simulator when the MicroEJ Application calls a native method
which is implemented into the Mock.
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4.20.7 Shielded Plug Mock

General Architecture

The Shielded Plug Mock simulates a Shielded Plug [SP] on desktop computer. This mock can be accessed from the
MicroEJ Simulator, the hardware platform or a Java J2SE application.

Fig. 52: Shielded Plug Mock General Architecture

Configuration

Themock socket port can be customized for J2SE clients, even though several Shielded Plugmocks with the same
socket port cannot run at the same time. The default socket port is 10082.

The Shielded Plug mock is a standard MicroEJ Application. It can be configured using Java properties:

• sp.connection.address

• sp.connection.port

4.20.8 Front Panel Mock

Principle

Amajor strengthof theMicroEJ environment is that it allowsapplications tobedevelopedand tested in aSimulator
rather than on the target device, which might not yet be built. To make this possible for devices that controls
operated by the user, the Simulatormust connect to a “mock” of the control panel (the “Front Panel”) of the device.
The Front Panel generates a graphical representation of the device, and is displayed in a window on the user’s
development machine when the application is executed in the Simulator.

The Front Panel has been designed to be an implementation of MicroUI library (see Simulation). However it can be
use to show a hardware device, blink a LED, interact with user without using MicroUI library.
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Functional Description

1. Creates a new Front Panel project.

2. Creates an image of the required Front Panel. This could be a photograph or a drawing.

3. Defines the contents and layout of the Front Panel by editing an XML file (called an fp file). Full details about
the structure and contents of fp files can be found in chapter Front Panel.

4. Creates images to animate the operation of the controls (for example button down image).

5. CreatesWidgets that make the link between the application and the user interactions.

6. Previews the Front Panel to check the layout of controls and the events they create, etc.

7. Exports the Front Panel project into a MicroEJ Platform project.

The Front Panel Project

Creating a Front Panel Project

A Front Panel project is created using the New Front Panel Project wizard. Select:

New > Project. . . > MicroEJ > Front Panel Project

The wizard will appear:

Fig. 53: New Front Panel Project Wizard
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Enter the name for the new project.

Project Contents

Fig. 54: Project Contents

A Front Panel project has the following structure and contents:

• The src/main/java folder is provided for the definition of Widgets . It is initially empty. The creation of
these classes will be explained later.

• The src/main/resources folder holds the file or files that define the contents and layout of the Front Panel,
with a .fp extension (the fp file or files), plus images used to create the Front Panel. A newly created project
will have a single fp file with the same name as the project, as shown above. The contents of fp files are
detailed later in this document.

• The JRE System Library is referenced, because a Front Panel project needs to support the writing of Java
for the Listeners (and DisplayExtensions ).

• The Modules Dependencies contains the libraries for the Front Panel simulation, the widgets it supports
and the types needed to implement Listeners (and DisplayExtensions ).

• The lib contains a local copy of Modules Dependencies .

Module Dependencies

The Front Panel project is a regular MicroEJ Module project. Its module.ivy file should look like this example:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org" xmlns:ej="https://developer.microej.com"␣
→˓ej:version="2.0.0">
<info organisation="com.mycompany" module="examplePanel" status="integration" revision="1.0.0"/>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public" description="Runtime dependencies to other artifacts"/>
<conf name="provided" visibility="public" description="Compile-time dependencies to APIs provided␣

→˓by the Platform"/>
</configurations>

(continues on next page)
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<dependencies>
<dependency org="ej.tool.frontpanel" name="widget" rev="1.0.0"/>

</dependencies>
</ivy-module>

The dependency ej.tool.frontpanel#widget is only useful forMicroUI application (see Simulation). The depen-
dencies block must be manually updated to depend only on the Front Panel framework. This framework contains
the Front Panel core classes:

<dependencies>
<dependency org="ej.tool.frontpanel" name="framework" rev="1.0.0"/>

</dependencies>

The Front Panel framework does not provide any widgets. Widgets have to be added to simulate user interactions.

Front Panel File

File Content

The Front Panel engine takes an XML file (the .fp file) as input. It describes the panel usingwidgets: they simulate
the drivers, sensors and actuators of the real device. The Front Panel engine generates the graphical representa-
tion of the real device, and is displayed in a window on the user’s development machine when the application is
executed in the Simulator.

The following example file describes a simple board with one LED:

<?xml version="1.0"?>
<frontpanel

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="https://developer.microej.com"
xsi:schemaLocation="https://developer.microej.com .widget.xsd">

<device name="MyBoard" skin="myboard.png">
<ej.fp.widget.LED x="131" y="127" skin="box_led.png"/>

</device>
</frontpanel>

The device skin must refer to a png file in the src/main/resources folder. This image is used to render the
background of the Front Panel. The widgets are drawn on top of this background.

The device contains the elements that define the widgets that make up the Front Panel. The name of the widget
element defines the type of widget. The set of valid types is determined by the Front Panel Designer. Every widget
element defines a label , whichmust be unique for widgets of this type (optional or not), and the x and y coordi-
nates of the position of the widget within the Front Panel (0,0 is top le�). Theremay be other attributes depending
on the type of the widget.

The file and tags specifications are available in chapter Front Panel.

Note: The .fp file grammar has changed since the UI Pack version 12.0.0 (Front Panel core has beenmoved to
MicroEJ Architecture 7.11.0 ). A quick migration guide is available: open Platform configuration file .Platform ,
go to Content tab, click onmodule Front Panel . The migration guide is available in Details box.
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Editing Front Panel Files

Toedit a .fp file, open it using the Eclipse XMLeditor (right-click on the .fp file, select Open With > XML Editor
). This editor features syntax highlighting and checking, and content-assist based on the schema (XSD file) refer-
enced in the fp file. This schema is a hidden file within the project’s definitions folder. An incremental builder
checks the contents of the fp file each time it is saved and highlights problems in the Eclipse Problems view, and
with markers on the fp file itself.

A preview of the Front Panel can be obtained by opening the Front Panel Preview ( Window > Show View >
Other. . . > MicroEJ > Front Panel Preview ).

The preview is updated each time the .fp file is saved.

A typical working layout is shown below.

Fig. 55: Working Layout Example

Within theXMLeditor, content-assist is obtainedbypressing CTRL + SPACE keys. Theeditorwill list all theelements
valid at the cursor position, and insert a template for the selected element.

Multiple Front Panel Files

A Front Panel project can contain multiple .fp files. All fp files are compiled when exporting the Front Panel
project in a Platform (or during Platform build). It is useful to have two ormore representation of a board (size, de-
vices layout, display size, etc.). By default the Simulator will chooses the default .fp file declared by the Platform,
or will defaults to a random one. To choose a specific one, set the Application Option frontpanel.file to a Front
Panel simple file name included in the Platform (e.g. mycompany.fp ).

Widget
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Description

A widget is a subclass of Front Panel framework class ej.fp.Widget . The library ej.tool.frontpanel#widget
provides a set of widgets which are Graphics Engine compatible (see Simulation). To create a new widget (or a
subclass of an existing widget), have a look on available widgets in this library.

A widget is recognized by the fp file as soon as its class contains a @WidgetDescription annotation. The anno-
tation contains several @WidgetAttribute . An attribute has got a name and tells if it is an optional attribute of
widget (by default an attribute is mandatory).

This is the description of the widget LED :

@WidgetDescription(attributes = { @WidgetAttribute(name = "x"),
@WidgetAttribute(name = "y"), @WidgetAttribute(name = "skin")})

As soon as a widget is created (with its description) in Front Panel project, the fp file can use it. Close and reopen
fp file a�er creating a newwidget. In device group, press CTRL + SPACE keys to visualize the available widgets:
the new widget can be added.

<ej.fp.widget.LED x="170" y="753" skin="box_led.png" />

Each attribute requires the set methods in the widget source code. For instance, the widget LED (or its hierarchy)
contains the following methods for sure:

• setX(int) ,

• setY(int) ,

• setskin(Image) .

The set method parameter’s type fixes the expected value in fp file. If the attribute cannot match the expected
type, an error is throw when editing fp file. Widget master class already provides a set of standard attributes:

• setFilter(Image) : apply a filtering image which allows to crop input area (Input Device Filters).

• setWidth(int) and setHeight(int) : limits the widget size.

• setLabel(String) : specifies an identifier to the widget.

• setOverlay(boolean) : draws widget skin with transparency or not.

• setSkin(Image) : specifies the widget skin.

• setX(int) and setY(int) : specifies widget position.

Notes:

• Widget class does not specify if an attribute is optional or not. It it the responsability to the subclass.

• The label is o�en used as identifier. It also allows to retrieve a widget calling Device.getDevice().
getWidget(Class<T>, String) . Some widgets are using this identifier as an integer label. It is the re-
sponsability to the widget to fix the signification of the label.

• The widget size is o�en fixed by the its skin (which is an image). See Widget.finalizeConfiguration()
: it sets the widget size according the skin if the skin has been set; even if methods setWidth() and
setHeight() have been called before.

Runtime

The Front Panel engine parsing the fp file at application runtime. The widget methods are called in two times.
First, engine creates widget by widget:

4.20. Simulation 509



MicroEJ Documentation, Revision 2788b3f4

1. widget’s constructor: Widget should initialize its own fields which not depend on widget attributes (not val-
orized yet).

2. setXXX() : Widget should check if given attribute value matches the expected behavior (the type has been
already checked by caller). For instance if a width is not negative. On error, implementation can throw an
IllegalArgumentException . These checks must not depend on other attributes because they may have
not already valorized.

3. finalizeConfiguration() : Widget should check the coherence between all attributes: they are now val-
orized.

During these three calls, all widgets are not created yet. And so, by definition, the main device (which is a
widget) not more. By consequence, the implementation must not try to get the instance of device by calling
Device.getDevice() . Furthermore, a widget cannot try to get another widget by calling Device.getDevice().
getWidget(s) . If a widget depend on another widget for any reason, the last checks can be performed in start()
method. This method is called when all widgets and main device are created. Call to Device.getDevice() is
allowed.

Themethod showYourself() is only useful when visualizing the fp file during its editing (use Eclipse view Front
Panel Preview ). This method is called when clicking on button Outputs .

Example

The following code is a simplewidget LED. MicroEJ Application can interact with it using nativemethods on() and
off() of class ej.fp.widget.LED :

package ej.fp.widget;

import ej.fp.Device;
import ej.fp.Image;
import ej.fp.Widget;
import ej.fp.Widget.WidgetAttribute;
import ej.fp.Widget.WidgetDescription;

/**
* Widget LED declaration. This class must have the same package than
* <code>LED</code> in MicroEJ application. This is required by the simulator to
* retrieve the implementation of native methods.
*/
@WidgetDescription(attributes = { @WidgetAttribute(name = "x"), @WidgetAttribute(name = "y"),

@WidgetAttribute(name = "skin") })
public class LED extends Widget {

boolean on; // false init

/**
* Called by the plugin when clicking on <code>Outputs</code> button from Front
* Panel Preview.
*/
@Override
public void showYourself(boolean appearSwitchedOn) {

update(appearSwitchedOn);
}

/**
* Called by framework to render the LED.
*/

(continues on next page)
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@Override
public Image getCurrentSkin() {

// when LED is off, hide its skin returning null
return on ? getSkin() : null;

}

/**
* MicroEJ application native
*/
public static void on() {

update(true);
}

/**
* MicroEJ application native
*/
public static void off() {

update(false);
}

private static void update(boolean on) {

// retrieve the LED (there is only one LED on device)
LED led = Device.getDevice().getWidget(LED.class);

// update its state
led.on = on;

// ask to repaint it
led.repaint();

}
}

Empty Widget

By definition a widget may not contain an attribute. This kind of widget is useful to perform something at Front
Panel startup, for instance to start a thread to pick up data somewhere.

The widget description is @WidgetDescription(attributes = { }) . In start() method, a custom behavior
can be performed. In fp file, the widget declaration is <com.mycompany.Init/> (where Init is an example of
widget name).

Input Device Filters

The widgets which simulate the input devices use images (or “skins”) to show their current states (pressed and
released). The user can change the state of the widget by clicking anywhere on the skin: it is the active area. This
active area is, by default, rectangular.

These skins can be associated with an additional image called a filter . This image defines the widget’s active
area. It is useful when the widget is not rectangular.
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Fig. 56: Active Area

The filter imagemust have the same size as the skin image. The active area is delimited by the fully opaque pixels.
Every pixel in the filter image which is not fully opaque is considered not part of the active area.

Installation

In theplatformconfiguration file, check Front Panel to install the Front Panelmodule. When checked, the proper-
ties file frontpanel/frontpanel.properties is required during platform creation to configure themodule. This
configuration step is used to identify and configure the Front Panel.

The properties file must / can contain the following properties:

• project.name [mandatory]: Defines the name of the Front Panel project (same workspace as the platform
configuration project). If the project name does not exist, a new project will be created.

• fpFile.name [optional, default value is “” (empty)]: Defines the Front Panel file (*.fp) the application has to
use by default when several fp files are available in project.

To test a Front Panel project without rebuilding the platform or without exporting manually the project, add the
Application Option ej.fp.project to a Front Panel Project absolute path (e.g. c:\\mycompany\\myfrontpanel.
fp ). The Simulator will use the specified Front Panel project prior to the one included by the Platform.

Note: This feature works only if the Platform has been built with the Front Panel module enabled.

Warning: This feature is useful to test locally some changes in Front Panel project. The Platform does not
contain the changes until a new Platform is built.

Use

Launch an application on the Simulator to run the Front Panel.

4.20.9 Bluetooth LE Mock

Overview

To runaMicroEJApplication thatuses theBluetoothLEFoundationLibrary (ej.api.bluetooth)onMicroEJSimulator,
a Bluetooth LEmock controller must be set up first:
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The Bluetooth LE mock controller is a hardware mock of the Bluetooth LE library. It means the Simulator uses a
realBluetoothLEdevice to scanotherdevices, advertise, discover services, connect, pair, etc. . . This designenables
testing of apps in a real-world environment.

The Bluetooth LE mock controller implementation is provided for the ESP32-DevKitC board reference. Other im-
plementations or sources can be provided on request.

Requirements

• A ESP32-DevKitC board.

• A Bluetooth LEmock controller firmware.

• A tool to flash the firmware like https://www.espressif.com/en/tools-type/flash-download-tools.

Usage

To simulate a Bluetooth LE application, follow these three steps:

• Set up the controller

• Set up the network configuration

• Run the application on the Simulator

If your are facing any issues, check the Troubleshooting section.

Controller Setup

To set up the controller, follow these steps:

• Plug-in the ESP32-DevKitC board to your computer,

• Find the associated COM port,

• In the flash tool:

– select the chip “ESP32 DownloadTool”

– browse for the firmware file

– set the o�set to 0x000000

– set the COM port
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– set the baudrate to 921 600

– start the flash download

With the flash download tool from Espressif, you should end with something similar to this :

Fig. 57: Bluetooth LE Flash Download Tool Configuration

Network Setup

To configure the network:
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1. Connect your computer to the Wi-Fi network “BLE-Mock-Controller-[hexa device id]” mounted by the con-
troller.

2. Open a browser and connect to http://192.168.4.1/ to access the Wi-Fi setup interface :

3. Select the desired network and provide the required information if asked. If an error occurs during the con-
nection, retry this step.

4. In case the device is successfully connected to the desired network, the web page should looks like this:

Additionally, the serial output of the device shows connection status.

5. Connect your computer back to this network: your computer and the controllermustbe in the samenetwork.

Simulation

It is possible to run the Simulator as many times as necessary using the same setup. Also, rebooting the controller
will automatically set up the network with the saved configuration.

The IP address of the controller is available in the logs :
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Before running your Bluetooth LE application on the Simulator, in the Run configuration panel, set the simulation
mode to “Controller (over net)” and configure the Bluetooth LEmock settings.
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Fig. 58: Bluetooth LE Mock Configuration

Launching theapplicationon theSimulatorwill restore thecontroller to its initial state (theBLEadapter isdisabled).

Troubleshooting

Network Setup Errors

I can’t find the “BLE-Mock-Controller-[hexa device id]” access point

The signal of this Wi-Fi access point may be weaker than the surrounding access points. Try to reduce the distance
between the controller and your computer; and rescan. If it’s not possible, try using a smartphone instead (only a
browser will be required to set up the network configuration).

I want to override the network configuration

If the Wi-Fi credentials are not valid anymore, the controller restarts the network setup phase. Yet, in case the
credentials are valid but you want to change them, erase the flash and reflash the firmware.

Simulation Errors
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Error during the simulation: mock could not connect to controller

This errormeans themock process (Simulator) could not initialize the connectionwith the controller. Please check
that the device is connected to the network (see logs in the serial port output) and that your computer is in the
same network.

4.21 Appendices

4.21.1 Low Level API

This chapter describes succinctly the available Low Level API, module by module. The exhaustive documentation
of each LLAPI function is available in the LLAPI header files themselves. The required header files to implement are
automatically copied in the folder include of MicroEJ Platform at platform build time.

LLMJVM: MicroEJ Core Engine

Naming Convention

The Low Level MicroEJ Core Engine API, the LLMJVM API, relies on functions that need to be implemented. The
naming convention for such functions is that their names match the LLMJVM_IMPL_* pattern.

Header Files

Three C header files are provided:

• LLMJVM_impl.h

Defines the set of functions that the BSPmust implement to launch and schedule the virtual machine

• LLMJVM.h

Defines the set of functions provided by virtual machine that can be called by the BSPwhen using the virtual
machine

• LLBSP_impl.h

Defines the set of extra functions that the BSPmust implement.

LLKERNEL: Multi-Sandbox

Naming Convention

The Low Level Kernel API, the LLKERNEL API, relies on functions that need to be implemented. The naming con-
vention for such functions is that their names match the LLKERNEL_IMPL_* pattern.

Header Files

One C header file is provided:
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• LLKERNEL_impl.h

Defines the set of functions that the BSP must implement to manage memory allocation of dynamically in-
stalled applications.

LLSP: Shielded Plug

Naming Convention

The Low Level Shielded Plug API, the LLSP API, relies on functions that need to be implemented. The naming
convention for such functions is that their names match the LLSP_IMPL_* pattern.

Header Files

The implementation of the [SP] for the MicroEJ Platform assumes some support from the underlying RTOS. It is
mainly related to provide some synchronization when reading / writing into Shielded Plug blocks.

• LLSP_IMPL_syncWriteBlockEnter and LLSP_IMPL_syncWriteBlockExit are used as a semaphore by
RTOS tasks. When a task wants to write to a block, it “locks” this block until it has finished to write in it.

• LLSP_IMPL_syncReadBlockEnter and LLSP_IMPL_syncReadBlockExit are used as a semaphore by RTOS
tasks. When a task wants to read a block, it “locks” this block until it is ready to release it.

The [SP] specification provides a mechanism to force a task to wait until new data has been provided to a block.
The implementation relies on functions LLSP_IMPL_wait and LLSP_IMPL_wakeup to block the current task and
to reschedule it.

LLEXT_RES: External Resources Loader

Principle

This LLAPI allows to use the External Resource Loader. When installed, the External Resource Loader is notified
when the MicroEJ Core Engine is not able to find a resource (an image, a file etc.) in the resources area linked with
the MicroEJ Core Engine.

When a resource is not available, theMicroEJ Core Engine invokes the External Resource Loader in order to load an
unknown resource. The External Resource Loader uses the LLAPI EXT_RES to let the BSP loads or not the expected
resource. The implementation has to be able to load several files in parallel.

Naming Convention

The Low Level API, the LLEXT_RES API, relies on functions that need to be implemented. The naming convention
for such functions is that their names match the LLEXT_RES_IMPL_* pattern.

Header Files

One header file is provided:

• LLEXT_RES_impl.h

Defines the set of functions that the BSPmust implement to load some external resources.
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LLCOMM: Serial Communications

Naming Convention

The Low Level Comm API (LLCOMM), relies on functions that need to be implemented by engineers
in a driver. The names of these functions match the LLCOM_BUFFERED_CONNECTION_IMPL_* or the
LLCOM_CUSTOM_CONNECTION_IMPL_* pattern.

Header Files

Four C header files are provided:

• LLCOMM_BUFFERED_CONNECTION_impl.h

Defines the set of functions that the driver must implement to provide a Bu�ered connection

• LLCOMM_BUFFERED_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Bu�ered connection

• LLCOMM_CUSTOM_CONNECTION_impl.h

Defines the set of functions that the driver must implement to provide a Custom connection

• LLCOMM_CUSTOM_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Custom connection

LLUI_INPUT: Input

LLUI_INPUT API is composed of the following files:

• the file LLUI_INPUT_impl.h that defines the functions to be implemented

• the file LLUI_INPUT.h that provides the functions for sending events

Implementation

LLUI_INPUT_IMPL_initialize is the first function called by the input engine, and it may be used to initialize the
underlying devices and bind them to event generator IDs.

LLUI_INPUT_IMPL_enterCriticalSection and LLUI_INPUT_IMPL_exitCriticalSection need to provide the
Input Enginewith a critical sectionmechanism for synchronizingdeviceswhen sending events to the internal event
queue. Themechanism used to implement the synchronizationwill depend on the platform configuration (with or
without RTOS), and whether or not events are sent from an interrupt context.

LLUI_INPUT_IMPL_getInitialStateValue allows the input stack to get the current state for devices connected
to the MicroUI States event generator, such as switch selector, coding wheels, etc.

Sending Events

The LLUI_INPUT API provides two generic functions for a C driver to send data to its associated event generator:
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• LLUI_INPUT_sendEvent : Sends a 32-bit event to a specific event generator, specified by its ID. If the in-
put bu�er is full, the event is not added, and the function returns LLUI_INPUT_NOK ; otherwise it returns
LLUI_INPUT_OK .

• LLUI_INPUT_sendEvents : Sends a frame constituted by several 32-bit events to a specific event generator,
specified by its ID. If the input bu�er cannot receive the whole data, the frame is not added, and the function
returns LLUI_INPUT_NOK ; otherwise it returns LLUI_INPUT_OK .

Eventswill be dispatched to the associated event generator thatwill be responsible for decoding them (seeGeneric
Event Generators).

The UI extension provides an implementation for each of MicroUI’s built-in event generators. Each one has dedi-
cated functions that allows a driver to send them structured data without needing to understand the underlying
protocol to encode/decode the data. The following table shows the functions provided to send structured events
to the predefined event generators:

Table 24: LLUI_INPUT API for predefined event generators
Function name Default event

generator
kind1

Comments

LLUI_INPUT_sendCommandEvent
Command Constants are provided that define all stan-

dard MicroUI commands [MUI].

LLUI_INPUT_sendButtonPressedEvent

LLUI_INPUT_sendButtonReleasedEvent

LLUI_INPUT_sendButtonRepeatedEvent

LLUI_INPUT_sendButtonLongEvent

Buttons In the case of chronological sequences (for
example, a RELEASE that may occur only
a�er a PRESSED), it is the responsibility of
the driver to ensure the integrity of such se-
quences.

LLUI_INPUT_sendPointerPressedEvent

LLUI_INPUT_sendPointerReleasedEvent

LLUI_INPUT_sendPointerMovedEvent

Pointer In the case of chronological sequences (for
example, a RELEASE that may occur only
a�er a PRESSED), it is the responsibility of
the driver to ensure the integrity of such se-
quences. Depending on whether a button of
the pointer is pressed while moving, a DRAG
and/or a MOVE MicroUI event is generated.

LLUI_INPUT_sendStateEvent
States The initial value of each state machine

(of a States) is retrieved by a call to
LLUI_INPUT_IMPL_getInitialStateValue
that must be implemented by the device. Al-
ternatively, the initial value can be specified
in the XML static configuration.

LLUI_INPUT_sendTouchPressedEvent

LLUI_INPUT_sendTouchReleasedEvent

LLUI_INPUT_sendTouchMovedEvent

Pointer In the case of chronological sequences (for
example, a RELEASE that may only occur
a�er a PRESSED), it is the responsibility of
the driver to ensure the integrity of such se-
quences. These APIswill generate a DRAGMi-
croUI event instead of aMOVEwhile they rep-
resent a touch pad over a display.

1 The implementation class is a subclass of the MicroUI class of the column.
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Event Bu�er

Functions LLUI_INPUT_IMPL_log_xxx allow logging the use of event bu�er. Implementation of these LLAPIs is
already available on the MicroEJ Central Repository ( LLUI_INPUT_LOG_impl.c ). This implementation is using an
array to add some metadata to each event. This metadata is used when the BSP is calling LLUI_INPUT_dump() .
Whenno implementation is included in theBSP, the call to LLUI_INPUT_dump() has no e�ect (no available logger).

LLUI_DISPLAY: Display

Principle & Naming Convention

The Graphics Engine provides some Low Level APIs to connect a display driver. The file LLUI_DISPLAY_impl.h
defines the API headers to be implemented. For the APIs themselves, the naming convention is that their names
match the *_IMPL_* pattern when the functions need to be implemented:

• LLUI_DISPLAY_IMPL_initialize

• LLUI_DISPLAY_IMPL_binarySemaphoreTake

• LLUI_DISPLAY_IMPL_binarySemaphoreGive

• LLUI_DISPLAY_IMPL_flush

Some additional Low Level APIs allow you to connect display extra features. These Low Level APIs are not required.
When they are not implemented, a default implementation is used (weak function). It concerns backlight, contrast,
etc.

This describes succinctly some LLUI_DISPLAY_IMPL functions. Please refer to documentation inside header files
to have more information.

Initialization

Each Graphics Engine gets initialized by calling the function LLUI_DISPLAY_IMPL_initialize : It asks its display
driver to initialize itself. The implementation function has to fill the given structure LLUI_DISPLAY_SInitData .
This structure allows to retrieve the size of the virtual and physical screen, the back bu�er address (where MicroUI
is drawing). The implementation has too give two binary semaphores.

Image Heap

The display driver must reserve a runtime memory bu�er for creating dynamic images when using MicroUI
ResouceImage and BufferedImage classes methods. The display driver may choose to reserve an empty bu�er.
Thus, calling MicroUI methods will result in a MicroUIException exception.

The section name is .bss.microui.display.imagesHeap .

Functions LLUI_DISPLAY_IMPL_image_heap_xxx allow to control the image bu�ers allocation in the im-
age heap. Implementation of these LLAPIs is already available on the MicroEJ Central Repository (
LLUI_DISPLAY_HEAP_impl.c ). This implementation is using a best fit allocator. It can be updated to log the al-
locations, the remaining space, etc. When no implementation is included in the BSP, the default Graphics Engine’a
allocator (a best fit allocator) is used.
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External Font Heap

The display driver must reserve a runtime memory bu�er for loading external fonts (fonts located outside CPU
addresses ranges). The display drivermay choose to reserve an empty bu�er. Thus, callingMicroUI Font methods
will result in empty drawings of some characters.

The section name is .bss.microui.display.externalFontsHeap .

Flush and Synchronization

The back bu�er (graphics bu�er) address set in Initialization function is the address for the very first drawing. The
content of this bu�er is flushed to the external display memory by the function LLUI_DISPLAY_flush . The pa-
rameters define the rectangular area of the content which has changed during the last drawing action, and which
must be flushed to the display bu�er (dirty area). This function should be atomic: the implementation has to start
another task or a hardware device (o�en a DMA) to perform the copy.

As soon as the application performs a new drawing, the Graphics Engine locks the thread. It will automatically
unlocked when the BSP will call LLUI_DISPLAY_flushDone at the end of the copy,

Display Characteristics

Function LLUI_DISPLAY_IMPL_isColor directly implements the method from the MicroUI Display class of the
same name. The default implementation always returns true when the number of bits per pixel is higher than 4.

Function LLUI_DISPLAY_IMPL_getNumberOfColors directly implements the method from the MicroUI Display
class of the same name. The default implementation returns a value according to the number of bits by pixel,
without taking into consideration the alpha bit(s).

Function LLUI_DISPLAY_IMPL_isDoubleBuffered directly implements the method from the MicroUI Display
class of the same name. The default implementation returns true . When LLAPI implementation targets a display
in direct mode, this function must be implemented and return false .

Contrast

LLUI_DISPLAY_IMPL_setContrast and LLUI_DISPLAY_IMPL_getContrast are called to set/get the current dis-
play contrast intensity. The default implementations don’t manage the contrast.

BackLight

LLUI_DISPLAY_IMPL_hasBacklight indicates whether the display has backlight capabilities.

LLUI_DISPLAY_IMPL_setBacklight and LLUI_DISPLAY_IMPL_getBacklight are called to set/get the current dis-
play backlight intensity.

Color Conversions

The following functions are only useful (and called) when the display is not a standard display, see Pixel Structure.

LLUI_DISPLAY_IMPL_convertARGBColorToDisplayColor is called to convert a 32-bit ARGB MicroUI color in
0xAARRGGBB format into the “driver” display color.
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LLUI_DISPLAY_IMPL_convertDisplayColorToARGBColor is called to convert a display color to a 32-bit ARGB Mi-
croUI color.

CLUT

The function LLUI_DISPLAY_IMPL_prepareBlendingOfIndexedColors is called when drawing an image with in-
dexed color. See CLUT to have more information about indexed images.

Image Decoders

The API LLUI_DISPLAY_IMPL_decodeImage allows to add some additional image decoders.

LLUI_LED: LEDs

Principle

The LEDs engine provides LowLevel APIs for connecting LEDdrivers. The file LLUI_LED_impl.h , which comeswith
the LEDs engine, defines the API headers to be implemented.

Naming Convention

The Low Level APIs rely on functions that must be implemented. The naming convention for such functions is that
their names match the *_IMPL_* pattern.

Initialization

The first function called is LLUI_LED_IMPL_initialize , which allows the driver to initialize all LED devices. This
methodmust return the available number of LEDs. Each LED has a unique identifier. The first LED has the ID 0, and
the last has the ID NbLEDs – 1.

This UI extensionprovides support to e�iciently implement the set ofmethods that interactwith the LEDs provided
by a device. Below are the relevant C functions:

• LLUI_LED_IMPL_getIntensity : Get the intensity of a specific LED using its ID.

• LLUI_LED_IMPL_setIntensity : Set the intensity of an LED using its ID.

LLNET: Network

Naming Convention

The Low Level API, the LLNET API, relies on functions that need to be implemented. The naming convention for
such functions is that their names match the LLNET_IMPL_* pattern.
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Header Files

Several header files are provided:

• LLNET_CHANNEL_impl.h

Defines a set of functions that the BSPmust implement to initialize the Net native component. It also defines
some configuration operations to setup a network connection.

• LLNET_SOCKETCHANNEL_impl.h

Defines a set of functions that the BSP must implement to create, connect and retrieve information on a
network connection.

• LLNET_STREAMSOCKETCHANNEL_impl.h

Defines a set of functions that the BSP must implement to do some I/O operations on connection oriented
socket (TCP). It also defines function to put a server connection in accepting mode (waiting for a new client
connection).

• LLNET_DATAGRAMSOCKETCHANNEL_impl.h

Defines a set of functions that theBSPmust implement todo some I/Ooperationsonconnectionless oriented
socket (UDP).

• LLNET_DNS_impl.h

Defines a set of functions that the BSPmust implement to request host IP address associated to a host name
or to request Domain Name Service (DNS) host IP addresses setup in the underlying system.

• LLNET_NETWORKADDRESS_impl.h

Defines a set of functions that the BSP must implement to convert string IP address or retrieve specific IP
addresses (lookup, localhost or loopback IP address).

• LLNET_NETWORKINTERFACE_impl.h

Defines a set of functions that the BSPmust implement to retrieve information on a network interface (MAC
address, interface link status, etc.).

LLNET_SSL: SSL

Naming Convention

The Low Level API, the LLNET_SSL API, relies on functions that need to be implemented. The naming convention
for such functions is that their names match the LLNET_SSL_* pattern.

Header Files

Three header files are provided:

• LLNET_SSL_CONTEXT_impl.h

Defines a set of functions that the BSP must implement to create a SSL Context and to load CA (Certificate
Authority) certificates as trusted certificates.

• LLNET_SSL_SOCKET_impl.h

Defines a set of functions that the BSP must implement to initialize the SSL native components, to create
an underlying SSL Socket and to initiate a SSL session handshake. It also defines some I/O operations such
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as LLNET_SSL_SOCKET_IMPL_write or LLNET_SSL_SOCKET_IMPL_read used for encrypted data exchange
between the client and the server.

• LLNET_SSL_X509_CERT_impl.h

Defines a function named LLNET_SSL_X509_CERT_IMPL_parse for certificate parsing. This function checks if
a given certificate is an X.509 digital certificate and returns its encoded format type : Distinguished Encoding
Rules (DER) or Privacy-Enchanced Mail (PEM).

LLFS: File System

Naming Convention

The Low Level File SystemAPI (LLFS), relies on functions that need to be implemented by engineers in a driver. The
names of these functions match the LLFS_IMPL_* and the LLFS_File_IMPL_* pattern.

Header Files

Two C header files are provided:

• LLFS_impl.h

Defines a set of functions that the BSPmust implement to initialize the FS native component. It also defines
some functions to manage files, directories and retrieve information about the underlying File System (free
space, total space, etc.).

• LLFS_File_impl.h

Defines a set of functions that the BSPmust implement to do some I/O operations on files (open, read, write,
close, etc.).

LLHAL: Hardware Abstraction Layer

Naming Convention

The Low Level API, the LLHAL API, relies on functions that need to be implemented. The naming convention for
such functions is that their names match the LLHAL_IMPL_* pattern.

Header Files

One header file is provided:

• LLHAL_impl.h

Defines the set of functions that the BSPmust implement to configure and drive some MCU GPIO.

LLDEVICE: Device Information

Naming Convention

The Low Level Device API (LLDEVICE), relies on functions that need to be implemented by engineers in a driver. The
names of these functions match the LLDEVICE_IMPL_* pattern.
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Header Files

One C header file is provided:

• LLDEVICE_impl.h

Defines a set of functions that the BSP must implement to get the platform architecture name and unique
device identifier.

LLWATCHDOG_TIMER: Watchdog Timer

Naming Convention

The Low Level Watchdog Timer API (LLWATCHDOG_TIMER), provides functions that allow the use of this API at the
BSP level in C. The names of these functions match the LLWATCHDOG_TIMER_IMPL_* pattern.

The Watchdog API is delivered with a Generic C implementation on which the platform must depend. This imple-
mentation relies on functions that need to be implemented by engineers in a driver. The name of these functions
match the LLWATCHDOG_TIMER_IMPL_*_action pattern.

Header Files

One C header file is provided:

• LLWATCHDOG_TIMER_impl.h

Defines a set of functions that can be used at BSP level if required.

This C header file contains functions to implement:

• watchdog_timer_helper.h

Defines a set of functions that the BSPmust implement to link the platformwatchdog timer to theWatchdog
Timer library.

4.21.2 MicroEJ Foundation Libraries

EDC

Error Messages

When an exception is thrown by the runtime, the error message

Generic:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:

Table 25: Generic Error Messages
Message ID Description
1 Negative o�set.
2 Negative length.
3 O�set + length > object length.

When an exception is thrown by the implementation of the EDC API, the error message
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EDC-1.2:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:

Table 26: EDC Error Messages
Message
ID

Description

-4 No native stack found to execute the Java native method.
-3 Maximum stack size for a thread has been reached. Increase themaximum size of the thread stack

parameter.
-2 No Java stack block could be allocated with the given size. Increase the Java stack block size.
-1 The Java stack space is full. Increase the Java stack size or the number of Java stack blocks.
1 A closed stream is being written/read.
2 The operation Reader.mark() is not supported.
3

lock is null in Reader(Object lock) .
4 String index is out of range.
5 Argument must be a positive number.
6 Invalid radix used. Must be from Character.MIN_RADIX to Character.MAX_RADIX .

Exit Codes

The MicroEJ Application can stop its execution by calling the method System.exit(). To retrieve the appplication
exit code (or exit status), use the C function SNI_getExitCode() a�er the end of SNI_startVM() (see sni.h
header file). If the MicroEJ Application ended without calling System.exit() then SNI_getExitCode() returns 0 .

The error codes returned by SNI_startVM() are defined in the section Error Codes.

SNI

Error Messages

The following error messages are issued at runtime.

Table 27: [SNI] Run Time Error Messages.
Message ID Description
-1 Not enough blocks.
-2 Reserved.
-3 Max stack blocks per thread reached.

KF

Definitions

Feature Definition Files

A Feature is a group of types, resources and [BON] immutables objects defined using two files that shall be in ap-
plication classpath:

• [featureName].kf , a Java properties file. Keys are described in the “Feature definition file properties” table
below.
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• [featureName].cert , an X509 certificate file that uniquely identifies the Feature

Table 28: Feature definition file properties
Key Usage Description
entryPoint Mandatory The fully qualified name of the class that implements ej.kf.

FeatureEntryPoint
immutables Optional Semicolon separated list of paths to [BON] immutable files owned by the

Feature. [BON] immutable file is defined by a / separated path relative
to application classpath

resources Optional Semicolon separated list of resource names owned by the Feature. Re-
source name is defined by Class.getResourceAsStream(String)

requiredTypes Optional Comma separated list of fully qualified names of required types. (Types
that may be dynamically loaded using Class.forName() ).

types Optional Comma separated list of fully qualified names of types ownedby the Fea-
ture. Awildcard is allowed as terminal character to embed all types start-
ing with the given qualified name ( a.b.C,x.y.* )

version Mandatory String version, that can retrieved using ej.kf.Module.getVersion()

Kernel Definition Files

Kernel definition files are mandatory if one or more Feature definition file is loaded and are named kernel.kf
and kernel.cert . kernel.kf must only define the version key. All types, resources and immutables are
automatically owned by the Kernel if not explicitly set to be owned by a Feature.

Kernel API Definition

Kernel types, methods and static fields allowed to be accessed by Features must be declared in kernel.api file.
Kernel API file is an XML file (see example “Kernel API XML Schema” and table “XML elements specification”).

Listing 10: Kernel API XML Schema

<xs:schema xmlns:xs='http://www.w3.org/2001/XMLSchema'>
<xs:element name='require'>

<xs:complexType>
<xs:choice minOccurs='0' maxOccurs='unbounded'>

<xs:element ref='type'/>
<xs:element ref='field'/>
<xs:element ref='method'/>

</xs:choice>
</xs:complexType>

</xs:element>

<xs:element name='type'>
<xs:complexType>

<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>

</xs:element>

<xs:element name='field'>
<xs:complexType>

<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>

(continues on next page)
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(continued from previous page)

</xs:element>

<xs:element name='method'>
<xs:complexType>

<xs:attribute name='name' type='xs:string' use='required'/>
</xs:complexType>

</xs:element>
</xs:schema>

Table 29: XML elements specification
Tag Attributes Description
require The root element
field Static fielddeclaration. Declaringa fieldasaKernelAPI automatically sets thedeclaring

type as a Kernel API
name Fully qualified name on the form [type].[fieldName]

method Method or constructor declaration. Declaring amethod or a constructor as a Kernel API
automatically sets the declaring type as a Kernel API

name Fully qualified name on the form [type].[methodName]([typeArg1,...,typeArgN)
typeReturned . Types are fully qualified names or one of a base type as described by
the Java language ( boolean , byte , char , short , int , long , float , double ) When
declaring a constructor, methodName is the single type name. When declaring a void
method or a constructor, typeReturned is void

type Type declaration, allowed to be loaded from a Feature using Class.forName()
name Fully qualified name on the form [package].[package].[typeName]

Access Error Codes

When an instruction is executed thatwill break a [KF] insulation semantic rule, a java.lang.IllegalAccessError
is thrown, with an error code composed of two parts: [source][errorKind] .

• source : a single character indicating the kind of Java element on which the access error occurred (Table
“Error codes: source”)

• errorKind : an error number indicating the action on which the access error occurred (Table “Error codes:
kind”)

Table 30: Error codes: source
Ch aracter Description
A Error thrown when accessing an array
I Error thrown when calling a method
F Error thrown when accessing an instance field
M Error thrown when entering a synchronized block or method
P Error thrown when passing a parameter to a method call
R Error thrown when returning from amethod call
S Error thrown when accessing a static field
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Table 31: Error codes: kind
Id Description
1 An object owned by a Feature is being assigned to an object owned by the Kernel, but the current context

is not owned by the Kernel
2 An object owned by a Feature is being assigned to an object owned by another Feature
3 An object owned by a Feature is being accessed from a context owned by another Feature
4 A synchronize on an object owned by the Kernel is executed in a method owned by a Feature
5 A call to a feature code occurs while owning a Kernel monitor

Loading Features Dynamically

Features may be statically embedded with the Kernel or dynamically built against a Kernel. To build a Feature
binary file, select Build Dynamic FeatureMicroEJPlatformExecution tab. Thegenerated file canbedynamically
loaded by the Kernel runtime using ej.kf.Kernel.load(InputStream) .

ECOM

Error Messages

When an exception is thrown by the implementation of the ECOM API, the error message

ECOM-1.1:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:

Table 32: ECOM Error Messages
Message ID Description
1 The connection has been closed. Nomore action can be done on this connection.
2 The connection has already been closed.
3 The connection description is invalid. The connection cannot be opened.
4 The connection stream has already been opened. Only one stream per kind of stream (input or

output stream) can be opened at the same time.
5 Toomany connections have been opened at the same time. The platform is not able to open a new

one. Try to close useless connections before trying to open the new connection.

ECOM Comm

Error Messages

When an exception is thrown by the implementation of the ECOM-COMM API, the error message

ECOM-COMM:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:
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Table 33: ECOM-COMM error messages
Message ID Description
1 The connection descriptor must start with "comm:"
2 Reserved.
3 The Comm port is unknown.
4 The connection descriptor is invalid.
5 The Comm port is already open.
6 The baudrate is unsupported.
7 The number of bits per character is unsupported.
8 The number of stop bits is unsupported.
9 The parity is unsupported.
10 The input stream cannot be opened because native driver is not able to create a RX bu�er to

store the incoming data.
11 The output stream cannot be opened because native driver is not able to create a TX bu�er to

store the outgoing data.
12 The given connection descriptor option cannot be parsed.

FS

Error Messages

When an exception is thrown by the implementation of the FS API, the error message

FS:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:

Table 34: File System Error Messages
Message ID Description
-1 End of File (EOF).
-2 An error occurred during a File System operation.
-3 File System not initialized.

Net

Error Messages

When an exception is thrown by the implementation of the Net API, the error message

NET-1.1:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:
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Table 35: Net Error Messages
Message ID Description
-2 Permission denied.
-3 Bad socket file descriptor.
-4 Host is down.
-5 Network is down.
-6 Network is unreachable.
-7 Address already in use.
-8 Connection abort.
-9 Invalid argument.
-10 Socket option not available.
-11 Socket not connected.
-12 Unsupported network address family.
-13 Connection refused.
-14 Socket already connected.
-15 Connection reset by peer.
-16 Message size to be sent is too long.
-17 Broken pipe.
-18 Connection timed out.
-19 Not enough free memory.
-20 No route to host.
-21 Unknown host.
-23 Native method not implemented.
-24 The blocking request queue is full, and a new request cannot be added now.
-25 Network not initialized.
-255 Unknown error.

SSL

Error Messages

When an exception is thrown by the implementation of the SSL API, the error message

SSL-2.0:E=<messageId>

is issued, where <messageId> meaning is defined in the next table:

Table 36: SSL Error Messages
Message ID Description
-2 Connection reset by the peer.
-3 Connection timed out.
-5 Dispatch blocking request queue is full, and a new request cannot be added now.
-6 Certificate parsing error.
-7 The certificate data size bigger than the immortal bu�er used to process certificate.
-8 No trusted certificate found.
-9 Basic constraints check failed: Intermediate certificate is not a CA certificate.
-10 Subject/issuer name chaining error.
-21 Wrong block type for RSA function.
-22 RSA bu�er error: Output is too small, or input is too large.
-23 Output bu�er is too small, or input is too large.

Continued on next page
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Table 36 – continued from previous page
Message ID Description
-24 Certificate AlogID setting error.
-25 Certificate public-key setting error.
-26 Certificate date validity setting error.
-27 Certificate subject name setting error.
-28 Certificate issuer name setting error.
-29 CA basic constraint setting error.
-30 Extensions setting error.
-31 Invalid ASN version number.
-32 ASN get int error: invalid data.
-33 ASN key init error: invalid input.
-34 Invalid ASN object id.
-35 Not null ASN tag.
-36 ASN parsing error: zero expected.
-37 ASN bit string error: wrong id.
-38 ASN OID error: unknown sum id.
-39 ASN date error: bad size.
-40 ASN date error: current date before.
-41 ASN date error: current date a�er.
-42 ASN signature error: mismatched OID.
-43 ASN time error: unknown time type.
-44 ASN input error: not enough data.
-45 ASN signature error: confirm failure.
-46 ASN signature error: unsupported hash type.
-47 ASN signature error: unsupported key type.
-48 ASN key init error: invalid input.
-49 ASN NTRU key decode error: invalid input.
-50 X.509 critical extension ignored.
-51 ASN no signer to confirm failure (no CA found).
-52 ASN CRL signature-confirm failure.
-53 ASN CRL: no signer to confirm failure.
-54 ASN OCSP signature-confirm failure.
-60 ECC input argument is wrong type.
-61 ECC ASN1 bad key data: invalid input.
-62 ECC curve sum OID unsupported: invalid input.
-63 Bad function argument provided.
-64 Feature not compiled in.
-65 Unicode password too big.
-66 No password provided by user.
-67 AltNames extensions too big.
-70 AES-GCM Authentication check fail.
-71 AES-CCM Authentication check fail.
-80 Cavium Init type error.
-81 Bad alignment error, no alloc help.
-82 Bad ECC encrypt state operation.
-83 Bad padding: message wrong length.
-84 Certificate request attributes setting error.
-85 PKCS#7 error: mismatched OID value.
-86 PKCS#7 error: no matching recipient found.
-87 FIPS mode not allowed error.

Continued on next page
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Table 36 – continued from previous page
Message ID Description
-88 Name constraint error.
-89 Random Number Generator failed.
-90 FIPS Mode HMACminimum key length error.
-91 RSA Padding error.
-92 Export public ECC key in ANSI format error: Output length only set.
-93 In Core Integrity check FIPS error.
-94 AES Known Answer Test check FIPS error.
-95 DES3 Known Answer Test check FIPS error.
-96 HMAC Known Answer Test check FIPS error.
-97 RSA Known Answer Test check FIPS error.
-98 DRBG Known Answer Test check FIPS error.
-99 DRBG Continuous Test FIPS error.
-100 AESGCM Known Answer Test check FIPS error.
-101 Process input state error.
-102 Bad index to key rounds.
-103 Out of memory.
-104 Verify problem found on completion.
-105 Verify mac problem.
-106 Parse error on header.
-107 Weird handshake type.
-108 Error state on socket.
-109 Expected data, not there.
-110 Not enough data to complete task.
-111 Unknown type in record header.
-112 Error during decryption.
-113 Received alert: fatal error.
-114 Error during encryption.
-116 Need peer’s key.
-117 Need the private key.
-118 Error during RSA private operation.
-119 Server missing DH parameters.
-120 Build message failure.
-121 Client hello not formed correctly.
-122 The peer subject namemismatch.
-123 Non-blocking socket wants data to be read.
-124 Handshake layer not ready yet; complete first.
-125 Premaster secret version mismatch error.
-126 Record layer version error.
-127 Non-blocking socket write bu�er full.
-128 Malformed bu�er input error.
-129 Verify problem on certificate and check date/time on your device.
-130 Verify problem based on signature.
-131 PSK client identity error.
-132 PSK server hint error.
-133 PSK key callback error.
-134 Record layer length error.
-135 Can’t decode peer key.
-136 The peer sent close notify alert.
-137 Wrong client/server type.

Continued on next page
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Table 36 – continued from previous page
Message ID Description
-138 The peer didn’t send the certificate.
-140 NTRU key error.
-141 NTRU DRBG error.
-142 NTRU encrypt error.
-143 NTRU decrypt error.
-150 Bad ECC Curve Type or unsupported.
-151 Bad ECC Curve or unsupported.
-152 Bad ECC Peer Key.
-153 ECC Make Key failure.
-154 ECC Export Key failure.
-155 ECC DHE shared failure.
-157 Not a CA by basic constraint.
-159 Bad Certificate Manager error.
-160 OCSP Certificate revoked.
-161 CRL Certificate revoked.
-162 CRLmissing, not loaded.
-165 OCSP needs a URL for lookup.
-166 OCSP Certificate unknown.
-167 OCSP responder lookup fail.
-168 Maximum chain depth exceeded.
-171 Suites pointer error.
-172 No PEM header found.
-173 Out of order message: fatal.
-174 Bad KEY type found.
-175 Sanity check on ciphertext failed.
-176 Receive callback returnedmore than requested.
-178 Need peer certificate for verification.
-181 Unrecognized host name error.
-182 Unrecognized max fragment length.
-183 Key Use digitalSignature not set.
-185 Key Use keyEncipherment not set.
-186 Ext Key Use server/client authentication not set.
-187 Send callback out-of-bounds read error.
-188 Invalid renegotiation.
-189 Peer sent di�erent certificate during SCR.
-190 Finishedmessage received from peer before receiving the Change Cipher message.
-191 Sanity check onmessage order.
-192 Duplicate handshake message.
-193 Unsupported cipher suite.
-194 Can’t match cipher suite.
-195 Bad certificate type.
-196 Bad file type.
-197 Opening random device error.
-198 Reading random device error.
-199 Windows cryptographic init error.
-200 Windows cryptographic generation error.
-201 No data is waiting to be received from the random device.
-202 Unknown error.
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4.21.3 Tools Options and Error Codes

SOAR

When a generic exception is thrown by the SOAR, the error message

SOAR ERROR [M<messageId>] <message>

is issued, where <messageId> and <message> meanings are defined in the next table.

Table 37: SOAR Error Messages.
Message ID Description
0 The SOAR process has encountered some internal limits.
1 Unknown option.
2 An option has an invalid value.
3 A mandatory option is not set.
4 A filename given in options does not exist.
5 Failed towrite theoutput file (access permissions required for -toDir and -root options).
6 The given file does not exist.
7 I/O error while reading a file.
8 An option value refers to a directory, instead of a file.
9 An option value refers to a file, instead of a directory or a jar file.
10 Invalid entry point class or no main() method.
11 An information file can not be generated in its entirety.
12 Limitations of the evaluation version have been reached.
13 I/O rrror while reading a jar file.
14 IO Error while writing a file.
15 I/O error while reading a jar file: unknown entry size.
16 Not enoughmemory to load a jar file.
17 The specified SOAR options are exclusive.
18 XML syntax error for some given files.
19 Unsupported float representation.
23 A clinit cycle has beendetected. The clinit cycle canbe cut either by simplifying the applica-

tion clinit code or by explicitly declaring clinit dependencies (see Class Initialization Code).
Check the generated .clinitmap file for more information.

50 Missing code: Java code refers to a method not found in specified classes.
51 Missing code: Java code refers to a class not found in the specified classpath.
52 Wrong class: Java code refers to a field not found in the specified class.
53 Wrong class: A Java classfile refers to a class as an interface.
54 Wrong class: An abstract method is found in a non-abstract class.
55 Wrong class: illegal access to a method, a field or a type.
56 Wrong class: hierarchy inconsistency; an interface cannot be a superclass of a class.
57 Circularity detected in initializion sequence.
58 Option refers twice to the same resource. The first reference is used.
59 Stack inconsistency detected.
60 Constant pool inconsistency detected.
61 Corrupted classfile.
62 Missing native implementation of a native method.
63 Cannot read the specified resource file.
64 The same property name cannot be defined in two di�erent property files.
65 Bad license validity.
66 Classfiles do not contain debug line table information.

Continued on next page
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Table 37 – continued from previous page
Message ID Description
67 Same as 51.
150 SOAR limit reached: The specified method uses toomany arguments.
151 SOAR limit reached: The specified method uses toomany locals.
152 SOAR limit reached: The specified method code is too large.
153 SOAR limit reached: The specified method catches toomany exceptions.
154 SOAR limit reached: The specified method defines a stack that is too large.
155 SOAR limit reached: The specified type defines too manymethods.
156 SOAR limit reached: Your application defines too many interfaces.
157 SOAR limit reached: The specified type defines too many fields.
158 SOAR limit reached: your application defines too many types.
159 SOAR limit reached: Your application defines too many static fields.
160 SOAR limit reached: The hierarchy depth of the specified type is too high.
161 SOAR limit reached: Your application defines too many bundles.
162 SOAR limit reached: Your application defines too deep interface hierarchies.
163 SOAR limit reached: Your application defines too many cnocrete types.
164 SOAR limit reached: Your application defines too many reference fields in a class.
251 Error in converting an IEE754 float(32) or double(64) to a fixed-point arithmetic number
300 Corrupted class: invalid dup_x1 instruction usage.
301 Corrupted class: invalid dup_x2 instruction usage.
302 Corrupted class:invalid dup_x2 instruction usage.
303 Corrupted class:invalid dup2_x1 instruction usage.
304 Corrupted class:invalid dup2_x1 instruction usage.
305 Corrupted class:invalid dup2_x2 instruction usage.
306 Corrupted class: invalid dup2 instruction usage.
307 Corrupted class:invalid pop2 instruction usage.
308 Corrupted class:invalid swap instruction usage.
309 Corrupted class: Finally blocks must be inlined.
350 SNI incompatibility: Some specified type should be an array.
351 SNI incompatibility: Some type should define some specified field.
352 SNI incompatibility: The specified field is not compatible with SNI.
353 SNI incompatibility: The specified type must be a class.
354 SNI incompatibility: The specified static field must be defined in the specified type.
355 SNI file error: The data must be an integer.
356 SNI file error: unexpected tag
357 SNI file error: attributes <name>, <descriptor>, <index>and<size> are expected in the spec-

ified tag.
358 SNI file error: invalid SNI tag value.
359 Error parsing the SNI file.
360 XML Error on parsing the SNI file.
361 SNI incompatibility: illegal call to the specified data.
362 No stack found for the specified native group.
363 Invalid SNI method: The argument cannot be an object reference.
364 Invalid SNI method: The array argument must only be a base type array.
365 Invalid SNI method: The return type must be a base type.
366 Invalid SNI method: The methodmust be static.

Immutable Files Related Error Messages

The following error messages are issued at SOAR time (link phase) and not at runtime.
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Table 38: Errors when parsing immutable files at link time.
Message
ID

Description

0 Duplicated ID in immutable files. Each immutable object should have a unique ID in the SOAR
image.

1 An immutable file refers to an unknown field of an object.
2 Tried to assign the same object field twice.
3 All immutable object fields should be defined in the immutable file description.
4 The assigned value does not match the expected Java type.
5 An immutable object refers to an unknown ID.
6 The length of the immutable object does not match the length of the assigned object.
7 The type defined in the file doesn’t match the Java expected type.
8 Generic error while parsing an immutable file.
9 Cycle detected in an alias definition.
10 An immutable object is an instance of an abstract class or an interface.
11 Unknown XML attribute in an immutable file.
12 A mandatory XML attribute is missing.
13 The value is not a valid Java literal.
14 Alias already exists.

SNI

The following error messages are issued at SOAR time and not at runtime.

Table 39: [SNI] Link Time Error Messages.
Message ID Description
363 Argument cannot be a reference.
364 Argument can only be from a base type array.
365 Return type must be a base type.
366 Methodmust be a static method.

SP Compiler
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Options

Table 40: Shielded Plug Compiler Options.
Option name Description

-verbose[e...e]
Extra messages are printed out to the console according to the number of ‘e’.

-descriptionFile
file

XML Shielded Plug description file. Multiple files allowed.

-waitingTaskLimit
value

Maximum number of task/threads that can wait on a block: a number between 0 and
7. -1 is for no limit; 8 is for unspecified.

-immutable
When specified, only immutable Shielded Plugs can be compiled.

-output dir
Output directory. Default is the current directory.

-outputName name
Output name for the Shielded Plug layout description. Default is “shielded_plug”.

-endianness name
Either “little” or “big”. Default is “little”.

-outputArchitecture
value

Output ELF architecture. Only “ELF” architecture is available.

-rwBlockHeaderSize
value

Read/Write header file value.

-genIdsC
When specified, generate a C header file with block ID constants.

-cOutputDir dir
Output directory of C header files. Default is the current directory.

-cConstantsPrefix
prefix

C constants name prefix for block IDs.

-genIdsJava
When specified, generate Java interfaces file with block ID constants.

-jOutputDir dir
Output directory of Java interfaces files. Default is the current directory.

-jPackage name
The name of the package for Java interfaces.

Error Messages

Table 41: Shielded Plug Compiler Error Messages.
Message ID Description
0 Internal limits reached.
1 Invalid endianness.
2 Invalid output architecture.
3 Error while reading / writing files.
4 Missing a mandatory option.
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NLS Immutables Creator

Table 42: NLS Immutables Creator Errors Messages
ID Type Description
1 Error Error reading the nls list file: invalid path, input/output error, etc.
2 Error Error reading the nls list file: The file contents are invalid.
3 Error Specified class is not an interface.
4 Error Invalid message ID. Must be greater than or equal to 1.
5 Error Duplicate ID. Both messages use the samemessage ID.
6 Error Specified interface does not exist.
7 Error Specified message constant is not visible (must be public).
8 Error Specified message constant is not an integer.
9 Error No locale file is defined for the specified header.
10 Error IO error: Cannot create the output file.
11 Warning Missing message value.
12 Warning There is a gap (or gaps) in messages constants.
13 Warning Specified property does not denote a message.
14 Warning Invalid properties header file. File is ignored.
15 Warning Nomessage is defined for the specified header.
16 Warning Invalid property.

MicroUI Static Initializer

Inputs

The XML file used as input by theMicroUI Static Initialization Toolmay contain tags related to the Input component
as described below.

Listing 11: Event Generators Description

<eventgenerators>
<!-- Generic Event Generators -->

<eventgenerator name="GENERIC" class="foo.bar.Zork">
<property name="PROP1" value="3"/>
<property name="PROP2" value="aaa"/>

</eventgenerator>

<!-- Predefined Event Generators -->
<command name="COMMANDS"/>
<buttons name="BUTTONS" extended="3"/>
<buttons name="JOYSTICK" extended="5"/>
<pointer name="POINTER" width="1200" height="1200"/>
<touch name="TOUCH" display="DISPLAY"/>
<states name="STATES" numbers="NUMBERS" values="VALUES"/>

</eventgenerators>

<array name="NUMBERS">
<elem value="3"/>
<elem value="2"/>
<elem value="5"/>

</array>

(continues on next page)
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(continued from previous page)

<array name="VALUES">
<elem value="2"/>
<elem value="0"/>
<elem value="1"/>

</array>

Table 43: Event Generators Static Definition
Tag Attributes Description

eventgenerators
The list of event generators.

priority Optional. An integer value. Defines the internal display thread priority. De-
fault value is 5.

eventgenerator
Describes a generic event generator. See also Generic Event Generators.

name The logical name.
class Theevent generator class (must extend the ej.microui.event.generator.

GenericEventGenerator class). This class must be available in the MicroEJ
Application classpath.

listener Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified the listener is the default display.

property
A generic event generator property. The generic event generator will receive
this property at startup, via the method setProperty .

name The property key.
value The property value.

command
The default event generator Command .

name The logical name.
listener Optional. Default listener’s logical name. Only a display is a valid listener. If

no listener is specified, then the listener is the default display.

buttons
The default event generator Buttons .

name The logical name.
extended Optional. An integer value. Defines the number of buttonswhich support the

MicroUI extended features (elapsed time, click and double-click).
listener Optional. Default listener’s logical name. Only a display is a valid listener. If

no listener is specified, then the listener is the default display.

pointer
The default event generator Pointer .

name The logical name.
width An integer value. Defines the pointer area width.
height An integer value. Defines the pointer area heigth.
extended Optional. An integer value. Defines the number of pointer buttons (right

click, le� click, etc.) which support the MicroUI extended features (elapsed
time, click and double-click).

listener Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.

touch
The default event generator Touch .

name The logical name.
display Logical name of the Display with which the touch is associated.
listener Optional. Default listener’s logical name. Only a display is a valid listener. If

no listener is specified, then the listener is the default display.

states
An event generator that manages a group of state machines.
The state of a machine is changed by sending an event using
LLUI_INPUT_sendStateEvent .

name The logical name.
Continued on next page
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Table 43 – continued from previous page
Tag Attributes Description

numbers The logical name of the array which defines the number of state machines
for this States generator, and their range of state values. The IDs of the state
machines start at 0. The number of state machines managed by the States
generator is equal to the size of the numbers array, and the value of each
entry in the array is the number of di�erent values supported for that state
machine. State machine values for state machine i can be in the range 0 to
numbers[i] -1.

values Optional. The logical name of the array which defines the initial state values
of the state machines for this States generator. The values array must be
the samesize as the numbers array. If initial state values are specifiedusing a
values array, then the LLUI_INPUT_IMPL_getInitialStateValue function
is not called; otherwise that function is used to establish the initial values1

listener Optional. Default listener’s logical name. Only a display is a valid listener. If
no listener is specified, then the listener is the default display.

array An array of values.
name The logical name.

elem
A value.

value An integer value.

Display

The display component augments the static initialization file with:

• The configuration of each display.

• Fonts that are implicitly embedded within the application (also called system fonts). Applications can also
embed their own fonts.

<display name="DISPLAY"/>

<fonts>
<font file="resources\fonts\myfont.ejf">

<range name="LATIN" sections="0-2"/>
<customrange start="0x21" end="0x3f"/>

</font>
<font file="C:\data\myfont.ejf"/>

</fonts>

1 Exception: When using MicroEJ Platform, where there is no equivalent to the LLUI_INPUT_IMPL_getInitialStateValue function. If no
values array is provided, and the MicroEJ Platform is being used, all state machines take 0 as their initial state value.
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Table 44: Display Static Initialization XML Tags Definition
Tag Attributes Description

display
The display element describes one display.

name
The logical name of the display.

priority
Deprecated. This value is not taken in consideration. UseMicroEj application
launcher option instead.

default
Deprecated. This value is not taken in consideration.

fonts
The list of system fonts. The system fonts are available for all displays.

font
A system font.

file
The font file path. The path may be absolute or relative to the XML file.

range A font generic range.

name
The generic range name ( LATIN , HAN , etc.)

sections
Optional. Defines one or several sub parts of the generic range.
“1”: add only part 1 of the range
“1-5”: add parts 1 to 5
“1,5”: add parts 1 and 5
These combinations are allowed:
“1,5,6-8” add parts 1, 5, and 6 through 8
By default, all range parts are embedded.

customrange
A font-specific range.

start
UTF16 value of the very first character to embed.

end
UTF16 value of the very last character to embed.

Front Panel

FP File

XML Schema

<?xml version="1.0"?>
<frontpanel

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="https://developer.microej.com"
xsi:schemaLocation="https://developer.microej.com .widget.xsd">

<device name="example" skin="example-device.png">
<ej.fp.widget.[type] x="22" y="51" [widget-attributes]/>
<ej.fp.widget.[type] x="30" y="125" [widget-attributes]/>
<!-- ... -->

</device>
</frontpanel>
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File Specification

Table 45: FP File Specification
Tag Attributes Description

frontpanel
The root element.

xmlns:xsi
Invariant tag1

xmlns
Invariant tag2

xsi:schemaLocation
Invariant tag3

device
The device’s root element.

name
The device’s logical name.

skin
Refers to a PNG file which defines the device background.

ej.fp.widget.xxx
Defines the widget to use. Refer to the widget documentation.

label
All widget should provide this identifier. Sometimes it is used
as string, sometimes as integer

x
The widget x-coordinate.

y
The widget y-coordinate.

HIL Engine

Below are the HIL Engine options:

Table 46: HIL Engine Options
Option name Description

-verbose[e....e]
Extra messages are printed out to the console (add extra e to get more messages).

-ip <address>
MicroEJ Simulator connection IP address (A.B.C.D). By default, set to localhost.

-port <port>
MicroEJ Simulator connection port. By default, set to 8001.

-connectTimeout
<timeout>

timeout in s for MicroEJ Simulator connections. By default, set to 10 seconds.

-excludes
<name[sep]name>

Types that will be excluded from the HIL Engine class resolution provided mocks. By
default, no types are excluded.

-mocks
<name[sep]name>

Mocks are either .jar file or .class files.

Heap Dumping

XML Schema

Below is the XML schema for heap dumps.
1 Must be “ http://www.w3.org/2001/XMLSchema-instance ”
2 Must be “ https://developer.microej.com ”
3 Must be “ https://developer.microej.com .widget.xsd ”
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Table 47: XML Schema for Heap Dumps

<?xml version='1.0' encoding='UTF-8'?>
<!--

Schema

Copyright 2012 IS2T. All rights reserved.

IS2T PROPRIETARY/CONFIDENTIAL. Use is subject to license terms.
-->

<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema">
<!-- root element: heap -->
<xs:element name="heap">

<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">

<xs:element ref="class"/>
<xs:element ref="object"/>
<xs:element ref="array"/>
<xs:element ref="stringLiteral"/>

</xs:choice>
</xs:complexType>

</xs:element>

<!-- class element -->
<xs:element name="class">

<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">

<xs:element ref="field"/>
</xs:choice>
<xs:attribute name="name" type="xs:string" use = "required"/>
<xs:attribute name="id" type="xs:string" use = "required"/>
<xs:attribute name="superclass" type="xs:string"/>

</xs:complexType>
</xs:element>

<!-- object element-->
<xs:element name="object">

<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">

<xs:element ref="field"/>
</xs:choice>
<xs:attribute name="id" type="xs:string" use = "required"/>
<xs:attribute name="class" type="xs:string" use = "required"/>
<xs:attribute name="createdAt" type="xs:string" use = "optional"/>
<xs:attribute name="createdInThread" type="xs:string" use = "optional"/>
<xs:attribute name="createdInMethod" type="xs:string"/>
<xs:attribute name="tag" type="xs:string" use = "required"/>

</xs:complexType>
</xs:element>

Continued on next page
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Table 47 – continued from previous page

<!-- array element-->
<xs:element name="array" type = "arrayTypeWithAttribute"/>
<!-- stringLiteral element-->
<xs:element name="stringLiteral">

<xs:complexType>
<xs:sequence>

<xs:element minOccurs ="4" maxOccurs="4" ref="field "/>
</xs:sequence>
<xs:attribute name="id" type="xs:string" use = "required"/>
<xs:attribute name="class" type="xs:string" use = "required"/>

</xs:complexType>
</xs:element>

<!-- field element: child of class, object and stringLiteral-->
<xs:element name="field">

<xs:complexType>
<xs:attribute name="name" type="xs:string" use = "required"/>
<xs:attribute name="id" type="xs:string" use = "optional"/>
<xs:attribute name="value" type="xs:string" use = "optional"/>
<xs:attribute name="type" type="xs:string" use = "optional"/>

</xs:complexType>
</xs:element>

<xs:simpleType name = "arrayType">
<xs:list itemType="xs:integer"/>

</xs:simpleType>

<!-- complex type "arrayTypeWithAttribute". type of array element-->
<xs:complexType name = "arrayTypeWithAttribute">

<xs:simpleContent>
<xs:extension base="arrayType">

<xs:attribute name="id" type="xs:string" use = "required"/>
<xs:attribute name="class" type="xs:string" use = "required"/>
<xs:attribute name="createdAt" type="xs:string" use = "optional"/>
<xs:attribute name="createdInThread" type="xs:string" use = "optional"/>
<xs:attribute name="createdInMethod" type="xs:string" use = "optional"/>
<xs:attribute name="length" type="xs:string" use = "required"/>
<xs:attribute name="elementsType" type="xs:string" use = "optional"/>
<xs:attribute name="type" type="xs:string" use = "optional"/>

</xs:extension>
</xs:simpleContent>

</xs:complexType>

</xs:schema>

File Specification

Types referenced in heapdumps are represented in the internal classfile format (Internal classfile Format for Types).
Fully qualified names are names separated by the / separator (For example, a/b/C ).
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Listing 12: Internal classfile Format for Types

Type = <BaseType> | <ClassType> | <ArrayType>
BaseType: B(byte), C(char), D(double), F(float), I(int), J(long), S(short), Z(boolean),
ClassType: L<ClassName>;
ArrayType: [<Type>

Tags used in the heap dumps are described in the table below.

Table 48: Tag Descriptions
Tags Attributes Description

heap
The root element.

class
Element that references a Java class.

name Class type ( <ClassType> )

id
Unique identifier of the class.

superclass
Identifier of the superclass of this class.

object
Element that references a Java object.

id
Unique identifier of this object.

class
Fully qualified name of the class of this object.

array Element that references a Java array.

id
Unique identifier of this array.

class
Fully qualified name of the class of this array.

elementsType
Type of the elements of this array.

length
Array length.

stringLiteral
Element that references a java.lang.String literal.

id
Unique identifier of this object.

class
Id of java.lang.String class.

field
Element that references the field of an object or a class.

name Name of this field.

id
Object or Array identifier, if it holds a reference.

type
Type of this field, if it holds a base type.

value
Value of this field, if it holds a base type.

4.21.4 Architectures MCU / Compiler

Principle

The MicroEJ C libraries have been built for a specific processor (a specific MCU architecture) with a specific C com-
piler. The third-party linkermustmake sure to link C libraries compatible with the MicroEJ C libraries. This chapter
details the compiler version, flags and options used to build MicroEJ C libraries for each processor.

Some processors include an optional floating point unit (FPU). This FPU is single precision (32 bits) and is compli-
ant with IEEE 754 standard. It can be disabled when not in use, thus reducing power consumption. There are two
steps to use the FPU in an application. The first step is to tell the compiler and the linker that the microcontroller
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has an FPUavailable so that theywill produce compatible binary code. The second step is to enable the FPUduring
execution. This is done by writing to CPAR in the SystemInit() function. Even if there is an FPU in the proces-
sor, the linker may still need to use runtime library functions to deal with advanced operations. A program may
also define calculation functions with floating numbers, either as parameters or return values. There are several
Application Binary Interfaces (ABI) to handle floating point calculations. Hence, most compilers provide options to
select one of these ABIs. This will a�ect how parameters are passed between caller functions and callee functions,
and whether the FPU is used or not. There are three ABIs:

• So� ABI without FPU hardware. Values are passed via integer registers.

• So�ABIwith FPUhardware. The FPU is accesseddirectly for simple operations, butwhena function is called,
the integer registers are used.

• Hard ABI. The FPU is accessed directly for simple operations, and FPU-specific registers are used when a
function is called, for both parameters and the return value.

It is important to note that code compiled with a particular ABI might not be compatible with code compiled with
another ABI. MicroEJ modules, including the MicroEJ Core Engine, use the hard ABI.

Supported MicroEJ Core Engine Capabilities by Architecture Matrix

The following table lists the supported MicroEJ Core Engine capabilities by MicroEJ Architectures.

Table 49: Supported MicroEJ Core Engine Capabilities by MicroEJ Ar-
chitecture Matrix

MicroEJ Core Engine Architectures Capabilities
MCU Compiler Single application Tiny application Multi applications
ARM Cortex-M0 GCC YES YES NO
ARM Cortex-M4 IAR Embedded Workbench

for ARM
YES YES YES

ARM Cortex-M4 GCC YES NO YES
ARM Cortex-M4 Keil uVision YES NO YES
ARM Cortex-M7 IAR Embedded Workbench

for ARM
YES NO YES

ARM Cortex-M7 GCC YES NO YES
ARM Cortex-M7 Keil uVision YES NO YES
ESP32 ESP-IDF YES NO YES

ARM Cortex-M0

Table 50: ARM Cortex-M0 Compilers
Compiler Version Flags and Options Module
GCC 4.8

-mabi=aapcs -mcpu=cortex-m0 -mlittle-endian -mthumb
flopi0G22
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ARM Cortex-M4

Table 51: ARM Cortex-M4 Compilers
Compiler Version Flags and Options Module
Keil uVi-
sion

5.18.0.0
--cpu Cortex-M4.fp --apcs=/hardfp --fpmode=ieee_no_fenv

flopi4A20

GCC 4.8
-mabi=aapcs -mcpu=cortex-m4 -mlittle-endian
-mfpu=fpv4-sp-d16 -mfloat-abi=hard -mthumb

flopi4G25

IAR Em-
bedded
Work-
bench for
ARM

8.32.1.18631
--cpu Cortex-M4F --fpu VFPv4_sp

flopi4I35

Note: Since MicroEJ 4.0, Cortex-M4 architectures are compiled using hardfp convention call.

ARM Cortex-M7

Table 52: ARM Cortex-M7 Compilers
Compiler Version Flags and Options Module
Keil uVi-
sion

5.18.0.0
--cpu Cortex-M7.fp.sp --apcs=/hardfp
--fpmode=ieee_no_fenv

flopi7A21

GCC 4.8
-mabi=aapcs -mcpu=cortex-m7 -mlittle-endian
-mfpu=fpv5-sp-d16 -mfloat-abi=hard -mthumbb

flopi7G26

IAR Em-
bedded
Work-
bench for
ARM

8.32.1.18631
--cpu Cortex-M7 --fpu VFPv5_sp

flopi7I36
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ESP32

Table 53: Espressif ESP32 Compilers
Compiler Version Flags and Options Module

Name
Module Version

GCC
(ESP-
IDF)

5.2.0
(crosstool-
ng-
1.22.0-
80-
g6c4433a)

-mlongcalls
simikou1 Any

GCC
(ESP-
IDF)

5.2.0
(crosstool-
ng-
1.22.0-
80-
g6c4433a)

-mlongcalls -mfix-esp32-psram-cache-issue
simikou2 Up to 7.13.0 (in-

cluded)

GCC
(ESP-
IDF)

5.2.0
(crosstool-
ng-
1.22.0-
96-
g2852398)

-mlongcalls -mfix-esp32-psram-cache-issue
simikou2

7.13.1 or higher

IAR Linker Specific Options

This section lists options thatmust bepassed to IAR linker for correctly linking theMicroEJobject file ( microejapp.
o ) generated by the SOAR.

--no_range_reservations

MicroEJ SOAR generates ELF absolute symbols to define some link-time options (0 based values). By default, IAR
linker allocates a 1 byte section on the fly, which may cause silent sections placement side e�ects or a section
overlap error whenmultiple symbols are generated with the same absolute value:

Error[Lp023]: absolute placement (in [0x00000000-0x000000db]) overlaps with absolute symbol
[. . . ]

The option --no_range_reservations tells IAR linker to manage an absolute symbol as described by the ELF
specification.

--diag_suppress=Lp029

MicroEJSOARgenerates internal veneers thatmaybe interpreted as illegal codeby IAR linker, causing the following
error:

Error[Lp029]: instruction validation failure in section "C:\xxx\microejapp.o[.text.
__icetea__virtual___1xxx#1126]": nested IT blocks. Code in wrong mode?

The option --diag_suppress=Lp029 tells IAR linker to ignore instructions validation errors.
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4.21.5 Former PlatformMigration

This chapter describes the steps to migrate a former MicroEJ Platform in its latest form described in Platform Cre-
ation chapter.

As a reminder, this new form brings twomain features:

• Both MicroEJ Platform build and dependencies declaration are managed by MicroEJ Module Manager. This
allows a fully automated build and continuous integration.

• The configuration of the target Board Support Package (BSP) has been revisited to support any BSP Connec-
tion cases.

Former MicroEJ Platformswere usually distributed byMicroEJ Corp. in an all-in-one ZIP file also called fullPackag-
ing.

In this document, the MicroEJ Platform for STMicroelectronics STM32F746G-DISCO board will be used as an exam-
ple.

The following figure shows the fullPackaging structure once extracted.

Fig. 59: STM32F746G-DISCO Platform Full Packaging Structure

Themigration steps are:

1. Create aModule Repository to store theMicroEJ Architecture andMicroEJ Packs used by theMicroEJ Platform.

2. Import the Platform Configuration Additions into the Platform Configuration project.

3. Update the Front Panel project configuration.

4. Configure the BSP Connection.

5. Add the Build Script and Run Script.

Create an Architecture Repository

The first step is to create an Architecture Repository. The MicroEJ Architecture and MicroEJ Packs are provided in
the platformArchitecture directory of the fullPackaging package.
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By default, we provide the steps to extend the default MicroEJ SDK settings file configuration with local MicroEJ
Architecture and MicroEJ Packs modules. The following steps can be adapted to custom settings file.

• Create a new empty project named architecture-repository

• Create a new file named ivysettings.xml with the following content and update the included settings file
according to your MicroEJ SDK version (see Determine the MicroEJ Studio/SDK Version)

<?xml version="1.0" encoding="UTF-8"?>
<ivysettings>

<property name="local.repo.url" value="${ivy.settings.dir}" override="false"/>

<!--
Include default settings file for MicroEJ SDK version:
- MICROEJ SDK 5.4.0 or higher: ${user.home}/.microej/microej-ivysettings-5.4.xml
- MICROEJ SDK 5.0.0 to 5.3.1: ${user.home}/.microej/microej-ivysettings-5.xml
- MICROEJ SDK 4.1.x: ${user.home}/.ivy2/microej-ivysettings-4.1.xml

-->
<include file="${user.home}/.microej/microej-ivysettings-5.xml"/>

<settings defaultResolver="ArchitectureResolver"/>

<resolvers>
<chain name="ArchitectureResolver">

<filesystem m2compatible="true">
<artifact pattern="${local.repo.url}/${microej.artifact.pattern}" />
<ivy pattern="${local.repo.url}/${microej.ivy.pattern}" />

</filesystem>
<resolver ref="${microej.default.resolver}"/>

</chain>
</resolvers>

</ivysettings>

• Copy the MicroEJ Architecture file ( .xpf ) into the correct directory following its naming convention).

– Open or extract the MicroEJ Architecture file ( .xpf )

– Open the release.properties file to retrieve the naming convention mapping:

* architecture is the ISA (e.g. CM7 )

* toolchain is the TOOLCHAIN (e.g. CM7hardfp_ARMCC5 )

* name is the UID (e.g. flopi7A21 )

* version is the VERSION (e.g. 7.11.0 )

For example, in the STM32F746G-DISCO Platform, the MicroEJ Architecture file flopi7A21-eval.
xpf shall be copied and renamed to architecture-repository/com/microej/architecture/CM7/
CM7hardfp_ARMCC5/flopi7A21/7.11.0/flopi7A21-7.11.0-eval.xpf .

• Copy theMicroEJ Architecture Specific Packs files ( .xpfp ) into the correct directory followingMicroEJ Nam-
ingConvention (seePack Import)with the exceptionof the Standalonepack that shouldnot be imported (e.g.
named flopi7A21Standalone.xpfp ).

– Open or extract the MicroEJ Architecture Specific Pack ( .xpfp ).

Note: The MicroEJ Architecture Specific Packs have the UID of the MicroEJ Architecture in their name
(e.g. flopi7A21UI.xpfp ) and their release_pack.properties file contains the information of the
MicroEJ Architecture.
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– Open the release_pack.properties file to retrieve the naming convention mapping:

* architecture is the ISA (e.g. CM7 )

* toolchain is the TOOLCHAIN (e.g. CM7hardfp_ARMCC5 )

* name is the UID (e.g. flopi7A21 )

* packName is the NAME (e.g. ui )

* packVersion is the VERSION (e.g. 12.0.1 )

For example, in the STM32F746G-DISCO Platform, the MicroEJ Architecture Specific Pack UI flopi7A21UI.
xpfp shall be copied and renamed to architecture-repository/com/microej/architecture/CM7/
CM7hardfp_ARMCC5/flopi7A21-ui-pack/12.0.1/flopi7A21-ui-pack-12.0.1.xpfp .

• Copy the Legacy MicroEJ Generic Packs ( .xpfp files) into the correct directory following MicroEJ Naming
Convention (see Pack Import).

– Open or extract the MicroEJ Generic Pack ( .xpfp ).

Note: The release_pack.properties of Legacy MicroEJ Generic Packs does not contain information
about MicroEJ Architecture.

– Open the release_pack.properties file:

* packName is the NAME (e.g. fs )

* packVersion is the VERSION (e.g. 4.0.2 )

For example, in the STM32F746G-DISCO Platform, the Legacy MicroEJ Generic Pack FS fs.xpfp shall be
copied and renamed to architecture-repository/com/microej/pack/fs/4.0.2/fs-4.0.2.xpfp .

• Configure MicroEJ Module Manager to use the Architecture Repository:

– Go to Window > Preferences > MicroEJ > Module Manager

– In Module Repository set Settings File: to ${workspace_loc:architecture-repository/

ivysettings.xml} .

– Apply and Close

Here is the layout of the Architecture Repository for STM32F746G-DISCO.
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Fig. 60: Architecture Repository for STM32F746G-DISCO fullPackaging

Install the Platform Configuration Additions

• Rename the file bsp.properties to bsp2.properties (save it for later).

• Install Platform Configuration Additions, by following instructions described at https://
github.com/MicroEJ/PlatformQualificationTools/blob/master/framework/platform/README.rst.
Files within the content folder have to be copied to the -configuration project (e.g.
STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-configuration ).

• Edit the module.properties file and set com.microej.platformbuilder.platform.filename to the
name of the platform configuration file (e.g. STM32F746GDISCO.platform ).

• Fill the module.ivy with the MicroEJ Architecture and MicroEJ Packs dependencies.

Here is the module dependencies declared for the STM32F746G-DISCO Platform.

Listing 13: STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-
configuration/module.ivy

<dependencies>
<!-- MicroEJ Architecture -->
<dependency org="com.microej.architecture.CM7.CM7hardfp_ARMCC5" name="flopi7A21" rev="7.11.0">

<artifact name="flopi7A21" m:classifier="${com.microej.platformbuilder.architecture.usage}" ext="xpf
→˓"/>
</dependency>

(continues on next page)
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(continued from previous page)

<!-- MicroEJ Architecture Specific Packs -->
<dependency org="com.microej.architecture.CM7.CM7hardfp_ARMCC5" name="flopi7A21-ui-pack" rev="12.0.1">

<artifact name="flopi7A21-ui-pack" ext="xpfp"/>
</dependency>
<dependency org="com.microej.architecture.CM7.CM7hardfp_ARMCC5" name="flopi7A21-net-pack" rev="6.1.5">

<artifact name="flopi7A21-net-pack" ext="xpfp"/>
</dependency>

<!-- Legacy MicroEJ Generic Packs -->
<dependency org="com.microej.pack" name="fs" rev="4.0.2">

<artifact name="fs" ext="xpfp"/>
</dependency>
<dependency org="com.microej.pack" name="hal" rev="2.0.1">

<artifact name="hal" ext="xpfp"/>
</dependency>

</dependencies>

Update Front Panel Configuration

• In -configuration/frontpanel/frontpanel.properties set the project.name to the folder name that
contains the frontpanel (e.g. project.name=STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-fp ).

At this state, the MicroEJ Platform is not connected to the BSP yet, but you can check that everything is properly
configured so far by building it:

• Right-click on the -configuration project and select Build Module

• Import the MicroEJ Platform built into the workspace by following instructions available at the end of the
build logs).

At this stage the MicroEJ Platform is built, so you can create a MicroEJ Standalone Application and run it on the
Simulator (see Create a MicroEJ Standalone Application).

Configure BSP Connection

This section explains how to configure a full BSP Connection on the STM32F746G-DISCOPlatform. SeeBSPConnec-
tion for more information.

• Open -configuration/bsp/bsp.properties .

• Comment out and set the following variables:

– root.dir

– microejapp.relative.dir

– microejlib.relative.dir

– microejinc.relative.dir

– microejscript.relative.dir

For example:

# Specify the MicroEJ Application file ('microejapp.o') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejapp.relative.dir=Projects/STM32746G-Discovery/Applications/MicroEJ/platform/lib

(continues on next page)
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(continued from previous page)

# Specify the MicroEJ Platform runtime file ('microejruntime.a') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejlib.relative.dir=Projects/STM32746G-Discovery/Applications/MicroEJ/platform/lib

# Specify MicroEJ Platform header files ('*.h') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejinc.relative.dir=Projects/STM32746G-Discovery/Applications/MicroEJ/platform/inc

# Specify BSP external scripts files ('build.bat' and 'run.bat') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejscript.relative.dir=Projects/STM32746G-Discovery/Applications/MicroEJ/scripts

# Specify the BSP root directory. Can use ${project.parent.dir} which target the parent of␣
→˓platform configuration project
# For example, '${project.parent.dir}/PROJECT-NAME-bsp' specifies a BSP project beside the '-
→˓configuration' project
root.dir=${project.parent.dir}/STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-bsp/

The paths to microejXXX.relative.dir can be inferred by looking at the output.dir value in bsp2.
properties saved earlier. For example on the STM32F746G-DISCOproject, its value is ${workspace}/${project.
prefix}-bsp/Projects/STM32746G-Discovery/Applications/MicroEJ/platform .

• The BSP project path ${workspace}/${project.prefix}-bsp becomes ${project.parent.dir}/
STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-bsp/ .

• Projects/STM32746G-Discovery/Applications/MicroEJ/platform is the path to MicroEJ Application
file, MicroEJ Platform header and runtime files. MicroEJ convention is to put the MicroEJ Application file
andMicroEJ Platform runtime files to platform/lib/ andMicroEJ Platform header files to platform/inc/
.

• Build Script File and Run Script File are PCA-specific and did not exist before. By convention we put them in a
scripts/ directory.

The paths to microejXXX.relative.dir can be also be checked by looking at the C TOOLCHAIN
configuration of the BSP. For example on the STM32F746G-DISCO project, the BSP configuration is lo-
cated at STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-bsp/Projects/STM32746G-Discovery/Applications/
MicroEJ/MDK-ARM/Project.uvprojx .

• In Project > Options for Target ‘standalone’. . . > C/C++ > Include Paths contains ../platform/inc

. This corresponds to the microejinc.relative.dir relative the TOOLCHAIN project’s file.

• In the Project pane, there is a folder MicroEJ/Libs that contains microejruntime.lib and microejapp.
o .

– Right-click on microejruntime.lib > Options for File ‘XXX’. . . . The Path is ../platform/lib/

microejruntime.lib . This corresponds to the microejlib.relative.dir .

– Right-click on microejapp.o > Options for File ‘XXX’. . . . The Path is ../platform/lib/

microejapp.o . This corresponds to the microejapp.relative.dir .

• Rebuild the platform (Right-click on the -configuration project and select Build Module )

At this stage the MicroEJ Platform is connected to the BSP so you can build and program a MicroEJ Firmware (see
Run on the Hardware Device).
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Add Build Script and Run Script

The final stage consists of adding the Build Script, to automate the build a MicroEJ Firmware, and the Run Script,
to automate the program a MicroEJ Firmware onto the device.

The Platform Qualification Tools provides examples of Build Script and Run Script for various C TOOLCHAIN here.

On the STM32F746G-DISCO, the C TOOLCHAIN used is Keil uVision.

• Create the directory pointed by microejscript.relative.dir (e.g.
STM32F746GDISCO-Full-CM7_ARMCC-FreeRTOS-bsp\Projects\STM32746G-Discovery\Applications\MicroEJ\scripts
).

• Copy the example scripts from the Platform Qualification Tools for the C TOOLCHAIN of the BSP (e.g.
PlatformQualificationTools/framework/platform/scripts/KEILuV5/ )

• Configure the scripts. Refer to the documentation in the scripts comments for this step.

• Enable the execution of the build script:

– Go to Run > Run Configurations. . .

– Select the launch configuration

– Go to Configuration > Device > Deploy

– Ensure Execute the MicroEJ build script (build.bat) at a location known by the 3rd-party BSP project.
is checked.

Going further

Now that theMicroEJPlatform is connected to theBSP it can leverage the JavaTest Suites providedby thePlatform
Qualification Tools. See Run a Test Suite on a Device for a step by step explanation on how to do so.
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CHAPTER

FIVE

KERNEL DEVELOPER GUIDE

5.1 Overview

5.1.1 Introduction

The Kernel Developer’s Guide describes how to create a MicroEJ Multi-Sandbox Firmware, i.e. a firmware that can
be extended (statically or dynamically) to run and control the execution of new applications (called Sandboxed
Applications).

The intended audience of this document are java developers and system architects who plan to design and build
their own firmware.

Here is a non-exhaustive list of the activities to be done by Multi-Sandbox Firmware Developers:

• Defining a list of APIs that will be exposed to applications

• Managing lifecycles of applications (deciding when to install, start, stop and uninstall them)

• Integrating applications (called System Applications)

• Defining and applying permissions on system resources (rules & policies)

• Managing connectivity

• Controlling andmonitoring resources

This document takes as prerequisite that a MicroEJ Platform is available for the target device (see Platform De-
veloper Guide). This document also assumes that the reader is familiar with the development and deployment of
MicroEJ Applications (see Application Developer Guide) and specifics of developing Sandboxed Applications (see
Sandboxed Application).

5.1.2 Terms and Definitions

A System Application is a Sandboxed Application that is linked into a Multi-Sandbox Firmware.

AMulti-Sandbox Platform is a Platform with the Multi Sandbox capability of the MicroEJ Core Engine enabled (see
the chapter Multi-Sandbox of the Platform Developer Guide). A Multi-Sandbox Firmware can only be built with a
Multi-Sandbox Platform.

AMono-Sandbox Firmware is produced by building and linking a Standalone Application with a Platform.

A Virtual Device is the Multi-Sandbox Firmware counterpart for developing a Sandboxed Application in MicroEJ
Studio. It provides the firmware functional simulation part. Usually it also provides a mean to directly deploy a
Sandboxed Application on the target device running a Multi-Sandbox Firmware (this is called Local Deployment).
In case of dynamic application deployment, the Virtual Device must be published on MicroEJ Forge instance in
order to execute an internal batch applications build for this device.
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5.1.3 Overall Architecture

Fig. 1: Firmware Boundary Overview
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Fig. 2: Firmware Input and Output Artifacts

5.1.4 Multi-Sandbox Build Flow

Firmware Build Flow

The Firmware build is composed of two phases:

• the build of the Kernel,

• the build of Sandboxed Application which is linked and append to the Firmware as a System Application
(repeatable).
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Fig. 3: Firmware Build Flow (Kernel + System Applications)
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Virtual Device Build Flow

TheVirtualDevice is automatically built at the same time than theFirmware (seeMulti-SandboxFirmwareCreation).

The Virtual Device builder performs the following steps:

• Remove the embedded part of the platform (compiler, linker and runtime).

• Append Add-On Libraries and System Applications into the runtime classpath. (See Ivy Configurations) for
specifying the dependencies).

• Turn the Platform (MicroEJ SDK) license to Virtual Device (MicroEJ Studio) license so that it can be freely
distributed.

• Generate the Runtime Environment from the Kernel APIs.

Fig. 4: Virtual Device Build Flow

5.1.5 Firmware Implementation Libraries

Firmware implementations must cover the following topics:

• The firmware’s kernel entry point implementation, that deals with configuring the di�erent policies, regis-
tering kernel services and converters, and starting applications.

• The storage infrastructure implementation: mapping the Storage service on an actual data storage imple-
mentation. There are multiple implementations of the data storage, provided in di�erent artifacts that will
be detailed in dedicated sections.

• The applicationsmanagement infrastructure: how application code is stored inmemory and how the lifecy-
cle of the code is implemented. Again, this has multiple alternative implementations, and the right module
must be selected at build time to cover the specific firmware needs.

• The simulation support: how the Virtual Device implementation reflects the firmware implementation, with
the help of specific artifacts.

• The Kernel API definition: not all the classes andmethods used to implement the firmware’s kernel are actu-
ally exposed to the applications. There are some artifacts available that expose some of the libraries to the
applications, these ones can be picked when the firmware is assembled.
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• The Kernel types conversion and other KF-related utilities: Kernel types instances owned by one application
can be transferred to another application through a Shared Interface. For that to be possible, a conversion
proxy must be registered for this kernel type.

• Tools libraries: tools that plug into MicroEJ Studio or SDK, extending them with feature that are specific to
the firmware, like deployment of an application, a management console, . . .

• System Applications: pre-built applications that can be embedded as System Apps into a firmware. Some of
them are user-land counter parts of the Kernel, implementing the application lifecycle for the firmware’s ap-
plication framework (e.g. theWadapps Framework). These “Kernel SystemApplications” rely on a dedicated
set of interfaces to interact with the Kernel, this interface being defined in a dedicated module.

5.2 Kernel & Features Specification

MicroEJMulti-Sandboxing is based on the Kernel & Features semantic (KF). It allows an application code to be split
between multiples parts: the main application, called the Kernel and zero or more sandboxed applications called
Features.

The Kernel part is mandatory and is assumed to be reliable, trusted and cannot be modified. If there is only one
application, i.e only one main entry point that the system starts with, then this application is considered as the
Kernel and called a Standalone Application. Even if there are more applications in the platform, there is still only
one entry point. This entry point is the Kernel. Applications (downloaded or preinstalled) are “code extensions”
(called “Features”), that are called by the Kernel. These Features are fully controlled by the Kernel: they can be
installed, started, stopped and uninstalled at any time independently of the system state (particularly, a Feature
never depends on an other Feature to be stopped).

The complete [KF] specification is available at http://www.e-s-r.net/download/specification/ESR-SPE-0020-KF-1.
4-F.pdf

The full API documentation of the Kernel & Features Foundation Library is available at https://repository.microej.
com/javadoc/microej_5.x/apis/ej/kf/package-summary.html.

5.3 Getting Started

5.3.1 Online Getting Started

The MicroEJ Multi-Sandbox Firmware Getting Started is available on MicroEJ GitHub repository, at https://github.
com/MicroEJ/Example-MinimalMultiAppFirmware.

The file README.md provides a step by step guide to produce aminimal firmware on an evaluation board onwhich
new applications can be dynamically deployed through a serial or a TCP/IP connection.

5.3.2 MicroEJ Demo VEE Flavors

This set of APIs is proposed as examples of industrial or commercial typical products APIs.

What is a MicroEJ Demo Runtime Environment?

A MicroEJ Runtime Environment defines a set of MicroEJ APIs exposed to a MicroEJ Sandboxed Application. Here
are the default runtimes provided for evaluation by MicroEJ. Any runtime can be customized with MicroEJ SDK for
a specific product.
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MicroEJ Demo Run-
time Environment

EDC/B-
ON/KF

COMP/WADAPPSMI-
CROUI/MWT

LEDS/BUTTONSNET/CONNECT/SSLBLE HAL ECOM/COMM

MicroEJ-Developer
MicroEJ-UI
MicroEJ-Headless
MicroEJ-BLE

You can find below what are the di�erent APIs included in the Runtime Environment:

API Purpose
EDC Core APIs for the execution.
B-ON Memory Usage control and Sequences start-up.
KF Required by the implementation of Shared Interfaces, an inter-application com-

munication process.
COMP or COMPONENTS Lightweight Services Framework.
WADAPPS Wadapps Application Framework.
MICROUI/MWT Main UI library for MicroEJ and the Widgets framework based on MicroUI.
LEDS or MICROUI-LEDS UI library specific to LEDs.
BUTTONS or MICROUI-
BUTTONS

UI library specfic to buttons.

NET Socket (TCP/UDP) library.
CONNECT or CONNECTIV-
ITY

Network connectivity detection library.

SSL Secure Socket Layer.
BLE Bluetooth Low Energy support.
HAL GPIO Access (digital and analog)
ECOM Device access framework.
COMM or ECOM-COMM Serial ports support for the ECOM.

What is a MicroEJ Demo Flavor?

A MicroEJ Demo Flavor is a composition of a set of runtime services, System Applications and a given MicroEJ
Runtime Environment. Any flavor can be customized with MicroEJ SDK for a specific product.

MicroEJ
Demo
Flavor

MicroEJ Runtime
Environment

Services System Apps UI System Apps

Man-
age-
ment

App-
Metadata-
Storage

CommandServer-
Socket

NTP About Ap-
pList

Forge
Connect

Green MicroEJ-
Developer

Blue MicroEJ-
Developer

Red MicroEJ-UI
Purple MicroEJ-Headless
Black MicroEJ-BLE

You can find below what are the di�erent System Apps included in the Flavor:
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System Apps Purpose
Management Contains the implementation of Wadapps framework services, required by all VEE.
App-Metadata-
Storage

Stores some Applications Metadata (icons, descriptions) so that it can be locally used by a
MicroEJ Companion.

CommandServer-
Socket

Allows the deployment of MicroEJ Applications through a local network connection.

NTP Synchronizes the time of the device.
About Displays version information about the VEE.
AppList An application browser, can be used to start, stop or uninstall the applications, or display

their descriptions and version information.
Forge Connect Displays a desktop that allows themanagement ofMicroEJ Applications using a connection

to MICROEJ FORGE.
Settings Displays the VEE parameters and settings.

5.4 Multi-Sandbox Firmware Creation

This chapter requires a minimum understanding ofMicroEJ Module Manager andModule Natures.

5.4.1 Create a new Firmware Project

First create a newmodule project using the build-firmware-multiapp skeleton.

A new project is generated into the workspace:
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5.4.2 Configure a Platform

Before building the firmware, a target platform must be configured. The easiest way to do it is to copy a platform
file into the myfirmware > dropins folder. Such file usually ends with .jpf . For other ways to setup the input
platform to build a firmware see Platform Selection.

5.4.3 Build the Firmware and Virtual Device

In the Package Explorer, right-click on the project and select Build Module . The build of the Firmware and Virtual
Device may take several minutes. When the build is succeed, the folder myfirmware > target~ > artifacts
contains the firmware output artifacts (see Firmware Input and Output Artifacts) :

• mymodule.out : The Firmware Binary to be programmed on device.

• mymodule.kpk : The Firmware Package to be imported in a MicroEJ Forge instance.

• mymodule.vde : The Virtual Device to be imported in MicroEJ Studio.

• mymodule-workingEnv.zip : This file contains all files produced by the build phasis (intermediate, debug
and report files).
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5.4.4 Define a Runtime Environment

A Multi-Sandbox Firmware must define a runtime environment which is the set of classes, methods and fields all
applications are allowed to use. In most of the cases the runtime environment is an aggregation of several Kernel
APIs.

Note: According to the :ref‘Kernel and Features specification <chapter_KF>‘, no API is open by default to Sand-
boxed Applications.

Specify Kernel APIs

A Kernel API module is added as a dependency with the configuration kernelapi->default .

<dependency org="com.microej.kernelapi" name="edc" rev="1.0.6" conf="kernelapi->default"/>

The build options runtime.api.name and runtime.api.version must be set unless declaring a dependency to
a Runtime API module.

Create a Runtime API Module

A Runtime API module is a module that aggregates a set of Kernel APIs modules.

It is be built withmodule project build-runtime-api skeleton.

<info organisation="myorg" module="mymodule" status="integration" revision="1.0.0">
<ea:build organisation="com.is2t.easyant.buildtypes" module="build-runtime-api" revision="2.+">
<ea:property name="runtime.api.name" value="RUNTIME"/>
<ea:property name="runtime.api.version" value="1.0"/>
</ea:build>

</info>

The build option runtime.api.name defines the name of the runtime environment (required). The build option
runtime.api.version defines its version. If not set, it takes the declared module version.

For example, the following dependencies declare a runtime environment that aggregates all classes, methods and
fields defined by edc,kf,bon,wadapps,components Kernel APIs modules.

<dependencies>
<dependency org="com.microej.kernelapi" name="edc" rev="1.0.4"/>
<dependency org="com.microej.kernelapi" name="kf" rev="2.0.1"/>
<dependency org="com.microej.kernelapi" name="bon" rev="1.0.4"/>
<dependency org="com.microej.kernelapi" name="wadapps" rev="1.2.2"/>
<dependency org="com.microej.kernelapi" name="components" rev="1.2.2"/>

</dependencies>

5.4.5 Add System Applications

A MicroEJ Sandboxed Application can be dynamically installed using Kernel.install() or can be directly linked into
the Firmware binary at built-time. In this case, it is called a System Application.

The user can specify the System Applications in two di�erent ways:

• Set the property build-systemapps.dropins.dir to a folder which contains System Applications ( .wpk
files).
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• Add a new dependency for each System Application with the configuration systemapp->application :

<dependency org="com.microej.app.wadapps" name="management" rev="2.2.2" conf="systemapp->
→˓application"/>

All System Applications are also included to the Virtual Device. If a System Application must only be linked to the
Firmware, declare the dependency with the configuration systemapp-fw instead of systemapp :

<dependency org="com.microej.app.wadapps" name="management" rev="2.2.2" conf="systemapp-fw->application
→˓"/>

5.4.6 Build Firmware using Meta Build

A Meta build project can be useful to automatically build Sandboxed Applications that will be linked as System
Application in the Firmware.

The following figure shows the overall build flow (Sandboxed Application build prior to the Firmware build):

Fig. 5: Firmware Build Flow using MicroEJ Module Manager
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5.4.7 Build Firmware using MicroEJ Launches

It is still possible to build the Firmware usingMicroEJ Launch rather than the regular module build. This speeds-up
the build time thanks to MicroEJ Module Manager workspace resolution and Eclipse incremental compilation.

• Import the Firmware project and all System Application projects in the same workspace,

• Prepare a MicroEJ Application for the Kernel as a regular Standalone Application,

• Prepare a MicroEJ Application launch for each System Application using Build Dynamic Feature settings,

• Prepare a MicroEJ Tool launch for each System Application using the Firmware Linker settings.

The following figure shows the overall build flow:
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Fig. 6: Firmware Build Flow using MicroEJ Launches
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5.4.8 Advanced

MicroEJ Firmware module.ivy

The following section describes module description file ( module.ivy ) generated by the
build-firmware-multiapp skeleton.

Ivy info

<info organisation="org" module="module" status="integration"
revision="1.0.0">

<ea:build organisation="com.is2t.easyant.buildtypes" module="build-firmware-multiapp" revision="2.+
→˓"/>

<ea:property name="application.main.class" value="org.Main" />
<ea:property name="runtime.api.name" value="RUNTIME" />
<ea:property name="runtime.api.version" value="0.1.0" />

</info>

The property application.main.class is set to the fully qualified name of the main java class. The firmware
generated from the skeleton defines its own runtime environment by using ivy dependencies on several kernel
API instead of relying on a runtime environmentmodule. As consequence, the runtime.api.name and runtime.
api.version properties are specified in the firmware project itself.

Ivy Configurations

The build-firmware-multiapp build type requires the following configurations, used to specify thedi�erent kind
of firmware inputs (see Firmware Input and Output Artifacts) as Ivy dependencies.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default" visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="platform" visibility="public"/>
<conf name="vdruntime" visibility="public"/>
<conf name="kernelapi" visibility="private"/>
<conf name="systemapp" visibility="private"/>
<conf name="systemapp-fw" visibility="private"/>

</configurations>

The following table lists the di�erent configuration mapping usage where a dependency line is declared:

<dependency org="..." name="..." rev="..." conf="[Configuration Mapping]"/>
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Table 1: ConfigurationsMapping for build-firmware-multiapp Build
Type

Configuration Mapping Dependency Kind Usage

provided->provided
Foundation Library (
JAR )

Expected to be provided by the platform. (e.g. ej.api.
* module)

default->default
Add-On Library ( JAR
)

Embedded in the firmware only, not in the Virtual De-
vice

vdruntime->default
Add-On Library ( JAR
)

Embedded in the Virtual Device only, not in the
firmware

default->default;
vdruntime->default

Add-On Library ( JAR
)

Embedded in both the firmware and the Virtual Device

platform->platformDev
Platform ( JPF ) Platform dependency used to build the firmware and

the Virtual Device. There are other ways to select the
platform (see Platform Selection)

kernelapi->default
Runtime Environ-
ment ( JAR )

See Define a Runtime Environment

systemapp->application
Application ( WPK ) Linked into both the firmware and the Virtual Device as

System Application. There are other ways to select Sys-
tem Applications (see Add System Applications)

systemapp-fw->application
Application ( WPK ) Linked into the firmware only as System Application.

Example of minimal firmware dependencies.

The followingexample firmware containsoneSystemApp (management ), anddefines anAPI that contains all types,
methods, and fields from edc,kf,wadapps,components .

<dependencies>
<dependency org="ej.api" name="edc" rev="1.2.0" conf="provided" />
<dependency org="ej.api" name="kf" rev="1.4.0" conf="provided" />
<dependency org="ej.library.wadapps" name="framework" rev="1.11.0" />
<dependency org="com.microej.library.wadapps.kernel" name="common-impl" rev="3.0.0" />
<dependency org="com.microej.library.wadapps" name="admin-kf-default" rev="1.2.0" />
<!-- Runtime API (set of Kernel API files) -->
<dependency org="com.microej.kernelapi" name="edc" rev="1.0.0" conf="kernelapi->default"/>
<dependency org="com.microej.kernelapi" name="kf" rev="2.0.0" conf="kernelapi->default"/>
<dependency org="com.microej.kernelapi" name="wadapps" rev="1.0.0" conf="kernelapi->default"/>
<dependency org="com.microej.kernelapi" name="components" rev="1.0.0" conf="kernelapi->default"/>
<!-- System Applications -->
<dependency org="com.microej.app.wadapps" name="management" rev="2.2.2" conf="systemapp->application

→˓"/>
</dependencies>

Build only a Firmware

Set the property skip.build.virtual.device

<ea:property name="skip.build.virtual.device" value="SET" />

Build only a Virtual Device

Set the property virtual.device.sim.only
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<ea:property name="virtual.device.sim.only" value="SET" />

Build only a Virtual Device with a pre-existing Firmware

Copy/Paste the .kpk file into the folder dropins

5.5 Writing Kernel APIs

This section lists di�erent ways to help to write kernel.api files.

5.5.1 Default Kernel APIs Derivation

MicroEJ provides predefined kernel API files for the most common libraries provided by a Kernel. These files are
packaged as MicroEJ modules under the com/microej/kernelapi organisation.

The packaged file kernel.api can be extracted from the JAR file and edited in order to keep only desired types,
methods and fields.

5.5.2 Build a Kernel API Module

• First create a newmodule project using the microej-kernelapi skeleton.

• Create the kernel.api file into the src folder.

• Right-click on the project and select Build Module .

5.5.3 Kernel API Generator

MicroEJ Kernel API Generator is a tool that help to generate a kernel.api file based on a Java classpath.

In MicroEJ SDK, create a new MicroEJ Tool launch, Run > Run Configurations > MicroEJ Tool , choose your

Platform, select Kernel API Generator for the Settings options, and don’t forget to set the output folder.
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Define the classpath to use in the Configuration tab, and Press Run . A kernel.api file is generated in the
output folder and it contains all classes, methods and fields found in the given classpath.

Category: Kernel API Generator
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Group: Classpath

Option(list):

Option Name: kernel.api.generator.classpath

Default value: (empty)

Group: Types Filters

Option(text): Includes Patterns

Option Name: kernel.api.generator.includes.patterns

Default value: **/*.class

Description: Comma separated list of ANT Patterns for types to include.

Option(text): Excludes Patterns

Option Name: kernel.api.generator.excludes.patterns

Default value: (empty)

Description: Comma separated list of ANT Patterns for types to exclude.

5.6 Communication between Features

Features can communicate together through the use of shared interfaces. This mechanism is described in Shared
Interfaces section.

The shared interfacemechanismallows to transfer an object instance of a Kernel type fromone Feature to an other.
To do that, the Kernel must register a new Kernel type converter.

See the Converter class and Kernel.addConverter() method for more details.

5.7 Multi-Sandbox Enabled Libraries

A Multi-Sandbox enabled library is a Foundation or Add-On Library which can be embedded into the Kernel and
exposed as API. MicroEJ Foundation Libraries provided inMicroEJ SDK are alreadyMulti-Sandbox enabled. A state-
less library - i.e. a library that does not contain any method modifying an internal global state - is Multi-Sandbox
enabled by default.

This section details the Multi-Sandbox semantic that have been added to MicroEJ Foundation Libraries in order to
be Multi-Sandbox enabled.
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5.7.1 MicroUI

Note: This chapter describes the current MicroUI version 3 , provided by UI Pack version 13.0.0 or higher. If you
are using the former MicroUI version 2 (provided by MicroEJ UI Pack version up to 12.1.x ), please refer to this
MicroEJ Documentation Archive.

Physical Display Ownership

The physical display is owned by only one context at a time (the Kernel or one Feature). The following cases may
trigger a physical display owner switch:

• during a call to Display.requestShow(Displayable), Display.requestHide(Displayable) or Dis-
play.requestRender(): a�er the successful permission check, it is assigned to the context owner.

• during a call to MicroUI.callSerially(Runnable): a�er the successful permission check it is assigned to owner
of the Runnable instance.

The physical display switch performs the following actions:

• If a Displayable instance is currently shown on the Display , themethodDisplayable.onHidden() is called,

• All pending events (input events, display flushes, call serially runnable instances) are removed from the dis-
play event serializer,

• System Event Generators handlers are reset to their default EventHandler instance,

• Thepending event created by callingDisplay.callOnFlushCompleted(Runnable) is removed andwill be never
added to the display event serializer.

Warning: The display switch is performed immediately when the current thread is the MicroUI thread itself
(during a MicroUI event such as a MicroUI.callSerially(Runnable)). The caller looses the display and its next
requests during same MicroUI event will throw a new display switch. Caller should call future display owner’s
code (which will ask a display switch) in a dedicated MicroUI.callSerially(Runnable) event.

The call to Display.callOnFlushCompleted(Runnable) has no e�ect when the display is not assigned to the context
owner.

Automatically Reclaimed Resources

Instances of ResourceImage and Font are automatically reclaimed when a Feature is stopped.

5.7.2 BON

Kernel Timer

A Kernel Timer instance can handle TimerTask instances owned by the Kernel or any Features.

It should not be created in clinit code, otherwise youmay have to manually declare explicit clinit dependencies.

Automatically Reclaimed Resources

TimerTask instances are automatically canceled when a Feature is stopped.
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5.7.3 ECOM

The ej.ecom.DeviceManager registry allows to share devices across Features. Instances of ej.ecom.Device that
are registered with a shared interface type are made accessible through a Proxy to all other Features that embed
the same shared interface (or an upper one of the hierarchy).

5.7.4 ECOM-COMM

Instances of ej.ecom.io.CommConnection are automatically reclaimed when a Feature is stopped.

5.7.5 FS

Instances of java.io.FileInputStream , java.io.FileOutputStream are automatically reclaimed when a Fea-
ture is stopped.

5.7.6 NET

Instances of java.net.Socket , java.net.ServerSocket , java.net.DatagramSocket are automatically re-
claimed when a Feature is stopped.

5.7.7 SSL

Instances of javax.net.ssl.SSLSocket are automatically reclaimed when a Feature is stopped.

5.8 Setup a KF Test Suite

A KF test suite can be executed when building a Foundation Library or an Add-On library, and usually extends the
tests written for the default library test suite to verify the behavior of this library when its APIs are exposed by a
Kernel.

A KF test suite is composed of a set of KF tests, each KF test itself is a minimal MicroEJ Multi-Sandbox Firmware
composed of a Kernel and zero or more Features.

5.8.1 Enable the Test Suite

In an existing library project:

• Create the src/test/projects directory,

• Edit the module.ivy and insert the following line within the <ea:build> XML element:

<ea:plugin organisation="com.is2t.easyant.plugins" module="microej-kf-testsuite" revision="+" />

5.8.2 Add a KF Test

A KF test is a structured directory placed in the src/test/projects directory.

• Create a new directory for the KF test
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• Within this directory, create the sub-projects:

– Create a newmodule project for the Kernel using the microej-javalib skeleton,

– Create a newmodule project for the Feature using the application skeleton,

– Create a newmodule project for the Firmware using the firmware-multiapp skeleton.

The names of the project directories are free, however MicroEJ suggests the following naming convention, assum-
ing the KF test directory is [TestName] :

• [TestName]-kernel for the Kernel project,

• [TestName]-app[1..N] for Feature projects,

• [TestName]-firmware for the Firmware project.

The KF Test Suite structure shall be similar to the following figure:
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Fig. 7: KF Test Suite Overall Structure

All the projects will be built automatically in the right order based on their dependencies.
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5.8.3 KF Test Suite Options

It is possible to configure the same options defined by Test Suite Options for the KF test suite, by using the prefix
microej.kf.testsuite.properties instead of microej.testsuite.properties .
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CHAPTER

SIX

TUTORIALS

6.1 Understand how to build a MicroEJ Firmware and its dependencies

A MicroEJ Firmware is built from several input resources and tools. Each component has dependencies and re-
quirements that must be carefully respected in order to build a firmware.

This document describes the components, their dependencies and the process involved in the build of a MicroEJ
Firmware.

Good knowledge of theMicroEJ Glossary is required.

6.1.1 The Components

As depicted in the following image, several resources and tools are used to build a MicroEJ Firmware.
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MicroEJ Architecture (.xpf, .xpfp)

AMicroEJ Architecture contains the runtime port to a target instruction set (ISA) and a C compiler (CC) andMicroEJ
Foundation Libraries.

The MicroEJ Architectures are distributed into two formats:

• EVAL: evaluation license with runtime limitations (explained in SDK developer guide).

• PROD: production license (only MicroEJ sales & Customer Care team distribute this version).

The supported MicroEJ Architectures are listed here https://developer.microej.com/
mej32-embedded-runtime-architectures/

The MicroEJ Architecture is either provided from:

• For EVAL license only: the MicroEJ Repository at https://repository.microej.com/modules/com/microej/
architecture/

• For PROD license only: please contact your sales representative or our support team. See also Production
Licenses for help with PROD license.

• MicroEJ sales or customer care team if the requested architecture is not listed as available.

See Platform Configuration for a description on how to import a MicroEJ Architecture.

MicroEJ Platform Source (.zip)

This package includes:

• a C Board Support Package (BSP) with C drivers and an optional RTOS

• the MicroEJ Architecture and MicroEJ Packs

• the Abstraction Layers implementations

• the MicroEJ Simulator and its associated MicroEJ Mocks

The platform .zip files contain:

• <platform>-configuration : The configuration of the MicroEJ Platform

• <platform>-bsp : The C code for the board-specific files (drivers).

• <platform>-fp : Front Panel mockup for the simulator.

See Platform Creation to learn how to create a MicroEJ Platform using a MicroEJ Platform Source project.

Depending on the project’s requirements, the MicroEJ Platform can be connected in various ways to the BSP; see
BSP Connection for more information on how to do it.

MicroEJ Application

A MicroEJ Application is a Java project that can be configured (in the Run configurations . . . properties):

1. to either run on:

• a simulator (computer desktop),

• a device (actual embedded hardware).

2. to setup:

• memory (example: Java heap, Java stack),
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• foundation libraries,

• etc.

To run on a device, the application is compiled and optimized for a specific MicroEJ Platform. It generates a
microejapp.o (native object code) linked with the <platform>-bsp project.

To import an existing MicroEJ Application as a zipped project in the SDK:

• Go to File > Import. . . > General > Existing Projects into Workspace > Select archive file >

Browse. . . .

• Select the zip of the project (e.g. x.zip ).

• And select Finish import.

See Create a MicroEJ Standalone Application for more information on how to create, configure, and develop a Mi-
croEJ Application.

C Toolchain (GCC, KEIL, IAR, . . . )

Used to compile and link the following files into the final firmware (binary, hex, elf, . . . that will be programmed on
the hardware):

• the microejapp.o (application),

• the microejruntime.lib or microejruntime.a (platform),

• the BSP C files (drivers).

Module Repository

A Module Repository provides the modules required to build MicroEJ Platforms and MicroEJ Applications.

• The MicroEJ Central Repository is an online repository of so�ware modules (libraries, tools, etc.), see https:
//repository.microej.com/. This repository can also be used as an o�line repository, see https://developer.
microej.com/central-repository/.

• (Optional) It can be extended with an o�line repository ( .zip ) that can be imported in the workspace (see
Use the O�line Repository):

SeeModule Repository for more information.

Dependencies Between Components

• A MicroEJ Architecture targets a specific instruction set (ISA) and a specific C compiler (CC).

– The C toolchain used for theMicroEJ Architecturemust be the same as the one used to compile and link
the BSP project and the MicroEJ Firmware.

• A MicroEJ Platform consists of the aggregation of both a MicroEJ Architecture and a BSP with a C toolchain.

– Changing either theMicroEJ Architecture or the C toolchain results in a change of theMicroEJ Platform.

• A MicroEJ Application is independent of the MicroEJ Architecture.

– It can run on any MicroEJ Platform as long the platform provides the required APIs.

– To run a MicroEJ Application on a new device, create a new MicroEJ Platform for this device with the
exact same features. The MicroEJ Application will not require any change.
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6.1.2 How to Build

The process to build a MicroEJ Firmware is two-fold:

1. Build a MicroEJ Platform

2. Build a MicroEJ Application

The MicroEJ Application is compiled against the MicroEJ Platform to produce the MicroEJ Firmware deployed on
the target device.

Note: The MicroEJ Application also runs onto the MicroEJ Simulator using the mocks provided by the MicroEJ
Platform.

Build a MicroEJ Platform

The next schema presents the components and process to build a MicroEJ Platform.

Build a MicroEJ Firmware

The next schema presents the steps to build a MicroEJ Mono-Sandbox Firmware (previously known as MicroEJ
Single-app Firmware). The steps are:

1. Build the MicroEJ Application into a microejapp.o using MicroEJ SDK

2. Compile the BSP C sources into .o using the C toolchain

3. the BSP ( .o ) and the MicroEJ Application ( microejapp.o ) and the MicroEJ Platform ( microejruntime.a )
are linkedby theC toolchain toproducea final ELForbinary calledMicroEJFirmware (e.g. application.out
).
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See BSP Connection for more information on how to connect the MicroEJ Platform to the BSP.

Dependencies Between Processes

• Rebuild the MicroEJ Platform:

– When the MicroEJ Architecture ( .xpf ) changes.

– When a MicroEJ Foundation Library ( .xpfp ) changes.

– When a Foundation Library changes, either when

* The public API ( .java or .h ) changes.

* The front-panel or mock implementation ( .java ) changes.

• Rebuild of the MicroEJ Platform is not required:

– When the implementation ( .c ) of a Foundation Library changes.

– When the BSP ( .c ) changes.

– When the MicroEJ Application changes.

• Rebuild MicroEJ Application:

– When it changes.

– When the MicroEJ Platform changes.

• Rebuild the BSP:

– When it changes.

– When the MicroEJ Platform changes.

• Rebuild the MicroEJ Firmware:
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– When the MicroEJ Application ( microejapp.o ) changes.

– When the BSP ( *.o ) changes.

– When the MicroEJ Platform ( microejruntime.a ) changes.

6.2 Create a MicroEJ Platform for a Custom Device

6.2.1 Introduction

AMicroEJ Architecture is a so�ware package that includes theMicroEJ Runtime port to a specific target Instruction
Set Architecture (ISA) and C compiler. It contains a set of libraries, tools and C header files. The MicroEJ Architec-
tures are provided by MicroEJ SDK.

A MicroEJ Platform is a MicroEJ Architecture port for a custom device. It contains the MicroEJ configuration and
the BSP (C source files).

MicroEJCorp. providesMicroEJEvaluationArchitecturesathttps://repository.microej.com/modules/, andMicroEJ
Platform demo projects for various evaluation boards at https://repository.microej.com/index.php?resource=JPF.

We recommend reading theMicroEJ Firmware section to get an overview of MicroEJ Firmware build flow.

The following document assumes the reader is familiar with the Platform Developer Guide.

Each MicroEJ Platform is specific to:

• a MicroEJ Architecture (MCU ISA and C compiler)

• an optional RTOS (e.g. FreeRTOS - note: the MicroEJ OS can run bare metal)

• adevice: theOSbringupcode that is device specific (e.g. theMCUspecific code/IO/RAM/Clock/Middleware. . .
configurations)

In this document we will address the following items:

• MicroEJ Platform Configuration project (in MicroEJ SDK)

• MicroEJ Simulator (in MicroEJ SDK)

• Platform BSP (in a C IDE/Compiler like GCC/KEIL/IAR)

The MicroEJ Platform relies on C drivers (aka low level LL drivers) for each of the platform feature. These drivers
are implemented in the platform BSP project. This project is edited in the C compiler IDE/dev environment (e.g.
KEIL, GCC, IAR). E.g. the MicroUI library LED feature will require a LLUI_LED.c that implements the native on/o�
IO drive.

The following sections explain how to create a MicroEJ Platform for a custom device starting from an existing Mi-
croEJ Platform project whether it is configured for the same MCU/RTOS/C Compiler or not.

In the following, we assume that the new device hardware is validated and at least a trace output is available. It is
also a good idea to run basic hardware tests like:

• Internal and external flash programming and verification

• RAM 8/16/32 -bit read/write operations (internal and external if any)

• EEMBC Coremark benchmark to verify the CPU/buses/memory/compiler configuration

• See the Platform Qualification Tools used to qualify MicroEJ Platforms.
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6.2.2 A MicroEJ Platform Project is already available for the sameMCU/RTOS/C Compiler

This is the fastest way: the MicroEJ Platform is usually provided for a silicon vendor evaluation board. Import this
platform in MicroEJ SDK.

As the MCU, RTOS and compiler are the same, only the device specific code needs to be changed (external RAM,
external oscillator, communication interfaces).

Platform

In MicroEJ SDK

• modify the .platform fromtheMicroEJPlatform(xxx-configuration project) tomatch thedevice features
and its associated configuration (e.g. UI->Display ).

More details on available modules can be found in the Platform Developer Guide.

BSP

Required actions:

• modify the BSP C project to match the device specification

– edit the scatter file/link options

– edit the compilation options

• create/review/change the platform Low Level C drivers. They must match the device components and the
MCU IO pin assignment

Note: A number of LL*.h files are referenced from the project. Implement the function prototypes declared
there so that the JVM can delegate the relevant operations to the provided BSP C functions.

Simulator

In MicroEJ SDK

6.2. Create a MicroEJ Platform for a Custom Device 589



MicroEJ Documentation, Revision 2788b3f4

• modify the existing Simulator Front Panel xxx-fp project

6.2.3 A MicroEJ Platform Project is not available for the sameMCU/RTOS/C Compiler

Look for an available MicroEJ Platform that will match in order of priority:

• same MCU part number

• same RTOS

• same C compiler

At this point, consider either to modify the closest MicroEJ Platform

• In MicroEJ SDK: modify the platform configuration.

• in the C IDE: start from an empty project that match with the MCU.

Or to start from scratch a newMicroEJ Platform

• In MicroEJ SDK: create theMicroEJ Platform and refer to the selectedMicroEJ Platform as amodel for imple-
mentation. (refer to Platform Configuration)

• in the C IDE: start from an empty project and implement the drivers of each of the LL drivers API.

Make sure to link with:

– the microejruntime.a that runs the JVM for the MCU Architecture

– the microejapp.o that contains the compiled Java application

MCU

The MCU specific code can be found:

• in the C project IDE properties

• in the linker file

• the IO configuration

• in the low level driver (these drivers are usually provided by the silicon vendor)

RTOS

The LL driver is named LLMJVM_RTOS.c/.h . Modify this file to match the selected RTOS.

C Compiler

The BSP project is provided for a specific compiler (that matches the selected platform architecture). Start a new
project with the compiler IDE that includes the LL drivers and start the MicroEJ Platform in the main() function.

6.2.4 Platform Validation

Use the Platform Qualification Tools to qualify the MicroEJ Platform built.
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6.2.5 Further Assistance Needed

Pleasenote that portingMicroEJ to anewdevice is also something that is part of our engineering services. Consider
contacting sales@microej.com to request a quote.

6.3 Create a MicroEJ Firmware From Scratch

This tutorial explains how to create a MicroEJ Firmware from scratch. It goes trough the typical steps followed by
a Firmware developer integrating MicroEJ with a C Board Support Package (BSP) for a target device.

In this tutorial, the target device is a a Luminary Micro Stellaris. Though this device is no longer available on the
market, it has two advantages:

• The QEMU PC System emulator can emulate the device.

• FreeRTOS provides an o�icial Demo BSP.

Consequently, no board is required to follow this tutorial. Everything is emulated on the developer’s PC.

The tutorial should take 1hour to complete (excluding the installation timeofMicroEJSDKandWindowsSubsystem
Linux (WSL)).

6.3.1 Intended Audience

The audience for this document is Firmware engineers who want to understand how MicroEJ is integrated to a C
Board Support Package.

In addition, this tutorial should be of interest to all developers wishing to familiarize themselves with the low level
components of a MicroEJ Firmware such as: MicroEJ Architecture,MicroEJ Platform, Low Level API and BSP connec-
tion.

6.3.2 Introduction

The following steps are usually followed when starting a new project:

1. Pick a target device (that meets the requirements of the project).

2. Setup a RTOS and a toolchain that support the target device.

3. Adapt the RTOS port if needed.

4. Install aMicroEJ Architecture that matches the target device/RTOS/toolchain.

5. Setup a newMicroEJ Platform connected to the Board Support Package (BSP).

6. Implement Low Level API.

7. Validate the resulting MicroEJ Platform with the Platform Qualification Tools (PQT).

8. Develop theMicroEJ Application.

This tutorial describes step by step how to go from the FreeRTOS BSP to a MicroEJ Application that runs on the
MicroEJ Platform and prints the classic "Hello, World!" .

In this tutorial:

• The target device is a Luminary Micro Stellaris which is emulated by QEMU (QEMU Stellaris boards).

• The RTOS is FreeRTOS and the toolchain is GNU CC fo ARM.
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All modifications to FreeRTOS BSP made for this tutorial are available at https://github.com/MicroEJ/FreeRTOS/
tree/tuto-microej-firmware-from-scratch.

Note: The implementation of the Low Level API and their validation with the Platform Qualification Tools (PQT)
will be the topic of another tutorial.

6.3.3 Prerequisites

• MicroEJSDKversion 5.3.0 or higher (distribution 20.10). Canbedownloaded fromhttps://repository.microej.
com/packages/SDK (tested on MicroEJ SDK distribution 20.10)

• Windows 10 with Windows Subsystem for Linux (WSL). See the installation guide.

• A Linux distribution installed on WSL (Tested on Ubuntu 19.10 eoan and Ubuntu 20.04 focal).

Note: In WSL, use the command lsb_release -a to print the current Ubuntu version.

A code editor such as Visual Studio Code is also recommended to edit BSP files.

6.3.4 Overview

Thenext sectionsdescribe stepby stephowtobuild aMicroEJFirmware that runsaHelloWorldMicroEJApplication
on the emulated device.

The steps to follow are:

1. Setup the development environment (assuming the prerequisites are satisfied).

2. Get a running BSP

3. Build the MicroEJ Platform

4. Create the HelloWorld MicroEJ Application

5. Implement the minimum Low Level API to run the application

This tutorial goes through trials and errors every Firmware developers may encounter. It provides a solution a�er
each error rather than providing the full solution in one go.

6.3.5 Setup the Development Environment

This section assumes the prerequisites have been properly installed.

In WSL:

1. Update apt’s cache: sudo apt-get update

2. Install qemu-system-arm and GNU CC toolchain for ARM: sudo apt-get install -y qemu-system-arm
gcc-arm-none-eabi build-essential subversion

3. The rest of this tutorial will use the folder src/tuto-from-scratch/ in the Windows home folder.

4. Create the folder: mkdir -p /mnt/c/Users/${USER}/src/tuto-from-scratch (the -p option ensures all
the directories are created).

5. Go into the folder: cd /mnt/c/Users/${USER}/src/tuto-from-scratch/
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6. Clone FreeRTOS and its submodules: git clone -b V10.3.1 --recursive https://github.com/
FreeRTOS/FreeRTOS.git (this may takes some time)

Note: Use the right-click to paste from the Windows clipboard into WSL console. The right-click is also used to
copy from the WSL console into the Windows clipboard.

6.3.6 Get Running BSP

This section presents how to get running BSP based on FreeRTOS that boots on the target device.

1. Go into the target device sub-project: cd FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC

2. Build the project: make

Ignoring the warnings, the following error appears during the link:

CC hw_include/osram96x16.c
LD gcc/RTOSDemo.axf
arm-none-eabi-ld: section .text.startup LMA [0000000000002b24,0000000000002c8f] overlaps section .
→˓data LMA [0000000000002b24,0000000000002b27]
make: *** [makedefs:191: gcc/RTOSDemo.axf] Error 1

Insert the following fixes in the linker script file named standalone.ld (thanks to http://roboticravings.
blogspot.com/2018/07/freertos-on-cortex-m3-with-qemu.html).

Note: WSL can start the editor Visual Studio Code. type code . in WSL. . represents the current directory
in Unix.

Listing 1: https://github.com/MicroEJ/FreeRTOS/commit/
48248eae13baebf7df9638cd8da6fbfe1a735a9c

diff --git a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/standalone.ld b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/
→˓standalone.ld
--- a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/standalone.ld
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/standalone.ld
@@ -42,7 +42,15 @@ SECTIONS

_etext = .;
} > FLASH

- .data : AT (ADDR(.text) + SIZEOF(.text))
+ .ARM.exidx :
+ {
+ *(.ARM.exidx*)
+ *(.gnu.linkonce.armexidx.*)
+ } > FLASH
+
+ _begin_data = .;
+
+ .data : AT ( _begin_data )

{
_data = .;
*(vtable)
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This is the output of the git diff command. Lines startingwith a - should be removed. Lines startingwith
a + should be added.

Note: The patch(1) can be used to apply the patch. Assuming WSL shell is in FreeRTOS/Demo/
CORTEX_LM3S811_GCC directory:

1. Install dos2unix utility: sudo apt install dos2unix

2. Convert all files to unix line-ending: find -type f -exec dos2unix {} \;

3. Copy the content of the code block in a file named linker.patch (every lines of the code block must
be copied in the file).

4. Apply the patch: patch -l -p4 < linker.patch .

It is also possible to paste the di� directly into the console:

1. In WSL, invoke patch -l -p4 . The command starts, waiting for input on stdin (the standard input).

2. Copy the di� and paste it in WSL

3. Press enter

4. Press Ctrl-d Ctrl-d (press the Control key + the letter d twice).

3. Run the build again: make

4. Run the emulator with the generated kernel: qemu-system-arm -M lm3s811evb -nographic -kernel
gcc/RTOSDemo.bin

The following error appears and then nothing:

ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3

5. Press Ctrl-a x (press Control + the letter a , release, press x ) to the end the QEMU session. The session
ends with QEMU: Terminated .

Note: The errors can be safely ignored. They occur because the OLED controller emulated receive incorrect
commands.

At this point, the target device is successfully booted with the FreeRTOS kernel.
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6.3.7 FreeRTOS Hello World

This section describes how to configure the BSP to print text on the QEMU console.

The datasheet of the target device (LM3S811 datasheet) describes how to use the UART device and an example
implementation for QEMU is available here).

Here is the patch that implements putchar(3) and puts(3) and prints Hello World .

Listing 2: https://github.com/MicroEJ/FreeRTOS/commit/
d09ec0f5cbdf69ca97a5ac15f8b905538aa4c61e

diff --git a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
--- a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -134,9 +134,25 @@ SemaphoreHandle_t xButtonSemaphore;
QueueHandle_t xPrintQueue;

/*-----------------------------------------------------------*/
+#define UART0BASE ((volatile int*) 0x4000C000)
+
+int putchar (int c){
+ (*UART0BASE) = c;
+ return c;
+}
+
+int puts(const char *s) {
+ while (*s) {
+ putchar(*s);
+ s++;
+ }
+ return putchar('\n');
+}

int main( void )
{
+ puts("Hello, World! puts function is working.");
+

/* Configure the clocks, UART and GPIO. */
prvSetupHardware();

Rebuild and run the newly generated kernel: make && qemu-system-arm -M lm3s811evb -nographic -kernel
gcc/RTOSDemo.bin (press Ctrl-a x to interrupt the emulator).

make: Nothing to be done for 'all'.
Hello, World! puts function is working.
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3

(continues on next page)
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(continued from previous page)

ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
ssd0303: error: Unknown command: 0x80
ssd0303: error: Unexpected byte 0xe3
QEMU: Terminated

With this two functions implemented, printf(3) is also available.

Listing 3: https://github.com/MicroEJ/FreeRTOS/commit/
1f7e7ee014754a4dcb4f6c5a470205e02f6ac3c8

diff --git a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
--- a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -149,9 +149,11 @@ int puts(const char *s) {

return putchar('\n');
}

+#include <stdio.h>
+
int main( void )
{
- puts("Hello, World! puts function is working.");
+ printf("Hello, World! printf function is working.\n");

/* Configure the clocks, UART and GPIO. */
prvSetupHardware();

At this point, the character output on the UART is implemented in the FreeRTOS BSP. The next step is to create the
MicroEJ Platform and MicroEJ Application.

6.3.8 Create a MicroEJ Platform

This section describes how to create and configure aMicroEJ Platform compatiblewith the FreeRTOSBSP andGCC
toolchain.

• A MicroEJ Architecture is a so�ware package that includes the MicroEJ Runtime port to a specific target In-
struction Set Architecture (ISA) and C compiler. It contains a set of libraries, tools and C header files. The
MicroEJ Architectures are provided by MicroEJ SDK.

• AMicroEJ Platform is a port of a MicroEJ Architecture for a custom device. It contains the MicroEJ configura-
tion and the BSP (C source files).

When selecting a MicroEJ Architecture, special care must be taken to ensure the compatibility between the
toolchain used in the BSP and the toolchain used to build the MicroEJ Core Engine included in the MicroEJ Ar-
chitecture.

The list of MicroEJ Architectures supported is listed at https://docs.microej.com/en/latest/
PlatformDeveloperGuide/appendix/toolchain.html. MicroEJ Evaluation Architectures provided by MicroEJ
Corp. can be downloaded fromMicroEJ Architectures Repository.

There is no CM3 in MicroEJ Architectures Repository and the Arm® Cortex®-M3 MCU is not mentioned in the ca-
pabilities matrix. This means that the MicroEJ Architectures for Arm® Cortex®-M3 MCUs are no longer distributed
for evaluation. Download the latest MicroEJ Architecture for Arm® Cortex®-M0 instead (the Arm® architectures are
binary upward compatible from Arm®v6-M (Cortex®-M0) to Arm®v7-M (Cortex®-M3)).
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Import the MicroEJ Architecture

This step describes how to import aMicroEJ Architecture.

1. Start MicroEJ SDK on an empty workspace. For example, create an empty folder workspace next to the
FreeRTOS git folder and select it.

2. Keep the default MicroEJ Repository

3. Download the latest MicroEJ Architecture for Arm® Cortex®-M0 instead: https://repository.microej.com/
modules/com/microej/architecture/CM0/CM0_GCC48/flopi0G22/7.14.0/flopi0G22-7.14.0-eval.xpf

4. Import the MicroEJ Architecture in MicroEJ SDK

1. File > Import > MicroEJ > Architectures

2. select the MicroEJ Architecture file downloaded

3. Accept the license and click on Finish

Install an Evaluation License

This step describes how to create and activate an Evaluation License for the MicroEJ Architecture previously im-
ported.

1. Select the Window > Preferences > MicroEJ > Architectures menu .

2. Click on the architectures and press Get UID .

3. Copy the UID. It will be needed when requesting a license.

4. Go to https://license.microej.com.
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5. Click on Create a new account link.

6. Create an account with a valid email address. A confirmation email will be sent a fewminutes a�er. Click on
the confirmation link in the email and login with the account.

7. Click on Activate a License .

8. Set Product P/N: to 9PEVNLDBU6IJ .

9. Set UID: to the UID generated before.

10. Click on Activate .

• The license is being activated. Anactivationmail shouldbe received in less than5minutes. If not, please
contact contact our support team.

• Once received by email, save the attached zip file that contains the activation key.

11. Go back to Microej SDK.

12. Select the Window > Preferences > MicroEJ menu.

13. Press Add. . . .

14. Browse the previously downloaded activation key archive file.

15. Press OK . A new license is successfully installed.

16. Go to Architectures sub-menu and check that all architectures are now activated (green check).

17. Microej SDK is successfully activated.
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Create the MicroEJ Platform

This step describes how to create a newMicroEJ Platform using the MicroEJ Architecture previously imported.

1. Select File > New > Platform Project .

2. Ensure the Architecture selected is the MicroEJ Architecture previously imported.

3. Ensure the Create from a platform reference implementation box is unchecked.

4. Click on Next button.

5. Fill the fields:

• Set Device: to lm3s811evb

• Set Name: to Tuto
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Setup the MicroEJ Platform

This step describes how to configure the MicroEJ Platform previously created. For more information on this topic,
please refer to Platform Configuration.

The Platform Configuration Additions provide a flexible way to configure the BSP connection between the Mi-
croEJ Platform and MicroEJ Application to the BSP. In this tutorial, the Partial BSP connection is used. That is,
the MicroEJ SDK will output all MicroEJ files (C headers, MicroEJ Application microejapp.o , MicroEJ Runtime
microejruntime.a , . . . ) in a location known by the BSP. The BSP is configured to compile and link with those files.

For this tutorial, that means that the final binary is produced by invoking make in the FreeRTOS BSP.

1. Install the Platform Configuration Additions by copying all the files within the content folder in the MicroEJ
Platform folder.

Note: The content directory contains files thatmust be installed in aMicroEJ Platform configuration direc-
tory (thedirectory that contains the .platform file). It canbeautomatically downloadedusing the following
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command line:

svn export --force https://github.com/MicroEJ/PlatformQualificationTools/trunk/framework/platform/
→˓content [path_to_platform_configuration_directory]

2. Edit the file bsp/bsp.properties as follow:

# Specify the MicroEJ Application file ('microejapp.o') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejapp.relative.dir=microej/lib

# Specify the MicroEJ Platform runtime file ('microejruntime.a') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejlib.relative.dir=microej/lib

# Specify MicroEJ Platform header files ('*.h') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejinc.relative.dir=microej/inc

3. Edit the file modules.ivy and add the MicroEJ Architecture as a dependency:

<dependencies>
<dependency org="com.microej.architecture.CM0.CM0_GCC48" name="flopi0G22" rev="7.14.0">

<artifact name="flopi0G22" m:classifier="${com.microej.platformbuilder.
→˓architecture.usage}" ext="xpf"/>

</dependency>
</dependencies>

4. Edit the file modules.properties and set the MicroEJ platform filename:

# Platform configuration file (relative to this project).
com.microej.platformbuilder.platform.filename=Tuto.platform

5. Right-click on the platform project and click on Build Module .

6. The following message appears in the console:

module-platform:report:
[echo] ␣

→˓============================================================================================================
[echo] Platform has been built in this directory 'C:\Users\user\src\tuto-from-

→˓scratch\workspace/lm3s811evb-Platform-CM0_GCC48-0.0.1'.
[echo] To import this project in your MicroEJ SDK workspace (if not already available):
[echo] - Select 'File' > 'Import...' > 'General' > 'Existing Projects into Workspace' >

→˓'Next'
[echo] - Check 'Select root directory' and browse 'C:\Users\user\src\tuto-from-

→˓scratch\workspace/lm3s811evb-Platform-CM0_GCC48-0.0.1' > 'Finish'
[echo] ␣

→˓============================================================================================================

BUILD SUCCESSFUL

1. Follow the instructions to import the generated platform in the workspace:
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At this point, the MicroEJ Platform is ready to be used to build MicroEJ Applications.

6.3.9 Create MicroEJ Application HelloWorld

1. Select File > New > Standalone Application Project .

2. Set the name to HelloWorld and click on Finish
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3. Run theapplication inSimulator to ensure it isworkingproperly. Right-clickonHelloWorldproject > Run As
> MicroEJ Application
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The following message appears in the console:

=============== [ Initialization Stage ] ===============
=============== [ Launching on Simulator ] ===============
Hello World!
=============== [ Completed Successfully ] ===============

SUCCESS

6.3.10 Configure BSP Connection in MicroEJ Application

This step describes how to configure the BSP connection for the HelloWorld MicroEJ Application and how to build
the MicroEJ Application that will run on the target device.

For aMicroEJApplication, theBSP connection is configured in the PROJECT-NAME/build/common.properties file.

1. Create a file HelloWorld/build/emb.properties with the following content:

core.memory.immortal.size=0
core.memory.javaheap.size=1024
core.memory.threads.pool.size=4
core.memory.threads.size=1
core.memory.thread.max.size=4
deploy.bsp.microejapp=true
deploy.bsp.microejlib=true
deploy.bsp.microejinc=true
deploy.bsp.root.dir=[absolute_path] to FreeRTOS\\FreeRTOS\\Demo\\CORTEX_LM3S811_GCC

Note: Assuming the WSL current directory is FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC , use the
following command to find the deploy.bsp.root.dir path with proper escaping:

pwd | sed -e 's|/mnt/c/|C:\\\\|' -e 's|/|\\\\|g'

2. Open Run > Run configurations. . .

3. Select the HelloWorld launcher configuration
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4. Select Execution tab.

5. Change the execution mode from Execute on Simulator to Execute on Device .

6. Add the file build/emb.properties to the options files
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7. Click on Run

=============== [ Initialization Stage ] ===============
Platform connected to BSP location 'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_
→˓LM3S811_GCC' using application option 'deploy.bsp.root.dir'.
=============== [ Launching SOAR ] ===============
=============== [ Launching Link ] ===============
=============== [ Deployment ] ===============
MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\src\tuto-from-
→˓scratch\workspace\HelloWorld\com.mycompany.Main\platform'.
The MicroEJ application (microejapp.o) has been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\lib'.
The MicroEJ platform library (microejruntime.a) has been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\lib'.
The MicroEJ platform header files (*.h) have been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S811_GCC\microej\inc'.
=============== [ Completed Successfully ] ===============

SUCCESS

At this point, the HelloWorld MicroEJ Application is built and deployed in the FreeRTOS BSP.

6.3.11 MicroEJ and FreeRTOS Integration

This section describes how to finalize the integration between MicroEJ and FreeRTOS to get a working firmware
that runs the HelloWorld MicroEJ Application built previously.

In the previous section, when the MicroEJ Application was built, several files were added to a new folder named
microej/ .

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC
$ tree microej/
microej/

inc
BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMJVM.h
LLMJVM_MONITOR_impl.h
LLMJVM_impl.h
LLTRACE_impl.h
MJVM_MONITOR.h
MJVM_MONITOR_types.h
intern

BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMJVM.h
LLMJVM_impl.h
trace_intern.h

sni.h
trace.h

lib
microejapp.o
microejruntime.a

(continues on next page)
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3 directories, 19 files

• The microej/lib folder contains the HelloWorld MicroEJ Application object file ( microejapp.o ) and the
MicroEJ Runtime. The final binary must be linked with these two files.

• The microej/inc folder contains several Cheader filesused toexposeMicroEJLowLevel APIs. The functions
defined in files ending with the _impl.h su�ix should be implemented by the BSP.

To summarize, the following steps remain to complete the integration between MicroEJ and the FreeRTOS BSP:

• Implement minimal Low Level APIs

• Invoke the MicroEJ Core Engine

• Build and link the firmware with the MicroEJ Runtime and MicroEJ Application

Minimal Low Level APIs

The purpose of this tutorial is to demonstrate how to develop aminimal MicroEJ Architecture, it is not to develop a
complete MicroEJ Architecture. Therefore this tutorial implements only the required functions and provides stub
implementation for unused features. For example, the following implementation does not support scheduling.

The two headers that must be implemented are LLBSP_impl.h and LLMJVM_impl.h .

1. In the BSP, create a folder named microej/src (next to the microej/lib and microej/inc folders).

2. Implement LLBSP_impl.h in LLBSP.c :

Listing 4: microej/src/LLBSP.c

#include "LLBSP_impl.h"

extern void _etext(void);
uint8_t LLBSP_IMPL_isInReadOnlyMemory(void* ptr)
{

return ptr < &_etext;
}

/**
* Writes the character <code>c</code>, cast to an unsigned char, to stdout stream.
* This function is used by the default implementation of the Java <code>System.out</code>.
*/
void LLBSP_IMPL_putchar(int32_t c)
{

putchar(c);
}

• The implementation of LLBSP_IMPL_putchar reuses the putchar implemented previously.

• The rodata section is defined in the linker script standalone.ld . The flash memory starts at 0 and
the end of the section is stored in the _etex symbol.

3. Implement LLMJVM_impl.h in LLMJVM_stub.c (all functions are stubbed with a dummy implementation):
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Listing 5: microej/src/LLMJVM_stub.c

#include "LLMJVM_impl.h"

int32_t LLMJVM_IMPL_initialize()
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_vmTaskStarted()
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_scheduleRequest(int64_t absoluteTime)
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_idleVM()
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_wakeupVM()
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_ackWakeup()
{

return LLMJVM_OK;
}

int32_t LLMJVM_IMPL_getCurrentTaskID()
{

return (int32_t) 123456;
}

void LLMJVM_IMPL_setApplicationTime(int64_t t)
{

}

int64_t LLMJVM_IMPL_getCurrentTime(uint8_t system)
{

return 0;
}

int64_t LLMJVM_IMPL_getTimeNanos()
{

return 0;
}

int32_t LLMJVM_IMPL_shutdown(void)
{

return LLMJVM_OK;

(continues on next page)
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}

The microej folder in the BSP has the following structure:

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S811_GCC
$ tree microej/
microej/

inc
BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMJVM.h
LLMJVM_MONITOR_impl.h
LLMJVM_impl.h
LLTRACE_impl.h
MJVM_MONITOR.h
MJVM_MONITOR_types.h
intern

BESTFIT_ALLOCATOR.h
BESTFIT_ALLOCATOR_impl.h
LLBSP_impl.h
LLMJVM.h
LLMJVM_impl.h
trace_intern.h

sni.h
trace.h

lib
microejapp.o
microejruntime.a

src
LLBSP.c
LLMJVM_stub.c

4 directories, 21 files

Invoke MicroEJ Core Engine

The MicroEJ Core Engine is created and initialized with the C function SNI_createVM . Then it is started and ex-
ecuted in the current RTOS task by calling SNI_startVM . The function SNI_startVM returns when the MicroEJ
Application exits. Both functions are declared in the C header sni.h .

Listing 6: https://github.com/MicroEJ/FreeRTOS/commit/
7ae8e79f9c811621569ccb90c46b1dcda91da35d

diff --git a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
--- a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/main.c
@@ -150,11 +150,14 @@ int puts(const char *s) {
}

#include <stdio.h>
+#include "sni.h"

int main( void )

(continues on next page)
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{
printf("Hello, World! printf function is working.\n");

+ SNI_startVM(SNI_createVM(), 0, NULL);
+

/* Configure the clocks, UART and GPIO. */
prvSetupHardware();

Build and Link the Firmware with the MicroEJ Runtime and MicroEJ Application

To build and link the firmware with the MicroEJ Runtime and MicroEJ Application, the BSP port must be modified
to:

1. Use the MicroEJ header files in folder microej/inc

2. Use the source files folder microej/src that contains the Low Level API implementation LLBSP.c and
LLMJVM_stub.c

3. Compile and link LLBSP.o and LLMJVM_stub.o

4. Link with MicroEJ Application ( microej/lib/microejapp.o ) and MicroEJ Runtime ( microej/lib/
microejruntime.a )

The following patch updates the BSP port Makefile to do it:

Listing 7: https://github.com/FreeRTOS/FreeRTOS/commit/
257d9e1d123be0342029e2930c0073dd5a4a2b2d

--- a/FreeRTOS/Demo/CORTEX_LM3S811_GCC/Makefile
+++ b/FreeRTOS/Demo/CORTEX_LM3S811_GCC/Makefile
@@ -29,8 +29,10 @@ RTOS_SOURCE_DIR=../../Source
DEMO_SOURCE_DIR=../Common/Minimal

CFLAGS+=-I hw_include -I . -I ${RTOS_SOURCE_DIR}/include -I ${RTOS_SOURCE_DIR}/portable/GCC/ARM_CM3 -I␣
→˓../Common/include -D GCC_ARMCM3_LM3S102 -D inline=
+CFLAGS+= -I microej/inc

VPATH=${RTOS_SOURCE_DIR}:${RTOS_SOURCE_DIR}/portable/MemMang:${RTOS_SOURCE_DIR}/portable/GCC/ARM_CM3:$
→˓{DEMO_SOURCE_DIR}:init:hw_include
+VPATH+= microej/src

OBJS=${COMPILER}/main.o \
${COMPILER}/list.o \

@@ -44,9 +46,12 @@ OBJS=${COMPILER}/main.o \
${COMPILER}/semtest.o \
${COMPILER}/osram96x16.o

+OBJS+= ${COMPILER}/LLBSP.o ${COMPILER}/LLMJVM_stub.o
+
INIT_OBJS= ${COMPILER}/startup.o

LIBS= hw_include/libdriver.a
+LIBS+= microej/lib/microejruntime.a microej/lib/microejapp.o

Then build the firmware with make . The following error occurs at link time.
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CC microej/src/LLMJVM_stub.c
LD gcc/RTOSDemo.axf ␣

→˓ ␣
→˓ arm-none-eabi-ld: error: microej/lib/microejruntime.a(sni_vm_startup_
→˓greenthread.o) uses VFP register arguments, gcc/RTOSDemo.axf does not
arm-none-eabi-ld: failed to merge target specific data of file microej/lib/microejruntime.a(sni_vm_
→˓startup_greenthread.o)
arm-none-eabi-ld: gcc/RTOSDemo.axf section `ICETEA_HEAP' will not fit in region `SRAM'
arm-none-eabi-ld: region `SRAM' overflowed by 4016 bytes
microej/lib/microejapp.o: In function `_java_internStrings_end':

The RAM requirements of the BSP (with printf), FreeRTOS, the MicroEJ Application and MicroEJ Runtime do not fit
in the 8k of SRAM. It is possible to link within 8k of RAM by customizing a MicroEJ Tiny Application on a baremetal
device (without a RTOS) but this is not the purpose of this tutorial.

Instead, this tutorial will switch to another device, the LuminaryMicro Stellaris LM3S6965EVB. This device is almost
identical as the LM3S811EVB but it has 256k of flash memory and 64k of SRAM. Updating the values in the linker
script standalone.ld is su�icient to create a valid BSP port for this device.

Instead of continuing to work with the LM3S811 port, create a copy, named CORTEX_LM3S6965_GCC:

$ cd ..
$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo
$ cp -r CORTEX_LM3S811_GCC/ CORTEX_LM3S6965_GCC
$ cd CORTEX_LM3S6965_GCC

The BSP path defined by the property deploy.bsp.root.dir in the MicroEJ Applicationmust be updated as well.

The rest of the tutorial assumes that everything is done in the CORTEX_LM3S6965_GCC folder.

Then update the linker script standlone.ld :

Listing 8: https://github.com/MicroEJ/FreeRTOS/commit/
0e2e31d8a510d37178c340051bab636902471eea

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/
→˓standalone.ld
--- a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld
@@ -28,8 +28,8 @@

MEMORY
{
- FLASH (rx) : ORIGIN = 0x00000000, LENGTH = 64K
- SRAM (rwx) : ORIGIN = 0x20000000, LENGTH = 8K
+ FLASH (rx) : ORIGIN = 0x00000000, LENGTH = 256K
+ SRAM (rwx) : ORIGIN = 0x20000000, LENGTH = 64K
}

SECTIONS

The new command to run the firmware with QEMU is: qemu-system-arm -M lm3s6965evb -nographic -kernel
gcc/RTOSDemo.bin .

Rebuild the firmware with make . The following error occurs:
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CC microej/src/LLMJVM_stub.c
LD gcc/RTOSDemo.axf ␣

→˓ ␣
→˓ microej/lib/microejapp.o: In function `_java_internStrings_end':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x1b3e):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_
→˓1SupportNumber_1parseLong'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x1cea):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_
→˓1SupportNumber_1toStringLongNative' C:\Users\user\src\tuto-from-
→˓scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x1e3e): undefined reference to␣
→˓`ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_1Systools_1appendInteger'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x1f2a):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___java_1lang_1System_1getMethodClass'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x1e3e):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___com_1is2t_1vm_1support_1lang_1Systools_
→˓1appen
... skip ...
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x31d6):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___java_1lang_1System_1initializeProperties'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x37b6):␣
→˓undefined reference to `ist_mowana_vm_GenericNativesPool___java_1lang_1Thread_1storeException'
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.soar+0x37c8):␣
→˓undefined reference to `ist_microjvm_NativesPool___java_1lang_1Thread_1execClinit'
microej/lib/microejapp.o: In function `__icetea__getSingleton__com_is2t_microjvm_mowana_VMTask':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.text.__icetea__
→˓getSingleton__com_is2t_microjvm_mowana_VMTask+0xc): undefined reference to `com_is2t_microjvm_mowana_
→˓VMTask___getSingleton'
microej/lib/microejapp.o: In function `__icetea__getSingleton__com_is2t_microjvm_IGreenThreadMicroJvm':
... skip ...
microej/lib/microejapp.o: In function `TRACE_record_event_u32x3_ptr':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.rodata.TRACE_
→˓record_event_u32x3_ptr+0x0): undefined reference to `TRACE_default_stub'
microej/lib/microejapp.o: In function `TRACE_record_event_u32x4_ptr':
C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.Main\SOAR.o:(.rodata.TRACE_
→˓record_event_u32x4_ptr+0x0): undefined reference to `TRACE_default_stub'
microej/lib/microejapp.o:C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.
→˓Main\SOAR.o:(.rodata.TRACE_record_event_u32x5_ptr+0x0): more undefined references to `TRACE_default_
→˓stub' follow
make: *** [makedefs:196: gcc/RTOSDemo.axf] Error 1

This error occurs because microejruntime.a refers to symbols in microejapp.o but is declared a�er in the linker
command line. By default, the GNU LD linker does not search unresolved symbols into archive files loaded previ-
ously (see man ld for a description of the start-group option). To solve this issue, either invert the declaration
of LIBS (put microejapp.o first) or guard the libraries declaration with --start-group and --end-group in
makedefs . This tutorial uses the later.

Listing 9: https://github.com/MicroEJ/FreeRTOS/commit/
4b23ea2e77112f053368718d299�8db826ddde1

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
--- a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
@@ -196,13 +196,13 @@ ifeq (${COMPILER}, gcc)

echo ${LD} -T ${SCATTER_${notdir ${@:.axf=}}} \
--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \

(continues on next page)
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- ${LDFLAGS} -o ${@} ${^} \
- '${LIBC}' '${LIBGCC}'; \
+ ${LDFLAGS} -o ${@} --start-group ${^} \
+ '${LIBC}' '${LIBGCC}' --end-group; \

fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=}}} \

--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \

- ${LDFLAGS} -o ${@} ${^} \
- '${LIBC}' '${LIBGCC}'
+ ${LDFLAGS} -o ${@} --start-group ${^} \
+ '${LIBC}' '${LIBGCC}' --end-group

@${OBJCOPY} -O binary ${@} ${@:.axf=.bin}
endif

Rebuild with make . The following error occurs:

LD gcc/RTOSDemo.axf
microej/lib/microejruntime.a(VMCOREMicroJvm__131.o): In function `VMCOREMicroJvm__1131____1_11046':
_131.c:(.text.VMCOREMicroJvm__1131____1_11046+0x20): undefined reference to `fmodf'
microej/lib/microejruntime.a(VMCOREMicroJvm__131.o): In function `VMCOREMicroJvm__1131____1_11045':
_131.c:(.text.VMCOREMicroJvm__1131____1_11045+0x2c): undefined reference to `fmod'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___cos':
Math.c:(.text.iceTea_lang_Math___cos+0x2a): undefined reference to `cos'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___sin':
Math.c:(.text.iceTea_lang_Math___sin+0x2a): undefined reference to `sin'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___tan':
Math.c:(.text.iceTea_lang_Math___tan+0x2a): undefined reference to `tan'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___acos__D':
Math.c:(.text.iceTea_lang_Math___acos__D+0x18): undefined reference to `acos'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___acos(void)':
Math.c:(.text.iceTea_lang_Math___acos__F+0x12): undefined reference to `acosf'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___asin':
Math.c:(.text.iceTea_lang_Math___asin+0x18): undefined reference to `asin'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___atan':
Math.c:(.text.iceTea_lang_Math___atan+0x2): undefined reference to `atan'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___atan2':
Math.c:(.text.iceTea_lang_Math___atan2+0x2): undefined reference to `atan2'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___log':
Math.c:(.text.iceTea_lang_Math___log+0x2): undefined reference to `log'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math_(...)(long long, *)':
Math.c:(.text.iceTea_lang_Math___exp+0x2): undefined reference to `exp'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math_(char,...)(int, long)':
Math.c:(.text.iceTea_lang_Math___ceil+0x2): undefined reference to `ceil'
microej/lib/microejruntime.a(iceTea_lang_Math.o): In function `iceTea_lang_Math___floor':
... skip ...

This erroroccursbecause theMath library ismissing. The rule for linking the firmware isdefined in the file makedefs
. Replicating how the libc is managed, the following patch finds the libm.a library and add it at link time:

Listing 10: https://github.com/MicroEJ/FreeRTOS/commit/
a202f43948c41b848ebfbc8c53610028c454b66f

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
--- a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs

(continues on next page)
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@@ -102,6 +102,11 @@ LIBGCC=${shell ${CC} -mthumb -march=armv6t2 -print-libgcc-file-name}
#
LIBC=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libc.a}

+#
+# Get the location of libm.a from the GCC front-end.
+#
+LIBM=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libm.a}
+
#
# The command for extracting images from the linked executables.
#
@@ -197,12 +202,12 @@ ifeq (${COMPILER}, gcc)

--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
${LDFLAGS} -o ${@} --start-group ${^} \

- '${LIBC}' '${LIBGCC}' --end-group; \
+ '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group; \

fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=}}} \

--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
${LDFLAGS} -o ${@} --start-group ${^} \

- '${LIBC}' '${LIBGCC}' --end-group
+ '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group;

@${OBJCOPY} -O binary ${@} ${@:.axf=.bin}
endif

Rebuild with make . The following error occurs:

CC microej/src/LLMJVM_stub.c
LD gcc/RTOSDemo.axf

/usr/lib/gcc/arm-none-eabi/6.3.1/../../../arm-none-eabi/lib/thumb/libc.a(lib_a-sbrkr.o): In function `_
→˓sbrk_r':
/build/newlib-jo3xW1/newlib-2.4.0.20160527/build/arm-none-eabi/thumb/newlib/libc/reent/../../../../../..
→˓/newlib/libc/reent/sbrkr.c:58: undefined reference to `_sbrk'
make: *** [makedefs:196: gcc/RTOSDemo.axf] Error 1

Instead of implementing a stub _sbrk function, this tutorial uses the libnosys.a which provides stub implemen-
tation for various functions.

Listing 11: https://github.com/MicroEJ/FreeRTOS/commit/
a202f43948c41b848ebfbc8c53610028c454b66f

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
--- a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/makedefs
@@ -107,6 +107,11 @@ LIBC=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libc.a}
#
LIBM=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libm.a}

+#
+# Get the location of libnosys.a from the GCC front-end.
+#
+LIBNOSYS=${shell ${CC} -mthumb -march=armv6t2 -print-file-name=libnosys.a}
+

(continues on next page)
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(continued from previous page)

#
# The command for extracting images from the linked executables.
#
@@ -202,12 +207,12 @@ ifeq (${COMPILER}, gcc)

--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
${LDFLAGS} -o ${@} --start-group ${^} \

- '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group; \
+ '${LIBNOSYS}' '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group; \

fi
@${LD} -T ${SCATTER_${notdir ${@:.axf=}}} \

--entry ${ENTRY_${notdir ${@:.axf=}}} \
${LDFLAGSgcc_${notdir ${@:.axf=}}} \
${LDFLAGS} -o ${@} --start-group ${^} \

- '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group;
+ '${LIBNOSYS}' '${LIBM}' '${LIBC}' '${LIBGCC}' --end-group;

@${OBJCOPY} -O binary ${@} ${@:.axf=.bin}
endif

Rebuild with make . The following error occurs:

CC microej/src/LLMJVM_stub.c
LD gcc/RTOSDemo.axf

/usr/lib/gcc/arm-none-eabi/6.3.1/../../../arm-none-eabi/lib/thumb/libnosys.a(sbrk.o): In function `_sbrk
→˓':
/build/newlib-jo3xW1/newlib-2.4.0.20160527/build/arm-none-eabi/thumb/libgloss/libnosys/../../../../../
→˓libgloss/libnosys/sbrk.c:21: undefined reference to `end'
make: *** [makedefs:201: gcc/RTOSDemo.axf] Error 1

The _sbrk implementation needs the end symbol to be defined. Looking at the implementation, the end symbol
corresponds to the beginning of the C heap. This tutorial uses the end of the .bss segment as the beginning of the
C heap.

Listing 12: https://github.com/MicroEJ/FreeRTOS/commit/
898f2e6cd492616b4ccaabc136cafa76ef038690

diff --git a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/
→˓standalone.ld
--- a/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld
+++ b/FreeRTOS/Demo/CORTEX_LM3S6965_GCC/standalone.ld
@@ -64,5 +64,6 @@ SECTIONS

*(.bss)
*(COMMON)
_ebss = .;

+ end = .;
} > SRAM

}

Then rebuild with make . There should be no error. Finally, run the firmware in QEMUwith the following command:

qemu-system-arm -M lm3s6965evb -nographic -kernel gcc/RTOSDemo.bin

Hello, World! printf function is working.
Hello World!
QEMU: Terminated // press Ctrl-a x to end the QEMU session

The first Hello, World! is from the main.c and the second one from the MicroEJ Application.
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Tomake this more obvious:

1. Update the MicroEJ Application to print Hello World! This is my first MicroEJ Application

2. Rebuild the MicroEJ Application

On success, the following message appears in the console:

=============== [ Initialization Stage ] ===============
Platform connected to BSP location 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC' using application option 'deploy.bsp.root.
→˓dir'.
=============== [ Launching SOAR ] ===============
=============== [ Launching Link ] ===============

(continues on next page)
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=============== [ Deployment ] ===============
MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\src\tuto-from-
→˓scratch\workspace\HelloWorld\com.mycompany.Main\platform'.
The MicroEJ application (microejapp.o) has been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib'.
The MicroEJ platform library (microejruntime.a) has been deployed to: 'C:\Users\user\src\tuto-
→˓from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib'.
The MicroEJ platform header files (*.h) have been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\inc'.
=============== [ Completed Successfully ] ===============

SUCCESS

3. Then rebuild and run the firmware:

$ make && qemu-system-arm -M lm3s6965evb -nographic -kernel gcc/RTOSDemo.bin

LD gcc/RTOSDemo.axf
Hello, World! printf function is working.
Hello World! This is my first MicroEJ Application
QEMU: Terminated

Congratulations!

At this point of the tutorial:

• The MicroEJ Platform is connected to the BSP (BSP partial connection).

• The MicroEJ Application is deployed within a known location of the BSP (in microej/ folder).

• The FreeRTOS LM3S6965 port:

– provides the minimal Low Level API to run the MicroEJ Application

– compiles and links FreeRTOS with the MicroEJ Application and MicroEJ Runtime

– runs on QEMU

The next steps recommended are:

• Complete the implementation of the Low Level APIs (implement all functions in LLMJVM_impl.h ).

• Validate the implementation with the PQT Core.

• Follow theCreateMicroEJ PlatformBuild andRunScripts tutorial to get thisMicroEJ Platform fully automated
for build and execution.

6.4 Create MicroEJ Platform Build and Run Scripts

This tutorial describes all the steps to createMicroEJ Platform build and run scripts and shows how to use them.

6.4.1 Intended Audience

The audience for this document is Platform engineers who want to

• validate their MicroEJ Platform using automatedMicroEJ test suites.
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• prepare their MicroEJ Platform for automated builds and continuous integration usingMicroEJ Module Man-
ager.

• easeMicroEJ Standalone Application development by simplifying the Firmware build for Java developers.

• configure their MicroEJ Platform with full BSP connection.

6.4.2 Prerequisites

This tutorial is a direct continuation of Create a MicroEJ Firmware From Scratch tutorial. It should have been com-
pleted before starting this one.

6.4.3 Introduction

Build and Run scripts are normalized entry points to

• build a MicroEJ Firmware linked to the Board Support Package,

• deploy and run the Firmware on a device.

External tools only need to run these scripts without additional knowledge about the toolchain or deployment
tools.

See Build Script File and Run Script File sections for more information about these scripts. Script examples are
provided in Platform Qualification Tools repository.

6.4.4 Overview

In the previous Create a MicroEJ Firmware From Scratch tutorial, the final binary is produced by invoking make in
the FreeRTOS BSP. The command to type is dependant of the toolchain used. The Firmware is then executed in
QEMU but could have been instead flashed to a device with another specific command. This tutorial explain how
to write build and run scripts for these two tasks.

The next sections will

• describe step-by-step how to create the build and run scripts both for unix-like systems (Bash scripts) and
Windows systems (batch files). These scripts automate Firmware build and execution in QEMU as presented
in Create a MicroEJ Firmware From Scratch tutorial.

• show a practical usage of these scripts in a MicroEJ development flow. This will allow to configure a MicroEJ
Standalone Application to build the Firmware in MicroEJ SDK.

Finally, this tutorial describes how to convert theMicroEJ Platform frompartial BSP connection to full BSP connec-
tion.

6.4.5 Create Build and Run Scripts

This section describes how to write build and run scripts.

There are two scripts:

1. build.[sh|bat] which calls the C toolchain to build and link the Firmware file. It also ensures that the
output file is called application.out and is located in the directory fromwhere the script was called.

2. run.[sh|bat] which deploys and runs application.out on the device. In this tutorial, it will only run the
Firmware with QEMU instead of flashing it on real hardware.
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Each of these scripts come in two flavors: .sh for unix-like systems, and .bat for Windows systems.

First, create a microej/scripts directory in BSP project:

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S6965_GCC
$ mkdir microej/scripts

Note: The scripts created in the next sections will be put in this directory.

Create build.sh and run.sh Scripts

Warning: Make sure the build and run scripts have the execution permission.

1. Create a file called build.sh in the microej/scripts directory with the following content:

#!/bin/bash

# Save application current directory and jump one level above scripts
CURRENT_DIRECTORY=$(pwd)

# Move to the directory where the Makefile is
cd $(dirname "$0")/../..

# Build the firmware
make

# Copy output the the current directory while renaming it
cp gcc/RTOSDemo.bin $CURRENT_DIRECTORY/application.out

# Restore application directory
cd $CURRENT_DIRECTORY/

2. Verify that the script successfully built your Firmware and put it in the current directory with the name
application.out .

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S6965_GCC
$ make clean
$ microej/scripts/build.sh

CC init/startup.c
CC main.c
CC ../../Source/list.c
CC ../../Source/queue.c
CC ../../Source/tasks.c

[..]
130 | __attribute__( ( always_inline ) ) static inline uint8_t ucPortCountLeadingZeros(␣

→˓uint32_t ulBitmap )
| ^~~~~~~~~~~~~~~~~~~~~~~

LD gcc/RTOSDemo.axf
$ ls *.out
application.out
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3. Check that application.out successfully runs with QEMU:

$ qemu-system-arm -M lm3s6965evb -nographic -kernel application.out
Hello, World! printf function is working.
Hello World!
QEMU: Terminated // press Ctrl-a x to end the QEMU session

4. Create a file called run.sh in the microej/scripts directory with the following content:

#!/bin/bash

# Add some text to the console before launch
echo -e "\033[0;32m## Start application in QEMU."
echo -e "## Use 'Ctrl-a x' to quit.\e[0m"

# Launch application with QEMU
qemu-system-arm -M lm3s6965evb -nographic -kernel application.out

5. We can now run the Firmware we just built with the run.sh script:

$ pwd
/mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S6965_GCC
$ microej/scripts/run.sh
## Start application in QEMU.
## Use 'Ctrl-a x' to quit.
Hello, World! printf function is working.
Hello World!

Note: This script is very simple because our Firmware is just run with QEMU instead of real hardware. To deploy
the Firmware on a device, the script would have to setup and call a flash tool. See for instance the build and run
scripts for Espressif-ESP-WROVER-KIT-V4.1.

Create build.bat and run.bat Scripts

As our toolchain has only be configured for Linux in WSL, we create wrappers that call shell scripts through WSL.
We could also decide to directly invoke QEMU for Windows instead. This is just a implementation choice for this
Platform.

1. Create a file called build.bat in the microej/scripts directory with the following content:

@echo off
SETLOCAL ENABLEEXTENSIONS

REM Reset ERRORLEVEL between multiple run in the same shell
SET ERRORLEVEL=0

REM Save application current directory and jump to scripts directory
SET CURRENT_DIRECTORY=%CD%
CD "%~dp0"

REM Get the script directory in a Unix path format
FOR /F %%i in ('WSL pwd') DO SET SCRIPT_DIRECTORY=%%i

REM Restore application directory
CD %CURRENT_DIRECTORY%

(continues on next page)
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REM Run the bash build script with WSL
WSL %SCRIPT_DIRECTORY%/build.sh

IF %ERRORLEVEL% NEQ 0 (
EXIT /B %ERRORLEVEL%

)

2. Calling this script in PowerShell should produce the following result:

PS C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC>␣
→˓microej\scripts\build.bat
CC init/startup.c
CC main.c
CC ../../Source/list.c
CC ../../Source/queue.c
CC ../../Source/tasks.c
[...]
CC microej/src/LLMJVM_stub.c
LD gcc/RTOSDemo.axf

Current DIR /mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_LM3S6965_
→˓GCC/microej/scripts

1 file(s) moved.

Note: This prints the full build output if it is the first build (or a�er a make clean ) otherwise it prints make:
Nothing to be done for 'all' .

3. Create a file called run.bat in the microej/scripts directory with the following content:

@echo off
SETLOCAL ENABLEEXTENSIONS

REM Reset ERRORLEVEL between multiple run in the same shell
SET ERRORLEVEL=0

REM Save application current directory and jump to scripts directory
SET CURRENT_DIRECTORY=%CD%
CD "%~dp0"

REM Get the script directory in a Unix path format
FOR /F %%i in ('WSL pwd') DO SET SCRIPT_DIRECTORY=%%i

REM Restore application directory
CD %CURRENT_DIRECTORY%

REM Run the bash run script with WSL
WSL %SCRIPT_DIRECTORY%/run.sh

IF %ERRORLEVEL% NEQ 0 (
EXIT /B %ERRORLEVEL%

)

4. Calling this script in PowerShell should produce the following result:
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C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\application.
→˓out
1 file(s) copied.
## Start application in QEMU.
## Use 'Ctrl-a x' to quit.
Hello, World! printf function is working.
Hello World!

6.4.6 Use Build Script in MicroEJ SDK

In this section, we illustrate how build script is used in practice to ease the Firmware build for Java developers in
MicroEJ SDK.

We will configure a MicroEJ Standalone Application to enable full Firmware build (application + BSP + link) when
building the HelloWorld application.

Wewill then configure a full BSP connection. This will remove the need to configure the path of the BSP root direc-
tory as a MicroEJ Standalone Application option. Please refer to BSP connection cases section and BSP connection
options for more details.

Note: Build and run scripts do not require to configure a full BSP connection. This last part has only be added to
allow a MicroEJ Standalone Application project to be built independently from the BSP.

Build Firmware fromMicroEJ SDK

1. Right click on the HelloWorld application project

2. In the menu, select Run As > Run Configurations. . .

3. Select the Configuration tab

4. Select Device > Deploy entry in the configurations menu

5. Check Execute the MicroEJ script (build.bat) at the location known by the 3rd-party BSP project checkbox
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6. Click on the Run button. It should print the following:

=============== [ Initialization Stage ] ===============
Platform connected to BSP location 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC' using application option 'deploy.bsp.
→˓root.dir'.
[INFO ] Launching in Evaluation mode. Your UID is 0120202834374C4A.
=============== [ Launching SOAR ] ===============
=============== [ Launching Link ] ===============
=============== [ Deployment ] ===============
MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\src\tuto-from-
→˓scratch\workspace\HelloWorld\com.mycompany.Main\platform'.

FAIL
The following error occurred while executing this line:
C:\Users\user\src\tuto-from-scratch\workspace\lm3s811evb-Platform-CM0_GCC48-0.0.
→˓1\source\scripts\deploy.xml:30: The following error occurred while executing this line:
C:\Users\user\src\tuto-from-scratch\workspace\lm3s811evb-Platform-CM0_GCC48-0.0.
→˓1\source\scripts\deployInBSP.xml:97: The following error occurred while executing this␣
→˓line:
C:\Users\user\src\tuto-from-scratch\workspace\lm3s811evb-Platform-CM0_GCC48-0.0.
→˓1\source\scripts\deployInBSP.xml:260: Option 'deploy.bsp.microejscript' is enabled but␣
→˓this Platform does no define a well-known location. Either update the Platform␣
→˓configuration (option 'deploy.bsp.microejscript.relative.dir' in 'bsp/bsp.properties') or␣
→˓disable this option.

7. Edit the file bsp/bsp.properties as follow:

# Specify BSP external scripts files ('build.bat' and 'run.bat') parent directory.
# This is a '/' separated directory relative to 'bsp.root.dir'.
microejscript.relative.dir=microej/scripts

8. Rebuild your Platform (right-click on the platform configuration project and click on Build Module )
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9. Run the HelloWorld launcher once again. This should print the following result:

=============== [ Initialization Stage ] ===============
Platform connected to BSP location 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC' using platform option 'deploy.bsp.root.
→˓dir'.
[INFO ] Launching in Evaluation mode. Your UID is 0120202834374C4A.=============== [␣
→˓Launching SOAR ] ===============
=============== [ Launching Link ] ===============
=============== [ Deployment ] ===============
MicroEJ files for the 3rd-party BSP project are generated to 'C:\Users\user\Workspaces\_test_
→˓fw_tuto\HelloWorld\com.mycompany.Main\platform'.
The MicroEJ application (microejapp.o) has been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib'.
The MicroEJ platform library (microejruntime.a) has been deployed to:
→˓'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\lib
→˓'.
The MicroEJ platform header files (*.h) have been deployed to: 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\inc'.
Execution of script 'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_
→˓LM3S6965_GCC\microej\scripts\build.bat' started...
LD gcc/RTOSDemo.axf
Current DIR /mnt/c/Users/user/Workspaces/_test_fw_tuto/HelloWorld/com.mycompany.Main
Execution of script 'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_
→˓LM3S6965_GCC\microej\scripts\build.bat' done.
=============== [ Completed Successfully ] ===============

SUCCESS

Reading the traces, we see that the HelloWorld application (microejapp.o) and the MicroEJ Platform library (mi-
croejruntime.a) have been deployed to the suitable BSP location. Then the build.bat script has been executed
to rebuild the BSP and link the Firmware. The output is the application.out binary that can be flashed on the
device (or run on QEMU).

Convert from partial BSP connection to full BSP connection (optional)

In this section, we configure the BSP root directory in the Platform. Such configuration is called full BSP connection:
the MicroEJ Platform includes the BSP, and any MicroEJ Standalone Application can be built against this MicroEJ
Platform without extra configuration.

When launching the HelloWorld application fromMicroEJ SDK, the launcher knows how to find the BSP because
we have configured its path in HelloWorld/build/emb.properties file which is imported in the launcher (this
file has been configured in Create a MicroEJ Firmware From Scratch tutorial).

1. Cut deploy.bsp.root.dir property value from HelloWorld/build/emb.properties file

2. Paste the value in bsp/bsp.properties as follow:

# Specify the BSP root directory. Can use ${project.parent.dir} which target the parent of␣
→˓platform configuration project
# For example, '${workspace}/${project.prefix}-bsp' specifies a BSP project beside the '-
→˓configuration' project
root.dir=[absolute_path] to FreeRTOS\\FreeRTOS\\Demo\\CORTEX_LM3S811_GCC

3. Rebuild your MicroEJ Platform (right-click on the platform configuration project and click on Build Module
)

The MicroEJ Platform is now fully connected to the BSP.
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4. Launch HelloWorld project from Eclipse launcher, it should print the following result:

=============== [ Initialization Stage ] ===============
Platform connected to BSP location 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC' using platform option 'root.
→˓dir' in 'bsp/bsp.properties'.
[INFO ] Launching in Evaluation mode. Your UID is 0120202834374C4A.
=============== [ Launching SOAR ] ===============
=============== [ Launching Link ] ===============
=============== [ Deployment ] ===============
MicroEJ files for the 3rd-party BSP project are generated to
→˓'C:\Users\user\src\tuto-from-scratch\workspace\HelloWorld\com.mycompany.
→˓Main\platform'.
The MicroEJ application (microejapp.o) has been deployed to:
→˓'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_
→˓GCC\microej\lib'.
The MicroEJ platform library (microejruntime.a) has been deployed to:
→˓'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_
→˓GCC\microej\lib'.
The MicroEJ platform header files (*.h) have been deployed to:
→˓'C:\Users\user\src\tuto-from-scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_
→˓GCC\microej\inc'.
Execution of script 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GCC\microej\scripts\build.bat'␣
→˓started...
LD gcc/RTOSDemo.axf

Current DIR /mnt/c/Users/user/src/tuto-from-scratch/FreeRTOS/FreeRTOS/Demo/CORTEX_
→˓LM3S6965_GCC/microej/scripts
Execution of script 'C:\Users\user\src\tuto-from-
→˓scratch\FreeRTOS\FreeRTOS\Demo\CORTEX_LM3S6965_GC C\microej\scripts\build.bat'␣
→˓done.
=============== [ Completed Successfully ] ===============

SUCCESS

Note: You can notice the di�erence in the second line of the trace that now says that the
connection is using platform option root.dir' in 'bsp/bsp.properties' instead of
using platform option 'deploy.bsp.root.dir' in the previous launch.

The application launcher does not know anymore where the BSP is located. Nevertheless it still builds
a Firmware ready to be flashed. The link to the BSP is now configured in the MicroEJ Platform. Any
MicroEJ Standalone Application can be built against thisMicroEJ Platformwith noBSP specific option.

6.4.7 Going Further

• More about build and run scripts in Build Script File in Run Script File sections

• Some build scripts examples from Platform Qualification Tools

• Perform the Run a Test Suite on a Device tutorial to learn how to run an automated testsuite

• Perform the Setup an Automated Build using Jenkins and Artifactory tutorial to learn how to automate the
build of a MicroEJ Platformmodule
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6.5 Setup an Automated Build using Jenkins and Artifactory

This tutorial explains how to setup an environment for automating MicroEJ Module build and deployment using
Jenkins and JFrog Artifactory.

Such environment setup facilitates continuous integration (CI) and continuous delivery (CD), which improves pro-
ductivity across your development ecosystem, by automatically:

• building modules when source code changes

• saving build results

• reproducing builds

• archiving binary modules

The tutorial should take 2 hours to complete.

6.5.1 Intended Audience

The audience for this document is engineers who are in charge of integrating MicroEJ Module Manager (MMM) to
their continuous integration environment.

In addition, this tutorial should be of interest to all developers wishing to understand how MicroEJ works with
headless module builds.

For thosewhoareonly interestedby command linemodulebuild, consider using theMMMCommandLine Interface.

6.5.2 Introduction

The overall build and deployment flow of a module can be summarized as follows:

1. Some event triggers the build process (i.e module source changed, user action, scheduled routine, etc.)

2. The module source code is retrieved from the Source Control System

3. The module dependencies are imported from the Repository Manager

4. The Automation Server then proceeds to building the module

5. If the build is successful, the module binary is deployed to the Repository Manager
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6.5.3 Prerequisites

• MicroEJ SDK 5.4.0 or higher.

• Git 2.x installed, with Git executable in path. We recommend installing Git Bash if your operating system is
Windows (https://git-for-windows.github.io/).

• Java Development Kit (JDK) 1.8.x .

This tutorial was tested with Jenkins 2.277.4 and Artifactory 7.24.3 .

Note: For SDK versions before 5.4.0, please refer to this MicroEJ Documentation Archive.

6.5.4 Overview

The next sections describe step by step how to setup the build environment and build your first MicroEJ module.

The steps to follow are:

1. Install and setup MicroEJ build tools, Jenkins and Artifactory

2. Create a Jenkins job template for MMM builds

3. Create a simple MicroEJ module (Hello World)

4. Create a new Jenkins job for the Hello World module

5. Build the module

In order to simplify the steps, this tutorial will be performed locally on a single machine.

Artifactory will host MicroEJ modules in 3 repositories:

• microej-module-repository : repository initialized with pre-built MicroEJmodules, amirror of the Central
Repository

• custom-modules-snapshot : repository where custom snapshot modules will be published

• custom-modules-release : repository where custom release modules will be published

6.5.5 Install the Build Tools

This section assumes the prerequisites have been properly installed.

1. Locate your JDK installation directory (typically something like C:\Program Files\Java\jdk1.8.
0_[version] on Windows).

2. Set the environment variable JAVA_HOME to point to this directory.

3. Set the environment variable JRE_HOME to point to the jre directory (for example C:\Program
Files\Java\jdk1.8.0_[version]\jre ).

4. Create a directory named buildKit .

5. Export theMicroEJ build kit fromyourMicroEJ SDK version to the buildKit directory, by following the steps
described here.

6. Edit the file buildKit/microej-module-repository/ivysettings.xml and replace its content by:
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<?xml version="1.0" encoding="UTF-8"?>
<ivy-settings>

<property name="artifactory.repository.url" value="http://localhost:8081/artifactory" override=
→˓"false"/>

<property name="local.repository.dir" value="${user.home}/.ivy2/repository/" override="false"/>

<!--
Map MMM resolvers (*.resolver) to custom resolver

Kinds of repositories:
- release: used when publishing a released module.
- snapshot: used when publishing a snapshot module.
- local: used when publishing a snapshot module locally.

-->
<property name="release.resolver" value="modulesReleaseRepository" override="false"/>
<property name="shared.resolver" value="modulesSnapshotRepository" override="false"/>
<property name="local.resolver" value="localRepository" override="false"/>

<property name="modules.resolver" value="fetchAll" override="false" />
<property name="request.cache.dir" value="${user.home}/.ivy2/cache" override="false"/>
<property name="default.conflict.manager" value="latest-compatible" override="false"/>

<settings defaultResolver="${modules.resolver}" defaultConflictManager="${default.conflict.
→˓manager}" defaultResolveMode="dynamic"/>

<caches defaultCacheDir="${request.cache.dir}"/>

<resolvers>

<url name="modulesReleaseRepository" m2compatible="true">
<artifact pattern="${artifactory.repository.url}/custom-modules-release/

→˓[organization]/[module]/[branch]/[revision]/[artifact]-[revision](-[classifier]).[ext]" />
<ivy pattern="${artifactory.repository.url}/custom-modules-release/

→˓[organization]/[module]/[branch]/[revision]/ivy-[revision].xml" />
</url>

<url name="modulesSnapshotRepository" m2compatible="true" checkmodified="true">
<artifact pattern="${artifactory.repository.url}/custom-modules-snapshot/

→˓[organization]/[module]/[branch]/[revision]/[artifact]-[revision](-[classifier]).[ext]" />
<ivy pattern="${artifactory.repository.url}/custom-modules-snapshot/

→˓[organization]/[module]/[branch]/[revision]/ivy-[revision].xml" />
</url>

<url name="microejModulesRepository" m2compatible="true">
<artifact pattern="${artifactory.repository.url}/microej-module-repository/

→˓[organization]/[module]/[branch]/[revision]/[artifact]-[revision](-[classifier]).[ext]" />
<ivy pattern="${artifactory.repository.url}/microej-module-repository/

→˓[organization]/[module]/[branch]/[revision]/ivy-[revision].xml" />
</url>

<filesystem name="localRepository" m2compatible="true" checkmodified="true">
<artifact pattern="${local.repository.dir}/[organization]/[module]/[branch]/

→˓[revision]/[artifact]-[revision](-[classifier]).[ext]" />
<ivy pattern="${local.repository.dir}/[organization]/[module]/[branch]/

→˓[revision]/ivy-[revision].xml" />
</filesystem>

(continues on next page)
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(continued from previous page)

<chain name="fetchRelease">
<resolver ref="modulesReleaseRepository"/>
<resolver ref="microejModulesRepository"/>

</chain>

<chain name="fetchSnapshot">
<resolver ref="modulesSnapshotRepository"/>
<resolver ref="fetchRelease"/>

</chain>

<chain name="fetchLocal">
<resolver ref="localRepository"/>
<resolver ref="fetchSnapshot"/>

</chain>

<chain name="fetchAll">
<resolver ref="fetchLocal"/>

</chain>

</resolvers>
</ivy-settings>

This file configures MicroEJ Module Manager to import and publish modules from the Artifactory repositories de-
scribed in this tutorial. Please refer to Settings File section for more details.

Note: At this point, the content of the directory buildKit should look like the following:

buildKit
bin

mmm
mmm.bat

conf
easyant-conf.xml

lib
ant.jar
...

microej-build-repository
ant-contrib
be
...

microej-module-repository
ivysettings.xml

release.properties

6.5.6 Get a Module Repository

A Module Repository is a portable ZIP file that bundles a set of modules for extending the MicroEJ development
environment. Please consult theModule Repository section for more information.

This tutorial uses the MicroEJ Central Repository, which is the Module Repository used by MicroEJ SDK to fetch
dependencies when starting an empty workspace. It bundles Foundation Library APIs and numerous Add-On Li-
braries.

Next step is to download a local copy of this repository:
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1. Visit the Central Repository on the MicroEJ Developer website.

2. Navigate to the Working O�line section.

3. Click on the o�line repository link. This will download the Central Repository as a ZIP file.

6.5.7 Setup Artifactory

Install and Start Artifactory

1. Download Artifactory here: https://jfrog.com/fr/open-source/ and select the appropriate package for your
operating system.

2. Unzip downloaded archive, then navigate to app/bin directory (by default artifactory-oss-[version]/
app/bin ).

3. Run artifactory.bat or artifactory.sh depending on your operating system.

4. Once Artifactory is started, go to http://localhost:8081/ .

5. Login to Artifactory for the first time using the default admin account (Username: admin , Password:
password ).

6. On the Welcome wizard, set the administrator password, then click Next ,

7. Configure proxy server (if any) then click Next , or click Skip .

8. Click on Finish .

Artifactory is up and running.

Configure Artifactory

For demonstration purposes we will allow anonymous users to deploy modules in the repositories:

1. Go to Administration > Security > Settings .

2. In the General Security Settings section, check Allow Anonymous Access .

3. Click on Save .

4. Go to Administration > Identity and Access > Permissions .

5. Click on Anything entry (do not check the line), then go to Users tab

6. Click on anonymous and check Deploy/Cache permission in the Repositories category.

7. Click on Save and finish .

Next steps will involve uploading large files, so we have to augment the file uploadmaximum size accordingly:

1. Go to Administration > Artifactory .

2. In the General Settings section, change the value of File Upload In UI Max Size (MB) to 1024 then click

on Save .
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Create Repositories

Wewill now create and configure the repositories. Let’s start with the repository for the future built snapshotmod-
ules:

1. Go to Administration > Repositories > Repositories in the le�menu.

2. Click on Add Repositories > Local Repository

3. Select Maven .

4. Set Repository Key field to custom-modules-snapshot and click on Save and Finish .

Repeat the same steps for the other repositories with the Repository Key field set to custom-modules-release

and microej-module-repository .

Import MicroEJ Repositories

In this section, wewill import MicroEJ repositories into Artifactory repositories tomake themavailable to the build
server.

1. Go to Administration > Artifactory > Import & Export > Repositories .

2. Scroll to the Import Repository from Zip section.

3. As Target Local Repository , select microej-module-repository in the list.

4. Click on Select file and select the MicroEJ module repository zip file ( microej-[MicroEJ
version]-[version].zip ) that you downloaded earlier (please refer to section Get a Module Reposi-
tory).

5. Click Upload . At the end of upload, click on Import . Upload and import may take some time.

Artifactory is now hosting all required MicroEJ modules. Go to Administration > Artifactory > Artifacts and
check that the repository microej-module-repository does contain modules as shown in the figure below.

6.5.8 Setup Jenkins

Install Jenkins

1. Download Jenkins here: https://www.jenkins.io/download/. In this tutorial we will use the WAR (Web
Archive), but you can use any other installation package (Docker, Ubuntu/Debian, . . . ).
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2. Open a terminal and type the following command: java -jar [path/to/downloaded/jenkinswar]/

jenkins.war . A�er initialization, the terminal will print out Jenkins is fully up and running .

3. Go to http://localhost:8080/ .

4. To unlock Jenkins, copy/paste the generated password that has been written in the terminal log. Click on
Continue .

5. Select option Install suggested plugins and wait for plugins installation.

6. Fill in the Create First Admin User form. Click Save and continue .

7. Click on Save and finish , then on Start using Jenkins .

Configure Jenkins

First step is to configure the JDK and MMM paths:

1. Go to Manage Jenkins > Global Tool Configuration .

2. Add JDK installation:

1. Scroll to JDK section.

2. Click on Add JDK .

3. Set Name to JDK [jdk_version] (for example JDK 1.8 ).

4. Uncheck Install automatically .

5. Set JAVA_HOME to the absolute path of your JDK installation (for example C:\Program

Files\Java\jdk1.8.0_[version] on Windows).

3. Click on Save .

4. Go to Manage Jenkins > Configure System .

1. Scroll to Global properties section.

2. Check Environment variables .

3. Click on Add .

4. Set Name to MICROEJ_BUILD_KIT_HOME .

5. Set Value to the absolute path of the buildKit folder.

5. Click on Save .

Create a Job Template

1. Go to Jenkins dashboard.

2. Click on New item to create a job template.

3. Set item name to Template - MMM from Git .

4. Select Freestyle project .
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5. Click on Ok .

In General tab:

1. Check This project is parameterized and add String parameter named easyant.module.dir with de-
fault value to $WORKSPACE/TO_REPLACE . This will later point to the module sources.

In Source Code Management tab:

1. Select Git source control:

2. Set Repository URL value to TO_REPLACE ,

3. Set Branch Specifier value to origin/master ,

4. In Additional Behaviours , click on Add , select Advanced sub-modules behaviors , then check
Recursively update submodules .

In Build tab:

• For Windows, add build step Execute Windows batch command :

– In Command , set the following content:

cd "%easyant.module.dir%"
"%MICROEJ_BUILD_KIT_HOME%\\bin\\mmm.bat" publish shared"

• For Linux, add build step Execute shell :

– In Command , set the following content:

cd "${easyant.module.dir}"
"${MICROEJ_BUILD_KIT_HOME}/bin/mmm" publish shared"

Finally, click on Save .

6.5.9 Build a newModule using Jenkins

Since your environment is now setup, it is time to build your first module from Jenkins and check it has been pub-
lished to Artifactory. Let’s build an “Hello World” Sandboxed Application project.

Create a newMicroEJ Module

In this example,wewill create a very simplemoduleusing theSandboxApplicationbuildtype (build-application
) that we’ll push to a Git repository.

Note: For demonstration purposes, we’ll create a new project and share it on a local Git bare repository. You can
adapt the following sections to use an existing MicroEJ project and your own Git repository.

1. Start MicroEJ SDK.

2. Go to File > New > Sandboxed Application Project .

3. Fill in the template fields, set Project name to com.example.hello-world .
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4. Click Finish . This will create the project files and structure.

5. Right-click on source folder src/main/java and select New > Package . Set a name to the package and

click Finish .

6. Right-click on the new package and select New > Class . Set a name to the class and check public

static void main(String[] args) , then click Finish .
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7. Locate the project files

1. In the Package Explorer view, right-click on the project then click on Properties .

2. Select Resource menu.

3. Click on the arrow button on line Location to show the project in the system explorer.

8. Open a terminal from this directory and type the following commands:

git init --bare ~/hello_world.git
git init
git remote add origin ~/hello_world.git
git add com.example.hello-world
git commit -m "Add Hello World application"
git push --set-upstream origin master

Note: For more details about MicroEJ Applications development, refer to the Application Developer Guide.

Create a New Jenkins Job

Start by creating a new job, from the job template, for building our application.

1. Go to Jenkins dashboard.

2. Click on New Item .

3. Set item name to Hello World .

4. In Copy from field, type Template - MMM from Git (autocomplete enabled).

5. Validate with Ok button.

The job configurationpageopens, let’s replace all the TO_REPLACE placeholders from the job templatewith correct
values:

1. In General tab, set easyant.module.dir to value $WORKSPACE/com.example.hello-world .

2. In Source Code Management , edit Repository URL to ~/hello_world.git .
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3. Click on Save .

Build the “Hello World” Application

Let’s run the job!

In Jenkins’ Hello World dashboard, click on Build with Parameters , then click on Build .

Note: You can check the build progress by clicking on the build progress bar and showing the Console Output .

At the end of the build, the module is published to http://localhost:8081/artifactory/list/
custom-modules-snapshot/com/example/hello-world/ .

Congratulations!

At this point of the tutorial:

• Artifactory is hosting your module builds and MicroEJ modules.

• Jenkins automates the build process usingMicroEJ Module Manager.

The next recommended step is to adapt MMM/Jenkins/Artifactory configuration to your ecosystem and develop-
ment flow.

6.5.10 Appendix

This section discusses some of the customization options.

Customize Jenkins

Jenkins jobs are highly configurable, following options and values are recommended by MicroEJ, but they can be
customized at your convenience.

In General tab:

1. Check Discard old builds and set Max # of builds to keep value to 15 .

2. Click on Advanced button, and check Block build when upstream project is building .
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In Build triggers tab:

1. Check Poll SCM , and set a CRON-like value (for example H/30 * * * * to poll SCM for changes every 30
minutes).

In Post-build actions tab:

1. Add post-build action Publish JUnit test result report :

2. Set Test report XMLs to **/target~/test/xml/**/test-report.xml, **/target~/test/xml/**/

*Test.xml .

Note: The error message ‘**/target~/test/xml/**/test-report.xml’ doesn’t match anything: ‘**’
exists but not ‘**/target~/test/xml/**/test-report.xml’ will be displayed since no build has been exe-
cuted yet. These folders will be generated during the build.

3. Check Retain long standard output/error .

4. Check Do not fail the build on empty test results

Customize target~ path

Some systems and toolchains don’t handle long path properly. A workaround for this issue is to move the build
directory (that is, the target~ directory) closer to the root directory.

To change the target~ directory path, set the build option target .

In Advanced , expand Properties text field and set the target property to thepathof your choice. For example:

target=C:/tmp/

6.6 Improve the Quality of Java Code

This tutorial describes some rules and tools aimed at improving the quality of a Java code to simplify its mainte-
nance. It makes up aminimum consistent set of rules which can be applied in any situation, especially on embed-
ded systems where performance and lowmemory footprint matter.

6.6.1 Intended Audience

The audience for this document is engineers who are developing any kind of Java code (application or library).

6.6.2 Readable Code

This section describes rules to get a readable code, in order to facilitate:

• the maintenance of an existing code with multiple developers contributions (e.g. merge conflicts, reviews).

• the landing to a new code base when the same rules are applied across di�erent modules and components.
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Naming Convention

Naming of Java elements (package, class, method, field and local) follows the Camel Case convention.

• Package names are written fully in lower case (no underscore).

• Package names are singular (e.g. ej.animal instead of ej.animals ).

• Class names are written in upper camel case.

• Interfaces are named in the same way as classes (see below).

• Method and instance field names are written in lower camel case.

• Static field names are written in lower camel case.

• Constant names are written in fully upper case with underscore as word separator.

• Enum constant names are written in fully upper case with underscores as word separators.

• Local (and parameter) names are written in lower camel case.

• When a name contains an acronym, capitalize only the first letter of the acronym (e.g. for a local with the
HTTP acronym, use myHttpContext instead of myHTTPContext ).

It is also recommended to use full words instead of abbreviations (e.g. MyProxyReference instead of MyProxyRef
).

Interfaces and Subclasses Naming Convention

An Interface is named a�er the feature it exposes. It does not have a I prefix because it hurts readability andmay
cause naming issues when potentially converted to/from an abstract class.

The classes implementing an interface are named a�er the interface and how they implement it. Using Impl su�ix
is not recommended because it does not express the implementation specificity. If there is no specificity, maybe
there is no need to have an interface.

Example: an interface Storage (that allows to load/store data) may have several implementations, such as
StorageFs (on a file system), StorageDb (on a database), StorageRam (volatile storage in RAM).

Visibility

Here is a list of the usage of each Java element visibility:

• public : API.

• protected : API for subclasses.

• package : component intern API (collaboration inside a package).

• private : internal structure, cache, lazy, etc.

By default, all instance fields must be private.

Package visibility can be used by writing the comment /* package */ in place of the modifier.

Javadoc

Javadoc comments convention is based on the o�icial documentation.
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Note: Javadoc is written in HTML format and doesn’t accept XHTML format: tagsmust not be closed. For example,
use only a <p> between two paragraphs.

Here is a list of the rules to follow when writing Javadoc:

• All APIs (see Visibility) must have a full Javadoc (classes, methods, and fields).

• Add a dot at the end of all phrases.

• Add @since tag when introducing a new API.

• Do not hesitate to use links to help the user to navigate in the API ( @see , @link ).

• Use the @code tag in the following cases:

– For keywords (e.g. {@code null} or {@code true} ).

– For names and types (e.g. {@code x} or {@code Integer} ).

– For code example (e.g. {@code new Integer(Integer.parseInt(s))} ).

Here is a list of additional rules for methods:

• The first sentence starts with the third person (as if there is This method before).

• All parameters and returned values must be described.

• Put as much as possible information in the description, keep @param and @return minimal.

• Start @param with a lower case and usually with the or a.

• Start @return with a lower case as if the sentence starts with Returns.

• Avoid naming parameters anywhere other than in @param . If the parameter is renamed a�erward, the com-
ment is not changed automatically. Prefer using the given xxx.

Code Convention

O�icial documentation: https://www.oracle.com/java/technologies/javase/codeconventions-introduction.html

Class Declaration

The parts of a class or interface declaration must appear in the order suggested by the Code Convention for the
Java Programming Language:

• Constants.

• Class (static) fields.

• Instance fields.

• Constructors

• Methods

Fields Order

For a better readability, the fields (class and instance) must be ordered by scope:

1. public
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2. protected

3. package

4. private

Methods Order

It is recommended to group related methods together. It helps for maintenance:

• when searching for a bug on a specific feature,

• when refactoring a class into several ones.

Modifiers Order

Classandmembermodifiers,whenpresent, appear in theorder recommendedby theJavaLanguageSpecification:

public protected private abstract default static final transient volatile synchronized native
strictfp

Code Style and Formatting

MicroEJ defines a formatting profile for .java files, which is automatically set up when creating a new Module
Project Skeleton.

Note: MicroEJ SDK automatically applies formatting when a .java file is saved. It is also possible to manually
apply formatting on specific files:

• In Package Explorer , select the desired files, folders or projects,

• then go to Source > Format . The processed files must not have any warning or error.

Here is the list of formatting rules included in this profile:

• Indentation is done with 1 tab.

• Braces are mandatory with if , else , for , do , and while statements, even when the body is empty or
contains only a single statement.

• Braces follow the Kernighan and Ritchie style (Egyptian brackets) described below:

– No line break before the opening brace.

– Line break a�er the opening brace.

– Line break before the closing brace.

– Line break a�er the closing brace, only if that brace terminates a statement or terminates the body of a
method, constructor, or named class. For example, there is no line break a�er the brace if it is followed
by else or a comma.

• One statement per line.

• Let the formatter automatically wraps your code when a statement needs to be wrapped.

Here is a list of additional formatting rules that are not automatically applied:

• Avoid committing commented code (other than to explain an optimization).
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• All methods of an interface are public. There is no need to specify the visibility (easier to read).

Note: Most of these rules are checked by Code Analysis with SonarQube™.

6.6.3 Best Practices

This sectiondescribes rulesmadeof best practices andwell-known restrictions of the JavaProgramming Language
andmore generally Object Oriented paradigm.

Common Pitfalls

• Object.equals(Object) and Object.hashCode() methods must be overridden in pairs. See Equals and Hash-
code.

• Do not assign fields in field declaration but in the constructor.

• Do not use non-final method inside the constructor.

• Do not overburden the constructor with logic.

• Do not directly store an array given by parameter.

• Do not directly return an internal array.

• Save object reference from a field to a local before using it (see Local Extraction).

Simplify Maintenance

• Extract constants instead of using magic numbers.

• Use parenthesis for complex operation series; it simplifies the understanding of operator priorities.

• Write short lines. This can be achieved by extracting locals (see Local Extraction).

• Use a limited number of parameters in methods (or perhaps a new type is needed).

• Create small methods with little complexity. When amethod gets too complex, it should be split.

• Use + operator only for single-line string concatenation. Use an explicit StringBuilder otherwise.

• Use component-oriented architecture to separate concerns. If a class is intended to be instantiated using
Class.newInstance(), add a default constructor (without parameters).

Basic Optimizations

• Avoid explicitly initializing fields to 0 or null , because they are zero-initialized by the runtime. A //VM_DONE
comment can be written to understand the optimization.

• The switch/case statements are generated by the Java compiler in twoways depending on the cases density.
Prefer declaring consecutive cases (table_switch) for performance ( O(1) ) and slightly smaller codememory
footprint instead of lookup_switch ( O(log N) ).

• Avoid using built-in thread safe types (Vector, Hashtable, StringBu�er, etc.). Usually synchronization has to
be done at a higher level.

• Avoid serializing/deserializing data from byte arrays using manual bitwise operations, use ByteArray utility
methods instead.
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Local Extraction

Local extraction consists of storing the result of an expression before using it, for example:

Object myLocale = this.myField;
if (myLocale != null) {
myLocale.myMethod();

}

It improves the Java code in many ways:

• self documentation: gives a name to a computed result.

• performance andmemory footprint: avoids repeated access to same elements and extract loop invariants.

• thread safety: helps to avoid synchronization issues or falling into unwanted race conditions.

• code pattern detection: helps automated tools such as Null Analysis.

Equals and Hashcode

The purpose of these methods is to uniquely and consistently identify objects. The most common use of these
methods is to compare instances in collections (list or set elements, map keys, etc.).

TheObject.equals(Object)method implements an equivalence relation (defined in the Javadoc)with the following
properties:

• It is reflexive: for any reference value x, x.equals(x) must return true .

• It is symmetric: for any reference values x and y, x.equals(y) must return true if and only if y.equals(x)
returns true .

• It is transitive: for any reference values x, y, and z, if x.equals(y) returns true and y.equals(z) returns
true , then x.equals(z) must return true .

• It is consistent: for any reference values x and y, multiple invocations of x.equals(y) consistently return
true or consistently return false , provided no information used in equals comparisons on the object is
modified.

• For any non-null reference value x, x.equals(null) must return false .

Avoid overriding the equals(Object) method in a subclass of a class that already overrides it; it could break the
contract above. See E�ective Java book by Joshua Bloch for more information.

If the equals(Object) method is implemented, the hashCode() method must also be implemented. The
hashCode() method follows these rules (defined in the Javadoc):

• It must consistently return the same integer when invoked several times.

• If two objects are equal according to the equals(Object) method, then calling the hashCode() method on
each of the two objects must produce the same integer result.

• In the same way, it should return distinct integers for distinct objects.

The equals(Object) method is written that way:

• Compare the argument with this using the == operator. If both are equals, return true . This test is for
performance purposes, so it is optional andmay be removed if the object has a few fields.

• Use an instanceof to check if the argument has the correct type. If not, return false . This check also
validates that the argument is not null.

• Cast the argument to the correct type.
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• For each field, check if that field is equal to the same field in the casted argument. Return true if all fields
are equal, false otherwise.

@Override
public boolean equals(Object o) {

if (o == this) {
return true;

}
if (!(o instanceof MyClass)) {

return false;
}
MyClass other = (MyClass)o;
return field1 == other.field1 &&

(field2 == null ? other.field2 == null : field2.equals(other.field2));
}

The Object.hashCode() method is written that way:

• Choose a prime number.

• Create a result local, whatever the value (usually the prime number).

• For each field, multiply the previous result with the prime plus the hash code of the field and store it as the
result.

• Return the result.

Depending on its type, the hash code of a field is:

• Boolean: (f ? 0 : 1) .

• Byte, char, short, int: (int) f) .

• Long: (int)(f ^ (f >>> 32)) .

• Float: Float.floatToIntBits(f) .

• Double: Double.doubleToLongBits(f) and the same as for a long.

• Object: (f == null ? 0 : f.hashCode()) .

• Array: add the hash codes of all its elements (depending on their type).

private static final int PRIME = 31;

@Override
public int hashCode() {

int result = PRIME;
result = PRIME * result + field1;
result = PRIME * result + (field2 == null ? 0 : field2.hashCode());
return result;

}

6.6.4 Related Tools

This section points to tools aimed at helping to improve code quality.

Unit Testing

Here is a list of rules when writing tests (see Test Suite with JUnit):
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• Prefer black-box tests (with a maximum coverage).

• Here is the test packages naming convention:

– Su�ix package with .test for black-box tests.

– Use the same package for white-box tests (allow to use classes with package visibility).

Code Analysis with SonarQube™

SonarQube is an open source platform for continuous inspection of code quality. SonarQube o�ers reports on
duplicated code, coding standards, unit tests, code coverage, code complexity, potential bugs, comments, and
architecture.

To set it uponyourMicroEJapplicationproject, please refer to this documentation. It describes the following steps:

• How to run a SonarQube server locally.

• How to run an analysis using a dedicated script.

• How to run an analysis during a module build.

6.7 Optimize the Memory Footprint of an Application

This tutorial explains how to analyze the memory footprint of an application and provides a set of common rules
aimed at optimizing both ROM and RAM footprint.

6.7.1 Intended Audience

The audience for this document is Java engineers and Firmware integrators who are going to execute a MicroEJ
Application on amemory-constrained device.

6.7.2 Introduction

Usually, the application development is already startedwhen the developer starts thinking about itsmemory foot-
print. Before jumping into code optimizations, it is recommended to list every area of improvement and estimate
for each area howmuchmemory can be saved and howmuch e�ort it requires.

Without performing the memory analysis first, the developer might start working on a minor optimization that
takes a lot of e�ort for little improvements. In contrast, he could work on amajor optimization, allowing faster and
bigger improvements. Moreover, each optimization described herea�er may allow significant memory savings for
an application while it may not be relevant for another application.

6.7.3 How to Analyze the Footprint of an Application

This section explains the process of analyzing the footprint of a MicroEJ Application and the tools used during the
analysis.

Suggested footprint analysis process:

1. Build the MicroEJ Application

2. Analyze SOAR.map with theMemory Map Analyzer

3. Analyze soar/*.xml with an XML editor
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4. Link the MicroEJ Application with the BSP

5. Analyze the map file generated by the third-party linker with a text editor

Footprint analysis tools:

• The Memory Map Analyzer allows to analyze the memory consumption of di�erent features in the RAM and
ROM.

• TheHeapDumper&HeapAnalyzer allow tounderstand the contents of the Java heap and findproblems such
as memory leaks.

• The API Dependency Discoverer allows to analyze a piece of code to detect all its dependencies.

How to Analyze the Files Generated by the MicroEJ Linker

TheMicroEJ Application linker generates files useful for footprint analysis, such as the SOARmap file and the SOAR
information file. To understand how to read these files, please refer to the Build Output Files documentation.

How to Analyze a Map File Generated by a Third-Party Linker

A <firmware>.map file is generated by the C toolchain a�er linking the MicroEJ Application with the BSP. This
section explains how amap file generated by GCC is structured and how to browse it. The structure is not the same
on every compiler, but it is o�en similar.

File Structure

This file is composed of 5 parts:

• Archive member included to satisfy reference by file . Each entry contains two lines. The first line
contains the referenced archive file location and the compilation unit. The second line contains the compi-
lation unit referencing the archive and the symbol called.

• Allocating common symbols . Eachentry contains thenameofaglobal variable, its size, and thecompilation
unit where it is defined.

• Discarded input sections . Each entry contains the name and the size of a section that has not been
embedded in the firmware.

• Memory Configuration . Each entry contains the name of a memory, its address, its size, and its attributes.

• Linker script and memory map . Each entry contains a linewith the nameand compilation unit of a section
and one line per symbol defined in this section. Each of these lines contains the name, the address, and the
size of the symbol.

Finding the Size of a Section or Symbol

For example, to know the thread stacks’ size, search for the .bss.vm.stacks.java section in the Linker script
and memory map part. The size associated with the compilation unit is the size used by the thread stacks.

The following snippet shows that the .bss.vm.stacks.java section takes 0x800 bytes.

.bss.vm.stacks.java
0x20014070 0x800 ..\..\..\..\..\..\..\.microej\CM4hardfp_

→˓GCC48\application\microejapp.o

(continues on next page)
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(continued from previous page)

0x20014070 __icetea___6bss_6vm_6stacks_6java$$Base
0x20014870 __icetea___6bss_6vm_6stacks_6java$$Limit

See Core Engine Link documentation for more information on MicroEJ Core Engine sections.

6.7.4 How to Reduce the Image Size of an Application

Generic coding rules can be found in the following tutorial: Improve the Quality of Java Code.

This section provides additional coding rules and good practices to reduce the image size (ROM) of an application.

Application Resources

Resources such as images and fonts take a lot of memory. For every .list file, make sure that it does not embed
any unused resource.

Only resources declared in a .list file will be embedded. Other resources available in the application classpath
will not be embedded and will not have an impact on the application footprint.

Fonts

Default Font

By default, in aMicroEJ Platform configuration project, a so-called system font is declared in the microui.xml file.

When generating the MicroEJ Platform, this file is copied from the configuration project to the actual MicroEJ Plat-
form project. It will later be converted to binary format and linked with your MicroEJ Application, even if you use
fonts di�erent from the system font.

Therefore, you can comment the system font from the microui.xml file to reduce the ROM footprint of your Mi-
croEJ Application if this one does not rely on the system font. Note that you will need to rebuild the MicroEJ Plat-
form and then the application to benefit from the footprint reduction.

See the Display Element section of the Static Initialization documentation for more information on system fonts.

Character Ranges

When creating a font, you can reduce the list of characters embedded in the font at several development stages:

• On font creation: see the Removing Unused Characters section of Font Designer documentation.

• On application build: see the Fonts section ofMicroEJ Classpath documentation.

Pixel Transparency

You can also make sure that the BPP encoding used to achieve transparency for your fonts do not exceed the fol-
lowing values:

• The pixel depth of your display device.

• The required alpha level for a good rendering of your font in the application.

See the Fonts section ofMicroEJ Classpath documentation for more information on how to achieve that.
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External Storage

To save storage on internal flash, you can access fonts from an external storage device.

See the External Resources section of the Font Generator documentation for more information on how to achieve
that.

Internationalization Data

Implementation

MicroEJ provides the Native Language Support (NLS) library to handle internationalization.

See https://github.com/MicroEJ/Example-NLS for an example of the use of the NLS library.

External Storage

The default NLS implementation fetches text resources from internal flash, but you can replace it with your own
implementation to fetch them from another location.

See External Resources Loader documentation for additional information on external resources management.

Compression

The default NLS implementation relies on text resources that are not compressed, but you can use your own en-
coding to load them from compressed resources.

Images

Encoding

If you are tight on ROM but have enough RAM and CPU power to decode PNG images on the fly, consider storing
your images as PNG resources. If you are in the opposite configuration (lots of ROM, but little RAM and CPU power),
consider storing your images in raw format.

See Image Generator documentation for more information on how to achieve that.

Color Depth (BPP)

Make sure to use images with a color depth not exceeding the one of your display to avoid the following issues:

• Waste of memory.

• Di�erences between the rendering on the target device and the original image resource.

External Storage

To save storage on internal flash, the application can access the images from an external storage device.

See External Resources Loader documentation for more information on how to achieve that.
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Application Code

The following application code guidelines are recommended in order to minimize the size of the application:

• Check libraries versions and changelogs regularly. Latest versions may bemore optimized.

• Avoid manipulating String objects:

– For example, prefer using integers to represent IDs.

– Avoid overridingObject.toString() for debugging purposes. Thismethodwill always be embedded even
if it is not called explicitly.

– Avoid using the logging library or System.out.println() , use the trace library or themessage library
instead. The logging library uses strings, while the trace and message libraries use integer-based error
codes.

– Avoid using the string concatenation operator ( + ), use an explicit StringBuilder instead. The code gen-
erated by the + operator is not optimal and is bigger than when usingmanual StringBuilder opera-
tions.

• Avoid manipulating wrappers such as Integer and Long objects, use primitive types instead. Such objects
have to be allocated in Java heapmemory and require additional code for boxing and unboxing.

• Avoid using the service library, use singletons or Constants.getClass() instead. The service library requires
embedding class reflection methods and the type names of both interfaces and implementations.

• Avoid using the JavaCollections Framework. ThisOpenJDK standard library has not beendesigned formem-
ory constrained devices.

– Use raw arrays instead of List objects. The ArrayTools class provides utility methods for common array
operations.

– Use PackedMap objects instead of Map objects. It provides similar APIs and features with lower Java
heap usage.

• Use ej.bon.Timer instead of deprecated java.util.Timer . When both class are used, almost all the code is
embedded twice.

• Use BON constants in the following cases if possible:

– whenwriting debug code or optional code, use the if (Constants.getBoolean()) { ... } pattern.
That way, the optional code will not be embedded in the production firmware if the constant is set to
false .

– replace theuseofSystemPropertiesbyBONconstantswhenbothkeysandvaluesareknownat compile-
time. System Properties should be reserved for runtime lookup. Each property requires embedding its
key and its value as intern strings.

• Check for useless or duplicate synchronization operations in call stacks, in order reduce the usage of
synchronized statements. Each statement generates additional code to acquire and release the monitor.

• Avoid declaring exit statements ( break , continue , throw or return ) that jump out of a synchronized
block. At each exit point, additional code is generated to release the monitor properly.

• Avoid declaring exit statements ( break , continue , throw or return ) that jump out of a try/finally
block. At each exit point, the code of the finally block is generated (duplicated). This also applies on every
try-with-resources block since a finally block is generated to close the resource properly.

• Avoid overridingObject.equals(Object) andObject.hashCode(), use == operator instead if it is su�icient. The
correct implementation of these methods requires significant code.

• Avoid calling equals() and hashCode() methods directly on Object references. Otherwise, the method
of every embedded class which overrides the method will be embedded.
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• Avoid creating inlined anonymous objects (such as new Runnable() { ... } objects), implement the
interface in a existing class instead. Indeed, a new class is created for each inlined object. Moreover, each
enclosed final variable is added as a field of this anonymous class.

• Replace constant arrays and objects initialization in static final fields by immutables objects. Indeed,
initializing objects dynamically generates code which takes significant ROM and requires execution time.

• Check if some features available in so�ware libraries are not already provided by the device hardware. For
example, avoid using java.util.Calendar (full Gregorian calendar implementation) if the application only re-
quires basic date manipulation provided by the internal real-time clock (RTC).

MicroEJ Platform Configuration

The following configuration guidelines are recommended in order to minimize the size of the application:

• Check MicroEJ Architecture and Packs versions and changelogs regularly. Latest versionsmay bemore opti-
mized.

• Configure the Platform to use the tiny capability of the MicroEJ Core Engine. It reduces application code size
by ~20%, provided that the application code size is lower than 256KB (resources excluded).

• Disable unnecessarymodules in the .platform file. For example, disable the Image PNG Decoder module
if the application does not load PNG images at runtime.

• Don’t embed unnecessary pixel conversion algorithms. This can save up to ~8KB of code size but it requires
knowing the format of the resources used in the application.

• Select your embeddedC compilation toolchainwith care, prefer onewhichwill allow lowROM footprintwith
optimal performance. Check the compiler options:

– Check documentation for available optimization options ( -Os onGCC). These options can also be over-
ridden per source file.

– Separate each function and data resource in a dedicated section ( -ffunction-sections
-fdata-sections on GCC).

• Check the linker optimization options. The linker command line can be found in the project settings, and it
may be printed during link.

– Only embed necessary sections ( --gc-sections option on GCC/LD).

– Some functions, such as the printf function, can be configured to only implement a subset of the pub-
lic API (for example, remove -u _printf_float option on GCC/LD to disable printing floating point
values).

• In the map file generated by the third-party linker, check that every embedded function is necessary. For
example, hardware timers or HAL components may be initialized in the BSP but not used in the application.
Also, debug functions such as SystemViewmay be disconnected when building the production firmware.

Application Configuration

The following application configuration guidelines are recommended in order to minimize the size of the applica-
tion:

• Disable class names generation by setting the soar.generate.classnames option to false . Class names
are only required when using Java reflection. In such case, the name of a specific class will be embedded
only if is explicitly required. See Stripping Class Names from an Application section for more information.

• Remove UTF-8 encoding support by setting the cldc.encoding.utf8.included option to false . The
default encoding ( ISO-8859-1 ) is enough for most applications.
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• Remove SecurityManager checks by setting the com.microej.library.edc.securitymanager.enabled
option to false . This feature is only useful for Multi-Sandbox firmwares.

For more information on how to set an option, please refer to the Defining an Option section.

Stripping Class Names from an Application

By default, when a Java class is used, its name is embedded too. A class is used when one of its methods is called,
for example. Embedding the name of every class is convenient when starting a new MicroEJ Application, but it is
rarely necessary and takes a lot of ROM. This section explains how to embed only the required class names of an
application.

Removing All Class Names

First, the default behavior is inverted by defining the Application option soar.generate.classnames to false .

For more information on how to set an option, please refer to the Defining an Option section.

Listing Required Class Names

Some class namesmay be required by an application to work properly. These class namesmust be explicitly spec-
ified in a *.types.list file.

The code of the application must be checked for all uses of the Class.forName(), Class.getName() and
Class.getSimpleName() methods. For each of these method calls, if the class name if absolutely required and can
not be known at compile-time, add it to a *.types.list file. Otherwise, remove the use of the class name.

The following sections illustrates this on concrete use cases.

Case of Service Library

The ej.service.ServiceLoader class of the service library is a dependency injection facility. It can be used to dynam-
ically retrieve the implementation of a service.

The assignment between a service API and its implementation is done in *.properties.list files. Both the ser-
vice class name and the implementation class namemust be embedded (i.e., added in a *.types.list file).

For example:

# example.properties.list
com.example.MyService=com.example.MyServiceImpl

# example.types.list
com.example.MyService
com.example.MyServiceImpl

Case of Properties Loading

Some propertiesmay be loaded by using the name of a class to determine the full name of the property. For exam-
ple:
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Integer.getInteger(MyClass.class.getName() + ".myproperty");

In this case, it can be replaced with the actual string. For example:

Integer.getInteger("com.example.MyClass.myproperty");

Case of Logger and Other Debugging Facilities

Logging mechanisms usually display the name of the classes in traces. It is not necessary to embed these class
names. The Stack Trace Reader can decipher the output.

6.7.5 How to Reduce the Runtime Size of an Application

You can find generic coding rules in the following tutorial: Improve the Quality of Java Code.

This section provides additional coding rules and good practices in order to reduce the runtime size (RAM) of an
application.

Application Code

The following application code guidelines are recommended in order to minimize the size of the application:

• Avoidusing thedefault constructorof collectionobjects, use constructors that allow to set the initial capacity.
For example, use the ArrayList(int initialCapacity) constructor instead of the default one which will allocate
space for ten elements.

• Adjust the type of int fields (32 bits) according to the expected range of values being stored ( byte for 8 bits
signed integers, short for 16 bits signed integers, char for 16 bits unsigned integers).

• When designing a generic and reusable component, allow the user to configure the size of any bu�er allo-
cated internally (either at runtime using a constructor parameter, or globally using a BON constant). That
way, the user can select the optimal bu�er size depending on his use-case and avoid wasting memory.

• Avoidallocating immortal arrays to call nativemethods, use regular arrays instead. Immortal arrays arenever
reclaimed and they are not necessary anymore when calling a native method.

• Reduce themaximumnumber of parallel threads. Each thread require a dedicated internal structure and VM
stack blocks.

– Avoid creating threads on the fly for asynchronous execution, use shared thread instances instead
(Timer, Executor, MicroUI.callSerially(Runnable), . . . ).

• When designing Graphical User Interface:

– Avoidcreatingmutable images (Bu�eredImage instances) todraw in themand render them later, render
graphics directly on the display instead. Mutable images require allocating a lot of memory from the
images heap.

– Make sure that your Widget hierarchy is as flat as possible (avoid any unnecessary Container). Deep
widget hierarchies take more memory and can reduce performance.

MicroEJ Platform Configuration

The following configuration guidelines are recommended in order tominimize the runtime size of the application:
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• Check the size of the stack of each RTOS task. For example, 1.0KB may be enough for the MicroJVM task but
it can be increased to allow deep native calls. See Debugging Stack Overflows section for more information.

• Check the size of the heap allocated by the RTOS (for example, configTOTAL_HEAP_SIZE for FreeRTOS).

• Check that the size of the back bu�er matches the size of the display. Use a partial bu�er if the back bu�er
does not fit in the RAM.

Debugging Stack Overflows

If the size you allocate for a given RTOS task is too small, a stack overflowwill occur. To be aware of stack overflows,
proceed with the following steps when using FreeRTOS:

1. Enable the stack overflow check in FreeRTOS.h :

#define configCHECK_FOR_STACK_OVERFLOW 1

2. Define the hook function in any file of your project ( main.c for example):

void vApplicationStackOverflowHook(TaskHandle_t xTask, signed char *pcTaskName) { }

3. Add a new breakpoint inside this function

4. When a stack overflow occurs, the execution will stop at this breakpoint

For further information, please refer to the FreeRTOS documentation.

Application Configuration

The following application configuration guidelines are recommended in order to minimize the size of the applica-
tion.

For more information on how to set an option, please refer to the Defining an Option documentation.

Java Heap and Immortals Heap

• Configure the immortals heap option to be as small as possible. You can get the minimum value by calling
Immortals.freeMemory() a�er the creation of all the immortal objects.

• Configure the Java heap option to fit the needs of the application. You can get the maximum heap usage
by calling Runtime.freeMemory() a�er System.gc() at di�erent moments in the application’s lifecycle. The
profiling library can be used for this.

Thread Stacks

• Configure themaximum number of threads option. This number can be known accurately by counting in the
code how many Thread and Timer objects may run concurrently. You can call Thread.getAllStackTraces()
or Thread.activeCount() to knowwhat threads are running at a given moment.

• Configure the number of allocated thread stack blocks option. This can be done empirically by startingwith a
low number of blocks and increasing this number as long as the application throws a StackOverflowError
.

• Configure the maximum number of blocks per thread option. The best choice is to set it to the number of
blocks required by the most greedy thread. Another acceptable option is to set it to the same value as the
total number of allocated blocks.
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• Configure the maximum number of monitors per thread option. This number can be known accurately by
counting the number of concurrent synchronized blocks. This can also be done empirically by starting
with a low number of monitors and increasing this number as long as no exception occurs. Either way, it is
recommended to set a slightly higher value than calculated.

VM Dump

The LLMJVM_dump() function declared in LLMJVM.h may be called to print information on alive threads such as
their current andmaximum stack block usage. This functionmay be called from the application by exposing it in a
native function. See Debugging section for usage.

More specifically, the Peak java threads count valueprinted in thedumpcanbeused to configure themaximum
number of threads. The max_java_stack and current_java_stack values printed for each thread can be used
to configure the number of stack blocks.

MicroUI Images Heap

• Configure the images heap to be as small as possible. You can compute the optimal size empirically. It can
also be calculated accurately by adding the size of every image that may be stored in the images heap at
a given moment. One way of doing this is to inspect every occurrence of Bu�eredImage() allocations and
ResourceImage usage of loadImage() methods.

6.8 Explore Data Serialization Formats

This tutorial highlights some data serialization formats that are provided on MicroEJ Central Repository and their
usage through basic code samples.

6.8.1 Intended Audience

The audience for this document is Application engineers who want to implement data serialization. In addition,
this tutorial should be of interest to so�ware architectswho are looking for a suitable data format for their use case.

6.8.2 XML

XML (EXtensibleMarkup Language) is used to describe data and text. It allows flexible development of user-defined
document types. The format is robust, non-proprietary, persistent and is verifiable for storage and transmission.
To parse this data format, the XMLPull parser KXmlParser from the Java community has been integrated toMicroEJ
Central Repository.

XMLModule

The XML Module must be added to themodule.ivy of the MicroEJ Application project to use the KXML library.

<dependency org="org.kxml2" name="kxml2" rev="2.3.2"/>
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Example Of Use

An example is available at https://github.com/MicroEJ/Example-XML. It presents how to use XML data exchange
for your MicroEJ Application. It also details how to use the KXmlParser module.

The example parses a short poemwritten in XML and prints the result on the standard output. The project can run
on any MicroEJ Platform (no external dependencies).

<?xml version="1.0" encoding="UTF-8"?>
<poem xmlns="http://www.megginson.com/ns/exp/poetry">

<title>Roses are Red</title>
<l>Roses are red,</l>
<l>Violets are blue;</l>
<l>Sugar is sweet,</l>
<l>And I love you.</l>

</poem>

Running the ReadPoem Java application should print the following trace :

=============== [ Initialization Stage ] ===============
=============== [ Launching on Simulator ] ===============
Roses are Red
_____________

Roses are red,
Violets are blue;
Sugar is sweet,
And I love you.

=============== [ Completed Successfully ] ===============

SUCCESS

Running MyXmlPullApp gives more details on the XML parsing and should print this trace :

=============== [ Initialization Stage ] ===============
=============== [ Launching on Simulator ] ===============
parser implementation class is class org.kxml2.io.KXmlParser
Parsing simple sample XML
Start document
Start element: {http://www.megginson.com/ns/exp/poetry}poem
Characters: "\n"
Start element: {http://www.megginson.com/ns/exp/poetry}title
Characters: "Roses are Red"
End element: {http://www.megginson.com/ns/exp/poetry}title
Characters: "\n"
Start element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "Roses are red,"
End element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "\n"
Start element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "Violets are blue;"
End element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "\n"
Start element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "Sugar is sweet,"
End element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "\n"

(continues on next page)

6.8. Explore Data Serialization Formats 654

https://github.com/MicroEJ/Example-XML
http://kxml.org/


MicroEJ Documentation, Revision 2788b3f4

(continued from previous page)

Start element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "And I love you."
End element: {http://www.megginson.com/ns/exp/poetry}l
Characters: "\n"
End element: {http://www.megginson.com/ns/exp/poetry}poem
=============== [ Completed Successfully ] ===============

SUCCESS

6.8.3 JSON

As described on the JSON o�icial site, JSON (JavaScript Object Notation) is a lightweight data-interchange format.
It is widely used in many applications such as:

• as a mean of data serialization for lightweight web services such as REST

• for server interrogation in Ajax to build dynamic webpages

• or even databases.

JSON is easily readable by humans compared to XML. To parse this data format, several JSON parsers are available
on the o�icial JSON page, such as JSONME, which has been integrated to MicroEJ Central Repository.

JSONModule

The JSONModule must be added to themodule.ivy of the MicroEJ Application project to use the JSON library.

<dependency org="org.json.me" name="json" rev="1.3.0"/>

The instantiation anduseof theparser is pretty straightforward. First youneed to get the JSONcontent as a String
, and then create a JSONObject instance with the string. If the string content is a valid JSON content, you should
have an workable JSONObject to browse.

Example Of Use

In the following example we will parse this JSON file that represents a simple abstraction of a file menu:

{
"menu": {

"id": "file",
"value": "File",
"popup": {

"menuitem": [
{"value": "New", "onclick": "CreateNewDoc()"},
{"value": "Open", "onclick": "OpenDoc()"},
{"value": "Close", "onclick": "CloseDoc()"}

]
}

}
}

First, we need to include this file in our project by adding it to the src/main/resources folder and creating a
.resources.list properties file to declare this resource for our application to be able to retrieve it (see Raw Re-
sources for more details).
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This .resources.list file (here named json.resources.list ) should contain the path to our JSON file as such
:

resources/menu.json

The example below will parse the file, browse the resulting data structure ( org.json.me.JSONObject ) and print
the value of the menuitem JSON array.

package com.microej.examples.json;

import java.io.DataInputStream;
import java.io.IOException;

import org.json.me.JSONArray;
import org.json.me.JSONException;
import org.json.me.JSONObject;

/**
* This example uses the org.json.me parser provided by json.org to parse and
* browse a JSON content.
*
* The JSON content is simple abstraction of a file menu as provided here:
* http://www.json.org/example.html
*
* The example then tries to list all the 'menuitem's available in the popup
* menu. It is assumed the user knows the menu JSON file structure.
*
*/
public class MyJSONExample {

public static void main(String[] args) {

// get back an input stream from the resource that represents the JSON
// content
DataInputStream dis = new DataInputStream(

MyJSONExample.class.getResourceAsStream("/resources/menu.json"));

byte[] bytes = null;

try {

// assume the available returns the whole content of the resource
bytes = new byte[dis.available()];

dis.readFully(bytes);

} catch (IOException e1) {

(continues on next page)

6.8. Explore Data Serialization Formats 656



MicroEJ Documentation, Revision 2788b3f4

(continued from previous page)

// something went wrong
e1.printStackTrace();
return;

}

try {

// create the data structure to exploit the content
// the string is created assuming default encoding
JSONObject jsono = new JSONObject(new String(bytes));

// get the JSONObject named "menu" from the root JSONObject
JSONObject o = jsono.getJSONObject("menu");

o = o.getJSONObject("popup");

JSONArray a = o.getJSONArray("menuitem");

System.out.println("The menuitem content of popup menu is:");
System.out.println(a.toString());

} catch (JSONException e) {
// a getJSONObject() or a getJSONArray() failed
// or the parsing failed
e.printStackTrace();

}

}

}

The execution of this example on the MicroEJ Simulator should print the following trace:

=============== [ Initialization Stage ] ===============
=============== [ Launching Simulator ] ===============
The menuitem content of popup menu is:
[{"value":"New","onclick":"CreateNewDoc()"},{"value":"Open","onclick":"OpenDoc()"},{"value":"Close",
→˓"onclick":"CloseDoc()"}]
=============== [ Completed Successfully ] ===============

SUCCESS

6.8.4 CBOR

TheCBOR(ConciseBinaryObjectRepresentation)binarydata serialization format is a lightweightdata-interchange
format similar to JSON but with a smaller footprint, making it very practical for embedded applications, though its
messages are o�en less easily readable by humans.

CBORModule

The CBOR Module must be added to themodule.ivy of the MicroEJ Application project to use the CBOR library.

<dependency org="ej.library.iot" name="cbor" rev="1.1.0"/>
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Example Of Use

An example is available at https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.
example.iot.cbor. It shows how to use the CBOR library in your MicroEJ Application by encoding some data and
reading it back, printing it on the standard output both as a raw byte string and in a JSON-like format. You can use
http://cbor.me/ to convert the byte string output to a JSON format and check that it matches the encoded data.
The project can run on any MicroEJ Platform (no external dependencies).

The execution of this example on the MicroEJ Simulator should print the following trace:

=============== [ Initialization Stage ] ===============
=============== [ Launching on Simulator ] ===============
CBOR data string :␣
→˓a1646d656e75a36269646466696c656576616c75656446696c6565706f707570a1686d656e756974656d83a26576616c7565634e6577676f6e636c69636b6e4372656174654e6577446f632829a26576616c7565644f70656e676f6e636c69636b694f70656e446f632829a26576616c756565436c6f7365676f6e636c69636b6a436c6f7365446f632829
Data content :
{

"menu" : {
"id" : "file",
"value" : "File",
"popup" : {

"menuitem" : [ {
"value" : "New",
"onclick" : "CreateNewDoc()"

}, {
"value" : "Open",
"onclick" : "OpenDoc()"

}, {
"value" : "Close",
"onclick" : "CloseDoc()"

} ]
}

}
}
=============== [ Completed Successfully ] ===============

Another example showing how to use the JSONModule along with the CBORModule to convert data from JSON to
CBOR is available here : https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.
iot.cbor.json.

The execution of this example on the MicroEJ Simulator should print the following trace:

Initial data (271 bytes) = {"menu":{"value":"File","id":"file","popup":{"menuitem":[{"value":"New",
→˓"onclick":"CreateNewDoc()"},{"value":"Open","onclick":"OpenDoc()"},{"value":"Close","onclick":
→˓"CloseDoc()"}]}}}
Data serialized (139 bytes)
Data deserialized = {menu={value=File, id=file, popup={menuitem=[{value=New, onclick=CreateNewDoc()},
→˓{value=Open, onclick=OpenDoc()}, {value=Close, onclick=CloseDoc()}]}}}

6.9 Instrument Java Code for Logging

This document explains how to add logging and tracing to MicroEJ applications and libraries with three di�erent
solutions. The aim is to help developers to report precise execution context for further debugging andmonitoring.
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6.9.1 Intended Audience

The audience for this document is application developers who are looking for ways to add logging to their MicroEJ
applications and libraries.

It should also be of interest to Firmware engineers how are looking for adjusting the log level while keeping low
memory footprint and good performances.

6.9.2 Introduction

One straightforward way to add logs in Java code is to use the Java basic print methods: System.out.println(.
..) .

However, this is not desirable when writing production-grade code, where it should be possible to adjust the log
level:

• without having to change the original source code,

• at build-time or at runtime, as application logging will a�ect memory footprint and performances

6.9.3 Overview

In this tutorial, we will describe 3 ways for logging data:

• Using Trace library: a real-time event recording library designed for performance and interaction analysis.

• Using Message library: a lightweight and simple logging library.

• Using Logging library: a complete and highly configurable standard logging library.

Through this tutorial, we will illustrate the usage of each library by instrumenting the following code snippet:

public class Main {

enum ApplicationState {
INSTALLED, STARTED, STOPPED, UNINSTALLED

}

private static ApplicationState currentState;
private static ApplicationState previousState;

public static void main(String[] args) {
currentState = ApplicationState.UNINSTALLED;
switchState(ApplicationState.INSTALLED);

}

public static void switchState(ApplicationState newState) {
previousState = currentState;
currentState = newState;

}
}

Finally, the last section describes some techniques to remove logging related code in order to reduce the memory
footprint.
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6.9.4 Log with the Trace Library

The library ej.api.trace provides a way of tracing integer events. Its features and principles are described in the
Event Tracing section.

Here is a short example of how to use this library to log the entry/exit of the switchState() method:

1. Add the following dependency to the module.ivy :

<dependency org="ej.api" name="trace" rev="1.1.0"/>

2. Start by initializing a Tracer object:

private static final Tracer tracer = new Tracer("Application", 100);

In this case, Application identifies a category of events that defines a maximum of 100 di�erent event
types.

3. Next, start trace recording:

public static void main(String[] args) {
Tracer.startTrace();

currentState = ApplicationState.UNINSTALLED;
switchState(ApplicationState.INSTALLED);

}

4. Use the methods Tracer.recordEvent(...) and Tracer.recordEventEnd(...) to record the entry/exit
events in the method:

private static final int EVENT_ID = 0;

public static void switchState(ApplicationState newState) {
tracer.recordEvent(EVENT_ID);

previousState = currentState;
currentState = newState;

tracer.recordEventEnd(EVENT_ID);
}

The Tracer object records the entry/exit of method switchState with event ID 0 .

5. Finally, to enable the MicroEJ Core Engine trace system, set the core.trace.enabled option to true . This
can be done from a launch configuration: check Runtime > Enable execution traces option.
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This produces the following output:

[TRACE: Application] Event 0x0()
[TRACE: Application] Event End 0x0()

Note: The default Platform implementation of the Trace library prints the events to the console. See Platform
Implementation for other available implementations such as SystemView tool.

6.9.5 Log with the Message Library

The library ej.library.runtime.message was designed to enable logging while minimizing RAM/ROM footprint and
CPUusage. For that, logs arebasedonmessage identifiers,whichare storedon integers insteadof usingof constant
Strings. In addition to a message identifier, the category of the message allows the user to find the corresponding
error/warning/info description. An external documentationmust bemaintained to describe allmessage identifiers
and their expected arguments for each category.

Principles:

• TheMessageLogger type allows for loggingmessages solely based on integers that identify themessage con-
tent.

• Log a message by using methods MessageLogger.log(...) methods, by specifying the log level, the mes-
sage category, and the message identifier. Use optional arguments to add any useful information to the log,
such as a Throwable or contextual data.

• Log levels are very similar to those of the Logging library. The class ej.util.message.Level lists the available
levels.

• Loggers rely on the MessageBuilder type for message creation. The messages built by the BasicMessage-
Builder follow this pattern: [category]:[LEVEL]=[id] . The builder appends the specified Object argu-
ments (if any) separated by spaces, then the full stack trace of the Throwable argument (if any).

Here is a short example of how to use this library to log the entry/exit of the switchState() method:

1. To use this library, add this dependency line in the module.ivy :
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<dependency org="ej.library.runtime" name="message" rev="2.1.0"/>

2. Call the message API to log some info:

private static final String LOG_CATEGORY = "Application";

private static final int LOG_ID = 2;

public static void switchState(ApplicationState newState) {
previousState = currentState;
currentState = newState;

BasicMessageLogger.INSTANCE.log(Level.INFO, LOG_CATEGORY, LOG_ID, previousState, currentState);
}

This produces the following output:

Application:I=2 UNINSTALLED INSTALLED

6.9.6 Log with the Logging Library

The library ej.library.eclasspath.logging implements a subset of the standard Java java.util.logging package and
follows the same principles:

• There is one instance of LogManager by application that manages the hierarchy of loggers.

• Findor create Logger objects using themethodLogger.getLogger(String). If a logger has alreadybeen created
with the same name, this logger is returned, otherwise a new logger is created.

• Each Logger created with this method is registered in the LogManager and can be retrieved using its String
ID .

• A minimum level can be set to a Logger so that only messages that have at least this level are logged. The
class java.util.logging.Level lists the available standard levels.

• The Logger API provides multiple methods for logging:

– log(...) methods that send a LogRecord to the registered Handler instances. The LogRecord object
wraps the String message and the log level.

– Log level-specificmethods, like severe(String msg) , that call the aforementioned log(...) method
with the correct level.

• The library defines a default Handler implementation, called DefaultHandler, that prints the message of the
LogRecord on the standard error output stream. It also prints the stack trace of the Throwable associated
with the LogRecord if there is one.

Here is a short example of how to use this library to log the entry/exit of the switchState() method:

1. Add the following dependency to the module.ivy :

<dependency org="ej.library.eclasspath" name="logging" rev="1.1.0"/>

2. Call the logging API to log some info text:

public static void switchState(ApplicationState newState) {
previousState = currentState;
currentState = newState;

(continues on next page)
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Logger logger = Logger.getLogger(Main.class.getName());
logger.log(Level.INFO, "The application state has changed from " + previousState.toString() +

→˓" to "
+ currentState.toString() + ".");

}

This produces the following output:

main INFO: The application state has changed from UNINSTALLED to INSTALLED.

Note: Unlike the two other libraries discussed here, the Logging library is entirely based on Strings (log IDs and
messages). String operations can lead to performance issues and String objects use significant ROM space. When
possible, prefer using a logging solution that uses primitive types over Strings.

6.9.7 Remove Logging Related Code

This section describes some techniques to remove logging related code, which saves memory footprint when log-
ging is disabled at runtime. This is typically useful whenbuilding two Firmware flavors: one for production and one
for debug.

Wrapwith a Constant If Statement

A boolean constant declared in an if statement can be used to fully remove portions of code. When this boolean
constant is detected to be false , the wrapped code becomes unreachable and is not embedded.

Note: More information about the usage of constants and if code removal can be found in the Classpath section.

1. Let’s consider a constant com.mycompany.logging declared as false in a resource file named example.
constants.list .
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2. Wrap the log code by an if statement, as follows:

private static final String LOG_PROPERTY = "com.mycompany.logging";

public static void switchState(ApplicationState newState) {
previousState = currentState;
currentState = newState;

if (Constants.getBoolean(LOG_PROPERTY)) {
Logger logger = Logger.getLogger(Main.class.getName());
logger.log(Level.INFO, "The application state has changed from " + previousState.toString()␣

→˓+ " to "
+ currentState.toString() + ".");

}
}

When using the Trace API ( ej.api.trace ), you can use the Tracer.TRACE_ENABLED_CONSTANT_PROPERTY con-
stant that represents the value of the core.trace.enabled option.

Follow the same principle as before:

private static final int EVENT_ID = 0;

public static void switchState(ApplicationState newState) {
if (Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {

tracer.recordEvent(EVENT_ID);
}

previousState = currentState;
currentState = newState;

if (Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
tracer.recordEventEnd(EVENT_ID);

}
}
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Shrink Code Using ProGuard

ProGuard is a tool that shrinks, optimizes, and obfuscates Java code.

It optimizes bytecode as well as it detects and removes unused instructions. Therefore it can be used to remove
log messages in a production binary.

A dedicated How-To is available at https://github.com/MicroEJ/How-To/tree/master/Proguard-Get-Started. It de-
scribes how to configure ProGuard to remove elements of code from the Logging library.

6.10 Run a Test Suite on a Device

This tutorial describes all the steps to configure and run a Platform Test Suite on a device using the PlatformQuali-
fication Tools.

In this tutorial, the target device is the Espressif ESP32-WROVER-KIT V4.1 board and the Filesystem Test Suite for FS
module will be used as an example.

The tutorial should take 1 hour to complete (excluding the Platform Getting Started setup).

6.10.1 Intended Audience and Scope

The audience for this document is so�ware engineers who want to validate an Abstraction Layer implementation
or understand how to automatically run a MicroEJ Test Suite on their device.

The following topics are out of the scope of this tutorial:

• How to write test cases and package a Test Suite module. See Test Suite with JUnit for this topic.

• How to create a new Foundation Library. See the Foundation Library Getting Started to learn more about
creating custom Foundation Library.

6.10.2 Prerequisites

This tutorial assumes the following:

• Good knowledge of theMicroEJ Glossary.

• Tutorial Understand how to build a MicroEJ Firmware and its dependencies has been followed.

• MicroEJ SDK distribution 20.07 or more (see Determine the MicroEJ Studio/SDK Version).

• The WROVER Platform has been properly setup (i.e., it can be used to generate a MicroEJ Mono-Sandbox
Firmware).

The explanation can be adapted to run the test suite on any other MicroEJ Platform providing:

• An implementation of LLFS: File System version 1.0.2 in com.microej.pack#fs-4.0.3 .

• A partial or full BSP Connection.

Note: This tutorial can also be adapted to run other test suites in addition to the Filesystem Test Suite presented
here.
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6.10.3 Introduction

This tutorial presents a local setup of thePlatformTest Suite for the FS Foundation Library on a concrete device (not
on Simulator).

In essence, a Foundation Library provides an API to be used by a MicroEJ Application or an Add-on Library.

Fig. 1: MicroEJ Foundation Libraries, Add-On Libraries and MicroEJ Application

For example, the Java file system API java.io.File is provided by the MicroEJ Foundation Library named FS .
The Abstraction Layer of each Foundation API must be implemented in C in the Board Support Package. The Test
Suite is used to validate the C code implementation of the Abstraction Layer.

6.10.4 Import the Test Suite

Follow these steps to import the Filesystem Test Suite into the workspace from the Platform Qualification Tools:

• Clone or download the Platform Qualitification Tools project 2.3.0.

• Select File > Import. . . .

• Select Existing Projects into Workspace .

• Set Select the root directory to the directory tests/fs in the Platform Qualification Tools fetched in the
previous step.

• Ensure Copy projects into workspace is checked.

• Click on Finish .

The project java-testsuite-fs should now be available in the workspace.

6.10.5 Configure the Test Suite

Select the Test Suite Version

For a givenFoundationLibrary version, a specific Test Suite version shouldbeused to validate theAbstractionLayer
implementation. Please refer to Test Suite Versioning to determine the correct Test Suite version to use.

On theWROVERPlatform, theFSTestSuite version touse is specified in {PLATFORM}-configuration/testsuites/
fs/README.md . The Test Suite version must be set in the module.ivy of the java-testsuite-fs project (e.g.
java-testsuite-fs/module.ivy ). For example:

<dependency org="com.microej.pack.fs" name="fs-testsuite" rev="3.0.3"/>
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Configure the Platform BSP Connection

Several properties must be defined depending on the type of BSP Connection used by the MicroEJ Platform.

For aMicroEJ Application, these properties are set using the launcher of the application. For a Test Suite, the prop-
erties are defined in a file named config.properties in the root folder of the Test Suite. For example, see this
example of config.properties file.

See BSP Connection for an explanation of the properties. See the comments in the file for a details description
of each properties. The microej.testsuite.properties.deploy.* and target.platform.dir properties are
required.

Configure Execution Trace Redirection

When the Test Suite is executed, the Test Suite Enginemust read the trace to determine the result of the execution.
To do that, we will use the Serial to Socket Transmitter tool to redirect the execution traces dumped to a COM port.

The WROVER platform used in this tutorial is particular because the UART port is already used to flash the device.
Thus, a separate UART port must be used for the trace output.

This platform defines the option microej.testsuite.properties.debug.traces.uart to redirect traces from
standard input to UART.

See the Testsuite Configuration section of the WROVER Platform documentation for more details.
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Start Serial To Socket

The Serial to Socket Transmitter tool can be configured to listen on a particular COMport and redirect the output on
a local socket. Theproperties microej.testsuite.properties.testsuite.trace.ip and microej.testsuite.
properties.testsuite.trace.port must be configured.

Follow these steps to create a launcher for Serial To Socket Transmitter:

• Select Run > Run Configurations. . . .

• Right-click on MicroEJ Tool > New .

• In the Execution tab:

– Set Name to Serial To Socket Transmitter .

– Select a MicroEJ Platform available in the workspace in Target > Platform .

– Select Serial To Socket Transmitter in Execution > Settings .

– Set the Output folder to the workspace.

• In the Configuration tab:

– Set the correct COM port and baudrate for the device in Serial Options .

– Set a valid port number in Server Options > Port . This port is the same as the one set in config.

properties as microej.testsuite.properties.testsuite.trace.port .

Configure the Test Suite Specific Options

Depending on the Test Suite and the specificities of the device, various properties may be required
and adjusted. See the file validation/microej-testsuite-common.properties (for example
https://github.com/MicroEJ/PlatformQualificationTools/blob/2.3.0/tests/fs/java/java-testsuite-fs/validation/
microej-testsuite-common.properties) and the README of the Test Suite for a description of each property.

On the WROVER Platform, the configuration files config.properties and microej-testsuite-common.
properties are provided in {PLATFORM}-configuration/testsuites/fs/ .

In config.properties , the property target.platform.dir must be set to the absolute path to the platform. For
example C:/P0065_ESP32-WROVER-Platform/ESP32-WROVER-Xtensa-FreeRTOS-platform/source .

6.10.6 Run the Test Suite

To run the Test Suite, right click on the Test Suite module and select Build Module .

6.10.7 Configure the Tests to Run

It is possible to exclude some tests from being executed by the Test Suite Engine.

To speed-up the execution, let’s configure it to run only a small set of tests. In the following example, only the
classes that match TestFilePermission are executed. This configuration goes into the file config.properties
in the folder of the test suite.
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# Comma separated list of patterns of files that must be included
# test.run.includes.pattern=**/Test*.class
test.run.includes.pattern=**/TestFilePermission*.class
# Comma separated list of patterns of files that must be excluded (defaults to inner classes)
test.run.excludes.pattern=**/*$*.class

Several reasons might explain why to exclude some tests:

• Iterative development. Test only the Abstraction Layer that is currently being developed. The full Test Suite
must still be executed to validate the complete implementation.

• Known bugs in the Foundation Library. The latest version of the Test Suite for a given Foundation Library
might contain regression tests or tests for new features. If the MicroEJ Platform doesn’t use the latest Foun-
dation Library, then it can be necessary to exclude the new tests.

• Known bugs in the Foundation Library implementation. The project might have specific requirements
that prevent a fully compliant implementation of the Foundation Library.

6.10.8 Examine the Test Suite Report

Once the Test Suite is completed, open the HTML Test Suite Report stored in java-testsuite-fs/target~/test/
html/test/junit-noframes.html .

At the beginning of the file, a summary is displayed. Below, all execution traces for each test executed are available.

If necessary, the binaries produced and ran on the device by the Test Suite Engine are available in target~/test/
xml/<TIMESTAMP>/bin/<FULLY-QUALIFIED-CLASSNAME>/application.out .

The following image shows the test suite report fully passed:

6.11 Get Started With GUI

6.11.1 Setup your Environment

Prerequisites

• Supported Operating System: MICROEJ SDK runs on the following operating systems: Windows (7, 8, 8.1, 10),
Linux, macos.
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• A Java™ Runtime Environment 8 is needed on your host computer for running MICROEJ SDK Dist. 21.03:
Download Java.

Download and Install

1. Download the installer package corresponding to your host computer OS: Download MicroEJ SDK.

2. Unzip the downloaded installer package if needed and execute the installer.

Start the IDE for the First Time

1. Start MICROEJ SDK and select a workspace.

Note: If you are not familiar with Eclipse workspaces, select the default and press OK.

2. Select the MICROEJ repository.

Note: If you are not familiar with MICROEJ repositories, select the default and press OK.

Prepare Platform Sources

1. Download and unzip the platform sources for STM32F7508-DK by clicking on Download > Download ZIP
: Go to the Github repository.

2. Follow the README to import the platform sources, activate your license and build your platform, in the
Platform Setup section.

3. Once all the steps of the platform setup are done, a new Java project can be created.

Create a New Project

Go to File > New > Standalone Application Project :
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The project structure should look like this:

Featured Project: Widget Demo

You can have a look at the widget demo project, which contains multiple samples of widgets and usage.

• Widget Demo GitHub Repository
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6.11.2 Starting MicroUI

1. To get started, first we need to addMicroUI, a Foundation Library that provides an abstraction layer to access
the low-level UI inputs and outputs.

2. Look for module.ivy , and replace dependencies with the following:

<dependencies>
<dependency org="ej.api" name="microui" rev="3.0.3"/>

</dependencies>

Note: There’s no need to add EDC as a dependency. It will be automatically resolvedwith the correct version
(as a dependency of the MicroUI library).

3. This call initializes theMicroUI frameworkandstarts theUI Thread,whichmanages theuser input anddisplay
events.

public static void main(String[] args) {
MicroUI.start();

}

Note: MicroUI has to be started before any UI operations.

4. To run your code on the Simulator, le� click on the Project Go To Run > Run As > MicroEJ Application .

Note: If you have several platforms you will be asked which to use.
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Widgets

1. Thewidget library provides a collectionof commonwidgets and containers. It is basedonMWT, a base library
that defines core type graphical elements for designing rich graphical user interface embedded applications.

2. Look for module.ivy , and replace dependencies with the following:

<dependencies>
<dependency org="ej.library.ui" name="widget" rev="4.0.0" />

</dependencies>

Note: There’s no need to add MWT or MicroUI, as both are dependencies of the Widget library. They will be
automatically resolved with the correct version.

Desktop Usage

1. A desktop is the top-level object that can be displayed on a Display. It may contain awidget, and atmost one
desktop is shown on a Display at any given time.

2. Desktop automatically triggers the layout and rendering phases for itself and its children.

public static void main(String[] args) {
MicroUI.start();

Desktop desktop = new Desktop();
desktop.requestShow();

}
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Displaying a Label

1. To add a label, just instantiate a Label object and add it to the desktop as the root widget.

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();

Label label = new Label("Hello World");
desktop.setWidget(label);

desktop.requestShow();
}

2. To run the code go to the Main.java file and right click it, hover over Run As and select
MicroEJ Application .
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6.11.3 Basic Drawing on Screen

• Wehave seen a basic use of theMWTandwidgets libraries. Before going further let’s see how towrite directly
on a display using both Displayable and GraphicsContext classes.

• A Displayable represents what can be shown on a screen, a GraphicsContext provides access to amodifiable
(readable and writable) pixel bu�er to be associated with an Image or a Displayable.

• It is then possible to have access to a drawable interface that represents a pixelated version of the Display.

public static void main(String[] args){
MicroUI.start();
Displayable myDisplayable = new Displayable() {

@Override
protected void render(GraphicsContext g) {

// Draws a yellow line.
g.setColor(Colors.YELLOW);
Painter.drawLine(g, 0, 0, 100, 50);

}

@Override
public boolean handleEvent(int event) {

return false;
}

};

Display.getDisplay().requestShow(myDisplayable);
}
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• This draws a line from the coordinates of the display (0,0) to (100,50) .

Drawing Basic Shapes

• The Painter class contains several primitives to draw geometric objects.

• The code below draws each component with the selected color (yellow, purple, green).

• The drawLine() method uses the starting and finishing point with x and y coordinates.

• Fill rectangle and ellipse methods use x and y coordinates and also width and height.

• Draw circle uses x and y and a diameter.

g.setColor(Colors.YELLOW);
Painter.drawLine(g, 0, 0, 100, 50);

g.setColor(Colors.PURPLE);
Painter.fillRectangle(g, 10, 20, 100, 20);
Painter.fillEllipse(g, 120, 50, 20, 100);

g.setColor(Colors.GREEN);
Painter.drawCircle(g, 50, 50, 100);
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Drawing Images

• The Painter class contains several primitives to draw images.

Image image = Image.getImage("/images/microej_logo.png");
// Draws the image at x,y coordinates (150, 50).
Painter.drawImage(g, image, 150, 50);
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Drawing Thick Shapes

• The ShapePainter class o�ers a set of primitives to render thick shapes with or without anti-aliasing.

• The code below shows how to draw a thick faded line.

// Draws a thick yellow line.
g.setColor(Colors.YELLOW);
ShapePainter.drawThickFadedLine(g, 20, 20, 100, 80, 10, 6, Cap.ROUNDED, Cap.PERPENDICULAR);

// Draws a thick green circle.
g.setColor(Colors.GREEN);
ShapePainter.drawThickFadedCircle(g, 130, 20, 100, 20, 2);
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6.11.4 Animation

Animations can be used to make the GUI more appealing andmore lively.

MWT provides a framework to create fluid animations. The principle is as follow:

• make a step of all the running animations (with a probable new rendering of some widgets),

• wait for the display to be flushed,

• do it again.

The goals are:

• doing animations as fast as possible (considering the complexity of the drawings and the hardware capabil-
ities),

• synchronizing all the running animations and avoiding glitches.

Usage

• An animation can be created by implemeting Animation interface and its tick() method.

• The tick() method is called for each step of the animation.

• Every time the method is called, the widget should be re-rendered.

• The animation can be stopped by returning false .
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Animation labelAnimation = new Animation() {

int tick = 0;

@Override
public boolean tick(long currentTimeMillis) {

label.setText(Integer.toString(tick++));
label.requestRender();
return true;

}
};
Animator animator = new Animator();
animator.startAnimation(labelAnimation);

• The code above updates the label text everytime it is called:

• The final code looks like this:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
final Label label = new Label("hello");

Flow flow = new Flow(LayoutOrientation.VERTICAL);
flow.addChild(label);

Animation labelAnimation = new Animation() {

int tick = 0;

(continues on next page)
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(continued from previous page)

@Override
public boolean tick(long currentTimeMillis) {

label.setText(Integer.toString(this.tick++));
label.requestRender();
return true;

}
};
Animator animator = new Animator();
animator.startAnimation(labelAnimation);

desktop.setWidget(flow);
desktop.requestShow();

}

6.11.5 Creating Widgets

• To create a widget, we need to create a class that extends the Widget superclass.

• In this example, we are going to create a simple progress bar.

• So create a MyProgressBarWidget class extending Widget.

Note: The computeContentOptimalSize() and renderContent() methods must be overridden:

public class MyProgressBarWidget extends Widget {
@Override
protected void computeContentOptimalSize(Size size) {

// TODO Auto-generated method stub
}

@Override
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {

// TODO Auto-generated method stub
}

}

Setting Up

• Let’s use a progress bar with a fixed size:

protected void computeContentOptimalSize(Size size) {
size.setSize(200,50);

}

• Then, let’s create the progress bar, first, it is important to add a progress value:

private float progressValue;

• Now, let’s render the progress bar:

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
// Draws the remaining bar: a 1 px thick grey line, with 1px of fading.

(continues on next page)

6.11. Get Started With GUI 682



MicroEJ Documentation, Revision 2788b3f4

(continued from previous page)

g.setColor(Colors.SILVER);
int halfHeight = contentHeight / 2;
ShapePainter.drawThickFadedLine(g, 0, halfHeight, contentWidth, halfHeight, 1, 1, Cap.ROUNDED,␣

→˓Cap.ROUNDED);

// Draws the progress bar: a 3 px thick blue line, with 1px of fading.
g.setColor(Colors.NAVY);
int barWidth = (int) (contentWidth * this.progressValue);
ShapePainter.drawThickFadedLine(g, 0, halfHeight, barWidth, halfHeight, 3, 1, Cap.ROUNDED, Cap.

→˓ROUNDED);
}

• Finally, let’s create a method to set the progress on the progress bar:

public void setProgress(float progress) {
this.progressValue = progress;

}

Using with Animator

• Using the codemade in the previous Animation tutorial, doing themodifications below, it is now possible to
see the progress bar animated:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
final MyProgressBarWidget progressBar = new MyProgressBarWidget();
Flow flow = new Flow(LayoutOrientation.VERTICAL);
flow.addChild(progressBar);

Animation progressBarAnimation = new Animation() {

float progress;

@Override
public boolean tick(long currentTimeMillis) {

this.progress += 0.001f;
progressBar.setProgress(this.progress);
progressBar.requestRender();
return true;

}
};
Animator animator = desktop.getAnimator();
animator.startAnimation(progressBarAnimation);
desktop.setWidget(flow);
desktop.requestShow();

}
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6.11.6 Using Layouts

The lay out process determines the position and size of the widgets. It depends on:

• The layout of the containers: how the children are arranged within the containers.

• The widgets content size: the size needed by the widgets for optimal display.

This process is started automatically when the desktop is shown. It can also be triggered programmatically.

Using a Flow Layout

The flow layout lays out any number of children horizontally or vertically, usingmultiple rows if necessary depend-
ing on the size of each child widget.

Creating a flow layout:

• First, instantiate a Flow container, then add two Label objets to this container.

6.11. Get Started With GUI 684



MicroEJ Documentation, Revision 2788b3f4

• Finally, add the Flow container to the Desktop .

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Label label = new Label("Hello World");
Label secondLabel = new Label("Hello World 2");

Flow flowContainer = new Flow(LayoutOrientation.HORIZONTAL);
flowContainer.addChild(label);
flowContainer.addChild(secondLabel);

desktop.setWidget(flowContainer);
desktop.requestShow();

}

Both of the labels will share the screen:

Using a Canvas

A canvas lays out any number of children freely.

To add a widget to a Canvas , specify its position and size.

Note: Using Widget.NO_CONSTRAINT sets the width and height to the optimal size of the widget.
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public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Label label = new Label("Hello World");
Label label2 = new Label("Hello World 2");

Canvas canvas = new Canvas();
canvas.addChild(label, 0, 0, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);
canvas.addChild(label2, 15, 15, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);

desktop.setWidget(canvas);
desktop.requestShow();

}

6.11.7 Style

Instances of Desktop,Widget, andContainer classes are semantic elements of theGUI, describing the structure and
meaning of the content.

The Style API (ej.mwt.style) defines style options for widgets, allowing for a clear separation of the core structure
(content) and the design aspects (colors, fonts, spacing, background, etc.).

Note: Some of the attributes are inspired by CSS, like Background, Border, Color, Dimension, Font, Alignment,
Margin/Padding. And the CascadingStylesheet manages the order of the selectors (with their specificity), the cas-
cading, etc.
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Selectors

Selectors determine the widget(s) to which a style applies. There are three main types of selectors:

• Simple selectors (based on type or class),

• State Selectors (based on state or position),

• Combinators (based on relationships or conditions).

Note: More of this will be presented in the Advanced Styling step.

Usage

• With a CascadingStylesheet, we can define a style for all labels using a TypeSelector:

CascadingStylesheet stylesheet = new CascadingStylesheet();
EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(Label.class));

• We can now change the style object options. In this sample, we change the base color to red and adding a
black rectangular border of 1px thickness.

style.setColor(Colors.RED);
style.setBorder(new RectangularBorder(Colors.BLACK, 1));

• For these options to take e�ect, bind the stylesheet to the desktop.

desktop.setStylesheet(stylesheet);

• The final code looks like this:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Label label = new Label("Hello World");
Label label2 = new Label("Hello World 2");

Canvas canvas = new Canvas();
canvas.addChild(label, 0, 0, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);
canvas.addChild(label2, 0, 15, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);

CascadingStylesheet stylesheet = new CascadingStylesheet();
EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
style.setColor(Colors.RED);
style.setBorder(new RectangularBorder(Colors.BLACK, 1));

desktop.setStylesheet(stylesheet);
desktop.setWidget(canvas);
desktop.requestShow();

}
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Padding and Margin

• Using margin and padding is pretty simple. Adding margin is as follows:

style.setMargin(new UniformOutline(4));
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• Setting an oversized margin looks like this:

style.setMargin(new UniformOutline(10));
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• Adding padding:

style.setPadding(new UniformOutline(2));

• Oversizing the padding (the widgets ovelap each other because we use a canvas with fixed positions):

style.setPadding(new UniformOutline(15));
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6.11.8 Images

Adding Images

• Create two packages in the Resources folder, one named list and another named images .

• Create an images list file, and add it to the list package ( myapp.images.list ).

• Save the following image to the images package:

• The structure looks like this:
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• Then go to the myapp.images.list and add the image file:

/images/microej_logo.png:ARGB4444

• The image declaration in the .list file follows this pattern:

path:format

• path is the path to the image file, relative to the resources folder.

• format specifies how the image will be embedded in the application.

Note: The ARGB4444mode is used here because the image has transparency, more info in the Images section.

Displaying an Image

• To display this image, first create an instance of the widget ImageWidget , specifying the path to the image
in the constructor:

ImageWidget image = new ImageWidget("/images/microej_logo.png");

• Add the widget to the canvas container by adding this line:

canvas.addChild(image, 0, 30, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);

• The final code looks like this:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Label label = new Label("Hello World");
Label label2 = new Label("Hello World 2");

Canvas canvas = new Canvas();
canvas.addChild(label, 0, 0, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);
canvas.addChild(label2, 0, 15, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);

ImageWidget image = new ImageWidget("/images/microej_logo.png");
canvas.addChild(image, 0, 30, Widget.NO_CONSTRAINT, Widget.NO_CONSTRAINT);

CascadingStylesheet css = new CascadingStylesheet();
EditableStyle style = css.getSelectorStyle(new TypeSelector(Label.class));
style.setColor(Colors.RED);
style.setBorder(new RectangularBorder(Colors.BLACK, 1));

desktop.setStylesheet(css);
desktop.setWidget(canvas);
desktop.requestShow();

}
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6.11.9 Advanced Styling

Using Images in Stylesheet

• Let’s add a button to the application, with the MicroEJ logo as background.

• Since this background will apply to a specific button, introduce a new class selector that will select this but-
ton.

Class Selector

• Just like a class in CSS, it associates to every element that is from the same class.

• Define a class for the button as follows:

private static final int BUTTON = 600;

• Bind the class BUTTON to the button widget:

Button button = new Button("Click ME");
button.addClassSelector(BUTTON);

• Retrieve the style for this class from the stylesheet and edit the attributes:

EditableStyle style = css.getSelectorStyle(new ClassSelector(BUTTON));

• Finally, lets add an Image Background to this Button:
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style.setBackground(new ImageBackground(Image.getImage("/images/microej_logo.png")));

• And the result should be as follows:

public class Main {
private static final int BUTTON = 600;

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Button button = new Button("Click ME");
button.addClassSelector(BUTTON);

Flow flow = new Flow(LayoutOrientation.VERTICAL);
flow.addChild(button);

CascadingStylesheet css = new CascadingStylesheet();
EditableStyle style = css.getSelectorStyle(new ClassSelector(BUTTON));
style.setBackground(new ImageBackground(Image.getImage("/images/microej_logo.png")));

desktop.setStylesheet(css);
desktop.setWidget(flow);
desktop.requestShow();

}
}
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Combinator and Conditional Style

• It is possible to combine two or more selectors using combinators.

• In this example the active state of the button will turn the text blue.

CascadingStylesheet css = new CascadingStylesheet();
Selector buttonSelector = new ClassSelector(BUTTON);
EditableStyle style = css.getSelectorStyle(buttonSelector);
style.setBackground(new ImageBackground(Image.getImage("/images/microej_logo.png")));
Selector activeSelector = new StateSelector(Button.ACTIVE);
EditableStyle styleActive = css.getSelectorStyle(new AndCombinator(buttonSelector,␣
→˓activeSelector));
styleActive.setColor(Colors.BLUE);

• The class selector for the button has been extracted as a locale to be combined with the button active state
selector.

6.11.10 Event Handling

MicroUI generates integer-based events that encode the low-level input type and some data. The application can
handle these events in the handleEvent method.

The handleEvent Method

• Every class that extends Widget inherits the handleEvent() method.

• Add custom event handling by overriding the handleEvent() method of a widget.
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• As an example, here is the event handling of the Button class:

@Override
public boolean handleEvent(int event) {

int type = Event.getType(event);
if (type == Pointer.EVENT_TYPE) {

int action = Pointer.getAction(event);
if (action == Pointer.PRESSED) {

setPressed(true);
} else if (action == Pointer.RELEASED) {

setPressed(false);
handleClick();
return true;

}
} else if (type == DesktopEventGenerator.EVENT_TYPE) {

int action = DesktopEventGenerator.getAction(event);
if (action == PointerEventDispatcher.EXITED) {

setPressed(false);
}

}
return super.handleEvent(event);

}

• It’s important to note that only widgets that are “enabled”will receive input events. One can enable awidget
by calling setEnabled(true) .

• In the Button class, the click triggers an action defined by the registered OnClickListener . The
handleClick method is where the listener is called:

public void handleClick() {
OnClickListener listener = this.onClickListener;
if (listener != null) {

listener.onClick();
}

}

Using Events with Buttons

As an example of usage of the Button class we reuse the code created in the previous step, and add a simple action
to the button by adding a OnClickListener .

button.setOnClickListener(new OnClickListener() {
@Override
public void onClick() {

System.out.println("Clicked!");
}

});

When running the modified sample, this is shown in the console:

=============== [ Initialization Stage ] ===============
=============== [ Converting fonts ] ===============
=============== [ Converting images ] ===============
=============== [ Launching on Simulator ] ===============
Clicked!
Clicked!

(continues on next page)

6.11. Get Started With GUI 696



MicroEJ Documentation, Revision 2788b3f4

(continued from previous page)

Clicked!
Clicked!
Clicked!

6.11.11 Fonts

• Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont() .
To be displayed, these fonts have to be converted at build-time from their source format to the display raw
format by the font generator tool.

• Fonts, just like images, must be declared in a *.fonts.list file.

Creating a font

• To create a font, go to the package you want to store your fonts in, usually Resources > fonts .

• Then Right-Click > New > Other > MicroEJ > MicroEJ Font :
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• Then, type the name of the font:
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• Click on Finish , the following window opens:
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Note: It is important to have the font that you want already installed on your system.

• To import characters from a system font, click on Import. . . and the following opens:
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• Click on Next and then select the font to use as shown below:
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Note: If using a latin based alphabet, just leave the settings as they are and click on Finish , don’t forget to
adjust the height and baseline of the font.

• Click Finish and save the file. The font is imported in the .ejf file.

• Then just add the font to a myapp.fonts.list file in the src/main/resources source folder of your appli-
cation:

/fonts/NewFont.ejf

• More info in the Fonts section.

Adding the Font to a Label

To add the font, choose the font in the StyleSheet:
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public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Flow flow = new Flow(LayoutOrientation.VERTICAL);
Label label = new Label("Hello World");
Font font = Font.getFont("/fonts/NewFont.ejf");
CascadingStylesheet css = new CascadingStylesheet();
EditableStyle style = css.getSelectorStyle(new ClassSelector(BUTTON));
flow.addChild(label);
style.setFont(font);
desktop.setStylesheet(css);
desktop.setWidget(flow);
desktop.requestShow();

}

Note: Don’t forget to set the stylesheet to the desktop.

6.11.12 Scroll List

List

• A list is a container that lays out its children one a�er the other in a single column or row depending on its
orientation.

• The size of each widget is set proportionally to its optimal size and the available size.
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• Naturally, it shows some issues if the list contains too many components.

• Adding 45 items to a list shows the following result:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();

List list = new List(LayoutOrientation.VERTICAL);
for (int i = 0; i < 45; i++) {

Label label = new Label("Label" + i);
list.addChild(label);

}

desktop.setWidget(list);
desktop.requestShow();

}

• To be able to see all the items, the list must be bigger than the display. So it needs to be included in another
container that is able to scroll it.

Scrollable List

• A simple way to see all the items correctly and scroll the list is to include it in a Scroll container:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
List list = new List(LayoutOrientation.VERTICAL);
for (int i = 0; i < 45; i++) {

(continues on next page)
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Label item = new Label("Label" + i);
list.addChild(item);

}
CascadingStylesheet css = new CascadingStylesheet();
Scroll scroll = new Scroll(LayoutOrientation.VERTICAL);
scroll.setChild(list);
desktop.setStylesheet(css);
desktop.setWidget(scroll);
desktop.requestShow();

}

• The list can be optimized for the scroll (to exclude the items that are outside the visible area). A scrollable list
is available at Widget Demo.

• It can be copied in the project and replace the list:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
ScrollableList list = new ScrollableList(LayoutOrientation.VERTICAL);
for (int i = 0; i < 45; i++) {

Label label = new Label("Label" + i);
list.addChild(label);

}
CascadingStylesheet css = new CascadingStylesheet();
Scroll scroll = new Scroll(LayoutOrientation.VERTICAL);
scroll.setChild(list);
desktop.setStylesheet(css);
desktop.setWidget(scroll);

(continues on next page)
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(continued from previous page)

desktop.requestShow();
}

6.11.13 Creating a Contact List using Scroll List

Creating the Contact Widget

• As explained in Creating Widget, it is possible to create our own widget by just extending the Widget class.

• First, let’s create a constructor with all the things that we are going to need for this.

public ContactWidget(String contactName, Image image) {
this.contactName = contactName;
this.image = image;

}

• Then, overriding the two abstract methods of Widget

@Override
protected void computeContentOptimalSize(Size size) {

Font f = getStyle().getFont();
int height = Math.max(f.getHeight(), this.image.getHeight());
int stringWidth = f.stringWidth(this.contactName);
int width = stringWidth + this.image.getWidth();
size.setSize(width, height);

}

@Override
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {

g.setColor(Colors.BLACK);
Painter.drawImage(g, this.image, 0, 0);
int cornerEllipseSize = contentHeight / 2;
int imageWidth = this.image.getWidth();
int imageHeight = this.image.getHeight();
Painter.drawRoundedRectangle(g, 0, 0, imageWidth, imageHeight, cornerEllipseSize,␣

→˓cornerEllipseSize);
Painter.drawString(g, this.contactName, getStyle().getFont(), imageWidth + 2, contentHeight /␣

→˓3);
}

• Then, simply replace the children in the List used in the last step:

for (int i = 0; i < 45; i++) {
list.addChild(new ContactWidget("Label" + i, Image.getImage("/images/microej_logo.png")));

}

• The class is as follows:

public class ContactWidget extends Widget {

private String contactName;
private Image image;

public ContactWidget(String contactName, Image image) {

(continues on next page)
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this.contactName = contactName;
this.image = image;

}

@Override
protected void computeContentOptimalSize(Size size) {

Font f = getStyle().getFont();
int height = Math.max(f.getHeight(), this.image.getHeight());
int stringWidth = f.stringWidth(this.contactName);
int width = stringWidth + this.image.getWidth();
size.setSize(width, height);

}

@Override
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {

g.setColor(Colors.BLACK);
Painter.drawImage(g, this.image, 0, 0);
int cornerEllipseSize = contentHeight / 2;
int imageWidth = this.image.getWidth();
int imageHeight = this.image.getHeight();
Painter.drawRoundedRectangle(g, 0, 0, imageWidth, imageHeight, cornerEllipseSize,␣

→˓cornerEllipseSize);
Painter.drawString(g, this.contactName, getStyle().getFont(), imageWidth + 2, contentHeight␣

→˓/ 3);
}

}

6.11.14 Internationalization
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Using PO Files

• PO files are a good way to handle Internationalization.

• Documentation is available here.

• In this example, let’s create two PO files for two di�erent languages(English and Portuguese) and add them
to resources/nls.

Labels_en_us.po:

msgid ""
msgstr ""
"Language: en_US\n"
"Language-Team: English\n"
"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=UTF-8\n"

msgid "Label1"
msgstr "My label 1"

msgid "Label2"
msgstr "My label 2"

Labels_pt_br.po:

msgid ""
msgstr ""
"Language: pt_BR\n"
"Language-Team: Portuguese\n"
"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=UTF-8\n"

msgid "Label1"
msgstr "Minha label 1"

msgid "Label2"
msgstr "Minha label 2"

• These PO files have to be converted to be usable by the application.

• In order to let the build system knowwhich PO files to process, theymust be referenced inMicroEJ Classpath
using a myapp.nls.list file.

Configuring NLS in MicroEJ

• First add those two dependencies to the module.ivy of your projet:

<dependency org="ej.library.runtime" name="nls" rev="3.0.1"/>
<dependency org="com.microej.library.runtime" name="nls-po" rev="2.2.0"/>

• Then, let’s create a myapp.nls.list file, and put it in the resources/list folder. The file looks like this:

com.mycompany.myapp.Labels

Note: For each line, PO files whose name starts with the interface name ( Labels in the example) are re-
trieved from the MicroEJ Classpath and used to generate:
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– a Java interface with the given fully qualified name, containing a field for each msgid of the PO files.

– a NLS binary file containing the translations.

Usage

• Import the interface set in the myapp.nls.list file:

import com.mycompany.myapp.Labels;

• Print the available locales:

for (String locale : Labels.NLS.getAvailableLocales()) {
System.out.println(locale);

}

• Print the current locale:

System.out.println(Labels.NLS.getCurrentLocale());

• Change the current locale:

Labels.NLS.setCurrentLocale("pt_BR");

• Finally, put a message from NLS in a label. The code looks like this:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Labels.NLS.setCurrentLocale("pt_BR");
// For english locale uncomment the line below and comment the pt_BR locale setter call.
// Labels.NLS.setCurrentLocale("en_US");
Label label = new Label(Labels.NLS.getMessage(Labels.Label1));
desktop.setWidget(label);
desktop.requestShow();

}

• The result looks like this:
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• Setting the locale to “en_US” the result is as follows:
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CHAPTER

SEVEN

ABOUTMICROEJ

MicroEJ’smission is todemocratizevirtualizationandObjectOrientedProgramming (OOP) to theembeddedworld.
These two technologies, widely used in computers and smartphones, radically simplifies how device so�ware is
built, from prototyping to hardware choice, by integrating simulation, systemic so�ware reuse, modularity, agility,
continuous integration, automated testing and so�ware component update in the development process.

The virtualized environment provided by MICROEJ VEE on-device platform allows for so�ware development on
virtual devices, exact “virtual twins” of real electronic configurations. Since several configurations can be tested
and evaluated within days, it is therefore much easier to build several prototypes while capitalizing on the code
that has already been built as “ready-to-use” binary so�ware assets.

MicroEJalsoo�ersan integrateddevelopmentenvironment, calledMICROEJSDK,whichprovidesoneof thewidest
rangesof standardand specialized tools and libraries,making it possible to easily developapplications implement-
ing IoT connectivity, graphical interfaces, security, and real-time processing of data (Edge Computing).

Browse this documentation to discover MicroEJ technology, learn about application and platform development,
and begin your coding journey thanks to a comprehensive range of dedicated tutorials.

For more information about MicroEJ, go to: https://www.microej.com/.
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